The Cisco implementation of TCP header compression is an adaptation of a program developed by the University of California, Berkeley (UCB) as part of UCB's public domain version of the UNIX operating system. All rights reserved. Copyright © 1981, Regents of the University of California.

Notwithstanding any other warranty herein, all document files and software of these suppliers are provided “as is” with all faults. Cisco and the above-named suppliers disclaim all warranties, expressed or implied, including, without limitation, those of merchantability, fitness for a particular purpose and noninfringement or arising from a course of dealing, usage, or trade practice.

In no event shall Cisco or its suppliers be liable for any indirect, special, consequential, or incidental damages, including, without limitation, lost profits or loss or damage to data arising out of the use or inability to use this manual, even if Cisco or its suppliers have been advised of the possibility of such damages.

Any Internet Protocol (IP) addresses and phone numbers used in this document are not intended to be actual addresses and phone numbers. Any examples, command display output, network topology diagrams, and other figures included in the document are shown for illustrative purposes only. Any use of actual IP addresses or phone numbers in illustrative content is unintentional and coincidental.

All printed copies and duplicate soft copies of this document are considered uncontrolled. See the current online version for the latest version.

Cisco has more than 200 offices worldwide. Addresses and phone numbers are listed on the Cisco website at www.cisco.com/go/offices.

Cisco and the Cisco logo are trademarks or registered trademarks of Cisco and/or its affiliates in the U.S. and other countries. To view a list of Cisco trademarks, go to this URL: https://www.cisco.com/c/en/us/about/legal/trademarks.html. Third-party trademarks mentioned are the property of their respective owners. The use of the word partner does not imply a partnership relationship between Cisco and any other company. (1721R)

© 2000–2020 Cisco Systems, Inc. All rights reserved.
## CONTENTS

### PREFACE

- Preface xxvii
  - Change History xxvii
  - About This Guide xxxii
  - Audience xxxiii
  - Conventions xxxiii
  - Related Documents xxxiv
  - Documentation and Support xxxv
  - Documentation Feedback xxxv

### CHAPTER 1

- Unified CCX Introduction 1
  - Unified CCX Components 1
  - Unified CCX Product Family 2
    - Unified IP IVR 3
    - Unified Contact Center Express 3
  - Unified CCX Cluster Architecture 4
    - Unified CCX Active Server 5
  - Unified CCX Engine 6
  - Set Up Unified CCX 7
    - Provision Telephony and Media Subsystems 7
    - Configure Unified CCX Subsystems 7
      - Provision Unified CCX Subsystem 8
      - Provision Additional Unified CCX Subsystems 8
    - View License Information 9
    - Configure Unified CCX Applications 9
      - Available Applications 9
      - Manage Scripts Prompts, Grammars, and Documents 9
Cisco Applications Configuration 41
  About Unified CCX Applications 41
    Configure Script Applications 42
    Add New Cisco Script Application 43
    Configure Busy Application 45
    Configure Ring-No-Answer Application 46
  Application Triggers 47
    Unified CM Telephony Trigger 47
      Add Unified CM Telephony Triggers from Application Web Page 47
      Add Unified CM Telephony Triggers from Unified CCX 48
    HTTP Trigger Provision 48
      Add HTTP Trigger from Application Web Page 49
      Add HTTP Trigger from HTTP Subsystem 50
  Script Management 51
    Upload New Scripts 51
    Download Script File 53
    Refresh Scripts 53
      Refresh Scripts Individually 53
      Refresh Bulk Scripts 54
    Rename Script or Folder 55
    Delete Script or Folder 55
    Sample Scripts 56

Telephony and Media Provision 57
  Unified CCX Telephony and Media 57
    Media Termination Groups 58
    Channels Required to Process Calls 58
    Provision Telephony and Media Resources 59
  Provision Unified CM Telephony Subsystem 59
    Resynchronize Cisco JTAPI Client 60
    Resynchronize Unified CM Telephony Data 60
    Configure Unified CM Telephony Provider 61
    Add New Call Control Group 62
Add Unified CM Telephony Trigger 69
Additional Unified CM Telephony Information 73
Unified CM Telephony Triggers for Unified CCX Queuing 73
Unified CM Telephony Information Resynchronization 74
Cisco Media Subsystem 74
Add CMT Dialog Control Group 75
ASR and TTS in Unified CCX 76
Prepare to Provision ASR/TTS 76
Provision of MRCP ASR Subsystem 77
Provision MRCP ASR Providers 77
Provision MRCP ASR Servers 78
Provision MRCP ASR Dialog Groups 80
MRCP TTS Subsystem 82
Provision MRCP TTS Providers 82
Provision MRCP TTS Servers 83
Provision MRCP TTS Default Genders 85

CHAPTER 8

Provision of Unified CCX 87
RmCm Provider Configuration 87
RmCm Provider Modification 88
Associating Agent Extensions with the RmCm Provider 88
Resource Groups 89
Create Resource Group 89
Modify Resource Group Name 89
Delete Resource Group 90
Skills Configuration 90
Create a Skill 90
Modify a Skill Name 91
Delete a Skill 91
Agent Configuration 92
Implications of Deleting Agents in Unified CM 93
Assign Resource Groups and Skills to One Agent 93
Assign Resource Groups and Skills to Multiple Agents 95
Remove Skills from Agents 96
Upload Zip Files to Language Folder 123
Upload of Prompt Files 124
  Record a Prompt 125
  Add Spoken-Name Prompts 125
Management of Custom Files 126
  Specify Custom Classpath Entries 126
AAR File Management 127
AAR File Creation 128
Upload AAR Files 128
META-INF Directory 129
Directories for Prompts, Grammars, Documents, and Scripts 129
  Prompts Directory 130
  Grammars Directory 130
  Documents Directory 130
  Scripts Directory 130
AAR Manifest 130
Attribute Types 132
  Main Attributes 132
  Per-entry Attributes 134
  META-INF Directory Attributes 134

CHAPTER 11 Unified CCX System Management 137
  Basic Terminology 137
  High Availability and Automatic Failover 138
    Network Partitions 139
Unified CCX CDS Information Management 139
Manage System Parameters 139
Unified CCX IP Address/hostname Management 140
  Prepare System for IP Address/hostname Change 140
  IP Address Modification 142
    Change IP Address for Server in Single-Node Deployment 142
    IP Address Modification in High-Availability (HA) Deployment 144
  HostName and Domain Name Modification 148
    HostName Modification 148
Verify Proper Function of System after IP Address/hostname Change 154
Domain Name Modification 154
Set Up Certificates 156
Client Requirements 156
Deploy Root Certificate for Internet Explorer 157
Set Up CA Certificate for Internet Explorer and Edge Browsers 157
Set Up CA Certificate for Firefox Browser 157
Set Up CA Certificate for Chrome Browser 158
Exit Unified CCX Administration 158

CHAPTER 12

Unified CCX Reporting 161
Reporting Administration on Unified CCX 161
Import of Stock Reports 161
Unified CCX Historical Reports 161
Unified CCX Historical Datastore 162
Historical Reporting Configuration 162
Purge of Historical Data 163
File Restore 166
Unified CCX Real-Time Reports 167
Available Unified CCX Real-Time Reports 167
Open Real-Time Reports 168
Run Reports 169
View Detailed Subreports 169
Print Reports 170
Reset Report Statistics 170
Clear Contact Option for Stuck Calls 171
Set Report Options 171
Set Report Appearance 171
Application Reporting User Interface 172
Reporting Administration on Unified Intelligence Center 205
Start Unified Intelligence Center 205
Administrator Overview 206
Security Overview 206
User List 207
Modify Resource 290
Resource Group Configuration 291
Add New Resource Group 291
Modify Existing Resource Groups 291
Contact Service Queues Configuration 291
Add a CSQ 291
RmCm Provider Configuration 292
Skills Configuration Assignment 292
Add Skills 292
Remove Skills 292
Agent Based Routing Settings Configuration 292
Teams Configuration 292
Add New Team 293
Chat and Email Menu Options 293
Customer Collaboration Platform Configuration 293
Delete Customer Collaboration Platform Configuration 297
Reinject Email Contacts 298
Chat Transcripts 298
Mail Server Configuration 299
Contact Service Queues 300
Predefined Responses 303
Predefined Responses 303
Wrap-Up Reasons 305
Wrap-Up Reasons 305
Email Signatures 306
Email Signature Configuration 306
Channel Parameters 308
Chat Widgets 309
Chat Widgets Page 310
Chat Widget Configuration 310
Chat - Facebook Messenger 314
Teams 316
Outbound Menu 316
General Configuration 316
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Campaign Configuration</td>
<td>317</td>
</tr>
<tr>
<td>Add New Campaigns</td>
<td>317</td>
</tr>
<tr>
<td>Import Contacts</td>
<td>317</td>
</tr>
<tr>
<td>Delete Contacts</td>
<td>318</td>
</tr>
<tr>
<td>Area Code Management</td>
<td>318</td>
</tr>
<tr>
<td>Add New Area Code</td>
<td>318</td>
</tr>
<tr>
<td>Configure SIP Gateway</td>
<td>318</td>
</tr>
<tr>
<td>SIP Gateway Configuration Web Page</td>
<td>319</td>
</tr>
<tr>
<td>Dial Peer Configuration for Outbound</td>
<td>320</td>
</tr>
<tr>
<td>Database Menu</td>
<td>321</td>
</tr>
<tr>
<td>DataSource</td>
<td>322</td>
</tr>
<tr>
<td>New DataSource</td>
<td>322</td>
</tr>
<tr>
<td>Add New Database Parameter</td>
<td>322</td>
</tr>
<tr>
<td>Driver</td>
<td>322</td>
</tr>
<tr>
<td>Add New Database Driver</td>
<td>322</td>
</tr>
<tr>
<td>HTTP Menu</td>
<td>323</td>
</tr>
<tr>
<td>HTTP Trigger Configuration</td>
<td>323</td>
</tr>
<tr>
<td>Add New HTTP Trigger</td>
<td>323</td>
</tr>
<tr>
<td>eMail Menu</td>
<td>324</td>
</tr>
<tr>
<td>Cisco Media</td>
<td>324</td>
</tr>
<tr>
<td>MRCP ASR Menu</td>
<td>324</td>
</tr>
<tr>
<td>MRCP ASR Provider</td>
<td>325</td>
</tr>
<tr>
<td>MRCP ASR Servers</td>
<td>325</td>
</tr>
<tr>
<td>MRCP ASR Dialog Groups</td>
<td>325</td>
</tr>
<tr>
<td>MRCP TTS Menu</td>
<td>325</td>
</tr>
<tr>
<td>MRCP TTS Providers</td>
<td>325</td>
</tr>
<tr>
<td>MRCP TTS Servers</td>
<td>326</td>
</tr>
<tr>
<td>MRCP TTS Default Genders</td>
<td>326</td>
</tr>
<tr>
<td>Wizards Menu</td>
<td>327</td>
</tr>
<tr>
<td>Application Wizard</td>
<td>327</td>
</tr>
<tr>
<td>RmCm Wizard</td>
<td>328</td>
</tr>
<tr>
<td>Tools Menu</td>
<td>331</td>
</tr>
</tbody>
</table>
Plug-Ins Menu 331
Real-Time Reporting Tool 332
Real-Time Snapshot Config Menu 333
  Create System DSN for Wallboard 334
  Wallboard Software in High Availability (HA) Deployment 336
Historical Reporting Menu 337
  Database Server Configuration 337
  SMTP Configuration 338
  Purge Schedule Configuration Option 338
  Purge Now Option 338
  File Restore Option 339
User Management Menu 339
  User View Submenu 340
  Name Grammar Generator Configuration 340
  Spoken Name Upload Submenu 341
  Administrator Capability View Menu 341
  Supervisor Capability View 342
    Manage Supervisors 343
    View Supervisor Details 343
  Reporting Capability View Menu 344
    Assign Prompts 345
  Agent Capability View Menu 346
  Password Management 346

CHAPTER 20

Help Menu 349
  Contents and Index 349
  For This Page Menu 350
  Unified CCX Documentation Link 350
  About Menu 350

CHAPTER 21

Cisco Finesse 351
  Introduction 351
  Cisco Finesse Administration Console 351
    Getting Started 351
Add Phone Book 413
Edit Phone Book 414
Delete Phone Book 414
Import Contacts 414
Export Contacts 415
Add Contact 416
Edit Contact 416
Delete Contact 416
Manage Reasons 417
Not Ready Reason Codes 417
Sign Out Reason Codes 419
Predefined System Reason Codes 421
Manage Reason Code Conflicts During Upgrade 423
Wrap-Up Reasons 424
Manage Team Resources 426
Team Resources 426
Assign Phone Books and Reasons to Team 427
Unassign Phone Books and Reasons from Team 428
Assign Custom Desktop Layout to Team 428
Assign Workflows to Team 430
Unassign Workflows from Team 431
Manage Workflows 431
Workflows and Workflow Actions 431
Add Browser Pop Workflow Action 435
Add HTTP Request Workflow Action 436
Edit Workflow Action 438
Delete Workflow Action 438
Add Workflow 438
Edit Workflow 439
Delete Workflow 439
Manage Security 439
HTTPS Support 440
HSTS 440
Cross-Origin Resource Sharing (CORS) 440
Gadget Source Allowed List 440
Security Enhancements 441
Manage Finesse IP Phone Agent 441
Finesse IP Phone Agent 441
One Button Sign In 442
Finesse IP Phone Service Subscription Options 443
Set Up Application User, Web Access, and HTTPS Server Parameters 443
Configure Finesse IP Phone Service in Unified CM 445
Finesse IP Phone Agent Certificate Management 446
Add Service Parameters for One Button Sign In 448
Subscribe Agent Phones to Manual Subscription Service 450
Set Up Agent Access to the Self Care Portal 450
Cisco Finesse Failover Mechanisms 451
CTI Failover 451
Finesse Desktop Failover 452
Desktop Behavior 453
Finesse IP Phone Agent Failover 456
Guidelines for Optimal Desktop Failover 457
Failover Planning 459
Backup and Restore 460
Additional Language Support 460
Cisco Finesse Agent and Supervisor Desktop 460

CHAPTER 22  
CUIC Cluster Configuration 461
Cluster Configuration for JVM Using Hazelcast 461
Troubleshooting Cluster Configuration 463

CHAPTER 23  
Extend and Connect 465
Overview of Extend and Connect 465
Server Configuration 465
Persistant Connection 467

CHAPTER 24  
Cisco Unified CCX Serviceability 469
Cisco Unified CCX Serviceability 469
Access Cisco Unified CCX Serviceability  469
Alarms  470
  Alarm Configuration  470  
  Configure Alarm Settings  470
  Alarm Configuration Settings  471
Traces  472
  Component Trace Files  473
  Configure Trace Parameters  473
  Trace Level Options  476
  Trace file location  480
    Trace File Information  480
Log Profiles Management  481
  Create Profile  482
  Save as Another Profile  483
  Enable Profile  483
  Delete Profile  484
  Save Current Trace Settings  484
  Upload Profile  485
  Update Profile  485
Serviceability Tools  486
  Access Control Center — Network Services Menu  486
Network Services  487
  System Services  487
  Admin Services  488
  DB Services  488
  Finesse Services  488
Manage Network Services  488
Command Line Interface  489
Unified CCX Datastore  489
Network Outage  490
Datastore Replication Status  490
  Reset Replication Between Nodes  491
Datastores  492
Update Parameters  493
CHAPTER 25

Real-Time Monitoring 497

Installation and Configuration 497
Performance Monitoring 498
Performance Objects 498
Performance Counters 498
Performance Objects and Counters for Unified CCX 498
Critical Services 499
Tools 499
Alerts 499
Unified CCX Alerts 499
Cisco Identity Service Alerts 503
Syslog and Alert 504
Traces and Logs 505
Cloud Connect Serviceability 505
CUCM Telephony Data Monitoring 506
Triggers Page 506
Call Control Groups page 506
CTI Ports Page 507
Summary Page 507
Cisco Unified Analysis Manager 508
Unified Analysis Manager for Unified CCX 508

CHAPTER 26

Backup and Restore 511
Important Considerations 512
SFTP Requirements 513
Cipher Support 513
Master and Local Agents 514
Master Agent Duties 514
Local Agent Duties 514
Backup Tasks 514
Manage Backup Devices 515
Manage Backup Schedules 515
Perform Manual Backup  516
Check Backup Status  516
Restore Scenarios  516
  Restore SA or HA Setup (Without Rebuild)  517
  Restore SA Setup (with Rebuild)  518
  Restore Only First Node in HA Setup (with Rebuild)  519
  Restore Second Node in HA Setup (with Rebuild)  520
  Restore Both Nodes in HA Setup (with Rebuild)  521
Trace Files  522
Command Line Interface  522
Alarms  523

APPENDIX A

Command Line Interface  525
  Command Line Interface Basics  525
    Start CLI Session  525
    Get Help with Commands  526
    Exit Command with Ctrl-C Key Sequence  527
    End CLI Session  527
  Additional CLI Commands  527
    Show commands  528
      show uccx version  528
      show uccx jtapi_client version  529
      show uccx components  529
      show uccx subcomponents  530
      show uccx license  530
      show uccx trace levels  531
      show uccx provider ip axl  532
      show uccx provider ip jtapi  532
      show uccx provider ip rmcx  533
      show uccx trace file size  533
      show uccx trace file count  534
      show uccx livedata connections  534
      show tls server min-version  535
      show tls client min-version  535
show uccx tech dbserver all 536
show uccx tech dbserver log diagnostic 536
show uccx tech dbserver status 537
show uccx dbcontents 537
show uccx dbtable schema 538
show uccx dbschema 538
show uccx dbtable list 539
show uccx dsbserver disk 540
show uccx dsbserver sessions all 541
show uccx dsbserver session 542
show uccx dsbserver sessions list 543
show uccx dsbserver user list 544
show uccx dsbserver user waiting 545
show uccx tech dbserver log message 546
show uccx dbtable contents 546
show vmtools version 547
show uccx asr sessions 547
show uccx tts sessions 548

Set Commands 548
set uccx trace defaults 548
set uccx trace file size component size 549
set uccx trace file count component no-of-files 549
set uccx trace enable 550
set uccx trace disable 551
set password user security 552
set tls server min-version 552
set tls client min-version 553
set uccx provider ip axl 553
set uccx provider ip jtapi 554
set uccx provider ip rmcm 555
set uccx appadmin administrator 555
set authmode 556
set uccx asr count clear 556
set uccx tts count clear 557
run Commands  557
  run uccx hrdataexport  557
  run uccx sql database_name sql_query  558
  run uccx sp database_name sp_name  559

Utils Commands  560
  utils uccx notification-service log  560
  utils remote_account  561
  utils reset_application_ui_administrator_name  562
  utils reset_application_ui_administrator_password  562
  utils service  563
  utils system upgrade  565
  utils system switch-version  566
  utils uccx database dbserver integrity  566
  utils uccx list license  567
  utils uccx delete license licenseName  568
  utils uccx jtapi_client update  568
  utils uccx prepend custom_classpath  569
  utils uccx switch-version db-check  570
  utils uccx switch-version db-recover  570
  utils uccx syncusers  571
  utils uccx synctocuc  571
  utils uccx icd clid status  572
  utils uccx icd clid enable  572
  utils uccx icd clid disable  573
  utils uccx icd clid header  573
  utils uccx icd clid prefix  573
  utils uccx security_filter enable  574
  utils uccx security_filter disable  574
  utils uccx security_filter status  575
  utils uccx dbreplication dump configfiles  575
  utils uccx database healthcheck  576
  utils uccx database dbperf start  576
  utils uccx database dbperf stop  577
  utils ids sync-security-config  577
utils uccx healthcheck 578
utils cloudconnect start 582
utils cloudconnect stop 583
utils fips 583
  utils fips enable 584
  utils fips status 585
  utils fips disable 585
Enhanced Security Mode 586
File Commands 587
  file uccx view 587
  file uccx list custom_file 587
  file uccx list prompt_file 588
  file uccx get 589
  file uccx tail 590
  file uccx dump 590
  file uccx delete 591
High Availability Commands 591
  show uccx dbreplication tables 592
  show uccx dbreplication servers 593
  utils uccx modify remote_IPAddress 593
  utils uccx modify remote_hostname 594
  utils uccx database forcedatasync 594
  utils uccx setuppubrestore 595
  utils uccx dbreplication setup 595
  utils uccx dbreplication status 596
  utils uccx dbreplication templatestatus 597
  utils uccx dbreplication repair 597
  utils uccx dbreplication start 598
  utils uccx dbreplication stop 598
  utils uccx dbreplication reset 599
  utils uccx dbreplication teardown 599
Cisco Finesse Commands 600
  utils reset_3rdpartygadget_password 600
Cisco Finesse Trace Logging 601
Contents

Toaster Notifications  601
Finesse IPPA Inactivity Timeout  602
Supported Content Security Policy Directives  603
Finesse System Commands  604
Desktop Properties  605
  WebProxy Service  608
Service Properties  612
Cross-Origin Resource Sharing (CORS)  614
Gadget Source Allowed List  617
Log Collection Schedule  618
View Property  619
Update Property  619
Cisco Unified Intelligence Center Commands  620
  show cuic component-status  620
  show cuic properties  620
  show cuic tech  621
  show cuic trace  623
  set cuic properties  624
  unset cuic properties  624
  set cuic syslog  625
  set cuic trace  625
  utils cuic purge  626
  utils cuic user make-admin [user-name]  627
  utils cuic cluster show  628
  utils cuic cluster mode  628
  utils cuic cluster refresh  628
  utils cuic cors  628
  utils cuic logging list  630
  utils cuic logging config set  631
  utils cuic logging update  631
  utils cuic logging config show  631
  utils cuic logging reset  631
Cloud Connect  632
  utils cloudconnect list  632
Preface

• Change History, on page xxvii
• About This Guide, on page xxxii
• Audience, on page xxxiii
• Conventions, on page xxxiii
• Related Documents, on page xxxiv
• Documentation and Support, on page xxxv
• Documentation Feedback, on page xxxv

Change History

This table lists changes made to this guide. Most recent changes appear at the top.

<table>
<thead>
<tr>
<th>Change</th>
<th>See</th>
<th>Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>Added details about using License Control</td>
<td>System Menu&gt;License Management&gt;Smart License Management</td>
<td>July 2020</td>
</tr>
<tr>
<td></td>
<td>System Menu&gt;License Management:Register with Cisco Smart Software Manager</td>
<td></td>
</tr>
<tr>
<td>Introduced FIPS and added commands to use FIPS</td>
<td>Command Line Interface&gt;Utils Commands&gt;utils fips</td>
<td></td>
</tr>
<tr>
<td>Introduced Specific License Reservation Commands</td>
<td>Command Line Interface&gt;Specific License Reservation Commands</td>
<td></td>
</tr>
<tr>
<td>Added Finesse failover mechanisms.</td>
<td>Cisco Finesse&gt;&gt;Cisco Finesse Administration Console &gt;&gt; Cisco Finesse Failover Mechanisms</td>
<td>June 2020</td>
</tr>
<tr>
<td>Added Content Security Policy details.</td>
<td>Command Line Interface&gt;&gt;Cisco Finesse Commands&gt;&gt;Supported Content Security Policy Directives</td>
<td></td>
</tr>
<tr>
<td>Change</td>
<td>See</td>
<td>Date</td>
</tr>
<tr>
<td>----------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------</td>
<td>----------</td>
</tr>
<tr>
<td><strong>Updated Document for Release 12.5(1) SU1 EFT1</strong></td>
<td><strong>See</strong></td>
<td><strong>Date</strong></td>
</tr>
<tr>
<td>Updated the option <strong>Enable Cisco Webex Experience Management</strong></td>
<td><strong>Cisco Applications Configuration</strong></td>
<td><strong>May 2020</strong></td>
</tr>
<tr>
<td><strong>post-call survey</strong> to enable Experience Management**</td>
<td><strong>About Unified CCX</strong></td>
<td></td>
</tr>
<tr>
<td><strong>SMS/Email post-call survey.</strong></td>
<td><strong>Applications</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Add New Cisco Script Application</strong></td>
<td><strong>Add New Cisco Script Application</strong></td>
<td></td>
</tr>
<tr>
<td>Added new DTMF desktop behaviour CLI.</td>
<td><strong>Command Line Interface</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Cisco Finesse Commands</strong></td>
<td><strong>Cisco Finesse Commands</strong></td>
<td></td>
</tr>
<tr>
<td>Added new service property configuration CLI for port 5223.</td>
<td><strong>Desktop Properties</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Added Smart License Reservation Commands</strong></td>
<td><strong>Command Line Interface</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Smart License Reservation Commands</strong></td>
<td><strong>Smart License Reservation Commands</strong></td>
<td></td>
</tr>
<tr>
<td><strong>CommandLineInterface&gt;&gt;Smart License Reservation Commands</strong></td>
<td><strong>CommandLineInterface&gt;&gt;Smart License Reservation</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Command Line Interface&gt;&gt;Smart License Reservation</strong></td>
<td><strong>Command Line Interface&gt;&gt;Smart License Reservation</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Commands&gt;&gt;license smart reservation enable</strong></td>
<td><strong>Commands&gt;&gt;license smart reservation enable</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Commands&gt;&gt;license smart reservation request</strong></td>
<td><strong>Commands&gt;&gt;license smart reservation request</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Commands&gt;&gt;license smart reservation install</strong></td>
<td><strong>Commands&gt;&gt;license smart reservation install</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Commands&gt;&gt;license smart reservation return</strong></td>
<td><strong>Commands&gt;&gt;license smart reservation return</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Commands&gt;&gt;license smart reservation return-authorization</strong></td>
<td><strong>Commands&gt;&gt;license smart reservation return-authorization</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Commands&gt;&gt;license smart reservation cancel</strong></td>
<td><strong>Commands&gt;&gt;license smart reservation cancel</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Commands&gt;&gt;license smart reservation disable</strong></td>
<td><strong>Commands&gt;&gt;license smart reservation disable</strong></td>
<td></td>
</tr>
</tbody>
</table>
## Changes

<table>
<thead>
<tr>
<th>Change</th>
<th>See</th>
<th>Date</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Initial Release of Document for Release 12.5(1)</strong></td>
<td></td>
<td>January 2020</td>
</tr>
<tr>
<td>Cisco SocialMiner (SM) has been renamed as Customer Collaboration Platform (CCP).</td>
<td>Subsystems Menu &gt;&gt; Customer Collaboration Platform Configuration.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Subsystems Menu &gt;&gt; Delete Customer Collaboration Platform Configuration.</td>
<td></td>
</tr>
<tr>
<td>From this release, Context Service is not supported.</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>Added Cloud Connect server settings.</td>
<td>Cisco Finesse &gt;&gt; Cisco Finesse Administration Console &gt;&gt; Manage System Settings &gt;&gt; Cloud Connect Server Settings</td>
<td></td>
</tr>
<tr>
<td>Added keyboard shortcuts.</td>
<td>Cisco Finesse &gt;&gt; Cisco Finesse Administration Console &gt;&gt; Manage System Settings &gt;&gt; Keyboard Shortcuts</td>
<td></td>
</tr>
<tr>
<td>Added edit call variables.</td>
<td>Cisco Finesse &gt;&gt; Cisco Finesse Administration Console &gt;&gt; Manage Call Variables Layouts &gt;&gt; Call Variables &gt;&gt; Edit Call Variables</td>
<td></td>
</tr>
<tr>
<td>Added text and XML editors for Desktop Layout.</td>
<td>Cisco Finesse &gt;&gt; Cisco Finesse Administration Console &gt;&gt; Manage Desktop Layout &gt;&gt; Finesse Desktop Layout XML</td>
<td></td>
</tr>
<tr>
<td>Added desktop property customization.</td>
<td>Cisco Finesse &gt;&gt; Cisco Finesse Administration Console &gt;&gt; Manage Desktop Layout &gt;&gt; Customize Desktop Properties</td>
<td></td>
</tr>
<tr>
<td>Changed the phone book limits.</td>
<td>Cisco Finesse &gt;&gt; Cisco Finesse Administration Console &gt;&gt; Manage Phone Books &gt;&gt; Phone Books and Contacts</td>
<td></td>
</tr>
<tr>
<td>Added text and XML editors for Team Resources.</td>
<td>Cisco Finesse &gt;&gt; Cisco Finesse Administration Console &gt;&gt; Manage Team Resources &gt;&gt; Assign Custom Desktop Layout to Team</td>
<td></td>
</tr>
<tr>
<td>Added desktop properties customization at team level.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Change</td>
<td>See</td>
<td>Date</td>
</tr>
<tr>
<td>----------------------------------------------------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>-----------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Added security enhancements.</td>
<td>Cisco Finesse&gt;&gt;Cisco Finesse Administration Console&gt;&gt;Manage Security&gt;&gt;Security Enhancements</td>
<td></td>
</tr>
<tr>
<td>Added Finesse IP Phone agent certificate management.</td>
<td>Cisco Finesse&gt;&gt;Cisco Finesse Administration Console&gt;&gt;Manage Security&gt;&gt;Security Enhancements</td>
<td></td>
</tr>
<tr>
<td>Added new desktop property configuration CLIs.</td>
<td>Command Line Interface&gt;&gt;Cisco Finesse Commands&gt;&gt;Desktop Properties</td>
<td></td>
</tr>
<tr>
<td>Added new service property configuration CLIs.</td>
<td>Command Line Interface&gt;&gt;Cisco Finesse Commands&gt;&gt;Service Properties</td>
<td></td>
</tr>
<tr>
<td>Added a new section about recording a prompt.</td>
<td>Management of Prompts, Grammars, Documents, and Custom Files&gt;&gt;Upload of Prompt Files&gt;&gt;Record a Prompt</td>
<td></td>
</tr>
<tr>
<td>Added a new section for CORS.</td>
<td>Cisco Finesse&gt;&gt;Manage Security&gt;&gt;Cross-Origin Resource Sharing (CORS)</td>
<td></td>
</tr>
<tr>
<td>Added new commands for showing ASR and TTS sessions.</td>
<td>Command Line Interface&gt;&gt;Show commands&gt;&gt;show uccx asr sessions</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Command Line Interface&gt;&gt;Show commands&gt;&gt;show uccx tts sessions</td>
<td></td>
</tr>
<tr>
<td>Added new sections about licensing, which details about Classic Licensing and Smart Licensing.</td>
<td>System Menu&gt;&gt;License Information</td>
<td></td>
</tr>
<tr>
<td>Change</td>
<td>See</td>
<td>Date</td>
</tr>
<tr>
<td>----------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>Introduced SRTP and added information about enabling SRTP.</td>
<td>Provision Unified CM for Unified CCX &gt;&gt; Unified Communications Manager for Unified CCX Configuration &gt;&gt; Guidelines for Agent Phone Configuration</td>
<td></td>
</tr>
<tr>
<td></td>
<td>System Menu &gt;&gt; System Parameters</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Telephony and Media Provision &gt;&gt; ASR and TTS in Unified CCX &gt;&gt; Provision of MRCP ASR Subsystem &gt;&gt; Provision MRCP ASR Servers</td>
<td></td>
</tr>
<tr>
<td></td>
<td>System Menu &gt;&gt; System Parameters</td>
<td></td>
</tr>
<tr>
<td></td>
<td>MRCPv2 is now available for selection and the default port numbers for MRCP are updated.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>System Menu &gt;&gt; System Parameters</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Telephony and Media Provision &gt;&gt; ASR and TTS in Unified CCX &gt;&gt; MRCP TTS Subsystem &gt;&gt; Provision MRCP TTS Servers</td>
<td></td>
</tr>
<tr>
<td></td>
<td>System Menu &gt;&gt; System Parameters</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Bubble chat can be launched on any device and the display adapts to the screen size of the device used.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Appendix C &gt;&gt; Bubble Chat Experience</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Appendix A &gt;&gt; Command Line Interface</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Administrators can use the Unified CCX Health Check Utility to check the overall health of the Unified CCX system.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>System Menu &gt;&gt; System Parameters</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Subsystems Menu &gt;&gt; Delete Customer Collaboration Platform</td>
<td></td>
</tr>
<tr>
<td></td>
<td>System Menu &gt;&gt; License Management</td>
<td></td>
</tr>
<tr>
<td></td>
<td>System Menu &gt;&gt; Smart Licensing</td>
<td></td>
</tr>
<tr>
<td></td>
<td>System Menu &gt;&gt; Smart Licensing</td>
<td></td>
</tr>
<tr>
<td></td>
<td>When secure RTP is enabled, the signaling channel (JTAPI) between Unified CCX and Unified CM is also secured and encrypted.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Provision Unified CM for Unified CCX &gt;&gt; Modify AXL Information</td>
<td></td>
</tr>
</tbody>
</table>
About This Guide

Cisco Unified Contact Center Express (Unified CCX), a member of the Cisco Unified Communications family of products, manages customer voice contact centers for departments, branches, or small to medium-size companies planning to deploy an entry-level or mid-market contact center solution.

The *Cisco Unified CCX Administration Guide* provides instructions for using the Administration web interface to provision the subsystems of the Unified CCX package and to configure Unified CCX applications.

This guide shows you how to implement the following two systems that integrate with the Unified CCX:

- Cisco Unified Contact Center Express (Unified CCX)
- Cisco Unified IP IVR

This guide also includes a reference section that describes all the menus and menu options of the Unified CCX Administration web interface.

This guide will help you to:

- Perform initial configuration tasks
- Administer applications such as the Unified CCX Engine and other components of the Cisco Unified Communications family of products
- Familiarize yourself with the menus and menu options of the Unified CCX Administration web interface

<table>
<thead>
<tr>
<th>Change</th>
<th>See</th>
<th>Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>Only TLS 1.2 is supported.</td>
<td>Tools Menu&gt;&gt;Real-Time Reporting Tool</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Command Line Interface&gt;&gt;show tls server min-version</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Command Line Interface&gt;&gt;show tls client min-version</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Command Line Interface&gt;&gt;set tls server min-version</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Command Line Interface&gt;&gt;set tls client min-version</td>
<td></td>
</tr>
<tr>
<td>Introduced Webex Experience Management (WXM) Post-Call Survey.</td>
<td>Cisco Applications Configuration&gt;&gt;Add New Cisco Script Application</td>
<td></td>
</tr>
<tr>
<td>You can assign prompts to applications.</td>
<td>Tools Menu&gt;&gt;Assign Prompts</td>
<td></td>
</tr>
<tr>
<td>Introduced Docker Engine and Cisco Cloud Connect Container Manager.</td>
<td>Command Line Interface&gt;&gt;utils service</td>
<td></td>
</tr>
</tbody>
</table>
Audience

The Cisco Unified CCX Administration Guide is written for business analysts and application designers who have the domain-specific knowledge required to create multimedia and telephony customer response applications. Experience or training with Java is not required but is useful for making best use of the capabilities of the Cisco Unified Communications family of products.

Conventions

This manual uses the following conventions.

<table>
<thead>
<tr>
<th>Convention</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>boldface</strong> font</td>
<td>Boldface font is used to indicate commands, such as user entries, keys, buttons, and folder and submenu names. For example:</td>
</tr>
<tr>
<td></td>
<td>• Choose <strong>Edit &gt; Find</strong></td>
</tr>
<tr>
<td></td>
<td>• Click <strong>Finish</strong>.</td>
</tr>
<tr>
<td><strong>italic</strong> font</td>
<td>Italic font is used to indicate the following:</td>
</tr>
<tr>
<td></td>
<td>• To introduce a new term. Example: A <em>skill group</em> is a collection of agents who share similar skills.</td>
</tr>
<tr>
<td></td>
<td>• For emphasis. Example: <em>Do not</em> use the numerical naming convention.</td>
</tr>
<tr>
<td></td>
<td>• An argument for which you must supply values. Example:</td>
</tr>
<tr>
<td></td>
<td>IF <em>(condition, true-value, false-value)</em></td>
</tr>
<tr>
<td></td>
<td>• A book title. Example:</td>
</tr>
<tr>
<td></td>
<td>See the <em>Cisco Unified Contact Center Express Installation Guide</em>.</td>
</tr>
</tbody>
</table>
### Convention

<table>
<thead>
<tr>
<th>Convention</th>
<th>Description</th>
</tr>
</thead>
</table>
| **window font** | Window font, such as Courier, is used for the following:  
• Text as it appears in code or information that the system displays. Example:  
  `<html><title> Cisco Systems,Inc. </title></html>`  
• File names. Example: `tserver.properties`.  
• Directory paths. Example: `C:\Program Files\Adobe` |
| **string**      | Nonquoted sets of characters (strings) appear in regular font. Do not use quotation marks around a string or the string will include the quotation marks. |
| **[]**          | Optional elements appear in square brackets. |
| `{ x | y | z }`    | Alternative keywords are grouped in braces and separated by vertical bars. |
| `[ x | y | z ]`    | Optional alternative keywords are grouped in brackets and separated by vertical bars. |
| `<>`            | Angle brackets are used to indicate the following:  
• For arguments where the context does not allow italic, such as ASCII output.  
• A character string that the user enters but that does not appear on the window such as a password. |
| `^`             | The key labeled Control is represented in screen displays by the symbol ^. For example, the screen instruction to hold down the Control key while you press the D key appears as ^D. |

### Related Documents

<table>
<thead>
<tr>
<th>Document or Resource</th>
<th>Link</th>
</tr>
</thead>
</table>
### Document or Resource

<table>
<thead>
<tr>
<th>Document or Resource</th>
<th>Link</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Note</strong> From Unified CCX Release 12.5(1), CCP documents are available in the Cisco Unified CCX documentation folder.</td>
<td></td>
</tr>
</tbody>
</table>

### Documentation and Support


### Documentation Feedback

To provide your feedback for this document, send an email to: contactcenterproducts_docfeedback@cisco.com
Unified CCX Introduction

Unified CCX provides a multimedia (voice, data, and web) IP-enabled customer-care application environment that enhances the efficiency of contact centers by simplifying business integration, easing agent administration, increasing agent flexibility, and enhancing network hosting.

All configuration values in Unified CCX must be entered in English language unless explicitly mentioned on the administration screen.

The following sections provide an overview of the configuration and management components of the Unified CCX product family:

• Unified CCX Components, on page 1
• Unified CCX Product Family, on page 2
• Unified CCX Cluster Architecture, on page 4
• Unified CCX Engine, on page 6
• Set Up Unified CCX, on page 7
• Manage Unified CCX, on page 10

Unified CCX Components

This section describes the following components of the Unified CCX system:

• Unified Gateway—Connects the Cisco Unified Communications family of products to the Public Switched Telephone Network (PSTN) and to other private telephone systems such as PBX.

• Unified CM Server—The Cisco Unified Communications Manager (Unified CM) provides the features required to implement IP phones, manage gateways, provide failover and redundancy service for the telephony system, and direct Voice over IP (VoIP) traffic to the Unified CCX system.

  Note Cisco Unified Communications Manager was previously known as Unified Call Manager. This guide uses Cisco Unified Communications Manager at the first occurrence and Unified CM for later occurrences.

• Unified CCX Server—Contains the Unified CCX Engine that runs applications, including Cisco script applications, Busy applications, Ring No Answer applications, and Voice Extensible Markup Language (VXML) 2.0 applications.
You can position your Unified CCX application server anywhere on the IP network and administer your applications from a web browser on any computer on the IP network. Because Unified CCX uses an open architecture that supports industry standards, you can integrate your applications with a wide variety of technologies and products, such as Enterprise databases. The Unified CCX Server has the following components:

- **Unified CCX Configuration Datastore (CDS)**—Manages configuration, component, and application information within the Unified CCX cluster and communicates with Unified CM.

- **Historical Reports Database Server**—Dedicated server that stores Unified CCX database for the following datastores: Configuration Datastore (CDS), Historical Datastore (HDS), and Repository Datastore (RDS).

- **Cisco Customer Collaboration Platform**—Acts as the endpoint that hosts the widgets that end users and agents use during chat and email sessions. Customer Collaboration Platform accepts chat request, communicates with Unified CCX to allocate an agent for the chat and then establishes the chat session between agent and end user.

  Customer Collaboration Platform fetches email messages from the email server, communicates with Unified CCX to allocate an agent, and provides the email management user interface components via the Finesse desktop.

- **Unified CCX Editor**—Allows application developers to use a simple Graphical User Interface (GUI) to create, modify, and debug Unified CCX scripts for automating customer interactions. Each script consists of a series of steps, implemented as Java Beans.

- **Unified CCX Administration and Unified CCX Serviceability web interfaces**—Provides access through a web browser for administrators to configure and manage Unified CCX datastores, servers, and applications.

- **Cisco IP Agent and Supervisor Desktops**—Desktop programs that allow Unified CCX agents and supervisors to log in to the system, change agent states, and monitor status.

- **Media Resource Control Protocol (MRCP) Automatic Speech Recognition (ASR) server**—(optional) Dedicated server that performs real-time speech recognition.

- **MRCP Text-to-Speech (TTS) server**—(optional) Dedicated server that converts text into speech and plays it back to the caller.

---

**Note**

Support for high availability and remote servers is available only in multiple-server deployments.

- **Cisco Unified Intelligence Center**—A web-based reporting solution for historical reports that provides detailed Call Contact Call Detail Records (CCDRs), application performance, and traffic analysis information.

---

**Unified CCX Product Family**

The Unified CCX product family provides contact-processing functions for your Cisco Unified Communications solution.
The software package that you choose determines which steps, components, and subsystems you receive. Each Unified CCX product includes Unified CCX Engine and Unified CCX Editor.

**Unified IP IVR**

The Unified IP IVR is a multimedia (voice, data, web) IP-enabled interactive voice response solution that offers an open and feature-rich foundation for the creation and delivery of Unified IP IVR applications through Internet technology.

Unified IP IVR automates call handling by autonomously interacting with contacts. Using Unified IP IVR, you can create applications that answer calls, provide menu choices for callers, obtain caller data such as passwords or account identification, and transfer calls to caller-selected extensions. You can also create Unified IP IVR applications that respond to HTTP requests, perform outbound calling, send e-mail, and process VXML 2.0 commands.

The Unified IP IVR package provides the following features:

- **Java Database Connectivity (JDBC) support**—Unified IP IVR applications can access Oracle, Sybase, and IBM DB2 databases.
- **Real-time reporting client**—Unified IP IVR applications can generate a variety of reports that provide detailed information about the real-time status of your system.
- **Cisco Unified Intelligence Center**—A web-based reporting solution for historical reports that provides detailed Call Contact Call Detail Records (CCDRs), application performance, and traffic analysis information.
- **Automatic Speech Recognition (ASR)**—Unified IP IVR applications can take advantage of ASR to provide callers with the option to use speech to navigate through menu options.
- **Text-to-Speech (TTS)**—Unified IP IVR applications can use TTS to read back documents and prescribed prompts to callers.

**Unified Contact Center Express**

Cisco Unified Contact Center Express (Unified CCX) is an IP-based Automated Call Distribution (ACD) system that queues and distributes incoming calls to Unified CCX agents, who can be groups of Unified CM users for Unified CM integration.

You can use Unified CCX applications to route calls to specific agents. You can also integrate Unified CCX with Unified IP IVR to gather caller data and classify incoming calls.

Unified CCX includes a web-based real-time and historical reporting system that you can use to monitor system, Contact Service Queue (CSQ), and resource performance.

The Unified CCX system consists of the following major components:

- **Resource Manager**—Application program that monitors Unified CCX agent phones and allows you to organize agents into resource groups or skills-based partitions according to the types of calls each group can handle.
- **CSQ**—Application program that places incoming calls in a queue and distributes them to the appropriate set of agents as the agents become available.

The following licensing options are available for the Unified CCX system:
Unified CCX Premium—Adds full Unified IP IVR support (except for Unified ICM integration) including database integration, Voice eXtensible Markup Language (VoiceXML), HTML web integration, custom Java extensions, and e-Notification services. The outbound feature is now bundled with the Premium package. You will receive one outbound seat free with each premium seat. The maximum number of outbound seats supported will be based on the hardware type.

Unified CCX Outbound—You need to have a Unified CCX Outbound license in addition to a Unified CCX Premium license to enable the IVR and agent outbound feature. You can increase the number of ports and agents for an existing Outbound license. For all the IVR and agent based outbound campaigns that are running currently in your Unified CCX, the Display License submenu option displays these IVR ports and agent seats:

- The licensed IVR ports for outbound.
- The licensed agent seats for outbound.
- The sum of the dedicated IVR ports configured for IVR-based outbound campaigns.
- The agent seats that currently in use for agent-based outbound campaigns.

Note
The dedicated outbound IVR ports for a campaign is the number of IVR ports that you want to reserve for a campaign from the total number of CTI ports available in the outbound call control group.

Note
The Unified CCX Enhanced package and the Unified CCX Premium package are provisioned in the same way.

Unified CCX Cluster Architecture

Support for high availability and remote servers is available only in multiple-server deployments.

The Unified CCX cluster consists of one or more servers (nodes) that are running Unified CCX components in your Unified CCX deployment.

If you deploy Unified CCX components on a single server, the Unified CCX cluster (often referred to as cluster in this manual) consists of that server. If you deploy Unified CCX on multiple servers, the cluster includes the Unified CCX server and standby server on which you installed Unified CCX. The Unified CCX cluster can support up to two Unified CCX Servers, one designated as the active Unified CCX Server and the other designated as the standby Unified CCX Server for high availability purposes.

When you install or upgrade Unified CCX on a server, you designate the cluster to which the server will belong by designating the cluster profile for that cluster.

Cluster architecture accommodates high availability and failover because if a component fails, a secondary server will take over the functionality lost by that failed component.
All Unified CCX servers within the cluster are configured identically and installed with the same features. One server is designated the active server.

**Unified CCX Active Server**

*Note*
Support for high availability and remote servers is available only in multiple-server deployments.

The Unified CCX active server makes global decisions for the cluster and keeps track of calls in the CSQs, agent states (if Unified CCX is installed) and generating historical detail records.

*Note*
Only one server in the cluster can be the active server at any given time.

If the active server fails, the Unified CCX provides automatic failover to the standby server. If the active server fails (for example, in the event a hardware failure occurs or the Unified CCX Engine process terminates), some calls being handled by the server are lost. The lost calls are restricted to those being handled by the system (those in the IVR stage or in queue). Calls answered by agents continue to remain live even though related data on the agent desktop is lost. When the standby server takes over as the new active server, call processing continues.

A Unified CCX cluster consists of the one or more servers (nodes) that run Unified CCX components in your Unified CCX deployment.

Cluster management consists of two main elements:

**Cluster Manager**
Receives updates about cluster status and subsystem states.

**Cluster View Daemon (CVD)**
Java code that interacts with Platform Service Manager and implements internode communication on behalf of the cluster. It detects availability of the other nodes, components and services, provides consistent cluster view, and dynamically elects a master service.

*Figure 1: Components of the CVD Interaction with Nodes*

The following figure shows the components of the CVD interaction with nodes.

The CVD has two interfaces:
- One that monitors inside the node, using:
  - Node Manager to monitor and control local processes
• Cluster Manager publisher or subscriber to communicate with local applications, such as Engine and Application Administration

• One that monitors outside the node and communicates with other nodes in the cluster

**Related Topics**

[Unified CCX IP Address/hostname Management](#), on page 140

---

**Unified CCX Engine**

The Unified CCX Engine enables you to run multiple applications to handle Unified CM Telephony calls or HTTP requests.

The Unified CCX Engine uses the Unified CM Telephony subsystem to request and receive services from the Computer Telephony Interface (CTI) manager that controls Unified CM clusters. The Unified CCX Engine is implemented as a service that supports multiple applications.

You can use a web browser to administer the Unified CCX Engine and your Unified CCX applications from any computer on the network. Unified CCX provides you the following two web interfaces:

- **Unified CCX Administration web interface**—Used to configure system parameters, subsystems, view real-time reports that include total system activity and application statistics, and so on

- **Unified CCX Serviceability web interface**—Used to view alarm and trace definitions for Unified CCX services, start and stop the Unified CCX Engine, monitor Unified CCX Engine activity, and so on

---

**Note**

Ensure that the popup blocker is disabled on your browser.

Depending on the Unified CCX products that you are using, the Unified CCX server may employ as many as 14 subsystems for communicating with other services:

- **Applications**
  - Manages the applications in the Unified CCX Engine and other features such as session management.

- **Cisco Media**
  - Configures Cisco Media Termination (CMT) dialog control groups, which can be used to handle simple Dual Tone Multifrequency (DTMF)-based dialog interactions with customers.

- **Core Reporting**
  - Provides information for Unified IP IVR real-time reports.

- **Database**
  - Handles the connections between the Unified CCX server and the enterprise database.

- **eMail**
  - Adds components to the Unified CCX Engine that allows the engine to send email messages.

- **HTTP**
  - Adds components to the Unified CCX Engine that allow the engine to respond to HTTP requests.

- **ICM Subsystem**
  - Manages the connection between the Unified CCX server and ICM.

- **Unified CM Telephony**
  - Manages the connection between Unified CM CTI Manager and the Unified CCX Engine.

- **MRCP ASR**
  - Allows a script to respond to voice input in addition to DTMF using the MRCP protocol.
MRCP TTS
Composes voice prompts that are generated real-time from text, such as speaking the words in the text of an email message using the MRCP protocol.

Resource Manager-Contact Manager (RmCm)
Allows Unified CCX to monitor agent phones, control agent states, route and queue calls, and manage the historical reporting feature.

NonVoice Subsystem
Allows Unified CCX to configure and manage Chat and Email.

Voice Browser
Manages Voice Browser functionality.

Set Up Unified CCX

After you install the Unified CCX system and perform the initial setup as described in Cisco Unified Contact Center Express Installation Guide, you can start provisioning and configuring the system:

- **Provisioning** is the process of allocating resources and devising strategies for using the resources to support the needs of your business.
- **Configuring** is the process of making applications available to the Unified CCX system.

Provision Telephony and Media Subsystems

The Unified CCX telephony and media subsystems manage telephony and media resources and communicate with supporting telephony and media systems.

Depending on the Unified CCX applications you plan to use, you need to provision some or all of the following subsystems:

- **Unified CM Telephony**—The Unified CM Telephony subsystem controls the Unified CM Telephony resources for the Unified CCX system.

⚠️ **Caution**
While Unified CM supports Unicode characters in first and last names, those characters become corrupted in Unified CCX Administration web pages for Real-Time Reporting.

- **Cisco Media**—The Cisco Media subsystem controls the CMT media resources for the Unified CCX system.
- **MRCP ASR**—The MRCP ASR subsystem controls the ASR media resources for the Unified CCX system.
- **MRCP TTS**—The MRCP TTS subsystem controls the TTS media resources for the Unified CCX system.

Configure Unified CCX Subsystems

You need to provision your Unified CCX subsystems to enable the Unified CCX Engine to run multiple applications to handle Unified Communications calls or HTTP requests.
You need to configure a particular subsystem only if you are using Unified CCX applications that require it and which are installed and activated using the appropriate license.

To continue the Unified CCX system configuration process, connect to the Unified CCX Administration web interface and perform the task in the links listed in the Related Topics section.

**Provision Unified CCX Subsystem**

If you have purchased any of the three versions of Unified CCX, you must provision the Unified CCX subsystem.

Provision the following settings on the Unified CCX subsystem:

- **RmCm Provider**
  The Resource Manager (RM) of the Unified CCX system uses a Unified CM user (called a Unified CM Telephony provider) for monitoring agent phones, controlling agent states, and routing and queueing calls.

- **Resources**
  Agents that answer calls are also called *resources*. After you create a resource group, you must assign agents (resources) to that group.

- **Resource Groups**
  Collections of agents that your CSQ uses to handle incoming calls. To use resource group-based CSQs, you must specify a resource group.

- **Skills**
  Customer-definable labels that are assigned to agents. You can route incoming calls to agents who have the necessary skills or set of skills to handle the call.

- **CSQs**
  After you assign an agent to a resource group or assign skills to an agent, you need to configure the agent for the CSQ to which the agent will be assigned.

- **Agent-Based Routing Settings**
  You can configure Automatic Work and Wrapup Time settings for the agent-based routing feature from the Agent-Based Routing Settings page.

- **Teams**
  If you want to create or associate teams with various agents, CSQs, and supervisors, you need to configure team settings.

**Provision Additional Unified CCX Subsystems**

The additional Unified CCX subsystems provide HTTP, Database, and email features.

Provision the following subsystems:
• **HTTP**—The HTTP subsystem enables Unified CCX applications to respond to requests from a variety of web clients.

• **Database**—The Database subsystem enables Unified CCX applications to communicate with enterprise database servers.

• **eMail**—The eMail subsystem enables Unified CCX applications to create and send email.

### View License Information

The initial license configuration is part of the installation of Unified CCX. For more information on obtaining and installing licenses for Cisco Unified CCX, see *Cisco Unified Contact Center Express Install and Upgrade Guide*. For more information on licensing, see *License Management*, on page 268.

### Configure Unified CCX Applications

After you provision the Unified CCX subsystems and view your license information, you need to configure Unified CCX applications to interact with contacts and perform a wide variety of functions.

To continue the Unified CCX system configuration process, connect to the Unified CCX Administration web interface and manage the following tasks:

- **Available Applications**, on page 9

- **Manage Scripts Prompts, Grammars, and Documents**, on page 9

### Available Applications

There are several types of applications you can configure for Unified CCX:

- Script applications perform such functions as receiving calls, playing back prompts, receiving caller input, transferring calls, and queueing calls.

- The Busy application simulates a busy signal.

- The Ring-No-Answer application simulates a ringtone.

After adding a Unified CCX application, you need to define a *trigger* so that this application can respond to telephone calls and HTTP requests. Triggers are specified signals that invoke application scripts in response to incoming contacts.

### Manage Scripts Prompts, Grammars, and Documents

The process of configuring Cisco script applications includes uploading Unified CCX scripts and prerecorded prompts, installing grammars and customized languages, and adding triggers to applications.

Depending on your particular Unified CCX implementation, you may need to perform most or all of the following tasks to configure a Cisco script application:

- Manage scripts—Cisco script applications are based on scripts that you must upload to the repository and make available to the Unified CCX system.
• Manage prompts—Many applications make use of prerecorded prompts, stored as .wav files, which are played back to callers to provide information and elicit caller response. You must upload these .wav files to the repository and make them available to the Unified CCX system.

• Install grammars—A grammar is a specific set of all possible spoken phrases and Dual Tone Multi-Frequency (DTMF) digits to be recognized by Unified CCX applications and acted upon during run time. The Unified CCX system uses specific grammars when recognizing and responding to caller responses to prompts. You must store these grammars in a directory to make them available to the Unified CCX system.

• Install customized Unified CCX languages—Language packs, such as American English and Canadian French, are installed with Unified CCX.

Configure Unified CCX Historical Reporting

When you install the Unified CCX system, the installation process creates a database named db_cra. This database contains:

• Information for historical reports, including Unified CCX configuration information, stored procedures, and some call statistics
• The ContactCallDetail table, which is the main table for call statistics

To conclude the Unified CCX system configuration process, connect to the Unified CCX Administration web interface and perform the following Historical Reporting Configuration tasks:

Procedure

| Step 1 | Define the maximum number of database connections for report client sessions. |
| Step 2 | Assign historical reporting capability to users. |
| Step 3 | Configure the Daily Purge Schedule and specify notification parameters. |

Manage Unified CCX

To manage your Unified CCX, you must first provision and configure it. The day-to-day administration of the Unified CCX system and datastores consist of many tasks, such as:

• Starting and stopping the Unified CCX Engine and processes.
• Managing and monitoring the status of Unified CCX servers and components across the cluster.

Note Support for high availability and remote servers is available only in multiple-server deployments.
Unified CCX Administration Web Interface

The Unified CCX provides a multimedia (voice, data, and web) IP-enabled customer-care application environment, using VoIP technology that allows your Cisco Unified Communications network to share resources with your data network.

You can then use a web browser located on any computer on the IP network to configure and administer your applications with the Unified CCX Administration web interface.

Support for high availability and remote servers is available only in multiple-server deployments.

The Unified CCX Administration web interfaces (Cisco Unified CCX Administration and Cisco Unified CCX Serviceability) allows you to:

- Configure and monitor overall system functions, applications, and subsystems
- Access a wide variety of system tools
- Perform many other administrative tasks

The following sections provide more information about the Unified CCX Administration web interface:

- Access Unified CCX Administration Web Interface, on page 11
- Cisco Unified CCX Administration Menu Bar and Menus, on page 13
- Cisco Unified CCX Administration Navigation, on page 14
- Unified CCX Configuration Web Pages, on page 15

Access Unified CCX Administration Web Interface

The web pages of the Unified CCX Administration web interface allow you to configure and manage the Unified CCX system and its subsystems.

Use the following procedure to browse into the server and log in to Unified CCX Administration web interface.
Access Unified CCX Administration Web Interface

Procedure

Step 1  Open the Unified CCX Administration Authentication page from a web browser on any computer on your network and enter the following case-sensitive URL:

https://<servername>/appadmin

In this example, replace <servername> with the hostname or IP address of the required Unified CCX server.

A Security Alert dialog box is displayed.

Step 2  Click the appropriate button.

The Authentication page appears.

Note

• Ensure that Cisco Tomcat and Cisco Unified Cluster View Daemon services are running before you log in to the Unified CCX Administration using the URL in Step 1.

• Ensure that the popup blocker is disabled on your browser.

• If a custom message is set up in Cisco Unified OS Administration, the message appears in a pop-up window. You must acknowledge the message to log in. For more information about setting up custom messages, see the Set Up Customized Logon Message section in Cisco Unified Operating System Administration Guide for Cisco Unified CCX and Cisco Unified IP IVR.

Step 3  On the main Cisco Unified CCX Administration web page, enter your Unified CCX username and password.

Note  If you are accessing Unified CCX for the first time, enter the Application User credentials that are specified during installation of the Unified CCX. See the Cisco Unified Contact Center Express Install and Upgrade Guide for further instructions. The user ID is not case-sensitive in Unified CCX.

Step 4  Click Login.

A web page opens listing information about Cisco Unified CCX Administration and the Cisco Unified CCX Administration menu bar appears at the top of the page.
Unified CCX Administrationdetects web-based cross-site request forgery attacks and rejects malicious client requests. It displays the error message, "The attempted action is not allowed because it violates security policies."

- **Avoid using multiple sessions of the Unified CCX Administration at the same time.**

- To log in again to the Cisco Unified CCX Administration after you clicked **Logout** click the link, **Click here to log in again**.

- For a complete logout from all applications, sign out of the respective applications and close the browser window. In a Windows desktop, you may achieve this by logging out of the Windows account. In a Mac desktop, you may quit the browser application.

- Single Sign-On enabled agents have the risk of others misusing their account. If the browser is not closed completely the **Click here to log in again** link does not require the agent to enter credentials to log in to the application.

- The Unified CCX Administration interface and the Unified CCX User Options (appuser) web interface should not be logged into the same window on different tabs.

- To configure session-timeout, use the `set webapp session timeout` command. You can specify the session-timeout between 5 and 35000 minutes. For example, if you have configured session-timeout for 5 minutes, the user is logged out after a session is inactive for 5 minutes. The configuration is updated only on the node where the command is run. Ensure to run this command on both the nodes. You must reboot the node for the configuration to take effect.

---

**Cisco Unified CCX Administration Menu Bar and Menus**

The Cisco Unified CCX Administration menu bar appears at the top of every web page of the Unified CCX Administration web interface. You begin every Unified CCX configuration and administration task by choosing a menu and submenu option from the menu bar.

The Cisco Unified CCX Administration menu bar contains the following menu options:

- **System**—Contains options for configuring new servers in the cluster, Unified CM information, language information, changing system parameters, custom file configuration, standalone CUIC configuration, adding or displaying licenses, and single sign-on.

- **Applications**—Contains options for managing applications, scripts, prompts, grammars, documents, and AAR files.

- **Subsystems**—Contains options for configuring parameters for the subsystems that are licensed for your Unified CCX server. Your Subsystems menu may include submenu options for one or more of the following subsystems: Unified CM Telephony, Unified CCX, Database, HTTP, Chat and Email, Cisco Media, MRCP Automatic Speech Recognition (ASR), and MRCP Text-To-Speech (TTS).

- **Wizards**—Contains options that provide access to the following wizards of your Unified CCX server: Application and RmCm.

- **Tools**—Contains options that allow you to access system tools such as Plug-ins, Real-Time Reporting, Real-Time Snapshot Config. You can also assign access levels to administrators and supervisors and reset passwords.

---

**Note**

- Unified CCX Administration Menu Bar and Menus

---

**Cisco Unified CCX Administration Menu Bar and Menus**

The Cisco Unified CCX Administration menu bar appears at the top of every web page of the Unified CCX Administration web interface. You begin every Unified CCX configuration and administration task by choosing a menu and submenu option from the menu bar.

The Cisco Unified CCX Administration menu bar contains the following menu options:

- **System**—Contains options for configuring new servers in the cluster, Unified CM information, language information, changing system parameters, custom file configuration, standalone CUIC configuration, adding or displaying licenses, and single sign-on.

- **Applications**—Contains options for managing applications, scripts, prompts, grammars, documents, and AAR files.

- **Subsystems**—Contains options for configuring parameters for the subsystems that are licensed for your Unified CCX server. Your Subsystems menu may include submenu options for one or more of the following subsystems: Unified CM Telephony, Unified CCX, Database, HTTP, Chat and Email, Cisco Media, MRCP Automatic Speech Recognition (ASR), and MRCP Text-To-Speech (TTS).

- **Wizards**—Contains options that provide access to the following wizards of your Unified CCX server: Application and RmCm.

- **Tools**—Contains options that allow you to access system tools such as Plug-ins, Real-Time Reporting, Real-Time Snapshot Config. You can also assign access levels to administrators and supervisors and reset passwords.
• **Help**—Provides access to online help for Unified CCX.

## Cisco Unified CCX Administration Navigation

After you log in, the main Cisco Unified CCX Administration web page appears.

---

**Note**

The minimum supported screen resolution specifies 1024 x 768. Devices with lower screen resolutions may not display the applications correctly.

---

The choices in the drop-down list include the following Cisco Unified CCX Administration applications:

- **Cisco Unified CCX Administration** — Uses Cisco Unified CCX Administration to configure system parameters, subsystems, wizards, and much more.

- **Cisco Unified CCX Serviceability** — Takes you to the main Cisco Unified CCX Serviceability web page that is used to configure trace files, alarms, and to activate and deactivate services.

- **Cisco Finesse Administration** — Uses Cisco Finesse Administration to configure system settings in Cisco Finesse.

- **Cisco Unified Serviceability** — Takes you to the main Cisco Unified Serviceability web page that is used to save alarms and traces for troubleshooting, provide alarm message definitions, activate and deactivate services and so on.

- **Cisco Unified OS Administration** — Takes you to the main Cisco Unified OS Administration web page, so that you can configure and administer the Cisco Unified Communications platform.

- **Disaster Recovery System** — Takes you to the Cisco Disaster Recovery System, a program that provides data backup and restore capabilities for all servers in a Cisco Unified CCX Administration cluster.

- **Cisco Identity Service Management**— Takes you to the Identity Service Management page where the Identity Service configurations can be done.

You can log in to Cisco Unified CCX Administration either as an administration user or an application user.

---

**Note**

An administration user is an end user that is configured on the Unified CM with Administrator capability in Unified CCX.

An application user is an user that is configured during the installation of Unified CCX having administrator capability by default.

---

If you log in as an Administrator, you can access the following applications that display in the navigation drop-down list in the top right corner of the Administration menu bar:

- Cisco Unified CCX Administration
- Cisco Unified CCX Serviceability
- Cisco Finesse Administrator
• Cisco Identity Service Management

If you log in as an application user, you can seamlessly traverse between the Unified CCX web applications as well as the Cisco Identity Service Management and Cisco Unified Serviceability without logging in again.

Note  For security purposes, Cisco Unified CCX Administration and Cisco Unified CCX Serviceability logs you out after a configured session timeout for an inactive session and you must log back in. This session timeout can be configured using the platform based command line interface command `set webapp session timeout`. For more information on this command, see *Command Line Interface Reference Guide for Cisco Unified Communications Solutions* at https://www.cisco.com/c/en/us/support/unified-communications/unified-communications-manager-callmanager/products-maintenance-guides-list.html.

Note  An application user can log in to these four Unified CCX web applications even when Unified CM is down.

To access these applications from Cisco Unified CCX Administration, you must first choose the desired application from the navigation drop-down list in the upper right corner and click Go.

Note  Cisco Finesse Administration Console opens in a new tab or in a new window based on the browser settings.

To log in to Cisco Finesse Administration, you must be a user with administrator privileges.

When the Cisco Tomcat service is down on any of the Unified CCX nodes, you will not be able to launch Cisco Unified CCX Administration from any of the Unified CCX nodes; therefore, you will not be able to launch the Cisco Finesse Administration from within it.

In that case, you can launch the Cisco Finesse Administration directly from the browser.

To launch the Finesse Administration Console, direct your browser to `https://FQDN:8445/cfadmin`, where `FQDN` is the fully-qualified domain name of the server.

You can access the following platform-based web applications using the platform user credentials as configured during installation of Unified CCX:

• Cisco Unified Operating System Administration

• Disaster Recovery System

**Unified CCX Configuration Web Pages**

When you choose any menu and submenu option from the Unified CCX Administration menu bar, a configuration or administration web page opens. Use this web page to continue your configuration or administration task.

In some cases, you will perform your configuration or administration task on this one web page.
In other cases, the web page that first opens when you choose a submenu item leads to a series of web pages. For example, the Unified CM Telephony Call Control Group Configuration web page contains both a tool bar in the top with a few icons that link to other web pages and a configuration area.

The following table describes the **Refresh All** button and the **Copy**, **Delete**, and **Refresh** icons that are found on several Unified CCX web pages.

<table>
<thead>
<tr>
<th>Icon/Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy</td>
<td>Click this icon to copy the information in that specific row. <strong>Note</strong> When you click <strong>Copy</strong>, the web page displays the copied configuration so you can make changes, if desired.</td>
</tr>
<tr>
<td>Delete</td>
<td>Click this icon to delete the information in that specific row.</td>
</tr>
<tr>
<td>Refresh</td>
<td>Click this icon to refresh the information in that specific row.</td>
</tr>
<tr>
<td>Refresh All</td>
<td>Click this button to refresh the information listed on this page.</td>
</tr>
</tbody>
</table>

**Details for Advanced Configuration**

In Unified CCX Administration web interface, advanced configuration with **Show More** and **Show Less** options exists. On the applicable pages, all configuration details can be displayed or minimised based on user preferences and requirements.

A page by default displays fewer parameters. Parameters configured with default values and not requiring modification or user input are now available in the advanced configuration section. You can access this advanced configuration section by clicking the **Show More** button at the bottom of the page. When you click this button, the extra parameters become visible and the button changes to **Show Less**. When you click **Show Less**, the page reverts to its original list of parameters.

**Note** If you are using Unified CCX with Cisco Contact Center Gateway solution, see the *Cisco IPCC Gateway Deployment Guide for Cisco Unified ICME/CCE/CCX*. The instructions for configuring Unified CCX with that solution differs from what is described in this guide. The Unified Gateway provides for the integration of the Unified ICME system with Unified CCX by way of Unified Gateway. For more information, see the *Cisco Unified Contact Center Enterprise Install and Upgrade* guides available at [https://www.cisco.com/en/US/products/sw/custcosw/ps1844/prod_installation_guides_list.html](https://www.cisco.com/en/US/products/sw/custcosw/ps1844/prod_installation_guides_list.html). The Unified Gateway is a Peripheral Gateway (PG), which you configure on the Unified ICME software.

**Toolbar and Buttons**

On the top left toolbar of many web pages, you will find an **Add New** icon and the same **Add New** will also be displayed as a button at the bottom of the web page.
For example, the Unified CM Telephony Call Control Group Configuration web page contains Add New and Refresh All icons on the top left toolbar and the same are displayed as buttons at the bottom of the web page. When you click the Add New icon or button, another Unified CM Telephony Call Control Group Configuration web page opens. Use this area to add a new Unified CM Telephony Call Control Group.

Many web pages contain icons or buttons that perform a variety of functions. For example, the Refresh All button on the Unified CM Telephony Call Control Group Configuration web page refreshes all the Unified CM Telephony call control group configurations in the Unified CCX server.

A few web pages (for example, Subsystems > Database > Parameters page) also contain a Reset to Default icon and button. This allows you to revert to the software set defaults for each parameter on this page.

**Application and RmCm Wizards**

In Unified CCX, two wizards are available in the main menu: the Application Wizard and the RmCm Wizard. To improve the usability and configuration process, these wizards take you through the configuration pages in the required order and help ease the configuration process for these two features. You can access these wizards from a new main menu option called Wizards.
CHAPTER 3

Unified CCX Provision Checklist

The Cisco Unified Communications Manager (CM) product supports both single-node and two-node (high availability) deployments available for the Cisco Unified Contact Center Express (CCX).

The deployment model is transparent to the Unified CCX installer as the clustering for Unified CM is performed through the Unified CCX Administration using the Unified CCX setup wizard. The high availability over WAN feature of Unified CCX is supported only for Unified CM deployments.

The following topics introduce the Unified CCX subsystem and explain how to modify the Unified CM information from Unified CCX.

• Unified CCX, on page 19
• Provision Unified CCX, on page 20
• Change Licensing Packages, on page 21

Unified CCX

The Unified CCX system uses the Unified CCX subsystem as part of an ACD system to provide resource distribution and queueing to call centers.

Two types of routing are available:

• Contact Service Queue (CSQ)-based routing—CSQs are entities that route calls to your resources (agents). Each CSQ controls incoming calls and determines where an incoming call is placed in the queue and to which agent the call is sent.

  Each CSQ selects resources from an associated resource pool that you define or from resource skills for all Unified CCX license packages. When an agent becomes available to take a call, the system chooses a queued call from one of the CSQs whose resource pool includes the agent, and routes that call to that agent.

• Agent-based routing—Agent-based routing provides the ability to send a call to a specific agent, rather than any agent available in a CSQ.

A Unified CCX agent can participate in both CSQ-based and agent-based routing. A Unified CCX agent can be any one of the following:

• Cisco Finesse
• IP Phone Agent
• Extension Mobility (EM) Agent
• Supervisor (if the supervisor is taking calls)

A supervisor who is not taking calls is not considered to be an agent.

Calls are queued in the Unified CCX server and sent to agents by the Unified CCX server.

The machine you install your Unified CCX system on determines how many agents and IVR ports Unified CCX can accommodate. However, be aware of the following general configuration rules:

• Each agent cannot be associated with more than:
  • 25 CSQs (This is a configuration design guideline; Unified CCX Administration does not enforce the rule.)
  • 50 skills (Unified CCX Administration enforces this rule.)

• Each CSQ cannot be associated with more than 50 skills. (Unified CCX Administration enforces this rule.)

• A call should not queue for more than 25 CSQs. (This is a configuration design guideline; Unified CCX Administration does not enforce the rule.)

**Provision Unified CCX**

To provision Unified CCX, complete the following tasks:

<table>
<thead>
<tr>
<th>Step</th>
<th>Task</th>
<th>Unified CM</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>Configure Unified CM users who will be agents in your Unified CCX system.</td>
<td>Provision Unified CM for Unified CCX, on page 23</td>
</tr>
<tr>
<td>Step 2</td>
<td>Provision resources information for Unified CCX telephony and media.</td>
<td>Provision Unified CM Telephony Subsystem, on page 59</td>
</tr>
<tr>
<td>Step 3</td>
<td>Provision RmCm Provider to allow RmCm Subsystem to be in service.</td>
<td>RmCm Provider Configuration, on page 87</td>
</tr>
<tr>
<td>Step 4</td>
<td>Create resource groups.</td>
<td>Resource Groups, on page 89</td>
</tr>
<tr>
<td>Step 5</td>
<td>Create skills.</td>
<td>Skills Configuration, on page 90</td>
</tr>
<tr>
<td>Step 6</td>
<td>Assign agents to resource groups and assign skills to agents.</td>
<td>Agent Configuration, on page 92</td>
</tr>
<tr>
<td>Step 7</td>
<td>Create Contact Service Queues.</td>
<td>Contact Service Queue Configuration, on page 96</td>
</tr>
<tr>
<td>Step 9</td>
<td>Provision agent-based routing—if using Unified CCX Enhanced or Premium.</td>
<td>Configure Agent-Based Routing, on page 104</td>
</tr>
</tbody>
</table>
Change Licensing Packages

Now, the Unified CCX system can be upgraded from Enhanced to Premium.

While upgrading the licenses, you need to configure the following system parameters:

- **Enhanced to Premium**—You need to configure the Number of Direct Preview Outbound Seats while upgrading to a Premium license.

**Note**
Downgrade of license is not supported in Unified CCX.

**Procedure**

Choose **System > System Parameters** from the Cisco Unified CCX Administration menu bar to open the System Parameters Configuration web page where you can update these values.
CHAPTER 4

Provision Unified CM for Unified CCX

When you access Unified CCX Administration for the first time in a cluster, the system automatically initiates the cluster setup procedure once for each cluster to perform the following tasks:

- Identify Unified CCX license files
- Enter information about Unified CM Administrative XML Layer (AXL) and Unified CM Telephony and RmCm providers

You can modify the Unified CM information from Unified CCX. See the _Cisco Unified Contact Center Express Install and Upgrade Guide_ for detailed information on how to perform the initial system setup using the Unified CCX Administration web interface.

The following topics explain how to modify the Unified CM information from Unified CCX:

- Configure Unified Communications Manager Information, on page 23
- Unified Communications Manager for Unified CCX Configuration, on page 28

Configure Unified Communications Manager Information

During initial setup of Unified CCX using the Unified CCX Administration web interface, the administrator who installed the Unified CCX should have already provided the Unified Communications Manager IP address and hostname(s). Upload the Cisco Unified Communications Manager Tomcat certificate from Cisco Unified Communications Manager (CUCM) into the Unified CCX Tomcat trust store using the Cisco Unified OS Administration interface. The administrator must also provide the Administrative XML Layer (AXL) authentication (user ID and password) information.

The Unified Communications Manager Configuration web page allows you to configure and update the AXL authentication information, Unified Communications Manager Telephony subsystem information, and RmCm Provider configuration information from within Unified CCX.

This page has three blocks of information: AXL service details, Unified Communications Manager Telephony Provider details, and RmCm Provider details.

If the same user ID (Application User in CUCM) is used as CUCM admin and is also configured as AXL user in Unified CCX, the user ID may get locked if wrong password is used multiple times to login to CUCM. If the user ID gets locked, you will not be able send AXL requests such as, Create Call Control groups, Triggers, and so on from Unified CCX to CUCM. The best practice is to create AXL specific admin credentials.
Modify AXL Information

To change previously configured AXL information, complete the following steps.

Procedure

Step 1
From the Unified CCX Administration menu bar, choose System > Cisco Unified CM Configuration.

The Cisco Unified Communications Manager Configuration web page opens.

Step 2
Go to the AXL Service Provider Configuration section to modify the AXL information using the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AXL Service Provider</td>
<td>List of AXL service providers that are configured. You can have a maximum of two AXL service providers in the list. Select one or both the AXL service providers and click the right arrow to remove them from the selected list. The removed AXL Service Providers are moved to the available list for future use. Arrange the order of the selected entries using the up and down arrows.</td>
</tr>
<tr>
<td>Available AXL Service</td>
<td>List of AXL service providers that are available in the Unified CM cluster. Select one or two AXL service providers and click the Left arrow to add them to the selected list. Make sure you configure multiple AXL providers running the AXL Service for a redundant system.</td>
</tr>
<tr>
<td>Service Providers</td>
<td></td>
</tr>
<tr>
<td>Cluster Wide Parameters</td>
<td>The Unified Communications Manager User ID. This information is provided during cluster setup in the Unified CCX installation process. When you select an AXL Service Provider, the corresponding username is automatically displayed in this field. This is a mandatory field.</td>
</tr>
<tr>
<td>User Name</td>
<td></td>
</tr>
</tbody>
</table>
Password

Description
Password for the Unified Communications Manager User ID. This information is provided during cluster setup in the Unified CCX installation process. When you select an AXL Service Provider, the corresponding user password is automatically displayed in this field. This is a mandatory field.

Step 3
After logging in to the Unified CCX Administration web interface, follow these steps to update the AXL password:

a) Log in to Unified Communications Manager Administration web interface and update the password for the application user (AXL provider).

b) Navigate back to System > Cisco Unified CM Configuration web page of Unified CCX and enter the new password in the Password field.

A dialog box prompts you to confirm the AXL username and password. Reenter the AXL user ID and password and click Login.

The system validates the data and takes you back to the Unified Communications Manager configuration page.

c) Enter the updated password once again to validate and click Update.

The AXL password is updated successfully and you should be able to log in to Unified CCX Administration web interface of Unified CCX with the new AXL password.

Step 4
Click Update at the top of the Cisco Unified Communications Manager Configuration web page or the Update button that displays at the bottom of the web page to save the changes. The Unified Communications Manager Configuration web page refreshes to display the new settings.

The selected AXL services are now enabled. If the selected AXL services cannot be enabled, an error message instructs you to reselect AXL service providers.

Modify Unified Communications Manager Telephony Information

Note
The Unified Communications Manager Telephony client is installed in the background after you configure the Unified Communications Manager Telephony user. The Unified Communications Manager Telephony client runs in the background and verifies that the right version and the right client are installed.

Configuring the Unified Communications Manager Telephony user does not automatically install the Unified Communications Manager Telephony client. This is normally done during activation of Unified CCX Engine in component activation (see Cisco Unified Contact Center Express Serviceability Administration Guide). To install it manually, go to Subsystems > Unified CM Telephony and select the Cisco JTAPI Resync submenu option from the Unified CCX Administration menu bar.

The updated list of CTI Managers within a cluster are listed in this section. If for any reason the Unified Communications Manager is not functioning or if the Unified CCX cannot connect to the Unified Communications Manager, information that is obtained from the most recent connection is saved as part of the bootstrap information.
To change previously configured Unified Communications Manager Telephony information, complete the following steps.

**Procedure**

**Step 1** From the Unified CCX Administration menu bar, choose System > Unified CM Configuration.

The Cisco Unified Communications Manager Configuration page opens.

**Step 2** Scroll down to the Unified CM Telephony Subsystem - Unified CM Telephony Provider Configuration section and reconfigure the Unified Communications Manager Telephony information using the following fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Unified CM Telephony Subsystem—Unified CM Telephony Provider Configuration</strong></td>
<td></td>
</tr>
<tr>
<td>Selected CTI Managers</td>
<td>Lists the CTI Managers that are configured. You can have a maximum of two CTI Managers in the list. Select one or both the CTI Managers and click the right arrow to remove them from the selected list. The removed CTI Managers are moved to the available list for future use. Arrange the order of the selected entries using the up and down arrows. <strong>Note</strong> SRTP settings remain unchanged, even if the <strong>Selected CTI Managers</strong> are changed.</td>
</tr>
<tr>
<td>Available CTI Managers</td>
<td>Lists the CTI Managers that are available in the Unified CM cluster. Select one or two CTI Managers and click the Left arrow to add them to the selected list.</td>
</tr>
<tr>
<td><strong>Cluster Wide Parameters</strong></td>
<td></td>
</tr>
</tbody>
</table>
| User Prefix                                | The syntax of the User ID is: `<userprefix>_<nodeid>`  
For example, if you set this field to **cti_user**, the User ID for Node 1 will be **cti_user_1**. This is a mandatory field. |
| Password                                   | Password that you defined for the User ID in Unified Communications Manager.  
If a CTI Manager is already selected, the corresponding password is displayed in this field. This is a mandatory field. |
| Confirm Password                           | Reenter the password that you provided in the Password field. This is a mandatory field. |

**Step 3** Click **Update** at the top of the Cisco Unified Communications Manager Configuration page or click the **Update** button that displays at the bottom of the web page to save the changes.
The Unified Communications Manager Configuration web page refreshes to display the new settings. The newly selected CTI Manager is now enabled. If the selected CTI Manager cannot be enabled, an error message instructs you to reselect CTI Managers.

Note In a HA over WAN deployment of Unified CCX, the JTAPI user will be created only for the selected node. To create JTAPI user for the HA node, you have to explicitly select the HA node, make necessary updates, and click Update.

---

**Modify RmCm Provider Information**

The list of all CTI Managers available in a cluster are saved as part of the bootstrap information. You can select any available CTI Managers listed in the Available CTI Managers list box in this page.

Note The RmCm Provider specified through the Unified CCX Administration is automatically created in Unified Communications Manager. You do not need to use the Unified Communications Manager web interface to create the user.

Note To change previously configured RmCm provider information or to configure a new RmCm Provider, complete the following steps.

**Procedure**

**Step 1** From the Unified CCX Administration menu bar, choose System > Unified CM Configuration. The Unified Communications Manager Configuration web page opens.

**Step 2** Scroll down to RmCm Subsystem - RmCm Provider Configuration and reconfigure the selected CTI Manager using the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>RmCm Subsystems—RmCm Provider Configuration</strong></td>
<td></td>
</tr>
<tr>
<td>Selected CTI Managers</td>
<td>Lists the CTI Managers that are configured. You can have a maximum of two CTI Managers in the list. Select one or both the CTI Managers and click the right arrow to remove them from the selected list. The removed CTI Managers are moved to the available list for future use. Arrange the order of the selected entries using the up and down arrows.</td>
</tr>
<tr>
<td>Available CTI Managers</td>
<td>Lists the CTI Managers that are available in the Unified CM cluster. Select one or two CTI Managers and click the Left arrow to add them to the selected list.</td>
</tr>
</tbody>
</table>
Unified Communications Manager for Unified CCX Configuration

To enable Unified CCX to communicate with Unified Communications Manager, you also need to assign extensions for the users who will be agents in your Unified CCX system.

**Note**

If you delete a Unified CCX user with Administrative rights from Unified Communications Manager, you can still log in to the Unified CCX Administration web interface as an application user.

**Note**

Q Signaling (QSIG) and Path Replacement (PR) features of Unified Communications Manager are not supported by Unified CCX.

Invoke Unified Communications Manager Administration

Begin the process of configuring Unified Communications Manager by connecting to the Unified Communications Manager Administration web interface.
To connect to the Unified Communications Manager Administration web interface, complete the following steps.

Procedure

Step 1
From a web browser on any computer on your network, enter the following URL:
In this example, servername is the hostname or IP address of your Unified Communications Manager server.
A Security Alert dialog box is displayed.

Step 2
Click the appropriate button.

Step 3
At the main Cisco Unified Communications Manager Administration web page, enter the Unified Communications Manager username and password, and then click Login.
The Unified Communications Manager Administration web page appears.
You are now ready to use the Unified Communications Manager Administration web interface to configure users for Unified CCX.

Unified Communications Manager Users as Unified CCX Agents

Warning
Do not configure Unified Communications Manager users having the same username/password as the application administration credentials (configured during installation). Doing so may restrict the Unified Communications Manager when shared across multiple Unified CCX servers.

Note
When there is a change in the configuration data on the Unified Communications Manager, the team configuration is lost on the Unified CCX. You must reconfigure the teams in the Unified CCX or restore data from DRS.

Agent ID
When logging in to the desktop, agents use the Unified Communications Manager user ID and password. Unified Communications Manager limits agent IDs to 128 alphanumeric characters, but Unified CCX limits the agent IDs to 31 alphanumeric characters.

Attention
Unified Communications Manager user ID should not exceed 31 alpha-numeric characters. If user ID exceeds 31 alphanumeric characters, Unified CCX does not synchronize users from Unified Communications Manager.

Agent Name
Agent name includes the first name and last name. The following is the limit for agent name in Unified CCX:
• English-based script (German, Spanish, English, and so on)—50 characters
• Non-English script (Arabic, Chinese, Cyrillic, and so on)—16 characters

If the agent name exceeds the limit, Unified CCX truncates the name to 50 or 16 characters respectively and stores.

RmCm uses the Unified Communications Manager database to determine which devices it can control and provides an interface method for getting the Media Access Control (MAC) address of the calling party.

After you install RmCm, you get access to the Unified Communications Manager database. The database stores parameters that initialize Unified Communications Manager Telephony, user profiles, application logic, network-specific configuration information, and Directory Number Associations such as Primary Extension and Unified CCX Extension.

The Primary Extension field represents the primary directory number for the end user. End users can have multiple lines on their phones. From the drop-down list box, choose a primary extension when associating devices for this end user.

Unified CCX Extension allows you to define Unified Communications Manager users as Unified CCX agents in Unified Communications Manager.

To assign Unified CCX devices to end users and application users in the Unified Communications Manager, these users must first exist in Unified Communications Manager. If these users do not exist, you must first add the users. See the Cisco Unified Communications Manager Administration Guide to obtain detailed information about the Unified CCX web interface and configuration procedures. After adding the end user and the application user, be sure to modify their Unified CCX settings.

Agents and Supervisors with IDs That Match Reserved Words Cannot Sign In

Do not use the following reserved words for agent ID or supervisor ID because these IDs conflict with system account names that are used internally within the Unified CCX server:

<table>
<thead>
<tr>
<th>System\Components</th>
<th>Reserved words</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unified CCX Web Chat</td>
<td>admin</td>
</tr>
<tr>
<td>Cisco Finesse</td>
<td>admin</td>
</tr>
<tr>
<td></td>
<td>finesse</td>
</tr>
<tr>
<td></td>
<td>fippa</td>
</tr>
<tr>
<td></td>
<td>xmpprootowner</td>
</tr>
<tr>
<td></td>
<td>presencelistener</td>
</tr>
</tbody>
</table>

If a user tries to sign in with a reserved word for the agent ID or supervisor ID, the sign-in fails.

Do not use the reserved words for IDs whether they are upper case, lower-case, or any combination of both cases. For example, admin, ADMIN, or Admin.
Guidelines for Agent Phone Configuration

Follow these guidelines when configuring agent phones for Unified CCX agents:

- Choose Device > Phone in Unified Communications Manager Administration. The Find and List Phones window is displayed.

Enter search criteria to locate a specific phone and click Find. A list of phones that match the search criteria is displayed. Click the device name of the phone to which you want to add a directory number. The Phone Configuration window is displayed.

In the Unified Communications Manager Administration Phone Configuration web page, select the required Association Information (on the left) to get to the Directory Number Configuration web page. On this page, make the following changes:

- In the Multiple Call/Call Waiting Settings section, set the Maximum Number of Calls to 2 (default is 4) for Cisco Unified IP Phones 7900 Series and 3 for Cisco Unified IP Phones 8961, 9951, and 9971.

  Note
  If you are using Cisco Finesse for your agent desktop, you must set the Maximum Number of Calls to 2 for all agent phones.

- In the Multiple Call/Call Waiting Settings section, set the Busy Trigger value to 1 (default is 2).

- In the Call Forward and Call Pickup Settings section, verify that you do not forward any Unified Communications Manager device to the Unified CCX extension of an agent.

- In the Call Forward and Call Pickup Settings section, verify that you do not configure the Unified CCX extension of an agent to forward to a Unified CCX route point.

- Secure Real-Time Transport Protocol (SRTP) based recording is now supported. You can disable Secure Real-Time Transport Protocol (SRTP) when configuring a Cisco Unified Communications product. You can disable SRTP for a specified device or for the entire Unified Communications Manager:

  - For a specified device—Choose Device > Phone. In the Find and List Phone page, select the required phone device. In the Phone Configuration page for the selected phone, scroll down to the Protocol Specific Information section. To turn off SRTP on the phone device, select any one of the Non Secure SCCP Profile auth by choices from the drop-down list in SCCP Phone Security Profile or SCCP Device Security Profile field.

  - For the entire Unified Communications Manager cluster—Choose System > Enterprise Parameters. In the Enterprise Parameters Configuration page, scroll down to the Securities Parameters section, to verify that the corresponding value for the Cluster Security Mode field is 0. This parameter indicates the security mode of the cluster. A value of 0 indicates that phones will register in nonsecure mode (no security).

- The Unified CCX extension for the agent must be listed within the top 4 extensions on the device profile. Listing the extension from position 5 on will cause Unified CCX to fail to monitor the device, so the agent will not be able to log in.

- Do not forward any Unified Communications Manager device to the Unified CCX extension of an agent.

- Do not configure the Unified CCX extension of an agent to forward to a Unified CCX route point.
• Do not use characters other than the numerals 0 to 9 in the Unified CCX extension of an agent.

• Do not configure two lines on an agent phone with the same extension when both lines exist in different partitions.

• Do not assign a Unified CCX extension to multiple devices.

• Do not configure the same Unified CCX extension in more than one device or device profile. (Configuring a Unified CCX extension in one device or device profile is supported.)

• To use Cisco Unified IP Phones 9900 Series, 8900 Series, and 6900 Series as agent devices, the RmCm application user in Unified Communications Manager needs to have “Allow device with connected transfer/conference” option assigned to itself.

To determine a list of Unified CCX agent devices supported by Cisco Finesse Desktop, see the Unified CCX Compatibility related information, located at: https://www.cisco.com/c/en/us/support/customer-collaboration/unified-contact-center-express/products-device-support-tables-list.html.

**Modify Existing Unified Communications Manager Users**

To use any version of Unified Communications Manager, you must first ensure that you define Unified Communications Manager users as Unified CCX agents in Unified Communications Manager. After you perform this task, these Unified CCX agents can be combined into Resource Groups, assigned Skills, and placed in CSQs.

---

**Note**  
In Unified CCX, this operation is called “associating a device.”

---

**Note**  
Be sure to assign Unified CCX devices to both end users and application users in the Unified Communications Manager web interface.

---

To assign devices to an end user, you must access the End User Configuration window for that user. The End User Configuration window in Unified Communications Manager Administration allows the administrator to add, search, display, and maintain information about Unified Communications Manager end users.

To assign devices to an application user, you must access the Application User Configuration window for that user. The Application User Configuration window in Unified Communications Manager Administration allows the administrator to add, search, display, and maintain information about Unified Communications Manager application users.

---

**Note**  
If Enterprise Mobility (EM) is used together with both Cisco Unified Communications Manager release 8.0 or later and Cisco Unified Communications Manager, the Resource Manager application user must be associated with the device profile and not with the device.

---

To modify the Unified CCX Extension settings for existing Unified Communications Manager users who are Unified CCX agents, complete the following steps:
If you change or update an end user ID in Unified Communications Manager, Unified CCX resets the end user's resource name, skills, and team to default values.

Procedure

Step 1
Connect to the Unified Communications Manager Administration web interface.
The Unified Communications Manager Administration web page appears.

Step 2
Choose User Management > End User.
The Find and List End Users page displays. Use the two drop-down list to search for an end user.

Tip
To find all end users that are registered in the database, click Find without entering any search text. A list of discovered end users is displayed. Then, skip to Step 6.

Step 3
From the first Find end user where drop-down list, choose one of the listed criteria.

Step 4
From the second Find end user where drop-down list, choose one of the listed criteria.

Step 5
Specify the appropriate search text, if applicable, and click Find.
A list of discovered end users is displayed.

Step 6
From the list of records, click the end user name that matches your search criteria.
The End User Configuration page opens, displaying the configuration information for the end user that you chose.

Step 7
In the Controlled Devices list box below the Device Information section, select the device and click the Down arrow below the Available Profiles list box. If the device that you want to associate with this end user is not displayed in this pane, do the following to associate devices with an end user:

a) From the Device Information pane, click Device Association. The User Device Association page opens.

b) Finding a Device: Because you may have several devices in your network, Cisco Unified Communications Manager lets you locate specific devices on the basis of specific criteria. Click Find. All or matching records are displayed. You can change the number of items that is displayed in each page by choosing a different value from the Rows per Page drop-down.

c) Associating a Device: From the Device association for (this particular end user) pane, choose the devices that you want to associate with this end user by checking the box to the left of the device names. You can also use the buttons at the bottom of the window to select and deselect devices to associate with the end user.

d) To complete the association, click Save Selected/Changes.

e) From Related Links drop-down list in the upper right corner of the web page, choose Back to User, and click Go.

The End User Configuration page is displayed, and the associated devices that you chose are displayed in the Controlled Devices pane.

Step 8
Select the required device and save your changes to associate that device with this end user.

After the device is associated, the Controlled Devices field displays the description information (for example, the MAC address) that the end user controls.
Step 9 In the End User Configuration page, scroll down to the **Directory Number Associations** section.

Step 10 In the **Primary Extension** field drop-down list and the **IPCC Extension** field drop-down list, choose the required agent extension for this device.

These fields represent the primary directory number for the end user. End users can have multiple lines on their phones. If you have a single line, be sure to select the same extension for both fields.

Step 11 Click **Update** to apply the changes.

The specific End User Information page for this user appears, with the message that the update was successful.

Step 12 From the Unified Communications Manager Administration menu bar, choose **User Management > Application User**. RmCm Providers are referred to as application users in Unified Communications Manager.

**Note** When you associate one device with the Unified CCX agent (end user), you must also be sure to associate the same device with the Unified CCX RmCm Provider (application user).

The Find and List Application Users window is displayed. Use the two drop-down list to search for the application users in Unified Communications Manager.

**Tip** To find all application users registered in the database, click **Find** without entering any search text. A list of discovered end users is displayed. Then, skip to Step 16.

Step 13 From the first Find application user where drop-down list, choose one of the listed criteria.

Step 14 From the second Find application user where drop-down list, choose one of the listed criteria.

Step 15 Specify the appropriate search text, if applicable, and click **Find**.

A list of discovered application users is displayed.

Step 16 From the list of records, click the application user name that matches your search criteria.

The window displays the application user that you choose.

Step 17 Repeat Step 7 and Step 8 for the selected Application User.

These steps ensure that the Unified Communications Manager application users are also defined as Unified CCX agents in Unified Communications Manager.

Step 18 Click **Update** to apply the changes.

The specific Application Information page for this user appears, with the message that the update was successful.

See the “User Management Configuration” section in the *Cisco Unified Communications Manager Administration Guide* for detailed information on how to configure an end user and application user using Unified Communications Manager.

Now that you have defined the agent in Unified Communications Manager, you can configure agents in Unified CCX. Before you configure the agent, you will also need to configure resource groups and CSQs.
Assign Unified Communications Manager Users as Cisco TelePresence Virtual Agents

The Cisco TelePresence application enables enterprises to create a live, face-to-face interaction with customers over the network. This solution allows rapid deployment of a virtual contact center infrastructure. Agents using Cisco TelePresence are referred to as virtual agents in this guide. Virtual agents connect to callers using Unified CCX, which incorporates ACD, CTI, and Unified IP IVR with Cisco Unified Communications Manager and providing the entire solution on one server.


The following guidelines apply for the Cisco TelePresence integration with Unified CCX:

• The only commonly supported codec for Unified CCX and Cisco TelePresence is G711.

• The following supervisor features are not supported:
  • Monitoring and Recording is not supported for Cisco TelePresence integration with Unified CCX.

Follow this procedure to assign Unified Communications Manager users as virtual agents:

**Procedure**

**Step 1** Identify the required Cisco TelePresence system that will participate as a virtual agent in the Unified CCX application.
   a) Note the Unified Communications Manager extension of the Cisco TelePresence deployment.
      **Note** The Cisco Unified IP Phone 7970G and Cisco TelePresence system must be assigned the same extension in Unified Communications Manager, because they both share the same line.
   b) Note the MAC address or the Directory Number of the Cisco Unified IP Phone 7970G connected to the identified Cisco TelePresence system.
      **Tip** From the Unified CCX perspective, this is another SIP endpoint.

**Step 2** Associate the Cisco Unified IP Phone 7970G with the Unified Communications Manager user to configure this user as a virtual agent.

**Step 3** Associate the Cisco Unified IP Phone 7970G with the RmCm provider.
   **Note** Do not associate the corresponding Cisco TelePresence system with the RmCm provider.

**Configure Tool for Auto-Registered Phones Support (TAPS)**

The Tool for Auto-Registered Phone Support (TAPS) loads a preconfigured phone setting on a phone. The TAPS works in conjunction with the Bulk Administration Tool (BAT). After the BAT is used to bulk add
phones with dummy MAC addresses to Cisco Unified Communications Manager Administration, you can plug the phones into the network.

The administrator or users can then dial a TAPS directory number that causes the phone to download its configuration. At the same time, the phone gets updated in the Unified Communications Manager database with the correct MAC address of the phone. Refer to Configuring the Bulk Administration Tool (BAT) if you are not familiar with the BAT.

For the TAPS to function, you must make sure that Auto-registration is enabled in Cisco Unified Communications Manager Administration (select System > Cisco Unified CM). Follow the instructions in the procedure below to install and configure TAPS application with Unified CCX.

Procedure

| Step 1 | Log in to Cisco Unified Communications Manager Administration and choose Application > Plugins from the Cisco Unified Communications Manager Administration menu bar. |
| Step 2 | In the Find and List Plugins web page, search for “Cisco TAPS” and click Find. |
| Step 3 | Download the TAPS_AAR.aar file to your client PC, which is used for accessing Unified Communications Manager Administration and Unified CCX Administration. |
| Step 5 | After installing Unified CCX, follow these steps from the User Configuration page in Unified CCX Administration: |
| a) | In the Cisco Unified Communications Manager Users list, select the Cisco Unified Communications Manager user whom you want to designate as the Cisco Unified CCX administrator and who can configure TAPS. |
| b) | Click the left arrow (<) to move the selected user to the Cisco Unified CCX Administrator list. |
| c) | Click Finish. The Cisco Unified CCX Setup Result Information window is displayed. This window confirms the result of the initial setup. The Cisco Unified CCX engine will restart. |
| d) | Close your web browser. |
| Step 6 | Log in to Cisco Unified CCX Administration as the Unified CCX application administrator, who can configure TAPS. After installing and configuring Unified CCX and Unified Communications Manager, follow this procedure to set up TAPS: |
| a) | From the Unified CCX Administration menu bar, choose Applications > AAR Management. Click Browse and upload the TAPS_AAR.aar file that you downloaded in Step 3 from Unified Communications Manager. On successful upload, you will see a confirmation message in the status bar at the top of the AAR Management web page. |
| Note | For TAPS configuration, you need to restart the Unified CCX engine and Unified CCX Cluster View Daemon (CVD). You can restart the CVD using the CLI command, \texttt{utils service service name stop/start}. |
| b) | After restarting the CVD, log in once again to Cisco Unified CCX Administration as the Unified CCX application administrator. From the Unified CCX Administration menu bar, choose Subsystems > Unified CM Telephony > Call Control Group. Click Add New and provide the Call Control Group Configuration values for TAPS using the following fields: |
| • Group ID |
• Number of CTI Ports
• Media Termination Support
• Device Name Prefix
• Starting Directory Number

c) From the Unified CCX Administration menu bar, choose Subsystems > Cisco Unified CM Telephony > Triggers. Click Add New and specify values for the following mandatory fields:

• Directory Number
• Language
• Application Name
• Device Name
• Description
• Call Control Group:

The call control group types can be Inbound or Outbound for Unified CCX running with Unified Communications Manager.

d) Choose Subsystems > Cisco Unified CM Telephony > Data Resync from the Cisco Unified CCX Administration menu bar to check and resynchronize the JTAPI data between Cisco Unified Communications Manager and Cisco Unified CCX.

e) From the Unified CCX Administration menu bar, choose Applications > Application Management. The Application Management web page opens, displaying the details of existing applications.

f) Click the Add New icon or button. The Add a New Application web page opens.

g) From the Application Type drop-down menu, choose Cisco Script Application and click Next. The Cisco Script Application configuration web page opens.

h) In the Script field, select the script “/TAPS.aef” from the drop-down list and enter the IP address of the Cisco Unified Communications Manager in the text box below the Script drop-down list.

i) Check the check box against Cisco_Unified_CM_IP_Address field.

j) Click the Yes radio button in the Enabled field.

k) Click Update.

l) Log in to Cisco Unified Communications Manager Serviceability Page and restart the TAPS Service.
Configure Tool for Auto-Registered Phones Support (TAPS)
Update Unified CM IP Address Change in Unified CCX

- Update Unified CM IP Address Change in Unified CCX, on page 39

### Update Unified CM IP Address Change in Unified CCX

The following section details the procedure to update any change in Unified CM IP Address in Unified CCX.

**Note**

Unified CCX supports changing one or more IP addresses of Unified CM servers but does not support changing the Unified CM cluster.

**Procedure**

Run the following CLI commands on the Unified CCX publisher using the new IP address of Unified CM as input.

- **set uccx provider ip axl** - Sets the Unified CCX AXL provider IP address.
- **set uccx provider ip jtapi** - Sets the Unified CCX JTAPI provider IP address.
- **set uccx provider ip rmcm** - Sets the Unified CCX Resource Manager-Contact Manager provider IP address.

**Note**

After you run the above CLI commands, restart the Unified CCX Engine service on the publisher node. After Unified CCX Engine service starts successfully, restart Cisco Tomcat.
Cisco Applications Configuration

The Unified CCX system uses applications to interact with contacts and perform a wide variety of functions, such as prompting callers for information, transferring calls, and providing information to callers.

To configure Unified CCX applications, you must complete the following tasks:

• Provision telephony and media resources (see Telephony and Media Provision, on page 57)
• Provision your Unified CCX subsystem, if required (see Provision of Unified CCX, on page 87)
• Provision additional subsystems, if required (see Provision of Additional Subsystems, on page 109)

The following sections describe how to configure applications and make them available to the Unified CCX system.

• About Unified CCX Applications, on page 41
• Application Triggers, on page 47
• Script Management, on page 51

About Unified CCX Applications

The Unified CCX system uses applications to interact with contacts and perform a wide variety of functions.

Note
Unified CCX licenses you purchase and install determine the applications available on your system.

Unified CCX provides the following application types:

• Script
• Busy
• Ring-No-Answer
Configure Script Applications

The Unified CCX script applications are applications based on scripts created in the Unified CCX Editor. These applications come with every Unified CCX system and execute scripts created in the Unified CCX Editor.

Use the Unified CCX Editor to create scripts that direct the Unified CCX system to automatically answer calls and other types of contacts, prompt callers for information, accept caller input, queue calls, distribute calls to available agents, place outbound calls, respond to HTTP requests, and send email messages.

Note

The Unified CCX system includes a number of sample scripts. For a description of these sample scripts, and for more information on creating scripts with the Unified CCX Editor, see the Cisco Unified Contact Center Express Getting Started with Scripts. In addition, a script repository is available at https://www.cisco.com/en/US/products/sw/custcosw/ps1846/products_implementation_design_guides_list.html. This repository provides some examples of scripting techniques that can leverage Unified CCX abilities.

Tip

Upload these components to the repository before you configure a Cisco script application that uses them.

Depending on your particular Unified CCX implementation, you may need to perform most or all of the following tasks to configure a Cisco script application:

• Manage scripts—Cisco script applications are based on scripts that you must upload to the repository and make available to the Unified CCX system.

• Manage prompts—Many applications make use of prerecorded prompts, stored as .wav files, which are played back to callers to provide information and elicit caller response. You must upload these .wav files to the repository and make them available to the Unified CCX system.

• Install grammars—The Unified CCX system uses specific grammars to recognize and respond to caller response to prompts. You must store these grammars in a directory to make them available to the Unified CCX system.

Unified CCX support only W3C XML grammar for speech recognition with Nuance adapter. The following XML and regular expression (regex) grammars are supported:

• Nuance extensions for XML grammar.

• regex grammar for DTMF input.

• Install customized Unified CCX languages—Language packs, such as American English, Canadian French, and so on, are installed with Unified CCX. You install language packs in a directory accessible by the Unified CCX system.

• Install Java files—In addition to the Java files automatically installed as part of the Unified CCX installation process, you can install your own custom classes and Java Archive (JAR) files to customize the performance of your Unified CCX system.
• Add a Cisco script application—Scripts created in the Unified CCX Editor are used as the basis for Cisco script applications.

• Add an application trigger—Triggers are specified signals that invoke application scripts in response to incoming contacts. After adding a new Cisco script application, you need to add a trigger so that this application can respond to telephone calls and HTTP requests.

Add New Cisco Script Application

To add a new Cisco script application, complete the following steps:

Procedure

Step 1  From the Unified CCX Administration menu bar, choose Applications > Application Management. The Application Management web page opens, displaying the details of any existing applications.

Step 2  Click Add New icon that is displayed in the tool bar in the upper left corner of the window or the Add New button that is displayed at the bottom of the window. The Add a New Application web page opens.

Step 3  From the Application Type drop-down menu, choose Cisco Script Application and click Next. The Cisco Script Application configuration Web page opens.

Step 4  Specify the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>A name for the application. This is a mandatory field.</td>
</tr>
<tr>
<td>ID</td>
<td>Accept the automatically-generated ID, or enter a unique ID. This is a mandatory field.</td>
</tr>
<tr>
<td></td>
<td>Note The Historical Reporting feature uses this ID to identify this application.</td>
</tr>
<tr>
<td>Maximum Number Of Sessions</td>
<td>The maximum number of simultaneous sessions (instances) that the application can handle. This is a mandatory field.</td>
</tr>
</tbody>
</table>
### Add New Cisco Script Application

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Script</td>
<td><strong>Note</strong> This field is available only for Cisco Script Application type. This is a mandatory field.</td>
</tr>
<tr>
<td></td>
<td>Perform one of the following actions:</td>
</tr>
<tr>
<td></td>
<td>• Choose a script from the drop-down list to run the application. If the script contains parameters, the parameters are displayed below the Script drop-down menu. Each parameter has a check box, which enables you to override the default value for that parameter. If you want to override the value, check the check box for that parameter.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong> All scripts under the default directory are listed in the drop-down list of the Script field in the Cisco Script Application Configuration web page.</td>
</tr>
<tr>
<td></td>
<td>• Click <strong>Edit</strong>, enter the script name in the dialog box, and click <strong>OK</strong>. The User Prompt dialog box closes, and the name you entered appears in the Script field.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong> If you enter the script name as a file URL, enter the value with double backslashes (\). For example, file://c:\temp\aa.aef</td>
</tr>
<tr>
<td>Description</td>
<td>Use the Tab key to automatically populate this field.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong> For the Busy and Ring-No-Answer application types, this field is visible only when you click <strong>Show More</strong>.</td>
</tr>
<tr>
<td>Enabled</td>
<td>Click the required radio button to accept (<strong>Yes</strong> = default) or reject (<strong>No</strong>)</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong> For the Busy and Ring-No-Answer application types, this field is visible only when you click <strong>Show More</strong>.</td>
</tr>
<tr>
<td>Enable Cisco Webex Experience Management post-call survey</td>
<td>This field is not enabled by default. For the procedure to enable the Cisco Webex Experience Management post-call survey and information about the script variables required for Cisco Webex Experience Management post-call survey, see <em>Cisco Unified Contact Center Express Features Guide</em>.</td>
</tr>
<tr>
<td></td>
<td>After you select the <strong>Enable Cisco Webex Experience Management post-call survey</strong> check box:</td>
</tr>
<tr>
<td></td>
<td>• If you want to play the inline survey to the customer, then select the <strong>IVR</strong> option and select the survey from the drop-down list.</td>
</tr>
<tr>
<td></td>
<td>• If you want to provide an offline SMS/Email survey to the customer:</td>
</tr>
<tr>
<td></td>
<td>• Select the <strong>SMS/Email</strong> option and select the survey from the drop-down list. After you select the survey, the associated questionnaire and associated channels are displayed. The associated channels can be sms, email, or both.</td>
</tr>
<tr>
<td></td>
<td>• Ensure that the script selected for the application has all the variables required for SMS/Email survey to work. Select the check box <strong>All the variables required for the survey have been defined in the script</strong>.</td>
</tr>
</tbody>
</table>

---

**Cisco Unified Contact Center Express Administration and Operations Guide, Release 12.5(1)**

44
Step 5  Click Add.

The Cisco Script Application page is refreshed, the Add New Trigger hyperlink appears in the left navigation bar, and the following message is displayed in the status bar on top:

The operation has been executed successfully.

Click Back to Application List icon or button to view the list of existing applications.

Step 6  Add a trigger for the application.

Configure Busy Application

The Cisco Busy application comes with each Unified CCX system. This application returns a busy signal when a call reaches a Computer Telephony Interface (CTI) route point and the extension is busy.

Before you begin

To configure the Busy application, you will need to perform the following tasks:

• Add the Busy application.
• Add a Unified CM Telephony trigger to the Busy application. The Busy application is activated when it is triggered by a Unified CM Telephony trigger. The Busy application does not support HTTP triggers.

To configure the Unified CCX server with the Busy application, complete the following steps.

Procedure

Step 1  From the Unified CCX Administration menu bar, choose Applications > Application Management.

The Application Management web page opens, displaying the details of existing applications, if any.

Step 2  Click Add New icon that displays in the tool bar in the upper, left corner of the window or the Add New button that is displayed at the bottom of the window.

The Add a New Application web page opens.

Step 3  From the Application Type drop-down menu, choose Busy, and then click Next.

The Busy Application Configuration web page appears.

Step 4  Specify the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>A name for the application. This is a mandatory field.</td>
</tr>
<tr>
<td>ID</td>
<td>Accept the automatically-generated ID, or enter a unique ID. This is a mandatory field.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong> The Historical Reporting feature uses this ID to identify this application.</td>
</tr>
<tr>
<td>Maximum Number Of Sessions</td>
<td>The maximum amount of simultaneous sessions (instances) that the application can handle.</td>
</tr>
</tbody>
</table>
Step 5
Click Add.

The Busy web page refreshes, the Add New Trigger hyperlink appears in the left navigation bar, and the following message is displayed in the status bar on top:

The operation has been executed successfully

Step 6
Add a trigger for the application.

Configure Ring-No-Answer Application

The Cisco Ring-No-Answer application comes with each Unified CCX system. This application returns a ring tone signal when a call reaches a CTI route point.

Before you begin
To configure the Ring-No-Answer application, you will need to perform the following tasks:

- Add the Ring-No-Answer application.
- Add a Unified CM Telephony trigger to the Ring-No-Answer application. The Ring-No-Answer application is activated when it is triggered by a Unified CM Telephony trigger.

To configure the Unified CCX server with the Ring-No-Answer application, complete the following steps:

Procedure

Step 1
From the Unified CCX Administration menu bar, choose Applications > Application Management.
The Application Management web page opens, displaying the details of existing applications, if any.

Step 2
Click Add New icon that is displayed in the tool bar in the upper, left corner of the window or the Add New button that is displayed at the bottom of the window.

Step 3
From the Application Type drop-down menu, choose Ring-No-Answer, and then click Next.
The Ring-No-Answer web page opens.

Step 4
Specify the following fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>A name for the application. This is a mandatory field.</td>
</tr>
</tbody>
</table>
### Application Triggers

After adding a new Cisco application, you need to add one or more triggers so that the application can respond to Unified CM Telephony calls and HTTP requests.

Triggers are specified signals that invoke application scripts in response to incoming contacts. The Unified CCX system uses Unified CM Telephony triggers to trigger responses to telephone calls and HTTP triggers to respond to HTTP requests.

You can use either of the below two methods to add a trigger to an application:

- Add the trigger from the Cisco Application web page or add the trigger from the Unified CM Telephony.
- HTTP Triggers web pages available from the Subsystem menu.

#### Unified CM Telephony Trigger

You must add Unified CM Telephony triggers to invoke Cisco applications in response to incoming contacts.

A Unified CM Telephony trigger responds to calls that arrive on a specific route point by selecting telephony and media resources to serve the call and invoking an application script to handle the call.

#### Add Unified CM Telephony Triggers from Application Web Page

To add a Unified CM Telephony trigger directly from the Cisco Application Configuration web page, complete the following steps.
Add Unified CM Telephony Triggers from Unified CCX

To add a Unified CM Telephony trigger to an application from the Unified CM Telephony subsystem, complete the following steps.

Procedure

Step 1  From the Unified CCX Administration menu bar, choose Subsystems > Unified CM Telephony > Triggers. The Unified CM Telephony Trigger Configuration summary web page opens.

Step 2  Click the Add New icon that is displayed in the tool bar in the upper, left corner of the window or the Add New button that is displayed at the bottom of the window.

Step 3  The Cisco Unified CM Telephony Trigger Configuration web page opens. Follow the procedure described in Add Unified CM Telephony Trigger, on page 69 (Steps 3 and 4) for detailed instructions on adding and configuring a Unified CM Telephony trigger.

Note  For triggers created in Unified CCX, Unified CM will always show the IPv4 Address of the CTI Route point, as the IP address is of the primary node or the first node in the Unified CCX cluster.

Related Topics

Add Unified CM Telephony Trigger, on page 69

HTTP Trigger Provision

A Cisco application can be used to handle HTTP requests when the Unified CCX system is provisioned with an HTTP trigger.

Note  HTTP/HTTPS triggers are available if your system has a license installed for one of the following Cisco product packages: Unified IP IVR or Unified CCX Premium.
An HTTP trigger is the relative URL a user enters into the client browser to start the application. You can upload either eXtensible Style Language Transformation (XSLT) templates or Java Server Pages (JSP) templates to serve as your HTTP trigger.

The following path is an example of an HTTP-triggered request (using the HTTP trigger name “/hello”):

http://www.appserver.acme.com:9080/hello

In this example, the URL starts the application with the HTTP trigger “/hello” on a web server running on port 9080 with the hostname www.appserver.acme.com.

You can add the HTTP trigger from the Cisco Script Application web page or add the trigger from the HTTP subsystem.

Add HTTP Trigger from Application Web Page

To add an HTTP trigger directly from a Cisco Application Configuration web page, complete the following steps.

Procedure

**Step 1**
From the configuration web page for the application you want to add a trigger for, click **Add New Trigger** hyperlink.

The Add a New Trigger window opens.

**Step 2**
From the Trigger Type drop-down menu, select **HTTP** and click **Next**.

The HTTP Trigger Configuration window opens.

**Step 3**
Specify the following fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>URL</td>
<td>The relative URL</td>
</tr>
<tr>
<td></td>
<td>For example: /hello</td>
</tr>
<tr>
<td>Language</td>
<td>Perform one of the following actions:</td>
</tr>
<tr>
<td></td>
<td>• Choose a default language from the drop-down list.</td>
</tr>
<tr>
<td></td>
<td>• Click <strong>Edit</strong>, specify a default language in the dialog box that appears, and click <strong>OK</strong>.</td>
</tr>
<tr>
<td>Maximum Number Of</td>
<td>The maximum amount of simultaneous sessions that can be served by the HTTP</td>
</tr>
<tr>
<td>Sessions</td>
<td>subsystem for this trigger.</td>
</tr>
<tr>
<td>Idle Timeout (in ms)</td>
<td>Maximum amount of time (in milliseconds) that the system will wait to invoke</td>
</tr>
<tr>
<td></td>
<td>the application before rejecting a contact.</td>
</tr>
<tr>
<td>Enabled</td>
<td>Click the required radio button to accept - <strong>Yes</strong> (the default).</td>
</tr>
</tbody>
</table>

**Note**
If you disable the trigger, the user receives an error message when browsing to the defined trigger URL.
Step 4 Click Add.

The Cisco Application Configuration web page appears, and the URL of the HTTP trigger appears on the navigation bar.

Step 5 Test the trigger by entering the URL you just configured in the address bar of your browser.

For example,

/hello

The browser should display “hello”.

---

Add HTTP Trigger from HTTP Subsystem

To configure a HTTP trigger from the HTTP subsystem, complete the following steps.

Procedure

Step 1 From the Unified CCX Administration menu bar, choose Subsystems > HTTP.

The HTTP Trigger Configuration web page opens.

Step 2 Click the Add New icon that is displayed in the tool bar in the upper, left corner of the window or the Add New button that is displayed at the bottom of the window.

The HTTP Trigger Configuration window opens.

Step 3 Specify the following mandatory fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>URL</td>
<td>The relative URL. For example: /hello</td>
</tr>
<tr>
<td>Language</td>
<td>Perform one of the following actions:</td>
</tr>
<tr>
<td></td>
<td>• Choose a default language from the drop-down list.</td>
</tr>
<tr>
<td></td>
<td>• Click Edit, specify a default language in the dialog box that appears,</td>
</tr>
<tr>
<td></td>
<td>and click OK.</td>
</tr>
<tr>
<td>Application Name</td>
<td>Choose the name of the application from the drop-down list.</td>
</tr>
<tr>
<td>Maximum Number Of Sessions</td>
<td>The maximum amount of simultaneous sessions that can be served by the HTTP subsystem for this trigger.</td>
</tr>
<tr>
<td>Idle Timeout (in ms)</td>
<td>Maximum amount of time (in milliseconds) that the system will wait to invoke the application before rejecting a contact.</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Enabled | Click the required radio button to accept - Yes (the default)  
**Note**  If you disable the trigger, the user receives an error message when browsing to the defined trigger URL. |

**Step 4**
Click **Add**.

The Cisco Application Configuration web page appears, and the URL of the HTTP trigger appears on the navigation bar.

**Step 5**
To test the trigger, enter the URL you just configured in the address bar of your browser.

For example,

```
/hello
```

The browser should display “hello”.

---

### Script Management

Scripts are created with the Unified CCX Editor, and can perform a wide variety of functions. For example, scripts can prompt callers for extension numbers to transfer calls, place callers in a queue and route calls to available agents, and place outbound calls.

The Script Management option of the Applications menu of the Unified CCX Administration web interface contains options for managing and refreshing Unified CCX scripts that are stored in the repository.

**Note**
Your Unified CCX system includes sample scripts stored as .aef files.

**Caution**
If a large number of VRU scripts are configured for your system, the **Upload a New Script** and **Refresh Scripts** operations can take a long time to complete. These tasks can also result in high CPU utilization.

### Upload New Scripts

To make a script available for use as a Unified CCX application, you must first upload the script to the repository. In Unified CCX, uploaded scripts are stored in the Repository Datastore (RDS) database, along with prompts, grammars, and documents files. The scripts can also be grouped into folders and subfolders. When user scripts are uploaded into repository, they get synchronized to local disk and are accessed from there.

To upload a script to the repository, complete the following steps:
Procedure

Step 1  From the Unified CCX Administration menu bar, choose Applications > Script Management.

The Script Management page opens.

The Script Management page allows you to only work with user scripts; it does not have language-based directories.

The following table describes the available columns on the Script Management web page.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Folder Path</td>
<td>The level of the directory that is currently selected in the folder drop-down list.</td>
</tr>
<tr>
<td>Name</td>
<td>The name of the script.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong> Click the icon in front of the script name to download the script file.</td>
</tr>
<tr>
<td>Name</td>
<td>The size of the script file prefixed with KB. The file size is converted from bytes to KB.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong> This column is usually blank on the root page as the items on this page are usually folders.</td>
</tr>
<tr>
<td>Date Modified</td>
<td>The date and time when the document was last uploaded or changed along with time zone.</td>
</tr>
<tr>
<td>Modified by</td>
<td>The user ID of the person who performed these modifications.</td>
</tr>
<tr>
<td>Delete</td>
<td>To delete the corresponding folder.</td>
</tr>
<tr>
<td></td>
<td><strong>Caution</strong> When you delete a folder, you permanently remove it from the repository and make it unavailable to the Unified CCX system.</td>
</tr>
<tr>
<td>Rename</td>
<td>To rename the required subfolder within the default folder.</td>
</tr>
<tr>
<td>Refresh</td>
<td>To refresh the corresponding script.</td>
</tr>
</tbody>
</table>

Step 2  Click Upload New Scripts icon that is displayed in the tool bar in the upper, left corner of the window or the Upload New Scripts button that is displayed at the bottom of the window.

The Upload Script dialog box opens.

Step 3  To locate the script, click Browse button next to the File Name field, navigate to the directory in which the scripts are located, select a script, and click Open.

The script path for the profile appears in the File Name field.

Step 4  Click Upload to upload the script to the repository.

A window opens, informing you that the script was successfully uploaded.
You are now ready to manage any existing scripts shown in the Script Management page (if necessary) or add prompts that may be useful to your applications.

---

**Download Script File**

To view or download a script file, complete the following steps.

**Procedure**

**Step 1**
From the Unified CCX Administration menu bar, choose *Applications > Script Management.*
The Script Management page opens to display the contents of the *default* folder.

**Step 2**
Click the *Download Script* icon that appears before the Name of the script file you want to view or download.
The File Download dialog box opens.

**Step 3**
Perform one of the following tasks:

a) To view the script file, click *Open.*
The script file opens in the Unified CCX Editor.

b) To download the script file, click *Save,* and then follow the prompts to choose a directory and file name for the script file.
The file is saved to the specified directory.

---

**Refresh Scripts**

---

**Caution**

If a large number of VRU scripts are configured for your system, the *Upload a New Script* and *Refresh Scripts* operations can take a long time to complete. These tasks can also result in high CPU utilization.

When you make changes to a script, you must refresh the script to direct all the applications and subsystems that use this script to reload the new version. There are two script refresh options:

- Refresh Scripts Individually, on page 53
- Refresh Bulk Scripts, on page 54

---

**Refresh Scripts Individually**

To refresh an individual script on the Unified CCX server from the repository (RDS), complete the following steps.
Procedure

Step 1  From the Unified CCX Administration menu bar, choose Applications > Script Management.  
The Script Management page opens to display the contents of the default folder.

Step 2  In the row that contains the script, click Refresh icon.  
The script information refreshes and the Script Management page reappears.

Refresh Bulk Scripts

Note  Support for high availability and remote servers is available only in multiple-server deployments.

Bulk scripts refers to multiple .aef script files within one .zip file.

Note  This option is available only when you upload .zip files. You will see the option to refresh scripts after the selected file is uploaded successfully.

To refresh all scripts (within a zip file) with one command, complete the following steps.

Procedure

Step 1  From the Unified CCX Administration menu bar, choose Applications > Script Management.  
The Script Management page opens to display the contents of the default folder.

Step 2  Click the Upload New Scripts icon or button.  
The Upload Script dialog box opens.

Step 3  To locate the script, click the Browse button next to the File Name field, navigate to the directory in which the scripts are located, select a file, and click Open. The script path for the profile appears in the File Name field.

Tip  You can only upload .zip files containing .aef files. The total size of the .zip file cannot exceed 20 MB.

Step 4  Click Upload to upload the script to the repository.  
A window opens, informing you that the script upload succeeded.

Step 5  Click Refresh icon in the Script Management page.  
The Script Management web page opens, giving you the option of refreshing the script and the applications that reference it, or just refreshing the script.
Step 6 Specify one of the following options:

- If you want all applications and subsystems that reference the script (in the repository) to use the new version, click Yes.
- If you only want to refresh the scripts, click No.
- If you want to cancel the operation, click Cancel.

The script information refreshes and the Script Management page reappears to display the newly loaded .zip file.

---

**Rename Script or Folder**

To rename a script or folder, complete the following steps.

**Procedure**

Step 1 From the Unified CCX Administration menu bar, choose **Applications > Script Management**. The Script Management page opens to display the contents of the default folder.

Step 2 Click **Rename** icon for the folder or script that you want to rename. A dialog box opens displaying the name of the selected folder or script.

Step 3 Enter a new name for this folder or script in the text box.

Step 4 Click **Rename** button.

The dialog box refreshes to state that the folder was successfully renamed.

Step 5 Click **Return to Script Management** button.

The dialog box closes and the default folder's updated Script Management page displays the new script name.

---

**Delete Script or Folder**

When you delete a script or a folder, you remove it permanently from the repository.

To delete a script or folder, complete the following steps.

**Procedure**

Step 1 From the Unified CCX Administration menu bar, choose **Applications > Script Management**. The Script Management page opens to display the contents of the default folder.

Step 2 To delete a folder, click **Delete** icon for the folder or script that you want to delete.
A dialog box opens to confirm your action on the selected script or folder.

**Step 3**  Click **OK**.

The dialog box closes and the **default** folder's updated Script Management page refreshes to display the updated list of folders and scripts.

---

### Sample Scripts

Your Unified CCX system includes sample scripts stored as .aef files. These scripts have been built using Unified CCX Editor steps, including prerecorded prompts. You can use these scripts to create applications without performing any script development, or you can use these scripts as models for your own customized scripts.

---

**Note**  The included scripts are bundled with the Unified CCX system only as samples; they are not supported by Cisco. For more information on these sample scripts, see the *Cisco Unified Contact Center Express Getting Started with Scripts*. 
Telephony and Media Provision

Resource provisioning information for the Unified CCX telephony and media subsystems are provided in this chapter.

- Unified CCX Telephony and Media, on page 57
- Provision Unified CM Telephony Subsystem, on page 59
- Additional Unified CM Telephony Information, on page 73
- Cisco Media Subsystem, on page 74
- ASR and TTS in Unified CCX, on page 76

Unified CCX Telephony and Media

The Unified CCX system uses a telephony resource called Computer Telephony Interface (CTI) ports to accept incoming calls and to place outbound calls. The Unified CCX system uses the following media resources to provide interactive services for calls:

- Unified CM Telephony—The Unified CCX Engine uses the Unified CM Telephony subsystem to send and receive calls from the Unified CM by interfacing with the CTI Manager through the Unified CM Telephony client.

- Cisco Media Termination (CMT)—The CMT channels provide media terminations in the Unified CCX for Unified CM Telephony Call Contacts. These channels enable the Unified CCX to play media to the connected party. DTMF digits are received out of band by the Unified CM Telephony subsystem.

- MRCP Automated Speech Recognition (MRCP ASR)—The ASR media resource allows callers to use speech to navigate menus and to provide other information to Unified CCX applications.

- MRCP Text-To-Speech (MRCP TTS)—The TTS media resource enables Unified CCX applications to play back documents to callers as speech.

Note

Media resources are licensed and sold as Unified IP IVR ports. Although you can provision more channels than you are licensed for, licensing is enforced at run-time. If more channels are provisioned than licensed, the system will not accept the extra calls, because doing so would violate your licensing agreements.

The Unified CCX system uses groups to share telephony and media resources among different applications:
• Call control groups allow you to control how the system uses CTI ports. For example, you can reserve more ports for higher-priority applications or provide access to fewer ports for applications with less traffic.

• Media resource groups allow you to share media resources among different applications. For example, you can share ASR media resource groups with applications that collect caller information and applications that transfer calls to specific extensions.

The Unified CCX system also uses triggers, which are specified signals that invoke application scripts in response to incoming contacts.

Media Termination Groups

Media termination groups are associated with CTI port groups.

Note
For Unified CM deployment, you can create and use additional CTI port groups as required.

If a CTI port group is selected to support media termination and if the number of channels are identical to both groups, the CTI port group is automatically created in the background. This auto creation feature eliminates the manual CTI port group creation process. If you choose to override media termination, the call control channel chooses the media termination automatically. If you want to select a new dialog group, you can have more than one media termination option. The options are used in the order that is displayed in the drop-down list.

Channels Required to Process Calls

Unified CCX needs two types of channels to process calls:

• A call control channel, which is provisioned through the Unified CM Telephony subsystem and corresponds to CTI port resources in Unified CM.

• A media channel, which is provisioned through either the CMT subsystem or the MRCP subsystem and corresponds to the kernel resources for handling the media voice path with the caller.

Note
MRCP channels also correspond to additional resources on the MRCP server for performing speech recognition.

Unified CCX needs access to a channel of each type to successfully process a call. However, the capabilities of the two channel types are not identical.

For example, consider a Unified CCX system provisioned with a single Unified CM Telephony call control channel (that is, a CTI port) and a single CMT channel. The system can handle one call at a time; when that call terminates, the system must reinitialize the channel resources before it can accept another call.

However, the time each channel takes to reinitialize is not equal—CMT channels take more time to reinitialize than CTI ports. For example:

• The Unified CM Telephony call control channel may take approximately 1 millisecond to reinitialize.
The CMT channel may take approximately 200 milliseconds to reinitialize.

This example implies that the system will not be able to accept a new incoming call for 200 milliseconds after the first call terminates; although the Unified CM Telephony channel is available after one millisecond, the CMT channel is not and Unified CCX needs both channels to process a call.

Such a delay can become an issue when a Unified CCX system is experiencing a high load condition or needs to handle a burst of incoming calls. Consequently, CMT channels require a higher channel count provisioning.

---

**Tip**

To provision Unified CCX systems to handle burst calls equally among all required resources, you must configure approximately 10 percentage more CMT channels than CTI ports, and approximately 10 percentage more MRCP channels than ASR licenses.

---

### Provision Telephony and Media Resources

To provision telephony and media resources, complete the following tasks:

**Procedure**

1. **Step 1**
   - Provision the Unified CM Telephony subsystem.
   - Unified CM Telephony subsystem controls telephony resources for Unified CCX system.

2. **Step 2**
   - Provision the Cisco Media subsystem.
   - Cisco Media subsystem controls CMT media resources for Unified CCX system.

3. **Step 3**
   - Provision the MRCP ASR subsystem.
   - MRCP ASR subsystem controls ASR media resources for Unified CCX system.

4. **Step 4**
   - Provision the MRCP TTS subsystem.
   - MRCP TTS subsystem controls TTS media resources for Unified CCX system.

### Provision Unified CM Telephony Subsystem

The Unified CM Telephony subsystem is the subsystem of the Unified CCX Engine that sends and receives call-related messages from the Unified CM CTI Manager through the Unified CM Telephony client. To enable your Unified CCX server to handle Cisco Unified Communications requests, you must provision the Unified CM Telephony subsystem. The Unified CM Telephony subsystem is available in all the Unified CCX license packages.
In previous versions of Unified CCX, it was necessary to configure Unified CM Telephony information using Unified CM. In Unified CCX, Unified CM Telephony configuration tasks are performed directly through Unified CCX Administration web pages.

To provision the Unified CM Telephony subsystem, complete the following tasks:

**Procedure**

**Step 1** Configure a Unified CM Telephony Provider, if not already configured. Specify the server on which Unified CM CTI Manager is running, and provide a Unified CM user ID and password.

**Step 2** Provision Unified CM Telephony call control groups.

Unified CM Telephony call control groups pool together a series of CTI ports, which the system then uses to serve calls as they arrive at the Unified CCX server.

**Step 3** Provision a Unified CM Telephony trigger.

Unified CM Telephony triggers invoke application scripts in response to incoming contacts.

**Step 4** Resynchronize Unified CM Telephony versions.

---

**Resynchronize Cisco JTAPI Client**

During the resynchronizing process, an additional check ensures that the Unified CM Telephony Client (also known as the Cisco JTAPI Client) are the same between the clients installed on the Unified CCX node and the Cisco Unified CM. If the Unified CCX detects a mismatch, the system downloads and installs the required version of Cisco JTAPI Client.

To resynchronize and view the status of Cisco JTAPI client, complete the following steps.

**Procedure**

**Step 1** Choose **Subsystems > Cisco Unified CM Telephony > Cisco JTAPI Resync** from the Unified CCX Administration menu bar.

**Step 2** The Cisco JTAPI Resync web page opens, displaying the status of Cisco JTAPI Client resynchronization. At this point, if there is an incompatible version, it automatically downloads the new client.

---

**Resynchronize Unified CM Telephony Data**

This resynchronizing process ensures that the Unified CM Telephony user, the call control groups, and the triggers match the data of Unified CM being used.

To resynchronize the Unified CM Telephony data, complete the following steps.
Procedure

From the Unified CCX Administration menu bar, choose **Subsystems > Cisco Unified CM Telephony > Data Synchronization**.

The Cisco Unified CM Telephony Data Synchronization web page opens after resynchronization, displaying the Data Resync status of Unified CM Telephony Port Groups and Unified CM Telephony Triggers.

---

**Configure Unified CM Telephony Provider**

The Unified CM Telephony Provider web page is a read-only page that displays the latest configured information.

⚠️ **Caution**

Some setups may prevent the Unified CM directory administrator from creating new Unified CM Telephony providers in a multiserver configuration. If this setup applies to you, be sure to delete preexisting Unified CM Telephony providers before creating new Unified CM Telephony providers. For example, if the Unified CM Telephony provider prefix is `cmtelephony` and you have a two-server configuration (node_id1 and node_id2), you must delete both `cmtelephony_<node_id1>` and `cmtelephony_<node_id2>`. If you do not verify and delete preexisting Unified CM Telephony providers, the Unified CM Telephony subsystem issues an error and will not allow you to create Unified CM Telephony providers from the Unified CM Telephony Provider Configuration web page.

---

**Procedure**

**Step 1**

Choose **Subsystems > Cisco Unified CM Telephony > Provider** from the Unified CCX Administration menu bar.

The Cisco Unified CM Telephony Provider web page opens.

The following table describes the read-only fields displayed in the Unified CM Telephony Provider Configuration web page.

<table>
<thead>
<tr>
<th>Field Heading</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Primary Unified CM Telephony Provider</td>
<td>IP address of the Server, running Unified CM CTI Manager in the cluster. This is normally the first CTI Manager or Cisco Unified CM Telephony Provider selected by the Unified CCX user for Unified CM Telephony subsystem using <strong>System &gt; Cisco Unified CM Configuration</strong> web page.</td>
</tr>
</tbody>
</table>
Step 2
To modify the Unified CM Telephony subsystem, click **Modify Cisco Unified CM Telephony Provider Information** icon that displays in the tool bar in the upper left corner of the window. The Cisco Unified CM Configuration web page opens.

### Add New Call Control Group

The Unified CCX system uses Unified CM Telephony call control groups to pool together a series of CTI ports, which the system uses to serve calls as they arrive or depart from the Unified CCX server. You can create multiple Unified CM Telephony call control groups to share and limit the resources to be used by specific applications.

To configure a new Unified CM Telephony call control group, complete the following steps.

**Procedure**

**Step 1**
From the Unified CCX Administration menu bar, choose **Subsystems > Unified CM Telephony > Call Control Group**.

The Cisco Unified CM Telephony Call Control Group Configuration web page opens, which displays the existing Unified CM Telephony Call Control Group information, if any.

**Step 2**
Click **Add New** icon that is displayed in the tool bar in the upper left corner of the window or the **Add New** button that is displayed at the bottom of the window to create a new CTI port. The Cisco Unified CM Telephony Call Control Group Configuration web page opens.

**Note**

You can create only one call control group of the Outbound type, in which the number of CTI ports must be always equal to or greater than the licensed Outbound IVR ports.

The CTI ports should be created through the Publisher for both nodes in a HA over WAN deployment.

**Step 3**
Use this web page to specify the following information:
<table>
<thead>
<tr>
<th>Page Area</th>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Group Information</td>
<td>Group ID</td>
<td>Corresponds to the trunk group number reported to Cisco Unified Intelligent Contact Management Enterprise (Unified ICME) when the Unified CCX server is part of the Unified ICME solution. The value for this field is automatically generated.</td>
</tr>
<tr>
<td></td>
<td>Description</td>
<td>Description of the Group ID. Press the Tab key to automatically populate the Description field.</td>
</tr>
<tr>
<td></td>
<td>Number of CTI Ports</td>
<td>Number of CTI Ports assigned to the call control group. This is a mandatory field. If you have a Premium license with an Outbound license, you can create only one Outbound call control group with a minimum licensed number of IVR ports or more. The number of CTI ports for an outbound type of call control group can be modified but not below the licensed ports for Outbound IVR. This rule does not apply to inbound type call control groups. You can continue to create more inbound type call control groups.</td>
</tr>
<tr>
<td></td>
<td>Media Termination Support</td>
<td>Enables the auto-creation of media termination groups. This is a mandatory field. Yes = Provides automatic media termination if the CTI port group is successful. No = Media termination port group is not created (default).</td>
</tr>
<tr>
<td></td>
<td>Group Type</td>
<td>Select the group type for the call control group using this radio button. The choices are Inbound and Outbound. This is a mandatory field and Inbound radio button is enabled by default. You cannot change the group type from Outbound to Inbound and vice versa. The Outbound type call control group will be displayed only if you have uploaded the Outbound license on top of the premium license in your Unified CCX.</td>
</tr>
<tr>
<td>Page Area</td>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Directory Number</td>
<td>Device Name</td>
<td>The Device Name Prefix (DNP) used in the name that will be given all of the CTI Ports in this group. This is a mandatory field.</td>
</tr>
<tr>
<td>Information</td>
<td>Prefix</td>
<td>The CTI ports for this port group is restricted to a maximum of 5 characters and has the following format:</td>
</tr>
<tr>
<td></td>
<td></td>
<td><code>&lt;deviceprefix&gt;_directoryno&gt;</code></td>
</tr>
<tr>
<td></td>
<td></td>
<td>For example, if the Device Name Prefix is CTP and the starting Directory Number is 7000, the CTI Port that is created in Unified CM can have the device name CTP_7000.</td>
</tr>
</tbody>
</table>

Select **Server for Telephony Port Group Configuration** (displayed only in a HA over WAN deployment).
This field is displayed only in a HA over WAN deployment and it displays the different Unified CCX nodes that are available in a HA over WAN deployment in a drop-down list.

In a HA over WAN setup, you need to configure directory information along with Unified CM-specific information for the ports in each node. Once you select a node, all configuration details displayed below this field will be specific to the selected node only. So, if you update any node-specific parameters (below the Select Server field), it will be applicable only to the ports specific to the selected node. But, if you update any configuration data above the Select Server field, it will be applicable for the ports in both the nodes except for the Number of CTI Ports field.

Note
You need to ensure that the values in Number of CTI ports field for both the nodes are the same. If you modify this field, the number of ports is modified for the selected node only as the device pool selection for both nodes could be different in a HA over WAN deployment. If you click Add before updating this value for either of the node, the port group for that node will be marked with a red cross in the main Cisco Unified CM Telephony Call Control Group Configuration web page to signify the fact that the number of ports between the two nodes is different and the other node should also be updated. In such a scenario, click the hyperlink for the node that is tagged in red; and from the Cisco Unified CM Telephony Call Control Group Configuration page for the selected node, update the value in the Number of CTI Ports field and click Update to ensure the number of CTI ports for both the nodes are the same.

After you configure the data for the selected node and click Add or Update, the updated configuration information will be saved. For detailed information on behavior in HA over WAN scenario, refer to the Cisco Unified Contact Center Express Design Guide https://www.cisco.com/en/US/products/sw/custcosw/ps1846/products_implementation_design_guides_list.html. In case of LAN deployment, this field is not displayed, as the same configuration data will be applicable for both the nodes in the cluster.
<table>
<thead>
<tr>
<th>Page Area</th>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Directory Number Information | Starting Directory Number | A unique phone number. The Starting Directory Number contains numerals, and can have an asterisk (*) or a hash (#), or both as a prefix or a suffix. To support E.164 compliance, Unified CCX allows you to add the plus sign (+) before the directory number. The specified number of ports will be created starting from the value specified in this field. The Directory Number that you enter can appear in more than one partition. This is a mandatory field.  

**Note** When a pattern is used as a Directory Number, the phone display and the caller ID display on the dialed phone will contain characters other than digits. To avoid this, provide a value for Display (Internal Caller ID), Line Text Label, and External Phone Number Mask.  

| Device Pool | Set of common characteristics for devices, such as region, date/time group, softkey template, and MLPP information to which you want to assign this phone.  

**Note** The support for having multiple device pools associated with call control group(s) has been withdrawn in Unified CCX. Manually assign a single device pool to each call control group if you have multiple device pools associated with call control group(s) in an older version of Unified CCX.  

In a HA over WAN setup, you need to configure directory information along with Unified CM-specific information for the ports in each node. Once you select a node, all configuration details displayed below this field will be specific to the selected node only. So, if you update any node-specific parameters (below the Select Server field), it will be applicable only to the ports specific to the selected node. But, if you update any configuration data above the Select Server field, it will be applicable for the ports in both the nodes except for the Number of CTI Ports field.  

**Note** You need to ensure that the values in Number of CTI ports field for both the nodes are the same. If you modify this field, the number of ports is modified for the selected node only as the device pool selection for both nodes could be different in a HA over WAN deployment. If you click Add before updating this value for either of the node, the port group for that node will be marked with a red cross in the main Cisco Unified CM Telephony Call Control Group Configuration web page to signify the fact that the number of ports between the two nodes is different and the other node should also be updated. In such a scenario, click the hyperlink for the node that is tagged in red; and from the Cisco Unified CM Telephony Call Control Group Configuration page for the selected node, update the value in the Number of CTI Ports field and click Update to ensure the number of CTI ports for both the nodes are the same.
<table>
<thead>
<tr>
<th>Page Area</th>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DN Calling Search Space</td>
<td>A collection of partitions that are searched to determine how a dialed number should be routed. The calling search space for the device and the calling search space for the directory number get used together. The directory number calling search space takes precedence over the device calling search space. For more information, see the .</td>
<td></td>
</tr>
<tr>
<td>Location</td>
<td>The Cisco Unified Communications phone location setting specifies the total bandwidth that is available for calls to and from this location. A location setting of HUB_NONE means that the location feature does not keep track of the bandwidth that this Cisco Unified Communications phone consumes.</td>
<td></td>
</tr>
</tbody>
</table>

**Advanced Directory Number Information** (only available if you click Show More)

| Directory Number (continued)   | Alerting Name ASCII | This information is automatically populated based on the configuration in the Unified CM setup and displays the ASCII name filed used in one of the following situations:  
• If the device is not capable of handling the Unicode strings  
• If the locals on endpoint devices do not match  
• If the Unicode string is not specified | Redirect Calling Search Space | A collection of partitions that are searched to determine how a redirected call is routed. Redirect Calling Search Space options:  
**Note** DN Calling Search Space is deprecated. Use Calling Party or Redirect Party instead.  
• DN Calling Search Space—This option enables the CTI Port to use its directory number CSS when performing a redirect / consult transfer.  
• Calling Party—This option enables the CTI Port to use the calling party's CSS when performing a redirect / consult transfer.  
• Redirect Party—This option enables the CTI Port to use the CTI Port's CSS to control the redirect. | Media Resource Group List | A prioritized grouping of media resource groups. An application chooses the required media resource, such as a Music On Hold server, from the available media resources according to the priority order that is defined in a Media Resource Group List.  
If you choose <none>, Unified CM uses the Media Resource Group that is defined in the device pool. |
### Page Area

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Refer to page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Directory Number Setting</td>
<td><strong>Voice Mail Profile</strong> A list of profiles defined in the Voice Mail Profile Configuration. The first option is &lt;None&gt;, which is the current default Voice Mail Profile that is configured in the Voice Mail Profile Configuration.</td>
<td>p. 68</td>
</tr>
<tr>
<td>Presence Group</td>
<td>See the <em>Cisco Unified Communications Manager Administration Guide</em> for detailed information on how to configure presence groups.</td>
<td></td>
</tr>
<tr>
<td>Require DTMF Reception</td>
<td>A Unified CM radio button to determine if DTMF reception is required. Yes is selected by default. If you select No, a warning message is displayed.</td>
<td></td>
</tr>
<tr>
<td>AAR Group</td>
<td>Automated Alternate Routing (AAR) group for this device. The AAR group provides the prefix digits that are used to route calls that are otherwise blocked due to insufficient bandwidth. An AAR group setting of &lt;None&gt; specifies that no rerouting of blocked calls will be attempted.</td>
<td></td>
</tr>
<tr>
<td>User Hold Audio Source</td>
<td>Audio source heard by the caller when the Unified CCX Script places the caller on Hold by using the Hold Step (when you press the hold key).</td>
<td></td>
</tr>
<tr>
<td>Network Hold Audio Source</td>
<td>Audio source heard by the caller when Unified CCX performs a Consult Transfer (when Unified CCX calls an agent). Use this entry for the .wav file (for example, .wav file playing a ringback tone) to be played to the caller during this Consult Transfer.</td>
<td></td>
</tr>
<tr>
<td>Call Forward and Pickup Settings</td>
<td><strong>Call Pickup Group</strong> The number that can be dialed to answer calls to this directory number in the specified partition.</td>
<td></td>
</tr>
<tr>
<td>Display</td>
<td>Use a maximum of 30 alphanumeric characters. Typically, use the user name or the directory number (if you use the directory number, the person receiving the call may not see the proper identity of the caller). Leave this field blank to have the system display the extension.</td>
<td></td>
</tr>
<tr>
<td>External Phone Number Mask</td>
<td>Phone number (or mask) that is used to send Caller ID information when a call is placed from this line. You can enter a maximum of 24 number, the international escape character ‡, *, # and &quot;X&quot; characters. The X characters represent the directory number and must appear at the end of the pattern. For example, if you specify a mask of 972813XXXX, an external call from extension 1234 displays a caller ID number of 9728131234.</td>
<td></td>
</tr>
</tbody>
</table>

**Step 4**

Click **Add** or **Save**.

The Unified CM Telephony Call Control Group Configuration summary web page opens. The corresponding CTI ports are created in the Unified CM Telephony call control group. The new call control group appears in...
the list of call control groups displayed in the Cisco Unified CM Telephony Call Control Group Configuration web page.

---

**Add Unified CM Telephony Trigger**

You must configure Unified CM Telephony triggers to invoke application scripts in response to incoming contacts. A Unified CM Telephony trigger responds to calls that arrive on a specific route point by selecting telephony and media resources to serve the call and invoking an application script to handle the call. The Unified CM Telephony triggers are available with all Unified CCX license packages.

Unified CM Telephony trigger settings include:

- **Session** information, such as the application to associate with the trigger, Maximum Number of sessions allowed, and the Idle Timeout value.

- **CTI** information, such as a CTI port device and CTI route points for each call Unified CCX simultaneously places or accepts.

- **Directory Number** information, such as the Voice Mail Profile and Calling Search Space.

- **Call Forward and Pickup** instructions.

To add and configure a Unified CM Telephony trigger, complete the following steps.

**Procedure**

**Step 1**

From the Unified CCX Administration menu bar, choose **Subsystems > Cisco Unified CM Telephony > Triggers**.

The Unified CM Telephony Trigger Configuration web page opens displaying the following fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Route Point</td>
<td>Available CTI route point, which is the directory number associated with the trigger.</td>
</tr>
<tr>
<td>Application</td>
<td>Application name to associate with the trigger.</td>
</tr>
<tr>
<td>Sessions</td>
<td>Maximum number of simultaneous calls that the trigger can handle.</td>
</tr>
<tr>
<td>Enabled</td>
<td>True if the trigger is enabled; False if the trigger is disabled.</td>
</tr>
</tbody>
</table>

**Note**

If you try to delete a trigger associated with an outbound call control group, then the campaigns associated with the trigger become invalid and the application also gets deleted. In such cases, when you click the **Delete** icon or button, a dialog box opens to confirm your action. Click **OK** if you want to delete the trigger and disassociate the campaigns associated with it. If you delete a trigger and navigate to the Campaign Configuration web page, you will also see an alert regarding the missing trigger association for that campaign.

**Step 2**

Click the **Add New** icon that is displayed in the tool bar in the upper left corner of the window or the **Add New** button that is displayed at the bottom of the window.
The Unified CM Telephony Trigger Configuration web page opens.

**Step 3**

Use this web page to specify the following mandatory fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Directory Information</strong></td>
<td></td>
</tr>
</tbody>
</table>
| Directory Number | A unique phone number. To support E.164 compliance, Unified CCX allows you to add a plus sign (+) before the agent extension or a route point directory number followed by 15 characters which consist of numerals and the following special characters: uppercase letter X, hash (#), square brackets ([ ]), hyphen (-), and asterisk (*).  
  - Supports only route point directory numbers and Finesse agent and supervisor extensions.  
  **Note**  
  - +1234 and 1234 are two different directory numbers.  
  - The square brackets ([ ]) enclose a range of values.  
  - For more information, see the “Wildcards and Special Characters in Route Patterns and Hunt Pilots” section in the System Configuration Guide for Cisco Unified Communications Manager.  
  **Examples:**  
  - Valid directory numbers—+1223* or *#12#*  
  - Invalid directory numbers—91X+ or +-12345  
  **Note** Use of two(2) wildcard CTI Route Points that overlap with each other is not supported. For example, Route Point 1: 123XXXX and Route Point 2: 1234XXX overlap with one another and is not supported. However, a wildcard CTI Route point can overlap with a full DID (best match pattern) that doesn't contain a wildcard. For example, Route Point 1: 123XXXX and Route Point 2: 1234567 is supported. |
| **Trigger Information** |            |
| Language | Choose the default language to associate with the incoming call when the application is started from this drop-down menu.  
  **Note** To add a Language option, click **Edit** button. The User Prompt dialog box opens. Enter a locale string value and click **OK**. The User Prompt dialog box closes, and the name of the language opens in the Language field in the Unified CM Telephony Configuration web page. |
<p>| Application Name | From the drop-down menu, choose the application to associate with the trigger. |
| Device Name | A unique identifier for this device, consisting of alphanumeric characters, dots, dashes, or underscores. |
| Description | A descriptive name for the CTI route point. |</p>
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Call Control Group</td>
<td>Choose the call control group to associate with the trigger from this drop-down menu. For Outbound IVR Dialer, you must select the call control group from Outbound type call control group list. The route point should be created on Unified CM. Once you assign the Outbound group for a trigger, you cannot change it to an Inbound group and vice versa.</td>
</tr>
<tr>
<td><strong>Advanced Configuration</strong> (available only if you click Show More).**</td>
<td></td>
</tr>
<tr>
<td><strong>Advanced Trigger Information</strong></td>
<td></td>
</tr>
<tr>
<td>Enabled</td>
<td>Radio buttons to choose the required option:</td>
</tr>
<tr>
<td></td>
<td>• Yes—enable the trigger (default)</td>
</tr>
<tr>
<td></td>
<td>• No—disable the trigger.</td>
</tr>
<tr>
<td>Maximum Number of Sessions</td>
<td>The maximum number of simultaneous calls that this trigger can handle. The number is actually governed by the Unified CM (10,000 for each separate line). However in Unified CCX, this number is restricted to the maximum number of sessions. Any call after this number is exceeded gets the busy tone.</td>
</tr>
<tr>
<td>Idle Timeout (in ms)</td>
<td>The number of milliseconds (ms) the system should wait before rejecting the Unified CM Telephony request for this trigger.</td>
</tr>
<tr>
<td>Override Media Termination</td>
<td>Radio buttons to choose the required options:</td>
</tr>
<tr>
<td></td>
<td>Yes—Override media termination.</td>
</tr>
<tr>
<td></td>
<td>No—Enable media termination (default).</td>
</tr>
<tr>
<td></td>
<td>If you select Yes, two panes open:</td>
</tr>
<tr>
<td></td>
<td>• Selected Dialog Groups displays the default or selected group.</td>
</tr>
<tr>
<td></td>
<td>• Available Dialog Groups lists the configured dialog.</td>
</tr>
<tr>
<td><strong>CTI Route Point Information</strong></td>
<td></td>
</tr>
<tr>
<td>Alerting Name ASCII</td>
<td>This information is automatically populated based on the configuration in the Unified CM setup and displays the ASCII name filed used in one of the following situations:</td>
</tr>
<tr>
<td></td>
<td>• If the device is not capable of handling the Unicode strings</td>
</tr>
<tr>
<td></td>
<td>• If the locals on endpoint devices do not match</td>
</tr>
<tr>
<td></td>
<td>• If the Unicode string is not specified</td>
</tr>
<tr>
<td>Device Pool</td>
<td>The device pool to which you want to assign this route point. A device pool defines sets of common characteristics for devices, such as region, date/time group, softkey template, and MLPP information.</td>
</tr>
<tr>
<td>Location</td>
<td>The total bandwidth that is available for calls to/from this location. A location setting of HUB_NONE indicates that the locations feature does not keep track of the bandwidth used by this route point.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td><strong>Directory Number Settings</strong></td>
<td></td>
</tr>
<tr>
<td>Partition</td>
<td>The partition to which the Directory Number belongs. The Directory Number field value must be unique within the partition that you choose. If you do not want to restrict access to the Directory Number, select <code>&lt;None&gt;</code> as the partition setting.</td>
</tr>
<tr>
<td>Voice Mail Profile</td>
<td>A list of profiles defined in the Voice Mail Profile Configuration. The first option is <code>&lt;None&gt;</code>, which is the current default Voice Mail Profile that is configured in the Voice Mail Profile Configuration.</td>
</tr>
<tr>
<td>Calling Search Space</td>
<td>A collection of partitions that are searched for numbers that are called from this directory number. The specified value applies to all devices that use this directory number. For example, assume you have two calling search spaces: Building and PSTN. Building only allows users to call within the building, while PSTN allows users to call both in and outside the building. You could assign the phone to the Building calling search space and the line on your phone to the PSTN calling search space. For more information, see the .</td>
</tr>
<tr>
<td><strong>Calling Search Space for Redirect</strong></td>
<td>By default, Cisco Unified Communications Manager uses the original calling party's calling search space (CSS) to process the redirected call from a Unified CCX Trigger to a Unified CCX CTI Port. This default behavior requires the partition of the Unified CCX CTI ports to be a member of the original calling party's CSS even if the partition of the CTI Route Point/Unified CCX Trigger is accessible to the calling device's CSS and the CSS of the CTI Route Point/Unified CCX Trigger contains the partition of the Unified CCX CTI Ports. You can modify this behavior using the drop-down list to instruct Cisco Unified Communications Manager which CSS to use when redirecting the call from the CTI Route Point to the CTI Port. <strong>Calling Search Space for Redirect options:</strong></td>
</tr>
<tr>
<td></td>
<td>• Default Calling Search Space—CSS of the calling device</td>
</tr>
<tr>
<td></td>
<td>• Calling Address Search Space—CSS of the calling device</td>
</tr>
<tr>
<td></td>
<td>• Route Point Address Search Space—CSS of the CTI Route Point (Trigger)</td>
</tr>
<tr>
<td>Presence Group</td>
<td>A list of groups to integrate the device with the iPass server. The device/line information is provided for integrating applications.</td>
</tr>
<tr>
<td><strong>Call Forward and Pickup Settings</strong></td>
<td></td>
</tr>
</tbody>
</table>
### Field Description

**Forward Busy**
Check one of the following options:
- **Voice Mail**—Check this box to use settings in the Voice Mail Profile Configuration window.

  **Note** When this box is checked, Unified CM ignores the settings in the Destination box and Calling Search Space.

  **Destination**—To use any disable phone number, including an outside destination.

  **Calling Search Space**—To apply the above setting all devices that are using this directory number.

**Display**
Use a maximum of 30 alphanumeric characters. Typically, use the user name or the directory number (if using the directory number, the person receiving the call may not see the proper identity of the caller). Leave this field blank to have the system display an extension.

**External Phone Number Mask**
Phone number (or mask) that is used to send Caller ID information when a call is placed from this line.

You can enter a maximum of 24 number, the international escape character +, *, # and "X" characters. The X characters represent the directory number and must appear at the end of the pattern. For example, if you specify a mask of 972813XXXX, an external call from extension 1234 displays a caller ID number of 9728131234.

---

**Step 4**
Click **Add** or **Save** to save the changes. The specified route point is created on the Unified CM.

The Unified CM Telephony Trigger Configuration web page opens and displays the new Unified CM Telephony trigger.

---

### Additional Unified CM Telephony Information

This section includes the following topics:

- [Unified CM Telephony Triggers for Unified CCX Queuing](#)
- [Unified CM Telephony Information Resynchronization](#)

### Unified CM Telephony Triggers for Unified CCX Queuing

When limiting the number of calls per application in Unified CCX applications, you need to take care to coordinate the Unified CM Telephony trigger Maximum Number of Sessions limit with the Media Group session limit.

For example, if you are using Unified CCX for queuing calls and set the Unified CM Telephony trigger Maximum Number of Sessions limit on Unified CCX to 4 and set the Call Forward and Pickup Settings to send the fifth call to voice mail. To make this happen, you must configure the Media Group Session Limit to
the identical setting (4). This will cause Unified CM to forward the next incoming call to voice mail (once the CTI New Call Accept timer setting expires).

The disadvantage of this approach is that you need to define more media groups for each application and you cannot share the same set of media groups across multiple applications.

Unified CM Telephony Information Resynchronization

If the Unified CM Telephony information (Unified CM Telephony users, CTI ports, triggers, SRTP) in the Unified CM is missing or not in sync with Unified CCX data, choose Subsystems > Cisco Unified CM Telephony > Data Resync from the Unified CCX Administration menu bar. Unified CCX checks whether:

- The Unified CM Telephony users exist in Unified CM.
- All the ports belonging to the Port Group exist in Unified CM.
- The port group's data is in sync with Ports data in Unified CM.
- The ports' association to users are correct.
- The route point exists in Unified CM.
- The triggers data is in sync with the Route Point data in the Unified CM.
- The route points have been associated with all the Unified CM Telephony users in Unified CM.
- The Unified CM configuration is in sync with Unified CCX for SRTP.

Unified CCX synchronizes the data by:

- Creating any missing users
- Creating any missing ports
- Modifying out-of-sync ports
- Associating CTI Ports to Unified CM Telephony users. (For example, associating CTI Ports created for Node 1 to the Unified CM Telephony User for Node 1, and so on.)
- Creating any missing route points
- Modifying out-of-sync route points
- Associating route points to all the Unified CM Telephony users.
- Modifying Unified CM configuration, such as user roles and CAPF profiles for JTAPI telephony users to match SRTP configuration.

Cisco Media Subsystem

The Cisco Media subsystem is a subsystem of the Unified CCX Engine. The Cisco Media subsystem manages the CMT media resource. CMT channels are required for Unified CCX to be able to play or record media.

The Cisco Media subsystem uses dialog groups to organize and share resources among applications. A dialog group is a pool of dialog channels in which each channel is used to perform dialog interactions with a caller, during which the caller responds to automated prompts by pressing buttons on a touch-tone phone.
The built-in grammars and grammar options that are supported by Unified CCX when using an MRCP dialog channel is determined by the MRCP speech software you purchase. See the software vendor for information about what built-in grammars and features are supported.

To enable your Unified CCX applications to handle simple DTMF-based dialog interactions with customers, you must provision the Cisco Media subsystem to configure CMT dialog groups.

Caution

All media termination strings begin with auto and contain the same ID as the call control group—not the CMT dialog group. If the default media termination is configured and the ID differs, follow the procedure provided in the Add CMT Dialog Control Group.

Related Topics
Add CMT Dialog Control Group, on page 75

Add CMT Dialog Control Group

To add a CMT dialog control group, complete the following steps.

Procedure

Step 1
From the Unified CCX Administration menu bar, choose Subsystems > Cisco Media.

The Cisco Media Termination Dialog Group Configuration web page opens. Any preconfigured entry is listed on this page with the following information:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GroupID</td>
<td>The unique Group ID associated with the media.</td>
</tr>
<tr>
<td>Description</td>
<td>CMT group description.</td>
</tr>
<tr>
<td>Note</td>
<td>The ID in this field need not necessarily match the CMT group ID.</td>
</tr>
<tr>
<td>Channels</td>
<td>Number of channels associated with the group.</td>
</tr>
</tbody>
</table>

Step 2
Click Add New icon at the top or Add New button at the bottom of the window. The Cisco Media Termination Dialog Group Configuration web page opens.

Note By default, a Unified CM Telephony Call Control Group with Group ID 0 is created.

Step 3
Use this web page to specify the following fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Group ID</td>
<td>A Group ID value unique within all media group identifiers, including ASR group identifiers. This is a mandatory field.</td>
</tr>
</tbody>
</table>
### ASR and TTS in Unified CCX

Unified CCX supports ASR and TTS through two subsystems:

**MRCP ASR**
- This subsystem allows users to navigate through a menu of options by speaking instead of pressing keys on a touch-tone telephone.

**MRCP TTS**
- This subsystem converts plain text (UNICODE) into spoken words to provide a user with information, or prompt a user to respond to an action.

Note: Only G.711 codec is supported for ASR/TTS integrations.

### Prepare to Provision ASR/TTS

It is the responsibility of the customer to perform the following tasks:

- Order ASR/TTS speech servers from Cisco-supported vendors.

Note: For more information on supported speech servers for Unified CCX, see the Unified CCX Compatibility related information, located at: https://www.cisco.com/c/en/us/support/customer-collaboration/unified-contact-center-express/products-device-support-tables-list.html.
• Work with the ASR/TTS vendor to size the solutions.

• Provision, install, and configure the ASR/TTS vendor software on a different server (in the same LAN) and not where the Unified CCX runs. (see the Unified CCX Compatibility related information, located at: https://www.cisco.com/c/en/us/support/customer-collaboration/unified-contact-center-express/products-device-support-tables-list.html).

• Before uploading a ASR/TTS script to Unified CCX Administration, validate the script against the capabilities and specifications supported by the ASR/TTS vendor.

Provision of MRCP ASR Subsystem

The MRCP ASR subsystem allows users to navigate through a menu of options by speaking instead of pressing keys on a touch-tone telephone. When a user calls local directory assistance, for example, ASR can prompt the user to say the city and state in which to locate the information, then connect the user to an appropriate operator.

To provision the MRCP ASR subsystem, define the following information:

• **MRCP ASR Providers**—Information about the vendor of your speech server, including the number of licenses and the grammar type.

• **MRCP ASR Servers**—Information about the ASR server’s name, port location, and available languages.

• **MRCP ASR Groups**—Information about the MRCP ASR dialog control groups and associated locales, which enable Unified CCX applications to use speech recognition.

Provision MRCP ASR Providers

Use the MRCP ASR Provider Configuration web page to specify information about the vendor of your speech server.

**Procedure**

**Step 1**  
From the Unified CCX Administration menu bar, choose **Subsystem > MRCP ASR > MRCP ASR Providers**. The MRCP ASR Provider Configuration web page opens, displaying the list of currently configured MRCP providers, licenses, and the corresponding status.

**Step 2**  
Click **Add New** icon that displays in the tool bar in the upper left corner of the window or the **Add New** button that is displayed at the bottom of the window. The MRCP ASR Provider Configuration web page opens.

**Step 3**  
Specify the following mandatory fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Provider Name</td>
<td>Enter the name of the MRCP ASR provider supported by Unified CCX.</td>
</tr>
<tr>
<td>Number of Provider Licenses</td>
<td>The number of ASR port licenses purchased from the ASR vendor.</td>
</tr>
</tbody>
</table>
### Provision MRCP ASR Servers

Use the MRCP ASR Server Configuration web page to specify information about the speech server’s name, port location, and available language.

**Note**

You must have an MRCP ASR Provider defined before you can provision an MRCP ASR Server.

**Procedure**

**Step 1**

From the Unified CCX Administration menu bar, choose Subsystem > MRCP ASR > MRCP ASR Servers.

The MRCP ASR Server Configuration web page opens, displaying a list of previously configured servers, if applicable with the following information:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Grammar Variant</td>
<td>Vendor-specific grammar setting. Valid options:</td>
</tr>
<tr>
<td></td>
<td>• Nuance Open Speech Recognizer servers version 9.0 and above (OSR 3.1.x)</td>
</tr>
<tr>
<td></td>
<td>• Nuance 8.5 and below version ASR servers (Nuance)</td>
</tr>
<tr>
<td></td>
<td>• IBM WVS ASR servers (2003 SISR)</td>
</tr>
</tbody>
</table>

Note

Your changes appear in the MRCP ASR Providers List page. You are now ready to provision MRCP ASR Servers.

**Note**

If you delete an ASR/TTS provider and all of its associated servers and then create a new ASR/TTS provider, its status might become IN SERVICE immediately, even before you create any servers for it. In this situation, click Refresh for that ASR/TTS provider, or click Refresh All. These actions change the status of the ASR/TTS provider to NOT_CONFIGURED.

**Step 4**

Click Add icon in the toolbar in the upper left corner of the window or the Add button that displays at the bottom of this window to apply changes.

**Note**

After you update MRCP ASR/TTS Providers, Servers, and Groups, the corresponding provider needs to be refreshed for changes to take effect. The Unified CCX Engine does not need to be restarted. However, during a Refresh, Unified CM Telephony triggers using affected groups will fall back to the dialog group that is configured and the MRCP Provider being refreshed will go NOT_CONFIGURED until the reload is complete.
<table>
<thead>
<tr>
<th>Computer Name</th>
<th>Hostname or IP address in which the ASR server software is installed.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Note</strong></td>
<td>ASR server deployment over WAN is not supported in Unified CCX. The ASR server should be in the same LAN where Unified CCX is. You need to specify the ASR server hostname or IP address that is local with the Unified CCX node while installing the ASR server software in this field.</td>
</tr>
<tr>
<td>Provider</td>
<td>The MRCP ASR Provider to which this server is associated.</td>
</tr>
<tr>
<td>Port</td>
<td>The default TCP port number that is used to connect to a MRCP server.</td>
</tr>
<tr>
<td></td>
<td>• OSR 3.1.x—4900 for MRCPv1 and 5060 for MRCPv2</td>
</tr>
<tr>
<td></td>
<td>• 2003 SISR—554</td>
</tr>
<tr>
<td></td>
<td>• Nuance—554</td>
</tr>
<tr>
<td>Status</td>
<td>Status or state of the subsystem.</td>
</tr>
</tbody>
</table>

**Step 2**
Click **Add New** icon that is displayed in the tool bar in the upper, left corner of the window or the **Add New** button that is displayed at the bottom of the window to provision a new MRCP ASR Server.

The MRCP ASR Server Configuration web page opens.

**Step 3**
Use this web page to specify the following fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Server Name</td>
<td>Hostname or IP address of the server where the MRCP ASR server software is installed.</td>
</tr>
<tr>
<td>Provider Name</td>
<td>Select the name of the MRCP ASR Provider to which this server is associated from this drop-down list.</td>
</tr>
<tr>
<td>Port Number</td>
<td>The default TCP port number that is used to connect to a MRCP server. Though the default value is shown as 4900. You need to provide any one of the following values in this field based on the TCP provider or grammar variant you have selected while configuring an MRCP ASR provider:</td>
</tr>
<tr>
<td></td>
<td>• OSR 3.1.x—4900 for MRCPv1 and 5060 for MRCPv2</td>
</tr>
<tr>
<td></td>
<td>• 2003 SISR—554</td>
</tr>
<tr>
<td></td>
<td>• Nuance—554</td>
</tr>
</tbody>
</table>
Locales | Languages supported by the ASR Provider. Select a language (or multiple languages) from the drop-down list and click **Add Language**; the selected language appears with a check box in the Enabled Languages list.  
*Note* | Use the check box to enable or disable a language.

**Step 4**  
Click **Add** to apply changes.  
Your changes appear in the MRCP ASR Server list web page. You are now ready to provision MRCP ASR Groups.

---

**Provision MRCP ASR Dialog Groups**

Use the MRCP Groups Configuration web page to specify information about MRCP ASR dialog control groups, which enable Unified CCX applications to use speech recognition.

**Note**  
You must have a MRCP ASR Provider defined before you can provision a MRCP ASR Group. Also, you should configure MRCP ASR Servers for the specific MRCP Provider before configuring the MRCP ASR Groups. This allows users to configure languages for the groups based on the languages supported by the configured servers.

**Procedure**

**Step 1**  
From the Unified CCX Administration menu bar, choose **Subsystem** > **MRCP ASR** > **MRCP ASR Dialog Groups**.

The MRCP ASR Dialog Group Configuration web page opens to display a list of preconfigured entries, if applicable with the following information:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Group ID</td>
<td>Identifier for the group.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of this dialog group.</td>
</tr>
<tr>
<td>Provider</td>
<td>Name of the MRCP ASR provider.</td>
</tr>
<tr>
<td>Channels</td>
<td>Maximum number of sessions.</td>
</tr>
</tbody>
</table>

This web page also displays the Number of Licensed IVR Channels.

**Step 2**  
Click **Add New** icon that displays in the tool bar in the upper, left corner of the window or the **Add New** button that displays at the bottom of the window to provision a MRCP ASR Group.

The MRCP ASR Dialog Group Configuration web page opens.
### Step 3

Use this web page to specify the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Group ID</td>
<td>Associated group ID.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of this dialog group. <em>Tip</em> Include languages that will be used by this Group to the description. Doing so will provide insight into the languages this Group uses when you set up the dialog group in the Unified CM Telephony trigger configuration. This also ensures that the locales used by the application configured in the Unified CM Telephony trigger match the locales supported by the MRCP ASR dialog group being selected.</td>
</tr>
<tr>
<td>Number Of Provider Licenses</td>
<td>Display only.</td>
</tr>
<tr>
<td>Number Of Licensed IVR Ports</td>
<td>Display only.</td>
</tr>
<tr>
<td>Maximum Number Of sessions</td>
<td>Maximum number of sessions associated with this dialog group. <em>Note</em> You can assign any value for Maximum Number Of Channels, but restrictions are placed on the system when a call is made. This restriction is imposed by the number of licensed IVR ports on your system. <em>Caution</em> Under heavy load, calls that utilize a channel from an MRCP ASR Dialog Control Group, might have a reduced call completion rate as the MRCP channels used by calls can take some additional time to clean up all the sessions set up with MRCP resources. To address this situation, you can overprovision the value of this field by a factor of 1.2 or by an additional 20 percent. For example, if your application requires 100 MRCP ASR channels, modify the value in this field to be 120 MRCP ASR channels.</td>
</tr>
<tr>
<td>Provider Name</td>
<td>Select a MRCP Provider name from the drop-down list that contains a list of all previously defined provider names.</td>
</tr>
<tr>
<td>Enabled Languages</td>
<td>Select the languages that you wish to configure for this group from the list displayed. The displayed languages represent the locales configured for all MRCP ASR servers for the specified provider. If there are no MRCP ASR servers configured, no languages are displayed. In this case, you must update the group configuration once MRCP ASR servers have been configured for the specified provider.</td>
</tr>
</tbody>
</table>

### Step 4

Click **Add** to apply changes.

Your changes appear in the MRCP ASR Groups list web page.
MRCP TTS Subsystem

The MRCP TTS subsystem converts plain text (UNICODE) into spoken words to provide a user with information, or prompt a user to respond to an action.

For example, a company might use TTS to read back a customer's name, address, and telephone number for verification before the company ships a requested product to the customer's location. Or a customer might dial into a pre-designated phone number, access a voice portal, and listen to the latest weather report or stock quotes. TTS can also convert email text to speech and play it back to the customer over telephone.

To provision the MRCP TTS subsystem, define the following information:

- **MRCP TTS Providers**—Information about the vendor of your TTS system.

  **Note** If you delete an ASR/TTS provider and all of its associated servers and then create a new ASR/TTS provider, its status might become IN_SERVICE immediately, even before you create any servers for it. In this situation, click Refresh for that ASR/TTS provider, or click Refresh All. These actions change the status of the ASR/TTS provider to NOT_CONFIGURED.

- **MRCP TTS Servers**—Information about the TTS server's name, port location, and available languages.

- **MRCP TTS Default Genders**—Information about the default gender setting for the Locales specified during TTS Server provisioning.

  **Note** You will need at least one MRCP TTS Provider for each vendor requiring TTS server installation.

Provision MRCP TTS Providers

Use the MRCP TTS Providers Configuration web page to specify information about the vendor of your TTS server.

**Note** After you update MRCP ASR/TTS Providers, Servers, and Groups, the corresponding provider needs to be refreshed for changes to take effect. The Unified CCX Engine does not need to be restarted. However, during a Refresh, Unified CM Telephony triggers using affected groups will fall back to the dialog group that is configured and the MRCP Provider being refreshed will go NOT_CONFIGURED until the reload is complete.

**Procedure**

**Step 1** From the Unified CCX Administration menu bar, choose **Subsystems > MRCP TTS > MRCP TTS Provider**.

The MRCP TTS Provider Configuration web page opens. If providers are already configured, this page lists the provider name and corresponding status.
**Configure Default TTS Provider for Unified CCX System**

Optionally, you can configure a default TTS provider. The Unified CCX Prompt Manager uses the default TTS provider for rendering TTS prompts if a TTS provider is not configured in the TTS Prompt. This usually happens in the case of VXML applications. For additional information on supported VXML tags for Unified CCX, see *Cisco Unified Contact Center Express Getting Started with Scripts* and for supported grammars see *Cisco Unified Contact Center Express Editor Step Reference Guide*.

To configure a default TTS provider, follow these steps.

**Procedure**

**Step 1** Choose **System > System Parameters**.

**Step 2** In the Default TTS Provider drop down list below Media Parameters section, select the provider you wish to be the system default. You must select only a preconfigured TTS provider as the Default TTS Provider.

**Note** If you are deploying an VXML applications and the only TTS functionality you need is to play pre-recorded .wav files, select the *Cisco LiteSSMLProcessor* option as the Default TTS Provider. This option allows you to execute SSML that has .wav file references in them.

**Step 3** Click **Update**.

---

**Provision MRCP TTS Servers**

Use the MRCP TTS Servers Configuration web page to configure the TTS server's name, port location, and available languages.

You need at least one MRCP TTS Server associated with each configured provider.

**Note** You must have an MRCP TTS Provider defined before you can provision an MRCP TTS Server.
Procedure

**Step 1**
From the Unified CCX Administration menu bar, choose *Subsystems > MRCP TTS > MRCP TTS Server*. The MRCP TTS Server Configuration web page opens, displaying a list of previously configured servers, if applicable, with the following information:

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Computer Name</td>
<td>Hostname or IP address of the server in which the TTS server software is installed.</td>
</tr>
<tr>
<td>Note</td>
<td>TTS server deployment over WAN is not supported in Unified CCX. In other words, the TTS server should be in the same LAN where Unified CCX is. Thus, you need to specify the TTS server hostname or IP address that is local with the Unified CCX node while installing the TTS server software in this field.</td>
</tr>
<tr>
<td>Port</td>
<td>TCP port number used to connect to an MRCP server. Following are the different TCP Provider names:</td>
</tr>
<tr>
<td></td>
<td>• MRCP Server</td>
</tr>
<tr>
<td></td>
<td>• Nuance Vocalizer</td>
</tr>
<tr>
<td></td>
<td>• Scansoft Realspeak</td>
</tr>
<tr>
<td>Provider</td>
<td>The MRCP TTS Provider to which this server is associated.</td>
</tr>
<tr>
<td>Status</td>
<td>Status or state of the subsystem.</td>
</tr>
</tbody>
</table>

**Step 2**
Click *Add MRCP TTS Server* icon that displays in the tool bar in the upper, left corner of the window or the *Add New* button that displays at the bottom of the window to provision a new MRCP ASR Server. The MRCP TTS Server Configuration web page opens.

**Step 3**
Specify the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Server Name</td>
<td>Hostname or IP address of the server the MRCP TTS server software is installed.</td>
</tr>
<tr>
<td>Provider Name</td>
<td>Select the name of the MRCP TTS Provider to which this server is associated from this drop-down list.</td>
</tr>
</tbody>
</table>
The default TCP port number used to connect to an MRCP TTS server. The port number is automatically displayed based on the provider or grammar variant that you have selected while configuring an MRCP TTS provider. Following are the different TCP Provider names along with their port numbers:

- MRCP Server—554
- Nuance Vocalizer—4900 for MRCPv1 and 5060 for MRCPv2
- Scansoft RealSpeak—4900

Languages supported by the TTS Provider. Select a language (or multiple languages) from the drop-down list and click Add Language; the selected language appears in the Enabled Language list.

**Note** Use the check box to disable/enable a language.

**Step 4**

Click Add to apply changes.

Your changes appear in the MRCP TTS Server Configuration web page. You are now ready to provision MRCP TTS Default Genders.

**Note** Whenever a new language is added for an MRCP Server—and if this is the first instance of this language being added for the corresponding MRCP Provider—then the default gender for that locale and for the specified provider is set to Neutral. You should check the MRCP Locales page to review the default genders that are set automatically per locale per provider. Default genders are used when a prompt for a specific locale is used without specifying any gender.

---

**Provision MRCP TTS Default Genders**

Use the MRCP TTS Default Genders Configuration web page to configure the default gender settings per Locale per Provider. TTS uses default genders when a prompt for a specific locale is used without specifying the gender.

**Procedure**

**Step 1**

From the Unified CCX Administration menu bar, choose Subsystems > MRCP TTS > MRCP TTS Default Genders.

The MRCP TTS Default Gender Configuration web page opens, displaying the default genders currently configured for each locale for every MRCP TTS Provider that is currently configured.

**Step 2**

Optionally, change the default gender setting for each locale for each provider.
**Note**  The Locale radio button has the Male, Female, or Neutral options. By default, the “Default Gender” is set to “Neutral” unless configured explicitly.

**Step 3**  Click **Update** to apply changes.

The system updates the default gender setting for each Locale per Provider.
To provision the Unified CCX subsystem, you must provision your telephony and media resources (see the Provision Telephony and Media Resources, on page 59).

Attention
Do not edit users, teams and permissions in Unified Intelligence Center. The Unified CCX to Unified Intelligence Center sync runs as part of daily purge and synchronizes these settings on Unified Intelligence Center according to Unified CCX settings.

The following topics introduce the Unified CCX subsystem and explain how to provision it in the Unified CCX system:

- RmCm Provider Configuration, on page 87
- Resource Groups, on page 89
- Skills Configuration, on page 90
- Agent Configuration, on page 92
- Contact Service Queue Configuration, on page 96
- Configure Agent-Based Routing, on page 104
- Teams Configuration, on page 105

**RmCm Provider Configuration**

The Unified CCX Resource Manager (RM) uses a Unified CM Telephony user (called the RmCm Provider) to monitor agent phones, control agent states, and route and queue calls. For information on adding Unified CM users, see section "Access Control Group Overview" section in the *Cisco Unified Communications Manager Administration Guide* available here:


Note
The RmCm user specified through Unified CCX Administration is updated automatically in Unified CM.
RmCm Provider Modification

**Note**
This section only applies to Unified CCX deployments with Unified CM.

**Caution**
While Unified CM supports Unicode characters in first and last names, those characters become corrupted in Unified CCX Administration web pages for RmCm configuration and real-time reporting.

The RmCm Provider web page is a read-only page that displays the latest configured information. To access this configuration area, choose **Subsystems > RmCm > RmCm Provider** from the Unified CCX Administration menu bar. The RmCm Provider web page opens, displaying the following read-only fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Primary RmCm Provider</td>
<td>The hostname or IP address of the server, running CTI Manager (Unified CM that runs CTI Manager). The RmCm subsystem registers with the CTI Manager so that it can observe an agent's device when the agent logs in. When the CTI Manager fails, the RmCm subsystem registers with the second CTI Manager, if there is one configured.</td>
</tr>
<tr>
<td>Secondary RmCm Provider</td>
<td>The hostname or IP address of the secondary RmCm Provider.</td>
</tr>
<tr>
<td>User ID</td>
<td>The RmCm user ID.</td>
</tr>
</tbody>
</table>

To modify the RmCm Provider, click **Modify RmCm Provider Information** icon in the tool bar in the upper, left corner of the window. The Cisco Unified CM Configuration web page opens.

**Associating Agent Extensions with the RmCm Provider**

**Note**
This section only applies to Unified CCX Deployments with Unified CM.

For every agent/resource created in Unified CM, make sure that the agent phone is also associated with the RmCm Provider. You do this from the Unified CM User Page for the RmCm Provider. In other words, even though you create the RmCm User in Unified CCX Administration, you still need to use the Unified CM interface to associate the RmCm user with an agent phone. These phones are the same as those associated with each agent.
If you use Extension Mobility (EM), ensure that the IPCC extension is associated with the Extension Mobility (EM) User Device Profile (UDP) and not to the physical phone. The Extension Mobility (EM) profile needs to be associated with the RmCm user and the physical phones that the agents may be expected to use should not be associated to the RmCm user.

Related Topics

Modify Unified Communications Manager Telephony Information, on page 25

Resource Groups

Resource groups are collections of agents that your CSQ uses to handle incoming calls. To use resource group-based CSQs, you must specify a resource group.

Create Resource Group

To create a resource group, complete the following steps.

Procedure

Step 1  From the Unified CCX Administration menu bar, choose Subsystems > RmCm > Resource Groups. The Resource Group web page opens with a list of configured resource groups (if any).

Step 2  Click Add New icon in the tool bar in the upper, left corner of the window or Add New button at the bottom of the window. The Resource Group Configuration area opens.

Step 3  In the Resource Group Name field, enter a resource group name. Enter a name that identifies the resource group to which you want to assign agents (for example, “Languages”).

Step 4  Click Add. The Resource Groups page opens displaying the resource group name in the Resource Group Name column.

Modify Resource Group Name

To modify a resource group name, complete the following steps.

Procedure

Step 1  From the Unified CCX Administration menu bar, choose Subsystems > RmCm > Resource Groups. The Resource Group web page opens.
Step 2  In the Resource Group Name column, click the resource group that you want to modify.
The Resource Group Configuration area opens.

Step 3  Type the name of the resource group in the Resource Group Name text field.

Step 4  Click Update to apply the modifications.
The Resource Groups area opens, displaying the modified resource group name in the Resource Group Name column.

Delete Resource Group

When you delete a resource group, the resource group is removed automatically if it is not associated with any agents and CSQs. If the resource group is associated with any agents or CSQs and if you click Delete, you will be directed to another web page, where you can see a list of the associated CSQs and agents, and you are prompted to confirm whether you want to delete the same.

Tip
To delete resource groups, you can use the following procedure or open a Resource Group and click the Delete icon or button in the Resource Group Configuration web page.

To delete a resource group, complete the following steps.

Procedure

Step 1  From the Unified CCX Administration menu bar, choose Subsystems > RmCm > Resource Groups.
The Resource Group web page opens.

Step 2  Click Delete icon next to the name of the Resource Group that you want to delete.
A dialog box opens, warning that the resource group is about to be permanently deleted.

Step 3  Click Continue.
The resource group is deleted.

Skills Configuration

Skills are customer-definable labels assigned to agents. All the Unified CCX license packages can route incoming calls to agents who have the necessary skill or sets of skill to handle the call.

Create a Skill

To create a skill, complete the following steps.
Procedure

Step 1
From the Unified CCX Administration menu bar, choose **Subsystems > RmCm > Skills**.
The Skills web page opens to display the Skill Name (customer-definable label assigned to an agent), if configured.

Step 2
Click **Add New** icon in the tool bar in the upper, left corner of the window or **Add New** button at the bottom of the window.

*Note* When the system reaches the maximum number of skills that can be created, the **Add New** icon or button no longer appears.

The Skill Configuration web page opens.

Step 3
In the Skill Name field, enter a description of a relevant skill (for example, French).

Step 4
Click Add.

The Skills web page opens, showing the skill in the Skill Name column and the total number of skills that exist in the system. You can add a maximum of 150 skills.

---

**Modify a Skill Name**

To modify a skill name, complete the following steps.

Procedure

Step 1
From the Unified CCX Administration menu bar, choose **Subsystems > RmCm > Skills**.
The Skills web page opens.

Step 2
In the Skill Name column, click the skill that you want to modify.
The Skill Configuration web page opens.

Step 3
Modify the name of the skill in the Skill Name text field.

Step 4
Click **Update** to apply the modifications.
The Skills Configuration summary opens, displaying the modified skill name in the Skill Name column.

---

**Delete a Skill**

When you delete a skill, the skill is removed automatically if it is not associated with any agents and CSQs. If the skill is associated with any agents or CSQs and if you click **Delete**, you are directed to another web page, where you can see a list of the associated CSQs and agents, and you are prompted to confirm whether you want to delete the same.
Tip
To delete a skill, you can use the following procedure or open a skill and click **Delete** icon or button in the Skills Configuration web page.

To delete a skill, complete the following steps.

**Procedure**

**Step 1**
From the Unified CCX Administration menu bar, choose **Subsystems > RmCm > Skills**.

The Skills web page opens.

**Step 2**
Click the **Delete** icon next to the name of the skill that you want to delete.

A dialog box opens, warning that the skill is about to be permanently deleted.

**Step 3**
Click **Continue**.

The skill is deleted.

---

**Agent Configuration**

Once the end users in Cisco Unified Communications are defined as agents, the list of agents and their associated Unified CCX devices are displayed in the **Subsystems > RmCm > Resources** page. These agents are also called resources. After you create a resource group, you can assign agents (resources) to that group.

You can add skills to agents once the skills have been created. You can also select the competence level of agents in assigned skills. Competence level indicates agent level of expertise in that skill.

You can assign resource groups and skills to agents either individually or in bulk. The bulk option enables you to assign skills and resource groups to multiple agents at the same time.

Once you assign agents to resource groups and skills, you can create a CSQ.

**Warning**
After an agent is added, wait for 10 minutes for Unified CCX to automatically synchronize or force synchronization before the agent can sign in to Cisco Finesse.

The maximum allowed length of an agent's IPCC Extension is 15.

**Special Characters**

- Unified CM supports the use of special characters—square brackets ([ ]), dollar ($), ampersand (&), single quotes (‘’), colon (:), angle brackets (< >), forward slash (/), question mark (?), backward slash (\), parentheses ({ }), double quotes(""), hash(#), percent (%), semicolon (;), comma (,), pipe (|), tilde (\n
---

1 Unified Communications users in a Unified CM deployment refers to a Unified CM user.
and space in a user ID when you configure end users. However, Unified CCX restricts the use of these characters when you configure end users as agents or supervisors.

- Unified CCX does not support the use of special characters—square brackets ([ ]), dollar ($), ampersand (&), single quotes (’), colon (:), angle brackets (< >), forward slash (/), question mark (?), backward slash (\), parentheses ( { } ), double quotes (“ ”), hash (#), percent (%), semicolon (;), comma (,), pipe (|), tilde (~).

- With Cisco Finesse for Unified CCX, agent IDs (or usernames) are case-sensitive and can contain letters, numbers, hyphens (-), underscores (_), at (@), and periods (.). They cannot begin or end with a period or contain two periods in a row. Finesse agent usernames are restricted to 7-bit printable ASCII characters (any of the 94 characters with the numeric values from 33 to 126). They do not support double quotes (“ ”), forward slash (/), backward slash (\), square brackets ([ ]), colon (:), semicolon (;), pipe (|), equal to (=), comma (,), add (+), star (*), question mark (?), angle brackets (< >), hash (#), percent (%), SPACE and the characters restricted by Unified Communications Manager and Unified CCX.

- Finesse agent passwords are restricted to 7-bit printable ASCII characters (any of the 94 characters with the numeric values from 32 to 126). They do not support control characters (for example, Tab) or international characters.

- Agent Alias name now supports the use of SPACE in the name.

**Implications of Deleting Agents in Unified CM**

If you modify an agent's record in Unified CM (for example, changing the Unified CCX extension or deleting the agent), ensure to refresh the user page on Unified CCX Administration interface so that the agent information in the Unified CCX RmCm subsystem is updated. Choose **Subsystems > RmCm > Resources** option to update the Unified CCX information in the Unified CCX Administration any time. If you change the Unified CCX extension of an agent who is currently logged in, the agent will continue to use the old extension until the agent logs off. The agent must log off and then log back in to the Cisco Finesse desktop to get the new extension. When Unified CCX performs an agent sync and detects that the agent no longer exists in Unified CM, the contact is marked as inactive in the **Resource** table of the Unified CCX Historical Reporting Database (db_cra). The resource is not deleted as the resource information is referenced for the HR reports.

---

**Caution**

Deleting Inactive Agents removes the agent details and records from the Historical Reporting Database, and HR reports will not display historical information of these agents.

If Unified CM connection errors have occurred, all agents will not be visible to Unified CCX. In this case, Unified CCX interprets these agents as deleted agents. As a result, the Inactive Agents list will not be accurate. When the errors are resolved, click **Inactive Agents** again to see an accurate list.

**Assign Resource Groups and Skills to One Agent**

To assign a resource group and skills to an individual agent, complete the following steps.

**Procedure**

**Step 1**

From the Unified CCX Administration menu bar, choose **Subsystems > RmCm > Resources**.
The Resources web page opens.

**Note** Only agents or supervisors who have assigned Unified CCX extensions are displayed in the list of resources in the Resources area.

**Step 2** Click the name of the agent in the Resource Name column.

The Resource Configuration web page opens.

**Step 3** Specify the following fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resource Name</td>
<td>Name of the agent (display only).</td>
</tr>
<tr>
<td>Resource ID</td>
<td>Unique identifying number of the agent (display only). This is the alpha-numeric user id assigned in the Unified CM End User Configuration page.</td>
</tr>
<tr>
<td>Unified CCX Extension</td>
<td>Unified CCX Extension assigned to the resource group (display only). This is the IP Phone extension assigned to the user from the Unified CM End User Configuration page as IPCC Extension.</td>
</tr>
<tr>
<td>Resource Group</td>
<td>A resource group with which to associate the agent (optional).</td>
</tr>
<tr>
<td>Automatic Available</td>
<td>Accept the default (Enabled) to automatically put the agent into the Available or Ready state after the agent finishes a call and disconnects. <em>Note</em> When a logged on agent in Ready, Not Ready, or Work state answers a call, the agent state is subject to the Automatic Available setting.</td>
</tr>
<tr>
<td>Assigned/Unassigned Skills</td>
<td>Select one or more skills from the Unassigned Skills list and click &lt; to add the skills to the Assigned Skills List. Select one or more skills from the Assigned Skills List and click &gt; to remove skills from the Unassigned Skills list. You can assign up to 50 skills to the agent.</td>
</tr>
<tr>
<td>Competence Level</td>
<td>Select a skill from the Assigned Skills list and choose a number from the Competence Level drop-down menu Changes the competence level of an assigned skill (1 = Beginner, 10 = Expert). <em>Note</em> You can change the competency level one skill at a time, only. You cannot change skill competency level as a bulk procedure.</td>
</tr>
<tr>
<td>Team</td>
<td>A group of agents who assign the team to which the resource belongs.</td>
</tr>
<tr>
<td>Agent Alias</td>
<td>Agent alias is the name used instead of the agent ID when an agent chats with a customer. This option is available only when Finesse is used by the chat agent.</td>
</tr>
</tbody>
</table>

**Step 4** Click **Update** to apply the changes.
The Resources area of the RmCm Configuration summary web page opens, and the agent is now assigned to the resource group and skills (if skills were assigned).

---

**Assign Resource Groups and Skills to Multiple Agents**

To assign resource groups and skills to agents in bulk, complete the following steps.

**Procedure**

**Step 1**  
From the Unified CCX Administration menu bar, select **Subsystems > RmCm > Assign Skills**.  
The Assign Skills summary web page opens.  
**Tip** Only agents or supervisors who have assigned Unified CCX extensions are displayed in the list of resources in the Resources area.

**Step 2**  
In the Resource Name column, check the check box beside each agent to whom you want to assign set of same resource group and skills.  
In the Resource Name column, check the check box next to each agent you want to assign set of same resource group and skills.  
**Note** You can check the **Select All** check box to select all agents.  
The Skill summary web page shows the total number of skills created.

**Step 3**  
Click **Add Skill** icon that displays in the tool bar in the upper, left corner of the window or the **Add Skill** button that displays at the bottom of the window.  
The Add Skill web page opens.

**Step 4**  
Specify the following fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resource Group</td>
<td>To assign a resource group to all the selected agents, choose a resource group from the Resource Group drop-down menu.</td>
</tr>
</tbody>
</table>
| Skills to Add  | Select one or more skills from the Skills list and click < to add the skills to Add List.  
**Note** The Skills to Add list contains all skills, not just the skills that agents already have. |
| Skills         | List of the available skills.                                               |
| Competence Level| Select a skill from the Assigned Skills list and choosing a number from the Competence Level drop-down menu |

**Step 5**  
Click **Update** to apply the changes.
The Assign Skills area of the RmCm Configuration web page opens, and the agents are now assigned to the resource group and their skills (if skills were assigned).

---

**Remove Skills from Agents**

**Note**
If a resource is not assigned a skill that you attempt to remove, the resource is not updated. However, the system will still generate a related message.

To remove skills from agents, complete the following steps.

**Procedure**

**Step 1**
From the Unified CCX Administration menu bar, choose **Subsystems > RmCm > Assign Skills.**

The Assign Skill summary web page opens.

**Step 2**
In the Resource Name column, click the check box next to the agent you want to remove skills from.

**Note**
You can click **Select All** check box to select all agents.

**Step 3**
Click **Remove Skill** icon that displays in the tool bar in the upper, left corner of the window or the **Remove Skill** button that displays at the bottom of the window.

The Remove Skill Configuration web page opens.

**Step 4**
Remove skills by choosing one or more skills from the Skills list and clicking > to move the skills to the Skills to Remove list.

**Step 5**
Click **Update** to apply the changes.

The Assign Skills area of the RmCm Configuration web page opens, and the agents are no longer assigned to the skills.

---

**Contact Service Queue Configuration**

The Contact Service Queue (CSQ) controls incoming calls by determining where an incoming call should be placed in the queue and to which agent the call is sent.

After you assign an agent to a resource group and assign skills, you need to configure the CSQs.

You assign agents to a CSQ by associating a resource group or by associating all skills of a particular CSQ. Agents in the selected resource group or who have all the selected skills are assigned to the CSQ.

Skills within the CSQ can be *ordered*. This means, when resources are selected, a comparison is done based on the competency level (highest for “most skilled” and lowest for “least skilled”) of the first skill in the list. If there is a “tie” the next skill within the order is used, and so on.
Skills within the CSQ can also be weighted. The weight value is an integer from 1 to 1000. Each competency level is multiplied by the skill's associated weight, and a final comparison is done on the sum of all the weighted skill competencies (highest value for “most skilled” and lowest for “least skilled”). The maximum number of CSQs in the system depends on the type of server on which the engine is running.


Each agent can belong to up to 25 CSQs. To ensure that agents are not assigned to more than 25 CSQs, click Resources submenu option in the RmCm Configuration web page, and click Open Resources Summary Report icon. The report opens, listing each agent and the number of CSQs to which the agent belongs. If the agent belongs to more than 25 CSQs, modify the skills and resource groups to which the agent is assigned so that the agent does not belong to more than 25 CSQs.

### Create a Contact Service Queue

To create a new CSQ and assign agents, complete the following steps.

**Procedure**

#### Step 1
From the Unified CCX Administration menu bar, choose Subsystems > RmCm > Contact Service Queues.

The Contact Service Queues web page opens.

Use this web page to view the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the resource or skill group.</td>
</tr>
<tr>
<td>Contact Queuing Criteria</td>
<td>Algorithm used to order the queued calls (contacts).</td>
</tr>
<tr>
<td>Resource Pool Selection Model</td>
<td>The resource selection criteria chosen for this CSQ.</td>
</tr>
<tr>
<td>Resource Pool</td>
<td>The skills or resource group used for this CSQ.</td>
</tr>
<tr>
<td>CSQ Type</td>
<td>The type of the CSQ.</td>
</tr>
<tr>
<td>Delete</td>
<td>Deletes the selected CSQ.</td>
</tr>
</tbody>
</table>

#### Step 2
Click Add New icon that displays in the tool bar in the upper, left corner of the window or the Add New button that displays at the bottom of the window.

The Contact Service Queue Configuration web page opens.

**Note** If this link does not appear on the page, it means that the system has reached the maximum number of CSQs that can be created. The CSQ Summary page displays the total number of created CSQs.

#### Step 3
Use the Contact Service Queue Configuration web page to specify the various fields. For more information on the fields, see [Contact Service Queue Configuration Web Page](https://www.cisco.com/c/en/us/products/contact-center/unified-contact-center-express/datasheet-listing.html).

#### Step 4
Click Next.

The second Contact Service Queue Configuration area opens with the newly-assigned CSQ Name.
**Step 5** Select an option from the Resource Selection Criteria drop-down menu.

**Note** The Resource Pool Selection Model settings determine the options available in this drop-down menu.

- **Longest Available**—Selects the agent who has been in the Available state for the longest amount of time.
- **Most Handled Contacts**—Selects the agent who has handled the most calls.
- **Shortest Average Handle Time**—Selects the agent who generally spends the least amount of time talking to customers.
- **Most Skilled**—Used for expert agent call distribution. Selects the agent with the highest total competency level. The total competency level is determined by adding the agent’s competency levels for each of their assigned skills that are also assigned to the CSQ.
  - Example 1: If Agent1 is assigned Skill1(5), Skill2(6), and Skill3(7) and CSQ1 specifies Skill1(min=1) and Skill3(min=1), the total competency level for Agent1 for CSQ1 is 12.
  - Example 2: If Agent1 is assigned Skill1(5) and Skill2(6) and Skill3(7) and CSQ1 specifies Skill1(min=1), only, the total competency level for Agent1 for CSQ1 is 5.
- **Least Skilled**—Used for expert agent call distribution. Selects the agent with the lowest total competency level. The total competency level is determined by adding the agent’s competency level in each assigned skill.
- **Most Skilled by Weight**—Used for expert agent call distribution. Selects the agent with the highest total competency level multiplied by the skill’s associated weight.
- **Least Skilled by Weight**—Used for expert agent call distribution. Selects the agent with the lowest total competency level multiplied by the skill’s associated weight.
- **Most Skilled by Order**—Used for expert agent call distribution. Selects the agent with the highest total competency level in the ordered list.
- **Least Skilled by Order**—Used for expert agent call distribution. Selects the agent with the lowest total competency level in the ordered list.

**Note** If two or more agents have equal competency level, the selection automatically defaults to **Longest Available** selection criteria.

**Step 6** Specify the following settings, as necessary:

**Note** The Resource Pool Selection Model setting determines the availability of these options.

a) Use the Select Skills list to highlight the skills you want; click the **Add** button next to the list.

b) Specify a Minimum Competence Level for the skills assigned to the CSQ. Depending on the Resource pool criteria you chose, specify a Weight value between 1 and 1000.

c) If the Resource Selection Criteria is Most Skilled by Order or Least Skilled by Order, use the arrow icons to order the skills by moving them up or down in the list.

**Note** Use the **Delete** icon next to a skill to delete that skill from the Skills Required list.

**Step 7** If you selected one of the Least/Most Skilled options as shown in the list below for the Resource Selection Criteria, you can view the agent order using **Show Resources** icon or button.
The order of the agents determines the priority, with the agent at the top of the list having the highest priority.

To change the order of the agents belonging to the CSQ, you should modify the skill set of the agents. The Least/Most Skilled Resource Selection Criteria option comprises the following:

a) Most Skilled  
b) Least Skilled  
c) Most Skilled by Order  
d) Least Skilled by Order  
e) Most Skilled by Weight  
f) Least Skilled by Weight

**Step 8**  
If you selected *Resource Groups* as the Resource Pool Selection Model on the previous page, follow these steps:

a) Select an option from the Resource Selection Criteria drop-down menu.
   - **Longest Available**—Selects the agent who has been in the Available state for the longest amount of time.
   - **Linear**—Selects the next available agent with the highest priority, as determined by the agent order in the Resources list.
   - **Circular**—Selects the next available agent with the highest priority, based on the last agent selected and the agent order in the Resources list.
   - **Most Handled Contacts**—Selects the agent who has handled the most calls.
   - **Shortest Average Handle Time**—Selects the agent who generally spends the least amount of time talking to customers.

b) Choose the resource group for this CSQ from the Resource Group drop-down menu.

c) Click **Show Resources** icon to show all agents who meet the specified criteria.

d) If you selected *Linear* or *Circular* as the Resource Selection Criteria, if necessary, rearrange the order of agents in the Resources list by highlighting an agent and using the up and down arrows to move the agent in the list.

e) Click **Add** to apply changes and update the system.

The new CSQ is now displayed, and all agents who belong to the resource group or all selected skill groups are now a part of this CSQ.

**Related Topics**

[Contact Service Queue Configuration Web Page](#), on page 99

### Contact Service Queue Configuration Web Page

Contact Service Queue Configuration web page:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contact Service Queue Name</td>
<td>Enter a meaningful name that is concise, yet easy to recognize (for example, Language Experts). This is a mandatory field.</td>
</tr>
<tr>
<td><strong>Field</strong></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td>-------------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Contact Service Queue Type</td>
<td>Display only. Voice—Agents in this CSQ can handle inbound and outbound voice calls.</td>
</tr>
<tr>
<td>Contact Queuing Criteria</td>
<td>Display only. Displays the criteria used for queuing the contacts. For example, First In, First Out (FIFO).</td>
</tr>
<tr>
<td>Automatic Wrapup</td>
<td>Determines whether agents handling calls that are routed through this CSQ automatically enter the Wrapup state when a call ends. This field is mandatory. Options are: • Enabled—Agents associated to a CSQ that has the Automatic Wrapup option enabled, enter the Wrapup state automatically when on a call. CSQ ends. If agents are associated to a CSQ that has the Automatic Wrapup option disabled handle transferred calls that were originally delivered by a CSQ that has Automatic Wrapup enabled, they also enter the Wrapup state automatically when a call ends. • Disabled (default)—Agents enter Ready or Not Ready state when a call ends, depending on the Automatic Available setting.</td>
</tr>
<tr>
<td>Wrapup Time</td>
<td>Determines the length of the Wrapup state for this CSQ when a call ends. Options are: • Enabled button with Seconds field—The Seconds field specifies the length of the Wrapup state phase. • Disabled—No limit on how long the agent can stay in the Wrapup state.</td>
</tr>
<tr>
<td>Resource Pool Selection Model</td>
<td>Select one of the following options from the drop-down menu: • Resource Skills—To create a skills-based CSQ. • Resource Group—To create a resource group-based CSQ. This is a mandatory field.</td>
</tr>
<tr>
<td>Service Level</td>
<td>The target maximum number of seconds a call is queued before it is connected to an agent. This is a mandatory field.</td>
</tr>
<tr>
<td>Service Level Percentage</td>
<td>The target goal for percentage of contacts that meet the service level. This is a mandatory field. For example, a call center that has a service level of 20 and a service level percentage of 80 percent has a goal of answering 80 percent of its calls within 20 seconds.</td>
</tr>
</tbody>
</table>
Modify a Contact Service Queue

Note

Changes take effect when all agents affected by the changes have left the Ready state. Emails Contact Service Queues cannot be modified. It is for display only.

To modify an existing CSQ, complete the following steps.

Procedure

Step 1
From the Unified CCX Administration menu bar, choose Subsystems > RmCm > Contact Service Queues.
The Contact Service Queues web page opens.

Step 2
In the Name list, click the CSQ that you want to modify.
The Contact Service Queue Configuration page opens.

Step 3
Modify the Contact Service Queue Configuration information as necessary.

Note  If you change an existing CSQ name, the old name still exists in the HR reports and the CSQ is not removed even if all the data is purged.

Step 4
Click Next icon that displays in the tool bar in the upper, left corner of the window or the Next button that displays at the bottom of the window to view and update the remaining fields.

Step 5
Click Update icon in the top of the window or the Update button that displays at the bottom of the window to apply the modifications.
Ensure that the Resource Selection Criteria is changed only when there are no agents signed in. If there are active agents, these changes take effect only when all the active agents sign out and sign in again.

Delete a Contact Service Queue

When you delete a CSQ, any skills or resource groups assigned to that CSQ are automatically removed from the CSQ, and any application using that CSQ can no longer access it. Before deleting the CSQ, change the applications to use a different CSQ. If the application is using a CSQ when the CSQ is deleted, new incoming calls will get an error and existing queued calls will not be routed to agents.

Note
- Existing Email Contact Service Queues can be deleted.
- Ensure that all the emails that are assigned to an Email Contact Service Queue are handled before the CSQ is deleted.

To delete a CSQ, complete the following steps.

Procedure

Step 1
From the Unified CCX Administration menu bar, choose Subsystems > RmCm > Contact Service Queues. The Contact Service Queues web page opens.

Step 2
Click the Delete icon next to the name of the CSQ that you want to delete.

Note
You can also delete a CSQ from its Contact Service Queue Configuration page using the Delete icon or button.

Resource Pool Selection Criteria: Skills and Groups

The resource selection criteria available for CSQs with Resource Skills is different from that of CSQs with Resource Groups.

Example—in a banking application with two skills (Banking and CreditCard) and one Resource Group (GeneralQueries), assume that the following agents, skills, and resource groups are defined:

<table>
<thead>
<tr>
<th>Agent ID</th>
<th>Assigned Skills</th>
<th>Resource Group</th>
</tr>
</thead>
<tbody>
<tr>
<td>Agent1</td>
<td>Banking (Competence Level 10)</td>
<td>GeneralQueries</td>
</tr>
<tr>
<td></td>
<td>CreditCard (Competence Level 6)</td>
<td></td>
</tr>
</tbody>
</table>
In addition, suppose you had the following Contact Service Queue information defined:

Table 1: Agent Skill and Resource Group Settings

<table>
<thead>
<tr>
<th>CSQ Name</th>
<th>Resource Pool Selection Model</th>
<th>Resource Selection Criteria</th>
<th>Skill/Competence</th>
<th>Available Agents</th>
</tr>
</thead>
<tbody>
<tr>
<td>CSQ1</td>
<td>Resource Skills</td>
<td>Most Skilled</td>
<td>Banking Minimum competency: 5</td>
<td>Agent1, Agent2</td>
</tr>
<tr>
<td>CSQ2</td>
<td>Resource Skills</td>
<td>Most Skilled</td>
<td>CreditCard Minimum competency: 5</td>
<td>Agent1, Agent2</td>
</tr>
<tr>
<td>CSQ3</td>
<td>Resource Group</td>
<td>Longest Available</td>
<td>GeneralQueries</td>
<td>Agent1, Agent2, Agent3</td>
</tr>
</tbody>
</table>

In this scenario, if a caller calls with a question about CreditCard information and there are no CSQs currently available with CreditCard skills (that is, Agent1 and Agent2), there is a possibility for Agent3—who has no CreditCard skill—to get selected as the Longest Available Agent.

To avoid such a situation, you could design the script to always look into CSQ2 for available agents since it has the highest competency of 10 for CreditCard, and agent selection here is based on most skilled.

Note: If two or more agents have equal competency level, the selection automatically defaults to Longest Available selection criteria.

Resource Skill Selection Criteria within a Contact Service Queue

Resource selection within a CSQ is based on the resource competency levels of the skills associated to the CSQ. You can choose between the most and least skilled.

The Unified CCX system defines a Level 10 competency to be the highest skill level, while a Level 1 denotes the lowest skill level. When more than one skill is involved, each skill is given the same weight, meaning no preference is given to any skill. A comparison is performed on the sum of all the competency levels for the associated skills. (Skills assigned to resources but not associated to the CSQ are ignored.) In the case of a tie when skill competencies are equal, the resource that has been ready for the longest amount of time will be chosen.

The following table provides examples of how Unified CCX selects resources within a CSQ.
Table 2: Resource Skill Selection Criteria

<table>
<thead>
<tr>
<th>Example</th>
<th>CSQ Skills</th>
<th>Agent Competency Levels</th>
<th>Sequence Agents Become Ready</th>
<th>Selection Order</th>
</tr>
</thead>
<tbody>
<tr>
<td>Most skilled resource selection model</td>
<td>Technical Support</td>
<td>Agent A = 10, Agent B = 10, Agent C = 5</td>
<td>A, B, C</td>
<td>A, B, C</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>C, A, B</td>
<td>A, B, C</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>A, C, B</td>
<td>A, B, C</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>C, B, A</td>
<td>B, A, C</td>
</tr>
<tr>
<td>Least skilled resource selection model</td>
<td>Technical Support</td>
<td>Agent A = 10, Agent B = 10, Agent C = 5</td>
<td>A, B, C</td>
<td>C, A, B</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>C, A, B</td>
<td>C, A, B</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>A, C, B</td>
<td>C, A, B</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>C, B, A</td>
<td>C, B, A</td>
</tr>
</tbody>
</table>

**Note** The ordering in the two examples above are not opposite because the selection criteria has changed from most to least skilled—when competency levels are equal, both selection models choose the resources that have been available for the longest time.

<table>
<thead>
<tr>
<th>Example</th>
<th>CSQ Skills</th>
<th>Agent Competency Levels</th>
<th>Sequence Agents Become Ready</th>
<th>Selection Order</th>
</tr>
</thead>
<tbody>
<tr>
<td>Most skilled resource selection model</td>
<td>SalesSupport</td>
<td>Agent A = Sales (10) Support (5), Agent B = Sales (5), Support (10), Agent C = Sales (5) Support (1)</td>
<td>A, B, C</td>
<td>A, B, C</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>C, A, B</td>
<td>A, B, C</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>A, C, B</td>
<td>A, B, C</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>C, B, A</td>
<td>B, A, C</td>
</tr>
<tr>
<td>Least skilled resource selection model</td>
<td>SalesSupport</td>
<td>Agent A = Sales (10) Support (5), Agent B = Sales (5), Support (10), Agent C = Sales (5) Support (1)</td>
<td>A, B, C</td>
<td>C, A, B</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>C, A, B</td>
<td>C, A, B</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>A, C, B</td>
<td>C, A, B</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>C, B, A</td>
<td>C, B, A</td>
</tr>
</tbody>
</table>

**Configure Agent-Based Routing**

Agent-based routing provides the ability to send a call to a *specific* agent, rather than any agent available in a CSQ.

Use the Agent Based Routing Settings web page to configure system-wide parameters to be used in an agent-based routing application.
Procedure

Step 1
From the Unified CCX Administration menu bar, choose **Subsystems > RmCm > Agent Based Routing Settings**. The Agent Based Routing Settings area opens.

**Note** The Agent Based Routing Settings are available only if you are using Unified CCX Enhanced or Premium license packages.

Step 2
Specify the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Automatic Wrapup</td>
<td>Determines whether agents handling calls that are routed through this CSQ automatically enter the Automatic Wrapup state when a call ends.</td>
</tr>
<tr>
<td></td>
<td>• Enabled—Agents associated to a CSQ that has the Automatic Wrapup option enabled enter the Wrapup state automatically when on a call. If agents are associated to a CSQ that has the Automatic Wrapup option disabled handle transferred calls that were originally delivered by a CSQ that has Automatic Wrapup enabled, they also enter the Wrapup state automatically when a call ends.</td>
</tr>
<tr>
<td></td>
<td>• Disabled (default)—Agents enter Ready or Not Ready state when a call ends, depending on the Automatic Available setting.</td>
</tr>
<tr>
<td>Wrapup Time</td>
<td>Determines if agents automatically enter Wrapup when a call ends.</td>
</tr>
<tr>
<td></td>
<td>• Enabled button with seconds field—Controls how long the agent can stay in the Wrapup state if Automatic Wrapup is enabled. The seconds field specifies the Wrapup time length.</td>
</tr>
<tr>
<td></td>
<td>• Disabled (default)—No limit of how long the agent can stay in the Wrapup state if Automatic Wrapup is enabled.</td>
</tr>
</tbody>
</table>

Step 3
Click **Save** icon that displays in the tool bar in the upper, left corner of the window or the **Save** button that displays at the bottom of the window to apply changes.

Wrap-Up Data Usage
Contact centers use wrap-up data to track the frequency of activities or to identify the account to which a call is charged, and other similar situations. Like reason codes, wrap-up data descriptions are set up by your system administrator to reflect the needs of your contact center. By default this feature is disabled.

Teams Configuration
A **team** is a group of agents who report to the same Supervisor. A team can have one primary Supervisor and optional secondary Supervisors. A Supervisor can also monitor CSQs that are assigned to the team being supervised.
**Barge-in** is when a Supervisor joins an existing call between an agent and a customer.

**Intercept** is when the Supervisor joins a call and drops the agent from the call.

A **default team** is automatically created by the system and cannot be deleted. If agents are not assigned to any team, they belong to the default team. When an agent is assigned to a team, the team Supervisor can barge-in and intercept any call being handled by the agent.

---

**Note**

Before creating a team, you must set up Supervisors using the User Management page.

---

**Note**

The Advanced Supervisor Capability of Queue Management is removed when:

- Supervisor is not associated to any team.
- Supervisor is not the primary or secondary Supervisor of any team.
- There are no CSQs assigned to the teams associated to the Supervisor.

---

**Note**

A team that accesses Live Data reports is limited to 50 agents.

---

**Assign Supervisor Privilege to a User**

Perform the following procedure to assign supervisor privilege to a user.

**Procedure**

**Step 1**

From the Unified CCX Administration menu, choose **Tools > User Management > User View**.

The User Configuration page displays the list of all users.

**Step 2**

Click the user to whom you want to assign supervisor capability.

The User Configuration page displays information about that user. In the Capabilities section, the left pane displays the list of assigned capabilities and the right pane displays the list of capabilities.

**Step 3**

Using the left arrow, assign Supervisor capability.

**Step 4**

Click **Update** to save your changes.

Agents, who have logged in must logout and login again to use supervisor specific features.

For agents with chat or email skill, who have logged in, it may take maximum of 30 mins to reflect the change.
Create Teams

Use the Teams area of the RmCm Configuration web page to create or associate teams with various agents, CSQs, and supervisors.

**Procedure**

**Step 1**  
From the Unified CCX Administration menu bar, choose **Subsystems > RmCm > Teams**.

**Step 2**  
Click **Add New** icon that displays in the tool bar in the upper, left corner of the window or the **Add New** button that displays at the bottom of the window.

The Team Configuration page appears.

**Step 3**  
Enter the **Team Name**.

**Step 4**  
Select the **Primary Supervisor** from the drop-down list.

**Step 5**  
(Optional) Select the secondary supervisor name from the **Available Supervisors** list and use the arrow icon to move it into the **Secondary Supervisors** list.

**Step 6**  
(Optional) Select an agent name in the **Available Resources** list and use the arrow icon to move it into the **Assigned Resources** list to add an agent to this team.

**Step 7**  
(Optional) Select the CSQ name in the **Available CSQs** list and use the arrow icon to move it into the **Assigned CSQs** list to add the CSQ to this team.

**Step 8**  
Click **Add** to apply changes.

Modify Teams

Use the Teams area to modify the supervisors, agents, CSQs, or auto answer configuration on an existing Team.

**Procedure**

**Step 1**  
From the Unified CCX Administration menu bar, choose **Subsystems > RmCm > Teams**.

**Step 2**  
Click a name in the **Team Name** column

The Team Configuration page appears.

**Step 3**  
Select the **Primary Supervisor** from the drop-down list.

**Step 4**  
(Optional) Select the secondary supervisor name from the **Available Supervisors** list and use the arrow icon to move it into the **Secondary Supervisors** list.

To remove the secondary supervisor name from this team, select the supervisor name in the **Secondary Supervisors** list and use the arrow icon to move it into the **Available Supervisors** list. This supervisor now belongs to the default team.

**Step 5**  
(Optional) Select an agent name in the **Available Resources** list and use the arrow icon to move it into the **Assigned Resources** list to add an agent to this team.
To remove an agent from this team, select an agent name in the Assigned Resources list and use the arrow icon to move it into the Available Resources list. This agent now belongs to the default team.

**Step 6** *(Optional)* Select the CSQ name in the Available CSQs list and use the arrow icon to move it into the Assigned CSQs list to add the CSQ to this team.

To remove a CSQ from this team, select a CSQ name in the Assigned CSQs list and use the arrow icon to move it into the Available CSQs list. This CSQ now belongs to the default team.

**Step 7** Click Update to apply changes.

---

**Delete a Team**

Use the Teams area of the RmCm Configuration web page to delete an existing Team.

**Procedure**

**Step 1** From the Unified CCX Administration menu bar, choose Subsystems > RmCm > Teams.

The Teams web page opens.

**Step 2** Click the Delete icon beside the Team Name icon you want to delete.

The system prompts you to confirm the delete.

**Step 3** Click OK.
To provision additional subsystems, you must complete the following tasks:

- Log into the Unified CCX Administration.
- Provision your telephony and media resources.
- Provision your Unified CCX subsystem, if required.

The following sections introduce the additional Unified CCX subsystems and explain how to provision them.

- About Additional Subsystems, on page 109
- Provision of HTTP Subsystem, on page 110
- Provision of Database Subsystem, on page 111
- Provision eMail Subsystem, on page 114

About Additional Subsystems

Your Unified CCX system may include some or all of the following additional subsystems:

- The HTTP subsystem—The Unified CCX system uses the HTTP subsystem to enable Unified CCX applications to respond to requests from a variety of web clients, including computers and IP phones.
- The Database subsystem—The Unified CCX system uses the Database subsystem to enable Unified CCX applications to interact with customer-provided enterprise database servers to make database information accessible to contacts.
- The eMail subsystem—The Unified CCX system uses the eMail subsystem to communicate with your email server and enable your applications to create and send email.

If you plan to run applications that use any of the additional Unified CCX subsystems included in your Unified CCX package, you should now provision those subsystems. The Unified CCX system uses these additional subsystems to communicate with supporting systems such as web servers, database servers, and email servers.

Note

You need to provision a particular subsystem only if you are using Unified CCX applications that require it.
Provision of HTTP Subsystem

Note
The HTTP subsystem is available if your system has a license installed for one of the following Cisco product packages: Unified IP IVR or Unified CCX Premium.

The Unified CCX system uses the HTTP subsystem to enable Unified CCX applications to respond to requests from a variety of web clients, including computers and IP phones.

Note
If you are not using HTTP applications, you do not need to provision the HTTP subsystem.

The Unified CCX system uses subdirectories in the Unified CCX installation directory to store text substitution, eXtensible Style Language (xsl) templates, static and dynamic web pages, and Java Servlet Pages (JSPs).

Note
Use the Document Management page to upload these documents.

To provision the HTTP subsystem, you need to provision HTTP triggers. HTTP applications use triggers to activate the application in response to an incoming HTTP message.

Note
You cannot change the TCP/IP port numbers used by the HTTP subsystems or triggers in Unified CCX.

Configure HTTP Triggers

You need to create an application using Applications > Application Management menu from the Unified CCX Administration menu bar. After you create an application, you can configure HTTP triggers for the application using the following procedure.

Procedure

Step 1
From the Unified CCX Administration menu bar, choose Subsystems > HTTP. The HTTP Trigger Configuration web page opens.

Step 2
Specify the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>URL</td>
<td>The relative URL. For example: /hello</td>
</tr>
</tbody>
</table>
Provision of Additional Subsystems

Provision of Database Subsystem

The Database subsystem is available if your system has a license installed for either the Unified IP IVR or Unified CCX Premium product packages. If you are not using Unified CCX applications that require access to databases, you do not need to provision the Database subsystem.

The Unified CCX system uses the Database subsystem to enable Unified CCX applications to interact with database servers to make database information accessible to contacts.

Caution

The Database subsystem does not support database views or execute stored procedures.

Database Subsystem Configuration

The Database subsystem enables the Unified CCX applications to obtain information from data sources, which are databases configured to communicate with the Unified CCX system. You can connect the Unified CCX system with enterprise databases such as Microsoft SQL Server, Sybase, Oracle, or IBM DB2.

You can upload JDBC driver files using Subsystems > Database > Drivers menu option.

Note

To determine a list of enterprise databases supported for the Database subsystem, see the Unified CCX Compatibility related information, located at: https://www.cisco.com/c/en/us/support/customer-collaboration/unified-contact-center-express/products-device-support-tables-list.html.

---

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application Name</td>
<td>Select an application for which you want to add a HTTP trigger from this list box.</td>
</tr>
<tr>
<td>Sessions</td>
<td>The maximum amount of simultaneous sessions (instances) that the application can handle.</td>
</tr>
<tr>
<td>Enabled</td>
<td>Click the required radio button to accept - Yes (the default). Note If you disable the trigger, the user receives an error message when browsing to the defined trigger URL.</td>
</tr>
</tbody>
</table>

Step 3

Click Add New.

The HTTP Trigger Configuration web page closes, and the trigger information appears on the HTTP Trigger Configuration summary web page.

You are now ready to provision any additional subsystems your Unified CCX applications require or to begin configuring Unified CCX applications.
Add New Datasource

After uploading the JDBC driver, you need to use this to create the datasource in the Database subsystem. To add a new data source, complete the following steps.

**Procedure**

**Step 1**
From the Unified CCX Administration menu bar, choose **Subsystems > Database > DataSource**. Click **Add New** icon that displays in the tool bar in the upper, left corner of the window or the **Add New** button that displays at the bottom of the page.

The Datasource Configuration web page opens. For more information on the web page fields, see **Datasource Configuration Web Page**.

**Step 2**
Click **Add** to save the changes.

The Enterprise Database Subsystem Configuration web page opens. You are now ready to provision any additional subsystems your Unified CCX applications require or to begin configuring Unified CCX applications.

**Related Topics**

- **Datasource Configuration Web Page**, on page 112

**Datasource Configuration Web Page**

Datasource Configuration web page.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Source Name</td>
<td>Data source name for referring to the datasource. This is a mandatory field.</td>
</tr>
<tr>
<td>User Name</td>
<td>Username defined for connecting to the enterprise database. This is a mandatory field.</td>
</tr>
<tr>
<td>Password</td>
<td>Password defined for connecting to the enterprise database.</td>
</tr>
<tr>
<td>Confirm Password</td>
<td>Re-enter the password that you provided in the Password field.</td>
</tr>
<tr>
<td>Maximum Number of Connections</td>
<td>Maximum number of connections allowed to connect to the database.</td>
</tr>
<tr>
<td></td>
<td>This database is usually an external database to which the customer script can connect. While the limit is set by that database and governed by your license, if this number in this setting is exceeded, the corresponding workflow is aborted and the caller receives an error message. However, you can avoid this error by configuring the appropriate number of sessions in the corresponding script or application. Also, the script writer can provide information about how many connections are used per call (or instance of application). This is a mandatory field.</td>
</tr>
<tr>
<td>Driver</td>
<td>Displays the list of available drivers for the enterprise database. One or more datasources can use the same driver. Select a driver for this datasource from this list box. This is a mandatory field.</td>
</tr>
</tbody>
</table>
Poll Database Connectivity

To poll connectivity to the database on a periodic basis, complete the following steps.

Procedure

| Step 1 | From the Unified CCX Administration menu bar, choose Subsystems > Database > Parameters.
The Parameters web page opens to display the parameter-related fields.

Step 2 | Specify the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>RetryConnectInterval</td>
<td>Specifies the interval between two connection attempts when a data source is initialized. The default is 15,000 milliseconds.</td>
</tr>
<tr>
<td>NumAttempt</td>
<td>Specifies the number of attempts to establish connections to the database when a data source is initialized. The default is 3 attempts.</td>
</tr>
<tr>
<td>LoginTimeout</td>
<td>Sets the maximum time in seconds that a driver will wait while attempting to connect to a database. The default is 0 (disabled).</td>
</tr>
</tbody>
</table>

Step 3 | Click Update to apply changes (or Reset to Default if you prefer to retain the default values).
The window refreshes and Unified CCX updates the parameters with your changes. You are now ready to provision any additional subsystems your Unified CCX applications require or to begin configuring Unified CCX applications.
Provision eMail Subsystem

The eMail subsystem is available if your system has a license installed for one of the following Cisco product packages: Unified IP IVR or Unified CCX Premium.

The Unified CCX system uses the eMail subsystem to communicate with your email server and enable your applications to create and send email. You must provision the eMail subsystem if you intend to create scripts that use messaging steps to create and send email.

Tip
If your email system is configured to receive acknowledgments, you should process the mailbox you identify in your configuration to determine whether or not an email was successfully sent.

The email configuration process identifies the default email address and server to be used for sending email (including e-pages and faxes) and for receiving acknowledgments.

Note
If you are not using email applications, you do not need to provision the eMail subsystem.

Complete the following steps.

Procedure

Step 1
Choose Subsystems > eMail.

The eMail Configuration web page opens.

Step 2
Specify the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mail Server</td>
<td>A fully-qualified email server name. (Example: server.domain.com)</td>
</tr>
<tr>
<td>email Address</td>
<td>An existing fully qualified e-mail address for the administrative account.</td>
</tr>
<tr>
<td></td>
<td>Example: <a href="mailto:administrator@domain.com">administrator@domain.com</a></td>
</tr>
</tbody>
</table>

Note
Unified CCX supports alphanumeric IDs and special characters (only hyphen "-", underscore "_", and dot ".")

Step 3
Click Update.

The Unified CCX system saves your changes and the Unified CCX Administration web page opens.

Note
Cisco does not currently support multiple email configurations. To remove the email information, you must erase the fields and click Update.
You are now ready to provision any additional subsystems your Unified CCX applications require, or to begin configuring Unified CCX applications.
Provision eMail Subsystem
Management of Prompts, Grammars, Documents, and Custom Files

Unified CCX applications can make use of many auxiliary files that interact with callers, such as scripts, pre-recorded prompts, grammars, and custom Java classes.

To manage these auxiliary files, you must complete the following tasks:

- Provision telephony and media resources.
- Provision Unified CCX subsystem, if required.
- Provision additional subsystems, if required.
- Configure Cisco script applications.

Depending on your particular Unified CCX implementation, your applications might make use of some or all of the file types described in the following sections.

- Manage Prompt Files, on page 117
- Manage Grammar Files, on page 119
- Manage Document Files, on page 120
- Language Management, on page 121
- Upload of Prompt Files, on page 124
- Management of Custom Files, on page 126
- AAR File Management, on page 127

Manage Prompt Files

Many applications make use of pre-recorded prompts stored as .wav files, which are played back to callers to provide information and elicit caller response.

Several system-level prompt files are loaded during Unified CCX installation. However, any file you create needs to be made available to the Unified CCX Engine before a Unified CCX application can use them. This is done through the Unified CCX cluster's Repository datastore, where the prompt, grammar, and document files are created, stored, and updated.
Support for High Availability and remote servers is available only in multiple-server deployments.

The Unified CCX Server's local disk prompt files are synchronized with the central repository during Unified CCX Engine startup and during run-time when the Repository datastore is modified.

To access the Prompt Management page, perform the following steps:

**Procedure**

**Step 1**
From the Unified CCX Administration menu bar, choose **Application > Prompt Management**.

**Step 2**
The Prompt Management web page opens to display the following fields and buttons.

<table>
<thead>
<tr>
<th>Field or Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Language</td>
<td>Lists the location of the items listed in the Name column.</td>
</tr>
<tr>
<td>Folder</td>
<td>Path of the current item selected in the Name column with respect to the root folder.</td>
</tr>
<tr>
<td>Name</td>
<td>Name of the language.</td>
</tr>
<tr>
<td>Size</td>
<td>The size of the prompt file prefixed with KB. The file size is converted from bytes to KB.</td>
</tr>
<tr>
<td><strong>Note</strong></td>
<td>This column is usually blank on the root page because the items on this page are usually folders.</td>
</tr>
<tr>
<td>Date Modified</td>
<td>The date and time when the document was last uploaded or changed along with time zone.</td>
</tr>
<tr>
<td>Modified by</td>
<td>The user ID of the person who performed these modifications.</td>
</tr>
<tr>
<td>Delete</td>
<td>Click <strong>Delete</strong> icon to remove the folder and its contents from the repository.</td>
</tr>
<tr>
<td>Rename</td>
<td>Click <strong>Rename</strong> icon to rename the folder in the repository.</td>
</tr>
<tr>
<td>Refresh</td>
<td>Click <strong>Refresh</strong> icon to refresh the folder in the repository.</td>
</tr>
<tr>
<td>Create Language</td>
<td>Displays a dialog box that lets you create a new language folder.</td>
</tr>
<tr>
<td>Upload Zip Files</td>
<td>Displays a dialog box that lets you locate and upload a zip file.</td>
</tr>
<tr>
<td><strong>Note</strong></td>
<td>The zip file must contain language folders in the root directory. Be sure to place the grammar files in folders and then zip the folders.</td>
</tr>
</tbody>
</table>

When you click a hyperlink (if configured) in the Name folder column, a secondary page appears. From this page, you can create a new subfolder or upload a new prompt.
Manage Grammar Files

The Unified CCX system uses specific grammars when recognizing and responding to caller response to prompts. A grammar is a specific set of all possible spoken phrases and Dual Tone Multi-Frequency (DTMF) digits to be recognized by Unified CCX applications and acted upon during runtime.

Several system-level grammar files are loaded during Unified CCX installation. However, any file you create needs to be made available to the Unified CCX Engine before a Unified CCX application can use them. This is done through the Unified CCX cluster's Repository datastore, where the grammar files are created, stored, and updated.

---

**Note**

Support for High Availability and remote servers is available only in multiple-server deployments.

The Unified CCX Server's local disk grammar files are synchronized with the central repository during Unified CCX Engine startup and during run-time when the Repository datastore is modified.

To access the Grammar Management page, perform the following steps:

**Procedure**

**Step 1**

From the Unified CCX Administration menu bar, choose **Applications > Grammar Management**.

**Step 2**

The Grammar Management web page opens to display the following fields and buttons.

<table>
<thead>
<tr>
<th>Field or Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Language</td>
<td>Lists the location of the items listed in the Name column.</td>
</tr>
<tr>
<td>Folder</td>
<td>Path of the current item selected in the Name column with respect to the root folder.</td>
</tr>
<tr>
<td>Codec</td>
<td>The codec chosen during installation for this Unified CCX server. Display only.</td>
</tr>
<tr>
<td>Name</td>
<td>Name of the language folder.</td>
</tr>
<tr>
<td>Size</td>
<td>The size of the grammar file prefixed with KB. The file size is converted from bytes to KB. This column is usually blank on the root page as the items on this page are usually folders.</td>
</tr>
<tr>
<td>Date Modified</td>
<td>The date and time when the document was last uploaded or changed along with time zone.</td>
</tr>
<tr>
<td>Modified by</td>
<td>The user ID of the person who performed these modifications.</td>
</tr>
<tr>
<td>Delete</td>
<td>Displays a dialog box that lets you delete an existing language folder.</td>
</tr>
<tr>
<td>Field or Button</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Rename</td>
<td>Displays a dialog box that lets you rename an existing language folder.</td>
</tr>
<tr>
<td>Refresh</td>
<td>Refreshes the specified folder in the repository.</td>
</tr>
<tr>
<td>Create Language</td>
<td>Displays a dialog box that lets you create a new language folder.</td>
</tr>
<tr>
<td>Upload Zip Files</td>
<td>Displays a dialog box that lets you locate and upload a zip file.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong> The zip file must contain language folders in the root directory. Be sure to place the grammar files in folders and then zip the folders.</td>
</tr>
</tbody>
</table>

When you click a hyperlink (if configured) in the Name folder column, a secondary page appears. From this page, you can create a subfolder or upload a new Prompt, Grammar, or Document.

## Manage Document Files

Documents might consist of .txt, .doc, .jsp, or .html files. Documents can also include custom classes and Java Archive (JAR) files that allow you to customize the performance of your Unified CCX system.

Several system-level document files are loaded during Unified CCX installation. However, any file you create needs to be made available to the Unified CCX Engine before a Unified CCX application can use them. This is done through the Unified CCX cluster’s Repository datastore, where the document files are created, stored, and updated.

**Note** Support for High Availability and remote servers is available only in multiple-server deployments.

The Unified CCX Server's local disk document files are synchronized with the central repository during Unified CCX Engine startup and during run-time when the Repository datastore is modified.

To access the Document Management page, perform the following steps:

**Procedure**

**Step 1** From the Unified CCX Administration menu bar, choose **Applications > Document Management**.

**Step 2** The Document Management web page opens to display the following fields and buttons.
### Field or Button | Description
--- | ---
Language | Lists the location of the items listed in the Name column.
Folder | Path of the current item selected in the Name column with respect to the root folder.
Name | Name of the language folder.
Size | The size of the grammar file prefixed with KB. The file size is converted from bytes to KB. This column is usually blank on the root page as the items on this page are usually folders.
Date Modified | The date and time when the document was last uploaded or changed along with time zone.
Modified by | The user ID of the person who performed these modifications.
Delete | Displays a dialog box that lets you delete an existing language folder.
Rename | Displays a dialog box that lets you rename an existing language folder.
Refresh | Refreshes the specified folder in the repository.
Create Language | Displays a dialog box that lets you create a new language folder.
Upload Zip Files | Displays a dialog box that lets you locate and upload a zip file.

**Note** The zip file must contain language folders in the root directory. Be sure to place the grammar files in folders and then zip the folders.

When you click a hyperlink (if configured) in the Name folder column, a secondary page appears. From this page, you can create a subfolder or upload a new Prompt, Grammar, or Document.

---

### Language Management

The topics in this section describe the procedure for managing languages.
Create New Language

Follow this procedure to create a new Prompt, Grammar, or Document language folder in the Repository datastore:

Procedure

---

Step 1
From the Unified CCX Administration menu bar, choose Applications > Prompt Management or Grammar Management or Document Management.
The corresponding Management web page opens.

Step 2
Click Create New Folder or Create Language icon that displays in the tool bar in the upper, left corner of the window or the Create New Folder or Create Language button that displays at the bottom of the window.
The Create New Folder or Create Language dialog box opens.

Step 3
Perform any one of the following actions:

- Select a value from the Language drop-down list.
- If you are unable to find a particular language or if the Language drop-down list is empty, click Edit button to add a new Language. The Explorer User Prompt dialog box opens. Enter the name of the new language in the Language Name field and click OK.

Step 4
Click Create.
A new language folder Name appears on the summary web page.

---

Rename Language

Follow this procedure to rename a Prompt/ Grammar/ Document language folder in the Repository datastore:

Procedure

---

Step 1
From the Unified CCX Administration menu bar, choose Applications > Prompt Management or Grammar Management or Document Management.
The corresponding Management web page opens.

Step 2
Select the Rename icon against the folder you want to rename.
The Rename Folder dialog box opens.

Step 3
From the Select Language Folder To Rename field, choose the name of the folder to be renamed.

Step 4
In the Rename Folder To field, enter the new name.

Step 5
Click Rename.
The web page then refreshes itself to provide a summary and status. Click **Return to Document Management** to navigate to the respective Prompt or Grammar or Document Management page.

---

**Delete Language**

Follow this procedure to delete a Prompt/Grammar/Document language folder in the Repository datastore:

**Procedure**

**Step 1** From the Unified CCX Administration menu bar, choose **Applications > Prompt Management** or **Grammar Management** or **Document Management**.

The corresponding Management web page opens.

**Step 2** Select the **Delete** icon against the respective folder, that you want to delete.

A dialog box opens to confirm the Delete action for the specific folder.

**Step 3** Click **OK** to delete.

---

**Upload Zip Files to Language Folder**

In addition to adding Prompt or Document files individually, you can upload multiple files from a Zip file.

**Note**

The maximum upload file size is 20 MB, whether it is a single file or a Zip file.

---

**Tip**

Be sure to upload (or download) large zip files in Prompt, Grammar and Document Management pages during off-peak hours.

**Procedure**

**Step 1** From the Unified CCX Administration menu bar, choose **Applications > Prompt Management** or **Grammar Management** or **Document Management**.

The corresponding Management web page opens.

**Step 2** Click **Upload Zip Files** icon that displays in the tool bar in the upper, left corner of the window or the **Upload Zip Files** button that displays at the bottom of the window to upload a new prompt or zip file.

The Upload Document dialog box opens.

**Step 3** Enter the path for the script file or click **Browse** to locate the script or the zip file containing the script files. Select the required script file and click **Open**.
Note You can upload only files with extension .aef or .zip.

**Step 4** Click the **Upload** button to upload the new script to the repository. A dialog box confirms the successful upload of the files.

**Note** If you try to upload invalid script files, the upload will be unsuccessful and an error message will be displayed on the upload dialog box. You can also create user-defined directories using “Create a New folder” option and uploads scripts to those directories.

**Step 5** By default, the files are unzipped after uploading. If you want to change this option, uncheck the **Unzip after uploading** check box.

**Caution** In the Documents Management summary web page, you have the option to zip or to unzip the file before uploading. By default, this check box is checked to unzip the file before uploading. Ensure to uncheck the check box if you want to upload it as a zipped file.

The maximum upload file size of the Zip file is 20 MB.

**Step 6** The contents of the zip file is uploaded to the folder. On successful uploading of the zip file, the status icon is updated accordingly. Click **Return to Document Management** button to go back to the respective Management web page.

---

### Upload of Prompt Files

Prompts are messages that the Unified CCX system plays back to callers. Unified CCX applications often use prompts to obtain caller response so that the Unified CCX system can transfer calls, receive account information, and perform other functions.

To use prompts in your Unified CCX applications, you must first create a folder to store them. You can then record and upload new user prompts, delete prompts, and modify existing prompts.

You store pre-recorded prompts as **.wav** files. The Unified CCX system also allows users to record spoken names, which you can upload to be used in the playback of prompts.

**Note** Unified CCX supports audio playback of RIFF header .wav files only though your MRCP vendor may support multiple .wav file header formats.

Unified CCX supports u-Law and A-Law prompts when G.711 voice codec is selected.

ScanSoft uses RIFF headers. When generating a .wav file prompt specifically for Nuance, ensure that you consider the server playing the prompt:

- If the prompt is played by the Nuance Speech Server, the .wav file requires a SPHERE header.
- If the prompt is played by the Unified CCX server, the .wav file requires a RIFF header.

Nuance provides a tool to convert .wav files from RIFF headers to SPHERE headers.

Managing prompts can include one or more of the following activities:
• **Creating a folder:** You must create a folder to store the .wav files that the Unified CCX system uses as prompts.

• **Recording a prompt:** You can record prompts by using Recording Step in Unified CCX or any third-party utility.

• **Upload one or more prompts:** You can replace any of the stored prompts used by Cisco script applications with a different .wav file by uploading the new.wav file. If necessary, you can also add spoken name prompts. Some Unified CCX applications play back the pre-recorded names of the people that callers are trying to reach, to allow the caller to confirm the transfer of the call.

  ![Note](image)

  In a HA setup, subscriber goes to Partial Service state while recording a prompt by using Unified CCX or uploading prompts.

---

**Record a Prompt**

You can record prompts and save in .wav format to be used in Unified CCX applications. You can use any third-party recording application to record prompts. You can save the prompts in one of the following standards:

- **G711:** The G711 is a freely distributed public domain codec that has several recording options and is available to any sound recording application. You can save the prompts in μ-Law or A-Law. While saving a prompt file, ensure that the **8.000 kHz, 8 Bit, Mono 7 kb/sec** attribute is selected.

- **G729:** The G729 codec is licensed and is not freely distributed. A white paper that describes the G729 prompt recording options is available on request. Send an email to Cisco Support to obtain a copy of this white paper.

After you record a prompt, upload the prompt, associate the prompt with an application, and run the application to ensure that the prompt is playing properly.

---

**Add Spoken-Name Prompts**

Some Unified CCX applications play back the pre-recorded names of people that callers are trying to reach, to allow callers to confirm the transfer of a call.

To upload .wav files of the spoken names of users, complete the following steps.

**Procedure**

**Step 1**

From the Unified CCX Administration menu bar, choose **Tools > User Management > Spoken Name Upload**.

**Step 2**

The Spoken Name Prompt Upload web page opens with the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User Id</td>
<td>Unique identifier of the user for which the spoken name is to be uploaded. This is a mandatory field.</td>
</tr>
</tbody>
</table>
Management of Custom Files

Use the Custom File Configuration web page to configure the classpath location of custom classes.

Specify Custom Classpath Entries

Use the Custom Classes Configuration web page to specify the available classpath entries.

Procedure

Step 1 From the Unified CCX Administration menu bar, choose System > Custom File Configuration.
The Custom Classes Configuration web page opens. You can:
• Select required entries from the Available Classpath Entries list and arrange them in the order you want.
• Use the arrow icons to move items between the Available Classpath Entries and Selected Classpath Entries lists.

Step 2 Click Update when your selections are complete.
Click Upload Custom Jar Files icon that displays in the tool bar in the upper, left corner of the window or the Upload Custom Jar Files button that displays at the bottom of the window to upload Jar files. The Document Management web page opens.
AAR File Management

Caution

Ensure that the contents of the AAR file are correct and conform to the specifications detailed in this section. If you upload AAR files that do not conform to these specifications, the Unified CCX Engine may not function as designed. Consequently, you need to manually reconfigure some of the applications uploaded through AAR.

AAR files are archives of prompt, grammar, document, scripts, applications, and custom classes that you use as building blocks for applications and extensions.

An AAR file can be simple—for instance, consisting of a single prompt—or complex—for example, containing all the prompts for all languages application uses, the workflow, and the configuration information for an application.

An AAR file is essentially a zip file that contains an optional META-INF directory. The META-INF directory, if it exists, stores configuration data, including security, versioning, extensions, and services.

You create AAR files using Java tools. After creating a file, you need to upload it to Unified CCX.

The following example shows a sample AAR Main Manifest and a sample AAR Application Manifest.

Sample AAR Main Manifest

Manifest-Version: 1.1
Created-By: 1.4.2_05 (Sun Microsystems Inc.)
Built-By: aaruser
Sealed: false
Cisco Unified CCX-Version: 9.0(1)
Class-Path:
  Application-List: customApp1.mf customApp2.mf
  Subsystem-List: sub1.mf sub2.mf
  Palette-List: Custom1 Custom2
  Custom1-Palette-Name: Category1
  Custom2-Palette-Name: Category2
  Custom1-Step-List: step1.mf
  Custom2-Step-List: step2.mf step3.mf
Implementation-Title: AAR Test File
Implementation-Version: 4.5(1)
Implementation-Vendor: Cisco Systems, Inc.
Implementation-Vendor-Id: 12345
Implementation-URL: https://www.cisco.com

Sample AAR Application Manifest

Application-Version: 1.1
Created-By: 1.4.2_05 (Sun Microsystems Inc.)
Built-By: aaruser
Sealed: false
Implementation-Title: AAR Application MF
Implementation-Version: 9.0(1)
Implementation-Vendor: Cisco Systems, Inc.
Implementation-Vendor-Id: 12345
Implementation-URL: https://www.cisco.com
Application-Name: Custom AA
Application-Type: Cisco Script Application
Application-Description: Cisco Unified CCX Cisco Custom Application
Application-Id: 100
Max-Sessions: 300
Enabled: true
Script: SSCRIPT[aa.aef]
Default-Script: SSCRIPT[aa.aef]
Initial-Script: SSCRIPT[aa.aef]

Figure 2: Sample AAR File

The figure below shows a sample AAR file.

To deploy custom applications, steps, and subsystems through an AAR file, you must first create the AAR file using a jar or zip tool and then upload the file through the Unified CCX Administration web page.

### AAR File Creation

You create an AAR file using a jar or WinZip tool.

An AAR file format is similar to a Zip file format. It includes an optional META-INF directory, which is used to store configuration data, including security, versioning, extension, and services.

### Upload AAR Files

To upload an AAR file, complete the following steps.
Procedure

Step 1
From the Unified CCX Administration menu bar, choose Applications > AAR Management. The AAR Management web page opens to display the following fields and buttons.

<table>
<thead>
<tr>
<th>Field or Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enter a Valid AAR File to Upload</td>
<td>You can either enter the name of the AAR file or click <strong>Browse</strong> button next to this field to navigate to the directory in which the file is located. This is a mandatory field.</td>
</tr>
<tr>
<td>Overwrite existing files</td>
<td>Enable this checkbox in case you want to overwrite the existing files.</td>
</tr>
<tr>
<td>Upload</td>
<td>Click this button to upload the AAR file.</td>
</tr>
<tr>
<td>Clear</td>
<td>Click this button to clear the selected file.</td>
</tr>
</tbody>
</table>

Enter the path for the AAR file or click **Browse** button to upload the file. The Choose File dialog box opens. Select the required script file and click **Open**.

Step 2
Click **Upload**.

The contents of the AAR file are uploaded to the respective folders.

**Note** Unified CCX generates an error if the AAR file is not formatted correctly or is missing some custom files.

---

META-INF Directory

Unified CCX uses the following files and subdirectories in the META-INF directory to configure applications, extensions and services:

- **MANIFEST.MF**. The file used to define extension and application related data.
- **applications**. This directory stores all application configuration files.

**Related Topics**

- [Main Attributes](#), on page 132

Directories for Prompts, Grammars, Documents, and Scripts

The AAR files features also provides directories to store prompts, grammars, documents, and scripts to be uploaded to the Repository.

The AAR directory structure mirrors the function of the Unified CCX Prompt, Grammar, Documents, and Scripts Management web pages. Each directory corresponds to each language for which to install prompts, grammars, documents and scripts. Languages are defined using the Java Locale standard, and the special default directory is used for prompts, grammars, and documents that are common to all languages.
Only Unified CCX supported prompt files and extensions are allowed within each directory. The maximum length of each individual folder name and file name within a directory is 64 characters.

**Prompts Directory**

The Prompts directory stores prompts that must be uploaded to the prompt repository (to make it seem like they were uploaded through Unified CCX Prompt Management).

**Grammars Directory**

The Grammars directory stores grammars that must be uploaded to the grammar repository (to make it seem like they were uploaded through Unified CCX Grammar Management).

**Documents Directory**

The Documents directory stores documents that must be uploaded to the document repository (to make it seem like they were uploaded through Unified CCX Document Management).

**Scripts Directory**

The Scripts directory stores scripts that must be uploaded to the script repository (to make it seem like they were uploaded through Unified CCX Script Management).

---

**Note**

The Script directory must define a single directory named `default` under which all script files must be listed.

---

**AAR Manifest**

An AAR file manifest consists of a main section followed by a list of sections for individual AAR file entries, each separated by a newline.

Information in a manifest file contains `name-value` pairs—which are also referred to as `headers` or `attributes`. Groups of name-value pairs are known as a `section`; sections are separated by empty lines.

The following table describes the expected syntax of the manifest file.

*Table 3: Manifest File Syntax*

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>section:</td>
<td>*header +newline</td>
</tr>
<tr>
<td>nonempty-section:</td>
<td>+header +newline</td>
</tr>
<tr>
<td>newline:</td>
<td>CR LF</td>
</tr>
<tr>
<td>header:</td>
<td>name: value</td>
</tr>
<tr>
<td>name:</td>
<td>alphanum *headerchar</td>
</tr>
<tr>
<td>value:</td>
<td>SPACE *otherchar newline *continuation</td>
</tr>
</tbody>
</table>
The main section, which is terminated by an empty line:

- Contains security and configuration information about the AAR file itself, as well as the applications or extensions that this AAR file is defining.
- Defines main attributes that apply to every individual manifest entry. No attribute in this section can have its name equal to “Name”.

The individual sections define various attributes for directories or files contained in this AAR file. Not all files in the AAR file need to be listed in the manifest as entries. The manifest file itself must not be listed. Each section must start with an attribute with the name as “Name”, and the value must be a relative path to the file or directory.

If there are multiple individual sections for the same file entry, the attributes in these sections are merged. If a certain attribute has different values in different sections, the last one is recognized.

Attributes that are not understood are ignored. Such attributes may include implementation-specific information used by applications.

The following table describes the specification for any file that can be archived in the AAR.

### Table 4: Syntax for AAR Files

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>manifest-file</td>
<td>main-section newline *individual-section</td>
</tr>
<tr>
<td>main-section</td>
<td>version-info newline *main-attribute</td>
</tr>
<tr>
<td>version-info</td>
<td>Manifest-Version: version-number</td>
</tr>
<tr>
<td>version-number</td>
<td>digit+{digit+}*</td>
</tr>
<tr>
<td>main-attribute</td>
<td>(any legitimate main attribute) newline</td>
</tr>
<tr>
<td>individual-section</td>
<td>Name: value newline *perentry-attribute</td>
</tr>
<tr>
<td>perentry-attribute</td>
<td>(any legitimate perentry attribute) newline</td>
</tr>
<tr>
<td>newline</td>
<td>CR LF</td>
</tr>
<tr>
<td>digit</td>
<td>{0-9}</td>
</tr>
</tbody>
</table>
Attribute Types

Attributes that appear in the main section are called main attributes. Attributes that appear in individual sections are called per-entry attributes. Some attributes appear in both the main and individual sections, in which case the per-entry attribute value overrides the main attribute value for the specified entry.

Main Attributes

Main attributes are the attributes that are present in the main section of the manifest:

General main attributes as shown in the following table.

Table 5: General Main Attributes

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manifest-Version</td>
<td>The manifest file version. The value is a legitimate version number.</td>
</tr>
<tr>
<td>Created-By</td>
<td>The version and the vendor of the java implementation on top of which this manifest file is generated. This attribute is generated by the jar tool.</td>
</tr>
<tr>
<td>Cisco Unified CCX-Version</td>
<td>The minimum Unified CCX version release compatible with the AAR file. Unified CCX-version is the accumulation of the Unified CCX release, Unified CCX Service Release, and Unified CCX Engineering Special defined in that order. For example, if the AAR file is compatible with Cisco Unified CCX release 4.5(1)_Build705, SR1_Build001, ES2_Build002, the Cisco Unified CCX-Version would be defined as 4.5(1)SR1ES2_Build002. Only the last build number is taken. So for instance, if the AAR file is compatible with Cisco Unified CCX release 4.5(1)_build705, SR1_Build001, then the Cisco Unified CCX-Version is 4.5(1)SR1_Build001. As a last example, if AAR file is compatible with Cisco Unified CCX release 4.5(1)_Build705 and above, then Cisco Unified CCX-Version would be 4.5(1)_Build705.</td>
</tr>
<tr>
<td>Class-Path</td>
<td>The directories or JAR files that need to be installed and accessed by scripts directly. Entries are separated by one or more spaces. The Unified CCX class loader uses the value of this attribute to construct its internal search path where each entry is defined relative to the /Documents/default/classpath directory in this AAR file.</td>
</tr>
<tr>
<td>Application-List</td>
<td>The application configuration files from the META-INF/applications/ directory to be installed. Entries are separated by one or more spaces.</td>
</tr>
</tbody>
</table>

Management of Prompts, Grammars, Documents, and Custom Files
### Attribute Definition

#### Subsystem-List
- Description: The subsystem configuration files from the META-INF/subsystems/ directory to be installed. Entries are separated by one or more spaces.

#### Palette-List
- Description: The step palettes that need to be installed. Each palette listed in this attribute will have a set of additional attributes that the Unified CCX editor uses to specify the palette name and the palette steps to install. Entries are separated by one or more spaces.

#### Palette-Name
- Description: The unique name of the palette to define in the Unified CCX editor where the specified steps will be grouped and accessible.

#### Step-List
- Description: The step configuration files from the META-INF/steps/ directory to be installed under the palette. Entries are separated by one or more spaces.

#### Attribute defined for extension identification: Extension-Name

This attribute specifies a name for the extension contained in the AAR file. The name should be a unique identifier.

The following tables show attributes defined for extension and directory versioning and sealing information. These attributes define features of the extension which the AAR file is a part of. The values of these attributes apply to all the directories in the AAR file, but can be overridden by per-entry attributes.

### Table 6: Implementation Category in Main Attributes

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Implementation-Title</td>
<td>The title of the extension implementation.</td>
</tr>
<tr>
<td>Implementation-Version</td>
<td>The version of the extension implementation.</td>
</tr>
<tr>
<td>Implementation-Vendor</td>
<td>The organization that maintains the extension implementation.</td>
</tr>
<tr>
<td>Implementation-Vendor-Id</td>
<td>The ID of the organization that maintains the extension implementation.</td>
</tr>
<tr>
<td>Implementation-URL</td>
<td>The URL from which the extension implementation is downloaded.</td>
</tr>
<tr>
<td>Sealed</td>
<td>Defines if this AAR file is sealed. Sealing a directory means that the files uploaded to the corresponding repository will not be modifiable once installed unless the AAR file is reinstalled. If set to true, then all directories in the AAR file default to be sealed, unless individually defined otherwise. If set to false, then all directories are modifiable.</td>
</tr>
</tbody>
</table>
**Per-entry Attributes**

Per-entry attributes apply only to the individual AAR file entry with which the manifest entry is associated. If the same attribute also appears in the main section, then the value of the per-entry attribute overwrites the main attribute value.

- **Example 1:** If AAR file a.aar has the following manifest content, then all the files archived in a.aar are sealed, except US English prompts. If the same attributes also appeared in an entry representing a parent directory of another entry, then the value of the per-entry attribute overwrites the parent directory per-entry attribute value.

  Manifest-Version: 1.1 Created-By: 1.2 (Sun Microsystems Inc.)
  Sealed: true
  Name: Prompts/en_US/
  Sealed: false

- **Example 2:** If AAR file a.aar has the following manifest content, then all the US English prompts archived in a.aar are sealed, except US English prompts located in the AA/ directory.

  Manifest-Version: 1.1 Created-By: 1.2 (Sun Microsystems Inc.)
  Name: Prompts/en_US/
  Sealed: true
  Name: Prompts/en_US/AA/
  Sealed: false

The per-entry attributes fall into the following groups:

- **Attributes defined for file contents: Content-Type**

  This attribute specifies the MIME type and subtype of data for a specific file entry in the AAR file. The value should be a string in the form of type/subtype. For example, image/bmp is an image type with a subtype of bmp (representing bitmap). This indicates that the file entry is an image with the data stored as a bitmap. RFC 1521 and 1522 discuss and define the MIME types definition.

- **Attributes defined for directory versioning and sealing information:**

  These are the same set of attributes defined in Table 6: Implementation Category in Main Attributes, on page 133 for the main attributes. When used as per-entry attributes, these attributes overwrite the main attributes for the individual file specified by the manifest entry.

**META-INF Directory Attributes**

The Unified CCX recognizes the x.MF file in the applications, subsystems, and steps subdirectories in the META-INF directory and interprets each to configure applications, subsystems, and steps respectively. The x is the base file name as listed on the Application-List main attribute of the manifest file. The X.MF file contains one section defining the configuration of a particular application.

**Application Subdirectory Attributes**

The following table describes the syntax of the manifest file for the application subdirectory.

*Table 7: Application Subdirectory Manifest File Syntax*

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>application-file</td>
<td>version-info newline *application-attribute</td>
</tr>
<tr>
<td>version-info</td>
<td>Application-Version: version-number</td>
</tr>
</tbody>
</table>
The application attributes fall into the following groups:

### Table 8: Application Attributes

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application-Version</td>
<td>The application configurations file version. The value is a legitimate version number. For example, Cisco Unified CCX Release 4.5 starts with version 1.1.</td>
</tr>
<tr>
<td>Application-Name</td>
<td>The unique name of the application (see Unified CCX Application Management).</td>
</tr>
<tr>
<td>Application-Type</td>
<td>The type of the application (Cisco Script Application, Busy, Ring-No-Answer).</td>
</tr>
<tr>
<td>Application-Description (optional)</td>
<td>The description for the application (see Unified CCX Application Management).</td>
</tr>
<tr>
<td>Application-Id</td>
<td>A unique identifier for the application (see Unified CCX Application Management).</td>
</tr>
<tr>
<td>Max-Sessions</td>
<td>The maximum number of sessions for the application (see Unified CCX Application Management).</td>
</tr>
<tr>
<td>Enabled</td>
<td>The application is enabled if the value is set to true (see Unified CCX Application Management). If the value is set to false, the case is ignored.</td>
</tr>
<tr>
<td>Script</td>
<td>The main script of a Cisco Script Application (see Unified CCX Application Management). The value must be relative to the Scripts directory. Unified CCX does not support configuring script parameters.</td>
</tr>
<tr>
<td>Default-Script</td>
<td>The default script of a Cisco Script Application, Unified ICME Translation or Post Routing application (see Unified CCX Application Management). The value must be relative to the Scripts directory. Unified CCX does not support configuring script parameters.</td>
</tr>
</tbody>
</table>
The initial script of a Unified CCX Post Routing application (see Unified CCX Application Management). The value must be relative to the Scripts directory. Unified CCX does not support configuring script parameters.

- Attributes defined for application versioning and sealing information: These attributes define features of the application to which the AAR file belongs. These attributes are the same as those listed in Main Attributes, on page 132.

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Initial-Script</td>
<td>The initial script of a Unified CCX Post Routing application (see Unified CCX Application Management). The value must be relative to the Scripts directory. Unified CCX does not support configuring script parameters.</td>
</tr>
</tbody>
</table>
Unified CCX System Management

Unified CCX administration provides options to configure, control, and monitor Unified CCX component activities and information across a cluster.

**Note**
Support for High Availability and remote servers is available only in multiple-server deployments.

See the *Cisco Unified Contact Center Express Install and Upgrade Guide* for instructions about tasks that significantly change your Unified CCX deployment, such as:

- Changing from a single-server deployment to a multiple-server deployment.
- Removing a Unified CCX Software component from a server.
- Moving a Unified CCX Software component to another server.
- Changes to a Unified CCX cluster (adding, removing, or replacing a server).

The following sections describe the day-to-day management of Unified CCX components.

- Basic Terminology, on page 137
- High Availability and Automatic Failover, on page 138
- Unified CCX CDS Information Management, on page 139
- Manage System Parameters, on page 139
- Unified CCX IP Address/hostname Management, on page 140
- Set Up Certificates, on page 156
- Exit Unified CCX Administration, on page 158

**Basic Terminology**

This section provides information about different Unified CCX terminology.

- **Cluster**. A Unified CCX cluster (often referred to as cluster in this manual) consists of one or more servers (nodes) that are running Unified CCX components in your Unified CCX deployment. If you deploy Unified CCX components on a single server, the Unified CCX cluster consists of that server. If you deploy Unified CCX on multiple servers, the cluster includes the Unified CCX server and standby server on which you installed Unified CCX. The Unified CCX cluster supports up to two Unified CCX...
servers, one designated as the active Unified CCX server and the other designated as the standby Unified CCX server for high availability purposes.

Note: Support for High Availability and remote servers is available only in multiple-server deployments.

- **Cluster profile.** The Unified CCX Administration web page (home page) displays information about the cluster profile. A cluster profile includes data relating to the Unified CCX servers, components, and licenses installed in a cluster.

- **Node (server).** A server that is part of the Unified CCX cluster.

- **Active Server.** The active server provides all system services and resources. You can deploy one active server in each Unified CCX subsystem. If the active server fails, the Unified CCX subsystem automatically fails over to the standby server.

- **Standby Server.** You can deploy up to two servers in each Unified CCX system for high availability—one active server (master) and one standby (not active) server. With high availability, if an active server becomes unavailable, the standby server automatically becomes the active server.

- **Component.** The software units in the Unified CCX system. The main software components of the Unified CCX server are the Engine, datastores, monitoring, recording, and the Cluster View Daemon (CVD). See the Cisco Unified Contact Center Express Install and Upgrade Guide for more information on setup and installation procedures.

- **Service.** An executable unit. A service may have other services as its children. (For example, subsystems and managers are children of the engine service).

- **Feature.** A logical representation of the functional unit.

- **Master service.** A specially-elected service. Only one service from the Engine service, or database services set can be the master within the Unified CCX Engine component.

- **Standby service.** An active service that can take over the master functionality in case the master service becomes unavailable within the Unified CCX Engine component. You cannot configure the standby service. The Cluster View Daemon (CVD) dynamically elects the services on the active node to be the master.

---

**High Availability and Automatic Failover**

Note: Support for High Availability (HA) and remote servers is available only in multiple-server deployments. Unified CCX does not support more than two nodes in a HA setup. Expansion servers where the Database, Monitoring, or Recording components are running on separate servers are not supported.

Unified CCX provides high availability and automatic failover capability through the use of two servers, the active server and the standby server.
The active server provides all system services and resources; no services or resources are available from the standby server. When you make administrative changes on the active server, both the servers are synchronized. If the active server fails, there is automatic failover to the standby server. For detailed information on HA over WAN deployment, see *Cisco Unified Contact Center Express Design Guide*.

**Note**

After a Unified CCX failover or failback the agent state changes to Not Ready state.

**Network Partitions**

Network malfunction or misconfiguration can create network partitions and split the network into separate *islands*. If a node enters this state, the node is referred to as being in the island mode. Nodes in the island mode are hard to detect. While these nodes can communicate within a partitioned island, they cannot communicate between partitioned islands. If the islands do not communicate, then each island will select its own active server.

Generally, you can connect to the Unified CCX administration on any node, and see a consistent cluster view. If a node is in the island mode, you will see different cluster views when you connect to nodes in each island.

**Note**

Support for High Availability and remote servers is available only in multiple-server deployments.

If your node enters the island mode, it should recover from the island mode as soon as the underlying network issue is resolved. If the island mode persists, check the network connectivity/reachability between the two CCX servers and take action accordingly.

**Unified CCX CDS Information Management**

The Unified CCX system stores configuration information in the Cisco Configuration Datastore Server (CDS). The Unified CCX Administration configurations are stored in the CDS.

**Note**

Support for High Availability and remote servers is available only in multiple-server deployments.

The Unified CCX server can receive directory information from one Cisco Unified Communications directory and application configuration and script logic from a repository on another server.

**Manage System Parameters**

The parameters in the System Parameters Configuration page are grouped logically into sections with headings. Each parameter has a corresponding suggested or default value on the right side of the page. Where applicable, radio buttons are used to toggle between the parameter options.

In this web page, you can configure the port settings, default session timeout, and codec.
ChangingsomesystemparametersliketheIPaddress,NetworkTimeProtocol(NTP)andsooncanresultinadifferentLicenseMAC.Youneedtoret-hostedlicensefiles(withnewLicenseMAC)insuchcaseswithin30-daygraceperiodbeyondwhichthesystemwillstopworking.

Procedure

**Step 1** Choose **System > System Parameters** from the Unified CCX Administration menu bar.

The System Parameters Configuration web page appears.

**Step 2** Click the **Update** icon that displays in the tool bar in the upper, left corner of the window or the **Update** button that displays at the bottom of the window.

The system notifies all nodes in the cluster about the changes.

**Note** If Cluster View Daemon is in Shutdown state during this operation, then the changes just made are synchronized on that node when Cluster View Daemon is started again.

Related Topics

- **System Parameters**, on page 261

Unified CCX IP Address/hostname Management

This section provides the steps you need to follow whenever there is a change in IP address/hostname for the following Unified CCX deployments:

- Unified CCX Cluster with Single-node
- Unified CCX Cluster with High Availability (HA)

You may want to change the IP address/hostname for a variety of reasons, including moving the server from one segment to another or resolving a duplicate IP address/hostname problem.

**Note** Hostname change is supported in Cisco Unified CCX.

The character limit for Hostname is 63 characters.

Prepare System for IP Address/hostname Change

Perform the following tasks to ensure that your system is prepared for a successful IP address/hostname change.
If you do not receive the results that you expect when you perform these tasks, do not continue with this procedure until after you resolve any problems that you find. DB replication across the entire cluster is essential for this process. Also, if the DNS check fails then the IP Address/hostname change will not happen.

**Procedure**

**Step 1** List all servers in the cluster and note whether the nodes are defined by using IP addresses or hostnames.

- From **Cisco Unified CCX Administration** menu bar on the first node, navigate to **System > Server**. A list of all servers in the cluster displays.

  - See whether the servers are defined using IP addresses or hostnames and capture this list of servers for later reference. Ensure that you have saved an inventory of both the hostname and IP address of each node in your cluster.

**Step 2** Ensure that all servers in the cluster are up and available by checking for any active ServerDown alerts. You can check by using either the Real Time Monitoring Tool (RTMT) or the Command Line Interface (CLI) on the first node.

  - To check by using RTMT, access Alert Central and check for ServerDown alerts.
  
  - To check by using the CLI on the first node, enter the following command and inspect the application event log:
    
    file search activelog syslog/CiscoSyslog ServerDown

**Step 3** Check the DB replication status on all the Cisco CRS nodes and Cisco Unified Communications nodes in the cluster to ensure that all servers are replicating database changes successfully using the following substeps:

  a) **For Unified CCX**: In a High Availability deployment of Unified CCX, you can check the DB replication status for the datastores across all servers in the cluster using Unified CCX Serviceability Administration. Choose **Tools > Datastore Control Center > Replication Servers** from the Unified CCX Serviceability menu bar to view the replication status. The value in State field for both the servers in this web page should display ACTIVE/CONNECTED.

  b) **For Cisco Unified Communications Platform**: You can check the DB replication status on all the Cisco Unified Communications nodes in the cluster by using either RTMT or a CLI command.

    - To check by using RTMT, access the Database Summary and inspect the replication status.

    - To check by using the CLI, enter the command that is shown in the following example:

      ```
      admin: show perf query class "Number of Replicates Created and State of Replication"
      => query class :
      
      - Perf class (Number of Replicates Created and State of Replication)
        has instances and values:
        ReplicateCount  -> Number of Replicates Created = 344
        ReplicateCount  -> Replicate_State = 2
      ```
Be aware that the Replicate_State object shows a value of 2 in this case. The following list shows the possible values for Replicate_State:

- 0—Replication Not Started. Either no subscribers exist, or the Database Layer Monitor service is not running and has not been running since the subscriber was installed.
- 1—Replicates have been created, but their count is incorrect.
- 2—Replication is good.
- 3—Replication is bad in the cluster.
- 4—Replication setup did not succeed.

**Step 4**
Run a manual DRS backup and ensure that all nodes and active services are backed up successfully.

**Step 5**
Run the CLI command `utils diagnose module validate_network` through Platform CLI on all nodes in the cluster to ensure network connectivity and DNS server configuration are intact.

---

### IP Address Modification

This section describes how to change the IP address.

⚠️ **Caution**
Changing the IP address on any node in a Cisco CRS cluster can interrupt call processing and other system functions. Also, changing the IP address can cause the system to generate certain alarms and alerts such as ServerDown and automatic failover to a backup server may not operate. Because of this potential impact to the system, you must perform IP address changes during a planned maintenance window.

🔍 **Note**
When there is a change in the Unified CCX server subnet, you must change the default gateway IP address. Ensure the following:

- The new default gateway IP address is configured on the Unified CCX server.
- The DNS is reachable and the DNS record exists for the Unified CCX server.

---

### Change IP Address for Server in Single-Node Deployment

Use this procedure to change the IP address of the server in a single-node deployment.

⚠️ **Caution**
Ensure that the server on the same subnet or that is moved to the new subnet has access to the configured default gateway before proceeding to change the IP address of the server.
**Procedure**

**Step 1**
Change the DNS record of the server to point to the new IP address. Ensure that you correctly update both the forward (A) and reverse (PTR) records, and there are no duplicate PTR records.

**Step 2**
If you want to change the IP address of the server on the same subnet or a different subnet that requires a new default gateway address, use either of the following methods:

- CLI commands
- Cisco Unified Communications Operating System Administration interface

**Using CLI commands:**

a) To change the default gateway, enter the following CLI command:

```
set network gateway <IP Address>
```

The following sample output displays:

```
admin: set network gateway 10.3.90.2
```

WARNING: Changing this setting will invalidate software license on this server. The license will have to be re-hosted.
Continue (y/n):
Continue (y/n)? y

b) To change the IP address of the server, enter the following CLI command:

```
set network ip eth0 <ip_address> <netmask> <default gateway> where ip_address specifies the new server IP address and netmask specifies the new server network mask and default gateway specifies the default gateway of the new server.
```

The following sample output displays:

```
admin: set network ip eth0 10.3.90.21 255.255.254.0 10.3.90.1
** WARNING **
If there are IP addresses (not hostnames) configured in UCCX Administration under System -> Servers then you must change the IP address there BEFORE changing it here or call processing will fail. This will cause the system to restart
```

Note: To recognize the new IP address all nodes within the cluster will have to be manually rebooted.

Do you want to continue?
Enter “yes” to continue and restart or any other key to abort

Enter y and press Enter. This will automatically reboot this server with the new IP address.

**Using Cisco Unified Communications Operating System Administration interface:**

Alternatively, you can change the IP address and default gateway of the server from Cisco Unified Communications Operating System Administration interface as follows:

- Choose Settings > IP > Ethernet.
- Change the IP address, default gateway, and netmask, and click Save. The server restarts automatically with the new IP address.
If you change the IP address, License MAC of the server will also change. Rehost the new license. Old license enters its grace period.

What to do next

When the Cloud Connect services are enabled, after the Unified CCX IP address has been changed, run the following CLI command to restart the services.

```
utils cloudconnect reinit services
```

Note

In a high availability (HA) deployment, run this CLI command on other nodes of the cluster.

IP Address Modification in High-Availability (HA) Deployment

Note

Ensure that the IP Address is sequentially changed first in the Publisher and then the Subscriber node of the Unified CCX servers.

Change IP Address for Publisher Server in HA Deployment

Use this procedure to change the IP address of publisher server in a HA deployment.

Caution

Ensure that the server on the same subnet or that is moved to the new subnet has access to the configured default gateway before proceeding to change the IP address of the server.

Procedure

Step 1

Change the DNS record of the publisher server to point to the new IP address. Ensure that you correctly update both the forward (A) and reverse (PTR) records, and there are no duplicate PTR records.

Step 2

Verify that the DNS change propagates to other nodes by using the `utils network host <IP Address>` CLI command on all the cluster nodes.

Step 3

From the Cisco Unified Operating System Administration page of the subscriber server in the cluster, perform the following tasks:

a) Navigate to **Settings > IP > Publisher**.

b) Change the IP address of the publisher server.

Step 4

To update new IP of the publisher server in subscriber, enter the following CLI command on the subscriber server:

```
utils uccx modify remote_IPAddress <Old_IP_of_Publisher> <New_IP_of_Publisher>
```

The following output displays:
Step 5

If you want to change the IP address of the server on the same subnet or a different subnet that requires a new default gateway address, use either of the following methods:

- **CLI commands**
- **Cisco Unified Operating System Administration interface**

**Using CLI commands:**

a) To change the default gateway, enter the following CLI command:

```bash
set network gateway <IP Address>
```

The following sample output displays:

```
admin:set network gateway 10.3.90.2
```

**WARNING:** Changing this setting will invalidate software license on this server. The license will have to be re-hosted.

Continue (y/n)?

Caution Ensure that the server is moved to the new subnet and has access to the default gateway before proceeding to the following sub-step.

b) To change the IP address of the server, enter the following CLI command:

```bash
set network ip eth0 <ip_address> <netmask> <default gateway>
```

where `<ip_address>` specifies the new server IP address, `<netmask>` specifies the new server network mask and `<default gateway>` specifies the default gateway of the new server.

The following sample output displays:

```
admin:set network ip eth0 10.78.92.55 255.255.255.0 10.78.92.1
```

**WARNING:** Changing this setting will invalidate software license on this server. The license will have to be re-hosted.

Continue (y/n)?

*** WARNING ***
This command will cause the system to restart

Note: Please verify that the new ip address is unique across the cluster and, if DNS services are utilized, any DNS configuration is completed before proceeding.

To recognize the new ip address all nodes within the cluster will have to be manually rebooted.

Continue (y/n)?

Enter `y` and press Enter. This will automatically reboot this server with the new IP address.

**Using Cisco Unified Operating System Administration interface:**
Alternatively, you can change the IP address and default gateway of the server from Cisco Unified Operating System Administration interface as follows:

- Choose Settings > IP > Ethernet.
- Change the IP address, default gateway, and netmask, and click Save. The server restarts automatically with the new IP address.

**Step 6**
Reboot all the servers in the cluster including the publisher using the CLI command `utils system restart`.

**Note** If you do not reboot the subscriber after the IP address change, all the services on the publisher may not start properly.

If you change the IP address, License MAC will also change. Rehost the new license for the new License MAC. Old license enters its grace period.

---

**Change IP Address for Subscriber Server in HA Deployment**

Use this procedure to change the IP address of a subscriber server in a HA deployment.

**Caution** Ensure that the server on the same subnet or that is moved to the new subnet has access to the configured default gateway before proceeding to change the IP address of the server.

**Procedure**

**Step 1** Change the DNS record of the subscriber server to point to the new IP address. Ensure that you correctly update both the forward (A) and reverse (PTR) records, and there are no duplicate PTR records.

**Step 2** Verify that the DNS change propagates to other nodes by using the `utils network host <IP Address>` CLI command on all the cluster nodes.  

**Caution** Skip Step 3 if the server is defined by hostname and you are changing only the IP address.

**Step 3** From Cisco Unified CCX Administration page, perform the following tasks:

a) Navigate to System > Server. From the List Servers web page, click the IP address of the subscriber server.

   The Server Configuration page for the subscriber server opens.

b) Enter the new IP address in the Host Name/IP Address field and click Save.

   **Note** You can use the CLI command `run sql select name,nodeid from ProcessNode` to check whether the new IP address has been replicated on all the servers.

**Step 4** To update new IP of the subscriber in publisher, enter the following CLI command on the publisher server:

   `utils uccx modify remote_IPAddress <Old_IP_of_Subscriber> <New_IP_of_Subscriber>`

   The following output displays:
Step 5  If you want to change the IP address of the server on the same subnet or a different subnet that requires a new default gateway address, use either of the following methods:

- CLI commands
- Cisco Unified Communications Operating System Administration interface

Using CLI commands:

a) To change the default gateway, enter the following CLI command:

```
set network gateway <IP Address>
```

The following sample output displays:

```
admin:set network gateway 10.3.90.2
```

WARNING: Changing this setting will invalidate software license on this server. The license will have to be re-hosted.

Continue (y/n)?

```
Continue (y/n)?y
```

**Caution** Ensure that the server is moved to the new subnet and has access to the default gateway before proceeding to the following sub-step.

b) To change the IP address of the server, enter the following CLI command:

```
set network ip eth0 <ip_address> <netmask> <default gateway>
```

where `ip_address` specifies the new server IP address, `netmask` specifies the new server network mask and `default gateway` specifies the default gateway of the new server.

The following sample output displays:

```
admin:set network ip eth0 10.78.92.55 255.255.255.0 10.78.92.1
```

WARNING: Changing this setting will invalidate software license on this server. The license will have to be re-hosted.

Continue (y/n)?

```
Continue (y/n)?y
```

*** WARNING ***

This command will cause the system to restart

=======================================================

Note: Please verify that the new ip address is unique across the cluster and, if DNS services are utilized, any DNS configuration is completed before proceeding.

To recognize the new ip address all nodes within the cluster will have to be manually rebooted.

```
Continue (y/n)?
```

Enter y and press Enter. This will automatically reboot this server with the new IP address.
Using Cisco Unified Communications Operating System Administration interface:

Alternatively, you can change the IP address and default gateway of the server from Cisco Unified Communications Operating System Administration interface as follows:

- Choose Settings > IP > Ethernet.
- Change the IP address, default gateway, and netmask, and click Save. The server restarts automatically with the new IP address.

**Step 6** Reboot all the servers in the cluster including the publisher using the CLI command `utils system restart`.

*Note* If you do not reboot the subscriber after the IP address change, all the services on the publisher may not start properly.

---

**HostName and Domain Name Modification**

Changing the hostname or domain name on any node in the Unified CCX cluster can interrupt call processing and other system functions. It can cause the system to generate certain alarms and alerts such as ServerDown and automatic failover to a backup server may fail. To prevent these failures, ensure to change the hostname or domain name during a planned maintenance window.

As a prerequisite ensure that the DNS is reachable and the DNS record exists for the server with its current fully qualified domain name (FQDN) and the IP address.

*Note* • Ensure Single Sign-On is disabled before modifying the hostname or domain name.

---

**HostName Modification**

This section describes how to change the hostname.

**Change HostName for Server in a Single-Node Deployment**

Use this procedure to change the hostname of the server in a single-node deployment.

*Note* The hostname can have a maximum of 63 characters.

Ensure Single Sign-On is disabled before modifying the hostname.

**Procedure**

**Step 1** Change the DNS record of the server to point to the new hostname. Ensure that you correctly update both the forward (A) and reverse (PTR) records, and there are no duplicate PTR records.
Step 2 You can change the hostname of the server either using the CLI (command line interface) command or using Cisco Unified OS Administration interface. To change the hostname using CLI command, go to step 3 or to change the hostname using Cisco Unified OS Administration interface go to step 4.

Step 3 At the CLI prompt, perform the following tasks:
   a) Enter the CLI command `set network hostname` and press Enter.

   The following sample output displays:

   ```
   admin:set network hostname
   WARNING: Changing this setting will invalidate software license on this server. The license will have to be re-hosted.
   Continue(y/n):
   Continue (y/n)?y
   ctrl-c: To quit the input.
   *** WARNING ***
   Do not close this window without first canceling the command.
   This command will automatically restart system services.
The command should not be issued during normal operating hours.
```

   Note: Please verify that the new hostname is a unique name across the cluster and, if DNS services are utilized, any DNS configuration is completed before proceeding.

   ```
   Security Warning : This operation will regenerate all UCCX Certificates including any third party signed Certificates that have been uploaded.
   Continue (y/n)?y
   Enter the hostname:
   ```

   b) Enter y twice to continue and enter the hostname and press Enter.

Step 4 From Cisco Unified OS Administration interface, perform the following task:
   a) Choose Settings > IP > Ethernet.
   b) Change the hostname.
   c) Click Save. The server automatically reboots with the new hostname.

Step 5 On changing the hostname/IP address, License MAC of the server changes. Rehost the new license. Old license enters its grace period.

Step 6 Verify the status of Customer Collaboration Platform:

Step 7 Regenerate the SAML certificate through the Cisco Identity Service Administration.

If Single Sign-On must be enabled, then perform the following steps:
   a. Establish the trust between the Cisco Identity Service and Identity Provider.
   b. Log in to the Cisco Unified CCX Administration and navigate to System --> Single Sign-On.
   c. Click Register to onboard the SSO components even if you had onboarded the components earlier.
d. You can now enable Single Sign-On after you perform SSO Test again.

HostName Modification in High-Availability (HA) Deployment

The character limit for Host Name is 24 characters.

Related Topics
Single Sign-On (SSO), on page 266

Change HostName for Publisher Server in HA Deployment

Use this procedure to change the hostname of publisher server in a HA deployment.

Note
Ensure Single Sign-On is disabled before performing the change in hostname.

Procedure

Step 1
Change the DNS record of the publisher server to point to the new hostname. Ensure that you correctly update both the forward (A) and reverse (PTR) records, and there are no duplicate PTR records.

Step 2
Verify that the DNS change propagates to other nodes by using the `utils network host <IP Address>` CLI command on all the cluster nodes.

Step 3
To change the hostname of the publisher on the subscriber node, use either of the following methods:

- CLI commands
- Cisco Cisco Unified OS Administration interface

Using CLI commands:

a) Run the following CLI command on the subscriber node:

```
set network cluster publisher hostname <hostname>
```

where `hostname` is the new publisher.

The following output displays:

```
admin:set network cluster publisher hostname hijk-lmn-n1
New Remote hostname: hijk-lmn-n1
```

Using Cisco Unified OS Administration interface:

From interface of the subscriber server, perform the following tasks:

a) Navigate to Setting > IP > Publisher.

b) The Server Configuration page for the publisher server opens. Change the hostname of Publisher server in the Host Name or IP Address field and then click Save.

Step 4
Run the following CLI command on the Subscriber node to update new hostname of the Publisher server:
utils uccx modify remote_hostname <Old_hostname_of_Publisher> <New_hostname_of_Publisher>

The following output displays:

admin:utils uccx modify remote-hostname abcd-efg-n1 hijk-lmn-n1

Old Remote hostname: abcd-efg-n1
New Remote hostname: hijk-lmn-n1

This command should be executed only in case you are changing Hostname of remote server.
Are you sure you want to run this command?
Continue (y/n)?
Enter y and press Enter.

**Step 5**

To change the hostname of publisher server, use either of the following methods:

- CLI commands
- Cisco Unified OS Administration interface

**Using CLI commands:**

a) Run the following CLI command on the publisher node:

```
set network hostname
```

The following output displays:

```
admin:set network hostname

*** WARNING ***
Do not close this window without first canceling the command.

This command will automatically restart system services.
The command should not be issued during normal operating hours.

Note: Please verify that the new hostname is a unique name across the cluster and, if DNS services are utilized, any DNS configuration is completed before proceeding.

Security Warning: This operation will regenerate all UCCX Certificates including any third party signed Certificates that have been uploaded.

Continue (y/n)?
```

Enter y and press Enter.

b) Enter the hostname when prompted. The system services will automatically restart.

**Using Cisco Unified OS Administration interface:**

Change the hostname using Cisco Unified OS Administration interface of the publisher server:

a) Choose **Settings > IP > Ethernet**.
b) Change the hostname.
c) Click **Save**. The system services will automatically restart.
**Step 6**
Reboot all the servers in the cluster including the publisher using the CLI command `utils system restart`.

*Note* If you do not reboot the subscriber, all the services on the publisher may not start properly.

**Step 7**
From the publisher node, run CLI command `utils dbreplication reset all` to resetup Unified CM database replication across the entire cluster.

**Step 8**
From the publisher node, run CLI command `utils uccx dbreplication reset` to setup Unified CCX database replication across the cluster.

**Step 9**
On changing the hostname, License MAC changes. Rehost the new license for the new license MAC. Old license enters its grace period.

**Step 10**
Verify the status of Customer Collaboration Platform:

**Step 11**
Regenerate the status of Customer Collaboration Platform:

If Single Sign-On must be enabled, then perform the following steps:

a. Establish the trust between the Cisco Identity Service and Identity Provider.

b. Log in to the Cisco Unified CCX Administration and navigate to System -> Single Sign-On.

c. Click Register to onboard the SSO components even if you had onboarded the components earlier.

d. You can now enable Single Sign-On after you perform SSO Test again.

---

**Change HostName for Subscriber Server in HA Deployment**

Use this procedure to change the hostname of a subscriber server in a HA deployment.

**Procedure**

**Step 1**
Change the DNS record of the subscriber server to point to the new hostname. Ensure that you correctly update both the forward (A) and reverse (PTR) records, and there are no duplicate PTR records.

**Step 2**
Verify that the DNS change propagates to other nodes by using the `utils network host <IP Address>` CLI command on all the cluster nodes.

**Step 3**
To update new hostname of the subscriber in publisher, enter the following CLI command on the publisher server:

`utils uccx modify remote_hostname <Old_hostname_of_Subscriber> <New_hostname_of_Subscriber>`

The following output displays:

```
admin:utils uccx modify remote_hostname abcd-efg-h1 ijk1-mno-p2
Old Remote hostname: abcd-efg-h1
New Remote hostname: ijk1-mno-p2
```

This command should be executed only in case you are changing Hostname of remote server.
Are you sure you want to run this command?
Continue (y/n)?

Enter y and press Enter.

**Step 4**
To change the hostname of the subscriber server, perform either of the following methods:

- CLI commands

- Cisco Unified OS Administration interface

**Using CLI commands:**
a) Run the following CLI command on the subscriber server:

set network hostname

The following output displays:

admin:set network hostname

WARNING: Changing this setting will invalidate software license on this server. The license will have to be re-hosted.

Continue (y/n):
Continue (y/n)?y

*** Warning ***
This command will cause the system to restart

====================================================================================================

Note: Please verify that the new ip address is unique across the cluster and, if DNS services are utilized, any DNS configuration is completed before proceeding.
To recognize the new ip address all nodes within the cluster will have to be manually rebooted.

====================================================================================================

Continue (y/n)?y

Enter y and press Enter. The system services will automatically restart.

**Using Cisco Unified OS Administration interface:**
Change the hostname using Cisco Unified OS Administration interface of the subscriber server:

a) Choose Settings > IP > Ethernet.
b) Change the hostname.
c) Click Save. The system services will automatically restart.

**Step 5**
Restart all the servers in the cluster using the CLI command `utils system restart`.

**Note**
If you do not reboot the subscriber, all the services on the publisher may not start properly.

**Step 6**
From the publisher node, run CLI command `utils dbreplication reset all` to resetup Unified CM database replication across the entire cluster.

**Step 7**
From the publisher node, run CLI command `utils uccx dbreplication reset` to set up Unified CCX database replication across the cluster.

**Step 8**
Verify the status of CCP.
a) Choose Subsystems > Chat and Email > CCP Configuration.
b) Click Save and verify that the CCP Status displays green for all the components.
Step 9 If Single Sign-On must be enabled, then reestablish the trust between the Cisco Identity Service and Identity Provider in the Publisher node.

Step 10 Log in to the Cisco Unified CCX Administration and navigate to System -> Single Sign-On.

Step 11 Click Register to onboard the SSO components even if you had onboarded the components earlier.

Step 12 You can now enable Single Sign-On after you perform SSO Test again.

Verify Proper Function of System after IP Address/hostname Change

After you change the IP addresses/hostnames of your cluster, complete the following tasks:

Procedure

Step 1 Ensure that all the servers in the cluster are up and available.

Step 2 Check the DB replication status as described in Step 3 of Prepare System for IP Address/hostname Change, on page 140 to ensure all the servers are replicating database changes successfully.

Step 3 Run a manual DRS Backup and ensure that all nodes and active services are successfully backed up.

Step 4 Run the CLI command `utils diagnose module validate_network` through platform CLI on all nodes in the cluster to ensure network connectivity and DNS server configuration are intact.

Step 5 If you have changed the IP address to move the Unified CCX server to a different network, then any firewall configuration on the other network must be changed to permit or deny traffic from the new IP address.

Step 6 If you have created any DSN using old IP address, change the DSN to point to the new IP. For example, the DSN created for Wallboard.

Step 7 Update the new IP address in the following web pages as well:

  - Work Flow Configuration > User Interface > Browser Setup - URL and HomePage
  - Work Flow Configuration > HTTP Action - Host
  - Work Flow Configuration > IPC Action - IP Address

  Update the Recording configuration and the Cisco Customer Collaboration Platform configuration in the Unified CCX Administration page on the Publisher server.

Step 8 For Cisco Identity Service, Cisco Finesse and Unified Intelligence Centers users, delete the certificates entries for the old hostname/IP Address from the web browser before you log in to Cisco Identity Service, Cisco Finesse Agent Desktop or Unified Intelligence Center.

Step 9 Reregister the SSO components if the components were registered earlier.

Step 10 Perform the SSO Test to check if all the SSO components like CCX, CUIC and Finesse are registered and the test is successful for each component.

Domain Name Modification

This section describes how to change the domain name on single node and HA deployment.
Change the UCCX Domain Name

You can change the Unified CCX domain name based on the requirement. After changing the domain name, you must restart the server (in case of HA setup both publisher and subscriber nodes must be restarted). This regenerates all Unified CCX certificates including any third-party signed certificates. Unified CCX domain name change will not affect your existing license MAC unless the DNS server details are changed.

Before you begin

Before you change the Unified CCX domain name, ensure that you complete the following prerequisites:

• Change the Unified CCX fully qualified domain name (FQDN) in DNS server to reflect the new domain name.

• Ensure that both the forward and reverse lookups on the DNS server return the fully qualified domain name (FQDN).

• Ensure that all the services are running. Run the following command in the Unified CCX OS platform CLI to verify that all the services are running:

  `utils service list`

  **Note** If verification fails then identify the cause, resolve the issues to ensure that all the services are running.

• If you are using a HA setup, run the following command to check the database replication status:

  `utils dbreplication runtimestate`

  **Note** Check if the database replication status is in sync on both the nodes.

Procedure

**Step 1** Log in to Cisco Unified Communications OS Platform CLI using administrator username and password.

**Step 2** Run the following command on the Unified CCX to set the new domain name:

`set network domain <domain-name>`

**Step 3** Restart the node. Run the following command to restart the node:

`utils system restart`

**Note** If you are using a HA setup, first change the domain name of the publisher node, restart the publisher node and verify that all the services are running. Then change the domain name of the subscriber node, restart the subscriber node, and verify that all the services are running.

What to do next

After changing the Unified CCX domain name, perform the following:
• After restarting the node, run the following command to verify that all the services are running:

```
utils service list
```

• Once the services are running, check if the new domain name is updated. Run the following command to check the domain name:

```
show network eth0 detail
```

• If you are using a HA setup, run the following command to check the database replication status:

```
utils dbreplication runtimestate
```

---

**Note**

Check if the database replication status is in sync on both the nodes.

---

• Run the following command to check if all the system tests are passing:

```
utils diagnose test
```

• Check the license MAC to find out the difference if the DNS server details and the domain name are changed. Run the following command to check the license MAC:

```
show status
```

• Regenerate the SAML certificate through the **Cisco Identity Service Administration**.

If Single Sign-On must be enabled, then perform the following steps:

1. Establish the trust between the Cisco Identity Service and Identity Provider.
2. Log in to the Cisco Unified CCX Administration and navigate to **System -> Single Sign-On**.
3. Click **Register** to onboard the SSO components even if you had onboarded the components earlier.
4. You can now enable Single Sign-On after you perform **SSO Test** again.

**Related Topics**

- Single Sign-On (SSO), on page 266

---

**Set Up Certificates**

**Client Requirements**

For more information on client requirements, see **Compatibility Information** at


---

**Note**

Finesse Desktop client machines should be time synchronized with a reliable NTP server for the correct updates to the Duration fields within Live data reports.
Deploy Root Certificate for Internet Explorer

In environments where group policies are enforced via the Active Directory domain, the root certificate can be added automatically to each user's Internet Explorer. Adding the certificate automatically simplifies user requirements for configuration.

To avoid certificate warnings, each user must use the fully-qualified domain name (FQDN) of the Unified CCX server.

Set Up CA Certificate for Internet Explorer and Edge Browsers

After obtaining and uploading the CA certificates, the certificate must be automatically installed via group policy or all users must accept the certificate.

In environments where users do not log directly into a domain or group policies are not utilized, every Internet Explorer user in the system must perform the following steps once to accept the certificate:

**Procedure**

**Step 1**
In Windows Explorer, double-click the `ca_name.cer` file and then click **Open**.

**Note** Here the `ca_name` is the name of your certificate.

**Step 2**
In the **Certificate Import Wizard**, select **Current User**.

**Step 3**
Click **Install Certificate > Next > Place all certificates in the following store**.

**Step 4**
Click **Browse** and choose **Trusted Root Certification Authorities**.

**Step 5**
Click **OK > Next > Finish**.

**Step 6**
Click **Yes** on the install a certificate from a CA prompt.

**Step 7**
To verify the certificate was installed, from the browser menu on IE, choose **Tools > Internet Options**.

**Step 8**
In the **Content** tab, click **Certificates**.

**Step 9**
In the **Trusted Root Certification Authorities** tab, ensure that the new certificate appears in the list.

**Step 10**
Restart the browser for certificate installation to take effect.

**Note** If using Internet Explorer 11, you may receive a prompt to accept the certificate even if signed by private CA.

Set Up CA Certificate for Firefox Browser

Every Firefox user in the system must perform the following steps once to accept the certificate:

**Note** To avoid certificate warnings, each user must use the FQDN of the Unified CCX server to access the desktop.
Set Up CA Certificate for Chrome Browser

Procedure

Step 1 In the browser, go to Settings.
Step 2 In the Chrome browser, select Advanced Settings > Privacy and Security, click Manage Certificates.
Step 3 In the Edge browser, select Privacy, search, and services. Under Privacy, click.
Step 4 Click Trusted Root Certification Authorities tab.
Step 5 Click Import and browse to the ca_name.cer file.
Step 6 Restart the browser for the certificate to install.

Exit Unified CCX Administration

To exit Unified CCX Administration without closing your web browser, you can do either of the following:

Note

You can also exit Unified CCX Administration by closing your web browser.

Procedure

Step 1 Click the Logout link displayed in the top right corner of any Cisco Unified CCX Administration web page
Step 2 Choose System > Logout from the Unified CCX Administration menu bar.
The system logs you out of Unified CCX and displays the Unified CCX Authentication web page.
Unified CCX Reporting

• Reporting Administration on Unified CCX, on page 161
• Reporting Administration on Unified Intelligence Center, on page 205
• Start Unified Intelligence Center, on page 205
• Administrator Overview, on page 206
• Security Overview, on page 206
• User List, on page 207
• Create a User, on page 207
• User Groups, on page 209
• Manage User Permissions, on page 211
• Run As, on page 214
• Audit Trail Logging in Cisco Unified Intelligence Center, on page 215
• Audit Trail Report, on page 215
• Security Considerations, on page 215

Reporting Administration on Unified CCX

Import of Stock Reports

If you import stock reports from Unified Intelligence Center, run the CLI `utils uccx synctocuic permission all` command to reset the permissions of the user groups. For more information, see `utils uccx synctocuic` command in the Cisco Unified Contact Center Express Administration and Operations Guide.

**Note**

Do not create a sub-category under the **Stock** category as the permissions for the **Stock** category is automatically reset at midnight.

You can now rename the Stock Reports folder name.

Unified CCX Historical Reports

Historical reports are the preconfigured reports in Unified Intelligence Center. These reports access past data from the historical data source to display information for the specified period of time.
Unified CCX Historical Datastore

In a Unified CCX Cluster, there can be one or more Historical datastores.

**Note** Support for High Availability and remote servers is available only in multiple-server deployments.

The Historical Unified CCX Datastore can be co-located with the Unified CCX.

**Note** In a Unified CCX High Availability server with co-resident Cisco Unified Intelligence Center, Cisco Unified Intelligence Center will intelligently point to the appropriate datasource. This will require no manual configuration during failover or in island mode scenario. For more information about Historical datastore, see *Cisco Unified Contact Center Express Serviceability Administration Guide*.

**Historical Reporting Configuration**

The Unified CCX Historical Reporting subsystem provides you with a way to set up and manage the purging of the Historical Reporting databases.

Setting up Unified CCX for Historical Reporting consists of the following tasks:

1. **Configure Automatic Purging**, on page 164

**Configure Database Server Limits**

To limit the performance impact of historical reporting on a particular Unified CCX server, you can configure a maximum number of five client/scheduler database connections per server.

To do so, complete the following steps:

**Procedure**

**Step 1** From the Unified CCX Administration menu bar, choose **Tools > Historical Reporting > Database Server Configuration**.

The Database Server Configuration web page opens with the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Server Name</td>
<td>The hostname or IP Address of the database server.</td>
</tr>
</tbody>
</table>
### Maximum DB Connections for Report Client Sessions

The maximum number of client and scheduler connections that can access the Historical Reports Database server.

There is a limit of instances for the reporting client sessions and the scheduler sessions based on the load that can be run on each server. The following are the limits:

- **Standalone Setup**—1 to 8 instances
- **High Availability Setup**—1 to 16 instances

#### Step 2
Enter a value in the **Maximum DB Connections for Report Client Sessions** field next to a Server Name.

#### Step 3
Click **Update**.

The configuration changes take effect.

---

**View Historical Reports**

You can view historical reports through the Unified Intelligence Center.

**Procedure**

Choose **Tools > User Management > Reporting Capability View**

The User Configuration web page opens.

---

**Purge of Historical Data**

As the Unified CCX Engine runs, it collects information about the status and performance of the Unified CCX system. Historical information is stored in a database that can then be accessed to provide reports.

When the database approaches its maximum size, some or all of the data in it must be removed. Removing data from a database is called **purging**.

When the system purges data, it removes data from the db_cra database. It determines what information to purge based on the number of months you specify and on the current date. For example, if you instruct the system to purge data older than 12 months, a purge on January 15 will purge data older than January 15 of the previous year.

**Note**

When you purge data, you permanently delete it. If you want to keep data that will be purged, back up the database.

Unified CCX Administration provides the following features for purging historical reports from the database:
Configure Automatic Purging

The Unified CCX Engine performs automatic purging each day at a preset time.

To help keep your system running most efficiently, schedule automatic purging to run when your system is least busy. By default, daily purges are scheduled to run at 01:00 a.m. (01:00 Hrs), but you can change this time.

The system bases its purging activities on a variety of parameters. You can change the default value for any parameter as needed.

The following section contains the procedure for setting the daily purge schedule and auto purge.

Configure Purge Schedule Configuration Parameters

You can change the time of day that the system assesses the need to purge data and the age of data to purge.

When data is purged, the Unified CCX sends a “Database purged” message. This message announces that a purge has taken place and includes an explanation of the purging activity. If the database is approaching its maximum size, then the Unified CCX sends the following message - “Database approaching maximum size”.

The system can send notifications through the following two methods:

- Syslog (system log)
- SNMP traps

To set the purge schedule configuration parameters, complete the following steps.

Procedure

Step 1

From the Unified CCX Administration menu bar, choose Tools > Historical Reporting > Purge Schedule Configuration.

The Purge Schedule Configuration area opens. The following fields are displayed in the Purge Schedule Configuration area.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Purge Schedule</td>
<td></td>
</tr>
</tbody>
</table>
**Field** | **Description**
--- | ---
Daily purge at | Time of day for the daily purge along with the time zone. The time that appears here is based on the primary time zone, which is specified during initial setup of Unified CCX Administration. In a High Availability over WAN deployment, the purge schedule will happen at the time zone of the primary node.

**Note** Unified CCX to Unified Intelligence Center sync runs as part of the purge. It synchronizes the users, teams and grants Live Data report permissions.

Purge data older than | Data can persist for a number of months before being purged.

Purge run time | The total duration for which the purge process should run.

**Auto Purge Configuration**

Initiate automatic purge when database exceeds | Percentage of the maximum database size at which an automatic purge is initiated (as compared to the total available size).

Initiate automatic purge when extent size exceeds | Percentage of the maximum extents size of any table above which an automatic purge is initiated.

Auto purge data for the oldest | Age of data to be purged.

**Step 2** From the drop-down list in the Daily purge at field, choose a time of day at which the system determines if purging is necessary.

**Step 3** From the drop-down list in the Purge data older than field, choose the required number of months.

If the system determines that purging is necessary, it will purge both databases of data that is older than the number of months specified in this field.

**Step 4** From the drop-down list in the Purge run time field, specify the required number of hours.

If the system determines that purging is necessary, it will purge both databases of data within the specified duration of time.

**Step 5** From the drop-down list in the Initiate automatic purge when database size exceeds field, accept the default, or choose another number.

**Step 6** From the drop-down menu in the Auto purge data for the oldest field, accept the default of 15, or choose another number.

**Step 7** From the drop-down list in the initiate automatic purge when extent size exceeds field, accept the default, or choose another number.

**Step 8** Click **Update** icon that displays in the tool bar in the upper, left corner of the window or the **Update** button that displays at the bottom of the window.
The new purge schedule configuration is added to the Unified CCX system.

---

Purge Manually

You can manually purge the databases at any time. This action will not affect the automatic purging schedule.

Note

Support for High Availability is available only in multiple-server deployments.

To manually purge historical data, complete the following steps.

Procedure

**Step 1**
From the Unified CCX Administration menu bar, choose **Tools > Historical Reporting > Purge Now**.

The Purge Now web page opens. The Purge data older than field is displayed in the Purge Now web page. You can specify this field in months and days.

**Step 2**
From the drop-down list in the Purge data older than $N$ months field, keep the default (13 months) or specify the required number of months.

If the system determines that purging is necessary, it will purge both databases of data that is older than the number of months specified in this field.

The Initiate automatic purge when database exceeds field displays the current historical database size as compared to the total available size.

**Step 3**
From the drop-down list in the Purge data older than $N$ days field, keep the default (15 days) or specify the required number of days.

If the system determines that purging is necessary, it will purge both databases of data that is older than the number of days specified in this field.

**Step 4**
From the drop-down list in the Purge run time, keep the default (7 hours) or specify the required number of hours.

If the system determines that purging is necessary, it will purge both databases of data within the specified duration of the time.

**Step 5**
Click **Purge Now**.

The database purge is initiated in the server and the Purge Now area refreshes.

---

File Restore

Use the File Restore menu option to restore the database records written to HR files when the database goes down.
Unified CCX Real-Time Reports

When the Unified CCX system is configured and functioning, you can run reports to monitor real-time activity using the Unified CCX Administration web interface.

To access Real-Time Reporting tools, you must configure the DNS client on your local machine.

If your local machine is not in the domain where Unified CCX resides, enter the hostnames in the local host file for the machines that house Unified CCX nodes.

You must be logged into the Unified CCX Administration web interface to run Unified CCX real-time reports.

Available Unified CCX Real-Time Reports

Unified CCX real-time reporting provides real-time reports you can use to monitor Unified CCX system activity. The following table briefly describes each of these reports.

<table>
<thead>
<tr>
<th>Report</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application Tasks</td>
<td>Provides information about currently active applications.</td>
</tr>
<tr>
<td>Application Tasks Summary</td>
<td>Provides a summary of specific application activity.</td>
</tr>
<tr>
<td>Applications</td>
<td>Provides a list of all applications loaded on the Unified CCX server.</td>
</tr>
<tr>
<td>Contacts Summary</td>
<td>Provides information for call contacts, email contacts, and HTTP contacts. Also provides the total number of contacts.</td>
</tr>
<tr>
<td>Note</td>
<td>Calls made by the Outbound subsystem will not be displayed in the Contacts Summary Real-Time Report.</td>
</tr>
<tr>
<td>Contacts</td>
<td>Provides information about currently active contacts.</td>
</tr>
<tr>
<td>Chat CSQ Cisco Unified Contact Center Express Stats</td>
<td>Provides information about Chat CSQ activity. This report is available only if Unified CCX has been configured.</td>
</tr>
<tr>
<td>Chat Resource Cisco Unified Contact Center Express Stats</td>
<td>Provides information about Chat Unified CCX resources activity.</td>
</tr>
<tr>
<td>CSQ Cisco Unified Contact Center Express Stats</td>
<td>Provides information about CSQ activity. This report is available only if Unified CCX has been configured.</td>
</tr>
<tr>
<td>Data Source Usage</td>
<td>Provides information about configured data source names (DSNs).</td>
</tr>
<tr>
<td>Engine Tasks</td>
<td>Provides information about currently active Engine tasks.</td>
</tr>
<tr>
<td>Preview Outbound Campaign Cisco Unified Contact Center Express Stats</td>
<td>Provides information about real-time Unified CCX information for the Outbound preview dialer.</td>
</tr>
</tbody>
</table>
### Report Menu, on page 172

#### Open Real-Time Reports

Real-Time reporting is available from the Unified CCX Administration web interface.

Real-Time Reporting requires the Java plug-in. If the Java plug-in is not already installed on the PC on which you are viewing the reports, the Unified CCX system automatically installs it when you choose **Tools > Real Time Reporting Tool**.

- Use Mozilla Firefox and Internet Explorer for Real Time Reporting.
- If you are using Mozilla Firefox, you must manually install the correct version of JRE to use real-time reports.

<table>
<thead>
<tr>
<th>Report</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Outbound Campaign Stats</td>
<td>Provides real-time statistics on IVR and agent based progressive and predictive Outbound campaigns since the statistics were last reset.</td>
</tr>
<tr>
<td><strong>Note</strong></td>
<td>This report will be available only if you have an Outbound license on top of the Unified CCX premium license in your Unified CCX.</td>
</tr>
<tr>
<td>Overall Outbound Stats</td>
<td>Provides real-time statistics across all IVR and agent based progressive and predictive Outbound campaigns since the statistics were last reset.</td>
</tr>
<tr>
<td><strong>Note</strong></td>
<td>This report will be available only if you have an Outbound license on top of the Unified CCX premium license in your Unified CCX.</td>
</tr>
<tr>
<td>Overall Chat Cisco Unified Contact Center Express Stats</td>
<td>Provides information about Chat Unified CCX resources and contact information. This report is available only if Unified CCX has been configured.</td>
</tr>
<tr>
<td>Overall Cisco Unified Contact Center Express Stats</td>
<td>Provides information about Unified CCX resources and calls. This report is available only if Unified CCX has been configured.</td>
</tr>
<tr>
<td>Resource Cisco Unified Contact Center Express Stats</td>
<td>Provides information about Unified CCX resources activity.</td>
</tr>
<tr>
<td>Sessions</td>
<td>Provides information on all active sessions.</td>
</tr>
</tbody>
</table>
The Application Reporting web page is a stand-alone component of the Unified CCX Administration interface. It has its own menu bar, which replaces the Unified CCX Administration menu bar.

To open real-time reporting, complete the following steps.

**Procedure**

**Step 1**
If you are running Real-Time Reporting for the first time on this system, log into Unified CCX Administration as an Administrator.

The system prompts you to download the Java plug-in; follow the prompt instructions.

**Note** After you perform the initial download of the Real-Time Reporting Java plug-in, non-Administrative users can access Real-Time Reporting on this system.

**Step 2**
Choose Tools > Real-Time Reporting from the Unified CCX Administration menu bar.

The Application Reporting web page opens in a new window. The real-time reporting tool requires a Java plug-in. If the plug-in is not installed on the machine you are using, the Unified CCX system prompts you to accept the automatic installation of the plug-in. If you do not accept the installation, you cannot use real-time reporting.

---

**Run Reports**

Open the real-time reporting tool from the Unified CCX Administration web interface to run reports.

To run a real-time report, complete the following steps.

**Procedure**

**Step 1**
From the Application Reporting menu bar, choose Reports.

**Step 2**
From the Reports menu, choose the report to run.

The report opens in the Application Reporting window.

---

**View Detailed Subreports**

You can view more detailed information for selected items in these four reports:

- Application Tasks report
- Contacts report
- Applications report
- Sessions report

To view detailed subreports, complete the following steps.
Procedure

Step 1  Run the Application Tasks, Contacts, Applications, or Sessions report.
Step 2  Click a line in the report for which you want to view more detailed information. For example, click an email address in the Contacts report.
Step 3  From the Application Reporting menu bar, choose Views and click the subreport that you want to run.

You can also open a subreport by right-clicking the selected item and choosing a subreport.

The subreport opens.

Print Reports

To facilitate printing, you can open a printable version of a report.
To print a report, complete the following steps.

Procedure

Step 1  Run a report.
Step 2  From the Application Reporting menu, choose Tools > Open Printable Report.

A printable version of the report opens in a separate window.
Step 3  Print the report using your browser print functionality.

Reset Report Statistics

The Unified CCX system automatically resets all statistics each day at midnight. You can reset the accumulated statistics manually at any time. Resetting statistics does not reset active statistics, such as active contacts and active tasks.

To reset report statistics, complete the following steps.

Procedure

Step 1  From the Application Reporting menu bar, choose Tools > Reset All Stats.

The Reset Stats dialog box opens for you to confirm the reset.
Step 2  Click Yes.

Accumulated statistics are reset.
Clear Contact Option for Stuck Calls

You may sometimes see a Contact/Call as waiting in Real Time Reports in CSQ Stats, and even though there are available Agents in the queue, the call does not seem to get routed to these Agents. The waiting time for the Queued call accumulates and will not clear even if the user activates “Reset All Stats” option from the Real-Time Reporting menu.

To enable clearing such stuck call entries from the system, Unified CCX system provides the Clear Contact option. This has the ability to clear stuck calls in the system without requiring a restart of the engine.

Set Report Options

You can set the following reporting options:

- Refresh interval
- Number of times that the Unified CCX Administration web interface should attempt to reconnect to the Unified CCX server
- Whether logged off users appear in reports

To set report options, complete the following steps.

Procedure

- **Step 1**: From the Application Reporting menu bar, choose **Settings > Options**. The Options dialog box opens.
- **Step 2**: From the Polling Interval drop-down menu, choose the refresh rate in seconds.
- **Step 3**: From the Server Connect Retry Count drop-down menu, choose the number of times that the Unified CCX Administration web interface should attempt to reconnect to the Unified CCX server.
- **Step 4**: From the Show Logged Off Resources drop-down menu, choose whether logged-off agents appear in reports.
- **Step 5**: Click **Apply** to apply the settings.

Set Report Appearance

You can select from three report appearances:

- Windows, which displays reports in colors based on your Windows settings
- Motif, which displays reports in purple and menu items in brown
- Metal, which displays reports in grey and menu items in black

To set the report appearance:

Procedure

Choose **Settings** from the Application Reporting menu bar and click the appearance that you want.
Application Reporting User Interface

Note
Support for High Availability and remote servers is available only in multiple-server deployments.

When you choose Tools > Real-Time Reporting from the Unified CCX Administration menu, the Application Reporting tool opens a web page in a new window.

The Application Reporting tool menu bar contains the following options:

- **Report**—Choose this option to display a list of the available top-level real-time reports.
- **Tools**—Choose this option to reset all the statistics and refresh connections.
- **Settings**—Choose this option to set the look and feel of the real-time Reporting client, set the polling (refresh) interval times, and set the amount of times the server will attempt to reconnect.
- **Help**—Choose this option to display system information and to access Unified CCX online help.

**Report Menu**

Note
All real-time reports display a Last Updated At field, which indicates the time of the snapshot. All summary reports display both a start time (which indicates when the summary statistics started being collected) and the current time. All real-time reports display a Connected or Not Connected status for each node in the cluster.

The Report menu provides access to a variety of top-level reports. It contains the following menu options:

- **Contacts Summary Real-Time Report**, on page 173
- **Application Tasks Summary**, on page 175
- **Application Tasks Real-Time Report**, on page 176
- **Engine Tasks Real-Time Report**, on page 176
- **Contacts Report**, on page 177
- **Applications Report**, on page 181
- **Sessions Report**, on page 182
- **Data Source Usage Report**, on page 182
- **Overall Cisco Unified Contact Center Express Stats Report**, on page 183
- **CSQ Cisco Unified Contact Center Express Stats Report**, on page 187
- **Preview Outbound Campaign Cisco Unified Contact Center Express Stats Report**, on page 188
- **Outbound Campaign Stats Report**, on page 194
- **Overall Outbound Stats Report**, on page 197
- **Resource Cisco Unified Contact Center Express Stats Report**, on page 198
- **Failover Behavior for Unified CCX Stats**, on page 200
High Availability (HA) Setup

In an HA setup, real-time reports obtain data from both nodes in the cluster.

- Support for High Availability and remote servers is available only in multiple-server deployments.
- In case of island mode where each node (on either side of the network) assumes mastership and handles calls, the real-time reports may not report accurate data.

Failover in a two-node cluster is available for Unified IP IVR reports as described in the following table.

<table>
<thead>
<tr>
<th>Failover Scenario</th>
<th>Connection Status</th>
<th>Node 1 Status</th>
<th>Node 2 Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>Both nodes are up</td>
<td>Fully Connected</td>
<td>Node ID current/start-time</td>
<td>Node ID current/start-time</td>
</tr>
<tr>
<td>Node 1 is up</td>
<td>Partially Connected</td>
<td>Node ID current/start-time</td>
<td>Node ID Not Connected</td>
</tr>
<tr>
<td>Node 2 is down</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Node 1 is down</td>
<td>Partially Connected</td>
<td>Node ID Not Connected</td>
<td>Node ID current/start-time</td>
</tr>
<tr>
<td>Node 2 is up</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Both nodes are down</td>
<td>Not Connected</td>
<td>Node ID Not Connected</td>
<td>Node ID Not Connected</td>
</tr>
</tbody>
</table>

Unified CCX real-time reports obtain data only from the current master node—failover in a two-node cluster is available as described in the following table.

<table>
<thead>
<tr>
<th>Failover Scenario</th>
<th>Connection Status</th>
<th>Node 1 Status</th>
<th>Node 2 Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>Both nodes are up</td>
<td>Fully Connected</td>
<td>Node ID current/start-time</td>
<td>Node ID Not Connected</td>
</tr>
<tr>
<td>Node 1 is master</td>
<td>Fully Connected</td>
<td>Node ID current/start-time</td>
<td>Node ID Not Connected</td>
</tr>
<tr>
<td>Node 2 is down</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Node 1 is down</td>
<td>Fully Connected</td>
<td>Node ID Not Connected</td>
<td>Node ID current/start-time</td>
</tr>
<tr>
<td>Node 2 is master</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Both nodes are down</td>
<td>Not Connected</td>
<td>Node ID Not Connected</td>
<td>Node ID Not Connected</td>
</tr>
</tbody>
</table>

Contacts Summary Real-Time Report

Use the Contacts Summary report to view specific contact information for call contacts, email contacts, HTTP contacts, and total number of contacts.

To access the Contacts Summary real-time report, choose Reports > Contacts Summary from the Application Reporting menu bar.

You display the data on this report as numbers or percentages by clicking the Display Value/Display % toggle button.
The following fields are displayed on the Contacts Summary report.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>Active contacts that are currently running.</td>
</tr>
<tr>
<td>Inbound</td>
<td>Number of inbound contacts since the statistics were last reset.</td>
</tr>
<tr>
<td>Outbound</td>
<td>Number of outbound contacts since the statistics were last reset.</td>
</tr>
<tr>
<td>Connected</td>
<td>Number of connected contacts since the statistics were last reset.</td>
</tr>
<tr>
<td></td>
<td>Provides a total for contacts that are connected to resources (for example,</td>
</tr>
<tr>
<td></td>
<td>a call connected to an ACD agent).</td>
</tr>
<tr>
<td>Terminated</td>
<td>Number of terminated contacts since the statistics were last reset.</td>
</tr>
<tr>
<td></td>
<td>This row reports contacts that are ended normally by the application (for</td>
</tr>
<tr>
<td></td>
<td>example, a caller hangs up and the application terminates), indicating</td>
</tr>
<tr>
<td></td>
<td>whether the contact was terminated:</td>
</tr>
<tr>
<td></td>
<td>• Locally—On the local server.</td>
</tr>
<tr>
<td></td>
<td>• Remotely—On a remote server in the cluster.</td>
</tr>
<tr>
<td>Rejected</td>
<td>Number of rejected contacts since the statistics were last reset.</td>
</tr>
<tr>
<td></td>
<td>This row reports contacts that are not accepted and processed (as a result,</td>
</tr>
<tr>
<td></td>
<td>for example, of insufficient resources or the rejection of the contact</td>
</tr>
<tr>
<td></td>
<td>based on some customer-defined logic). Indicates the reason code for the</td>
</tr>
<tr>
<td></td>
<td>reject:</td>
</tr>
<tr>
<td></td>
<td>• Channels busy</td>
</tr>
<tr>
<td></td>
<td>• No channel license</td>
</tr>
<tr>
<td></td>
<td>• No trigger</td>
</tr>
<tr>
<td></td>
<td>Use the + toggle button to access these statistics.</td>
</tr>
</tbody>
</table>
### Application Tasks Summary

Use the Application Tasks Summary report to display statistics that summarize the activity of specific applications.

To access the Application Tasks Summary real-time report, choose **Reports > Application Tasks Summary** from the Application Reporting menu bar.

The following fields are displayed on the Application Tasks Summary report.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Aborted</td>
<td>Number of aborted contacts since the statistics were last reset.</td>
</tr>
<tr>
<td></td>
<td>This row reports contacts improperly ended by a task associated with the application (as when, for example, the system generates an exception or can not invoke the application because of some error in the application) and includes the associated Java exception code.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong> Java exception codes are dynamic, as they can be generated from a variety of sources.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong> Use the + toggle button to access these statistics.</td>
</tr>
<tr>
<td>Handled</td>
<td>Number of handled contacts since the statistics were last reset.</td>
</tr>
<tr>
<td></td>
<td>This row reports contacts that are explicitly marked “Handled” by the application (typically when the application connects the contact to a Unified CCX agent).</td>
</tr>
<tr>
<td>Abandoned</td>
<td>Number of abandoned contacts since the statistics were last reset.</td>
</tr>
<tr>
<td></td>
<td>This row reports contacts that end without being marked “Handled” by the application.</td>
</tr>
</tbody>
</table>

| Application Name | Names of the applications that are running or have run.                   |
| Running          | Currently running applications.                                           |
| Completed        | Applications that have stopped running.                                   |
| Total            | Number of times an application was invoked since the statistics were last reset. |
Application Tasks Real-Time Report

Use the Application Tasks real-time report to view information about currently active applications.

To access the Application Tasks report, choose **Reports > Application Tasks** from the Application Reporting menu bar. The following fields are displayed on the Application Tasks report.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DTMF VB and AA</td>
<td>Application names configured from the Unified CCX Administration.</td>
</tr>
<tr>
<td>Status</td>
<td>Displays the failover connection status. The possibilities are: Fully connected, Partially connected, and Not connected. See the following tables for detailed status information for Unified IP IVR and Unified CCX reports.</td>
</tr>
</tbody>
</table>

**Note**

If this report indicates that an application is running for an unusually long time, there may be a problem with the application. The application script may not include error handling that prevents infinite retries if a call is no longer present. If the application does not receive a disconnect signal after a call, the application repeatedly retries to locate the call, and causes the application to run for an unusually long time. To prevent this problem, include the proper error handling in the application script.

Engine Tasks Real-Time Report

Use the Engine Tasks real-time report to view information about currently active Engine tasks.

To access the Engine Tasks report, choose **Reports > Engine Tasks** from the Application Reporting menu bar.

The following fields are displayed on the Engine Tasks report.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ID</td>
<td>Unique identifier of the engine task.</td>
</tr>
<tr>
<td></td>
<td>If the engine task is the main task running the application and the parent ID is empty, its identifier will match the Application Task Identifier.</td>
</tr>
</tbody>
</table>
Contacts Report

Use the Contacts real-time report to view information for all the active contacts for all servers across clusters.

**Note**
Support for High Availability and remote servers is available only in multiple-server deployments.

To access the Contacts report, choose Reports > Contacts from the Application Reporting menu bar.

You can access detailed information about specific contacts listed on the Contacts web page by performing one of the following procedures:

- Call Contacts Detailed Info Report, on page 178
- Email Detailed Info Report, on page 179
- HTTP Detailed Info Report, on page 179

The following fields are displayed on the Contacts report.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ID</td>
<td>Unique identifier representing a contact.</td>
</tr>
<tr>
<td>Type</td>
<td>Type of contact: Unified CM Telephony call, Cisco agent call, or</td>
</tr>
<tr>
<td>Impl ID</td>
<td>Unique identifier provided by the particular type of contact. For example,</td>
</tr>
<tr>
<td></td>
<td>for a call contact, this identifier would represent the Unified CM global</td>
</tr>
<tr>
<td></td>
<td>call ID.</td>
</tr>
<tr>
<td>Node ID</td>
<td>Unique identifier for a server in the cluster.</td>
</tr>
<tr>
<td>Start Time</td>
<td>Time stamp when the contact was created.</td>
</tr>
<tr>
<td>Duration</td>
<td>Length of time that the contact is active.</td>
</tr>
<tr>
<td>Handled</td>
<td>If True, the contact is handled; if False, the contact is not handled.</td>
</tr>
</tbody>
</table>
If True, the contact is aborted with a default treatment; if False, the contact is not aborted.

**Application**

Name of the application currently managing the contact.

**Task**

Unique identifier of the application task that is currently responsible for the contact.

**Session**

Unique identifier of the session currently managing the contact (if any).

The information displayed is dependent on the type of contact selected. Depending on the type of call, some fields may not be supported and will appear blank.

**Call Contacts Detailed Info Report**

Use the Call Contacts Detailed Info real-time report to view all information related to the call contact.

To access the Call Contacts Detailed Info report, right-click a specific call contact record on the Contacts report; information for that specific record displays.

The following fields are displayed on the Call Contacts Detailed Info report.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>State</td>
<td>Current state of the contact.</td>
</tr>
<tr>
<td>Inbound</td>
<td>If True, this call was received by the Unified CCX server; if False, this call was placed as an outbound call by an application.</td>
</tr>
<tr>
<td>Language</td>
<td>The selected language context of the call.</td>
</tr>
<tr>
<td>Application ID</td>
<td>Unique identifier of the associated application.</td>
</tr>
<tr>
<td>Called Number</td>
<td>Called number for this call leg from the perspective of the called party.</td>
</tr>
<tr>
<td>Dialed Number</td>
<td>Dialed number for this call leg from the perspective of the calling party.</td>
</tr>
<tr>
<td>Calling Number</td>
<td>Calling number of the originator of this call.</td>
</tr>
<tr>
<td>ANI</td>
<td>Automatic number identification.</td>
</tr>
<tr>
<td>DNIS</td>
<td>Dialed number identification service.</td>
</tr>
<tr>
<td>CLID</td>
<td>Caller ID.</td>
</tr>
</tbody>
</table>
### Description Field
Information on how the call contact arrived in the system.

### Arrival Type
Information on how the call contact arrived in the system.

### Last Redirected Number
Number from which the last call diversion or transfer was invoked.

### Original Called Number
Originally called number.

### Original Dialed Number
Originally dialed number.

### ANI Digits
Automatic Number Identification information indicator digit codes.

### CED
Entered digits that were gathered by the network before the call was received.

---

**Email Detailed Info Report**

Use the Email Detailed Info real-time report to view all information related to the email contact.

To access the Email Detailed Info report, right-click a specific email contact record on the Contacts report; information for that specific record displays.

The following fields are displayed on the Email Detailed Info report.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>State</td>
<td>Current state of the contact.</td>
</tr>
<tr>
<td>Inbound</td>
<td>If True, this email message was received by the Unified CCX server; if False, this email was created by an application.</td>
</tr>
<tr>
<td>Note</td>
<td>Inbound email messages are not currently supported.</td>
</tr>
<tr>
<td>Language</td>
<td>Selected language context of the email message.</td>
</tr>
<tr>
<td>Application ID</td>
<td>Unique identifier of the associated application.</td>
</tr>
<tr>
<td>From</td>
<td>Sender of this email message.</td>
</tr>
<tr>
<td>To</td>
<td>All the recipients of this email message.</td>
</tr>
<tr>
<td>Subject</td>
<td>“Subject” field of this email message.</td>
</tr>
<tr>
<td>Attachments</td>
<td>List of all attachments (file names) associated with this email message.</td>
</tr>
</tbody>
</table>

---

**HTTP Detailed Info Report**

Use the HTTP Detailed Info real-time report to view all information related to the HTTP contact.
To access the HTTP Detailed Info report, right-click a specific HTTP contact record in the Contacts report; information for that specific record displays.

The following fields are displayed on the HTTP Detailed Info report.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>State</td>
<td>Current state of the contact.</td>
</tr>
<tr>
<td>Inbound</td>
<td>If True, this HTTP request was received by the Unified CCX server; if False, this HTTP request was created by an application. Note: This information will always be reported as True, because the Unified CCX server does not currently track outbound HTTP requests in this way.</td>
</tr>
<tr>
<td>Language</td>
<td>Language currently associated with the HTTP request.</td>
</tr>
<tr>
<td>Application ID</td>
<td>Unique identifier of the associated application.</td>
</tr>
<tr>
<td>Authentication Type</td>
<td>Name of the authentication scheme used to protect the servlet; for example, “BASIC” or “SSL.”</td>
</tr>
<tr>
<td>Character Encoding</td>
<td>Length, in bytes, of the request body, which is made available by the input stream, or -1 if the length is not known. Note: This length is the same as the value of the CGI variable CONTENT_LENGTH.</td>
</tr>
<tr>
<td>Content Length</td>
<td>MIME type of the body of the request, or null if the type is not known. Note: This is the same as the value of the CGI variable CONTENT_TYPE.</td>
</tr>
<tr>
<td>Content Type</td>
<td>Type of HTTP contact request.</td>
</tr>
<tr>
<td>Request Language</td>
<td>Preferred language for client content (the language that the client accepts for its content), based on the Accept-Language header.</td>
</tr>
<tr>
<td>Path Info</td>
<td>Any extra path information associated with the URL the client sent when the HTTP request was made.</td>
</tr>
<tr>
<td>Protocol</td>
<td>Name and version of the protocol the request uses in the form: protocol/majorVersion.minorVersion; for example, HTTP/1.1. Note: This value is the same as the value of the CGI variable SERVER_PROTOCOL.</td>
</tr>
</tbody>
</table>
### Field | Description
--- | ---
Remote Address | IP address of the client that sent the request
**Note** | This value is the same as the value of the CGI variable REMOTE_ADDR.
Remote Host | Fully qualified name of the client that sent the request, or the IP address of the client, if the name cannot be determined
**Note** | This value is the same as the value of the CGI variable REMOTE_HOST.
Remote User | Login of the user making this request, if the user has been authenticated.
Requested Session ID | HTTP session ID as specified by the client.
Request URL | Section of the URL of the HTTP request, from the protocol name up to the query string in the first line of the HTTP request.

2 CGI = Common Gateway Interface

---

**Applications Report**

Use the Applications real-time report to view all the applications loaded on the server.

To access the Applications report, choose **Reports > Applications** from the Application Reporting menu bar.

The following fields are displayed on the Applications report.

### Field | Description
--- | ---
Name | Unique name of the currently loaded application.
ID | Application ID.
Type | Type of application that is currently running (for example, a Cisco Script Application).
Description | Description of the application as entered on the Unified CCX Administration web site.
Enabled | If True, the application is enabled; if False, the application is disabled.
Max. Sessions | Maximum number of simultaneous task instances that can run simultaneously on the Unified CCX server.
Valid | If True, the application is valid; if False, the application is invalid.2
An application is valid if it was successfully loaded and initialized from its configuration. At any time, an application can become invalid if it internally fails to be refreshed.

**Sessions Report**

Use the Sessions real-time report to view real-time information on all the active sessions.

To access the Sessions report, choose **Reports > Sessions** from the Application Reporting menu bar.

The following fields are displayed on the Sessions report.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ID</td>
<td>Session ID. This identifier is guaranteed to remain unique for a period of 12 months.</td>
</tr>
<tr>
<td>Mapping ID</td>
<td>User- or system-defined identifier that maps to this session.</td>
</tr>
<tr>
<td>Node ID</td>
<td>Unique identifier for a server in the cluster.</td>
</tr>
<tr>
<td>Parent</td>
<td>Sessions that were created as a result of consult calls propagated in the system.</td>
</tr>
<tr>
<td>Creation Time</td>
<td>Creation time of the session.</td>
</tr>
<tr>
<td>State</td>
<td>Current state of the session.</td>
</tr>
<tr>
<td>Idle Time</td>
<td>Length of time that the session has been idle.</td>
</tr>
</tbody>
</table>

**Data Source Usage Report**

Use the Data Source Usage real-time report to view real-time information on all configured Data Source Names (DSNs).

To access the Data Source Usage report, choose **Reports > Datasource Usage** from the Application Reporting menu bar.

The following fields are displayed on the Data Source Usage report.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Source Name</td>
<td>Name of the data source, as configured through the Unified CCX Administration web interface.</td>
</tr>
<tr>
<td>Available Connections</td>
<td>Number of connections available.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Busy Connections</td>
<td>Number of busy connections.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong> Busy + available = Maximum number of connections configured.</td>
</tr>
<tr>
<td>Checkouts Granted</td>
<td>Number of times the database connections have been used up since the statistics were last reset.</td>
</tr>
<tr>
<td>Checkouts Denied</td>
<td>Number of times the Database connections have been denied since the statistics were last reset.</td>
</tr>
</tbody>
</table>

**Overall Cisco Unified Contact Center Express Stats Report**

Use the Overall Cisco Unified Contact Center Express Stats real-time report to view real-time Unified CCX resource and call information.

**Note**

Unified CCX reports contain information for calls that have been queued in one or more CSQs. If a call is not queued (for example, the caller hangs up before being queued), the reports do not display data for that call.

Unified CCX reports retrieve the following statistics:
- Unified CCX statistics from the current Master node.
- Unified IP IVR statistics from all nodes in the cluster.

To access the Overall Unified CCX Stats report, choose **Reports > Overall Cisco Unified Contact Center Express Stats** from the Application Reporting menu bar.

**Note**

Preview Outbound durations are updated when the preview outbound call disconnects and all agents (resources) involved in the call move out of the Work and Talking state.

The following fields are displayed on the Overall Cisco Unified Contact Center Express Stats report.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Resource Information</strong></td>
<td></td>
</tr>
<tr>
<td>CSQs</td>
<td>Number of CSQs currently configured. If a CSQ is added or removed, this statistic reflects that change.</td>
</tr>
<tr>
<td>Logged-in Resources</td>
<td>Number of resources currently logged in.</td>
</tr>
<tr>
<td>Talking Resources</td>
<td>Number of resources currently talking.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong> This number includes resources in Talking, Work, and Reserved states.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Ready Resources</td>
<td>Number of resources currently ready.</td>
</tr>
<tr>
<td>Not Ready Resources</td>
<td>Number of resources currently not ready.</td>
</tr>
<tr>
<td><strong>Call Information — Inbound</strong></td>
<td></td>
</tr>
<tr>
<td>Total Contacts</td>
<td>Number of total contacts that have arrived since the statistics were last reset. This includes contacts that are waiting, contacts connected to a resource, and contacts that have disconnected. If a resource transfers to or conferences with a route point, this value increases.</td>
</tr>
<tr>
<td>Contacts Waiting</td>
<td>Number of contacts waiting to be connected to a resource. A contact is shown as waiting until the call is answered by the agent. This means that, even if the phone is ringing at the agent, the contact will still show as waiting in RTR.</td>
</tr>
<tr>
<td>Oldest Contact in Queue</td>
<td>Displays the wait time for the oldest contact in the queue.</td>
</tr>
<tr>
<td>Contacts Handled</td>
<td>Number of contacts that have been handled by a resource.</td>
</tr>
<tr>
<td>Contacts Abandoned</td>
<td>Number of contacts that have arrived and disconnected before being connected to a resource.</td>
</tr>
<tr>
<td>Avg Talk Duration</td>
<td>Average duration (in seconds) that resources spend talking on Unified CCX contacts. Talk duration starts when a contact first connects to a resource and ends when the contact disconnects from the last resource to which it was connected. Talk duration does not include hold time.</td>
</tr>
<tr>
<td>Avg Wait Duration</td>
<td>Average wait time (in seconds). It begins when the contact enters the system and ends when the contact stops waiting. Wait duration does not include hold time. The time a contact spends on a CTI port prior to getting queued is included in this report.</td>
</tr>
<tr>
<td>Longest Talk Duration</td>
<td>Longest talk duration (in seconds) of a contact. Talk duration does not include hold time.</td>
</tr>
<tr>
<td>Longest Wait Duration</td>
<td>Longest wait (in seconds) for a contact to be connected to a resource. Wait duration does not include hold time.</td>
</tr>
</tbody>
</table>
## Field Information — Preview Outbound

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Active</strong></td>
<td>Total number of preview outbound calls currently previewed or connected to agents.</td>
</tr>
<tr>
<td><strong>Preview</strong></td>
<td>Total number of preview outbound calls currently previewed but have not been accepted, rejected, or closed by the agents.</td>
</tr>
<tr>
<td><strong>Connected</strong></td>
<td>Total number of preview outbound calls currently connected to agents. When an agent conferences in other agents, the call is counted once towards the total number of connected calls.</td>
</tr>
<tr>
<td><strong>Offered</strong></td>
<td>Total number of preview outbound calls offered. A call is considered offered when it is presented to an agent. A contact that is presented to an agent, skipped/rejected by that agent, and then presented to the same agent or to another agent is counted twice towards the number of calls offered. Offered = Accepted + Rejected + Closed + Timed-out.</td>
</tr>
<tr>
<td><strong>Accepted</strong></td>
<td>Total number of preview outbound calls accepted. A call is considered accepted if an agent has clicked Accept when presented the call. A call that is presented to an agent, skipped/rejected by that agent, presented to another agent, and then accepted by that other agent is counted once towards the number of calls accepted.</td>
</tr>
<tr>
<td><strong>Rejected</strong></td>
<td>The number of preview outbound calls that were skipped or rejected by an agent. This means that the agent selected Reject, Skip, or Cancel Reservation. These contacts will be dialed again. If a contact is rejected by multiple agents, this field increments each time the contact is rejected. The number Rejected is also incremented each time an agent drops the preview call while it is ringing at the customer’s contact.</td>
</tr>
<tr>
<td><strong>Closed</strong></td>
<td>The number of preview outbound contacts that were closed by agents. This means that the agent selected Skip-Close or Reject-close. These contacts will not be dialed again.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Timed-Out</td>
<td>Total number of preview outbound calls that timed out. A call is considered timed out when it is presented to an agent and not accepted, rejected, or closed within the allocated time. These contacts will be dialed again. If a contact timed out multiple agents, this field is incremented each time the contact is timed out for each agent.</td>
</tr>
<tr>
<td>Invalid Number</td>
<td>The number of preview outbound calls that were dialed to an invalid number. This means that the agent accepted the call (by clicking Accept), got connected to the customer, and selected the Invalid Number option from the contact Reclassification drop down. It also includes the number of preview outbound calls that failed at the network level.</td>
</tr>
<tr>
<td>Voice</td>
<td>The number of preview outbound calls that ended in successful customer contact. This means that an agent accepted the call (by clicking Accept) and selected a classification of Voice (default) or Do Not Call for this contact.</td>
</tr>
<tr>
<td>Answering Machine</td>
<td>The number of preview outbound calls that connected to an answering machine for this campaign. This means that the agent accepted the call (by clicking Accept), got connected to the answering machine and selected the Answering Machine option from the contact Reclassification drop down.</td>
</tr>
<tr>
<td>Requested Callback</td>
<td>The number of contacts marked for callback. This means that the agent accepted the call (by clicking Accept), got connected to the contact, the contact requested a callback, and the agent selected the CallBack option. A call that is accepted by an agent, marked for callback, later presented to and accepted by another agent (at the callback time), and marked for callback again is counted twice towards the number of callback calls.</td>
</tr>
</tbody>
</table>
### CSQ Cisco Unified Contact Center Express Stats Report

Use the CSQ Cisco Unified Contact Center Express Stats real-time report to view real-time information.

**Note**

Unified CCX reports contain information for calls that have been queued in one or more CSQs. If a call is not queued, the reports do not display data for that call.

To access the CSQ Cisco Unified Contact Center Express Stats report, choose **Reports > CSQ Cisco Unified Contact Center Express Stats** from the Application Reporting menu bar.

The following fields are displayed on the CSQ Cisco Unified Contact Center Express Stats report.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Avg Outbound Talk Duration</td>
<td>The average time in HH:MM:SS (hours, minutes, seconds) that agents spend talking on outbound calls. The durations consider all calls that were Agent Accepted and classified as Voice. If a preview outbound call is transferred or conferenced to a route point, this average outbound talk duration does not include the talk time of agents who handle the call after it came through the route point. Instead, the talk time is included in the inbound talk duration.</td>
</tr>
<tr>
<td>Longest Outbound Talk Duration</td>
<td>The longest talk duration of a preview outbound call in HH:MM:SS (hours, minutes, seconds). The durations consider all calls that were Agent Accepted and classified as Voice.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the CSQ.</td>
</tr>
<tr>
<td>Talking/Ready Resources/Not Ready Resources/Logged-In Resources</td>
<td>Number of resources who are in the talking, ready, and not ready states, and the number of resources logged in for this CSQ. Values for the four items are separated by colons. Values are displayed in the same order that the items appear in the column heading. <strong>Note</strong> This number includes resources in Talking, Work, and Reserved states. If you are logged into the Unified CCX Administration web interface as a Supervisor and opening the Real-Time Reporting plug-in, you will be able see all the logged in agents from all the teams independent of team membership.</td>
</tr>
<tr>
<td>Total Contacts</td>
<td>Number of total contacts since the statistics were last reset for this CSQ.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>---------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Contacts Waiting</td>
<td>Number of contacts waiting to be connected to a resource in this CSQ.</td>
</tr>
<tr>
<td></td>
<td>This column also displays how long the oldest contact has been waiting.</td>
</tr>
<tr>
<td>Contacts [oldest contact in queue]</td>
<td>Duration of longest currently waiting contact.</td>
</tr>
<tr>
<td>Contacts Handled</td>
<td>Number of contacts that have been handled by this CSQ.</td>
</tr>
<tr>
<td>Contacts Abandoned</td>
<td>Number of contacts that have been abandoned by this CSQ.</td>
</tr>
<tr>
<td>Contacts Dequeued</td>
<td>Number of contacts that have been dequeued from this CSQ.</td>
</tr>
<tr>
<td>Avg Talk Duration</td>
<td>Average time (in seconds) agents in this CSQ spent talking to contacts.</td>
</tr>
<tr>
<td>Avg Wait Duration</td>
<td>Average wait time (in seconds). It begins when the call was queued (when you execute the “Select Resource” step) and ends when the call reaches the agent. Wait duration does not include hold time. The time a contact spends on a CTI port prior to getting queued is not included in this wait time.</td>
</tr>
<tr>
<td>Longest Talk Duration</td>
<td>Longest time (in seconds) agents in this CSQ spend talking to contacts.</td>
</tr>
<tr>
<td>Longest Wait Duration</td>
<td>Longest wait (in seconds) for a contact to be connected to a resource.</td>
</tr>
</tbody>
</table>

**Preview Outbound Campaign Cisco Unified Contact Center Express Stats Report**

Use the Preview Outbound Campaign Cisco Unified Contact Center Express Stats real-time report to view real-time Unified Contact CCX information for the Outbound preview dialer.

To access the Preview Outbound Campaign Cisco Unified Contact Center Express Stats report, choose **Reports > Preview Outbound Campaign Cisco Unified Contact Center Express Stats** from the Application Reporting menu bar.

The following fields are displayed on the Preview Outbound Campaign Cisco Unified Contact Center Express Stats report.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Campaign</td>
<td>The name of the preview outbound campaign.</td>
</tr>
</tbody>
</table>
### Field

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Status | The current activation state of the preview outbound campaign:  
• Running: an active preview outbound campaign  
• Stopped: an inactive preview outbound campaign |
<p>| Active | Total number of outbound calls currently previewed by or connected to agents for this preview outbound campaign. Active Calls = Previewed + Connected. |
| Preview | Total number of outbound calls currently previewed but have not been accepted, rejected or closed by the agents as part of this preview outbound campaign. |
| Connected | Total number of outbound calls currently connected to agents for this preview outbound campaign. When an agent conferences in other agents, the call is counted once towards the total number of connected calls. |
| Offered | Total number of outbound calls offered for this preview outbound campaign. A call is considered offered when it is presented to an agent as part of this preview outbound campaign. A contact that is presented to an agent, rejected by that agent, and then presented to the same agent or to another agent is counted twice towards the number of calls offered. Offered = Accepted + Rejected + Closed + Timed-out. |
| Accepted | Total number of outbound calls accepted for this preview outbound campaign. A call is considered accepted if an agent has clicked Accept when presented the call. A call that is presented to an agent, rejected by that agent, presented to another agent, and then accepted by that other agent is counted once towards the number of calls accepted. |
| Rejected | The number of outbound calls that were rejected by an agent as part of this preview outbound campaign. This means that the agent selected Reject or Cancel Reservation. These contacts will be dialed again. If a contact is rejected by multiple agents, this field increments each time the contact is rejected. The number Rejected is also incremented each time an agent drops the preview call while it is ringing at the customer contact. |
| Closed | The number of outbound contacts that were closed by agents as part of this preview outbound campaign. This means that the agent selected Reject-close. These contacts will not be dialed again. |</p>
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Timed-Out</td>
<td>Total number of outbound calls that timed out. A call is considered timed out when it is presented to an agent and not accepted, rejected, or closed within the allocated time. These contacts will be dialed again. If a contact times out for multiple agents, this field is incremented each time the contact is timed out for each agent.</td>
</tr>
<tr>
<td>Invalid Number</td>
<td>The number of outbound calls that were dialed to an invalid number for this preview outbound campaign. This means that the agent accepted the call (by clicking Accept), got connected to the customer, and selected the “Invalid Number” option from the contact Reclassification drop down. It also includes the number of outbound calls that failed at the network level. Note: The agent can manually reclassify the contact as Invalid Number while the customer contact is on the call or when the agent has gone into the Work state after the call.</td>
</tr>
<tr>
<td>Voice</td>
<td>The number of outbound calls that ended in successful customer contact. This means that an agent accepted the call (by clicking Accept) and selected a classification of Voice or Do Not Call for this contact.</td>
</tr>
<tr>
<td>Answering Machine</td>
<td>The number of outbound calls that connected to an answering machine for this preview outbound campaign. This means that the agent accepted the call (by clicking Accept), got connected to the answering machine and selected the Answering Machine option from the contact Reclassification drop down. Note: The agent can manually reclassify the contact as Answering Machine while the customer contact is on the call or when the agent has gone into the Work state after the call.</td>
</tr>
</tbody>
</table>
Chat CSQ Cisco Unified Contact Center Express Stats Report

Use the Chat CSQ Cisco Unified Contact Center Express Stats real-time report to view real-time queue information. This report is available in Cisco Unified CCX Premium license package.

Note

Unified CCX reports contain information for a chat contact that are queued with a specific CSQ. If a contact is not queued, the reports do not display data for that chat contact.

To access the Chat CSQ Cisco Unified Contact Center Express Stats report, choose Reports > Chat CSQ Cisco Unified Contact Center Express Stats from the Application Reporting menu bar.

The following fields are displayed on the Chat CSQ Cisco Unified Contact Center Express Stats report.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the chat CSQ</td>
</tr>
</tbody>
</table>

Cisco Unified Contact Center Express Administration and Operations Guide, Release 12.5(1)
### Chat Resource Cisco Unified Contact Center Express Stats Report

Use the Chat Resource Cisco Unified Contact Center Express Stats real-time report to view real-time Unified CCX chat resource information. This report is available in Cisco Unified CCX Premium license package.

To access the Chat Resource Cisco Unified Contact Center Express Stats report, choose **Reports > Chat Resource Cisco Unified Contact Center Express Stats** from the Application Reporting menu bar.

The following fields are displayed on the Chat Resource Cisco Unified Contact Center Express Stats report:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name (ID)</td>
<td>Unique identifier of the resource.</td>
</tr>
<tr>
<td>State</td>
<td>Current state of the resource.</td>
</tr>
<tr>
<td>Current Active Contacts</td>
<td>Number of active contacts that the agent is handling.</td>
</tr>
<tr>
<td>Duration in State</td>
<td>Length of time (in HH:MM:SS) the resource has remained in the current state.</td>
</tr>
</tbody>
</table>
### Field | Description
--- | ---
**Avg Resource Busy Duration** | Average time the agent spent with contacts. The resource busy duration is the elapsed time between the resource accepting the contact and completing the chat by clicking End.

**Longest Resource Busy Duration** | Longest time the agent spent with a contact. The resource busy duration is the elapsed time between the resource accepting the contact and completing the chat by clicking End.

**Contacts Presented** | Number of contacts that have been presented to this resource.

**Contacts Handled** | Number of contacts that have been handled by this resource.

---

**Overall Chat Cisco Unified Contact Center Express Stats Report**

Use the Overall Chat Cisco Unified Contact Center Express Stats real-time report to view real-time Unified CCX resource and contact information. This report is available in Cisco Unified CCX Premium license package.

---

**Note**

Unified CCX reports contain information for contacts that have been queued in one or more CSQs. If a contact is not queued, the reports do not display data for that contact.

---

To access the Overall Chat Unified CCX Stats report, choose **Reports > Overall Chat Cisco Unified Contact Center Express Stats** from the Application Reporting menu bar.

The following fields are displayed on the Overall Chat Cisco Unified Contact Center Express Stats report.

### Field | Description
--- | ---
**Resource Information**

**CSQs** | Number of chat CSQs currently configured. If a chat CSQ is added or removed, this statistic reflects that change.

**Logged-in Resources** | Number of resources currently logged in.

**Busy Resources** | Number of resources currently busy.

**Ready Resources** | Number of resources currently ready.

**Not Ready Resources** | Number of resources currently not ready.

---

**Contact Information**

**Total Contacts** | Number of total contacts that have arrived since the statistics were last reset. This includes contacts that are waiting, contacts connected to a resource, and contacts that have disconnected.

**Contacts Waiting** | Number of contacts waiting to be connected to a resource.

---

**Note** A contact is shown as waiting until the contact is answered by the agent.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Oldest Contact in Queue</td>
<td>Displays the wait time for the oldest contact in the queue.</td>
</tr>
<tr>
<td>Contacts Handled</td>
<td>Number of contacts that have been handled by a resource.</td>
</tr>
<tr>
<td>Contacts Abandoned</td>
<td>Number of contacts that are routed to the CSQ since midnight but are abandoned due to one of the following:</td>
</tr>
<tr>
<td></td>
<td>• Customer ended the chat as the chat was not answered by an agent.</td>
</tr>
<tr>
<td></td>
<td>• Customer chat was disconnected.</td>
</tr>
<tr>
<td></td>
<td>• No agents were available.</td>
</tr>
<tr>
<td></td>
<td>• All agents were busy.</td>
</tr>
<tr>
<td>Avg Contact Handling Duration</td>
<td>Average duration (in HH:MM:SS) that resources spent chatting on Unified CCX contacts. Chat duration starts when a contact first connects to a resource and ends when the contact disconnects from the resource to which it was connected.</td>
</tr>
<tr>
<td>Avg Wait Duration</td>
<td>Average wait time (in HH:MM:SS). It begins when the contact enters the system and ends when either the contact is connected with an agent or if contact was disconnected.</td>
</tr>
<tr>
<td>Longest Contact Handling Duration</td>
<td>Longest contact handling duration (in HH:MM:SS) of a contact.</td>
</tr>
<tr>
<td>Longest Wait Duration</td>
<td>Longest wait (in HH:MM:SS) for a contact to be connected to a resource.</td>
</tr>
</tbody>
</table>

**Outbound Campaign Stats Report**

If you have an Outbound license, use the Outbound Campaign Stats report to view real-time statistics on each IVR-based and agent-based progressive and predictive Outbound campaign configured in Unified CCX. This report will be available only if you have an Outbound license on top of Unified CCX premium license in your Unified CCX.

To access the Outbound Campaign Stats report, choose **Reports > Outbound Campaign Stats** from the Application Reporting menu bar. The following fields are displayed on the Outbound Campaign Stats report.

---

**Note**

The call related fields display the data from the time the statistics were last reset.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Campaign Name</td>
<td>The name of the IVR-based or agent-based progressive or predictive campaign.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------</td>
<td>------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Status</td>
<td>The current activation state of the campaign:</td>
</tr>
<tr>
<td></td>
<td>• Running: an active IVR-based or agent-based progressive or predictive campaign.</td>
</tr>
<tr>
<td></td>
<td>• Stopped: an inactive IVR-based or agent-based progressive or predictive campaign.</td>
</tr>
<tr>
<td>Campaign Type</td>
<td>The dialer type of the campaign, which can be one of the following:</td>
</tr>
<tr>
<td></td>
<td>• IVR Progressive</td>
</tr>
<tr>
<td></td>
<td>• IVR Predictive</td>
</tr>
<tr>
<td></td>
<td>• Agent Progressive</td>
</tr>
<tr>
<td></td>
<td>• Agent Predictive</td>
</tr>
<tr>
<td>Attempted</td>
<td>The total number of attempted calls.</td>
</tr>
<tr>
<td></td>
<td>If there are no customer abandoned calls, then Attempted will be equal to sum of the following</td>
</tr>
<tr>
<td></td>
<td>counters:</td>
</tr>
<tr>
<td></td>
<td>Voice + Answering Machine + Invalid Number + Fax/Modem + No Answer + Busy + Failed.</td>
</tr>
<tr>
<td>Voice</td>
<td>The total number of calls that are connected to live voice.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong> The call will be marked as System Abandoned after it has been marked as Voice and Active</td>
</tr>
<tr>
<td></td>
<td>due to any of the following reasons:</td>
</tr>
<tr>
<td></td>
<td>• Whenever there is an exception while executing some steps in an IVR script in case of IVR-</td>
</tr>
<tr>
<td></td>
<td>based campaigns. For example, if there is any codec mismatch issue, there will be an exception</td>
</tr>
<tr>
<td></td>
<td>in the Accept Step. In such cases, the same call will be marked in the following three</td>
</tr>
<tr>
<td></td>
<td>categories voice, active, and system abandoned.</td>
</tr>
<tr>
<td></td>
<td>• Whenever the call that is ringing on the agent's phone fails in case of agent-based</td>
</tr>
<tr>
<td></td>
<td>campaigns.</td>
</tr>
<tr>
<td>Answering Machine</td>
<td>The total number of calls that reached an answering machine.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Invalid Number</td>
<td>The total number of calls that reached an invalid number:</td>
</tr>
<tr>
<td></td>
<td>• A failed call when the gateway returns an invalid or not found error.</td>
</tr>
<tr>
<td>Fax/Modem</td>
<td>The total number of calls that reached fax or modem.</td>
</tr>
<tr>
<td>No Answer</td>
<td>The total number of calls that were not answered within the time configured for the No Answer Ring Limit field in the Add New Campaign web page.</td>
</tr>
<tr>
<td>Busy</td>
<td>The total number of calls that reached a busy destination.</td>
</tr>
<tr>
<td>Failed</td>
<td>The total number of calls that failed due to any one of the following reasons:</td>
</tr>
<tr>
<td></td>
<td>• Dialer asked the Gateway to cancel a call that was dialed out, but not connected.</td>
</tr>
<tr>
<td></td>
<td>• Gateway has declined the call.</td>
</tr>
<tr>
<td></td>
<td>• Gateway failure or configuration issues at the Gateway.</td>
</tr>
<tr>
<td></td>
<td>• Gateway is down.</td>
</tr>
<tr>
<td>Active</td>
<td>The total number of calls that were connected to IVR ports or agents.</td>
</tr>
<tr>
<td></td>
<td>All the voice calls that will be connected to Outbound IVR ports or agents will be marked as active. If you have selected Answering Machine Treatment or Abandoned Call Treatment as &quot;Transfer to IVR,&quot; the answering machine calls and abandoned calls that are getting transferred to Outbound IVR ports will also be marked as active.</td>
</tr>
<tr>
<td>Customer Abandoned</td>
<td>The total number of calls that were disconnected by the customer or agent within the Abandoned Call Wait Time configured in Add New Campaign web page.</td>
</tr>
<tr>
<td>System Abandoned</td>
<td>The total number of calls that were abandoned due to any of the following reasons:</td>
</tr>
<tr>
<td></td>
<td>• Non-availability of ports or agents.</td>
</tr>
<tr>
<td></td>
<td>• Any issues at system level.</td>
</tr>
<tr>
<td>Abandon Rate (in %)</td>
<td>Abandon Rate = (System Abandoned/Voice)*100</td>
</tr>
</tbody>
</table>
• If you have selected Answering Machine Treatment as "End Call" for an IVR or agent based outbound campaign through Campaign Configuration web page, then Voice = Active + System Abandoned.

• If you have selected Answering Machine Treatment or Abandoned Call Treatment as "Transfer to IVR" for an IVR or agent based outbound campaign through Campaign Configuration web page, then Voice + Answering Machine = Active + System Abandoned.

**Overall Outbound Stats Report**

If you have an Outbound license, you can use the Overall Outbound Stats report to view real-time statistics across all IVR-based and agent-based progressive and predictive campaigns since the statistics were last reset. This report will be available only if you have an Outbound license on top of Unified CCX premium license in your Unified CCX.

To access the Overall Outbound Stats report, choose Reports > Overall Outbound Stats from the Application Reporting menu bar. The following fields are displayed on the Overall Outbound Stats report for all the configured IVR-based and agent-based Outbound campaigns.

**Note**
The call related fields display the data from the time the statistics were last reset.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Attempted</td>
<td>The total number of attempted Outbound calls.</td>
</tr>
<tr>
<td>Voice</td>
<td>The total number of Outbound calls that were connected to live voice.</td>
</tr>
<tr>
<td>Answering Machine</td>
<td>The total number of Outbound calls that reached answering machine.</td>
</tr>
<tr>
<td>Invalid Number</td>
<td>The total number of Outbound calls that reached an invalid number.</td>
</tr>
<tr>
<td>Fax/Modem</td>
<td>The total number of Outbound calls that reached fax or modem.</td>
</tr>
<tr>
<td>No Answer</td>
<td>The total number of Outbound calls that were not answered.</td>
</tr>
<tr>
<td>Busy</td>
<td>The total number of Outbound calls that reached a busy destination.</td>
</tr>
<tr>
<td>Failed</td>
<td>The total number of failed Outbound calls for all IVR and agent based Outbound campaigns.</td>
</tr>
<tr>
<td>Active</td>
<td>The total number of Outbound calls that were connected to Outbound IVR ports or agents.</td>
</tr>
</tbody>
</table>
### Resource Cisco Unified Contact Center Express Stats Report

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Customer Abandoned</td>
<td>The total number of Outbound calls that were abandoned by the customer or disconnected by the agent.</td>
</tr>
<tr>
<td>System Abandoned</td>
<td>The total number of Outbound calls that were abandoned by the system.</td>
</tr>
</tbody>
</table>

#### Resource Cisco Unified Contact Center Express Stats Report

Use the Resource Cisco Unified Contact Center Express Stats real-time report to view real-time Unified Contact CCX agent information.

To access the Resource Cisco Unified Contact Center Express Stats report, choose **Reports > Resource Cisco Unified Contact Center Express Stats** from the Application Reporting menu bar.

#### Note

If multiple lines are configured for an agent, only the calls on the agent's primary extension are reported in Resource Cisco Unified Contact Center Express Stats report.

The following fields are displayed on the Resource Cisco Unified Contact Center Express Stats report.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name (ID)</td>
<td>Unique identifier of the agent.</td>
</tr>
<tr>
<td>State</td>
<td>Current state of the agent.</td>
</tr>
<tr>
<td>Duration in State</td>
<td>Amount of time (in seconds) the agent has remained in the current state.</td>
</tr>
<tr>
<td>Contacts Presented</td>
<td>Number of contacts presented to the agent.</td>
</tr>
<tr>
<td>Contacts Handled</td>
<td>Number of contacts handled by the agent.</td>
</tr>
<tr>
<td>Avg Talk Duration</td>
<td>Average time (in seconds) the agent spent in talking state.</td>
</tr>
<tr>
<td>Avg Hold Duration</td>
<td>Average time (in seconds) the agent keeps calls on hold.</td>
</tr>
<tr>
<td>Longest Talk Duration</td>
<td>Longest time (in seconds) the agent spent in talking state.</td>
</tr>
<tr>
<td>Longest Hold Duration</td>
<td>Longest time (in seconds) the agent keeps a call on hold.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Outbound Offered</td>
<td>Total number of preview outbound calls offered to the agent. A call is considered offered when it is presented to an agent. The number of calls offered is counted twice if a contact that is presented to an agent is skipped/rejected by that agent and then the contact is presented to the same agent or to another agent. Offered = Accepted + Rejected + Closed + Timed-out.</td>
</tr>
<tr>
<td>Outbound Accepted</td>
<td>Total number of outbound calls accepted by the agent. For transferred or conferenced outbound calls, the call is considered accepted if it is answered by the agent. A preview outbound call is considered accepted if an agent has clicked Accept to accept the call and then the system places the call to the customer. The number of calls accepted is counted once if a call that is presented to an agent is skipped/rejected by that agent and then the call is presented to another agent who accepts the call. A progressive or predictive outbound call is considered accepted if an agent has answered a live voice call that is presented to the agent (if Agent AutoAnswer is disabled).</td>
</tr>
<tr>
<td>Outbound Rejected</td>
<td>The number of preview outbound calls skipped/rejected by the agent. This means that the agent selected Reject, Skip, or Cancel Reservation. These contacts will be dialed again. The number of calls rejected is also incremented each time an agent drops the preview call while it is ringing at the customer’s contact.</td>
</tr>
<tr>
<td>Outbound Closed</td>
<td>The number of contacts closed by the agent for preview outbound. This means that the agent selected Skip-Close or Reject-close. These contacts will not be dialed again.</td>
</tr>
<tr>
<td>Outbound Timed-Out</td>
<td>Total number of preview outbound calls that timed out. A call is considered timed out when the call is presented to an agent but not accepted, rejected, or closed within the allocated time. These contacts will be dialed again. If a contact timed out for multiple agents, this field is incremented each time the contact is timed out for each agent.</td>
</tr>
<tr>
<td>Outbound Voice</td>
<td>The number of preview outbound calls that ended in successful customer contact for the agent. This means that the agent accepted the call (by clicking Accept) and selected a classification of Voice or Do Not Call for this contact.</td>
</tr>
</tbody>
</table>
### Failover Behavior for Unified CCX Stats

All failovers, regardless of whether the Unified CCX Engine is restarted, will cause the Unified CCX stats to reset.

The Unified IP IVR stats do not reset in all cases if the Unified CCX Engine is not restarted on a node. However, the node loses its active server status. The Unified IP IVR stats on that node will not be reset.

### Tools Menu

The Tools menu gives you access to the following Application Reporting tools:

- **Reset All Stats**—Choose this option to reset all statistics.
- **Open Printable Report**—Choose this option to get a printable report of all currently active contacts in the system.
- **Refresh Connections**—Choose this option to refresh connections with the Unified CCX system.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Outbound Avg Talk Duration</td>
<td>The average time in HH:MM:SS (hours, minutes, seconds) that the agent spends in talking state for outbound calls. This talk duration also includes the time spent on outbound calls that were transferred or conferenced to a route point. For preview outbound, the talk duration considers all calls that were Agent Accepted and classified as Voice.</td>
</tr>
<tr>
<td>Outbound Avg Hold Duration</td>
<td>The average time in HH:MM:SS (hours, minutes, seconds) that the agent spent in holding an outbound call. For preview outbound, the hold duration considers all calls that were Agent Accepted and classified as Voice.</td>
</tr>
<tr>
<td>Outbound Longest Talk Duration</td>
<td>The longest time in HH:MM:SS (hours, minutes, seconds) that the agent spent in talking state for an outbound call. For preview outbound, the talk duration considers all calls that were Agent Accepted and classified as Voice.</td>
</tr>
<tr>
<td>Outbound Longest Hold Duration</td>
<td>The longest time in HH:MM:SS (hours, minutes, seconds) that the agent spent in holding an outbound call. For preview outbound, the hold duration considers all calls that were Agent Accepted and classified as Voice.</td>
</tr>
</tbody>
</table>
- **Clear Contact**—Choose this option to clear contacts/calls that have been stuck in the system for a long time.

**Reset All Statistics**

Use the Reset All Stats option to reset all statistics accumulated since the last time the statistics were reset. It will not reset active statistics, such as active contacts, tasks, and so on.

---

**Note**

The Unified CCX system automatically resets all statistics each day at midnight.

**Procedure**

Choose **Tools > Reset All Statistics** from the Application Reporting menu bar.

---

**Open Printable Report**

Use the option to get a printable report of all currently active contacts in the system.

To get a printable report:

**Procedure**

Choose a real-time report from the Report menu option and then **Tools > Open Printable Report** from the Application Reporting menu bar.

---

**Refresh Connections**

To refresh connections with the Unified CCX system:

**Procedure**

Choose **Tools > Refresh Connections** from the Application Reporting menu bar.

The Unified CCX system refreshes all connections.

---

**Clear Contact Menu**

You can use the Clear Contact menu option to clear contacts in the following three situations:

- **Clear Stuck Calls from Sontacts Real-Time Report**

  To clear stuck calls or contacts from the Unified CCX system:
Clear Stuck Calls from Overall Cisco Unified CCX Stats

To clear stuck calls/contacts from the Unified CCX system:

Procedure

Step 1 Choose Reports > Overall Cisco Unified Contact Center Express Stats.
Step 2 Choose the contact from Views and click Overall Waiting Contacts Info.
Note Please note that the Overall Waiting Contacts Info menu option displays only those calls that are queued in CSQs and not agent-based routing calls.
Step 3 From the Application Reporting menu bar, choose Tools and click Clear Contact. A Clear Call dialog box is displayed to warn you. If you want to continue with the clear action, click No. To cancel the action, click Yes.
Step 4 Click No to proceed with the clear action. A Clear Contact dialog box is displayed for you to confirm the action. You can click Yes to proceed or No to cancel.
Step 5 Click Yes. The Unified CCX system removes the contact from all its queues.

Clear Stuck Calls from CSQ Cisco Unified CCX Stats

To clear stuck calls or contacts from the Unified CCX system:

Procedure

Step 1 Choose Reports > CSQ Cisco Unified Contact Center Express Stats.
Step 2 Choose the contact from Views and click CSQ Waiting Contacts Info.
Step 3 From the Application Reporting menu bar, choose Tools > Clear Contact. A Clear Call dialog box is displayed to warn you. If you want to continue with the clear action, click No. To cancel the action, click Yes.
Step 4 Click No to proceed with the clear action. A Clear Contact dialog box is displayed for you to confirm the action. You can click Yes to proceed or No to cancel.
Step 5 Click Yes. The Unified CCX system removes the contact from all its queues.
Views Menu

The Views menu allows you to access more detailed information for the following reports: The Application Tasks report, the Contacts report, the Applications report, the Sessions report, Overall Cisco Unified Contact Center Express Stats report, and the CSQ Cisco Unified Contact Center Express Stats report.

For some reports, detailed information is also available by right-clicking a record in that report.

The Views menu contains different options, depending on the report you have chosen. Possible options are:

- **Contacts by Application Task ID**—Choose this option to view contacts according to Application Task ID numbers.

- **Engine Tasks by Application Task ID**—Choose this option to view Engine tasks according to Application Task ID numbers.

- **Detailed Info**—Choose this option to view more detailed information on selected reports.

- **Application Tasks by Application Name**—Choose this option to view application tasks by application name.

- **Contacts by Session ID**—Choose this option to view contacts by session ID.

- **Overall Waiting Contacts Info**—Choose this option to view detailed information for the overall waiting contacts. To clear stuck calls in this view, see Scenario 2 in Clear contact menu option.

- **CSQ Waiting Contacts Info**—Choose this option to view detailed information for the CSQ waiting contacts. To clear stuck calls in this view, see Scenario 3 in Clear contact menu option.

**Application Tasks**

You can obtain reports based on the application task ID associated with application tasks.

**Contacts by Application Task ID**

This report displays the same report as the Contact report with the exception that the Contacts by Application Task ID report has been filtered using only the contact currently being managed by the selected application task.

**Engine Tasks by Application Task ID**

This report displays the same report as the Engine Task reports except that the Engine Tasks by Application Task ID report has been filtered to display only the engine tasks that are associated with the application task.

**Contacts**

When you use the Views options with the Contacts report, the Views menu contains only the Detailed Info option.

The Detailed Info option provides various detailed information, depending on the type of contact selected. For example, if the contact is a call, the Calling Party number, the Called Number, and so on, are displayed for that particular call.
Applications

When you use the Views options with the Application reports, the Views menu contains only the Application Tasks by Application Name option.

The Application Task By Application Name report displays the same report as the Application Task report except that the Application Task By Application Name report is filtered using only the active application tasks associated with this application.

Sessions

You can obtain reports based on the session ID associated with a session.

Contacts by Session ID

This report displays the same report as the Contact report with the exception that the Contacts By Session ID report is filtered using only the contacts associated with the selected session.

Detailed Info

Detailed info displays the time the session was created and its current state.

Settings Menu

The Settings menu of the Application Reporting menu bar allows you to adjust various settings of the Real Time Reporting tool.

The Settings menu contains the following menu options:

- **Options**—Choose this option to set the polling (refresh) interval times and to set the amount of times the server will attempt to reconnect.

- **Window**—Choose this option to display reports in colors based on your Windows settings.

- **Motif**—Choose this option to display reports in purple and menu items in brown.

- **Metal**—Choose this option to display reports in grey and menu items in black.

Options Menu

Choose **Settings** and click **Options** to access the Options dialog box. Use the Options dialog box to set the polling (refresh) interval time, set the number of times the server will attempt to reconnect, and specify whether logged off agents appear in reports.

The following fields appear in the Options dialog box.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Polling Interval</td>
<td>Time between two requests to the server for new statistics by the client.</td>
</tr>
<tr>
<td>Server Connect Retry Count</td>
<td>The number of times that the Unified CCX Administration web interface should attempt to reconnect to the Unified CCX server.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong> If an error occurs, an Error dialog box opens to alert you that the server is not communicating with the web interface.</td>
</tr>
</tbody>
</table>
Specifies whether logged off agents appear in reports.

Click **Apply** to submit configuration changes.

### Reporting Administration on Unified Intelligence Center

Unified Intelligence Center is the default reporting solution for Unified CCX. Unified Intelligence Center is a comprehensive, end-to-end reporting solution.

**Note**

Do not access Unified Intelligence Center until you complete the post installation tasks for Unified CCX.

Live Data reports can only be run by agents, supervisors, and reporting users.

**Note**

The maximum number of users who can concurrently run Live Data reports is 42.

For more information, see the following guides:


**Note**

Historical Reporting Client (HRC) is not available from 10.0(1).

### Cisco Finesse

You can configure the Live Data reports that are to be displayed in the gadgets of the Cisco Finesse desktops.

### Start Unified Intelligence Center

**Procedure**

1. **Step 1**
   
   Open a web browser.

2. **Step 2**
   
   Access [http://<host address>](http://<host address>) and click **Cisco Unified Contact Center Express Reporting**.

   **Note**

   Host address is the DNS name or IP address of the Unified CCX node.

3. **Step 3**
   
   Enter your username and password.
Administrator Overview

Access to the functions in the Unified Intelligence Center reporting application is controlled by the one or more users who have the user role of Security Administrator.

The initial, default Security Administrator is the user defined as the System Application User during the installation.

Security Administrators can:

- Create and maintain users.
- Assign User Roles—User roles are assigned to users to control access to drawers and what objects the user can create.
- Assign users to User Groups.
- Create and maintain user groups.
- Assign Permissions—Whereas User Roles are associated with people, permissions are associated with objects (Dashboards, Reports, Report Definitions, Data Sources, Value Lists, and Collections).
- Use the Run As feature to verify other users' permissions.

Security Overview

Unified Intelligence Center security offers multi-layered and flexible functionality that allows a security administrator to create a flat or a tiered structure of access to Unified Intelligence Center functions, based on the organization's needs.

A user's access to Unified Intelligence Center functions is based on:

- Login authentication.
- License type under which the user's organization runs Unified Intelligence Center. For example, organizations that use a Standard license cannot access the Report Definition functions.
- User Role (a user can have one, some, or all seven User Roles).
- User Groups in which user is a member.
- For an object the user can access, the object-level permissions assigned by the person who created that object.
## User List

User List page opens from the Security drawer. If a user who does not have the Security Administrator user role accesses this page, that user can see all the parameters except the user roles. The user cannot change his role or group membership.

When Security Administrators access this page, they can see all existing users; can create users, modify or delete users, review or edit user information, and use the **Run As** feature to work in Cisco Unified Intelligence Center as a user.

### Table 9: Fields on User List Page

<table>
<thead>
<tr>
<th>Field</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Only show currently active users</td>
<td>Check the check box to display users who are currently active.</td>
</tr>
<tr>
<td>Name Contains</td>
<td>Use this filter field to narrow the list of names or to move to a specific name.</td>
</tr>
<tr>
<td>User Name</td>
<td>The domain and user name (domain\username).</td>
</tr>
<tr>
<td>First Name</td>
<td>The user's first name.</td>
</tr>
<tr>
<td>Last Name</td>
<td>The user's last name.</td>
</tr>
</tbody>
</table>

You can perform the following actions on the user lists page:

- **Create**—Opens the User Information page.
- **Edit**—Select a user name and click **Edit** to edit the User Information page.
- **Delete**—Select a user and click **Delete** to delete the user.
- **Run As**—Select a user and click **Run As** to refresh the Cisco Unified Intelligence Center reporting interface.
- **Refresh**—Refreshes the page to show any latest changes to the User List.
- **Page**—Click the arrow to move to the next page of the User List.
- **Help**—Opens online help.
- **X**—Closes the page.

## Create a User

To create a user, perform the following procedure:

### Procedure

#### Step 1
Navigate to **Security > User List.**
### Step 2

Under the General Information tab, perform the following:

a) In the **User Name** field, enter the domain and user name (domain\name).
b) In the **Alias** field, enter the alias name for this user.
c) Check the **User is active** check box to enable the user to log in and remain active.
   
   **Note** If the check box is unchecked, the user cannot log in.
d) In the **First Name** field, enter the first name of the user.
e) In the **Last Name** field, enter the last name.
f) In the **Organization** field, enter the company name or other descriptive text to be associated with the user, such as region or Line of Business.
g) In the **Email** field, enter the email address of the user.
h) In the **Phone** field, enter a phone number for the user. This can be the user's personal phone number or an emergency contact.
i) In the **Description** field, enter the description of the user.
j) In the **Time Zone** field, choose the time zone that you want to use in the report from the drop-down list. This time zone is also used for the user's scheduled reports and takes precedence over the time zone used by the report server.
   
   **Note** If this field is left blank, the system uses the time zone of the report server.

k) For **Start Day of the Week**, perform the following:

   - Select **Locale Based** to select starting day of the week based on locale.
   - Select **Custom Settings** to choose one of the seven days of the week from the drop-down list.

   **Note** Start Day Of The Week is used in Scheduled Report, Report Views, and Permalink.

l) In the **Roles** field, select and assign one or more roles for this user.

   If the Security Administrator adds or changes User Roles, the change does not take effect until the user logs out and then logs in again.

m) In the **Permissions** field, choose the user's permission setting preference for My Group when creating new objects. My Group is the object owner's default group.

   **Note** Settings for My Group configures whether other users who belong to this user's default group can write, or execute the objects. Higher level permissions persist and override other permissions.

### Step 3

Under the Groups tab, you can determine which groups this user is a member of and how to add group membership(s) for a user. You can view the following:

- **My Group**: This field shows the user's default group. The Security Administrator can change it. The group is represented as “My Group” for the user.

- **Available Groups**: This list shows all the groups that have been created and that the user is not yet a member of. You can use arrows to move groups between columns.

- **Selected Groups**: This column shows all the groups that the user is a member of. You can use arrows to move groups between columns.
By default, every user has AllUsers in their Selected Groups column. You cannot remove the AllUsers group from the Selected Groups column.

**User Groups**

User Groups page opens from the Security drawer. Use it to see the existing groups, to create or delete groups, and to review or edit group information.

The following are the two default groups created by the system:

- The **AllUsers** group is supplied by Unified Intelligence Center. All users belong to this group by default.
- The **Administrators** group consists of administrators.

**Table 10: Fields on the User Groups Page**

<table>
<thead>
<tr>
<th>Field</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name Contains</td>
<td>Use this filter field to narrow down the list of group names or to move to a specific name.</td>
</tr>
<tr>
<td>Name</td>
<td>Name of the group.</td>
</tr>
<tr>
<td>Full Name</td>
<td>The full name shows the child relationship of a group, as indicated by a dot separator. For example, if the default group for Group3 is Group1, and Group1 is a top level group (does not have a parent), then the Full Name of Group1 is <strong>Group1</strong>. The Full Name of Group 3 is <strong>Group1.Group3</strong>.</td>
</tr>
<tr>
<td>Description</td>
<td>Description text of the group.</td>
</tr>
</tbody>
</table>

You can perform the following actions on the User Groups page:

- **Create**—Opens the Group Information page.
- **Edit**—Select the group name and click Edit to open the Group Information page.
- **Delete**—Select the group name and click Delete.
- **Refresh**—Refreshes the page to show any changes to the Group List.
- **Help**—Opens online help.
- **X**—Closes the page.

**Overview**

User Groups are constructs that allow security administrators to partition Unified Intelligence Center functionality.
Creating User Groups expedites the process of provisioning users when multiple users need the same access to dashboards and reports, or when users require distinct permissions and features based on regional or organizational requirements.

User groups have no impact on how data is stored in the database. They are used only for assigning permissions to all the user members of the group through one operation instead of repeating the same operation for each user.

**System-Defined All Users Group**

All users are automatically a member of the system-defined *All Users* group.

*All Users* always appears on the User Groups window. The security administrator cannot delete it.

**System-Defined Administrator User Group**

The security administrator is automatically a member of the system-defined Administrators group and can add other security administrators to it.

Additional Security Administrators must be added to the Administrators group. Having the role does not automatically make them members of that group.

**Customer-Defined User Groups**

Security administrators can create any number of user groups and can add users to them. From those other user groups, one is designated as the user's *Group* (also called *My Group*).

### Create a User Group

To create a user group, perform the following:

**Procedure**

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Step 1</strong></td>
<td>Navigate to <strong>Security &gt; User Groups</strong>.</td>
</tr>
<tr>
<td><strong>Step 2</strong></td>
<td>Under the General Information tab, perform the following:</td>
</tr>
<tr>
<td></td>
<td>a) In the <strong>Group Name</strong> field, enter the name of the group. This field is available only when you create a new group.</td>
</tr>
<tr>
<td></td>
<td>b) In the <strong>Description</strong> field, enter or modify text to describe this group</td>
</tr>
<tr>
<td><strong>Step 3</strong></td>
<td>Under the Groups tab, perform the following:</td>
</tr>
<tr>
<td></td>
<td>a) <strong>Default Group</strong>—From the drop-down list, enter the default group.</td>
</tr>
<tr>
<td></td>
<td>b) <strong>Available Groups</strong>—Lists the groups that were created and that are available for this group to become a child of. Click &gt; or &lt; to move just that group or groups.</td>
</tr>
<tr>
<td></td>
<td>c) <strong>Selected Groups</strong>—Lists the groups that this group is a child of. Click &gt; or &lt; to move just that group or groups.</td>
</tr>
<tr>
<td><strong>Step 4</strong></td>
<td>Under the Groups Members tab, perform the following:</td>
</tr>
<tr>
<td></td>
<td>a) Under <strong>Users</strong> tab:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Available Users</strong>—Lists all the users that were created and that are available to be children of this group. Click &gt; or &lt; to move just that group or groups.</td>
</tr>
</tbody>
</table>
• **Selected User Members**—Lists the users that are currently children of this group. Click > or < to move just that group or groups.

b) Under **Groups** tab:

• **Available Groups**—Lists all the groups that were created and that are available to be children of this group. Click > or < to move just that group or groups.

• **Selected Groups Members**—Lists the groups that are currently children of this group. Click > or < to move just that group or groups.

**Step 5** Click **Save** to update new entry or changes to the fields.

**Step 6** Click **Cancel** to cancel or close the page.

---

**Manage User Permissions**

Use this page to set extra permissions to Groups or to individual users.

User permissions page has the following tabs:

---

**About Permissions**

User Roles are associated with people and permissions are associated with objects. Unified Intelligence Center objects are Dashboards, Reports, Report Definitions, Data Sources, Categories, Value Lists, and Collections.

Permissions:

• **EXECUTE**: When the user has EXECUTE permissions for an object, that user can perform some actions that depend on the object.

  For example, with EXECUTE permission, a user can run, print, and refresh a report, open and refresh a dashboard and run a dashboard slide show, and see a Value List query. EXECUTE permission includes the read permission.

  __Note__ Permissions set on categories are not recursive. For all entities under Dashboard, Report, or Report Definition types, you need separate EXECUTE/WRITE permissions.

• **WRITE**: When the user has WRITE permission for an object, that user can alter, rename or delete the object. For example, With WRITE permission, you Save As, import, and export reports; you can edit a data source and can delete a custom Value List. WRITE permission also includes EXECUTE and read permission.

  __Note__ If no check boxes are selected when setting permission for an object, the user has no access privileges to the object.
The following rules are applicable for all category trees in Unified Intelligence Center — Reports, Report Definitions, Dashboards.

- To delete an entity, you need WRITE permissions for the entity and the entity's parent category.
- To delete a category, you need WRITE permissions for the category, the category's parent, and all the categories and/or entities belonging to the category.
- A user can only Edit or Save an entity even if the immediate parent category has no WRITE permissions.
- A user can only use the Save As feature if the entity has no WRITE permissions enabled.
- Any category owner within the Imported Report Definitions can delete a category if the administrator provides explicit WRITE permissions on the Imported Report Definitions category.

Permissions are combined and the highest level prevails.

A user receives permission for an object from different sources. Permission can be inherited from the AllUsers group, the Default Group (My Group), or the permission assigned by the Security Administrator. Among all these permissions, the highest level permission is used when the user accesses the object.

**User Roles and Permissions**

Your User Role allows you to “open” the drawer that corresponds to that role. If you have EXECUTE permission, you can create objects for that drawer. For example, if you are a Dashboard Designer, you can create dashboards on the Available Dashboards page.

When you create an object, you are the owner of that object. You have WRITE permission for the object, and you can set the permissions for that object for users in your Group only.

If the object is still a work-in-progress and you do not want anyone to access it yet, you can make it “private” by leaving all permissions unchecked for both the All Users and the Groups.

When the object is ready, set your default Group (My Group) permissions to EXECUTE or even WRITE. For example, if you create a Dashboard for your Group and the dashboard has notes, you might want others in your Group to update the notes.

Even though you are a Dashboard Designer, if the Available Dashboards page contains dashboards created by (owned by) other Dashboard Designers, you may not be able to see those dashboards, based on your Group permissions and on the object-level permissions those owners have set for their dashboards.

**Assigned Group Permissions**

**Procedure**

- **Step 1** Select the object type in the Permissions For panel. For Dashboard, Report or Report Definition type, you can select a category or an object within a category. For other object types, select an object from the list. All the groups that have already been assigned permissions for the object are displayed in the Group permissions for the selected item panel.
- **Step 2** Select a group in the All Groups panel. All user members of this group are displayed in the All Users for the selected group panel.
- **Step 3** Click Set Permissions. Check the level you want for the group (Execute, Write), and click OK.
Step 4  

The **Group Permissions for the selected item** panel updates to include the group and its assigned permission you defined in **Step 3**.

---

**Note**

If the Security Administrator adds or changes User Permissions, the change may not occur immediately.

---

**Table 11: Fields on the Group Members Tab**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Permissions For panel (top left)</td>
<td>Click the drop-down list to select the objects for which you want to set permissions. Options are: Data Sources, Report Definitions, Reports, Dashboards, Value Lists, and Collections. Selecting an object type refreshes the panel to show the list of items or categories for that object.</td>
</tr>
<tr>
<td>All Groups panel (top right)</td>
<td>This panel shows the available User Groups. Highlighting a user group refreshes the page to display an All Users for Selected Group panel that lists the member of the group.</td>
</tr>
<tr>
<td>All Users for the Selected Group panel (bottom right)</td>
<td>This panel shows all members in the group that is highlighted in the All Groups panel above.</td>
</tr>
<tr>
<td>Set Permissions button</td>
<td>Click this option to open a dialog box where you select the permission level for the selected object in the Permissions For panel and the selected group in the All Groups panel.</td>
</tr>
<tr>
<td>Group Permissions for the selected item</td>
<td>This panel shows the groups that have already been assigned permission for the selected object, and their permission level.</td>
</tr>
</tbody>
</table>

**Assigned User Permissions**

**Procedure**

**Step 1** Select the object type in the Permissions For panel. For Dashboard, Report, or Report Definition type, you can select a category or an object within a category. For other object types, select an object from the list. All the users that have already been assigned permission for the object are displayed in the User permissions for the selected item panel.

**Step 2** Select a user name in the User List panel.

**Step 3** Click **Show Groups** to see the groups for which this user is a member.

**Step 4** Click **Set Permissions**, check the level you want for this user (Execute, Write), and click **OK**.

The **All Permissions for the selected item** panel refreshes to show the user permissions you have added or changed for this user in steps 3 and 4.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Permissions For panel (top left)</td>
<td>Click the drop-down arrow to select the kinds of object for which you want to set permissions. Options are Data Sources, Report Definitions, Reports, Dashboards, Value Lists, Collections, and System Collections. Selecting an object type refreshes the panel to show the list of items or categories for that object.</td>
</tr>
<tr>
<td>User List panel (top right)</td>
<td>This panel shows current users. Filter the list and select one or many user names.</td>
</tr>
<tr>
<td>Show Groups button</td>
<td>Click this option to show the All Groups for the selected user panel.</td>
</tr>
<tr>
<td>All Groups for the selected User (bottom right)</td>
<td>This panel shows all groups to which the highlighted username in the User List panel above is a member.</td>
</tr>
<tr>
<td>Set Permissions button</td>
<td>Click this option to open a dialog box where you select the permission level for the object (Execute, Write).</td>
</tr>
<tr>
<td>All Permissions for the selected item</td>
<td>This panel shows users who have permission for the object, and the level of permissions they have.</td>
</tr>
</tbody>
</table>

**Note**  
You cannot change the permission for the owner of an object. The owner always has Write permission for the object. For example, if a user is the owner of Report 1, then that user has WRITE permission for Report 1, and no one else can change the permission to EXECUTE.

---

**Run As**

Security Administrators can select a name on the User List page and click **Run As**. This refreshes the Unified Intelligence Center web page so that it reflects the interface that user has when logged in.

Use this tool to verify that the User Roles and permissions are configured properly.

**Note**  
- When you Run As another user, the top of the page shows both your Logged In identity and your Run As identity.
- You cannot Run As yourself.
- You can Run As one level of user. A Security Admin cannot Run As User A and, as User A, then Run As User B.

To leave Run As mode, click **Stop Run As** at the top of the page.
Audit Trail Logging in Cisco Unified Intelligence Center

Unified Intelligence Center now supports Audit Trail Logging. This feature allows you to view the sequence of audit records of the transactions related to create, update, modify, and delete that are performed on the entities of a Unified Intelligence Center server. You can view the audit trails using the Audit Trail stock report. Only System Administrators can access and view this feature by default. However, a System Administrator can then give permissions to other Unified Intelligence Center users to use this feature.

Note
Localization of Audit Trail report is not supported.

View Audit Trail Logging in Unified Intelligence Center

Procedure

Step 1
Log in to the Unified Intelligence Center Reporting Interface.

Step 2
Navigate to Reports > Stock > Intelligence Center Admin and click Audit Trail. The system opens the Audit Trail Report Filter window.

Step 3
Specify the required filter criteria and click Run. The system displays the Audit Trail report based on the filter criteria that you specified.

Audit Trail Report

Location: Reports > Stock > Intelligence Center Admin > Audit Trail.

Views: This report has three grid views - Non-grouped, Groupby – EntityName, Groupby – Username.

Grouping: This report has two grouped views - grouped and sorted by User and Entity Name. The third view is un-grouped which is also the default view for this report.

Value List: CUIC Users, CUIC Operations, CUIC Entity Types.

Database Schema Tables from which data is retrieved:
- CUICAUDITLOG
- CUICLOGENTITY

Security Considerations

If you make the user a member of one or more other groups, make one of those groups the user's default group, and set the permissions for the default group higher than those of the AllUsers group.
Higher permissions for the default group prevail over permissions in the AllUsers group. Individual user permissions prevail over group permissions.
Unified CCX Outbound Dialer Configuration

- Outbound Feature for Unified CCX, on page 217
- Supported Dialers and Dialing Modes for Outbound, on page 220
- Configure Outbound Subsystem in Unified CCX, on page 222
- Configure General Outbound Properties, on page 222
- Configure Application and Trigger for Outbound Campaign, on page 227
- Add New Campaign, on page 228
- Import Contacts for Campaign, on page 238
- Enable Campaigns, on page 244
- Outbound Subsystem and Time Detection, on page 244
- Add Area Codes, on page 245
- Call Status Values, on page 246
- Call Result Values, on page 247
- Reclassification Status Behavior, on page 249
- Call Retrieval Priority, on page 250
- Failover and System Restarts, on page 250

Outbound Feature for Unified CCX

The Outbound feature provides outbound dialing functionality in addition to existing Unified CCX inbound capabilities.

The Unified CCX Direct Preview Outbound feature is bundled along with the Unified CCX Premium license package. The Unified CCX IVR and Agent Progressive and Predictive Outbound feature is available with the Unified CCX Outbound license. When you upload the Premium license, the Outbound subsystem will automatically appear in the Subsystems menu. With this Outbound feature, you can maintain high agent productivity by configuring contact centers for automated Outbound activities to perform Outbound calls.

Outbound Characteristics

The Outbound feature has the following characteristics:

- An Outbound subsystem that can be monitored from the control center
- IVR and Agent Progressive and Predictive Outbound
- Dialing modes - Direct preview, Progressive and Predictive
Unified CCX Requirements

To use the Outbound feature, you must adhere to the following requirements:

**Unified CCX Licensing Requirements**

The licensing requirements for Outbound feature in Unified CCX will vary depending on the dialing modes.

- **For Unified CCX Outbound Direct Preview Dialer**—The Unified CCX Outbound Direct Preview Dialer feature is automatically available with Premium license package without any additional license. It is no longer available with Enhanced license.

- **For Unified CCX Outbound IVR Dialer**—You need to upload an Outbound license on top of the Unified CCX premium license with the required number of IVR ports that you would like to use for the Outbound feature.

- **For Unified CCX Outbound Agent Dialer**—You need to upload an Outbound license on top of the Unified CCX premium license with the required number of agent seats that you would like to use for the Outbound feature.

*Note*

The sum of inbound and outbound IVR ports should be less than or equal to a maximum number of IVR ports supported for your hardware model.

You can view the licensed IVR ports for outbound and inbound and the dedicated ports for both outbound and inbound calls by navigating to System > License Information > Display License(s) submenu from the Unified CCX Administration menu bar.

**Scenario 1:**

If your Contact Center is already utilizing maximum licensed IVR ports supported for your hardware model, then:

- Inbound calls will take precedence over the configured Outbound IVR calls.
- If IVR ports are dedicated for a campaign, then the Outbound IVR ports available for the campaign will be gradually incremented as and when the inbound ports become free.
For example, if you have an UCS C220 hardware that supports maximum of 300 IVR ports and if you have 200 premium seats, then the current licensed IVR ports = 300 (Minimum of [seats*2, maximum supported for platform]).

In this case, if you upload an Outbound add-on license for 100 IVR ports and add 3 campaigns with 20 dedicated ports each running at the same time, then the 60 Outbound IVR ports will be available to the campaigns only when the number of inbound ports are freed up to support the Outbound IVR calls.

In other words, if the number of inbound ports that are used during the outbound IVR campaign time is 280, then only 20 Outbound IVR ports will be available to the campaigns. The number of Outbound IVR ports will be gradually incremented depending on the availability of free inbound ports.

**Scenario 2:**

If your Contact Center is close to utilizing the maximum IVR ports supported for your hardware model, then:

- Inbound calls will take precedence over the configured Outbound IVR calls.
- If IVR ports are dedicated for a campaign and if you reach the maximum inbound call limit, then the Outbound IVR ports available for the campaign will be gradually incremented as and when the inbound ports become free.

For example, if you have an UCS C220 hardware that supports a maximum of 300 IVR ports and if you have 130 premium seats, then the current licensed IVR ports = 260 (Minimum of [seats*2, max supported for platform]).

In this case, if you upload an Outbound add-on license for 50 IVR ports and add 2 campaigns with 25 dedicated ports each running at the same time and if you reach the inbound call limit of 260 during the outbound IVR campaign time, then only 40 ports (300-260) will be freed up initially for Outbound IVR calls. The number of Outbound IVR ports will be gradually incremented depending on the availability of free inbound ports.

**Scenario 3:**

If your Contact Center is using fewer ports than the maximum licensed ports supported for your hardware model, then the number of available IVR ports for inbound will continue to remain the same.

For example, if you have an UCS C220 hardware that supports maximum of 300 IVR ports and if you have 60 premium seats, then the current licensed IVR ports = 120 (Minimum of [seats*2, max supported for platform]).

In this case if you upload an Outbound add-on license for 50 IVR Outbound ports, and add 2 campaigns with 20 dedicated ports each running at the same time, then Unified CCX will support 40 IVR Outbound calls, and the inbound port limit will continue to be 120 as the sum of both inbound and outbound ports (160) are within the maximum licensed ports (300) for the platform.

---

**Note**

The total number of dedicated IVR ports in all the IVR campaigns must be less than twice the number of Premium Seats that is equivalent to the Total Licensed Inbound IVR ports.

---

**Unified CCX Subsystem Requirements**

- The Outbound subsystem must be IN SERVICE.
- The RmCm subsystem must be IN SERVICE.
- The Unified CM Telephony subsystem must be IN SERVICE.
• The Unified CCX Database must be IN SERVICE.

Geographic Region Support

• The Outbound feature can be used in any geographic region supported by Unified CCX. The area codes and time zones mapping for North America are automatically prepopulated in the system. The system uses this information to determine the time zone of a customer’s phone number.

• For regions outside North America, administrators must enter the mapping of the international area codes and their time zones using the Unified CCX Administration GUI or REST API.

• The national do_not_call list is not supported in this release. Be sure to abide by the national do_not_call list.

In this guide, the underscore character linking each word differentiates the national do_not_call list from the Outbound subsystem's Do Not Call list.

Outbound Components

This section provides details about the following Outbound feature components:

• Unified CCX Administration—Enables the Outbound subsystem configuration, creates campaigns, and imports contacts to generate the dialing list.

• Outbound subsystem—Is responsible for the following tasks:
  • Manages campaigns
  • Maintains Outbound system configurations
  • Manages the dialing list
  • Reserves agents
  • Makes Outbound calls
  • Updates the call data in the dialing list based on the outcome of the call
  • Decides which contact records to retrieve from a campaign

The Outbound subsystem views campaigns as logical entities that group a set of contacts together in a dialing list. Campaigns deliver outgoing calls to agents. Agents are assigned to campaigns using CSQs.

Supported Dialers and Dialing Modes for Outbound

In addition to the existing Direct Preview Outbound dialer option, Unified CCX supports IVR-based and agent-based dialing. If you select the IVR-based option for a campaign, the outbound calls are handled by IVR scripts. If you select the agent-based option for a campaign, the outbound calls are handled by agents. Typical applications include appointment and bill-payment reminders.
Unified CCX Outbound Dialing Modes

The Outbound feature in Unified CCX Release supports the following dialing modes:

- Direct preview dialing mode
- Progressive dialing mode
- Predictive dialing mode

Tip

For agent predictive and agent progressive outbound calls, disable the Call Waiting option on the agent's phone to allow agents to preview a customer call on Cisco Finesse before the call is placed. The Call Waiting option must be disabled (default) in Unified Communications Manager on each Outbound agent phone to ensure that every customer call successfully transfers to an available agent.

When an Outbound call is transferred or conferenced to another agent, the second or subsequent agents are not counted towards the number of Outbound licenses. For example, if you have five seats licensed for Outbound and Agent1 gets an Outbound call, Agent1 accepts the call and conferences in Agent2 and Agent3. Now, three agents are on one Outbound call but only Agent1 is considered an Outbound agent and you are only using one licensed seat. Consequently, your system allows four more Outbound calls to agents.

Direct Preview Dialing Mode

The direct preview dialing mode allows agents to preview a customer call on Cisco Finesse before the call is placed. The advantage of this mode is that an agent is already on the call when the customer answers and can quickly begin talking with the customer immediately.

Progressive Dialing Mode

In the Progressive Dialing mode, you can specify a fixed number of lines that will always be dialed per available IVR port or per available agent. You can configure the progressive dialer settings for each campaign while creating the campaign through Unified CCX Application Administration web interface. You can also update the configuration at a later date.

Predictive Dialing Mode

The Predictive Dialing mode works similar to the Progressive Dialing mode in terms of dialing the Outbound calls. The difference remains in tuning the lines per port or per agent depending on the abandoned call-rate thus eliminating manual intervention as in the case of the Progressive Dialer.

In other words, in the Predictive Dialing mode, the Dialer adjusts the number of customers to dial per available IVR port or per available agent. The number of lines to dial is calculated by an algorithm and gets updated automatically.
Configure Outbound Subsystem in Unified CCX

Procedure

Step 1 Configure the general properties of the outbound subsystem. See Configure General Outbound Properties.
Step 2 (Optional) If the dialing list contains contacts outside of North America or if Unified CCX is installed outside of North America, manually add the area codes and their corresponding time zones. See Add New Area Code.
Step 3 Configure the SIP Gateway parameters to enable communication between Unified CCX and the SIP gateway for IVR and agent-based progressive and predictive campaigns. See Configure SIP Gateway.
Step 4 Configure the campaign. See Add New Campaign.

Related Topics
  Configure General Outbound Properties, on page 222
  Add New Area Code, on page 318
  Configure SIP Gateway, on page 318
  Add New Campaigns, on page 317

Configure General Outbound Properties

General Outbound properties refer to the settings that is common for all the campaigns.

⚠️ Caution

Area code and long distance prefix configuration changes made to the Outbound subsystem do not take effect for the calls/contacts that are currently in the Outbound subsystem’s memory. For example, if you change the long distance prefix or local area code, the contacts that are already in the Outbound subsystem's memory will continue to use the old long distance prefix and local area code.

To configure general Outbound properties, complete the following steps.

Procedure

Step 1 From the Unified CCX Administration menu bar, choose Subsystems > Outbound > General.
The General Configuration web page opens.
Step 2 Specify the following fields in the General Configuration section:
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Customer Dialing Time Range (hh:mm)</td>
<td>The time range during which a customer can be called. This time range supersedes the time range of the individual campaigns and ensures that a customer is never called outside the legally allowed time range for that country. This is a mandatory field. For example, in the USA, the Federal Communications Commission (FCC) specifies the legal time range as 8 AM to 9 PM. This does not apply to callbacks, since the customer explicitly requested to be called at a certain time. This time range is always converted to the local time for each contact record. Default = 8:00 AM to 9:00 PM (USA FCC regulations)</td>
</tr>
<tr>
<td>Outbound Call Timeout (seconds)</td>
<td>If an agent does not respond to the Outbound preview call on Cisco Finesse within the timeout duration that is specified in this field, the system sets the agent to the Not Ready state. If an agent does not respond to the Outbound progressive or predictive call on Finesse within the timeout duration that is specified in this field, then the call is dropped. The system sets the agent to the Ready or Not Ready state depending on the option that is selected for Agent State after Ring No Answer field in the System Parameters Configuration Web Page. This is a mandatory field. Default = 60 seconds, Range = 5 to 3600 seconds. <strong>Note</strong> • If the Unified CCX Engine or Finesse restarts when a call is being presented to an agent, then the timeout value specified in the Outbound Call Timeout field will not be applicable for that call.</td>
</tr>
<tr>
<td>Dialing Prefix</td>
<td>The number that is prefixed to the phone number when the dialer dials an outgoing call (also referred to as switch prefix). This number can have a numeric value, including 0 or leading zeros. This is a user defined value. For example, if the dialing prefix is set as 9 and the phone number of the contact is 54321, then the dialer will dial out '954321'.</td>
</tr>
<tr>
<td>Long Distance Prefix</td>
<td>This is a user defined value that can have a numeric value, including 0 or leading zeros. When this value is set and an outgoing call is made, it helps to determine the long distance prefix in the phone number that is dialed by the dialer. It is first determined whether it is an international or domestic number by the presence of any matching International Prefix set in the General configurations page. When the phone number is a domestic number, based on the matching local area code set, it is determined if it is a local number or a long distance number. For example, if the long distance prefix is set as 044, the phone number of the contact is 54321, and if the Include Long Distance Prefix is enabled, then the dialer dials out '4454321'.</td>
</tr>
</tbody>
</table>
### Unified CCX Outbound Dialer Configuration

#### Configure General Outbound Properties

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>International Prefix</td>
<td>This is a user defined value that can have a numeric value, including 0 or leading zeros. When this value is set and an outgoing call is made, it helps to determine the international prefix in the phone number for that international number. If there is no International Prefix, then the number is considered to be a domestic number. If the imported number doesn't contain an international prefix but has a &quot;+&quot; sign prefixed to the phone number, then it is considered to be an international number.</td>
</tr>
<tr>
<td>Local Area Code</td>
<td>The area code of the location from where the PSTN call is made from. This number can have a numeric value, including 0 or leading zeros. The local area code when set in the General configurations page, helps to determine the prefix value in the domestic phone number which is included in the outgoing call if the Do Not Remove Local Area Code When Dialing is checked.</td>
</tr>
<tr>
<td>Do Not Remove Local Area Code When Dialing</td>
<td>If this box is checked, the local area code is included when dialing the phone numbers within this area code. If it is unchecked, then the local area code is stripped from the phone number before dialing the local numbers. It is expected that when contacts are imported into the system, the phone numbers include the area code. For international phone numbers, the country code must be included when importing contacts.</td>
</tr>
<tr>
<td>Include Long Distance Prefix</td>
<td>This field will be displayed only if you check the Do Not Remove Local Area Code When Dialing check box. For local numbers, the long distance prefix will be prefixed only if this check box is checked. The long distance prefix will be prefixed to the phone number for all non-local numbers (the numbers that do not start with local area code) irrespective of the status (checked/unchecked) of this check box.</td>
</tr>
<tr>
<td>Agent AutoAnswer</td>
<td>If this box is checked, any agent-based progressive or predictive campaign call that gets transferred to the agent is automatically answered by Unified CCX. This check box is checked by default. Note • Either check this option in Unified CCX, or set Agent AutoAnswer to 'yes' in Unified Communications Manager. Do not select both of these options. • Enable Agent AutoAnswer so that the call presented to the agent is automatically answered. A beep tone notifies the agent that the call has been answered. • If the workflow is enabled, it will be executed irrespective of the status (Checked/unchecked) of the Agent AutoAnswer check box.</td>
</tr>
</tbody>
</table>
Assigned CSQs are CSQs that are used by the Outbound subsystem. This is a mandatory field. To allocate CSQs for Outbound:

a. Select a CSQ in the **Available CSQs** list.

b. Select a value from the **% of Logged in Agents for Outbound** drop-down list to indicate what percentage of the CSQ is allocated for Outbound.

c. Click the left arrow icon to move the CSQ to the **Assigned CSQs** list.

The selected CSQ is removed from the **Available CSQs** box and appears in the **Assigned CSQs** box with the percentage allocation in parentheses next to the CSQ name.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Available CSQs</td>
<td>The Available CSQs pane displays all CSQs configured in the CSQ Configuration page under the RmCm subsystem configuration.</td>
</tr>
<tr>
<td>% of Logged in Agents for Outbound</td>
<td>The % of Logged in Agents for Outbound field indicates the percentage of logged in agents in each of the selected CSQs that are allocated for handling Outbound calls. The number of agents allocated for OB is considered as the whole number of the <strong>% of Logged in Agents for Outbound</strong>. Any decimal value in the value is not considered. For example, If the percentage of allocation is 95% and 4 agents are logged in, then the number of agents allocated for OB are 3 [95% * 4 = 3.8 (decimal value is neglected)]. If the percentage of allocation is 80% and 4 agents were logged in, then the number of agents allocated for OB are 3 [(80% * 4 = 3.2 (decimal value is neglected)].</td>
</tr>
</tbody>
</table>

**Step 3**

Click **Update** icon that is displayed in the toolbar in the upper, left corner of the window or the **Update** button that is displayed at the bottom of the window.

The System Options components are now updated.

---

**Callbacks**

A customer can request a callback at a specific callback phone number and also specify the time/date of the callback. The Outbound subsystem stores this information (the callback phone number, date, time) in the dialing list table.

The Outbound subsystem handles the callback as follows:

- Convert to GMT—The callback date and time specified with respect to the customer's time zone is converted to GMT time zone and then stored in the database.

- Agent not Available—When the Outbound subsystem looks up the database for contacts, it first checks the callbacks. The default callback time limit is 15 minutes (can be changed) before and after the
customer-specified time. If an agent is available, then the Outbound subsystem places the callback. If an agent is not available, the Outbound subsystem retries agent availability (agent state) after 10 minutes.

• Missed Callbacks—If the Unified CCX system is unable to process a callback request in the specified time, you have three action options:
  • Reschedule it to the same time on the next business day.
  • Mark it as another retry (the callback phone number is removed and the callback date time is ignored). In this case, it moves out of the call back state and into the retry state.
  • Close the record (never dialed again).

Note The selected status for the Missed Callbacks is applied at midnight.

• Agent reclassifications—If calls were retrieved and presented to the agent and if the agent reclassifies it (for example, changed it to answering machine status), then the call status is updated to the answering machine.

Outbound Area Code Functionality

In the Outbound option, the area code determines the geographical location of the phone number you dial, which correspondingly provides the Greenwich Meridian Time (GMT) zone. The db_cra database contains a mapping of the area codes to the time zones.

The U.S. area code mappings are provided along with the product. International customers should provide their own data and add it to the database.

Configuration Updates

Whenever Outbound parameters are modified in the Unified CCX Administration GUI, the changes take effect immediately. If a new CSQ is added using the Subsystems > RmCm > Contact Service Queues menu option, it is instantly displayed in the list of available CSQs in the General configuration page in the Unified CCX Administration GUI, as this list is dynamically updated. If a CSQ is modified and if this impacts the allocation of agents, the Outbound subsystem is aware of this change as it refreshes the list of agents in each relevant CSQ periodically.

• If a configuration change affects the Outbound contacts dialing process (for example, if a campaign is disabled or a CSQ is removed from a campaign), the Outbound subsystem stops processing the Outbound contacts, recalls these contacts to the database, and resets the call status to Pending.

• If a campaign start time is changed, the Outbound subsystem checks if the campaign is enabled. If it is enabled, and if the new start time is after the current time, it performs the following actions:
  • Sends a recall contact message to the Outbound subsystem passing the campaign ID.
  • For all Outbound contacts for this campaign in the Outbound subsystem's memory that are waiting to be dialed out, it resets all Outbound contacts to the Pending state and clears them from memory.

If the campaign is disabled or if the new start time is before the current time, the Outbound subsystem ignores this change.
• If campaign end time is changed, the Outbound subsystem checks if the campaign is enabled. If it is enabled, and if the new end time is before the current time, it performs the following actions:
  • Sends a recall contact message to the Outbound subsystem passing the campaign ID.
  • For all the Outbound contacts for this campaign in Outbound subsystem's memory that are waiting to be dialed out, it resets all the Outbound contacts to the Pending state and clears them from memory.

If the campaign is disabled or if the new end time is after the current time, the Outbound subsystem ignores this change.

• If a CSQ is deleted from a campaign or if the CSQ itself is deleted, the Outbound subsystem sends a recall contacts message with the csq ID of the deleted CSQ. It also reallocates any Outbound contacts in its memory that are currently allocated to this CSQ among the other existing CSQs for this campaign.

**CSQ Agent Pool Allocation**

You need to specify a percentage of total agents in the assigned CSQs to be allocated for Outbound calls. This pool of agents is shared by all Outbound campaigns.

---

**Tip**

The CSQs for Outbound are the same as the CSQs for inbound. If you need more CSQs, you must first configure them in Unified CCX and assign the required CSQs for agents as required by your configuration, before allocating them.

---

**Configure Application and Trigger for Outbound Campaign**

For IVR campaigns, configure application and trigger before you create the campaign.

For an agent-based predictive campaign and an agent-based progressive campaign, configure the application and trigger if you configure the answering machine and the abandoned call treatment to transfer to IVR.

**Procedure**

**Step 1** Create a Call Control Group for Outbound type with the required number of IVR ports to be used for outbound campaigns. See [Add New Call Control Group](Add%20New%20Call%20Control%20Group).

**Step 2** Create an application, which will be used for the outbound campaign. See [Cisco Applications Configuration](Cisco%20Applications%20Configuration).

**Step 3** Create a trigger and assign the newly created Outbound Call Control group to this trigger. See [Cisco Applications Configuration](Cisco%20Applications%20Configuration).

**Step 4** Create a new progressive or predictive outbound campaign. See [Add New Campaign](Add%20New%20Campaign).

**Step 5** Import contacts for the campaign. See [Import Contacts for Campaign](Import%20Contacts%20for%20Campaign).

**Related Topics**

- [About Unified CCX Applications](About%20Unified%20CCX%20Applications), on page 41
- [Configure Script Applications](Configure%20Script%20Applications), on page 42
- [Add New Cisco Script Application](Add%20New%20Cisco%20Script%20Application), on page 43
Add New Campaign

Use the Campaign component to configure properties for the campaign, including the campaign name and description, CSQ selection, and the time range when a campaign can call contacts.

Complete the following steps to define or modify the settings that apply to a campaign.

**Procedure**

**Step 1**
From the Unified CCX Administration menu bar, choose Subsystems > Outbound > Campaigns.

The Campaign web page opens, displaying the details of existing campaigns, if any. Click an existing campaign to view or update the configuration settings for the campaign.

**Step 2**
Click the Add New icon in the tool bar in the upper, left corner of the window or the Add New button at the bottom of the window.

Add a New Campaign web page opens up where you can specify the campaign type and the dialer type for the campaign using the following fields.

**Note** You need to upload an Outbound license on top of the Premium license for Unified CCX to create a campaign for Outbound.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select the type of the campaign</td>
<td></td>
</tr>
</tbody>
</table>
**Description Field**

Description of the campaign to be used for outbound calls. You can specify any one of the following two campaign types:

- **Agent-based**—If you select this, all the outbound calls in a campaign will be handled by the available agents.
- **IVR-based**—If you select the IVR-based option, the outbound calls in a campaign will be handled by the IVR scripts.

**Select the type of dialer for the campaign**

<table>
<thead>
<tr>
<th>Description</th>
<th>The dialer type options available for a campaign will vary depending on the selected Campaign Type.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>- If you select Agent-based campaign type, then you can select any one of the following dialer types:</td>
</tr>
<tr>
<td></td>
<td>- Direct Preview (default)</td>
</tr>
<tr>
<td></td>
<td>- Progressive</td>
</tr>
<tr>
<td></td>
<td>- Predictive</td>
</tr>
<tr>
<td></td>
<td>- If you select IVR-based campaign type, then you can select any one of the following dialer types:</td>
</tr>
<tr>
<td></td>
<td>- Progressive (default)</td>
</tr>
<tr>
<td></td>
<td>- Predictive</td>
</tr>
</tbody>
</table>

**Note** Once the campaign is created, you cannot change the Campaign Type and Dialer Type.

After you select the campaign type and dialer type, click **Next** to continue. The Campaign Configuration web page opens, displaying the following three column headings:

- Parameter Name
- Parameter Value
- Suggested Value

You can specify values for a new campaign or modify values for an campaign using the fields listed in the Parameter Value column. See the table below for a list of fields along with their description.

The Suggested Value displays the default configuration value for each campaign. You can refer to these values if you want to revert any changes made to one or more parameters listed in the Campaign Configuration web page.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Campaign Name</td>
<td>Name of the campaign (must be a unique identifier). This is a mandatory field.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Enabled</td>
<td>Indicates the current state of the campaign to the Outbound subsystem. Yes = The campaign is currently active. No = The campaign is currently inactive (default).</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the campaign.</td>
</tr>
<tr>
<td>Start Time/End Time (hh:mm) AM PM</td>
<td>Indicate the time range during which the campaign runs. These are mandatory fields. The name of the primary time zone is also displayed adjacent to these two field values. Default = 8:00 AM - 9:00 PM Pacific Standard Time (USA FCC regulations).</td>
</tr>
<tr>
<td>Time Zone</td>
<td></td>
</tr>
<tr>
<td>Campaign Calling Number</td>
<td>The campaign calling number is the number that will be displayed to the contact. This number is used by the dialer. This is a mandatory field. Note: This field is not available if you have selected the direct preview dialer type for an agent based campaign.</td>
</tr>
<tr>
<td>Maximum Attempts to Dial Contact</td>
<td>The maximum number of times the Outbound subsystem attempts to dial a contact beyond which the call status will be marked as closed. You can choose this value from the drop-down list box. Default = 3, Range = 1 to 3.</td>
</tr>
<tr>
<td>Callback Time Limit</td>
<td>The time period before and after the scheduled callback time during which the Outbound subsystem attempts to dial out a callback. For example, if a callback was scheduled for 9:30 am and if the Callback Time Limit is set to 15 minutes, then the Outbound subsystem calls the customer anytime between 9:15 am to 9:45 am. This field is also used to determine the dialing time range for the Retries settings in the Add New Campaign web page. Default = 15 minutes, Range = 1 to 60 minutes.</td>
</tr>
</tbody>
</table>

Fields displayed only if you have selected IVR-based campaign type

| Application Trigger                 | This is the JTAPI trigger associated with this campaign. There will one-to-one mapping between a campaign and an application trigger. Only those triggers that are not associated with any other campaigns are displayed in the trigger list. |
| Application Name                    | The name of the application associated with the above-mentioned JTAPI trigger. This field is auto-populated.                                                                                       |

Fields displayed only if you have selected Agent-based campaign type
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Abandoned Call</td>
<td>If the agent is not available to handle the call, you can choose to abandon the call or transfer it to IVR by selecting the desired radio button in this field. If you choose to transfer the call to IVR, a trigger field and an application name field appears for selection. The trigger field is a drop-down list of JTAPI triggers associated with this campaign. There is one-to-one mapping between a campaign and a trigger. Only those triggers that are not associated with any other campaigns are displayed in the trigger list. The application name is associated with the above-mentioned JTAPI trigger. This field is auto-populated. Transfer to IVR radio button is enabled by default.</td>
</tr>
</tbody>
</table>
| Treatment             | Note • This field is not applicable if you have selected the Direct Preview dialer type for an agent-based campaign.  
                          • If the agent is available to handle the call and if Unified CCX fails to transfer the call to the agent, then the call is dropped and will not be transferred to the IVR port. |
| Assigned CSQs         | The CSQs from which agents are selected for Outbound calls for this campaign. This is a mandatory field.                                     |
|                       | Note • For agent selection, the CSQs are used in the order in which they are assigned to the campaign.  
                          • CSQs that are associated with agent-based progressive or predictive campaigns cannot be shared across any other campaigns.  
                          • CSQs that are associated with direct preview campaigns can be shared only across other direct preview campaigns and not with agent-based progressive and predictive campaigns. |
| Available CSQs        | For direct preview campaigns—CSQs that are allocated for outbound but not assigned to any progressive or predictive agent-based campaign. For progressive and predictive agent-based campaigns—CSQs that are allocated for outbound and not assigned to any other campaign. |
| Fields displayed only | Fields displayed only if you have selected Direct Preview dialer type for an Agent-based campaign  |
| if you have selected   | |
| Direct Preview dialer | type for an Agent-based campaign |

Cisco Unified Contact Center Express Administration and Operations Guide, Release 12.5(1)
The number of contact records the Outbound subsystem retrieves from the database in bulk for dialing. The allowed values are 1–100. This is a mandatory field. For example, if 50 records are retrieved in bulk for campaign 1 and 10 for campaign 2 and they are running at the same time, the Outbound subsystem attempts to place 50 Outbound calls for campaign 1 and 10 Outbound calls for campaign 2. The number of Outbound calls actually placed for each campaign depends upon the number of agents available for the respective campaigns.

Once all the records retrieved for a campaign have been dialed, the Outbound subsystem retrieves another batch of records for that campaign. Over a period of time, it is likely that more contacts would have been called from campaign 1 than from campaign 2. If two campaigns run simultaneously and share CSQs or agents, the records in both campaigns may not be processed at the same rate even if their contact cache sizes are identical. It is possible that more records from one of these two campaigns is processed before the other.

Default = 20, Range = 1 to 100

If you select Yes, then the Outbound subsystem retries the contact after all the callbacks and pending contacts for the campaign are dialed out.

Default = No

The following fields in Dialing Options are displayed if you have selected IVR-based campaign type

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contact Records Cache Size</td>
<td>The number of contact records the Outbound subsystem retrieves from the database in bulk for dialing. The allowed values are 1–100. This is a mandatory field. For example, if 50 records are retrieved in bulk for campaign 1 and 10 for campaign 2 and they are running at the same time, the Outbound subsystem attempts to place 50 Outbound calls for campaign 1 and 10 Outbound calls for campaign 2. The number of Outbound calls actually placed for each campaign depends upon the number of agents available for the respective campaigns. Once all the records retrieved for a campaign have been dialed, the Outbound subsystem retrieves another batch of records for that campaign. Over a period of time, it is likely that more contacts would have been called from campaign 1 than from campaign 2. If two campaigns run simultaneously and share CSQs or agents, the records in both campaigns may not be processed at the same rate even if their contact cache sizes are identical. It is possible that more records from one of these two campaigns is processed before the other. Default = 20, Range = 1 to 100.</td>
</tr>
<tr>
<td>Answering Machine Retry</td>
<td>If you select Yes, then the Outbound subsystem retries the contact after all the callbacks and pending contacts for the campaign are dialed out. Default = No.</td>
</tr>
</tbody>
</table>

The following fields in Dialing Options are displayed if you have selected IVR-based campaign type.
Number of dedicated IVR ports that you want to reserve for this campaign based on the number of CTI ports available in the outbound call control group for the campaign duration. That is, the total number of dedicated IVR ports for the selected campaign cannot exceed the maximum licensed ports for outbound IVR minus the sum total of IVR ports dedicated to other campaigns running at the same time.

You can enter or update this value for a campaign only after associating a trigger with the campaign. Default value = 0, Range = 0 to number of available ports for the campaign duration.

For example, if you have a medium or large profile VM, which supports maximum of 300 IVR ports with 50 licensed ports for outbound IVR and you have already dedicated:

- 20 ports for Campaign1, which runs between 10–12 pm
- 10 ports for Campaign2, which runs between 2–4 pm, then the number of dedicated IVR ports that you can enter in this field for a new campaign cannot exceed:
  - 30 ports if the new campaign runs between 10–12 pm and
  - 40 ports if the new campaign runs between 2–4 pm and
  - 50 ports if the new campaign runs during any time other than 10–12 pm and 2–4 pm

If the number of configured ports for a campaign is greater than the available number of licensed ports at the specified campaign time, then an alert message stating the same will be shown while saving the campaign.

**Note**

Ensure that few IVR ports from the total number of licensed IVR ports are left free if you want to use the "Transfer to IVR" option available in the answering machine treatment and abandoned call treatment fields for agent-based progressive and predictive outbound campaigns.

See **Unified CCX Requirements**, on page 218 to know how the licensed IVR ports are distributed between the inbound and outbound IVR calls in different scenarios.
### Field | Description
---|---
Lines Per Port (1-3) | Number of lines to be dialed for each port. The dialer will try to connect as many live voices to the available port(s) where IVR script is playing and it will disconnect the remaining calls. The probability of abandoned calls increases geometrically as the lines per port increases.

In an IVR based progressive campaign, you can configure the number of lines to dial per port at a time. The dialer will determine the number of calls to dial based on the following calculation - Lines per port * Available number of ports.

In an IVR based predictive campaign, this is the seed value that is passed to the predictive algorithm. Initially the dialer starts dialing with this value.

**Note** Predictive algorithm will pick up the LPP value, when the value is updated only while the campaign is running. The updated value will be picked when the next set of contacts are fetched for dialing.

This is a mandatory field.
Default value = 1.5; Range = 1 to 3.

| Lines Per Agent (1-3) | Number of lines to be dialed for each agent. The dialer will try to connect as many live voices to the available agent(s) and it will disconnect the remaining calls. The probability of abandoned calls increases geometrically as the lines per agent increases.

In an agent-based progressive campaign, you can configure the number of lines to dial per agent at a time. The dialer will determine the number of calls to dial based on the following calculation - Lines per agent * Available number of agents.

In an agent-based predictive campaign, this is the seed value that is passed to the predictive algorithm. Initially the dialer starts dialing with this value.

**Note** Predictive algorithm will pick up the LPP value, when the value is updated only while the campaign is running. The updated value will be picked when the next set of contacts are fetched for dialing.

This is a mandatory field.
Default value = 1.5; Range = 1 to 3.

**Note** This field is not applicable if you have selected the Direct Preview dialer type for an agent-based campaign.

Callback Missed | Determines the action that should be taken on the contacts that were not called back. The three options for this field are:

- Reschedule for same time next business day (default)
- Mark it for a retry
- Close the record.

The following fields in Dialing Options are displayed if you have selected Agent-based campaign type

### The following fields in Dialing Options are common if you have selected Progressive or Predictive dialer type for IVR-based and Agent-based campaigns
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Handle Low Volume as Voice</td>
<td>Determines whether a low volume call should be treated as voice or disconnected. Select <strong>Yes</strong> or <strong>No</strong> radio button accordingly. Default is Yes, which means low volume calls are handled as voice and they are connected to an IVR port or an agent.</td>
</tr>
<tr>
<td>Answering Machine Treatment</td>
<td>If the outbound call detects an answering machine, you can choose to end the call or transfer it to IVR by selecting the desired radio button in this field. For agent-based campaigns, if you choose to transfer the call to IVR, a trigger field and an application name field appears for selection. The trigger field is a drop down list of JTAPI triggers associated with this campaign. There is one-to-one mapping between a campaign and a trigger. Only those triggers that are not associated with any other campaigns are displayed in the trigger list. The application name is associated with the above-mentioned JTAPI trigger. This field is auto-populated. Transfer to IVR radio button is enabled by default.</td>
</tr>
</tbody>
</table>

The following fields in Dialing Options are common if you have selected Predictive dialer type for IVR-based and Agent-based campaigns

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Predictive Correction Pace (10-1000)</td>
<td>The number of calls that were answered by live voice that the predictive algorithm should consider for each iteration. This is directly proportional with the correction frequency made in the Lines Per Port or Lines Per Agent parameter. This is a mandatory field. Default value = 100, Range = 10 to 1000. <strong>Note</strong> It is advisable not to change this value.</td>
</tr>
<tr>
<td>Predictive Gain</td>
<td>The Gain parameter controls the size of the lines per port or lines per agent corrections. This is directly proportional to the size of the lines per port or lines per agent correction. This is a mandatory field. Default value = 1.0, Range = Greater than 0 to 1.0. <strong>Note</strong> It is advisable not to change this value.</td>
</tr>
<tr>
<td>Call Abandon Limit (0-100)</td>
<td>Call abandon percentage, which should be within the limit specified by Federal Trade Commission (FTC). This is a mandatory field. Default value = 3%, Range = 0-100%. This means that no more than three percent of calls that are answered by a person are abandoned, measured per day per calling campaign.</td>
</tr>
</tbody>
</table>

The following field in Dialing Options is displayed only if you have selected Predictive dialer type for an IVR-based campaign

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum Lines Per Port (1-3)</td>
<td>Maximum number of lines to be dialed for each port. You can configure the maximum number of lines that can be dialed per port and the predictive algorithm ensures that it does not exceed this number. This is a mandatory field. Default value = 3.0, Range = 1 to 3.</td>
</tr>
</tbody>
</table>
### Field Description

**The following field in Dialing Options is displayed only if you have selected Predictive dialer type for an Agent-based campaign**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Maximum Lines Per Agent (1-3) | Maximum number of lines to be dialed for each agent. You can configure the maximum number of lines that can be dialed per agent and the predictive algorithm ensures that it does not exceed this number.  
This is a mandatory field. Default value = 3.0, Range = 1 to 3. |

**Dial Settings (displayed if you have selected IVR-based or Agent-based campaign types)**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| No Answer Ring Limit   | The duration for which the progressive/predictive dialer should allow the customer phone to ring before disconnecting an unanswered call.  
The duration is calculated from the time the dialer receives the ringing message from the gateway. If the dialer does not receive any ringing message from the gateway within the time duration entered for this field, then the dialer waits for the same time duration one more time before disconnecting the call.  
For example, if you have configured the value for No Answer Ring Limit as 30 seconds, then the dialer will wait for 60 seconds before disconnecting the call.  
Default = 15 seconds, Range = 1 to 60 seconds.  
**Note** This field is also used to determine the reservation timeout for agent-based progressive or predictive campaigns. If the agent does not receive any outbound calls, then the agent continues to remains in the reserved state up to maximum time duration of twice the value configured in the No Answer Ring Limit field.  
For example, if you have configured the value for No Answer Ring Limit as 30 seconds, then the range for reservation timeout is calculated as 30 to 60 (30 * 2) seconds. |
| Abandoned Call Wait Time | For IVR-based progressive and predictive outbound campaigns, if the customer disconnects the call within the time set here, then the call is classified as customer abandoned.  
For agent-based progressive and predictive outbound campaigns, if the customer or the agent disconnects the call within the time set here, then the call is classified as customer abandoned.  
This is a mandatory field.  
Default value = 2 seconds, Range = 1 to 10 seconds. |

**Retries (displayed if you have selected IVR-based or Agent-based campaign types):** Set the value for the following four fields as “0” if you want to disable retry option for an existing IVR or agent based outbound campaign.  
**Note** The time duration for the below fields is calculated as the value entered for each field, plus or minus the value entered for the Callback Time Limit field in the Add New Campaign web page.
**Field** | **Description**
--- | ---
No Answer Delay | The time duration (in minutes) for which the dialer waits before calling back a no-answer call.
Default value = 60 minutes.
Though the default value is 60 minutes, the retry attempt will not be made after 60 minutes. This is based on the value set for the Callback Time Limit configured in the subsystem. For example, if a callback was scheduled for 9:30 am and if the Callback Time Limit is set to 15 minutes, then the Outbound subsystem calls the customer anytime between 9:15 am to 9:45 am.
**Note** The value set for the No Answer Delay should always be more that the value set for the Callback Time Limit.

Busy Signal Delay | The time duration (in minutes) for which the dialer waits before calling back a busy telephone number.
Default value = 60 minutes.
This parameter is also based on the value set for the Callback Time Limit as described above in the No Answer Delay.

Customer Abandoned Delay | • For IVR-based progressive and predictive outbound campaigns, if a customer abandons a call, the time duration (in minutes) after which the dialer should call the customer back.
• For agent-based progressive and predictive outbound campaigns, if a customer or an agent abandons a call, the time duration (in minutes) after which the dialer should call the customer back.
Default value = 0

Dialer Abandoned Delay | If the dialer abandons a call, the time duration (in minutes) after which the dialer should call back the customer.
Default value = 0

**Step 3**
Click **Add** or **Save** to save the configuration changes. While saving a new or updated campaign, the Outbound subsystem validates the Session values in the application and trigger pages based on following criteria, and it might display an alert message to increase Session value in application and trigger pages:

- In case of a Progressive campaign, the outbound subsystem checks whether the Lines Per Port * Dedicated Port for IVR-based campaigns and Lines Per Agent * Dedicated Agent for agent-based campaigns is greater than the minimum of the Session value in application and trigger.

- In case of a Predictive campaign, the outbound subsystem checks whether the maximum Lines Per Port * Dedicated Port for IVR-based campaigns and maximum Lines Per Agent * Dedicated Agent for agent-based campaigns is greater than minimum of the Session value in application and trigger.

You should increase the Session values in the application and trigger to the suggested value in the alert message to reduce the number of abandoned calls in an Outbound campaign.
Once you create a campaign, you need to import contacts for the campaign.

**Import Contacts for Campaign**

**Caution**

You must verify all the contacts against the national do_not_call list before importing them.

**Note**

- When you import contacts that have agent extension numbers, ensure that the agents are not logged in when the campaigns are executed.

- When you import contacts for campaign, the order of field names is as per the last selected order for that campaign.

- When *Allow Duplicate Contacts* option is not selected in both Manual and Automatic import, there could be a difference between the number of contacts imported and the number of remaining contacts. This is because many of the contacts imported could be duplicates in the database and are overwritten.

- When Phone 1 of a contact is dialed and the CPA marks it as Busy or Unanswered the same number is retried based on the retry count and delay configured in the campaign. When the retry count reaches the maximum value, the contact is marked as closed. The other phone number for a given contact is dialed only when the called number is classified as Modem, Fax or Invalid.

- Each time contacts are imported, they are appended to the existing list of contacts for the selected campaign. If the new list contains a contact with the same Phone 1 value as the Phone 1, Phone 2, or Phone 3 value, or the same Phone 2 value as the Phone 1, Phone 2, or Phone 3 value, or the same Phone 3 value as the Phone 1, Phone 2, or Phone 3 value, of an existing contact, the existing contact is overwritten with the new contact information. The call history for the contact (if any) is retained.

- For supervisors to **Schedule Import** of contacts for a campaign, you must configure the campaign to use SFTP or HTTPS.

**For a manual import of contacts:**
Attention

- The contacts file should be ASCII-encoded or UTF-8 encoded if it contains special characters (for example, if the contact names are in Chinese, Russian, Japanese, and so on).
- The maximum limit of contacts in the contacts file is 1 million.
- The maximum limit of contacts that can be imported per campaign is determined by:
  - Number of contacts that are already imported and yet to be dialed out.
  - The number of contacts present in the contacts file being imported.
- After the import of contacts, ensure that a maximum of 20,000 contacts are remaining (yet to be dialed) to be imported for a campaign.
- You must not initiate the manual import of contacts and automatic import of contacts using SFTP or HTTPS at the same time. If a manual import is attempted when an automatic import is in progress, it would fail.

For a scheduled import of contacts:
Attention

• The contacts file should be ASCII-encoded or UTF-8 encoded if it contains special characters (for example, if the contact names are in Chinese, Russian, Japanese, and so on).

• The maximum limit of contacts in the contacts file is 1 million.

• The automatic import process would stop importing contacts for a campaign after the campaign has 20,000 contacts remaining (yet to be dialed out). After the contacts are dialed out, then the next scheduled import would import additional contacts.

• The maximum limit of contacts that can be imported per campaign is determined by:
  • Number of contacts that are already imported and yet to be dialed out.
  • The number of contacts present in the contacts file being imported.

  For example: Assume a new campaign and a contacts file has 1 million contacts that are scheduled for import. When the import is attempted for the first time, the first 20,000 (from 1 to 20,000 contact) contacts are fetched and imported for the campaign.

  Before the next scheduled import, assume system has successfully dialed out 5000 contacts and 15000 contacts are remaining. In this case, when next import is attempted as per the schedule, the system would import 5000 contacts for the remaining capacity of the campaign (20000-15000=5000 contacts). Thus, assuming that the contacts file has not changed across the imports, the system would import the contacts from 20001 to 25000 in the contacts file.

• You must not initiate the manual import of contacts and automatic import of contacts using SFTP or HTTPS at the same time. If a manual import is attempted when an automatic import is in progress, it would fail.

• If there are multiple imports scheduled at the same time, the import of contacts happen one at a time.

• When an automatic import of contacts is in progress and if there is a Unified CCX Engine failover, then the import will be terminated and its status is not available on the Automatic Import Contacts page.

Manual Import of Contacts for Campaign

To import contacts manually for a selected campaign, complete the following steps.

Procedure

Step 1 From the Unified CCX Administration menu bar, choose Subsystems > Outbound > Campaigns. The Campaigns web page opens, displaying the details of existing campaigns.

Step 2 Click the hyperlink below the Name column for the campaign for which you want to import the contacts. The Campaign Configuration web page opens for the selected campaign.

Step 3 Click Import Contacts. The Import Contacts web page opens.

Step 4 To import contacts from a CSV or a TXT file, click the Manual Import Contacts tab.
Step 5

Navigate to the directory that contains the imported fields in the *same order* as they appear in the text file. Specify a filename to import the contacts from the fields being imported.

A contact list can contain up to 7 fields:

- **Account Number** - The account number of a contact. The account number can be a maximum length of 25 characters.
- **First Name** - The first name of a contact. The first name can be a maximum length of 50 characters.
- **Last Name** - The last name of a contact. The last name can be a maximum length of 50 characters.
- **Phone1** - The phone number for the contact. This field can be 28 characters long and must be a valid phone number. Phone1 is mandatory and must be specified.
- **Phone2** - The phone number for the contact. This field can be 28 characters long and must be a valid phone number.
- **Phone3** - The phone number for the contact. This field can be 28 characters long and must be a valid phone number.
- **Dial Time** - The time to dial a number for individual contacts on the current date. The format to be used for this field is HH:MM. For example, to specify the dialing time as 08:25 am, the dial time field value should be 08:25 and for 03:45 pm, the dial time field value should be 15:45. This field is applicable only for Direct Preview Outbound campaigns.

Step 6

Check the **Allow Duplicate Contacts** option, if required.

**Allow Duplicate Contacts**

A record is considered duplicate when the phone number in any of the three phone fields (Phone 1, Phone 2, and Phone 3) of the records being imported:

- Exists in any of the three phone fields of the other contacts being imported.
- Exists in any of the three phone fields of the contacts previously imported for the campaign that are dialed out since last midnight or yet to be dialed out.

If this option is not selected:

- The contacts identified as duplicates are not imported for the campaign.

If this option is selected:

- The check for duplicate contacts is not performed and all contacts are imported as is.

**Note** By default this option is not selected.

Step 7

Click **Import**.

---

**What to do next**

While uploading outbound contacts in a HA over WAN deployment of Unified CCX, if all the contacts that are being uploaded exist in the database and are being modified, follow these guidelines to avoid long delays:

- Upload the contacts during non-peak hours.
Schedule Import of Contacts Using SFTP or HTTPS

Procedure

Step 1  From the Unified CCX Administration menu bar, choose **Subsystems > Outbound > Campaigns**.

The Campaigns web page opens, displaying the details of existing campaigns.

Step 2  Click the hyperlink below the Name column for the campaign for which you want to import the contacts.

The Campaign Configuration web page opens for the selected campaign.

Step 3  Click **Import Contacts**. The Import Contacts web page opens.

Step 4  To automatically import contacts from a remote server using SFTP or HTTPS, click the **Automatic Import Contacts** tab. SFTP is the default option.

Step 5  Select the server type as **SFTP** or **HTTPS**. Enter the SFTP or the HTTPS remote server details to import contacts from a remote server using SFTP or HTTPS respectively.

If you select SFTP, enter the following details for the Remote SFTP Server:

- **IP Address /FQDN**—The IP address or the Fully Qualified Domain Name of the remote SFTP server.
- **RSA Key**—The RSA public key of the remote SFTP server. This is optional and is used for trust verification of the SFTP server by the Unified CCX server.
- **User Name**—The username that is required to log in to the remote SFTP server.
- **Password**—The password that is required to log in to the remote SFTP server.
- **CSV File Path**—The CSV file path (.csv or .txt file path) to import contacts from the remote SFTP server. This is the fully qualified file name. For example:

If you select HTTPS, enter the following details for the Remote HTTPS Server:

- **URL**—The URL to access the contacts over the remote HTTPS Server.
- **User Name**—The username that is required to log in to the remote HTTPS server.
- **Password**—The password that is required to log in to the remote HTTPS server.
- **HTTPS Certificate**—The check box to confirm that:
  - You have uploaded the HTTPS Certificate in the Unified OS Administration web interface at, **Security > Certificate Management**.
  
  **Note** This is required for trust verification of the HTTPS server by the Unified CCX server.

- Restarted the Cisco Tomcat and Cisco Unified CCX Engine on both the node.

Step 6  Check the **Allow Duplicate Contacts** option, if required.

**Allow Duplicate Contacts**

- Upload in batches of 500 contacts or less.
A record is considered duplicate when the phone number in any of the three phone fields (Phone 1, Phone 2, and Phone 3) of the records being imported:

- Exists in any of the three phone fields of the other contacts being imported.
- Exists in any of the three phone fields of the contacts previously imported for the campaign that are dialed out since last midnight or yet to be dialed out.

If this option is not selected:

- The contacts identified as duplicates are not imported for the campaign.

If this option is selected:

- The check for duplicate contacts is not performed and all contacts are imported as is.

**Note** By default this option is not selected.

**Step 7** Click **Test Connection** to check the connectivity with the remote SFTP or HTTPS server.

**Step 8** Set the order of field names and a schedule to automatically import contacts in regular intervals.

A contact list can contain up to 7 fields:

- **Account Number** - The account number of a contact. The account number can be a maximum length of 25 characters.
- **First Name** - The first name of a contact. The first name can be a maximum length of 50 characters.
- **Last Name** - The last name of a contact. The last name can be a maximum length of 50 characters.
- **Phone 1** - The phone number for the contact. This field can be 28 characters long and must be a valid phone number. Phone 1 is mandatory and must be specified.
- **Phone 2** - The phone number for the contact. This field can be 28 characters long and must be a valid phone number.
- **Phone 3** - The phone number for the contact. This field can be 28 characters long and must be a valid phone number.
- **Dial Time** - The time to dial a number for individual contacts on the current date. The format to be used for this field is HH: MM. For example, to specify the dialing time as 08:25 am, the dial time field value should be 08:25 and for 03:45 pm, the dial time field value should be 15:45. This field is applicable only for Direct Preview Outbound campaigns.

**Step 9** Set the Schedule for the automatic import of contacts.

a) Select the date.

b) Set the **Start Time**.

c) Check the **Repeat Every** checkbox and set the reoccurrence of the automatic schedule.

**Note**

- The Outbound schedule time is based on the Unified CCX server time zone.
- Avoid scheduling the import of contacts during peak hours.

**Step 10** Select **Enable** or **Disable** option for automatic schedule of import of contacts.
Enable Campaigns

You must verify that the configured campaigns are active and that the start and end times for the enabled campaigns are specified as required.

To verify the state of the required campaign, complete the following steps.

Procedure

**Step 1**

From the Unified CCX Administration menu bar, choose **Subsystems > Outbound > Campaigns**.

The Campaigns web page opens, displaying following information for the existing campaigns:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the campaign.</td>
</tr>
<tr>
<td>Start Time/End Time (hh:mm) AM PM</td>
<td>Start Time and End Time fields indicate the time range during which the campaign runs.</td>
</tr>
<tr>
<td>Remaining Contacts</td>
<td>The Remaining Contacts field indicates the number of contacts that are yet to be dialed for each campaign. In addition to the contacts that have not been dialed, this number also includes contacts that have requested a callback and contacts that will be tried again because of unsuccessful prior attempt(s) (for example, the contact was busy or unavailable). A detailed breakdown of the pending contacts is provided in the Printable Reports page for each campaign.</td>
</tr>
<tr>
<td>Enabled</td>
<td>The Enabled field indicates to the Outbound subsystem whether this campaign is currently active.</td>
</tr>
<tr>
<td>Campaign Type</td>
<td>Denotes whether a specific campaign is IVR-based or Agent-based. The existing campaigns will be marked as Agent-based after an upgrade.</td>
</tr>
<tr>
<td>Delete</td>
<td>Click <strong>Delete</strong> icon next to the name of the campaign that you want to delete.</td>
</tr>
</tbody>
</table>

**Step 2**

Verify that the Enabled field is set to **TRUE** and that the start and end times are specified as required.

Outbound Subsystem and Time Detection

The Outbound subsystem uses the area code of a contact's phone number to determine the time zone of the contact's calling area. The contact's phone number can also be in E.164 format.

The subsystem provides the mapping for North American area codes to their corresponding time zones. The default North American area codes are used to determine the time zone for phone numbers that are not in the E.164 format (for example, 234-567-8900). The Area Codes web page allows you to add, modify, and delete...
any area-code-to-time-zone mapping. Some area codes extend across multiple time zones. For such area codes, you can edit the default time zone for that area code and specify a different one, if required.

Changes to area codes take affect the next time you import contacts. For example, if the time zone of area code 603 is changed from 16 to 17, contacts already present in the system that have an area code of 603 continue to have the GMT Offset of 16. Any contacts with area code 603 that are imported after the area code change have 17 for the GMT Offset.

When Outbound contacts are imported into the database, all contacts are assigned a GMT time zone for the three phone numbers provided. The Outbound subsystem determines this GMT time zone by extracting the area code of each phone number and checking it against the Area Codes table to obtain the corresponding time zone. If the area code cannot be matched, the Outbound subsystem uses the local time zone and Daylight Savings Time (DST) setting of the server. The Outbound subsystem also considers the DST to determine if an Outbound contact can be called at a given time.

The Outbound subsystem ensures that the contacts are dialed at valid times. For Outbound contacts which have been scheduled for callback, the scheduled callback time is converted to GMT time zone and stored in the callbackDateTime field in the database.

For pending records, the Outbound subsystem ensures that Outbound contacts are called only within the Customer Dialing Time Range (hh:mm) detected by the MinCustomerDialTime and MaxCustomerDialTime, as per federal regulations. You can configure this time in the Unified CCX Administration GUI.

Add Area Codes

⚠️ Caution

Area code and long distance prefix configuration changes made to the Outbound subsystem do not take effect for calls/contacts currently in the Outbound subsystem's memory. For example, if you change the long distance prefix or local area code, the contacts already in the Outbound subsystem's memory will continue to use the old long distance prefix and local area code.

The Outbound subsystem provides all of the mappings from North American area codes to their corresponding time zones at the time of product release. The Area Codes page allows the administrator to add, modify, and delete any area-code-to-time-zone mappings.

Some area codes extend across multiple time zones. For such area codes, an administrator can edit the default time zone for that area code and specify a different one, if required.

The Area Codes Management page allows users to find, add, delete, and modify the mapping of area codes and time zones. The Outbound subsystem uses the area code of a contact's phone number to determine the time zone of the contact's calling area. This page can also be used for adding international area codes. International area codes must include the country code and the city code.

To add an area code, complete the following steps.

Procedure

Step 1 From the Unified CCX Administration menu bar, choose Subsystems > Outbound > Area Codes. The Area Codes Management web page opens.
Step 2 In the Area Code field, specify a unique identifier for the area code. This field can have any numeric value, including 0 or leading zeros. This is a mandatory field.

Step 3 Click the Add New icon that is displayed in the tool bar in the upper, left corner of the window or the Add New button that is displayed at the bottom of the window.

The new Area Code information is updated.

Call Status Values

For each contact, the call statuses and their corresponding values are recorded in the database and described in the following table:

<table>
<thead>
<tr>
<th>Call Status</th>
<th>Value (stored in database)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pending</td>
<td>1</td>
<td>The call is pending. This is the initial state for all records.</td>
</tr>
<tr>
<td>Active</td>
<td>2</td>
<td>The record was retrieved by the Outbound subsystem for dialing.</td>
</tr>
<tr>
<td>Closed</td>
<td>3</td>
<td>The record is closed (not dialed).</td>
</tr>
<tr>
<td>Callback</td>
<td>4</td>
<td>The record is marked for a callback.</td>
</tr>
<tr>
<td>Max Calls</td>
<td>5</td>
<td>Maximum attempts have been reached for this record (considered closed).</td>
</tr>
<tr>
<td>Retry</td>
<td>6</td>
<td>The record is redialed immediately whenever there is any miss in the callbacks for Retries with Delay.</td>
</tr>
<tr>
<td>Unknown</td>
<td>7</td>
<td>If the Outbound subsystem was restarted with records in the Active (2) state, they are moved to this state.</td>
</tr>
<tr>
<td>Retries with Delay</td>
<td>8</td>
<td>The record is redialed as it was either busy, no answer, customer abandoned or system abandoned. Retry time is set as per the corresponding configuration in Unified CCX Application Administration web interface.</td>
</tr>
</tbody>
</table>

Contact States Reset at Midnight

The Outbound subsystem performs the following actions at midnight:
The DialingListConfig records with a call status of Unknown are reset to Pending.

Note: Outbound contacts with a call status of Unknown indicate that the these contacts were retrieved from the database but the system went down before they could be dialed out.

Missed callback records (dialingListConfig records that have call status callback and a callBackDateTime smaller than the current time) are updated depending on the missed callback action configured in the Unified CCX Administration GUI.

- MissedCallbackAction: Reschedule (for the same time on the next business day)
- MissedCallbackAction: Retry (sets the call status to Retry and retries at the start of next business day)
- MissedCallbackAction: Close (sets the call status to Closed)
- Dialing list records with a call status of Closed or Max Calls are moved to a separate historical data table

Note: The records marked as closed today will be moved the next day at midnight. For example, the records closed on 4th June will be moved on 5th June at midnight.

Dialing list records with a call result of Do Not Call are not deleted, as these records are exported to a text file.

- The DialingListConfig records with a call status of “Retries with delay” and which could not be retried due to lapsed time are marked for immediate retry at midnight.
- When the Unified CCX engine goes from offline to online (for example, the standby server becomes active [online] if the active [first] server fails), the dialing list records with a status of Unknown are reset to Pending.

Call Result Values

For each contact, the call results (as marked by the agent on Finesse or automatically deleted by the system) and their corresponding values are recorded in the database and described in the following table:

<table>
<thead>
<tr>
<th>Call Result</th>
<th>Value (stored in database)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Voice</td>
<td>1</td>
<td>Customer answered and was connected to agent.</td>
</tr>
<tr>
<td>Fax</td>
<td>2</td>
<td>Fax machine or modem detected.</td>
</tr>
<tr>
<td>Answering machine</td>
<td>3</td>
<td>Answering machine detected.</td>
</tr>
</tbody>
</table>
### Call Result Values

<table>
<thead>
<tr>
<th>Call Result</th>
<th>Value (stored in database)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Invalid</td>
<td>4</td>
<td>Number reported as invalid by the network.</td>
</tr>
<tr>
<td>Wrong Number</td>
<td>6</td>
<td>Number successfully contacted but wrong number.</td>
</tr>
<tr>
<td>Customer Not Home</td>
<td>7</td>
<td>Number successfully contacted but reached the wrong person.</td>
</tr>
<tr>
<td>Callback</td>
<td>8</td>
<td>Customer requested callback.</td>
</tr>
<tr>
<td>Agent Rejected</td>
<td>9</td>
<td>Agent skipped or rejected the preview call.</td>
</tr>
<tr>
<td>Agent Closed</td>
<td>10</td>
<td>Agent skipped or rejected the preview call with the close option (not dialed).</td>
</tr>
<tr>
<td>Busy</td>
<td>11</td>
<td>Busy tone detected.</td>
</tr>
<tr>
<td>Ring No Answer</td>
<td>12</td>
<td>Agent did not respond to the preview call within the time out duration.</td>
</tr>
<tr>
<td>Note</td>
<td></td>
<td>You can configure the time out duration using the Preview Call Timeout field detailed in the Configure General Outbound Properties.</td>
</tr>
<tr>
<td>Callback Failed</td>
<td>13</td>
<td>This value should not be written to the database; this is for internal use only.</td>
</tr>
<tr>
<td>Callback Missed</td>
<td>14</td>
<td>Callback missed and marked for Retry.</td>
</tr>
<tr>
<td>Timeout</td>
<td>15</td>
<td>Customer phone timed out either due to Ring No Answer (RNA) or Gateway failure.</td>
</tr>
<tr>
<td>Call Abandoned</td>
<td>16</td>
<td>Call was abandoned because IVR port was unavailable or Unified CCX failed due to transfer the call to the IVR port.</td>
</tr>
</tbody>
</table>
Call Result | Value (stored in database) | Description
--- | --- | ---
Call Failed | 17 | Call failed due any one of the following reasons:
• Dialer asked the Gateway to cancel a call that has not yet been placed
• Gateway has declined the call
• Gateway is down or Gateway has timed out while placing the call
• Gateway failure or configuration issues at the Gateway.
Customer Abandoned | 18 | Customer abandoned as customer disconnected the call within the time limit as configured in “Abandoned Call Wait Time” in Unified CCX Application Administration web interface.

### Reclassification Status Behavior

When the Outbound contacts are imported into the database from the Unified CCX Administration GUI, the call status column in the Dialing List table is assigned the default value of 1 (Pending), indicating that these Outbound contacts are yet to be dialed. When the Outbound subsystem retrieves a batch of contacts from the database, the call status is set to 2 (Active). After a call is placed to the Outbound contact, the call status is set to 3 (Closed) and the call result is set to 1 (Voice), as all Outbound calls are classified by the agent desktop as voice by default. If the agent clicks the reclassification button on the agent desktop and reclassifies the call as answering machine/fax/busy/invalid or selects the callback button and schedules a callback, the Outbound subsystem updates the call result field accordingly and, based on the call result, it also updates the call status.

The following table describes the relationship between call status and call result values and the resulting behavior of the system. The values in brackets are the actual values stored in the database.

The following information is applicable only for Preview Dialer.

<table>
<thead>
<tr>
<th>Call Result</th>
<th>Call Status</th>
<th>Behavior</th>
</tr>
</thead>
<tbody>
<tr>
<td>Voice (1)</td>
<td>Closed (3)</td>
<td>This contact is not dialed again.</td>
</tr>
<tr>
<td>Fax (2)</td>
<td>Retry (6)</td>
<td>This contact is retried, using a different phone number provided for this contact. If alternate phone numbers are not available, the call status is closed.</td>
</tr>
<tr>
<td>Answering machine (3)</td>
<td>Retry (6)</td>
<td>This contact is retried, with the same phone number as before.</td>
</tr>
</tbody>
</table>
Behavior Call Status Call Result

This contact is retried, using a different phone number provided for this contact. If alternate phone numbers are not available, the call status is closed.

<table>
<thead>
<tr>
<th>Call Result</th>
<th>Call Status</th>
<th>Behavior</th>
</tr>
</thead>
<tbody>
<tr>
<td>Invalid Number (4)</td>
<td>Retry (6)</td>
<td>This contact is retried, using a different phone number provided for this contact. If alternate phone numbers are not available, the call status is closed.</td>
</tr>
<tr>
<td>Busy</td>
<td>Retry (6)</td>
<td>This contact is retried, with the same phone number as before.</td>
</tr>
</tbody>
</table>

The call status is set to 5 (Closed) when the Outbound contact is no longer dialed for this campaign. This happens when a call was successfully placed (call result is voice) and also when an agent selects Skip-Closed, Reject-Closed, or Do Not Call. This also happens automatically if the system reaches the maximum attempts limit for an Outbound contact, which means that the system tried dialing the Outbound contact the maximum number of times configured in the Unified CCX Administration GUI.

Call Retrieval Priority

While retrieving Outbound contacts from the database, records that have scheduled callbacks have priority as the callback time must be adhered to. Outbound contacts are retrieved in the following order of priority:

- Priority 1—Outbound contacts with a scheduled callback (call status = 4) and the current time is within the CallbackTimeLimit configured on the Campaigns page (default value is 15 minutes) of the scheduled callback time.
- Priority 2—Outbound contacts to be retried after a specific delay. This is not applicable for direct preview campaigns (call status = 8).
- Priority 3—Outbound contacts in the Pending state (call status = 1).
- Priority 4—Outbound contacts in the Retry state (call status = 6).

The Call Retrieval Priority is on a per campaign basis. If an agent is part of multiple CSQs that are part of different campaigns, priority of callbacks may be overridden by different queues. For example, Priority 4 in a particular queue may take precedence over Priority 1 of another queue.

Failover and System Restarts

Outbound contacts with an Active call status during a failover indicate that these contacts were retrieved from the database but the system went down either before they could be dialed or after they were dialed but before the call status and call result columns were updated. When the system restarts, the call status for all such Outbound contacts is changed to 7 (Unknown). All Outbound contacts in the Unknown state will be reset to the Pending state (should be retrieved for dialing again) at midnight every night.

If there is an Outbound call in progress during a failover, they cannot be dialed again, as the call status is set to Closed as soon as an Outbound call is placed and these records will not be retrieved for dialing again when the system comes back. However, if the failover happened before the system could update the call status to Closed, these records remain in the Active state and are marked Unknown so they transition to Pending state after midnight. Once they are in the Pending state, they will be dialed again.
Cisco Unified Contact Center Express Supervisor and User Options Plug-Ins

The following sections provide detailed information on the additional plug-in options provided by the Unified CCX.

- About User Management, on page 251
- About Unified CCX User Capabilities, on page 251
- Unified CCX Supervisor Web Interface, on page 253
- Unified CCX User Options Web Interface, on page 254

About User Management

In earlier versions of Unified CCX, many user parameters like userID, password, and pin were configured from the Unified CM Administrator. Some Unified CCX-related user parameters were configured through the Unified CCX Administration.

In Unified CCX, all Unified CCX user roles (capabilities) are consolidated into one User Configuration area.

Note

Any changes made to the user privileges for the Unified CCX user roles after the backup operation is performed are not restored.

The Unified CM user details are stored in the Unified CM database.

About Unified CCX User Capabilities

The capability for each user refers to the Unified CCX access level assigned for each user. Unified CCX users can be assigned to one of the following four roles (or capabilities):

- Administrator
- Supervisor
- Historical Report User
- Agent
Each of these roles are described in this section.

**Administrator Privileges**

A Unified CCX Administrator is a user with complete access to the Unified CCX Administration and has the authority to configure the entire system. An Administrator can also be assigned a combination of other roles. The Administrator can turn on/off the authority of a Supervisor to manage the teams and agents.

**Supervisor Privileges**

Supervisors can additionally modify and view skills, view the list of all teams for which this user is the supervisor, view the skills, CSQs, and resource groups configured in this system, view and manage resources, and configure the teams that they are to manage.

Unified CCX provides three types of supervisors:

- **Application Supervisor**: A basic supervisor role applicable to a Unified CCX Application server *without* a Unified CCX license. An application supervisor can only view reports.

- **ACD Supervisor**: A supervisor with an agent role. This role is applicable to a Unified CCX Application server with *any* Unified CCX license. An ACD supervisor can administer teams/agents and also view reports. Thus Unified CCX enables dynamic reskilling, the ability by which an ACD supervisor can add or remove skills from an agent without an administrator privilege.

Depending on the license allowed, Unified CCX Supervisors have the following privileges:

- View reports through Unified Intelligence Center web client.
- View agents and CSQ being monitored. This is only for a remote Supervisor.
- View the list of all teams for which this user is the Supervisor.
- Configure the teams managed by the Supervisor.
- View the skills, CSQs, and Resource Groups configured in this system.

---

**Note**

The RmCm menu can be viewed by the Supervisor only when any of the following two options are selected as the parameter value for the Supervisor Access field located in **System > System Parameters > Application Parameters**:

- Access to all Teams
- Access to Supervisor's Teams only

- View and manage all the resources.

**Historical Report User Privileges**

A user with a historical report role can view various historical reports. The number and types of reports allowed to be viewed depends on the licenses available on a given Unified CCX system.
## Agent Privileges

An agent capability is only available with a Unified CCX license.

**Note**

Unified CM users in Unified CCX are assigned an agent role when an agent extension is associated to the user in the Unified CM User Configuration page. Consequently, this role can only be assigned or removed for the user using Unified CM Administrator End User Configuration web page. These users cannot be assigned or removed in Unified CCX Administration.

## Unified CCX Supervisor Web Interface

Use the Unified CCX Supervisor web page to:

- View and monitor permitted agents
- View and monitor permitted CSQs
- Access real-time reports, tools, and settings

## Access Unified CCX Supervisor Web Page

To access the Unified CCX Supervisor web page, perform the following steps:

**Procedure**

### Step 1
Ensure supervisor capability is assigned to the user designated as supervisor (see Supervisor Privileges and User View Submenu).

**Note**
If the supervisor is assigned administrator capability as well, the Unified CCX Administration window is opened instead of the Supervisor web page.

### Step 2
From a web browser on any computer on your network, enter the following case-sensitive URL:

https://<servername>/appadmin

In this example, replace <servername> with the hostname or IP address of the required Unified CCX server.

**Tip**
If you have already accessed the Unified CCX Administration application or Supervisor web page in the browser, be sure to logout from the current session using Logout link displayed in the top right corner of any Cisco Unified CCX Administration web page or System > Logout and login with respective user credentials.

The Unified CCX Supervisor web page appears.
Unified CCX User Options Web Interface

Use the Unified CCX User Options web page to perform:

- Unified CCX downloads
- Alternate pronunciations for call by name
- Access the Unified CM User web page

Access Unified CCX User Options Web Page

To access the Unified CCX User Options web page, perform the following steps:

**Procedure**

**Step 1**
From the Unified CCX Administration, enter `https://<Cisco Unified CCX IP address>/appusermain`

**Step 2**
If prompted to do so, enter your UserID and Password.

The Unified CCX User Options web page appears.

**Note**
Only Unified CM users are allowed to log in.

**Step 3**
When finished, click **Logout**.

Add Alternative Pronunciations

Alternative Pronunciations for Call by Name is an independent feature located on the Unified CCX User Options Welcome web page. This feature lets you add one or more alternate pronunciations for your first or last name and is useful if callers might refer to you by more than one name. For example, if your first name is Bob, you might add the alternate pronunciations “Bob” and “Bobby”. Similarly, if your last name is Xhu, you might add the alternate pronunciation “Xhu”.

To access the Alternative Pronunciations for Call by Name web page, perform the following steps:

**Procedure**

**Step 1**
In the Cisco Unified CCX User Options Welcome web page, choose User Options > Alternative Pronunciations for Call by Name.

The Alternate Pronunciations web page appears.
Step 2  In the First Name field, you can enter an alternate pronunciation of your first name. For example, if your name is “Mary,” you might enter “Maria.”

Step 3  Click Add>>.

The name moves to a list of alternate first name pronunciations.

Step 4  Repeat Steps 2 and 3 as needed to add other alternate pronunciations.

To remove an alternate pronunciation for your first name, click the alternate pronunciation and then click Remove.

Step 5  In the Last Name field, you can enter an alternate pronunciation of your last name. For example, if your last name is “Smith,” you might enter “Smitty.”

Step 6  Click Add>>.

The name moves to a list of alternate last name pronunciations.

Step 7  Repeat Steps 5 and 6 as needed to add other alternate pronunciations.

To remove an alternate pronunciation of your last name, click the alternate pronunciation and then click Remove.

Step 8  Click Save to apply the changes.

---

**Access Unified CM User Options Page**

To access the Unified CM User Options webpage, perform the following steps:

**Procedure**

Step 1  In the Unified CCX User Options Welcome web page, choose User Options > Cisco Unified CM User Page.

The Unified CM User Options Log On dialog box appears.

Step 2  Enter your Unified CM user ID and password, and then click Log On.

The Unified CM User Options web page appears.

Step 3  Click the option you want.

Step 4  When finished, click Logout.
System Menu

The System menu of the Unified CCX Administration system provides options for performing system-related tasks. Depending on the product package you purchased, the System menu contains some or all of the following menu options:

- Access Server Menu, on page 257
- Cloud Connect, on page 259
- Unified CM Configuration, on page 261
- System Parameters, on page 261
- Single Sign-On (SSO), on page 266
- Custom File Configuration, on page 268
- Standalone Cisco Unified Intelligence Center Configuration, on page 268
- License Management, on page 268
- Language Information, on page 277
- Logout Menu, on page 278

Access Server Menu

Choose System > Server from the Cisco Unified CCX Administration menu bar to access the List Servers web page. Use the List Servers web page to view, add, remove, and view servers in the cluster.

Note

Before installing Unified CCX on the second node, you must configure the second server using this procedure. Installation of second node will fail if you do not perform this configuration.

To view, modify, or delete the server configuration information of any server, click the respective hyperlink in the Host Name/IP Address field. The Server Configuration web page opens to display Host Name/IP Address, MAC Address, and Description of the server. Update the values in the fields and click Save to save the changes. Click Delete to delete the configuration information of a server.

Note

You cannot delete the publisher.
Configure Server

To configure a new server that needs to be added to form a Unified CCX cluster for a High Availability setup, complete the following steps.

Procedure

Step 1
Click the Add New icon in the toolbar in the upper left corner of the List Servers web page or the Add New button at the bottom of the List Servers web page to add the new server. The Server Configuration web page appears.

Note
• The Add New button is disabled when two servers are added to the cluster in a High Availability setup.
• A warning message appears when you click the Add New button without having a High Availability license.

Step 2
Complete the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Host Name/IP Address</td>
<td>Hostname or IP address of the server that you want to add.</td>
</tr>
<tr>
<td>MAC Address</td>
<td>MAC address of the server that you want to add.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the server that you want to add.</td>
</tr>
</tbody>
</table>

Step 3
Click Add to add details of the new server.

Server Deletion

This section describes how to delete a server from the Unified CCX. In Unified CCX administration, you cannot delete the first node that is also called as the publisher node, but you can delete the subscriber node.

Procedure

Step 1
Choose System > Server from the Cisco Unified CCX Administration menu bar to access the List Servers web page.

Step 2
Select the subscriber node and click Delete to delete the configuration information of the server.

Step 3
Power off the subscriber node.

Note
When a subscriber node is removed from a cluster, its certificates still exist in the publisher node. The administrator must manually remove the following:
• The certificate of the subscriber node from the trust-store of the publisher node.
• The certificates of the publisher from the trust-store of the removed subscriber node.
Step 4  
Run the `utils system restart` command to restart the publisher node.

---

**Cloud Connect**

Cloud Connect enables on-premise Unified CCX solution to integrate with different cloud services. The Cloud Connect services are responsible for interacting with Webex Experience Management (WXM) cloud service for presenting surveys to users and access analytics on the survey responses to understand the Customer Experience trends.

To use cloud services, memory requirement is different. If you do not have the required memory an error message is displayed. For the appropriate memory requirements, see *Solution Design Guide for Unified Contact Center Express* at [https://www.cisco.com/c/en/us/support/customer-collaboration/unified-contact-center-express/products-implementation-design-guides-list.html](https://www.cisco.com/c/en/us/support/customer-collaboration/unified-contact-center-express/products-implementation-design-guides-list.html).

Use the **Cloud Connect** page to perform the following:

- Check the status of Cloud Connect.
- Register and Deregister Unified CCX with Cisco Webex Cloud.
- Enable and Disable Cloud Services.
- Check Cluster Information.
- Check the status of the nodes in the cluster.

For more information, see **Cloud Connect** chapter in *Cisco Unified Contact Center Express Features Guide*.

**Actions**

The following table lists the actions that you can perform on this page:

<table>
<thead>
<tr>
<th>Action</th>
<th>Procedure</th>
</tr>
</thead>
<tbody>
<tr>
<td>Register</td>
<td>To use the Cisco Webex Cloud features.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong> Ensure that all the Prerequisites are met.</td>
</tr>
<tr>
<td></td>
<td>1. Select the <strong>I have received the email for the account creation in Cisco Webex Cloud and have successfully created an account in Cisco Webex Cloud</strong> checkbox.</td>
</tr>
<tr>
<td></td>
<td>2. Click <strong>Register</strong>. The <strong>Cisco Webex Control Hub</strong> page is displayed. Follow the on-screen instructions to register.</td>
</tr>
<tr>
<td>Deregister</td>
<td>Click <strong>Deregister</strong>. The <strong>Cisco Webex Control Hub</strong> page is displayed. Follow the on-screen instructions to deregister.</td>
</tr>
<tr>
<td>Deployment Name</td>
<td>Enter a name to identify the Unified CCX system. By default, <strong>Deployment ID</strong> is displayed.</td>
</tr>
</tbody>
</table>
Click **Test Connection** to check the Unified CCX connectivity with **Cisco Webex Cloud**. In a HA environment, the connection is tested for both the nodes.

To publish the Unified CCX data to a database that is available in cloud:

1. In the **Cluster Information** table, enter the **Deployment Name**.
2. In the **Cloud Services** table, select the **Enable** checkbox for **Data Streaming to Cisco Webex Cloud**.
3. Click **Update**.

### Cluster Information

The details of **Cluster Information** table are as follows:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Deployment ID</td>
<td>Mac address of the system.</td>
</tr>
<tr>
<td>Deployment Name</td>
<td>Name to identify the Unified CCX system.</td>
</tr>
<tr>
<td>HTTP Proxy</td>
<td>HTTP Proxy value that is used by Cloud Connect.</td>
</tr>
</tbody>
</table>

**Note**

If you have configured HTTP Proxy settings in the previous versions of Unified CCX, after upgrading, you must click **Update** to get the previously configured HTTP Proxy value.

If there is a mismatch of HTTP Proxy value between **System Parameters** page and **Cloud Connect** page, a **Warning** icon is displayed.

Click **Update** to get the updated proxy value.

### Cloud Services

You can enable and disable the cloud services that are listed. The following cloud service is available:

- **Data Streaming to Cisco Webex Cloud**

### Cluster Status

The **Cluster Status** table lists the **Host Name** and **Status** of each node. The status can be any one of the following:

- In Service
- In Maintenance
- Not Configured
- Out of Service
- Unknown
Adjacent to each status, there is a link to **View Status**. Click the link to download a text file that has the status details of the node. This file is used to debug issues with Cloud Connect.

## Unified CM Configuration

Choose **System > Unified CM Configuration** from the Unified CCX Administration menu bar to access the Unified CM Configuration web page.

Use the Unified CM Configuration web page to update the following information:

- The Unified CM AXL provider used for Unified CCX AXL requests for agent authentication and SQL queries.
- The Unified CM JTAPI provider used by the Unified CCX Engine Unified CM Telephony subsystem to control and monitor CTI ports and route points.
- The Unified CM RmCm - JTAPI provider used by the Unified CCX Engine RmCm subsystem to control and monitor the agent phones and extensions.

**Related Topics**

- [Configure Unified Communications Manager Information](#), on page 23

## System Parameters

**Note**

When you configure a parameter for the primary node, same value is reflected for the secondary node.

The System Parameters configuration web page displays the following fields.

### Table 12: System Parameters

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Generic System Parameters</strong></td>
<td></td>
</tr>
<tr>
<td>System Time Zone</td>
<td>The system or primary time zone will be the same as local time zone of the primary Unified CCX node configured during installation. Display only. Unified CCX Administration uses this primary time zone to display time-related data.</td>
</tr>
<tr>
<td><strong>Note</strong></td>
<td>If you have changed the primary time zone, you must reboot both the nodes in the Unified CCX cluster.</td>
</tr>
<tr>
<td><strong>Network Deployment Parameters</strong></td>
<td>Displayed only in a HA over WAN deployment</td>
</tr>
<tr>
<td>Network Deployment Type</td>
<td>Displays the network deployment type as LAN or WAN only if we have more than one node. Display only.</td>
</tr>
<tr>
<td><strong>Internationalization Parameters</strong></td>
<td></td>
</tr>
</tbody>
</table>
### System Parameters

#### Field | Description
--- | ---
Customizable Locales | Use to specify a unique locale.  
Default value is blank.

Default Currency | Default currency, such as American dollars (USD), Euros, and so on. This is a mandatory field.  
The system uses the default currency for converting currency amounts in a playable format when no currency designator is specified.  
Default: American Dollar [USD]

### Media Parameters

#### Codec
The Codec chosen during installation for this Unified CCX server.  
Unified CCX supports packetization intervals of 20 ms, 30 ms, or 60 ms.  
Default value is 30 ms.

**Note**  
After changing the Codec, ensure that you restart Unified CCX Engine on all nodes for the settings to take effect.

#### MRCP Version
Select appropriate version of the protocol for ASR and TTS. When you select **MRCPv1** or **MRCPv2**, ensure that the appropriate port changes are done for MRCP ASR and MRCP TTS Servers.

**Note**  
When you upgrade, the default value is **MRCPv1**.  
After changing the MRCP version, ensure that you restart Unified CCX Engine on all nodes for the settings to take effect.

#### Default TTS Provider
Default TTS (Text-to-Speech) provider.  
Default: By default, no TTS provider is configured. Select a provider from the drop-down list to configure it as the default. The system uses the default TTS provider to determine which provider to use if the TTS request does not explicitly specify the provider to use.

#### User Prompts override System Prompts
When enabled, custom recorded prompt files can be uploaded to the appropriate language directory under Prompt Management to override the system default prompt files for that language. By default, this is disabled.
SRTP (Secure Real-Time Protocol) protects the confidentiality of the media with cryptographic procedures.

When enabled, a secure media for communication (SRTP) is established between callers and CTI port. Before you enable SRTP, ensure that the CUCM Cluster Security Mode is set to Mixed mode.

**Note**

When SRTP is enabled, a secure JTAPI connection is established between the following subsystems and Unified CM:

- Unified CM Telephony
- RmCm

After enabling or disabling SRTP, ensure that you restart Unified CCX Engine on all nodes for the settings to take effect.

An SRTP-enabled HA setup requires distinct RmCm provider users. So, the system generates a separate **RmCm Provider User Id** with suffix “_ccxsub” for the subscriber node. Associate devices and profiles only with the **RmCm Provider User Id** that is configured in the **Cisco Unified CM Configuration** page. If you associate devices or profiles with the system-generated **User Id**, the associations of those devices and profiles are deleted during data synchronization.

### Application Parameters

**Supervisor Access**

The Administrator uses this option to allow certain privileges to supervisors (all supervisors have the same privilege). The options are:

- No access to teams—The supervisor logs into the Supervisor page, but will not be able to see any team information (No RmCm info).
- Access to all teams—The supervisor logs into the Supervisor page, and will be able to see all the teams (RmCm information).
- Access to supervisor teams only—The supervisor logs into the Supervisor page, and can see the teams that they supervise. When this option is selected, only the Primary Supervisor can see the team-specific information. The secondary supervisor will not be able to see the team-specific information.

Default: No access to teams

**Note**

A supervisor who does not have administrator privileges can add, modify, or remove skills from an agent.

**Max Number of Executed Steps**

The maximum number of steps an application can execute before the Unified CCX Engine terminates the script or application. This is a mandatory field. This limitation is intended to prevent a script from running indefinitely.

Default value is 1000.

**Note**

Do not change the default value.
<p>| Field                        | Description                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                 |</p>
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of Direct Preview Outbound seats</td>
<td>The maximum number of Direct Preview Outbound seats. The configuration of Outbound seats is done during the initial configuration or setup phase, after the installation. <strong>Note</strong>: This is a mandatory field. This field is displayed only if you have a Premium license. The maximum number of direct preview outbound seats that can be configured is limited by the Premium Seat Count. If there is an invalid entry during configuration, an error message is displayed.</td>
</tr>
<tr>
<td>Live Data - Short Term Reporting Duration</td>
<td>This parameter applies to Live Data reports that are available to agents and supervisors on Finesse desktops. For certain fields in the live data reports, you can set a short-term value to 5, 10 or 15 minutes. Long-term value is always set to 30 minutes.</td>
</tr>
<tr>
<td>Persistent Connection</td>
<td>Radio button that determines whether to establish persistent connection to a remote device. The options are: • Enable (default)—Establishes persistent connection. • Disable—Does not establish persistent connection.</td>
</tr>
</tbody>
</table>

### System Ports Parameters

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>RMI Port</td>
<td>The port number used by the Unified CCX CVD to serve RMI requests. This is a mandatory field. Default value is 6999. <strong>Note</strong>: After changing the RMI Port, ensure that you restart the system for the settings to take effect. On a high availability setup, restart both the nodes.</td>
</tr>
<tr>
<td>RmCm TCP Port</td>
<td>TCP port number on which the CTI server component of the RmCm subsystem opens the server socket and listens to the clients. All CTI server clients, such as Sync Server, and IP Phone Agent Server, use this port number. This is a read-only field and cannot be modified. Default value is 12028.</td>
</tr>
</tbody>
</table>

### Proxy Parameters

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>HTTP</td>
<td>• <strong>Host Name</strong>: Fully qualified domain name (FQDN) of the HTTP proxy server. Do not enter the IP address. • <strong>Port</strong>: Port number that is used to connect to the HTTP proxy server. Range is from 1 to 65535.</td>
</tr>
</tbody>
</table>
Single Sign-On (SSO)

Use Single Sign-On (SSO) page to register, test, enable, and disable Single Sign-On.

Before you begin

Ensure you access the Cisco Unified CCX Administration page through a Fully Qualified Domain Name URL instead of IP address.

You need to configure Cisco Identity Service and enable trust relationship between Cisco Identity Service and Identity Provider.


If Cisco Identity Service is not configured, it displays the status as **Cisco Identity Service is not configured** and provides the link to configure or update. Click here to update Cisco Identity Service configuration. The steps 2 to 4 are disabled till the Cisco Identity Service is configured. The changes take effect when the page is refreshed.

If Cisco Identity Service is configured, it displays the status as **Cisco Identity Service is configured successfully with the link to update**. Click here to update Cisco Identity Service configuration.

Procedure

**Step 1**

Choose **System > Single Sign-On (SSO)** from the Unified CCX Administration menu to access the Single Sign-On page.

The page displays the Cisco Identity Service configuration status, options to register, test, enable, and disable Single Sign-On.

*Note* If the **Cisco Identity Service is configured successfully**, then the **Register** option is enabled.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| SOCKS Proxy    | • **Host Name**: Fully qualified domain name (FQDN) of the SOCKS proxy server.  
                          Do not enter the IP address.                                                 |
|                | • **Port**: Port number that is used to connect to the SOCKS proxy server.    
                          Range is from 1 to 65535.                                                  |
| SOCKS Username | Username of the SOCKS proxy server.                                          |
| SOCKS Password | Password of the SOCKS proxy server.                                          |

**Related Topics**

- [Manage System Parameters](#), on page 139
**Step 2** Click **Register** on the Single Sign-On page to onboard the Single Sign-On components. A status message is displayed on the screen to notify the status of the registration of the components. A **red** color icon indicates failure in the executed operation. A **green** color icon indicates success in executed operation. A **grey** color icon indicates the inability to capture the status of the executed operation.

**Step 3** Perform all the following prerequisites before the **SSO Test**. All the check boxes have to be checked for the **Test** option to be enabled.

a) Configure and Perform LDAP Sync in Cisco Unified CM.

b) Assign Cisco Unified CCX Administrator rights to one or more Enterprise users.

c) Assign Reporting Capability to Cisco Unified CCX Administrator (assigned in Administrator Capability View) and execute CLI command `utilscuicusermake-admin CCX:<Admin’s UserID>` to provide administrator rights to the Cisco Unified CCX Administrator in Cisco Unified Intelligence Center. Use the configured user with Unified CCX Administrator rights for the SSO Test operation.

**Note**

- Ensure that the browser based pop-up blocker is disabled for the SSO Test to work.

- For the SSO Test to be successful, the root domain of both the Unified CCX nodes must be the same.

**Step 4** Click **Test** on the Single Sign-On page to test the status of registration of each component. You will be redirected to the Identity Provider for authentication.

A status message is displayed on the screen to notify the test status of the registered components. Single Sign-On test results are not persisted and will be lost when the page is reloaded. If the SSO Test is successful then the **Enable** option is enabled.

**Step 5** Click **Enable** on the Single Sign-On page to enable each component for Single Sign-On.

**Note**

- When SSO is enabled and if the enterprise user is unable to log in, the recovery URLs can be used to log in. For troubleshooting purpose the enterprise user or system user chosen during the installation can login to Unified CCX Administration and Unified CCX Serviceability through the following recovery URL to bypass the enterprise Identity Provider and Cisco Identity Service. However, this is not possible when SSO is enabled and normal login URL is used.

  - **URL for Cisco Unified CCX Administration**:
    https://<ipaddress/fqdn>/appadmin/recovery_login.htm

  - **URL for Cisco Unified CCX Serviceability**:
    https://<ipaddress/fqdn>/uccxservice/recovery_login.htm

  - To disable SSO in an SSO enabled Cisco Unified Contact Center Express solution, click **Disable** on the **Single Sign-On (SSO)** page. After SSO is disabled, you have to perform **SSO Test** again to enable SSO.

The page displays the status of each component being enabled for Single Sign-On or not.

---

You may close this page and open a new window of the browser to access the Cisco Unified CCX Administration. This automatically redirects you to the page to enter your credentials for the authentication with the Single Sign-On identity provider.
Custom File Configuration

Use the Custom Classes Configuration web page to specify the classpath for custom classes.

Choose **System > Custom File Configuration** from the Unified CCX Administration menu bar to access the Custom Classes Configuration area.

**Note**
Restart Unified CCX engine and Unified CCX administration services to use the custom files in scripts.

Standalone Cisco Unified Intelligence Center Configuration

To access the Cisco Unified Intelligence Center standalone configuration webpage, perform the following steps:

**Procedure**

**Step 1** Click **System > Standalone CUIC configuration** for configuring standalone CUIC.

**Step 2** Enter FQDN (Fully Qualified Domain Name), DataSource Name, Username, and Password of standalone CUIC.

**Step 3** Click **Save**.

A Status message will be displayed.

**Note**
Asterisk (*) indicates the required fields.

If the configuration is successful, a status message will be displayed. If the configuration is not successful, an error message will be displayed. This can be due to:

- An error in input validation (DataSource Name, Username or Password).
- A failure in connectivity between the CUIC and the Unified CCX servers.

License Management

From the Unified CCX Administration menu bar, select **Systems > License Management**. Based on the upgrade and usage scenarios, one of the following pages is displayed:

<table>
<thead>
<tr>
<th>Page Displayed</th>
<th>Condition</th>
</tr>
</thead>
<tbody>
<tr>
<td>License Management</td>
<td>For customers who have upgraded from Unified CCX Release 11.6(2) or earlier.</td>
</tr>
<tr>
<td>Classic License Management</td>
<td>For customers who have upgraded from Unified CCX Release 12.0.</td>
</tr>
</tbody>
</table>
**Smart Licensing**  
This page is available only for the following customers:  
- Who want to migrate from Classic Licensing to Smart Licensing.  
- Who have done the fresh install of Unified CCX Release 12.5.

**Smart License Management**  
For customers who have enabled or migrated to Smart Licensing.

Use this page to select the appropriate Unified CCX license. This page lists **Classic Licensing** and **Smart Licensing** options. By default, **Smart Licensing** is selected.

**Procedure**

Select one of the licenses and click **Next**.

This page is displayed for the first time after the upgrade. After you select one of the licenses, from the next login, **Classic License Management** or **Smart License Management** page is displayed respectively.

---

**Classic License Management**

Use this page to manage Classic License (Add, View, and Delete).

**Add License**

To add a new license, perform the following steps:

1. From the Unified CCX Administration menu bar, select **Systems > License Management**. The **Classic License Management** page is displayed.

2. On the **Classic License Management** page, in the **Add New License** section, click **Browse** to select the Unified CCX license file.

3. Select the appropriate license file and click **Upload**.

**View License Information**

On the **Classic License Management** page, you can view the license files and the details of the configured licenses in the **View Licenses** section. You can select an uploaded license from the **Licenses** drop-down list. When you select **Cumulative License Information** from the list, the following details are listed:

- **Configured Licenses**  
  - Package  
  - Total IVR Ports  
  - Cisco Unified CCX Premium Seats  
  - High Availability
• Cisco Unified CCX Preview Outbound Dialer
• Cisco Unified CCX Quality Manager Seats
• Cisco Unified CCX Advanced Quality Manager Seats
• Cisco Unified CCX Workforce Manager Seats
• Cisco Unified CCX Compliance Recording Seats
• Cisco Unified CCX Maximum Agents

• Inbound
  • Available Inbound IVR Ports

• Outbound
  • Cisco Unified CCX Licensed Outbound IVR Ports
  • Cisco Unified CCX Outbound IVR Ports In Use
  • Cisco Unified CCX Licensed Outbound Agent Seats
  • Cisco Unified CCX Outbound Agent Seats In Use

**Note**
All the license details that are mentioned may not be displayed. The license details are displayed as per the procurement.

**Delete Licenses**
You can delete only temporary licenses. You cannot delete permanent licenses. To delete a temporary license, select the required license from the Licenses drop-down list and click **Delete**. Click **OK** in the confirmation dialog box.

**Note**
It is a good practice to remove redundant or expired license files before you upload new ones. Remove old temporary license files (that are expired) from the server. For the changes to take effect, you must reboot Unified CCX after uploading or deleting the licenses.

**Migrate to Smart Licensing**
To migrate to smart licensing, on the Classic License Management page, click **Smart Licensing**.

**Smart Licensing**
Use this page to select and enable the appropriate **Smart License Type**. After you enable the required **Smart License Type**, from the next login, **Smart License Management** page is displayed. The license types that are listed and available for selection depends on the type of installation.
Procedure

Step 1
Select one of the following license types:

- Unified IP IVR
- Unified CCX
  - Lab
    - NPS
    - NFR
- Production
  - Flex
  - Perpetual Enhanced
  - Perpetual Premium
- HCS
  - Flex(HCS)

Note: For more information on the license types, see Cisco Contact Center Ordering Guide.

Step 2
Click Enable.
A confirmation message is displayed.

Step 3
Click Yes to enable Smart Licensing.

What to do next
You must register this Product Instance with Cisco Smart Software Manager to use Smart Licensing.

Smart License Management

The Smart License Management page provides the summary and detailed information on system license usage as it is reported to Cisco Smart Software Manager (Cisco SSM) or Cisco Smart Software Manager On-Prem (Cisco SSM On-Prem). Licenses are assigned to your Smart Account and are not node-locked to a device. That is, a single license can be used by multiple users but only one at a time.

Note: The same license can be used across multiple systems (nodes) but only on one node at a time.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status</td>
<td>Displays the status of the actions that are performed on this page.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>License Type Details</strong></td>
<td></td>
</tr>
<tr>
<td>Current License Type</td>
<td>Displays the type of license that was selected in the Enable Smart Licensing page. To select a different license type, click the link. The Enable Smart Licensing page is displayed.</td>
</tr>
<tr>
<td><strong>License Control</strong></td>
<td></td>
</tr>
<tr>
<td>Current License Type</td>
<td>Displays the type of license that was selected in the Enable Smart Licensing page.</td>
</tr>
<tr>
<td>Overage Allowance</td>
<td>You can Enable or Disable. By default Enable is selected, which allows you to use more licenses than you have purchased. If you want to limit the usage of licenses to the purchased quantity or less, select Disable. Enter the number that you want to allow in the fields that are displayed as per the Current License Type. For more information on license types, see the Overview section of Smart Licensing chapter in Cisco Unified Contact Center Express Features Guide.</td>
</tr>
<tr>
<td>I have purchased High Availability License</td>
<td>If you have deployed a HA, this check box is displayed, which has to be selected.</td>
</tr>
<tr>
<td><strong>Registration Information</strong></td>
<td></td>
</tr>
<tr>
<td>Use Transport Settings button to configure different settings through which Cisco Unified CCX can connect to Cisco SSM or Cisco SSM On-Prem.</td>
<td></td>
</tr>
<tr>
<td>Register</td>
<td>Use the Register button to register Cisco Unified CCX with Cisco SSM or Cisco SSM On-Prem. By default this button is disabled. You have to first configure Transport Settings to enable this button. After you successfully register, this button is disabled.</td>
</tr>
<tr>
<td><strong>Smart License Details</strong></td>
<td></td>
</tr>
</tbody>
</table>
### Field | Description
--- | ---
Registration Status | Displays the current registration status. The following are the statuses:
- Registered
- Unregistered or Unidentified
- Unregistered-Registration Expired
- Reservation In Progress
- Registered - Specific License Reservation

Authorization Status | Displays one of the following status information:
- Evaluation mode—Product is not registered with Cisco.
- Evaluation Expired—Product evaluation period has expired.
- In Compliance—Product is in authorized or in compliance state.
- Not Authorized—Product is in not-authorized state.
- Authorization Expired—Authorization has expired for the product. This issue usually occurs when the product has not communicated with Cisco for 90 consecutive days. After 90-days, the product instance is put into Enforcement state.
- Out of Compliance—Product is in out-of-compliance state because of insufficient licenses.
- Unidentified—Unable to determine current registration status.

Smart Account Name | Displays the Smart Account name. It is created from the **Request a Smart Account** option in **Administration** section of the [software.cisco.com](http://software.cisco.com). It is the primary account that is created to represent the customer and all licenses of a company are assigned to this Smart Account. It also manages licenses of all Cisco products.

Virtual Account Name | Displays a self-defined construct to reflect the organization, which is created and maintained by the administrator on Cisco SSM or Cisco SSM On-Prem. Licenses and product instances can be distributed across virtual accounts.

Serial Number | Unique identifier of the product instance.
### Field: Export-Controlled Functionality

Displays one of the following status information:

- **Allowed**—Cisco Unified CCX registered to Smart Account that allows export-controlled functionality.
- **Not Allowed**—Cisco Unified CCX not registered to Smart Account that allows export-controlled functionality.

Specifies if the Export-Controlled functionality was enabled in the token with which the product was registered.

**Note**  
The Allow export-controlled functionality on the products that are registered with this token check box is not displayed for the Smart Accounts that are not permitted to use the Export-Controlled functionality.

### Field: Actions

This drop-down list gets activated after you successfully register the Smart License. It lists the following type of actions that can be performed:

- **Renew Authorization**—Use this option to manually renew the authorization.
  
The license authorization is renewed automatically every 30 days. If the product instance is not connected to Cisco SSM or Cisco SSM On-Prem, the authorization expires after 90 days.
  
  If you select the Cisco SSM On-Prem option, Cisco SSM On-Prem must have an internet connection to connect to Cisco SSM for authorization.

- **Renew Registration**—Use this option to manually renew the registration.
  
The initial registration is valid for one year. Registration is automatically renewed every six months, provided the product is connected to Cisco SSM or Cisco SSM On-Prem. If the Cisco SSM On-Prem option is selected, Cisco SSM On-Prem must have an internet connection to connect to Cisco SSM.

- **Reregister**—When you select this option, the **Smart Licensing Product Registration** window is displayed. Enter the appropriate Product Instance Registration Token and click **Reregister**.

- **Deregister**— Use this option to deregister Unified CCX from Cisco SSM or Cisco SSM On-Prem and release all the licenses from the current virtual account. All license entitlements that are used for the product instance are released to the virtual account and is available for other product instances.

  **Note**  
  If Unified CCX is unable to connect to Cisco SSM or Cisco SSM On-Prem, and the product instance is deregistered, a confirmation message is displayed. This message notifies you to remove the product instance manually from Cisco SSM or Cisco SSM On-Prem to free up licenses.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>License Name</td>
<td>Displays the different licenses as per the license type that is selected in the Smart Licensing page.</td>
</tr>
<tr>
<td>Reported Usage</td>
<td>Displays the number of licenses that are used by this product instance as per the details that was last reported.</td>
</tr>
</tbody>
</table>
| Status        | Displays the status of each license. The different statuses for the product instance are as follows:  
|               | • Authorization Expired—The authorized period has expired.  
|               | • Evaluation—This entitlement is in Evaluation mode.  
|               | • Evaluation Expired—Evaluation period has expired.  
|               | • In-compliance—In-compliance (authorized).  
|               | • No License in Use—There are no licenses that are in use.  
|               | • Invalid—In Error state.  
|               | • Invalid Tag—The entitlement tag is invalid.  
|               | • Not Applicable—Enforcement mode is not applicable.  
|               | • Out of Compliance—Out-of-compliance (unauthorized).  
|               | • Waiting—Waiting response from Cisco SSM or Cisco SSM On-Prem for entitlements that are submitted.                                    |

**Configure Transport Settings for Smart Licensing**

Configure the connection mode between Unified CCX and Cisco SSM.

**Procedure**

**Step 1** From Unified CCX Administration, navigate to **System > License Management**.

**Step 2** Click **Transport Settings** to set the connection method.

**Step 3** Select the connection method to Cisco SSM:

- **Direct**—Unified CCX connects directly to Cisco SSM on cisco.com. This is the default option.

- **Transport Gateway**—Unified CCX connects to Cisco SSM On-Prem for smart licensing. Enter the Cisco SSM On-Prem URL.

- **HTTP/HTTPS Proxy**—Unified CCX connects to a proxy server, which connects to Cisco SSM. Enter the IP address or hostname of the proxy server along with the port.

**Step 4** Click **Save** to save the settings.
Register with Cisco Smart Software Manager

The product instance has 90 days of evaluation period, within which, the registration must be completed. Else, the product instance gets into the enforcement state.

Register your product instance with Cisco SSM or Cisco SSM On-Prem to exit the Evaluation or Enforcement state.

---

**Procedure**

**Step 1**
In , navigate to Overview > Infrastructure Settings > License Management.

**Step 2**
From Unified CCX Administration, navigate to System > License Information.

**Step 3**
Click Register.

*Note* Before you register the product instance, ensure to select the License Type and the communication mechanism in Transport Settings.

**Step 4**
In the Smart Software Licensing Product Registration dialog box, paste the product instance registration token that you generated from Cisco SSM or Cisco SSM On-Prem.

For information on generating the Registration Token, see the Obtain the Product Instance Registration Token section in Cisco Unified Contact Center Express Features Guide.

License Control pane is displayed with the Overage Allowance option. By default Enable is selected, which allows you to use more licenses than you have purchased.

If you want to limit the usage of licenses to the purchased quantity or less, select Disable. Enter the number that you want to allow in the fields that are displayed as per the Current License Type.

If you have deployed a HA, the I have purchased High Availability License check box is displayed, which has to be selected.

For more information on license types, see the Overview section of Smart Licensing chapter in Cisco Unified Contact Center Express Features Guide.

**Step 5**
Click Register to complete the registration process.

After registration, the Smart Licensing Status displays the following details.

***Table 13: Smart Licensing Status***

<table>
<thead>
<tr>
<th>Smart License Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>On Unsuccessful Registration</td>
<td></td>
</tr>
<tr>
<td>Registration Status</td>
<td>Unregistered</td>
</tr>
<tr>
<td>License Authorization Status</td>
<td>Evaluation</td>
</tr>
<tr>
<td>Smart License Status</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------------</td>
<td>----------------------</td>
</tr>
<tr>
<td>Export-Controlled Functionality</td>
<td>Not Allowed</td>
</tr>
</tbody>
</table>

**On Successful Registration**

<table>
<thead>
<tr>
<th>Status</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Registration Status</td>
<td>Registered (Date and time of registration)</td>
</tr>
<tr>
<td>License Authorization Status</td>
<td>Authorized (Date and time of authorization)</td>
</tr>
<tr>
<td>Export-Controlled Functionality</td>
<td>Not Allowed</td>
</tr>
<tr>
<td>Smart Account</td>
<td>The name of the smart account</td>
</tr>
<tr>
<td>Virtual Account</td>
<td>The name of the virtual account</td>
</tr>
<tr>
<td>Product Instance Name</td>
<td>The name of the product instance</td>
</tr>
<tr>
<td>Serial Number</td>
<td>The serial number of the product instance</td>
</tr>
</tbody>
</table>

Entitlements are a set of privileges customers and partners receive when purchasing a Cisco service agreement. Using Smart Licensing, you can view the License consumption summary for the entitlements of different license types. The License consumption summary displays the License Name, Usage Count, and Status against each entitlement name.

License usage information is updated automatically every 15 minutes.

For more information, see *License Information*.

---

**Language Information**

Customized Unified CCX languages such as American English, Canadian French, and so on are installed with Unified CCX.

Use the Languages Configuration web page to:

- Enable languages that can be used to play prompts and grammars through Cisco Unified IP IVR.

Choose **System > Language Information** from the Cisco Unified CCX Administration menu bar to access the Languages Configuration web page. The Languages Configuration web page opens to display the following fields and buttons.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Choose IVR Language</td>
<td></td>
</tr>
</tbody>
</table>
You can choose a language that you wish to use with Unified IP IVR. You can select the language from the drop-down list. You can also specify the group and country-specific information for the language by selecting the desired radio button and check box respectively. Some languages have only one choice. US English (en_US) is the default.

You may set the chosen language in Set IVR Language option. The chosen language doesn't get automatically set and the value is not persisted after it is chosen.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Language</td>
<td>You can choose a language that you wish to use with Unified IP IVR. You can select the language from the drop-down list. You can also specify the group and country-specific information for the language by selecting the desired radio button and check box respectively. Some languages have only one choice. US English (en_US) is the default. You may set the chosen language in Set IVR Language option. The chosen language doesn't get automatically set and the value is not persisted after it is chosen.</td>
</tr>
<tr>
<td>Set IVR Language</td>
<td>This field is for setting the IVR language, which could be either one of the selected IVR languages or country-specific or a user-defined language entered using the Edit button. This is a mandatory field and you can choose from the drop-down list. Click Edit to add a new Language option. Default: English (United States) [en_US]</td>
</tr>
</tbody>
</table>

Logout Menu

To exit Unified CCX Administration without closing your web browser, you can perform one of the following:

- Choose System > Logout from the Unified CCX Administration menu bar.
- Click the Logout link displayed in the top right corner of any Cisco Unified CCX Administration web page.

The system logs you out of Unified CCX and displays the Unified CCX Authentication web page.

Note: You can also exit Unified CCX Administration by closing your web browser.
Applications Menu

The Applications menu on the top contains the following menu options:

- **Application Management**—to add, configure, copy, delete, or refresh a specific application
- **Script Management**—to add a new script and to view, refresh, upload, or delete an existing script
- **Prompt Management**—to display, modify, or delete existing prompts, and to add new prompts
- **Grammar Management**—to display, modify, or delete existing grammars, and to add new grammars
- **Document Management**—to display, modify, or delete existing documents, and to add new documents
- **AAR Management**—to upload AAR files to Unified CCX
- **Calendar Management**—to create a new calendar, configure, and schedule the contact center business hours

The following sections describe the menu options:

- Access Application Management Menu, on page 279
- Manage Scripts, on page 280
- Prompt Management, on page 280
- Grammar Management, on page 281
- Document Management, on page 281
- AAR Management, on page 282
- Calendar Management, on page 282

### Access Application Management Menu

The Application Management menu option in the Unified CCX Administration web interface contains options for configuring and managing the applications the Unified CCX system uses to interact with contacts and perform a wide variety of functions.

To access the Application Management web pages, perform the following steps:

**Procedure**

**Step 1** From the Unified CCX Administration menu bar, choose Applications > Application Management.
The Applications Configuration web page opens, displaying a list of applications that are currently configured on your Unified CCX server.

Step 2 Click the **Add New** icon that displays in the toolbar in the upper left corner of the window or the **Add New** button that displays at the bottom of the window to add a new application. Add a New Application web page opens.

Step 3 Select the type of application that you want to create from the Application Type drop-down list.

---

**Manage Scripts**

Use the Script Management web page to add a new script and to rename, refresh, or delete an existing script. Unified CCX applications are based on scripts created in the Unified CCX Editor.

To create a new subfolder under the default folder, perform the following steps:

**Procedure**

**Step 1** To access the Script Management web page, choose Applications > Script Management from the Unified CCX Administration menu bar.

The Script Management web page opens, displaying the default directory that contains the scripts uploaded to the repository.

**Step 2** Click the **Create New Folder** icon that displays in the toolbar in the upper left corner of the window or the **Create New Folder** button that displays at the bottom of the window.

The Create New Folder dialog box opens.

**Step 3** Enter a name of the new subfolder in the **Folder Name** field and click **Create**.

Once the folder is successfully created, the dialog box refreshes with the following message:

**Folder successfully created**

**Step 4** Click the **Return to Script Management** button to return to the default folder's updated Script Management page. You can create any number of folders within the default folder.

---

**Prompt Management**

Several system-level prompt files are loaded during Unified CCX installation. However, any file you create must be made available to the Unified CCX Engine before a Unified CCX application can use them. This is done through the Unified CCX cluster's Repository datastore, where the prompt files are created, stored, and updated.

**Note** You can use a custom script or the Unified CCX Administration to upload a prompt.
To access the Prompt Management page, choose **Applications > Prompt Management** from the Unified CCX Administration menu bar.

The Prompt Management web page contains the following icons and buttons:

- **Create Language**—Click the **Create Language** icon that displays in the toolbar in the upper left corner of the window or the **Create Language** button that displays at the bottom of the window to create a new language folder.

- **Upload Zip Files**—Click the **Upload Zip Files** icon that displays in the toolbar in the upper left corner of the window or the **Upload Zip Files** button that displays at the bottom of the window to upload a new prompt or zip file.

See **Manage Prompt Files** section to know more about the different fields in this page and how to rename, refresh, or delete existing prompts.

**Related Topics**

- **Manage Prompt Files**, on page 117

---

**Grammar Management**

Several system-level grammar files are loaded during Unified CCX installation. However, any file you create must be made available to the Unified CCX Engine before a Unified CCX application can use them. This is done through the Unified CCX cluster's Repository datastore, where the grammar files are created, stored, and updated.

To access the Grammar Management page, choose **Applications > Grammar Management** from the Unified CCX Administration menu bar.

The Grammar Management web page contains the following icons and buttons:

- **Create Language**—Click the **Create Language** icon that displays in the toolbar in the upper left corner of the window or the **Create Language** button that displays at the bottom of the window to create a new language folder.

- **Upload Zip Files**—Click the **Upload Zip Files** icon that displays in the toolbar in the upper left corner of the window or the **Upload Zip Files** button that displays at the bottom of the window to upload a new grammar or zip file.

---

**Document Management**

Several system-level document files are loaded during Unified CCX installation. However, any file you create must be made available to the Unified CCX Engine before a Unified CCX application can use them. This is done through the Unified CCX cluster's Repository datastore, where the document files are created, stored, and updated.

To access the Document Management page, choose **Applications > Document Management** from the Unified CCX Administration menu bar.

The Document Management web page contains the following icons and buttons:
• **Create Language**—Click the Create Language icon that displays in the toolbar in the upper left corner of the window or the Create Language button that displays at the bottom of the window to create a new language folder.

• **Upload Zip Files**—Click the Upload Zip Files icon that displays in the toolbar in the upper left corner of the window or the Upload Zip Files button that displays at the bottom of the window to upload a new document or zip file.

---

**Note**

Ensure that you do not upload any .jar files that are already used by Unified CCX. For the list of .jar files that are used, refer to the specific versions of the Open Source Used In UCCX document.

---

**AAR Management**

Use the AAR Management web page to upload an AAR file to Unified CCX.

To access the AAR Management web page, choose Applications > AAR Management from the Unified CCX Administration menu bar. The AAR Management web page appears.

**Calendar Management**

Use the Calendar Management section to create a new calendar. You can also configure and schedule business hours such as start and end time for business days, special days, and holidays.

To create and configure a Calendar, complete the following steps:

**Procedure**

**Step 1**
From the Unified CCX Administration menu bar, choose Applications > Calendar Management.

The Calendar Management web page opens and displays the information for existing calendars, if any.

**Step 2**
To add a new calendar, click the Add New icon or the Add New button.

The Add New Calendar web page opens.

**Step 3**
In the Calendar Details section, specify the following information:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique name of the calendar.</td>
</tr>
<tr>
<td>Description</td>
<td>Calendar description.</td>
</tr>
<tr>
<td>Time Zone</td>
<td>Time zone for the calendar.</td>
</tr>
</tbody>
</table>

The following information is available to view:
### Table 14:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Associated with</td>
<td>Lists the names of applications and chats that are associated with the calendar.</td>
</tr>
</tbody>
</table>

#### Step 4

In the **Business Hours** section, select one of the following options to configure the Business Days.

- **24 hours x 7 days** - The service is available 24 hours a day, 7 days a week.
- **Fixed Hours** - Administrator can configure a fixed time range for the entire week as per the business requirements.
- **Flexible Hours** - Administrator can configure a flexible time range for each of the business days as per the business requirements.

**Note**

- The **Custom Business Hours Schedule Configuration** is based on the Unified CCX server time zone.
- During an upgrade of Unified CCX, by default the **24 hours x 7 days** is selected as the **Business Days**.

#### Step 5

Click **Next**.

#### Step 6

In the **Schedule Custom Business Days** section, specify the name, date, and configure business hours for a custom business day.

**Note**

Scheduling business hours for a custom business day overrides any previous schedule that was configured in **Custom Business Hours** for the same day.

a) To add more custom business days, click **Add More**. Click the delete icon to delete a custom business day.

#### Step 7

Click **Next**.

#### Step 8

In the **Schedule Holidays** section, configure holidays.

a) To add more holidays, click **Add More**. Click the delete icon to delete a configured holiday.

#### Step 9

Click **Finish** to save the configuration.

**Note**

- A maximum of 50 Calendars can be configured.
- A maximum of 40 Custom Business Days and Holidays each can be configured.

---

### Calendar Flow

An example of the calendar step is as follows:

**Procedure**

#### Step 1

Use the **Calendar Step** of Unified CCX Editor in any of the scripts.
Step 2  Create a new variable NewCalendar of type CxCCalendar.
Step 3  Save the script in an appropriate location.
Step 4  Upload the script in Unified CCX Administration.
         You can also modify and save the uploaded scripts.
Step 5  Navigate to Applications > Calendar Management.
Step 6  Create a new calendar HolidayCalendar.
Step 7  Navigate to Applications > Application Management.
Step 8  Select an application from the list or create an application.
Step 9  Select the script that has been uploaded.
Step 10 Select the calendar variable NewCalendar.
Step 11 Select HolidayCalendar from the list and save to associate the calendar with the application.
Step 12 Assign the HolidayCalendar to the appropriate supervisor.
         You can assign one calendar to multiple supervisors.

The HolidayCalendar is now available in the Calendar Management tab of Advanced Supervisor Capabilities in Finesse Desktop, which can be edited by supervisors. If you have not associated HolidayCalendar in UCCX Administration, supervisors can associate it by using the Manage Application from the Application Management tab of Advanced Supervisor Capabilities in Finesse Desktop.
The Subsystems menu of the Unified CCX Administration web interface provides access to the subsystems that are licensed for your Unified CCX system.

The Unified CCX system uses subsystems for communicating with other services. Depending on the Unified CCX package you have installed, the Subsystems menu may contain some or most of the following menu options:

- **Cisco Unified CM Telephony**—to enter Unified CM Telephony provider information, Computer Telephony Interface (CTI) port group information, Unified CM Telephony trigger information, and to resynchronize Unified CM Telephony information.

- **RmCm**—to set up your Unified CCX resources.

- **Chat / Chat and Email**—allows Unified CCX to configure and manage chat and email CSQs, configure mail server and Customer Collaboration Platform, predefined responses for chat and email, channel parameters, chat widget list, and teams.

- **Outbound**—to configure contact centers for automated outbound activities.

- **Database**—to configure the Unified CCX system to communicate with database servers.

- **HTTP**—to configure the Unified CCX Engine to respond to requests from a variety of web clients, including computers and IP phones.

- **eMail**—to configure the Unified CCX Engine to communicate with your email server and enable your applications to create and send email.

- **Cisco Media**—to configure Cisco Media Termination (CMT) dialog groups that can be used to handle simple Dual-Tone Multi-Frequency (DTMF) based dialog interactions with customers.

- **MRCP ASR**—to configure the MRCP Automated Speech Recognition (ASR) subsystem, which allows users to navigate through a menu of options using spoken responses to prompts.

- **MRCP TTS**—to configure the MRCP Text-to-Speech (TTS) subsystem, which converts plain text (UNICODE) into spoken words to provide a user with information or to prompt a user to respond to an action.

- Unified CM Telephony Menu, on page 286
- RmCm Menu, on page 289
- Chat and Email Menu Options, on page 293
- Outbound Menu, on page 316
Unified CM Telephony Menu

The Unified CCX system uses the Unified CM Telephony subsystem of the Unified CCX Engine to send and receive call-related messages from the Unified CM Computer Telephony Interface (CTI) Manager.

To access the Unified CM Telephony Configuration web pages, choose Subsystems > Cisco Unified CM Telephony from the Unified CCX Administration menu bar.

The Unified CM Telephony Configuration menu contains the following submenu options:

- **Unified CM Telephony Provider**—Choose this option to enter Unified CM Telephony provider information.
- **Unified CM Telephony Call Control Group Configuration**—Choose this option to configure CTI port groups for applications.
- **Unified CM Telephony Trigger Configuration**—Choose this option to configure Unified CM Telephony triggers for applications.
- **Data Synchronization**—Choose this option to check and synchronize data components like Unified CM Telephony Users (JTAPI Application Users), Unified CCX Triggers/Route points, and Call Control Groups between Unified CCX and Unified CM.
- **Cisco JTAPI Resync**—Choose this option to resynchronize Cisco JTAPI Client versions.
- **Advanced Settings**—Choose this option to configure advanced settings for the Cisco Unified CM Telephony client.

Unified CM Telephony Provider Configuration

To access this configuration area, choose Subsystems > Cisco Unified CM Telephony > Provider from the Unified CCX Administration menu bar. The Cisco Unified CM Telephony Provider web page opens.

Use the Unified CM Telephony Provider Configuration web page to view and modify the primary and secondary location of your Unified CM Telephony provider, and user prefix.

Unified CM Telephony Call Control Group Configuration

Choose Subsystems > Cisco Unified CM Telephony > Call Control Group from the Unified CCX Administration menu bar to access the Unified CM Telephony Call Control Group list web page. Use the Unified CM Telephony Call Control Group Configuration web pages to display, add, modify, and delete information about the call control group.

To add a new Unified CM Telephony Call Control Group, click the Add New icon or button on the Unified CM Telephony Call Control Group Configuration web page.
To modify an existing Unified CM Telephony Call Control Group, click any hyperlink within the Ports List table entry; the Cisco Unified CM Telephony Call Control Group Configuration web page opens.

**Unified CM Telephony Triggers Configuration**

Choose **Subsystems > Cisco Unified CM Telephony > Triggers** from the Cisco Unified CCX Administration menu bar to configure Unified CM Telephony Triggers.

The Cisco Unified CM Telephony Trigger Configuration web page opens where you can view, add, modify, and delete Unified CM Telephony triggers. To add a Unified CM Telephony trigger, click the **Add New** icon or button. The Cisco Unified CM Telephony Trigger Configuration web page opens.

---

**Note**

Use of two(2) wildcard CTI Route Points that overlap with each other is not supported. For example, Route Point 1: 123XXXX and Route Point 2: 1234XXX overlap with one another and is not supported.

However, a wildcard CTI Route point can overlap with a full DID (best match pattern) that doesn't contain a wildcard. For example, Route Point 1: 123XXXX and Route Point 2: 1234567 is supported.

---

**Synchronize Unified CM Telephony Data**

You can configure the telephony data synchronization through a new web page called Cisco Unified CM Telephony Data Synchronization.

The data synchronization process ensures that data components like Unified CM Telephony Users (JTAPI Application Users), Unified CCX Triggers/Route points, Call Control Groups between Unified CCX and Unified CM, and SRTP are synchronized without any inconsistency.

**Data Check** option displays if the selected data components are in synchronization between Unified CCX and Unified CM. If you find any inconsistency, use the **Data Resync** option to rectify the issue.

To check and synchronize the JTAPI data components between Cisco Unified CM and Cisco Unified CCX, perform the following steps:

---

**Caution**

It is important that you plan to perform this task during off peak hours to avoid hampering routine contact center operations.

---

**Procedure**

**Step 1**

From the Unified CCX Administration menu bar, choose **Subsystems > Cisco Unified CM Telephony > Data Synchronization**.

The Cisco Unified CM Telephony Data Synchronization page appears.

**Step 2**

Choose the desired components by selecting the corresponding check box:

- Call Control Group(s)
- Trigger(s)
• CM Telephony User(s)
• SRTP

Step 3  Click **Data Check** or **Data Resync**. Once you click **Data Check** or **Data Resync**, a confirmation message dialog box appears prompting you to either proceed or cancel. Click **OK** to continue.

**Note**  Once you click **OK** in the confirmation message for Data Check or Data Resync, you will not be allowed to cancel the process.

Step 4  The Cisco Unified CM Telephony Data Synchronization web page continues to update until the Data Check or Data Resync process is complete. On completion of the Data Check or Data Resync process, the result is displayed in the same web page in a tree structure. The result for each selected component is displayed in collapsed format with a tick mark if no mismatch is found. Click the arrow adjacent to each selected component to expand and view the detailed results.

If any mismatch is found in the elements of the selected component, the results for those components are displayed automatically in an expanded format.

**Note**  If you had multiple device pools (for Call Control Groups) in your older versions of Unified CCX setup, performing Data Resync after an upgrade would merge all multiple device pools to a single default device pool. However, you can manually assign a different device pool to the Call Control Group if the default device pool is not the intended one.

---

**Unified CM Telephony Cisco JTAPI Resync**

Choose **Subsystems > Cisco Unified CM Telephony > Cisco JTAPI Resync** from the Cisco Unified CCX Administration menu bar to resynchronize the JTAPI client version on the Unified CCX with the JTAPI version on the Unified CM. You can view the status of Cisco JTAPI client resynchronization in this web page.

If the Unified CCX detects a mismatch, the system downloads and installs the compatible or JTAPI client required installer version. Restart the Unified CCX Engine to view these configuration changes.

The JTAPI client update happens only on the local node and not on the second node in case of High Availability deployment.

---

**Unified CM Telephony Advanced Settings**

Choose **Subsystems > Cisco Unified CM Telephony > Advanced Settings** from the Cisco Unified CCX Administration menu bar to configure advanced settings for the Unified CM Telephony Client.

Use the Unified CM Telephony Advanced Settings web page to update the following information:

- Periodic Wakeup Interval (seconds): Select the check box before Enable Periodic Wakeup prior to updating the existing value in this field.
- Queue Size Threshold: Select the check box before Enable Queue Stats prior to updating the existing value in this field.
- CTI Request Timeout (sec)
- Provider Open Request Timeout (sec)
• Provider Retry Interval (sec)
• Server Heartbeat Interval (sec)
• Route Select Timeout (ms)
• Post Condition Timeout
• Use Progress As Disconnect

Click the **Update** icon that displays in the toolbar in the upper left corner of the window or the **Update** button that displays at the bottom of the window to save the changes. Restart the Unified CCX Engine to view these configuration changes.

In case of High Availability deployment, the changes are propagated to the second node. If the second node cannot be contacted, an alert message indicating that the update has failed on the remote node is displayed.

## RmCm Menu

Use the RmCm Configuration web page to configure skills groups, resources, resource groups, Contact Service Queues (CSQs), and RM (Resource Manager) Unified CM Telephony providers. To access the Unified CCX Configuration web page, choose **Subsystems > RmCm** from the Unified CCX Administration menu bar.

The RmCm menu contains the following submenu options:

- **Skills**—Click this submenu to create skills. This option is available only with the Unified CCX Enhanced and Unified CCX Premium license packages.
- **Resources**—Click this submenu to assign a resource group and skills to agents.
- **Resource Groups**—Click this submenu to create resource groups.
- **Contact Services Queues (CSQs)**—Click this submenu to configure CSQs.
- **RmCm Provider**—Click this submenu to configure the RM (Resource Manager) Unified CM Telephony provider for the RmCm subsystem.
- **Assign Skills**—Click this submenu to assign skills and a resource group to agents in bulk.
- **Agent Based Routing Settings**—Click this submenu to send a call to a specific agent, rather than to any agent available in a CSQ.
- **Teams**—Click this submenu to create or associate teams with various agents, CSQs, and supervisors.

## Skill Configuration

Use the Skills page to add, modify, or delete skill.

Choose **Subsystems > RmCm > Skills** from the Unified CCX Administration menu bar to access the Skills summary web page.

## Add New Skill

Use the Skill Configuration area to add a new skill name.
**Procedure**

Click the **Add New** icon that displays in the toolbar in the upper left corner of the window or the **Add New** button that displays at the bottom of the window to access the Skill Configuration area.

**Modify Skills**

Click the required skill in the Skill name column on the Skill Configuration web page to access the Skill Configuration area.

**Procedure**

Click the **Open Printable Report of this Skill Configuration** icon to view a list of the resources associated with that skill.

**Resources Configuration**

Use the Resources Configuration area to assign a resource group, to assign skills to a resource, and to assign an alias to the agent. When the agent is on chat, the alias of the agent is displayed to the customer.

To access this configuration area, choose **Subsystems > RmCm > Resources** from the Unified CCX Administration menu bar. The main area of the Resources area of the Unified CCX Configuration web page contains a list of resources (if configured).

Click the **Open Resources Summary Report** icon to open the Resources Summary Report in a new window. For each resource, this report lists the resource groups associated with the resource, the Unified CCX extension of the resource, and the number of CSQs and team to which the resource is assigned.

**Modify Resource**

Use the Resource Configuration area to modify resource configuration.

To access the Resource Configuration area, click any of the required resource in the Resource area of the Unified CCX Configuration summary web page.

**Procedure**

Click the **Open Printable Report of this Resource Configuration** icon to open a Resource Report for the agent. The Resource Report lists each agent resource ID, resource name, Unified CCX extension, resource group, automatic available status, skills, CSQs, and team.
Resource Group Configuration

Use the Resource Group Configuration web page to display and modify the names of existing resource groups and to add new resource groups.

Choose **Subsystems > RmCm > Resource Groups** from the Unified CCX Administration menu bar to access the Resource Groups web page.

Add New Resource Group

Use the Resource Configuration area to enter resource group name in the Resource Group Name field.

Procedure

Add a new Resource Groups by clicking **Add New** icon or button in the Resource Group area of the Unified CCX Configuration web page.

Modify Existing Resource Groups

Use the Resource Modification page to change or update the resource group name into the Resource Group Name field.

Modify an existing Resource Group by clicking the required resource group in the Resource Groups area. In the Resource Group Configuration area, change the Resource Group and update.

Procedure

Click the **Open Printable Report of this Resource Group Configuration** icon to view a list of the available resources for this resource group.

Contact Service Queues Configuration

Use the Contact Service Queues area of the Unified CCX Configuration web page to display existing CSQs, delete a CSQ, and add a new CSQ.

To access the Contact Service Queues area, choose **Subsystems > RmCm > Contact Service Queues** from the Unified CCX Administration menu.

Note

When all the CSQs assigned to the teams associated to the Supervisor are deleted, the Advanced Supervisor Capability of Queue Management is removed for the Supervisor.

Add a CSQ

Use the Contact Service Queues Configuration area to add a new CSQ.
To access the Contact Service Queues Configuration area, click the Add New icon or button in the Contact Service Queues area of the Unified CCX Configuration web page.

To open the Contact Service Queue Report for the required CSQ, click the Open Printable Report of this CSQ Configuration icon from the Contact Service Queues Configuration area.

**RmCm Provider Configuration**

Use the RmCm Provider area of the Unified CCX Configuration web page to identify the Unified CM Telephony user for the Resource Manager.

Choose Subsystems > RmCm > RmCm Provider from the Unified CCX Administration menu bar to access the RmCm Provider web page.

**Skills Configuration Assignment**

Use the Assign Skills area of the Unified CCX Configuration web page to modify an existing resource group and skill configuration or to assign new resource groups and skills to all or selected agents.

Choose Subsystems > RmCm > Assign Skills from the Unified CCX Administration menu bar to access this configuration area.

This web page also contains the following icons and buttons:

- **Add Skill**—to add new skills or resource groups to all or selected agents.
- **Remove Skill**—to remove skills of all or selected agents.

**Add Skills**

When you click the Add Skill button in the Assign Skills area of the Unified CCX Configuration web page, the Add Skill area opens. Use the Add Skill area to add a resource group and skills to the selected agents.

**Remove Skills**

When you click the Remove Skill button in the Assign Skills area of the Unified CCX Configuration web page, the Remove Skill area opens. Use the Remove Skill area to remove skills of all or selected agents.

**Agent Based Routing Settings Configuration**

Use the Agent Based Routing Settings area of the Unified CCX Configuration web page to configure Automatic Work and Wrapup Time.

Choose Subsystems > RmCm > Agent Based Routing Settings from the Unified CCX Administration menu bar to access this configuration area.

**Teams Configuration**

Use the Teams area of the Unified CCX Configuration web page to create or associate teams with various agents, CSQs, and supervisors.

Choose Subsystems > RmCm > Teams from the Unified CCX Administration menu bar to access this configuration area.
Add New Team

Click the **Add New** icon or button on the Teams summary web page. The Team Configuration page appears. Click the **Open Printable Report of this Team Configuration** icon in the Teams web page to open the report in a new window and send it to a printer.

Chat and Email Menu Options

- The **Chat and Email** option is available with Unified CCX Premium license package.

To access either of these menu options, choose **Subsystems > Chat and Email** as applicable.

The Chat and Email menu contains the following submenu options:

- **Customer Collaboration Platform Configuration**—Choose this option to configure the Customer Collaboration Platform parameters. This page also displays the overall health of Customer Collaboration Platform.

- **Mail Server Configuration**—Choose this option to configure the mail server. This page is available on the Unified CCX node with a premium license.

- **Contact Service Queues**—Choose this option to configure chat and Email CSQs. You can configure the email CSQs on the Unified CCX node with a premium license.

- **Predefined Responses**—Choose this option to define the chat and email predefined responses that are available in the Manage Chat and Email gadget on the Finesse Agent Desktop.

- **Channel Parameters**—Choose this option to configure channel parameters.

- **Chat Widget**—Choose this option to configure and manage chat widgets.

- **Teams**—Choose this option to configure teams.

Customer Collaboration Platform Configuration

Use the **CCP Configuration** web page to configure Cisco Customer Collaboration Platform. You must configure information only on this web page to enable the chat and email features.

Cisco Unified CCX does not support custom configuration changes on the chat and email campaigns or feeds from the Customer Collaboration Platform administration page.

This option is available only with the Unified CCX Premium license package. The email feature support for Unified CCX depends on the Customer Collaboration Platform version. For information about feature compatibility, see the Unified CCX Compatibility related information, located at: https://www.cisco.com/c/en/us/support/customer-collaboration/unified-contact-center-express/products-device-support-tables-list.html.

Any configuration change using Customer Collaboration Platform Administration interface is not supported.
On a high availability setup, after the **Add to Cluster** operation is successful, the following message is displayed:

In case of HA, configure the CCP on secondary node after adding to cluster in the secondary node.

Every time you navigate to this page, the state of feeds, campaigns, and notifications rules are validated for chat and email, the connectivity to the email server is checked, and the web page shows the appropriate status. Icons are used as visual indicators to display the status of each service. Hover the cursor over the icon to display a tooltip that explains the reason for the current state. As part of validation, Unified CCX checks the following:

- **CCP XMPP Service**
  
  Unified CCX checks the connectivity with the Customer Collaboration Platform XMPP service. If the XMPP service is down, the following message is displayed:
  
  CCP XMPP service is not accessible. Check the logs for more details.

- **CCP Runtime Service**
  
  Unified CCX checks the connectivity with the Customer Collaboration Platform runtime service. If the runtime service is down, the following message is displayed:
  
  CCP runtime service is not accessible. Check the logs for more details.

- **CCP Tomcat Service**
  
  Unified CCX checks the connectivity with the Customer Collaboration Platform Tomcat service. If the Tomcat service is down, the following message is displayed:
  
  Unable to communicate to the CCP on the IP address(Hostname) provided. Please verify whether CCP is running on this IP address(Hostname) or check the network connection and make sure that CCP is reachable from CCX.

- **CCP Status**
  
  - **Feeds**
    
    Unified CCX validates the status of the intended chat and email feeds in Customer Collaboration Platform.
    
    - ✔️—All the feeds are operating normally in Customer Collaboration Platform.
    
    - 🚫—One or more feeds mismatches with Customer Collaboration Platform.
    
    - ❌—All the feeds are missing in Customer Collaboration Platform.

  - **Campaigns**
    
    Unified CCX validates the status of the intended chat and email campaigns in Customer Collaboration Platform.
    
    - ✔️—All the campaigns are operating normally in Customer Collaboration Platform.
• 😞—One or more campaigns mismatches with Customer Collaboration Platform.

• ☹—All the campaigns are missing in Customer Collaboration Platform.

• **Notifications**
Unified CCX validates the status of the intended chat and email notifications in Customer Collaboration Platform.

• ✅—All the notifications are operating normally in Customer Collaboration Platform.

• 😞—One or more notifications mismatches with Customer Collaboration Platform. This status icon also appears after configuration, when no chat and email contact is injected yet. The status will change to normal after successful injection of chat and email contact.

• ☹—All the notifications are missing in Customer Collaboration Platform.

• **Email Cache**
Unified CCX checks and alerts the user about the email cache.

• ✅—Email cache is operating normally.

• ☹—Unable to cache emails. No new emails will be fetched.

• **Not Applicable**—Customer Collaboration Platform version is not compatible.

• **Email Server**
Unified CCX checks the connectivity with the email server.

• ✅—Email server is operating normally.

• **Not Configured**—Channel provider is not configured.

• **Not Applicable**—The following are the reasons for the current state:
  • Cisco Finesse is not active.
  • Email CSQ is not configured.
  • Customer Collaboration Platform version is incompatible with the Email feature.

• ☹—Unable to reach the email server.

• **CCP Chat Gateway**
This indicates the status of the Customer Collaboration Platform Chat Gateway and the Channel that is integrated.

• **CCP Chat Gateway**
  • ✅—The gateway is operating normally and is configured with a channel.
• The gateway is not in an operating state as it is either Unreachable or configurations are incorrect.

• Not Configured — The gateway is not configured and no channels are configured.

• Not Applicable — The following are the reasons for the current state:
  
  Cisco Finesse is not active.

  Customer Collaboration Platform version is incompatible or is not configured.

• Facebook Messenger Integration — This indicates whether the channel is enabled. It also indicates the last failure recorded in the channel. This helps to determine any intermittent or permanent errors.

Procedure

Step 1

From the Unified CCX Administration menu bar, choose Subsystems > Chat and Email > CCP Configuration as applicable.

The Configuration web page appears.

Note Ensure that Customer Collaboration Platform certificate is uploaded to the Unified CCX Tomcat trust store using the Cisco Unified OS Administration interface. You can also use the `set cert import trust tomcat` CLI.

Unified CCX and Customer Collaboration Platform servers must have DNS entries. Customer Collaboration Platform must be accessible to Unified CCX by hostname. If the entries are not valid, an error is displayed.

Step 2

Specify the following fields for Customer Collaboration Platform:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>IP Address / Host Name</td>
<td>IP address or fully qualified domain name of the Customer Collaboration Platform server. For example, 192.168.1.5 or host.example.com.</td>
</tr>
<tr>
<td>User Name</td>
<td>Username of the Customer Collaboration Platform administrator.</td>
</tr>
<tr>
<td>Password</td>
<td>Password of the Customer Collaboration Platform administrator.</td>
</tr>
</tbody>
</table>

Note When the Customer Collaboration Platform application password is reset, ensure that the new password is first updated in Unified CCX and then reset the password in Customer Collaboration Platform. This prevents the account getting locked due to the authentication attempts from Unified CCX with old password.

Step 3

Click Save to save the changes.
After saving a valid Customer Collaboration Platform configuration, you cannot change the IP Address / Host Name details. If you want to change the configuration, delete the existing configuration and create a new one.

If you see an error message, click Save to re-create feeds, campaigns, and notifications for chat and email in Customer Collaboration Platform.

When Unified CCX hostname is changed or when a new Unified CCX node is added, the Customer Collaboration Platform Configurations must be saved again. This enables the change to take effect to re-create all the notifications for email and chat in Customer Collaboration Platform.

Delete Customer Collaboration Platform Configuration

To delete the Customer Collaboration Platform configuration from the Unified CCX Administration interface, perform the following:

**Important**

- Ensure that the Customer Collaboration Platform configuration delete operation is performed during maintenance window.
- Ensure that the Customer Collaboration Platform configuration hostname is deleted manually from Desktop Layout in Cisco Finesse Administration.

**Procedure**

**Step 1**


**Step 2**

Click OK to delete the Customer Collaboration Platform configuration.

This deletes the Customer Collaboration Platform configuration data from the Unified CCX configuration database. In addition, it deletes the configurations such as Feeds, Campaigns, Notifications, and Webhooks (that were created by Unified CCX) from the Customer Collaboration Platform application.

**Note**

If you select Delete all Associated Chat and Email CSQs check box in the confirmation dialog box, all the chat and email CSQs are also deleted from the Unified CCX configuration database.

**Result:** When the Customer Collaboration Platform configuration is deleted from both Unified CCX and Customer Collaboration Platform application, the following message is displayed: CCP configuration has been deleted successfully. However, due to connectivity issues, if the Customer Collaboration Platform configuration is deleted in Unified CCX but not deleted in Customer Collaboration Platform application, the following message is displayed: CCP configuration has been deleted successfully from UCCX. Ensure that the related configurations are deleted manually from the CCP application as well.

**Step 3**

Click Cancel to cancel this operation.
What to do next

When CCP configuration is not deleted in the Customer Collaboration Platform application.

Access Customer Collaboration Platform application: By default, access to Customer Collaboration Platform administration user interface is restricted. Administrator can provide access by whitelisting client's IP addresses and revoke by removing the client's IP from the whitelist. For any modification to whitelist to take effect, Cisco Tomcat must be restarted.

Whitelist administrator user interface: Use the `utils whitelist admin_ui add` command to whitelist the client's IP address, with which you want to access the Customer Collaboration Platform application. For example: `admin:utils whitelist admin_ui add 10.XXX.XX.XX`.

Delete Campaign: In the Customer Collaboration Platform application, select the Configuration tab. Select the checkbox to the left of one or more campaign names and click Delete. Click OK in the confirmation window to confirm the deletion of the selected campaigns.

Delete Feeds: In the Customer Collaboration Platform application, select the Configuration tab. Select the checkbox to the left of one or more feed names and click Delete. Click OK in the confirmation window to confirm the deletion of the selected feeds.

Delete Notifications: In the Customer Collaboration Platform application, select the Administration tab. Select the checkbox to the left of one or more notification names and click Delete. Click OK in the confirmation window to confirm the deletion of the selected notifications.

Reinject Email Contacts

Emails may be parked in Customer Collaboration Platform due to component failures or if the email server is down or not reachable. You can ensure that these emails are attended to when the services are restored by reinjecting the email contacts.

Procedure

To reinject the email contacts back to Unified CCX, click Subsystems > Chat and Email CCP Configuration > Reinject.

Note: The CCP Configuration web page is reloaded, but the configuration is not updated.

Chat Transcripts

You can search and retrieve stored chat transcripts. You can search by username (chat.agentName) and alias (chat.agentNickname). For more information on how to perform a default search or a field-specific search, see the “Search” section of the Cisco Customer Collaboration Platform User Guide or the Customer Collaboration Platform interface online help.

For information on how to change chat storage space and calculate the disk space that you need to store data for a specific duration, see the online help that is available for the Customer Collaboration Platform interface or see the Cisco Customer Collaboration Platform User Guide, located at: https://www.cisco.com/en/US/products/sw/custcosw/ps1846/tsd_products_support_series_home.html
Mail Server Configuration

Use the Mail Server Configuration web page to configure the mail server. This web page is available on the Unified CCX node with a premium license.

Before you begin

- Execute the commands `set-service msExchangeIMAP4 -startuptype automatic`, and `start-service msExchangeIMAP4` on Microsoft Exchange to set the Microsoft Exchange IMAP4 service to start automatically.

- Execute the command `set-service msExchangeIMAP4BE -startuptype automatic`, and execute `start-service msExchangeIMAP4BE` (for Microsoft Exchange 2013) on Microsoft Exchange to set the Microsoft Exchange IMAP4 Back End service to start automatically.

These commands are specific to the local Exchange server.

- Create accounts and email addresses to be used for CSQ creation.

Procedure

Step 1

From the Unified CCX Administration menu bar, choose Subsystems > Chat and Email > Mail Server Configuration.

The Mail Server Configuration web page opens.

Step 2

Complete or modify the following fields for the mail server:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mail Server Settings</td>
<td>Choose the mail server that is required to be configured from the listed options:</td>
</tr>
<tr>
<td>Mail Server</td>
<td>MS Exchange Server / Office 365</td>
</tr>
<tr>
<td></td>
<td>Gmail</td>
</tr>
<tr>
<td>Note</td>
<td>You must not perform any automatic or manual operations on the emails from the mail server. For example, create rules, move the emails manually to a different location, delete emails from the mail server, and so on.</td>
</tr>
<tr>
<td></td>
<td>The Unified CCX must be connected to a dedicated mail server and ensure that the server is not shared.</td>
</tr>
<tr>
<td>IMAP Folder Structure</td>
<td>The name of the sent items folder of the respective mail server that is configured.</td>
</tr>
<tr>
<td>Sent Items Folder Name</td>
<td>All the listed mail servers have the default folder names prepopulated for all the IMAP folders in English locale. These folder names can be edited and can have custom values.</td>
</tr>
</tbody>
</table>

Incoming (Secure IMAP)
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Host Name</td>
<td>Fully qualified domain name (FQDN) of the incoming (IMAP) server. Do not enter the IP address.</td>
</tr>
<tr>
<td>Port Number</td>
<td>Port number that is used to connect to the IMAP server. The default port number is 993.</td>
</tr>
<tr>
<td><strong>Outgoing (Secure SMTP)</strong></td>
<td></td>
</tr>
<tr>
<td>Host Name</td>
<td>FQDN of the outgoing (SMTP) server. Do not enter the IP address.</td>
</tr>
<tr>
<td>Port Number</td>
<td>Port number that is used to connect to the SMTP server. The default port number is 587.</td>
</tr>
<tr>
<td>Proxy Settings</td>
<td>Choose the <strong>Enable</strong> or <strong>Disable</strong> radio button to use socks proxy for Mail Server connectivity. By default the <strong>Disable</strong> option is selected and <strong>Enable</strong> option is disabled. To enable <strong>SOCKS</strong>, configure <strong>SOCKS Proxy</strong> in <strong>System Parameters</strong> page.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the mail server.</td>
</tr>
</tbody>
</table>

#### Contact Service Queues

**Before you begin**

- You must create a skill before creating a CSQ. For information about creating a skill, see *Skill Configuration* section in the Cisco Unified Contact Center Express Administration and Operations Guide.
- Before creating an email CSQ, you must have configured the mail server.

**Procedure**

**Step 1** From the Unified CCX Administration menu bar, choose **Subsystems > Chat and Email > Contact Service Queues** as applicable.

The Contact Service Queues (CSQs) web page opens and displays the information for existing chat and email CSQs if any.

**Step 2** To add a new chat or email CSQ, click the **Add New** icon that appears in the toolbar in the upper left corner of the window or the **Add New** button that appears at the bottom of the window.

The Contact Service Queue Configuration web page opens.

**Step 3** Specify the following fields:
### Resource Selection Criteria

- **Longest Available** — Selects the agent who has been in the Available state for the longest amount of time.

- **Most Skilled** — Used for expert agent chat distribution. Selects the agent with the highest total competency level. The total competency level is determined by adding the agent's competency levels for each assigned skill that is also assigned to the CSQ.
  
  
  - Example 1: If Agent1 is assigned Skill1(5), Skill2(6), and Skill3(7) and CSQ1 specifies Skill1(min=1) and Skill3(min=1), the total competency level for Agent1 for CSQ1 is 12.
  
  - Example 2: If Agent1 is assigned Skill1(5) and Skill2(6), and Skill3(7) and CSQ1 specifies Skill1(min=1), only, the total competency level for Agent1 for CSQ1 is 5.

- **Note** — If two agents score equal in the primary selection criteria, the agent who was updated first is assigned to the incoming chat.

### Table 15: CSQ Type — Chat

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CSQ Type</td>
<td>Choose Chat.</td>
</tr>
</tbody>
</table>

### Table 16: CSQ Type — Email

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CSQ Type</td>
<td>Choose Email. You can create up to 100 email CSQs. If you exceed the limit,</td>
</tr>
<tr>
<td></td>
<td>the following error is displayed:</td>
</tr>
<tr>
<td></td>
<td><strong>Cisco Unified CCX supports a maximum of 100 Email CSQs.</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Exceeded maximum limit for Email CSQs.</strong></td>
</tr>
<tr>
<td>Mail Server</td>
<td>Fully Qualified Domain Name (FQDN) of email server. This field displays the</td>
</tr>
<tr>
<td></td>
<td>mail server that you configured.</td>
</tr>
<tr>
<td>Email username</td>
<td>The email address to which emails are sent or retrieved.</td>
</tr>
<tr>
<td>Email password</td>
<td>Password for the email account.</td>
</tr>
</tbody>
</table>
### Field Name | Description
--- | ---
Inbox Folder Name | The folder from which emails will be fetched and queued for the Contact Service Queue.  
  Default value = Inbox folder of the selected mail server type  
**Note** If you change the Inbox folder name, which is already in use, the emails that are downloaded and cached by Customer Collaboration Platform are made available to agents. The remaining emails in the folder are ignored.

Sent Items Folder Name | The folder to which Customer Collaboration Platform will move the response email to, when it is sent.

Test Configuration | This checks the following:  
  • Connectivity from Customer Collaboration Platform to the configured mail server by using the user credentials that is specified in the Contact Service Queue (CSQ) configuration.  
  • Presence of and permissions to the Inbox, Drafts, Outbox, and Sent Items folder for the user, that is specified in the CSQ configuration.

Poll Interval (Seconds) | Frequency in seconds to fetch emails from the server.  
  Default value = 180, Range = 60 to 3600

Snapshot Age (Minutes) | Specify the time in minutes from when the emails are to be fetched.  
  Default value = 120, Range = 60 to 43200  
  For example, if you specify 120 minutes, this field fetches the emails from the last two hours.

---

**Step 4**  
Click **Next**.

The Skill Association for CSQ area opens with the newly assigned CSQ name.  
**Note** You can create up to 100 email CSQs. If you exceed the limit, the following error is displayed:

> Cisco Unified CCX supports a maximum of 100 Email CSQs. Exceeded maximum limit for Email CSQs.

**Step 5**  
From the Available Skills list, choose the skill that you want to associate with the CSQ by clicking it. To choose more than one skill, press the **Ctrl** key and click the skills that you want to associate with the CSQ.

**Step 6**  
Click **Add**.  
The chosen skill and the minimum competence level for that skill are displayed in the right pane under the heading **Selected**.  
**Note** To delete the skill from the Skills Required list, click the **Delete** icon next to **Minimum Competence**.

**Step 7**  
Specify a minimum competence level for the skill assigned to the CSQ.

**Step 8**  
To view the associated resources, click **Show Resources**.
**Step 9**

Click **Save** to save the changes for the CSQ.

The newly added CSQ appears in the **List of CSQs**.

**Note** You can create up to 100 email CSQs. If you exceed the limit, the following error is displayed:

Cisco Unified CCX supports a maximum of 100 Email CSQs. Exceeded maximum limit for Email CSQs.

You can sort the CSQs by title by clicking the **CSQ Name** header and by type by clicking the **CSQ Type** header.

**Step 10**

To view the printable report and associated resources, click the CSQ for which you want to view the report and the associated resources and then click **Open Printable Report**.

**Note** To delete a CSQ, click the CSQ that you want to delete and then click **Delete**. A warning dialog box appears, asking you to confirm the deletion. To delete, click **OK**.

**Caution** Deletion of the chat CSQ affects the associated chat web forms. After deleting, modify the corresponding chat web form configurations and generate the HTML code.

---

**Predefined Responses**

To access the predefined responses, choose **Subsystems > Chat > Predefined Responses OR Subsystems > Chat and Email > Predefined Responses** as applicable.

Use the **Predefined Responses** page to configure and manage chat and email predefined responses. You can add a maximum of 500 chat and email predefined responses in total. These predefined responses are available in the Manage Chat and Email gadget on the Finesse Agent Desktop.

You can configure the responses to be available either to all the agents or only to the agents that are associated with specific CSQs.

**Note** Predefined responses are not available in the Cisco Agent Desktop. They are only available with the Finesse Agent Desktop.

---

**Predefined Responses**

Using this web page, you can add, modify, and delete predefined responses.

You can add a maximum of 500 chat and email predefined responses in total.

**Note** To modify an existing predefined response, click the Title header for the predefined response that you want to modify. To delete an existing predefined response, click the **Delete** icon for the predefined response that you want to delete.
Procedure

Step 1  From the Unified CCX Administration menu bar, choose Subsystems > Chat > Predefined Responses OR Subsystems > Chat and Email > Predefined Responses as applicable.

The Predefined Responses web page opens, displaying the information for existing responses, if any.

Step 2  Click the Add New icon that is displayed in the toolbar in the upper left corner of the window or the Add New button that is displayed at the bottom of the window to create a new response.

The Predefined Response Configuration web page opens.

Step 3  Specify the following information:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>Unique identifier of the predefined response.</td>
</tr>
<tr>
<td><strong>Note</strong></td>
<td>The special characters angle brackets (&lt; &gt;), parentheses ( () ), double quotation marks (&quot; &quot;), and pipe symbol () are not allowed.</td>
</tr>
<tr>
<td>Type</td>
<td>Types of media.</td>
</tr>
<tr>
<td>Response Description</td>
<td>Description for the predefined response.</td>
</tr>
<tr>
<td><strong>Note</strong></td>
<td>The special characters angle brackets (&lt; &gt;), parentheses ( () ), double quotation marks (&quot; &quot;), and pipe symbol () are not allowed in Plain Text Editor for Chat Predefines Response.</td>
</tr>
<tr>
<td></td>
<td>Use the supported tags as provided in the Rich Text Editor for formatting purpose.</td>
</tr>
<tr>
<td></td>
<td>The maximum characters limit for predefined response for chat and email is 1500.</td>
</tr>
<tr>
<td></td>
<td>In case of email, rich text is supported and includes the HTML tag characters for representing rich text.</td>
</tr>
<tr>
<td>Tags</td>
<td>Choose a tag for the predefined response.</td>
</tr>
<tr>
<td><strong>Global for all CSQs</strong></td>
<td>The predefined response is available to all the agents that are associated with all the CSQs.</td>
</tr>
<tr>
<td><strong>Customize (Maximum 10 CSQs)</strong></td>
<td>The predefined response is available only to the agents that are associated with the selected CSQs.</td>
</tr>
<tr>
<td></td>
<td>If you choose this option, select the CSQs from the Available CSQs pane, and then click the left arrow to assign them.</td>
</tr>
<tr>
<td><strong>Note</strong></td>
<td>Predefined responses can be used only for emails sent in HTML format and not plain text.</td>
</tr>
</tbody>
</table>
Step 4  
Click Save.

The newly added predefined response appears with the assigned tags in the List of Predefined Responses.

You can sort the predefined responses by title by clicking the Title header and by type by clicking the Type header.

---

### Wrap-Up Reasons

To access the Wrap-Up Reasons, choose Subsystems > Chat and Email > Wrap-Up Reasons.

Use the Wrap-Up Reasons page to configure and manage Wrap-Up categories and reasons for chat and email Contact Service Queues (CSQs). Use the Ellipsis (…) to view all the Wrap-Up Reasons that are added for each Wrap-Up category.

### Procedure

**Step 1**  
From the Unified CCX Administration menu bar, choose Subsystems > Chat and Email > Wrap-Up Reasons.

The Wrap-Up Reasons web page opens, displaying the information for existing Wrap-Up Reasons, if any.

**Step 2**  
Click the Add New icon or the Add New button that is displayed in the toolbar in the upper left corner of the window.

The Wrap-Up Reasons web page opens.

**Step 3**  
Specify the following information:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Category</td>
<td>Specify the name for the Wrap-Up category. Allows up to 40 characters.</td>
</tr>
<tr>
<td>Wrap-Up Reasons</td>
<td>Enter the Wrap-Up Reasons for the specified category. Allows up to 40 characters. Click the Add button to add up to 25 Wrap-Up Reasons for each category.</td>
</tr>
</tbody>
</table>
### Email Signatures

To access the email signatures, choose **Subsystems > Chat and Email > Email Signatures.**

**Email Signature Configuration**

Using this web page, you can add, modify, and delete email signatures.

**Note**  
To modify an existing email signature, click the Title header for the email signature that you want to modify. To delete an existing email signature, click the **Delete** icon for the email signature that you want to delete.

**Procedure**

**Step 1**  
From the Unified CCX Administration menu bar, choose **Subsystems > Chat and Email > Email Signatures.**  
The Email Signature web page opens, displaying the list of existing email signatures that are configured, if any.

**Step 2**  
Click the **Add New** icon that is displayed in the toolbar in the upper left corner of the window or the **Add New** button that is displayed at the bottom of the window to create a new email signature.  
The Email Signature Configuration web page opens.

**Step 3**  
Specify the following information:
### Field | Description
--- | ---
Name | Unique name of the email signature.  
**Note** | The name can have a maximum of 100 characters.
Content | The email signature content.  
**Note** | The email signature can have a maximum of 1500 characters. You may format the text of the email signature content, add images, add URL to the email signature, and add the Agent alias information.  
  
The Agent alias variable appears by default when any new email signature is created. If it is removed from the email signature it can be reinserted at the cursor location in the email signature by clicking on the Agent alias variable icon.  
  
  When there is no alias configured for an agent, the Agent ID is presented in the email signature by default.
Tags | Choose a tag for the email signature.  
  
  **Global for all CSQs**: The email signature is available to all the agents that are associated with all the CSQs.  
  
  **Customize (Maximum 10 CSQs)**: The email signature is available only to the agents that are associated with the selected CSQs.  
  
  If you choose this option, select the CSQs from the **Available CSQs** pane, and then click the left arrow to assign them.  
  
  **Note** | Only one (1) email signature can be tagged as Global for all CSQs.  
  
  A CSQ can be tagged with only one (1) email signature.  
  
  When an email is responded by an agent of a particular CSQ, the system will check if there is any email signature tagged for that CSQ. The different scenarios are:  
  
  • If there is an email signature tagged to a CSQ, that will be appended in the email response.  
  
  • If there is no CSQ specific email signature, the global signature is appended in the email response.  
  
  • If there is no global email signature and no customized email signature tagged to the CSQ then there will be no email signature appended in the email response.

**Step 4** Click **Save**.

The newly added email signature appears with the assigned tags in the **List of Email Signatures**.

You can sort the email signatures by title by clicking the Title header and by type by clicking the Type header.
Channel Parameters

Use the Channel Parameters web page to configure channel parameters.

Procedure

**Step 1**
From the Unified CCX Administration menu bar, choose **Subsystems > Chat > Channel Parameters** OR **Subsystems > Chat and Email > Channel Parameters** as applicable.

The Channel Parameters Configuration web page opens.

**Step 2**
Use this web page to specify or modify the following fields for channel parameters:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| No Answer Timeout (Seconds)| The time for an agent to respond to the chat request after which, the chat request is routed back to the chat queue and for the chat toaster to fade out. This is applicable for the Group Chat request also. However when the chat is not accepted, the chat request is not routed back to the chat queue.  
Note: When you use Chrome or Firefox, the browser overrides the chat toaster notification to fade out in 20 seconds, even if it is configured to a higher value. |
| Join Timeout (Minutes)    | The time after which the customer initiates a chat and, if an agent is not joined, the customer gets a message as per the configuration in the **Chat Web Form Configuration** page. But an agent can still join the chat after this timeout. The default timeout is one minute and the maximum timeout value allowed is 60 minutes.                                                                                                                                                                      |
| Inactivity Timeout (Minutes)| The customer inactivity time after which, the system ends the chat. This timeout is on the customer side only.  
The agent gets a message *"You are alone in the chat room. Click End to close the chat interface."*.  
The customer gets a message *"Warning: the server connection was lost due to an inactivity timeout or connection failure."*.  
Inactivity timeout may also apply to contacts in queue that have not yet been accepted by agents. This scenario occurs only when the Join Timeout value is greater than the Inactivity Timeout value.  
The customer then gets a message *"Sorry, the chat service is currently not available. Please try again later."* |
| Offer Chat Contact When On Voice Call | Click Yes if agents are allowed to handle a chat session during a voice call.  
Note: This setting takes effect when the agent ends the current voice call.  
Chats are presented to agents even when they go off-hook or busy in a Non ICD call. |
### Field | Description
--- | ---
Offer Voice Call When On Chat | Click Yes if agents are allowed to handle a voice call during a chat session. **Note** This setting takes effect when the agent receives a new incoming chat. Direct/Consult Transfer to an IPCC extension is an exception. Even if agents are busy on a chat they would still get calls that are transferred to their extension directly.

Maximum Number Of Chat Sessions Per Agent | Number of chat sessions (ranging from 1 to 5) that an agent is allowed to handle. This includes the group chat sessions also. **Note** This option is available only if Finesse service is activated. For Cisco Agent Desktop, the value is set to 1.

Maximum Number Of Email Sessions Per Agent | Number of Email sessions (ranging from 1 to 5) that an agent is allowed to handle.

Sticky Email Timeout (Hours) | Specify the amount of time for which an email message waits in a specific agent CSQ. Sticky email routing (Last-agent email routing) is a mechanism to route an email message to the agent who handled the last leg of the email conversation. When an email message, which is part of an ongoing conversation, comes in and the agent who handled the last leg of the conversation is not available, then the email does not wait indefinitely in that agent queue. After the configured time expires, the email message is placed on the intended CSQ to be handled by any available agent. **Note** Last-agent email routing is not available if the customer changes the subject line of the email message. Default = 4 hours, Range = 1 to 120 hours.

### Step 3
Click **Save** to save the changes for the channel parameters. **Note** If any of the above parameters are changed during the call center operation, the updated values are not applied to the existing contacts in the system. The changed parameters will affect only the new contacts coming into the system.

---

## Chat Widgets

Use the **Chat Widgets** section to configure the Bubble Chat widget and generate HTML code snippet that can be hosted on the customer website.

To access the **Chat Widgets** page, choose **Subsystems > Chat and Email > Chat Widgets**.
Chat Widgets Page

The Chat Widgets page lists the following information and options for each chat widget:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the chat widget.</td>
</tr>
<tr>
<td>Description</td>
<td>A brief description.</td>
</tr>
<tr>
<td>Post Chat Rating</td>
<td>Whether post chat rating is available for the chat.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong> Post chat rating can be configured for only bubble chat.</td>
</tr>
<tr>
<td>Code</td>
<td>Option to generate the web form code for the configured chat widget.</td>
</tr>
<tr>
<td>Delete</td>
<td>Option to delete the chat widget.</td>
</tr>
</tbody>
</table>

Chat Widget Configuration

You can add, modify, and delete chat widgets. You can select any one of the following calendars:

- 24 Hours X 7 Days
- Custom Calendar, which has been configured by using the Calendar Management in Finesse desktop.

**Note**

- To modify an existing chat widget, click the chat widget name.
- To delete an existing chat widget, click the delete icon. Ensure that the widget is removed from the customer website before deleting the widget.

You can configure or modify the Bubble Chat widget.

Bubble Chat Widget

To configure a Bubble Chat widget, complete the following steps:

**Procedure**

**Step 1**

From the Unified CCX Administration menu bar, choose **Subsystems > Chat and Email > Chat Widgets**.

The Chat Widgets web page opens, displaying the information for existing chat widgets.

**Note** During the widget configuration, live preview of the widget is possible.

**Step 2**

Click the **Add New** icon or the **Add New** button.

The Bubble Chat Configuration web page opens. The administrator can configure the messages and labels in any language.

**Step 3**

In the **Widget Details** area, specify the following information:
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique name of the chat widget.</td>
</tr>
<tr>
<td>Description</td>
<td>Chat widget description.</td>
</tr>
</tbody>
</table>

**Step 4**

Click Next.

The **Attributes - Branding and Identity** area appears.

**Step 5**

Specify the following information:

<table>
<thead>
<tr>
<th>Section</th>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Font Family</td>
<td>Typeface</td>
<td>Font family used for the text in the Chat Web Form and chat window.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note</strong> The default font family is Helvetica. You can change the font family by either selecting from the drop-down or entering a new name. If the selected font family is not available in the system where from the AppAdmin page is accessed, it will display an alert message. When you enter a new name, ensure that the correct spelling (case sensitive) is used. The system does not indicate if you enter an invalid name. Ensure that you use commonly available fonts so as to make it easy for the customers to view the information. Before proceeding, the administrator should ensure that the selected font family is applied on the Chat Web Form preview.</td>
</tr>
<tr>
<td>Chat Title</td>
<td>Text</td>
<td>Title text displayed on the Chat Web Form and Chat Bubble.</td>
</tr>
<tr>
<td></td>
<td>Text Color</td>
<td>Color of the title text.</td>
</tr>
<tr>
<td>Button</td>
<td>Text</td>
<td>Text displayed on the button of the Chat Web Form.</td>
</tr>
<tr>
<td></td>
<td>Color</td>
<td>Color of the button.</td>
</tr>
<tr>
<td></td>
<td>Text Color</td>
<td>Color of the text displayed on the button.</td>
</tr>
<tr>
<td>Agent Message</td>
<td>Message Color</td>
<td>Background color of the agent message in the chat window.</td>
</tr>
<tr>
<td></td>
<td>Text Color</td>
<td>Color of the agent message text.</td>
</tr>
</tbody>
</table>

**Note** As you specify the attributes, the **Preview** area dynamically displays the preview of the Chat Web Form and chat window based on your specifications.

**Step 6**

Click Next.

The **Attributes - Post Chat Rating** areas open.

**Step 7**

Specify the following information:
If this checkbox is checked, post-chat rating will be available for the chat. The Post Chat Rating column in the Chat Widgets page indicates whether post chat rating is available for a chat.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable Post Chat Rating</td>
<td>If this checkbox is checked, post-chat rating will be available for the chat.</td>
</tr>
<tr>
<td>Label</td>
<td>Text asking the user to rate the chat experience.</td>
</tr>
<tr>
<td>Button Text</td>
<td>Text displayed on the button that is used to submit the rating.</td>
</tr>
</tbody>
</table>

Note: The Preview area dynamically displays the preview of the rating window based on the information specified.

Step 8
Click Next.
The User Form Fields and Problem Statements and CSQ Mapping areas open.

Step 9
In the User Form Fields area, specify the following information:

a. From Available Fields, select the desired fields and move it to Selected Fields.

To create new fields in addition to the list of available fields, click Add Custom Field, enter the name of the new custom field in the pop-up window and click OK. The new custom field appears in the list of Selected Fields.

Step 10
In the Add problem Statement CSQ mapping area, specify the following information:

a. In Problem Statement Caption, enter the label for the problem statement field.

b. Enter the problem statement for the Chat Web Form and map the problem statement with an existing chat CSQ from the CSQ List drop-down list.

To add more problem statements and associate them with a chat CSQ, click Add More. Click the delete icon for a problem statement to delete that problem statement.

Step 11
Click Next. The Chat Messages area appears.

Step 12
Specify the following information:

<table>
<thead>
<tr>
<th>Section</th>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Initialization</td>
<td>Widget Wait Message</td>
<td>Message displayed to the customer when the customer submits the chat form and waits for an agent to join.</td>
</tr>
<tr>
<td>Messages</td>
<td>Join Time-out Message</td>
<td>Message displayed on the chat window to inform the customer that no agent is available currently.</td>
</tr>
<tr>
<td>In Progress</td>
<td>Text for Text Typing</td>
<td>Text directing the customer to enter a message. This text appears in the text box of the chat window where the customer enters messages to be sent.</td>
</tr>
<tr>
<td>Messages</td>
<td>Box</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Agent Joined Message</td>
<td>Message displayed on the chat window to inform the customer that an agent has joined. This message has the Agent Alias or Agent ID. Two text boxes are available to enter text to be displayed before and after the Agent Alias or Agent ID.</td>
</tr>
</tbody>
</table>
### Step 13
Click **Next**. The **Service Hours** page appears.

### Step 14
In **Service Hours** area, select one of the following options to configure the business hours.

- **Default (24 hours x 7 days)**- Select this option if the contact center works 24 hours and 7 days in a week.
- **Select Calendar**- Select this option to configure the business hours. Calendar drop-down is enabled for this selection.

### Step 15
Select the desired calendar from the drop-down list and click the **View** link to preview the calendar details such as **Business Hours**, **Custom Business Days**, and **Holidays**.

### Step 16
In the **Messages** area, specify the following:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Holiday</td>
<td>Message displayed on the bubble chat widget to inform the customer during a holiday.</td>
</tr>
<tr>
<td>Off Hours</td>
<td>Message displayed on the bubble chat widget to inform the customer during non-working hours.</td>
</tr>
<tr>
<td>Label</td>
<td>Heading text displayed on the bubble chat widget to inform the customer for the business hours details.</td>
</tr>
</tbody>
</table>
**Step 17**
In the **Label for Days of Week** area, specify a label for each day of the week.

**Step 18**
Click **Finish**.
The code for the Chat Web Form is generated and appears onscreen.

**Note**
The Chat Web Form that is generated uses JavaScript. You must access this Chat Web Form from a JavaScript enabled browser.

**Step 19**
Click **Save Code to File** to save the generated code. Click **Back to Chat Widgets** to go to the main **Chat Widgets** page.

**Note**
You can also generate the code from the main **Chat Widgets** page by clicking on the **Code** icon against the chat widget name. The generated code appears on a pop-up window. To save this code, click **Save Code to File**.

---

**Integration of Chat Code into Customer Website**

When you complete a chat widget configuration by clicking the **Finish** button, the code for the configured chat widget is generated. You can save this generated code by clicking **Save Code to File**. The code is saved in an HTML file. You can also generate the code from the main **Chat Widgets** page by clicking on the **Code** icon against the chat widget name.

For bubble chat, copy or download the HTML code snippet and insert it into the desired webpage of the customer's website. Use the function provided in the HTML code snippet as the event handler for an event such as “click”, etc., and use this event in an element, such as `<button>`, `<a>`, `<p>` etc. Invoking this event using the element will initiate the chat conversation. An example is shown in the HTML code snippet. If changes are made to the widget after deployment, there is no need to redeploy the HTML code snippet. The updated information is automatically fetched based on the widget ID and dynamically reflected for the next conversation.

---

**Note**
In cases where the website is comprises more than one page, ongoing chats might get disconnected when the user navigates from one page to another.

---

**Chat - Facebook Messenger**

**Before you begin**
To integrate Facebook Messenger with Unified CCX, you must ensure that the following conditions are met:

- Business entity must have a public Facebook page for their business.
- The endpoints like, Cisco Customer Collaboration Platform or a reverse proxy, must have valid Certificate Authority signed SSL certificates as they are exposed publicly to the Internet.
- A new Facebook App is created on the Messenger platform. For more information about creation of the Facebook App and Messenger setup see, https://developers.facebook.com/docs/messenger-platform.
Procedure

**Step 1** From the Unified CCX Administration menu bar, choose Subsystems > Chat and Email > Chat - Facebook Messenger.

**Step 2** In Configure Token from Facebook, enter the Facebook Page Access Token. This access token is generated on the Facebook App page when the Facebook App is created.

**Step 3** In HTTP Proxy, enable HTTP Proxy and provide valid values for the HTTP Proxy.

**Step 4** Click Validate to ensure that the token is valid using HTTP Proxy (if provided).

**Step 5** In Problem Statements and CSQ Mapping, enter Problem Statement Caption.

**Step 6** Enter problem statement and select CSQ from the dropdown list. Click Add More to add problem statements and CSQs.

You can add a maximum number of three (3) problem statements.

**Step 7** In Chat Messages, you can edit the existing messages as per your business requirement. The following table describes the messages that a Facebook Messenger user would see:

<table>
<thead>
<tr>
<th>Section</th>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Initialization Messages</td>
<td>Welcome Message</td>
<td>This message welcomes the user when a chat session is initiated. The user can select a problem statement from the list.</td>
</tr>
<tr>
<td>In Progress Messages</td>
<td>Wait Message</td>
<td>This message informs the user to wait until an agent joins the chat.</td>
</tr>
<tr>
<td></td>
<td>Join Timeout Message</td>
<td>This message informs the user to continue to wait or try again later.</td>
</tr>
<tr>
<td>End Messages</td>
<td>End Message</td>
<td>This message informs the user that the chat session has ended.</td>
</tr>
<tr>
<td></td>
<td>No Agent Available</td>
<td>This message informs the user that no agent is available.</td>
</tr>
<tr>
<td>Error Messages</td>
<td>Unsupported Content Message</td>
<td>This message informs the user that any attachments other than text formats are not supported.</td>
</tr>
<tr>
<td></td>
<td>Unknown Error</td>
<td>This message informs the user about any unknown internal error.</td>
</tr>
<tr>
<td></td>
<td>Inactivity Timeout Message</td>
<td>This message informs the user that the chat session has ended due to inactivity.</td>
</tr>
</tbody>
</table>

**Step 8** In Post Chat Rating, you can enable Post Chat Rating so that customers can rate the chat experience on a scale of 1 (worst) to 5 (best). You can edit the existing messages as per your business requirement. The following table describes the messages that the Facebook Messenger user would see:
This message informs the user that the chat experience can be rated. The user can select one of the ratings from 1 (worst) to 5 (best).

This message informs the user that the rating was successfully submitted.

Step 9
In Webhooks Update in Facebook, ensure that the Facebook Verification token and configured Callback URL are updated in the Facebook App.

Note
• If you have modified tokens, restart Customer Collaboration Platform Chat Gateway Service for the changes to take effect.

Step 10
In Enable Integration, check or uncheck the check box to enable or disable the integration of Facebook Messenger with Unified CCX respectively.

Step 11
Click Save to save settings.

Teams

Choose Subsystems > Chat > Teams OR Subsystems > Chat and Email > Teams as applicable from the Unified CCX Administration menu bar to access this configuration area.

Note
The team configuration for chat is the same as it is for voice.

Related Topics
Teams Configuration, on page 105

Outbound Menu

Use the Outbound Configuration web page or REST API to provision outbound dialing functionality feature. The Outbound menu option will be displayed when you upload the Cisco Unified Premium license.

General Configuration

Choose Subsystems > Outbound > General from the Cisco Unified CCX Administration menu bar to access the General Configuration web page.

Use this web page to add or modify Outbound dialing preferences.

Related Topics
Configure General Outbound Properties, on page 222
Campaign Configuration

Choose Subsystems > Outbound > Campaigns from the Cisco Unified CCX Administration menu bar to access the Campaigns web page. You can create and schedule a campaign, modify the settings that apply to a campaign, and import a list of contacts (in bulk using a comma-separated plain text file with .txt or .csv extension) into the Unified CCX database for each campaign using this web page.

From the Direct Preview Campaign Configuration page, you can also create a schedule to automatically import contacts from a remote server using the Import Contacts option.

The Campaigns web page displays the following status in the Automatic Import column in the Campaigns List table for the listed campaigns:

- **Not Configured** — Automatic Import of contacts is not configured.
- **Enable** — Automatic Import of contacts is configured and Automatic Schedule is enabled.
- **Disable** — Automatic Import of contacts is configured but Automatic Schedule is disabled.

You can define any one of the following two types for a campaign:

- Agent-based - If you select this campaign type, all the outbound calls will be handled by the available agents.
- IVR-based - In this campaign type, the outbound calls will be handled by the IVR scripts.

Add New Campaigns

To configure the properties for direct preview, progressive and predictive agent-based campaigns, for campaign name and description, callback settings, skill group selection, time range, dialing options, retry settings, and the dial settings, click Add New icon or button in the Campaigns web page.

**Related Topics**

Unified CCX Requirements, on page 218

Import Contacts

To import contacts for a selected campaign, click the hyperlink for the required campaign under the Name column and click Import Contacts. This will open the Import Contacts window through which you can import contacts.

The Open Printable Report for this Campaign Configuration icon provides the information for the selected campaign in addition to call-specific information, which varies depending on the selected dialer type for outbound. Few of them are:

- Campaign Name
- Enabled - Yes or No
- Description
- Start Time of the campaign
- End Time of the campaign
- Contact Records Cache Size
- Remaining Contacts

**Related Topics**

Manual Import of Contacts for Campaign, on page 240
Delete Contacts

To ensure that a contact does not get called again for subsequent campaigns, you must delete the contact from all campaigns to which it belongs.

Click **Delete All Contacts** icon or button in the Campaign Configuration web page to delete all contacts of a particular campaign. Once you click **Delete All Contacts**, you will see a dialog box with the message “This campaign will be disabled and all its contacts will be permanently deleted. Continue?” with **OK** and **Cancel** buttons.

If you click **OK**, the Outbound subsystem checks whether the contacts are used in an active Outbound campaign. If the contacts are used as part of an active Outbound campaign, you will see the following alert message in the status bar at the top of the Campaign Configuration web page: “Campaign is active. Cannot remove contacts from an active campaign. Disable the campaign and try again.” In such cases, disable the campaign first and then try deleting all contacts. Click **Cancel** if you do not want to delete all contacts for the specific campaign.

Area Code Management

Use this page to manually add new area codes, update existing area codes, and to add international area codes.

Add New Area Code

The Area Codes Management page allows you to find, add, delete, and modify the mapping of area codes and time zones. The dialer uses the area code of a contact phone number to determine the time zone of the contact calling area.

Configure SIP Gateway

You can use the SIP Gateway Configuration web page to add or modify the parameters that enable the Outbound subsystem of Unified CCX to communicate with the SIP gateway. You can also update the parameters specific to Call Progress Analysis functionality of the gateway using this web page.

Call Progress Analysis is a feature of the SIP gateway by which it determines whether the outcome of a call is an answering machine, live voice, fax, or beep tone and so on. The SIP gateway performs call progressive analysis of the call and informs the outcome of the call to Unified CCX.

---

**Note**

It is mandatory to configure the SIP Gateway used by the Outbound subsystem to place calls in case of IVR-based and agent-based progressive and predictive Outbound campaigns.

Follow this procedure to configure the SIP gateway parameters through Unified CCX Administration web interface:

**Procedure**

**Step 1** From the Unified CCX Administration menu bar, choose **Subsystems > Outbound > SIP Gateway Configuration**.
The SIP Gateway Configuration web page opens.

**Step 2** Click **Update** to save the configuration changes.

The new SIP gateway configuration is added to the Unified CCX system.

**Step 3** Click **Cancel** to restore the default settings.

### SIP Gateway Configuration Web Page

The SIP Gateway Configuration web page.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Gateway Configuration</strong></td>
<td></td>
</tr>
<tr>
<td>Gateway Hostname/IP Address</td>
<td>The HostName or IP Address of the SIP Gateway in the Unified CCX server, which will be used by the Outbound subsystem to place calls for the predictive or progressive campaigns.</td>
</tr>
<tr>
<td>Gateway Port</td>
<td>Destination port used by Unified CCX to communicate with SIP gateway. The default value is 5060.</td>
</tr>
<tr>
<td>Local CCX Port</td>
<td>Destination port to be used by SIP gateway to communicate with Unified CCX. You cannot edit this field. Default value is as follows:</td>
</tr>
<tr>
<td></td>
<td>• Fresh install: 5065</td>
</tr>
<tr>
<td></td>
<td>• Upgrade: Previously configured value. If not configured, 5065 is displayed.</td>
</tr>
<tr>
<td></td>
<td>If you have configured a value other than 5065, you can restore to the default value by using the <strong>Restore Default</strong> button.</td>
</tr>
<tr>
<td>Local User Agent</td>
<td>This read-only field provides a description of the owner for this connection. The default value is Cisco-UCCX.</td>
</tr>
<tr>
<td>Transport(TCP/UDP)</td>
<td>The protocol required to send SIP messages. You can select any one of the following protocols:</td>
</tr>
<tr>
<td></td>
<td>• TCP - Transport Control Protocol or</td>
</tr>
<tr>
<td></td>
<td>• UDP - User Datagram Protocol</td>
</tr>
<tr>
<td></td>
<td>The default value is UDP.</td>
</tr>
</tbody>
</table>

**Call Progress Analysis Configuration (displays the parameter name, parameter value, and suggested value for the following fields)**
Dial Peer Configuration for Outbound

Dial peer configuration is required to transfer the outbound calls to the IVR ports and agents in case of progressive and predictive outbound campaigns. The dial peer maps to the CUCM trigger for IVR-based campaigns and to the agent extension for agent-based campaigns.

When you configure voice-network dial peers, the key commands that you must configure are the destination-pattern and session-target commands.

**IVR**

For IVR-based progressive and predictive campaigns, the destination-pattern command specifies the Unified CM Telephony Trigger associated with the IVR campaign. The session-target command specifies a destination address for the voice-network peer.

**Agent**

For agent-based progressive and predictive campaigns, the destination-pattern command specifies the agent extension. The session-target command specifies a destination address for the voice-network peer.

<table>
<thead>
<tr>
<th><strong>Parameter</strong></th>
<th><strong>Description</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Minimum Silence Period (10-1000)</strong></td>
<td>The amount of time that the signal must be silent after speech detection to declare a live voice (in milliseconds). Default = 375 milliseconds, Range = 10-1000 milliseconds</td>
</tr>
<tr>
<td><strong>Analysis Period (1000 - 10000)</strong></td>
<td>Maximum amount of time (from the moment the system first detects the speech) during which analysis will be performed on the input audio. Default = 2500 milliseconds, Range = 1000-10000 milliseconds</td>
</tr>
<tr>
<td><strong>Maximum Time Analysis (1000-10000)</strong></td>
<td>The amount of time to wait when it is difficult for the dialer to determine voice or answering machine. Default = 3000 milliseconds, Range = 1000-10000 milliseconds</td>
</tr>
<tr>
<td><strong>Minimum Valid Speech Time (50-500)</strong></td>
<td>Amount of time that the signal must be active before being declared speech. Anything less is considered as a glitch. Default = 112 milliseconds, Range = 50-500 milliseconds</td>
</tr>
<tr>
<td><strong>Maximum Term Tone Analysis (1000-60000)</strong></td>
<td>This is the amount of time the gateway will look for a terminating beep once an answering machine has been detected. Default = 15000 milliseconds, Range = 1000-60000 milliseconds</td>
</tr>
</tbody>
</table>
For Extend and Connect, the destination-pattern must specify the destination address of the CTI Remote Device (CTIRD). See the Cisco Unified TAPI Developers Guide for Cisco Unified Communications Manager at https://www.cisco.com/en/US/products/sw/custcosw/ps1844/prod_installation_guides_list.html for more information on CTIRD.

**Disable Hunting for Agent-Based Outbound Calls**

When the agent does not answer a live voice call within the time limit configured for Outbound Call Timeout in General Configuration web page, then the call has to be dropped. If hunting is not disabled on the gateway, the call is not dropped and is forwarded to the agent extension.

The gateway receives a 403 forbidden error message and hunts for the “preference 2 dial peer.” The gateway forwards the call to the agent extension using the “preference 2 dial peer.” Hence, the call is seen on the agent desktop and the state of the agent is changed to Ready or Not Ready depending on the option selected for the Agent State after Ring No Answer field in System Parameters Configuration web page.

To disable hunting for the gateway, use no voice hunt 57 command (57 maps to 403 forbidden in SIP).

---

**Note**

This is a global configuration to restrict the gateway from hunting for all 403 forbidden error messages.

**Translation of Phone Numbers**

Unified CCX does not support the translation or modification of the phone number that it uses to dial out outbound calls. Any “voice translation rules” configured in the gateway that modifies the phone number are not supported. If the phone number is translated, then those calls are not treated as IVR or agent-based outbound calls. Any such calls cannot have all the functionality and capabilities of a normal IVR or agent-based outbound calls.

---

**Note**

You can use either of the below two supported methods to modify a dialed number in the gateway:

- To remove the initial digits of the phone number use `forward-digits` or `digit-strip` in the dial peer configuration.

- To add a prefix to the phone number use `prefix` in the dial peer configuration.

---

**Database Menu**

The Unified CCX system uses the Database subsystem of the Unified CCX Engine to communicate with database servers, to obtain information that can be relayed to callers or to make application decisions. The Database subsystem enables the Unified CCX applications to obtain information from data sources, which are databases configured to communicate with the Unified CCX system.

The Database menu contains the following options, which are explained below:

- Datasource
- Parameters
- Drivers
**DataSource**

Use the DataSources web page to add a new data source, display, modify, or delete existing datasources.

Choose **Subsystems > Database > DataSource** from the Cisco Unified CCX Administration menu bar to access the DataSources web page.

**New DataSource**

Follow this procedure from the DataSources web page to add a new DataSource:

**Procedure**

Click the **Add New** icon that displays in the toolbar in the upper left corner of the window or the button that displays at the bottom of the window to add a new data source.

The DataSource Configuration web page opens.

**Add New Database Parameter**

To add a new database parameter:

**Procedure**

Choose **Subsystems > Database > Parameter** from the Unified CCX Administration menu bar.

The Parameters web page displays. See **Poll Database Connectivity** to know more about how to update parameter-related fields.

**Related Topics**

- **Poll Database Connectivity**, on page 113

**Driver**

Use the Driver List web page to upload new drivers, or to view and delete existing drivers.

**Add New Database Driver**

Follow this procedure to add a new jdbc driver:

**Procedure**

**Step 1**

From the Unified CCX Administration menu bar, choose **Subsystems > Database > Drivers**.
The Driver List webpage opens up displaying a list of uploaded driver class filenames along with a Delete icon.

**Step 2**
Click the **Add New** icon that displays in the toolbar in the upper left corner of the window or the **Add New** button that displays at the bottom of the window to add a new driver class name.

The Driver Management webpage opens.

**Step 3**
Specify a valid JDBC driver jar file in the Driver File field or click **Browse** to locate the driver file.

The driver file is validated before uploading.

**Step 4**
Choose the supported class name for the new driver from the Driver Class Name drop-down list box.

**Step 5**
Click **Upload** to save the new driver to the database.

**Tip**
- Contact your database vendor to know the appropriate JDBC driver versions that is compatible with your Enterprise database server.
- While uploading com.ibm.db2.jcc.DB2Driver, if your IBM DB2 deployment also requires a license Jar to be in the application’s classpath, upload the license Jar as a Custom Jar File using the procedure detailed in **Specify Custom Classpath Entries**. Then, restart the Unified CCX Engine on all nodes through the Unified CCX Serviceability.

**Related Topics**
- **Specify Custom Classpath Entries**, on page 126

---

**HTTP Menu**

The Unified CCX system uses the HTTP subsystem of the Unified CCX Engine to add components to the Unified CCX Engine that allow applications to be triggered in response to requests from a variety of web clients, including computers and IP phones.

HTTP/HTTPS triggers are available if your system has a license installed for one of the following Cisco product packages: Unified IP IVR or Unified CCX Premium.

**HTTP Trigger Configuration**

Use the HTTP Trigger Configuration web pages to display, add, modify, and delete existing HTTP triggers. Choose **Subsystems > HTTP** from the Cisco Unified CCX Administration menu bar to access the HTTP Trigger Configuration web page.

**Add New HTTP Trigger**

To add a new HTTP trigger:
**Procedure**

Click the **Add New** icon or button on the HTTP Trigger Configuration web page to access the HTTP Trigger Configuration web page.

To modify an existing trigger, click any hyperlink within the HTTP Trigger List table; the HTTP Trigger Configuration web page opens.

---

**eMail Menu**

The Unified CCX system uses the eMail subsystem of the Unified CCX Engine to communicate with your email server and enable your applications to create and send email. The email configuration identifies the default email address and server to be used for sending email (including e-pages and faxes) and for receiving acknowledgments.

---

**Note**

This email subsystem is not related to agent email-based routing.

Choose **Subsystems > eMail** from the Cisco Unified CCX Administration menu bar to access the eMail Configuration web page. You must configure email functionality so that Unified CCX scripts created with the email steps will function correctly.

---

**Cisco Media**

Choose **Subsystems > Cisco Media** from the Unified CCX Administration menu bar to access the Cisco Media Termination Dialog Group Configuration web page.

The Unified CCX system uses the Media subsystem of the Unified CCX Engine to configure Cisco Media Termination (CMT) dialog groups that can be used to handle simple Dual-Tone Multi-Frequency (DTMF) based dialog interactions with customers. A dialog group is a pool of dialog channels in which each channel is used to perform dialog interactions with a caller.

To modify an existing CMT dialog group, click any hyperlink within the trigger's summary table entry; the Cisco Media Termination Dialog Group Configuration web page opens.

To add a new CMT dialog group, click the **Add New** icon or button in the Cisco Media Termination Dialog Group Configuration web page. The Cisco Media Termination Dialog Group Configuration web page opens.

---

**MRCP ASR Menu**

The Unified CCX system uses the MRCP ASR (Automatic Speech Recognition) subsystem to allow navigation through a menu of options by speaking instead of pressing keys on a touch-tone telephone.
MRCP ASR Provider

Choose Subsystems > MRCP ASR > MRCP ASR Provider from the Cisco Unified CCX Administration menu bar to configure information about the vendor of your speech server, including the number of licenses, and the grammar type.

To modify an existing ASR Provider information, click any hyperlink within the provider's summary table entry; the ASR Provider Configuration web page opens.

To add a new ASR Provider information, click the Add New icon or button.

MRCP ASR Servers

Choose Subsystems > MRCP ASR > MRCP ASR Servers from the Cisco Unified CCX Administration menu bar to configure your speech server name, port location, and available languages.

---

**Note**

You must have a MRCP ASR Provider defined before you can provision a MRCP ASR Server.

To modify an existing ASR Server, click any hyperlink within the server summary table entry; the ASR Server Configuration web page opens.

To add a new ASR Server, click the Add New icon or button.

MRCP ASR Dialog Groups

Use the MRCP ASR Dialog Group Configuration web page to display, add, modify, and delete information about MRCP ASR dialog control groups, which enable Unified CCX applications to use speech recognition.

Choose Subsystems > MRCP ASR > MRCP ASR Dialog Groups from the Cisco Unified CCX Administration menu bar to configure the MRCP ASR dialog control groups.

---

**Note**

You must have a MRCP ASR Provider defined before you can provision a MRCP ASR Group.

To modify an existing MRCP ASR Dialog Group, click any hyperlink within the group summary table entry; the MRCP ASR Dialog Control Group Configuration web page opens.

To add a new MRCP ASR Group, click the Add New icon or button.

MRCP TTS Menu

The Unified CCX system uses the MRCP (Text-to-Speech) subsystem to convert plain text (UNICODE) into spoken words to provide a user with information or to prompt a user to respond to an action.

MRCP TTS Providers

Use the MRCP TTS Provider Configuration web pages to display, add, modify, and delete information about your TTS Provider.
Choose **Subsystem**s > **MRCP TTS** > **MRCP TTS Provider** from the Cisco Unified CCX Administration menu bar to configure information about the vendor of your TTS system.

To modify an existing MRCP TTS Provider, click any hyperlink within the provider summary table entry; the MRCP TTS Provider Configuration web page opens.

**MRCP TTS Servers**

Use the MRCP TTS Server Configuration web page to display, add, modify, and delete the text-to-speech server name, port location, and available language.

To modify an existing MRCP TTS Server, click any hyperlink within the server summary table entry; the MRCP TTS Server Configuration web page opens.

To add a new MRCP TTS Server, click **Add New** icon or button in the MRCP TTS Server Configuration web page.

**Related Topic**

**MRCP TTS Default Genders**

Use the MRCP TTS Default Genders Configuration web page to display or modify the gender setting for each Locale. You can modify the default gender setting for the Locales specified during TTS Server provisioning using this page. Click the **Update** icon or button to save the changes.

**Related Topic**
Wizards Menu

The Wizards menu of the Unified CCX Administration web interface provides access to the wizards available for your Unified CCX system.

In each Wizard web page, you are provided with a list of procedures and a description for each procedure in the main pane.

Click the Exit icon in the toolbar in the upper left corner of the window or the Exit button that displays at the bottom of the window to exit the wizard at any time and to go to the main Unified CCX Administration menu bar. Click Next to go to the next wizard menu option.

The Unified CCX system contains the following options in the Wizards menu:

- Application Wizard, on page 327
- RmCm Wizard, on page 328

Application Wizard

Application Configuration is one of the very basic requirements in Unified CCX Administration. You must complete several steps in the following order to successfully complete Application Configuration.

To access the Application Wizard, select Wizards > Application Wizard > Description of Steps from the Unified CCX Administration menu bar. The Application Configuration Wizard: Description of Steps web page opens up, displaying the different steps to perform the configuration, along with a brief description of each step as shown in the following bulleted list.

Click Next to proceed to the subsequent steps from the main Application Configuration Wizard web page or jump directly to any step using Wizards > Application Wizard and clicking the desired submenu (see Configure Unified CCX Applications).

- **Scripts**—In this step, you can view a list of existing custom scripts. When you click the Next button from the main Application Configuration Wizard web page, you are transferred to Script Management web page, which lists the available scripts, provides links to create a folder, and uploads custom scripts. Scripts can be uploaded as either a single script file or a zip file of scripts. You can upload multiple scripts in this step (see Script Management).

- **Prompts**—In this step, you can view a list of existing custom prompts. The Prompt Management web page lists the available prompts, provides links to create new folders, and uploads custom prompts. Prompts can be uploaded as either a single prompt file or a zip file of prompts. You can upload multiple prompts in this step (see Manage Prompt Files).
• **Grammars**—In this step, you can view a list of existing custom grammar files that are used to recognize and respond to caller prompts. The Grammar Management web page lists the available grammars, provides the links to create new folders, and uploads custom grammars. Grammars can be uploaded as either a single grammar file or a zip file of grammars. You can upload multiple grammars in this step (see **Manage Grammar Files**).

• **Documents**—In this step, you can view a list of existing custom documents such as .txt, .doc, .jsp, or .html, custom classes, and Java Archive (JAR) files that allow you to customize the performance of your Unified CCX system. The Document Management web page lists the available documents, provides the links to create new folders, and uploads custom documents. Documents can be uploaded as either a single document file or a zip file of documents. You can upload multiple documents in this step (see **Manage Document Files**).

• **Application Configuration**—In this step, you can select the type of application to be configured using Add a New Application page. Click **Next** to provide configuration details for the selected application type. Each application can be any combination of the scripts, prompts, grammars, and documents on file. By default, the uploaded script, prompt, document and grammar are selected, if applicable. You can create multiple applications in this step (see **About Unified CCX Applications**).

• **Triggers**—In this step, you can create different types of triggers for the applications that were created in the previous step using the Trigger Configuration page. More than one trigger can be created for one application. By default, the application configured in the previous step is automatically selected. On providing the Directory Number, device name and language, the trigger configuration is complete. You can create multiple triggers in this step (see **Application Triggers**).

Selecting the type of the trigger concludes the Application Configuration wizard process.

**Related Topics**
- Configure Unified CCX Applications, on page 9
- Script Management, on page 51
- Manage Prompt Files, on page 117
- Manage Grammar Files, on page 119
- Manage Document Files, on page 120
- About Unified CCX Applications, on page 41
- Application Triggers, on page 47

**RmCm Wizard**

RmCm Configuration is a commonly performed procedure in the contact center environment. You must complete several steps to successfully complete RmCm Configuration. The RmCm Configuration wizard leads you through the following steps.

**Note**

The RmCm Wizard option is available with all Unified CCX license packages.

To access the Application Wizard, select Wizards > **RmCm Wizard** > Description of Steps from the Unified CCX Administration menu bar. The Application Configuration Wizard: Description of Steps web page opens up displaying the different steps in which you can perform the configuration along with a brief description of each step as shown in the bulleted list below.
Click **Next** to proceed to the subsequent steps from the main RmCm Wizard web page or jump directly to any step using **Wizards > RmCm Wizard** and clicking the desired submenu.

- **Add a Skill**—Choose this submenu to configure the skills to be associated with the user. In this step, you are transferred to the **RmCm > Skills** web page. Repeat this step to create multiple skills.

- **Add a Resource Group**—Choose this submenu to upload multiple custom scripts. In this step, you are transferred to the Resource Group Configuration web page, where you can enter the Resource Group Name.

- **Add Resources**—Choose this submenu to create resource groups that will later be assigned to resources. In this step, you are transferred to RmCm Wizard - User Configuration web page, which has a hyperlink to **Add resources in Unified CM**. This link invokes **Unified CM** automatically (see the following related topics):
  - **RmCm Provider Configuration, on page 292**
  - **Add Supervisors**—Choose this submenu to assign supervisor privileges to a user. In this step, you are transferred to the User Management web page, which allows you to search for a specific user.

- **Configure Resources**—Choose this submenu to add or remove skills that are associated with resources. In this step, you are transferred to the RmCm Configuration Resources web page, which lists the configured resources. Resources can be modified together to obtain the same skills, or they can be modified separately to be assigned different skills.

- **Modify Existing Contact Service Queues**—Choose this submenu to modify skills that are associated with a contact service queue. In this step, you are transferred to the RmCm Configuration Contact Service Queue web page, which lists the configured CSQs.

- **Add a Contact Service Queue**—Choose this submenu to add contact service queues. Skills or resource groups are associated to these contact service queues to filter out the resources. In this step, you are transferred to the RmCm Configuration Contact Service Queue Configuration web page, which allows you to add CSQs.

- **Modify Existing Teams**—Choose this submenu to modify agents in existing teams. In this step, you are transferred to the RmCm Configuration Contact Teams web page, which lists the configured teams.

- **Add a Team**—Choose this submenu to create new teams and associate those teams with new agents. In this step, you are transferred to the RmCm Configuration Team Configuration web page, which allows you to create new teams.

- **Create an Application**—On completing the RmCm configuration, you can optionally proceed to the Application Wizard configuration.
Tools Menu

The Tools menu of the Unified CCX Administration web interface provides access to system tools you can use to perform a variety of administrative tasks and contains the following menu options:

- **Plug-ins**—to download plug-ins that you can use to enhance the Unified CCX Engine.
- **Real-Time Reporting**—to generate reports that provide detailed information about the status of your Unified CCX system.
- **Real-Time Snapshot Config**—to configure the Unified CCX database connection to a wallboard display.
- **Historical Reporting**—to perform Historical Reporting tasks, including configuring the database server, synchronizing data, configuring users, installing client software, and purging your database.
- **User Management**—to assign access levels to administrators and supervisors.
- **Password Management**—to reset passwords for external database access users like workforce management, historical reporting user and so on.

The following sections describe the various menu options.

- Plug-Ins Menu, on page 331
- Real-Time Reporting Tool, on page 332
- Real-Time Snapshot Config Menu, on page 333
- Historical Reporting Menu, on page 337
- User Management Menu, on page 339
- Password Management, on page 346

Plug-Ins Menu

The Unified CCX system includes software components called *plug-ins* that you can use to enhance the Unified CCX Engine. You can download these plug-ins from the Plug-ins web page.

To access the Plug-ins web page, choose **Tools** > **Plug-ins** from the Unified CCX Administration menu bar.

The Plug-ins web page contains one or more of the following hyperlinks (depending on the Unified CCX package you have purchased):

- **Cisco Unified CCX Editor Installer for Windows**—Click this hyperlink to install the client-side Unified CCX Editor. For more information, see the *Cisco Unified Contact Center Express Getting Started with Scripts and Cisco Unified Contact Center Express Editor Step Reference Guide.*
• **Cisco Unified CCX Editor Web Launcher**—Click Unified CCX Editor Web Launcher hyperlink to download and launch the Unified CCX Editor through JNLP file. For more information, see the *Cisco Unified Contact Center Express Getting Started with Scripts and Cisco Unified Contact Center Express Editor Step Reference Guide*.

• **Cisco Unified CCX Real-Time Monitoring Tool for Windows**—Click this hyperlink to install client-side Unified CCX Serviceability Real-Time Monitoring Tool (RTMT) for Windows. This tool monitors real-time behavior of the components in a Unified CCX cluster. RTMT uses HTTP/HTTPS and TCP to monitor device status, system performance, device discovery, and CTI applications. It also connects directly to devices by using HTTP/HTTPS for troubleshooting system problems. This plugin is available only for users with administrator capability.

    ![](image)

    **Note**

    To download on Windows, right-click **Download** hyperlink and select **Save Target As** option.

• **Cisco Unified CCX Real-Time Monitoring Tool for Linux**—Click this hyperlink to install client-side Unified CCX Serviceability Real-Time Monitoring Tool (RTMT) for Linux. RTMT uses HTTP/HTTPS and TCP to monitor device status, system performance, device discovery, and CTI applications. It also connects directly to devices by using HTTP/HTTPS for troubleshooting system problems. This plug in is available only for users with administrator capability.

• **Cisco Unified CCX Real-Time Reporting Tool**—Click this hyperlink to download and launch the Real-Time Reporting Tool. This provides real-time reports to monitor Unified CCX system activity. RTR client tool is a Java application and hence requires Java Runtime Environment (JRE) to be installed on the client machine. It runs outside the web browser and prompts for user authentication. **Note**: To download, right click on Download hyperlink and select Save Target As option.

---

## Real-Time Reporting Tool

![Caution]

While Unified CM supports Unicode characters in first and last names, those characters become corrupted in Unified CCX Administration web pages for RmCm configuration, and Real-Time Reporting.

The Real Time Reporting (RTR) client is a Java application that is used to generate various reports that provide detailed information about the status of the Unified CCX system.

You can download and access the RTR client from the Unified CCX Administration, Tools menu at the following paths:

- **Tools > Real Time Reporting**.
- **Tools > Plug-ins**.
To run the Real Time Reporting client,

- In the Security tab of the Java Control Panel, add the fully qualified domain name (FQDN) of the Unified CCX server to the Exception Site List. For a high availability deployment, add the FQDN of both the Unified CCX servers to the Exception Site List.

- In the Advanced tab of the Java Control Panel, select the Use TLS 1.2 option in the Advanced Security Settings.

The RTR client is a Java application. You can double-click the downloaded RTR file to run the client on the client machine. You can access the RTR client with the Unified CCX Administrator or Supervisor credentials. You must close it after you have run the reports for the Unified CCX system. The RTR client requires Java 1.7.0_80 or later to run on the client machine.

The Real Time Reporting (RTR) client online help requires user authentication, if the Cisco Unified CCX Administration user interface is not currently active in the web browser.

### Real-Time Snapshot Config Menu

Many call centers use wallboards to display their real-time reporting status. Wallboards can display data such as available agents in CSQs, call volumes, talk times, wait times, and number of handled calls. You can enable the Unified CCX system to write Unified CCX real-time information to a database that can then be displayed on a wallboard.

You must purchase the wallboard separately, and configure and control it with its own wallboard software. Wallboard software and hardware are supported by the third-party wallboard vendors, not by Cisco.

You must install the wallboard software on a separate machine or desktop, not on the Unified CCX server. During installation of your wallboard software, you must configure your wallboard software to access the Unified CCX database. To do this, you must assign a DSN, User ID, and password.

Use the Real-Time Snapshot Writing Configuration for Wallboard web page to enable the system to write data to the wallboard system.

To access the Real-Time Snapshot Writing Configuration for Wallboard web page, choose Tools > Real Time Snapshot Config from the Unified CCX Administration menu bar.

The following fields are displayed on the Real-Time Snapshot Writing Configuration for Wallboard web page.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Writing Enable</td>
<td>If checked, the system writes the data to the database. If not checked, the system does not write the data to the database. The default is disabled.</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Writing Interval</td>
<td>Sets the refresh interval for the wallboard data. Valid options: 5, 10, 15, 20, 25, 30, 60, 90, 120, 150 and 180.</td>
</tr>
<tr>
<td>Cisco Unified CCX CSQs Summary</td>
<td>If checked, writes information about each CSQ to the RtCSQsSummary table in the Unified CCX database.</td>
</tr>
<tr>
<td>Cisco Unified CCX System Summary</td>
<td>If checked, writes overall Unified CCX system summary to the RtICDStatistics table in the Unified CCX database.</td>
</tr>
</tbody>
</table>

### Wallboard System

| Server Name                                    | IP addresses of the servers running the Wallboard software pointing to the HDS Database Server, which contains the Wallboard Real-Time Snapshot data. If you have multiple Wallboard servers, you can list their IP addresses in this field separated by commas. |

**Note**

For details about the information written to the RtCSQsSummary and RtUnified CCXStatistics database tables, see the *Cisco Unified Contact Center Express Database Schema Guide*. Only the RtCSQsSummary and RtICDStatistics statistics tables can be used in wallboard queries. Use of historical reporting tables in wallboard queries is not supported.


### Create System DSN for Wallboard

You can create a system Data Source Name (DSN) on your Windows server by performing the following procedure.

**Procedure**

**Step 1**

Install the wallboard software and IBM Informix ODBC Driver (IDS Version 3.0.0.13219 and above) on the wallboard client desktop.

**Note**

- You can download the Informix ODBC driver from the following URL: [https://www-01.ibm.com/marketing/iwm/iwm/web/pickUrxNew.do?source=ifxdl](https://www-01.ibm.com/marketing/iwm/iwm/web/pickUrxNew.do?source=ifxdl). Download the IBM Informix Client Software Development Kit (CSDK) Version 3.00 or higher for the operating system you are installing with the wallboard client. More information about the CSDK can be found at the following URL: [http://www.ibm.com/software/data/informix/tools/csdk/](http://www.ibm.com/software/data/informix/tools/csdk/).
- The ODBC connections to Unified CCX do not support encryption.
Step 2  Select Start > Settings > Control Panel.

Step 3  From the Control Panel menu, select Administrative Tools > Data Sources ODBC to launch the OBDC Data Source Administrator.

Step 4  Click the System DSN tab. Then click Add to open the Create New Data Source dialog box.

Step 5  Scroll down to locate and select the IBM INFORMIX ODBC DRIVER.

Step 6  Click Finish to open the IBM Informix Setup dialog box.

Step 7  On the General tab, enter and apply a Data Source Name and Description.

Step 8  On the Connection tab, enter the values for the fields as shown in the following table:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Server Name</td>
<td>This is the instance name of the Informix database.</td>
</tr>
<tr>
<td></td>
<td>Informix database instance name can be formed using Host Name of the Unified</td>
</tr>
<tr>
<td></td>
<td>CCX server by following these conventions:</td>
</tr>
<tr>
<td></td>
<td>• Convert all upper case letters to lower case.</td>
</tr>
<tr>
<td></td>
<td>• Replace hyphens with underscore.</td>
</tr>
<tr>
<td></td>
<td>• Add the letter “i” as a prefix to the instance name, if the hostname starts with a number.</td>
</tr>
<tr>
<td></td>
<td>• Append the letters “_uccx” to the instance name.</td>
</tr>
<tr>
<td></td>
<td>For example, if the hostname is “802UCCX-Ha-Node1”, enter “i802uccx_ha_node1_uccx” in the Server Name field.</td>
</tr>
<tr>
<td>Host Name</td>
<td>Enter the hostname of the primary Unified CCX server.</td>
</tr>
<tr>
<td>Service</td>
<td>Enter 1504.</td>
</tr>
<tr>
<td>Protocol</td>
<td>Enter onsoctcp.</td>
</tr>
<tr>
<td>Options</td>
<td>Leave blank.</td>
</tr>
<tr>
<td>Database Name</td>
<td>Enter db_cra.</td>
</tr>
<tr>
<td>User ID</td>
<td>Enter uccxwallboard. This is the user id of the Unified CCX database created for wallboard.</td>
</tr>
<tr>
<td>Password</td>
<td>The password for the wallboard user that has been configured. You can change the password by going to Tools &gt; Password Management submenu option from the Unified CCX Administration menu bar.</td>
</tr>
</tbody>
</table>

Step 9  Click Apply.

Step 10 Click the Environment tab and enter the values for the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Client Locale</td>
<td>Enter en_US.UTF8.</td>
</tr>
<tr>
<td>Database Locale</td>
<td>Enter en_US.UTF8.</td>
</tr>
</tbody>
</table>
Step 11 Click OK.

Step 12 Return to the Connection tab and click Apply and Test Connection.

If the phrase “Test completed successfully” is returned, click OK.

If the test is unsuccessful, return to the configuration sequence and fix any errors.

Wallboard Software in High Availability (HA) Deployment

If you use wallboard software in an High Availability (HA) deployment of Unified CCX and do not want any manual intervention in case of failover, you must upgrade your wallboard software.

Upgraded wallboard software should have a new service which periodically requests Unified CCX server for database mastership information using REST API (URL - http://<Unified CCX server IP Address>/uccx/isDBMaster). During failover, this new service in wallboard will update DSN registry to use new database master server.

REST API can be requested only from wallboard servers configured through Tools > Real Time Snapshot Config web page from the Unified CCX Administration menu bar.

Use Upgraded Wallboard Software with New Service in HA Deployment

If you use wallboard software in a High Availability (HA) deployment of Unified CCX, you must work with your wallboard vendor to use the new API exposed by Unified CCX.

Wallboard software with the new service ensures that the wallboard server always displays data from the master database server of Unified CCX and no manual intervention is required. Follow this procedure to complete the setup:

Procedure

Step 1 Create DSN using secondary server information and modify the same DSN using primary server information. This will create sqlhost entries for both the servers in a registry at HKEY_LOCAL_MACHINE\SOFTWARE\Informix\SqlHosts.

Step 2 Configure the wallboard software with new service as described in the wallboard software documentation.

Step 3 Configure information of both the Unified CCX servers with new service of wallboard as described in the wallboard software documentation.

What to do next

After you complete this procedure, no manual intervention is required in case of failover.

Use Wallboard Software (without New Service) in HA Deployment

If you use the existing wallboard software without the new service in an High Availability (HA) deployment of Unified CCX, you must complete the following actions:
Procedure

Step 1 Create DSN using secondary server information and modify the same DSN using primary server information. This will create sqlhost entries for both the servers in a registry at HKEY_LOCAL_MACHINE\SOFTWARE\Informix\SqlHosts.

Step 2 Configure the wallboard software as described in the wallboard software documentation.

Step 3 Whenever there is a failover, you must manually change the DSN registry entry as follows:
   a) Enter http://<UnifiedCCX server IP Address>/uccx/isDBMaster in a web browser from any wallboard client to know whether the requested Unified CCX IP address server has a database master or not.
   b) On failover, change SERVER value to master DB instance name in registry of DSN under HKEY_LOCAL_MACHINE\SOFTWARE\ODBC\ODBC.INI
   c) You can find the exact database instance name at HKEY_LOCAL_MACHINE\SOFTWARE\Informix\SqlHosts

Historical Reporting Menu

⚠️ Caution

While Unified CM supports Unicode characters in first and last names, those characters become corrupted in Unified CCX Administration web pages for RmCm configuration, and Real Time Reporting.

Use the areas of the Historical Reporting Configuration web page to perform a variety of tasks, including configuring users, installing client software, and purging your database.

To access the different Historical Reporting Configuration options, choose Tools > Historical Reporting and click any of the following submenu options from the Unified CCX Administration menu bar:

- **Database Server Configuration**—to configure the database server to specify the reporting options provided to the user.
- **SMTP Configuration**—to configure the email server used to email scheduled Cisco Unified Intelligence Center (CUIC) reports.
- **Purge Schedule Configuration**—to automatically purge data as per the following configurations:
  - Timing of the purge
  - Automatic purge configuration
- **Purge Now**—to manually purge data.
- **File Restore**—to restore database records written to HR files when the database goes down.

Database Server Configuration

Use the Database Server Configuration area to specify the maximum number of client and scheduler connections that can access the database server.
SMTP Configuration

Use SMTP Server Settings area to configure the email server used to email scheduled Cisco Unified Intelligence Center (CUIC) reports.

The following fields are displayed in the SMTP Server Settings area:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Host/ IP Address</td>
<td>The host name or IP address of the SMTP server</td>
</tr>
<tr>
<td>From email address</td>
<td>The email address that is to appear in the From field of emails sent by the Scheduler</td>
</tr>
<tr>
<td><strong>Note</strong> Unified CCX supports alphanumeric IDs and special characters (only hyphen &quot;,&quot;, underscore &quot;,&quot;, and dot &quot;.&quot;)</td>
<td></td>
</tr>
<tr>
<td>Use SMTP Authentication</td>
<td>Check this if your SMTP server expects to receive username/password credentials</td>
</tr>
<tr>
<td>SMTP Username</td>
<td>If you check the Authenticate checkbox, enter the username that is to be authenticated</td>
</tr>
<tr>
<td>SMTP Password</td>
<td>If you check the Authenticate checkbox, enter the password that is to be authenticated</td>
</tr>
</tbody>
</table>

**Note** You will not be able to save the SMTP configuration if Cisco Unified Intelligence Center service on the publisher node is down.

**Note** The Unified Intelligence Center email client does not support SSL/TLS based SMTP servers to email the scheduled Unified Intelligence Center reports.

Purge Schedule Configuration Option

Use the Purge Schedule Configuration area to select a user for whom you want to choose a reporting package for the Unified CCX Historical Reports system.

Choose **Tools > Historical Reporting > Purge Schedule Configuration** from the Unified CCX Administration menu bar to access the Purge Schedule Configuration web page.

The Historical Reporting Configuration web page opens, enabling you to configure the following:

- Daily purge schedule
- Automatic purge (you can specify how long records should persist before the system purges them)

Purge Now Option

Use the Purge Now area to manually purge data.
Choose Tools > Historical Reporting > Purge Now from the Unified CCX Administration menu bar to access the Purge Now area.

**File Restore Option**

Use the File Restore area to restore the database records written to HR files when the database goes down. In case of an High Availability setup, files from both the nodes are restored to the HR Database of the first and second node respectively. If it is unable to connect to the second node, you will see an alert message stating that the remote node is not reachable. When the second node comes up, the restored data will be replicated but you must repeat this Restore operation to restore the HR files, if any, on the second node.

**Procedure**

**Step 1**
Choose Tools > Historical Reporting > File Restore from the Unified CCX Administration menu bar to access the Historical Reporting Configuration web page.

**Note**
Restore Now radio button is enabled by default on this page.

**Step 2**
Click the Start icon that displays in the toolbar in the upper left corner of the window or the Start button that displays at the bottom of the window to restore the database records.

You can view the status of the restore operation on this page.

---

**User Management Menu**

The User Management menu option allows you to assign access levels to Unified CCX system administrators and supervisors.

When you configure a Unified CCX supervisor, you are configuring users who can access the Unified CCX Supervisor web pages. You are not creating a supervisor for Unified CCX.

**Attention**
Do not edit users, teams, and permissions in Unified Intelligence Center. The Unified CCX to Unified Intelligence Center sync runs as part of daily purge and synchronizes these settings on Unified Intelligence Center according to Unified CCX settings.

Only administrators can update the Unified CCX system. You must select at least one administrator, so that someone is available to perform updates.

**Procedure**

Choose Tools > User Management and click any of the following submenu options from the Unified CCX Administration menu bar to assign administrative privileges to administrators and supervisors:

- User View Submenu, on page 340
User View Submenu

From the Unified CCX Administration menu bar, choose Tools > User Management > User View to access the User Configuration web page.

Use this page to view existing users and assign administrative privileges to administrators and Supervisors. You can provide a search string based on a user ID; for example, if you provide the search string as:

- “*Agent1”, it will display user IDs ending with Agent1.
- “Agent1*”, it will display user IDs starting with Agent1.
- “Agent1”, it will display user IDs that contain Agent1.

All the columns are hyperlinked to the user configuration page.

---

**Note**

This search bar searches the users only by last name or user ID. Do not use the first name for searching.

When you unassign any Supervisor from the list of Supervisors who has one or more Advanced Supervisor Capabilities, an alert is displayed for your confirmation. Upon confirmation, the Advanced Supervisor Capabilities that are assigned and the Supervisor role are removed for that Supervisor.

Name Grammar Generator Configuration

Use the Name Grammar Generator Configuration web page to define scheduling information for the Name Grammar Generator.

From the Unified CCX Administration menu bar, choose Tools > User Management > Name Grammar Generator Configuration to access Name Grammar Generator Configuration area.

Name Grammars must be generated if you wish to use the Name to User Step with ASR. The Name Grammar Generator scans the User Directory and creates a speech recognition grammar containing every user in the directory. These grammars are saved in the grammar repository.

You may use the Name Grammar Generator Configuration page to run the Name Grammar Generator or schedule it to run at some later time. The page also displays the date and time that the Name Grammar Generator was last run and the completion status of that run.

The following fields are displayed on the Name Grammar Generator web page:
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Frequency</td>
<td>How often Name Grammar Generator is automatically run. Valid options: Never, Daily, and Weekly. This is a mandatory field.</td>
</tr>
<tr>
<td>Run task on (hrs of day)</td>
<td>Time of day to run the task. This is a mandatory field.</td>
</tr>
<tr>
<td>Run task on (day of week)</td>
<td>Day of week to run the task. This is a mandatory field.</td>
</tr>
<tr>
<td>Last Completed on</td>
<td>Date of last generation of name grammar.</td>
</tr>
<tr>
<td>Last Completion Result</td>
<td>The status after the last name grammar generation. (Display only.)</td>
</tr>
<tr>
<td>Grammar Variant</td>
<td>Select one or more grammar variants to generate from the check box next to the following three options:</td>
</tr>
<tr>
<td></td>
<td>• OSR 3.1.x</td>
</tr>
<tr>
<td></td>
<td>• 2003 SISR</td>
</tr>
<tr>
<td></td>
<td>• Nuance</td>
</tr>
<tr>
<td>Current Status</td>
<td>Running status of the Name Grammar Generator. (Display only.)</td>
</tr>
</tbody>
</table>

Click the **Generate Name Grammar Now** icon or button to trigger the Name Grammar Generator.

**Note**

Clicking **Generate Name Grammar Now** will not apply changes to the scheduling configuration; you must click **Update** to apply scheduling changes.

### Spoken Name Upload Submenu

When a caller requests to be transferred to a specific extension, Unified CCX applications can playback a recording of the spoken name of the person to whom the caller has called. These spoken name recordings are stored as .wav files and managed by the Spoken Name Upload tool of the Unified CCX Administration web interface.

To access the Spoken Name Prompt Upload web page, choose **Tools > User Management > Spoken Name Upload** from the Unified CCX Administration menu bar.

The Spoken Name Prompt Upload web page also contains the **Click Here for Recording Information** icon and button, which displays a .htm page in your browser with more information on recording spoken name prompts.

### Administrator Capability View Menu

From the Unified CCX Administration menu bar, choose **Tools > User Management > Administrator Capability View** to access the capability view for the Administrator User Management area.
This web page contains a pane for users identified as Unified CCX Administrator and another pane with the list of Available Users. Based on your requirements, you can move users back and forth between these two panes by clicking the arrows in either direction. Click Update to save the changes.

- You cannot assign Administrator capability to a user ID that is the same as the application administrator user ID created during the Unified CCX installation. If you assign Administrator capability to such a user ID, an error appears.

- In Single Sign-On (SSO) mode the Application User created during installation will not be able to access the Cisco Unified Intelligence Center application with administrator privileges. To enable the Cisco Unified CCX Administrator to have administrator privileges in Cisco Unified Intelligence Center as well, follow the steps below:
  1. Assign the reporting capability to the user.
  2. Execute the CLI command, utils cuic user make-admin.
  3. Restart the Cisco Unified Intelligence Center Reporting Service for the changes to reflect.

Supervisor Capability View

From the Unified CCX Administration menu, choose Tools > User Management > Supervisor Capability View menu to access the detailed view for Supervisors.

- For a Supervisor to access Unified Intelligence Center Live Data reports, an extension must be assigned to the Supervisor.

- You cannot assign Supervisor capability to a user ID that is the same as the application administrator user ID created during the Unified CCX installation.

The Supervisor Capability View page displays the list of existing Supervisors. This page displays the teams to which they are assigned as Primary or Secondary Supervisors, CSQs, and the Advanced Supervisor Capabilities.

The Supervisors can be assigned the following Advanced Supervisor Capabilities:

- Queue Management- Enables a Supervisor to manage resources across the assigned CSQs and teams.
- Calendar Management- Enables a Supervisor to change business hours, custom business days and holidays.
- Outbound Campaign Management- Enables a Supervisor to schedule, enable or disable outbound campaigns, and manage import contacts.
- Application Management - Enables a Supervisor to manage Unified CCX applications.
## Manage Supervisors

### Procedure

| Step 1 | From the Unified CCX Administration menu, choose Tools > User Management > Supervisor Capability View menu to access the Supervisor Capability View page. |

| Step 2 | Click Manage Supervisor. The Manage Supervisor page opens. Use this page to assign users as Supervisors from the Available Users field. |

**Note** Supervisors are listed on the Supervisor Capability View page.

| Step 3 | Click Save. When you unassign a Supervisor from the Supervisor role, the Supervisor capabilities and the Advanced Supervisor Capabilities are unassigned for the Supervisor. |

## View Supervisor Details

From the Unified CCX Administration menu, choose Tools > User Management > Supervisor Capability View.

Click any Supervisor from the list of Supervisors to access the Supervisor page.

Use the Supervisor page to view the following:

- A list of teams, the role details of the Supervisor, and the Contact Service Queues (CSQs).
- The Advanced Supervisor Capabilities that are enabled for Primary and Secondary Supervisors.

## Assign an Existing Team to Secondary Supervisor

### Before you begin

- Use Manage Supervisors to add users as Supervisors.
- Use Teams to add new teams.
- Use Teams Configurations to assign a Primary Supervisor and Secondary Supervisors to the teams.

### Procedure

| Step 1 | From the Unified CCX Administration menu, choose Tools > User Management > Supervisor Capability View menu to access the Supervisor Capability View page. |

**Note** Supervisors are listed on the Supervisor Capability View page.

| Step 2 | From the Supervisor Name column, click any Supervisor from the list of Supervisors.

The Supervisor page opens.
Step 3 Click **Assign a Team** to assign teams to the Secondary Supervisors.

The **Assign a Team** pop-up window appears.

Step 4 From the **Team Name** drop-down list, select a team and click **Assign**.

The **Assigned Teams** table lists the teams that are assigned to the Supervisor roles and the CSQs that are associated with the teams.

### Assign Advanced Supervisor Capabilities

Use the **Supervisor** page to enable or disable one or more Advanced Supervisor Capabilities for Supervisors.

**Note** If you assign capabilities to supervisors through API, ensure that at least one calendar, one campaign, or one application is assigned accordingly. If proper assignment is not done, the supervisors will be able to view the capabilities in Finesse but none of the details will be listed.

### Procedure

**Step 1** From the Unified CCX Administration menu, choose **Tools > User Management > Supervisor Capability View** menu to access the **Supervisor Capability View** page.

**Note** Supervisors are listed on the **Supervisor Capability View** page.

**Step 2** From the **Supervisor Name** column, click any Supervisor from the list of Supervisors.

The **Supervisor** page opens.

**Step 3** Assign one or more Advanced Supervisor Capabilities to the Supervisor. From the **Advanced Supervisor Capabilities**, perform the following:

a) To enable the **Queue Management** capability for the Supervisor, check **Assign Queue Management**.

**Note** A team and at least a CSQ that is associated with the team must be assigned to the Supervisor to enable **Queue Management** capability.

b) To enable **Calendar Management** capability for the Supervisor, check the calendars from the **Calendar Name** column.

c) To enable **Outbound Campaign Management** capability, check one or more outbound campaigns from the table in the **Campaign Name** column.

d) To enable **Application Management** capability, check one or more applications from the table in the **Application Name** column.

**Step 4** Click **Save**.

### Reporting Capability View Menu

From the Unified CCX Administration menu bar, choose **Tools > User Management > Reporting Capability View** to access the capability view for the Historical Report Users area.
The capability view for the Reporting Management web page contains a pane for users identified as Unified CCX Historical Report Users and another pane with the list of Available Users. Based on your requirements, you can move users back and forth between these two panes by clicking the arrows in either direction.

**Note**

You cannot assign Reporting capability to a user ID that is the same as the application administrator user ID created during the Unified CCX installation. If you assign Reporting capability to such a user ID, an error appears.

The following users can access Unified Intelligence Center:

<table>
<thead>
<tr>
<th>Roles</th>
<th>Access</th>
<th>Available reports</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application administrator</td>
<td>Super user</td>
<td>• Historical reports</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Live Data reports</td>
</tr>
<tr>
<td>Reporting user</td>
<td>Unified CCX administrator must assign</td>
<td>• Historical reports</td>
</tr>
<tr>
<td></td>
<td>this role to a user.</td>
<td>• Live Data reports</td>
</tr>
<tr>
<td>Supervisor</td>
<td>Unified CCX administrator must assign</td>
<td>Live Data reports</td>
</tr>
<tr>
<td></td>
<td>this role to a user.</td>
<td></td>
</tr>
<tr>
<td>Agent</td>
<td>Unified CCX administrator must assign</td>
<td>Agent-specific Live Data reports</td>
</tr>
<tr>
<td></td>
<td>this role to a user.</td>
<td></td>
</tr>
</tbody>
</table>

**Assign Prompts**

Use this page to assign prompts to applications. The prompts must be explicitly assigned to an application when a new application is created or a new prompt is uploaded. When you upgrade to Unified CCX 12.5(1), the system behavior is as follows:

- All the prompts that were there prior to the upgrade will be assigned to all the applications.
- When you upload a new prompt to a folder that was there prior to the upgrade, the prompt will be assigned to all the applications.

**Procedure**

1. **Step 1** Select **Tools > User Management > Assign Prompts.**

   **Note** If the system has only one application, by default, that application is selected.

2. **Step 2** On the **Assign Prompts** page, select an **Application** from the drop-down list.

3. **Step 3** Click **Assign/Unassign Prompts.**

4. **Step 4** In the **Assign/Unassign Prompts** window, select the required prompt files or folders from the left navigation pane.
   a) Click **Select All** to select all the folders.
b) Click **Unselect All** to clear the selection.

**Note**
- When you select all the files in a folder, the folder is also selected.
- When you add prompt files to a selected folder, the new prompt files are available for the respective supervisors.
- If you have selected an empty folder, add prompt files to that folder, the new prompt files are available for the respective supervisors.

**Step 5**  
Click **Save**.

---

### Agent Capability View Menu

From the Unified CCX Administration menu bar, choose **Tools > User Management > Agent Capability View** to access the capability view for Unified CCX agents.

The capability view for the Agent User Management web page contains a pane for users identified as Unified CCX Agents and another pane with the list of Available Users. Based on your requirements, you can move users back and forth between these two panes by clicking the arrows in either direction.

### Password Management

From the Unified CCX Administration menu bar, choose **Tools > Password Management**.

You can set the passwords for the following system users using this web page:

<table>
<thead>
<tr>
<th>User</th>
<th>Username</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Wallboard</td>
<td>uccxwallboard</td>
<td>This user can connect to Configuration and Historical databases and has read-only access to RtICDStatistics and RtCSQsSummary tables.</td>
</tr>
<tr>
<td>Recording SFTP</td>
<td>uccxrecording</td>
<td></td>
</tr>
<tr>
<td>Workforce Management</td>
<td>uccxworkforce</td>
<td></td>
</tr>
</tbody>
</table>
### User Description

<table>
<thead>
<tr>
<th>User</th>
<th>Username</th>
<th>Description</th>
</tr>
</thead>
</table>
| Historical Reporting      | uccxhruser | This user can connect to Configuration, Historical and Repository databases and has the following privileges:  
  - read-only access to Historical, Configuration, and Repository tables  
  - execute stored procedures  
  - create new stored procedures.  
  This user is used by coresident Unified Intelligence Center and Standalone Unified Intelligence Center (if configured) to connect to Unified CCX Database and execute historical reports.  
  This user is also used during initialization of Live Data gadgets in Finesse and Live Data reports in Unified Intelligence Center. |
| System Call Tracking (part of Real Time Monitoring Tool/ Analysis Manager) | uccxsct |                                                                                                                                              |

Click **Save** icon that displays in the toolbar in the upper left corner of the window or the **Save** button that displays at the bottom of the window. Click the **Clear** button to remove the data entered and to retain the existing passwords. You will see an error message if the old and new passwords are the same for any of the users. Click **Check Consistency** to confirm.

---

**Note**

- The maximum length of the password entered is limited to 80 characters.
- A new password cannot be one of the last five passwords used.
- There is no default password set. You must manually reset it for the first time.

In case of a High Availability deployment, the password change will not be propagated to the second node. You must access the AppAdmin web interface of the second node manually to change the password. In an HA setup, you will be able to see **Check Consistency** icon or button in the Password Management page. Use this button to check and confirm whether the passwords between the two nodes match or not. You will be able to see the status of the password check in the Password Management page.
If passwords are not same across the nodes, applications using these user credentials, such as Wallboard, Historical Reports and Live Data reports in Unified Intelligence Center and Finesse may not function. Ensure that the user passwords are same in both the nodes.

When one or more user passwords are not same across both the nodes, the following alert would be generated, **UserPasswordMismatchAcrossNodes**.
CHAPTER 20

Help Menu

The Help Menu of the Unified CCX Administration web interface provides access to online help for the Unified CCX system.

Use the Help menu to access configuration procedures and descriptions of Unified CCX components.

The Help menu contains the following menu options:

- **Contents and Index**—Choose this option to view the entire Unified CCX Administrator Guide online help system and index.
- **For this page**—Choose this option to view context-sensitive help.
- **Unified CCX Documentation on Cisco.com**—Choose this option to view the documentation index page.
- **About**—Choose this option to view Unified CCX version information.

The following sections describe the Help menu options.

- Contents and Index, on page 349
- For This Page Menu, on page 350
- Unified CCX Documentation Link, on page 350
- About Menu, on page 350

Contents and Index

To view the entire Unified CCX Administration Guide online help system and index, choose **Help > Contents and Index** from the Unified CCX Administration menu bar. The Unified CCX Administration Guide Online Help window opens.

When you click any topic in the top pane, the section of the online help that corresponds to that topic appears in the bottom pane.

The following table describes the menu options in the Unified CCX Administration Guide Online Help window.

<table>
<thead>
<tr>
<th>Menu Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Back</td>
<td>Returns you to the previous page.</td>
</tr>
<tr>
<td>Forward</td>
<td>Leads you to the next page.</td>
</tr>
</tbody>
</table>
For This Page Menu

To access context-sensitive help, open the web page for which you want help and choose Help > For This Page from the Unified CCX Administration menu bar. The Unified CCX Administration online help displays information that is specific to the open web page.

Unified CCX Documentation Link

To access the complete Unified CCX documentation set for Unified CCX, and Unified IP IVR, choose Help > Cisco Unified CCX Documentation on Cisco.com from the Unified CCX Administration menu bar. A new browser window opens to display the following documentation index page:


About Menu

To access Unified CCX version information, choose Help > About from the Unified CCX Administration menu bar. The Unified CCX Administration web page opens, displaying version information and package information.
Introduction

Cisco Finesse is a next-generation agent and supervisor desktop designed to provide a collaborative experience for the various communities that interact with your customer service organization. It helps improve the customer experience while offering a user-centric design to enhance customer care representative satisfaction as well.

Cisco Finesse provides:

- A browser-based administration console and a browser-based desktop for agents and supervisors; no client-side installations required.
- A single, customizable "cockpit", or interface, that gives customer care providers quick and easy access to multiple assets and information sources.
- REST APIs that simplify the development and integration of value-added applications and minimize the need for detailed desktop development expertise.

Finesse configuration changes are permitted on only the primary server. Access to Finesse administration console on the secondary server is read-only.

When you attempt to save the changes in Finesse administration console on the secondary node, you receive a message that administration on the secondary node is read-only.

Cisco Finesse Administration Console

Getting Started

This chapter describes the interfaces that you use to configure, administer, and maintain Cisco Finesse and describes how to access them.
Administration Tools

Cisco Finesse Administration Console

The Cisco Finesse administration console is a web-based interface used to configure system settings in Cisco Finesse. The administration console contains tabs to click and access the various administration features. The tab names and the associated tasks are:

- **Settings**: IP Phone Agent Settings.
- **Call Variables Layout**: Manage the call and ECC variables that appear on the agent desktop call control gadget, team performance gadget, and call popover.
- **Desktop Layout**: Make changes to the default desktop layout for agents and supervisors.
- **Phone Books**: Add, edit, or delete phone books or phone book contacts.
- **Reasons**: Add, edit, or delete Not Ready reason codes, Sign Out reason codes, or Wrap-Up reasons (Reason Codes are disabled for Packaged CCE deployments).
- **Team Resources**: Assign desktop layouts, phone books, reason codes, and wrap-up reasons to specific teams.
- **Workflows**: Create and manage workflows and workflow actions.

The features you configure in the administration console are case-sensitive. For example, you can create two workflows named WORKFLOW and workflow; or two phone books named BOOK and book.

Response Caching

To reflect the changes made to system settings in Finesse desktop, the administrator must clear server cache using the CLI

```
utils webproxy cache clear rest
```

Ensure that the agent browser is refreshed for the system settings changes to take effect.


Sign In to Cisco Finesse Administration Console

You can access the Cisco Finesse administration console only through HTTPS.

When you sign in to Cisco Finesse, always use the fully qualified domain name (FQDN) of the Cisco Finesse server in the URL.

Procedure

**Step 1**
Direct your browser to https://<FQDN>:8445/cfadmin, where *FQDN* is the fully qualified domain name of your primary Finesse server.

**Step 2**
The first time you access the administration console using HTTPS, you are prompted to trust the self-signed certificate provided with Finesse. The following table describes the steps for each supported browser.

| **Note** | If you are using HTTPS but have installed a CA Certificate, you can skip this step. For more information about installing a CA Certificate, see Cisco Finesse Installation and Upgrade Guide at https://www.cisco.com/c/en/us/support/customer-collaboration/finesse/products-installation-guides-list.html. |

---

Cisco Unified Contact Center Express Administration and Operations Guide, Release 12.5(1)
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Internet Explorer:</td>
<td>a. A page appears that states this site is untrusted.</td>
</tr>
<tr>
<td></td>
<td>b. Click More information &gt; Go on to the webpage.</td>
</tr>
<tr>
<td>Edge:</td>
<td>a. A page appears that states this site is untrusted.</td>
</tr>
<tr>
<td></td>
<td>b. Click Details and click Go on to the webpage.</td>
</tr>
<tr>
<td>Firefox:</td>
<td>a. A page appears that states this connection is untrusted.</td>
</tr>
<tr>
<td></td>
<td>b. Click I Understand the Risks, and then click Add Exception.</td>
</tr>
<tr>
<td></td>
<td>c. In the Add Security Exception dialog box, ensure that the check box is Permanently store this exception checked.</td>
</tr>
<tr>
<td></td>
<td>d. Click Confirm Security Exception.</td>
</tr>
<tr>
<td>Chrome:</td>
<td>a. A page appears that states this connection is not private.</td>
</tr>
<tr>
<td></td>
<td>b. Click Advanced.</td>
</tr>
<tr>
<td></td>
<td>c. Click the <a href="https://FQDN">https://FQDN</a> of Cisco Finesse Server/ link.</td>
</tr>
<tr>
<td></td>
<td>d. Enter your agent ID or username, password, and extension, and then click Sign In.</td>
</tr>
<tr>
<td></td>
<td>The following message appears:</td>
</tr>
<tr>
<td></td>
<td>Establishing encrypted connection...</td>
</tr>
<tr>
<td></td>
<td>A dialog box appears that lists the certificates to accept.</td>
</tr>
<tr>
<td></td>
<td>e. Click OK.</td>
</tr>
</tbody>
</table>

**Step 3**
On the Sign In page, in the ID field, enter the Application User ID that was used during the installation.

**Step 4**
In the Password field, enter the Application User password that was used during the installation.

**Step 5**
Click Sign In.

A successful sign in launches an interface with defined administration gadgets and a Sign Out link.

---

**Note**
After 30 minutes of inactivity, Cisco Finesse automatically signs you out of the administration console and you must sign in again.

**Sign In Using IPv6**
If you sign in to the Finesse Administration Console using an IPv6-only client, include the HTTPS port in the sign in URL in Step 1 of the preceding procedure.

https://<FQDN>:8445/cfadmin
The remaining steps of the sign in procedure remain the same for IPv6.

If you sign in to the Finesse Administration Console using an IPv6-only client, include HTTPS port in the sign in URL in Step 1 of the preceding procedure.

- For HTTPS access, enter:
  https://<FQDN>:8445/cfadmin

The remaining steps of the sign in procedure remain the same for IPv6.

Account Locked after Five Failed Sign in Attempts

If an administrator tries to sign in to the Finesse administrator console (or diagnostic portal) with the wrong password five times consecutively, Finesse blocks access to that user account for 30 minutes. For security reasons, Finesse does not alert the user that their account is locked. They must wait 30 minutes and try again.

Similarly, if agents or supervisors sign in to the desktop five times consecutively with the wrong password, Finesse blocks access to that user account. However, in this case, the lockout period is 5 minutes. This restriction also applies when agents and supervisors sign in using the mobile agent or Finesse IP Phone Agent (IPPA).

When an agent or supervisor account is locked, subsequent attempts to sign in, even with correct credentials, reset the lockout period to 5 minutes again. For example, if a locked user tries to sign in again after only 4 minutes, the lockout period is reset and the user must wait another 5 minutes. This reset does not apply to the administrator account.

To view if a user account is locked, enter the `file get activelog desktop recurs compress` CLI command.

Extract the zipped output and search the catalina.out logs (/opt/cisco/desktop/finesse/logs/catalina.out) for the following message referring to the locked username:

An attempt was made to authenticate the locked user "<username>"

Cisco Unified Operating System Administration

This interface is web-based and is used to perform the following system administration functions:

- **Show**: View information on cluster nodes, hardware status, network configuration, installed software, system status, and IP preferences.
- **Settings**: Display and change IP settings, network time protocol (NTP) settings, SMTP settings, time, and version.
- **Security**: Manage certificates and set up and manage IPSec policies.
- **Software Upgrades**: Perform and upgrade or revert to a previous version.
- **Services**: Use the Ping and Remote Support features.
Sign In to Cisco Unified Operating System Administration

Procedure

Step 1  Direct your browser to https://FQDN:8443/cmplatform, where FQDN is the fully-qualified domain name of your server.

Step 2  Sign in with the username and password for the Administrator User account.

Note  After you sign in, you can access other Unified Communications Solutions tools from the Navigation drop-down list.

Certificate Management

Finesse provides a self-signed certificate that use or provide a CA certificate. You can obtain a CA certificate from a third-party vendor or produce one internal to your organization.

Finesse does not support wildcard certificates. After you upload a root certificate signed by a certificate authority (CA), the self-signed certificates are overwritten.

If you use the Finesse self-signed certificate, agents must accept the security certificates the first time they sign in to the desktop. If you use a CA certificate, you can accept it for the browser on each client or deploy a root certificate using group policies.

Note  If there is a mismatch between the server hostname and the certificate hostname, a certificate address mismatch warning message is displayed in IE. The certificate must be regenerated so that the hostname matches the server hostname before importing to Finesse. If there is a valid reason for the mismatch, uncheck the Warn about certificate address mismatch checkbox from Tools > Internet Options > Advanced > Security to allow the certificate to be accepted.

Obtain and Upload CA Certificate

Note  This procedure only applies if you are using HTTPS and is optional. If you are using HTTPS, you can choose to either obtain and upload a CA certificate or use the self-signed certificate provided with Finesse.

To eliminate browser security warnings each time you sign in, obtain an application and root certificate signed by a CA. Use the Certificate Management utility from Cisco Unified Operating System Administration.

To open Cisco Unified Operating System Administration in your browser, enter:

https://hostname of primary UCCX server/cmplatform

Sign in using the username and password for the Application User account created during Finesse installation.
You can find detailed explanations in the Security topics of the Cisco Unified Operating System Administration Online Help.

Procedure

**Step 1** Generate a CSR.
- a) Click Security > Certificate Management > Generate CSR.
- b) From the Certificate Name drop-down list, choose tomcat and click Generate CSR.

**Step 2** Download the CSR.
- a) Select Security > Certificate Management > Download CSR.
- b) From the Certificate Name drop-down list, choose tomcat and click Generate CSR.

**Step 3** Generate and download a CSR for the secondary Unified CCX server.
To open Cisco Unified Operating System Administration for the secondary server in your browser, enter:
https://hostname of secondary UCCX server/cmplatform

**Step 4** Use the CSRs to obtain the CA root certificate, intermediate certificate, and signed application certificate from the Certificate Authority.
- **Note** To set up the certificate chain, you must upload the certificates in the order described in the following steps.

**Step 5** When you receive the certificates, click Security > Certificate Management > Upload Certificate.

**Step 6** Upload the root certificate.
- a) From the Certificate Purpose drop-down list, select tomcat-trust.
- b) In the Upload File field, click Browse and browse to the root certificate file.
- c) Click Upload File.

**Step 7** Upload the intermediate certificate.
- a) From the Certificate Purpose drop-down list, choose tomcat-trust.
- b) In the Upload File field, click Browse and browse to the intermediate certificate file.
- c) Click Upload File.

**Step 8** Upload the application certificate.
- a) From the Certificate Purpose drop-down list, choose tomcat.
- b) In the Upload File field, click Browse and browse to the application certificate file.
- c) Click Upload File.

**Step 9** Restart both the Unified CCX nodes in the cluster.

**Client-Side Certificate Acceptance**

There are procedures that agents must perform to accept certificates the first time they sign in. The procedure type depends on the method you choose to manage certificates and the browser used by the agents.
Deploy Root Certificate for Internet Explorer

In environments where group policies are enforced via the Active Directory domain, the root certificate can be added automatically to each user's Internet Explorer. Adding the certificate automatically simplifies user configuration requirements.

To avoid certificate warnings, each user must use the FQDN of the Finesses server to access the desktop.

Procedure

Step 1
On the Windows domain controller, navigate to Administrative Tools > Group Policy Management.

Note
Users who have strict Group Policy defined on the Finesses Agent Desktop have to disable Cross Document Messaging from Group Policy Management to ensure proper functioning of Finesses on Internet Explorer 11.

Step 2
Right-click Default Domain Policy and select Edit.

Step 3
In the Group Policy Management Console, click Computer Configuration > Policies > Window Settings > Security Settings > Public Key Policies.

Step 4
Right-click Trusted Root Certification Authorities and select Import.

Step 5
Import the ca_name.cer file.

Step 6

Step 7
From the Configuration Model list, select Enabled.

Step 8
Sign in as a user on a computer that is part of the domain and open Internet Explorer.

Step 9
If the user does not have the certificate, run the command \gpupdate.exe /target:computer /force on the user's computer.

Set Up CA Certificate for Internet Explorer and Edge Browsers

After obtaining and uploading the CA certificates, the certificate must be automatically installed via group policy or all users must accept the certificate.

In environments where users do not log directly into a domain or group policies are not utilized, every Internet Explorer user in the system must perform the following steps once to accept the certificate:

Procedure

Step 1
In Windows Explorer, double-click the ca_name.cer file and then click Open.

Note
Here the ca_name is the name of your certificate.

Step 2
In the Certificate Import Wizard, select Current User.

Step 3
Click Install Certificate > Next > Place all certificates in the following store.

Step 4
Click Browse and choose Trusted Root Certification Authorities.
Step 5: Click OK > Next > Finish.
Step 6: Click Yes on the install a certificate from a CA prompt.
Step 7: To verify the certificate was installed, from the browser menu on IE, choose Tools > Internet Options.
Step 8: In the Content tab, click Certificates.
Step 9: In the Trusted Root Certification Authorities tab, ensure that the new certificate appears in the list.
Step 10: Restart the browser for certificate installation to take effect.

**Note** If using Internet Explorer 11, you may receive a prompt to accept the certificate even if signed by private CA.

---

**Set Up CA Certificate for Firefox Browser**

Every Firefox user in the system must perform the following steps once to accept the certificate:

**Note** To avoid certificate warnings, each user must use the FQDN of the Unified CCX server to access the desktop.

**Procedure**

**Step 1** From the Firefox browser menu, choose Options.
**Step 2** Go to Privacy and Security tab.
**Step 3** Under Certificates section, click View Certificates.
**Step 4** Select Authorities.
**Step 5** Click Import and browse to the ca_name.cer file.

**Note** Here the ca_name is the name of your certificate.

**Step 6** Check the Validate Identical Certificates check box.
**Step 7** Restart the browser for certificate to install.

**Set Up CA Certificate for Chrome Browser**

**Procedure**

**Step 1** In the browser, go to Settings.
**Step 2** In the Chrome browser, select Advanced Settings > Privacy and Security, click Manage Certificates.
**Step 3** In the Edge browser, select Privacy, search, and services. Under Privacy, click .
**Step 4** Click Trusted Root Certification Authorities tab.
**Step 5** Click Import and browse to the ca_name.cer file.

In the Trusted Root Certification Authorities tab ensure the new certificate appears in the list.
**Step 6**  
Restart the browser for the certificate to install.

---

**Trust Self-Signed Certificate**

Trust the self-signed certificate provided by Finess to eliminate browser warnings each time you sign in to the administration console or agent desktop.

If you have uploaded a CA certificate, you can skip this procedure.

**Procedure**

In your browser, enter the URL for the administration console (https://FQDN of primary server:portnumber/cfadmin) or the agent desktop (https://FQDN of primary server).

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| **If you use Internet Explorer:** | **a.** A page appears that states there is a problem with the website's security certificate. Click **Continue to this website (not recommended)**. The sign in page for the administration console (or agent desktop) appears with a certificate error in the address bar if the browser.  
**b.** Click **Certificate Error > View Certificates** to open the Certificate dialog box.  
**c.** In the Certificate dialog box, click **Install Certificate** to open the Certificate Import Wizard.  
**d.** Click **Next**.  
**e.** Choose **Place all certificates in the following store** and click **Browse**.  
**f.** Choose **Trusted Root Certification Authorities** and click **OK**.  
**g.** Click **Next > Finish**  
**h.** If a Security Warning dialog box appears asking if you want to install the certificate, click **Yes**.  
**i.** In the Successful Certificate Import dialog box, click **OK**.  
**j.** Enter your credentials and click **Sign In**. |
| **If you use Firefox:** | **a.** A page appears that states this connection is untrusted.  
**b.** Click **I Understand the Risks Add Exception**.  
**c.** In the Add Security Exception dialog box, ensure the **Permanently store this exception** check box is checked.  
**d.** Click **Confirm Security Exception**.  
The page that states this connection is untrusted automatically closes and the administration console (or agent desktop) loads.  
**e.** Enter your credentials and click **Sign In**. |
**Option** | **Description**
--- | ---
f. | For the agent desktop only, an error appears that states Finesse cannot connect to the Cisco Finesse Notification Service and prompts you to add a security exception for the certificates issued by the Finesse server.

Click **OK**.

### Add Certificate for HTTPS Gadget

Add a certificate for a secure HTTP (HTTPS) gadget to load the gadget on the Finesse desktop and successfully perform HTTPS requests to the Finesse server.

This process allows HTTPS communication between the Finesse gadget container and the third-party gadget site for loading the gadget and performing any API calls the gadget makes to the third-party server.

**Note**

A gadget that loads using HTTPS may still use HTTP communication between that gadget and the application server where it resides. If all traffic must be secure, the gadget developer must ensure that HTTPS is used to make API calls to the application server.

The certificate must be signed with a common name. The gadget URL in the desktop layout must use the same name (whether it uses an IP address or a FQDN) as the name with which the certificate is signed. If the certificate name and the name in the gadget URL do not match, the connection is not trusted and the gadget does not load.

To find the certificate name, enter the gadget URL in your browser. Click the lock icon in the address bar and then click View Details. Look for the common name field.

The Finesse host must be able to resolve this name using the DNS host entered during the installation. To verify that Finesse can resolve the name, run the CLI command **utils network ping <hostname>**.

### Procedure

**Step 1**  
Download the certificate from the third-party gadget host.

**Step 2**  
Upload the certificate to the designated Finesse system.

a) Sign in to Cisco Unified Operating System Administration on the primary Unified CCX node (https://*FQDN/cmplatform*, where *FQDN* is the fully qualified domain name of the Unified CCX node).

b) Click **Security > Certificate Management**.

c) Click **Upload Certificate/Certificate Chain**.

d) From the Certificate Name drop-down list, select **tomcat-trust**.

e) Click **Browse** and navigate to the tomcat.pem file that you downloaded in the previous step.

f) Click **Upload File**.

**Step 3**  
Restart Cisco Tomcat on the primary Unified CCX node.

**Step 4**  
Restart Cisco Finesse Tomcat on the primary Unified CCX node.

**Step 5**  
After synchronization is complete, restart Cisco Tomcat on the secondary Unified CCX node.
Step 6  Restart Cisco Finesse Tomcat on the secondary Unified CCX node.

Add Certificate for Multi-session Chat and Email

Add the Customer Collaboration Platform certificate to the Unified CCX servers to allow communication between Customer Collaboration Platform and Finesse. After you complete this procedure, agents must accept certificates in the Finesse desktop before they can use this gadget.

If Customer Collaboration Platform is deployed with private certificates, agents cannot join chat rooms or reply to email messages until they accept the Customer Collaboration Platform certificates. If the Manage Chat and Email gadget is deployed on the Manage Chat and Email tab of the Finesse desktop, agents may not realize that they need to accept the certificates. Have agents check the tab where the gadget appears when they sign in to Finesse to make sure that certificates are all accepted and the gadget loads correctly.

The steps to add a certificate for the Manage Chat and Email gadget are the same as the steps outlined in the procedure Add Certificate for HTTPS Gadget.

Note  The procedure to add a certificate for an HTTPS gadget refers to the third-party gadget host. To add a certificate for chat and email, perform the applicable steps on the Customer Collaboration Platform server.

Related Topics  Add Certificate for HTTPS Gadget, on page 360

Manage System Settings

Note  For information about Finesse IP Phone Agent Settings, see Manage Finesse IP Phone Agent.

Related Topics  Manage Finesse IP Phone Agent, on page 441

Desktop Chat Server Settings

Desktop Chat is an XMPP browser based chat, which is powered by Cisco Instant Messaging and Presence (IM&P) service. It provides presence and chat capabilities within the Unified CM platform. For more details, see Configuration and Administration of the IM and Presence Service at https://www.cisco.com/c/en/us/support/unified-communications/unified-communications-manager-callmanager/products-installation-and-configuration-guides-list.html.

Desktop Chat connects to Cisco IM&P servers over port 5280 from the browser hosting the agent desktop. IM&P server visibility and port accessibility needs to be ensured if clients intend to use this feature. The Desktop Chat gadget configures the IM&P host BOSH URL’s used by the desktop to communicate with the IM&P server over BOSH HTTP.

IM&P has a clustered design, where users are distributed across multiple nodes in the cluster. The Desktop Chat initially discovers the IM&P nodes that a user has configured, caches this information and communicates with the actual server for subsequent login, until the browser cache is cleared. To spread the initial discovery load, it is advisable to configure the nodes in a round robin fashion if the deployment has more than one
Finesse cluster. For example, if there are 5 IM&P nodes configure Finesse cluster A with node 1 & 2, Finesse cluster B with nodes 3 & 4, and so on.

Node availability should be considered while configuring the IM&P URL. The secondary node will be available for discovery in scenarios where the first node is not reachable. The secondary node will be connected for discovery only if the primary node is unreachable.

For the URL to be configured, refer Cisco Unified Presence Administration service, in System, Service Parameters. Choose the required IM&P server, select Cisco XCP Web Connection Manager. The URL binding path is listed against the field HTTP Binding Path. The full URL to be configured in Finesse is https://<hostname>:5280/URL-binding-path.

For more information on the Desktop Chat design, refer to the Solution Design Guide for Cisco Unified Contact Center Express.

Use the Desktop Chat Server Settings to configure chat settings for the Finesse desktop. The following table describes the fields on the Desktop Chat Server Settings gadget.

<table>
<thead>
<tr>
<th>Field</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Primary Chat Server</td>
<td>Enter the IM&amp;P primary server URL of Desktop Chat.</td>
</tr>
<tr>
<td>Secondary Chat Server</td>
<td>Enter the IM&amp;P secondary server URL of Desktop Chat.</td>
</tr>
</tbody>
</table>

**Actions on the Desktop Chat Server gadget:**

- **Save**: Saves your configuration changes
- **Revert**: Retrieves the most recently saved server settings

---

**Important**

For Desktop Chat to work without any issues, ensure the following services are running on IM&P:

- Cisco Presence Engine
- Cisco XCP Text Conference Manager
- Cisco XCP Web Connection Manager
- Cisco XCP Connection Manager
- Cisco XCP Directory Service
- Cisco XCP Authentication Service
- Cisco XCP File Transfer Manager
Desktop Chat requires the Cisco IM and Presence certificates to be trusted. To start the Desktop Chat without experiencing an exception, you must add the certificate to the browser trust store, or configure IM and Presence with CA-signed certificate, or push self-signed certificate through group policies in supported browsers. For more information on accepting certificates, see the Accept Security Certificates section, in the Common Tasks chapter of Cisco Finesse Agent and Supervisor Desktop User Guide for Cisco Unified Contact Center Express at https://www.cisco.com/c/en/us/support/customer-collaboration/unified-contact-center-express/products-user-guide-list.html.

Note
Desktop Chat is not supported with the unrestricted versions of IM&P.

Configure Desktop Chat Server Settings

Procedure

Step 1
Sign into the administration console with the Application User credentials.

Step 2
In the Desktop Chat Server Settings area, enter the IM&P primary and secondary server URL of the Desktop Chat.

Step 3
Click Save.

Note
Desktop Chat requires Cisco Unified Presence 12.5 and higher versions.

Cloud Connect Server Settings

Cloud Connect is a component that hosts services that allow customers to use cloud capabilities such as Cisco Webex Experience Management. The administrator can configure the Cloud Connect server settings in the Finesse administration console to contact the Cisco cloud services.


The following table describes the fields on the Cloud Connect server settings gadget:

<table>
<thead>
<tr>
<th>Field</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Username</td>
<td>(mandatory) The Cloud Connect administrator username required to sign in to Cloud Connect.</td>
</tr>
<tr>
<td>Password</td>
<td>(mandatory) The Cloud Connect administrator password required to sign in to Cloud Connect.</td>
</tr>
<tr>
<td>Publisher Address</td>
<td>(mandatory) The hostname of the Cloud Connect publisher.</td>
</tr>
<tr>
<td>Subscriber Address</td>
<td>(optional) The hostname of the Cloud Connect subscriber.</td>
</tr>
</tbody>
</table>
Actions on the Cloud Connect Server Settings gadget:

- **Save**: Saves your configuration changes.
- **Revert**: Retrieves the most recently saved Cloud Connect server settings.

**Configure Cloud Connect Server Settings**

**Procedure**

1. **Step 1** Sign in to the administration console on the primary UCCX server using the URL: `https://FQDN of Unified CCX server:8445/cfadmin`.
2. **Step 2** Select **Settings > Cloud Connect Server Settings**.
3. **Step 3** Enter the **Username**, **Password**, and **Publisher Address** of the Cloud Connect server.
   (optional) Enter the **Subscriber Address** for multinode deployment.
4. **Step 4** Click **Save**.

**Keyboard Shortcuts**

Keyboard shortcuts provide an alternate way to perform a specific action on the Finesse agent and supervisor desktop. For more information, see Access Keyboard Shortcuts section in the Cisco Finesse Agent and Supervisor Desktop User Guide.

**Keyboard Shortcut Conflicts**

Keyboard shortcut conflicts occur if multiple gadgets use the same keyboard shortcut. This causes a particular key combination to be disabled until the conflict is resolved.

Keyboard shortcut conflicts at the page level can be resolved only by modifying the keyboard shortcuts at the gadget level. To modify the keyboard shortcuts at the gadget level, contact developer support services.

Keyboard shortcut conflict can occur in the following scenarios:

<table>
<thead>
<tr>
<th>Conflict Scenario</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Conflicts can occur between keyboard shortcuts at the page level and gadget level.</td>
<td>This conflict cannot be resolved by the Finesse administrator.</td>
</tr>
<tr>
<td>Conflicts can occur when two gadgets have the same keyboard shortcut, and both are in the same tab.</td>
<td>Move one of the gadgets to another tab.</td>
</tr>
<tr>
<td>Conflicts can occur when there are multiple instances of the same gadget and focus is on the active tab*.</td>
<td>Move one of the gadgets to another tab.</td>
</tr>
</tbody>
</table>

* - Active tab refers to the tab that is currently being used.

The administrator can use the CLI command to disable the keyboard shortcuts for the Finesse agent and supervisor desktop. For more information on CLI commands, see Desktop Properties.
After deploying the third-party gadgets, the administrator must sign in as an agent and a supervisor to check if there are any keyboard shortcut conflicts and resolve them.

• The third-party gadget providers can use the keyboard shortcuts JavaScript library as a guideline to provide a consistent desktop user experience.

Manage Call Variables Layouts

Call Variables Layouts

You can use the Call Variables Layouts gadget to define how call variables appear on the Finesse agent desktop. You can configure up to 200 unique Call Variables Layouts (one default and 199 custom layouts). As part of this functionality:

• Each layout has a name (required) and description (optional).

• You can change the name and description of the default Call Variables Layout.

• You cannot delete the default Call Variables Layout.

• Finesse appends (Default) to the name of the default Call Variables Layout.

• To display a custom Call Variables Layout, in the Unified CCX routing script, set the user.layout ECC variable to the name of a configured Call Variables Layout. In this case, if no custom layouts match the user.layout value (or no custom layouts are configured), Finesse displays the default layout.

• Finesse retains the custom layout as specified by the user/Layout ECC variable on CTI server failover. During PG failover, Finesse changes the active call layout to the default layout while retaining the call variables and time indicators.

Call Variables

Each Call Variables Layout supports one variable in the header of the call control gadget and up to a total of 20 variables in two columns below the header (up to 10 in each column). You can use call variables, Extended Call Context (ECC) variables, or the following Outbound Option ECC variables:

• BACampaign
• BAAccountNumber
• BAResponse
• BASTatus
• BADialedListID
• BATimeZone
• BABuddyName
• BACustomerNumber

Columns can be empty.
The administrator can include the following additional fields in the Call Variables Layout. These variables appear as a drop-down list in the call variable gadget which the admin can assign to a layout.

- queueNumber
- queueName
- callKeySequenceNum
- wrapUpReason

To enable Outbound Option data to appear in Cisco Finesse, the administrator must edit the Default Layout to include some or all Outbound Option variables.

**Edit Call Variables**

Administrator can set call variables (callVariable1 to callVariable10) values and ECC variable values as editable. Amongst BA (campaign-based outbound calls) variables, only BAResponse can be edited. The agent and the supervisor can edit the call variable values during an active call or in the wrap-up state.

**Note**

Call variables edit operation updates the values of the variables within the particular call. All entities listening to dialog events receive the updated call variables through the Cisco Finesse notifications. If any CTI clients are connected to the same CTI server, they also receive notifications of the changed call data though CTI call events. However, application scripts or databases that are used to populate the call variables are not directly affected by this edit.

**Call Variable Limits**

The following table lists the limits for the default call variable values:

<table>
<thead>
<tr>
<th>Resource</th>
<th>Limits (in bytes)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Call variables 1–10 (bytes)</td>
<td>For Unified CCX: 39</td>
</tr>
<tr>
<td>Maximum payload per ECC variable (bytes)</td>
<td>For Unified CCX: 210</td>
</tr>
<tr>
<td>Maximum total ECC payload size (bytes)</td>
<td>2000</td>
</tr>
</tbody>
</table>

**Configure Call Variables Layouts**

**Procedure**

**Step 1**

From the Manage Call Variables Layouts gadget:

- Click **New** to create a new Call Variables Layout.
- Choose a layout from the list and click **Edit** to modify an existing Call Variables Layout (or click **Delete** to remove it).
Step 2 Under **Create New Layout** (or under Edit <layout name> when editing an existing layout):

- Enter a name for the Call Variables Layout (maximum 40 characters).
- Enter a description of the Call Variables Layout (maximum 128 characters).

Step 3 Under Call Header Layout:

- Enter the display name that you want to appear in the header of the Call Control gadget on the Finesse desktop. For example, Customer Name (maximum 50 characters).
- From the drop-down list, choose the call variable or Outbound Option ECC variable that you want to appear in the header. For example, callVariable3 (maximum 32 characters).

Step 4 In the Call Body Left-Hand Layout and Call Body Right-Hand Layout areas:

a) Click **Add Row** to add a new row (or click the “X” to delete a row).

b) For each row:

- Enter the display name that you want to appear on the desktop. For example, Customer Name (maximum 50 characters).
- Enter the corresponding call variable or Outbound Option ECC variable from the drop-down list (maximum 32 characters).

Step 5 Select up to five call variables using the check box. The selected call variables are displayed in agent call popover and supervisor active call details.

**Note** If you do not select any call variables, the first two call variables from the Call Body Left-Hand layout area will be displayed in the agent call popover and supervisor active call details. If there are no call variables in the Left-hand layout area, then the call variables in the Right-Hand Layout will be selected.

Step 6 Turn on the toggle switch to enable the edit option for a specific call variable. By default, this option is turned off.

**Note**

- Call variable (callVariable1 to callVariable10) values are editable.
- ECC variable values are editable.
- Amongst BA variables (campaign-based outbound calls), only BAResponse value is editable.

Step 7 Click **Save** to save the changes, or **Cancel** to discard the changes.

**Note** When you modify the Call Variables Layout of the agent desktop, the changes you make take effect after three seconds. However, agents or supervisors who are signed in when the changes are made must sign out and sign back in to see those changes reflected on their desktops.

Step 8 To view the latest configured Call Variables Layout, click **Refresh** from the Manage Call Variables Layouts gadget.
Add ECC Variables to Call Variables Layout

Note
Cisco Finesse only supports Latin1 characters for ECC variables. Other Unicode characters are not supported. For example, if you add an ECC variable that contains Chinese characters to the call variable layout, it may not appear correctly on the agent desktop.

Procedure

Step 1  In the header or the row where you want the ECC variable to appear, from the Variable drop-down list, choose Custom.
Step 2  In the Custom/ECC Variable Name field, enter the name of the ECC variable you want to appear on the agent desktop.
Step 3  Click Set.

The ECC variable now appears in the Variable drop-down list for selection.

Assign Call Variables Layouts

Procedure

Step 1  In Cisco Unified CCX Editor, open the script for which you want to assign ECC call variables.
Step 2  Select Expanded Call Variables from Settings.
Step 3  Click New Variable icon.
Step 4  Create a variable with "user" as prefix.
For example: userSSN
Step 5  In Set Enterprise Call Info step of the script, add or modify the Expanded Call Variables.

Manipulate Call Variables Layouts with a Workflow

You can manipulate the call variables layout that an agent sees when a call is answered by using a workflow. To do so, configure an HTTP Request workflow action and set the value of the ECC variable user. Layout to the name of the custom layout to display.

For information about how and when workflows are executed, see Workflows and Workflow Actions.

For more details, see the section, "Adding an HTTP Request Workflow Action" in the white paper Cisco Finesse: How to Create a Screen-Pop Workflow.

Manage Desktop Layout

You can define the layout of the Finesse desktop on the Desktop Layout tab.
Requirements, such as processor speed and RAM, for clients that access the Finesses desktop can vary. Desktops that receive events for more than one agent (such as agent and supervisor desktops running Live Data reports that contain information about other agents and skill groups) require more processing power than desktops that receive events for a single agent.

Factors that determine how much power is required for the client include, but are not limited to, the following:

- Contact center traffic
- Additional integrated gadgets in the desktop (such as Live Data reports or third-party gadgets)
- Other applications that run on the client and share resources with the Finesses desktop

## Gadgets and Components

### Gadgets

Cisco Finesses is an OpenSocial gadget, which is an XML document that defines metadata for an OpenSocial Gadget container. The gadgets are applications that are placed within the Cisco Finesses desktop. This helps administrator to provide access to the contact center agents for all the applications that is required to service calls inside a single application.

Cisco Finesses comes with default gadgets such as, the teem performance gadget, call control gadget, and call popover. JavaScript library is available for any customers with specific requirements that are not available out of the box.

Gadgets are listed in the desktop layout using the `<gadget>` tag.

Third-party gadgets are hosted on the Cisco Finesses server using the 3rdpartygadget web application or on an external web server. Gadgets can make REST requests to services hosted on external servers using the Cisco Finesses JavaScript Library API. To avoid browser cross-origin issues, REST requests are proxied through the backend Shindig web application. Third-party gadgets must implement their own authentication mechanisms for third-party REST services.

For more information about gadgets, see [https://developer.cisco.com/docs/finesse/](https://developer.cisco.com/docs/finesse/).

### Components

Components are simple scripts that are loaded into the desktop directly at predefined positions as directed by the layout, without an enclosing frame and its document.

Components have been introduced in the desktop to overcome a few rendering limitations and performance considerations inherent to gadgets.

Components are listed in the desktop layout using the `<component>` tag. Currently, the layout validations prevent custom components from being created. Hence, only default components are allowed in the desktop layouts. The default desktop functionalities are currently registered as components to provide flexibility and to reduce the load on the server.

### Finesses Desktop Layout XML

The Finesses Layout XML defines the layout of the Finesses desktop, and the gadgets and components displayed on the desktop.
Use the Manage Desktop Layout gadget to upload an XML layout file to define the layout of the Finesse desktop for agents and supervisors.

Actions on the Manage Desktop Layout gadget are as follows.

- **Edit the code using any of the following editors:**
  - **Text Editor**
  - **XML Editor**

- **View Default Layout** - Displays the Cisco Finesse default layout.
- **Restore Default Layout** - Restores the Cisco Finesse desktop to the default layout.
- **Save** - Saves your configuration changes.
- **Revert** - Retrieves and applies the most recently saved desktop layout.

### Default Layout XML

The Finesse default desktop layout XML for Unified CCX contains optional tabs and gadgets for Web Chat and Email, Advanced Supervisor Capabilities, and notes that describe how to modify the layout for your deployment type.

Remove the comments from the optional gadgets and tabs that you want to appear on the Finesse desktop.

Remove any gadgets or tabs that you do not want to use.

The Manage Desktop Layout supports the following types of editors:

- **Text Editor**—A plain text editor. It is the default editor. You can use the Expand All option to see all the code details and Search text box to refine your search results.

- **XML Editor**—An XML editor.

  **Note**
  - You cannot add or edit comments (<!-- and -->) in the XML Editor.
  - In this document, all the examples that are related to desktop layout are applicable for text editor.

Both the editors support the following features:

- Expand and collapse option
- Syntax highlights and color code for the visual indication
- Auto-complete suggestions and hints for valid elements in the tags

Following are the updates available in the default layout XML in Unified CCX 12.5(1) release:

- Sample configurations for customizing desktop properties are added to the default layout (Desktop Layout) and team-specific layout (Team Resources > Desktop Layout).
For upgraded layouts, sample configurations for customizing desktop properties do not appear by default. The administrator must copy the XML from the View Default Layout and add to the respective custom layouts.

- Horizontal Header is available in the layout configuration and the Header can be customised.
- Title and Logo of Finesse desktop can be customised.
- Desktop Chat, Team Message, Dialer, Agent Identity, and Non-Voice State Control are added as part of the header component.
- Vertical tabs in Finesse desktop are moved to collapsable left navigation bar for which the icons can be customised.
- Support for inbuilt java script components has been added.
- The **ID** attribute (optional) is the ID of the HTML DOM element used to display the gadget or component. The ID should start with an alphabet and can contain alpha numeric characters along with hyphen(-) and underscore(_). It can be set through the Finesse Administrative portal and has to be unique across components and gadgets.
- The **managedBy** attribute (optional) for Live Data gadgets defines the gadgets which manage these Live Data gadgets. The value of **managedBy** attribute for Live Data gadgets is team-performance. This means that the rendering of the gadget is managed by the Team Performance gadget. These gadgets are not rendered by default, but will be rendered when the options Show State History and Show Call History are selected in the Team Performance gadget.

For upgraded layouts, the **managedBy** attribute will be introduced, and will have the value of the **ID** of the Team Performance gadget in the same tab. If there are multiple instances of Team Performance gadgets and Live Data gadget pairs, they will be associated in that order. If the **ID** of the Team Performance gadget is changed, the value of the **managedBy** attribute should also be updated to reflect the same **ID** for the Live Data gadgets. Otherwise, the Team Performance gadget instance will not show its respective Live Data gadgets.

- The **Hidden** attribute (optional) is used to support headless gadgets. When an attribute is set to "hidden=true", then the gadget is loaded by the container, but will not be displayed. The default value set for the attribute is "false".
- The **maxRow** attribute (optional) is used to adjust the height of the Team Performance gadget. If there are multiple instances of the Team Performance gadget, each instance height can be set by using this attribute. By default the **maxRow** attribute value is set to 10 rows.

Following are the updates available in the default layout XML in Unified CCX 11.6(1) release:

- Agents can view Recent Call History and Recent State History gadgets in My History tab.
- Supervisors can view Recent Call History and Recent State History gadgets in Manage Team tab.

Agents can view Recent Call History and Recent State History gadgets in My History tab.
Supervisors can view Recent Call History and Recent State History gadgets in Manage Team tab.
Important

After a system upgrade, the old desktop layout is retained. If you had a modified desktop layout before upgrade, perform the following steps to ensure you obtain the latest changes:

- Sign in to the Finesse administration console and click the Desktop Layout tab.
- Copy the desktop layout to a text file.
- On the Manage Desktop Layout gadget, click Restore Default Layout.
- Click Save.
- Using the text file of the desktop layout that you saved before the upgrade as a reference, modify the layout to include the changes that you made to the previous layout.
- Click Save to save your changes.

If any changes are made to the component IDs or URLs in the default XML layout, the following features may not work as expected.

Note

The components can be rearranged in any order to show on the Finesse desktop.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Component ID</th>
<th>URL</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title and Logo</td>
<td>cd-logo</td>
<td>&lt;url&gt;/desktop/scripts/js/logo.js&lt;/url&gt;</td>
</tr>
<tr>
<td>Voice State control</td>
<td>agent-voice-state</td>
<td>&lt;url&gt;/desktop/scripts/js/agentvoicestate.component.js&lt;/url&gt;</td>
</tr>
<tr>
<td>Non-voice state control</td>
<td>nonvoice-state-menu</td>
<td>&lt;url&gt;/desktop/scripts/js/nonvoice-state-menu.component.js&lt;/url&gt;</td>
</tr>
<tr>
<td>Team Message</td>
<td>broadcastmessagepopover</td>
<td>&lt;url&gt;/desktop/scripts/js/teammessage.component.js&lt;/url&gt;</td>
</tr>
<tr>
<td>Desktop Chat</td>
<td>chat</td>
<td>&lt;url&gt;/desktop/scripts/js/chat.component.js&lt;/url&gt;</td>
</tr>
<tr>
<td>Dialer</td>
<td>make-new-call-component</td>
<td>&lt;url&gt;/desktop/scripts/js/makenewcall.component.js&lt;/url&gt;</td>
</tr>
<tr>
<td>Agent identity</td>
<td>identity-component</td>
<td>&lt;url&gt;/desktop/scripts/js/identity-component.js&lt;/url&gt;</td>
</tr>
</tbody>
</table>

Update Default Desktop Layout

When you modify the layout of the Finesse desktop, the changes you make take effect on the desktop after 3 seconds. However, agents who are signed in when the changes are made must sign out and sign in again to see those changes reflecting on the desktop.

Note

- The call control gadget is only supported at the page level. You must ensure that the call control gadget (<gadget>/desktop/scripts/js/callcontrol.js</gadget>) is placed within the <page></page> tag for it to work correctly. Do not place this gadget within a <tab></tab> tag.

The version tag of Desktop Layout XML cannot be edited.
Procedure

**Step 1**  Click Desktop Layout.

**Step 2**  Select from the following editors:
- Text Editor
- XML Editor

**Step 3**  Make changes to the XML as required.

**Example:**

If you want to add a new tab called Reports, add the following XML within the tabs tags under the <role>Agent</role> tag:

```xml
<tab>
  <id>reports</id>
  <icon>Reports</icon>
  <label>Reports</label>
</tab>
```

If you want to add this tab to the supervisor desktop, add the XML within the tabs tags under the <role>Supervisor</role> tag.

To add a gadget to a tab, add the XML for the gadget within the gadgets tag for that tab.

```xml
<gadgets>
  <gadget>https://<ipAddress>/gadgets/<gadgetname>.xml</gadget>
</gadgets>
```

Replace <ipAddress> with the IP address of the server where the gadget resides.

If you want to add multiple columns to a tab on the Finesse desktop, add the gadgets for each column within the columns tags for that tab. You can have up to four columns on a tab.

```xml
<tabs>
  <tab>
    <id>home</id>
    <icon>home</icon>
    <label>finesse.container.tabs.agent.homeLabel</label>
    <columns>
      <column>
        <gadgets>
          <gadget>/desktop/scripts/js/queueStatistics.js</gadget>
        </gadgets>
      </column>
    </columns>
  </tab>
  <tab>
    <id>myHistory</id>
    <icon>history</icon>
    <label>finesse.container.tabs.agent.myHistoryLabel</label>
    <columns>
      <!-- The following gadgets are used for viewing the call history and state history of an agent. -->
    </columns>
  </tab>
</tabs>
```
Step 4  Click **Save**.

Finesse validates the XML file to ensure that it is valid XML syntax and conforms to the Finesse schema.

Step 5  After you save your changes, if you want to revert to the last saved desktop layout, click **Revert**. If you want to revert to the default desktop layout, click **Restore Default Layout**.

**Note**  During upgrade, any changes made to the Cisco Finesse Default Layout will be not be updated. You need to click on **Restore Default Layout** to get the latest changes.

---

**Drag-and-Drop and Resize Gadget or Component**

The administrator can configure the drag-and-drop and resize gadget or component features for the agents and supervisors to customize their Finesse desktop.

- The drag-and-drop feature allows the agents or supervisors to drag (and drop) the gadget or the component to the required position on the desktop layout.

- The resize feature allows the agents or supervisors to shrink or expand the gadget or the component to a custom size on the desktop layout.

**Note**  By default, the drag-and-drop and resize features are disabled. The administrator must set the `enableDragDropAndResizeGadget` desktop property value as `true` to enable these features.

The administrator can customize the desktop property value of these features through the desktop layout:

- Default layout (**Desktop Layout**)—In the **Text Editor**, remove the comment (<!---->) from the `enableDragDropAndResizeGadget` code snippet and enter the value as `true` to add these features to the desktop layout. For more information, see **Customize Desktop Properties**, on page 375.

  The following is the sample code snippet, as displayed in the default **Desktop Layout**.

  ```xml
  <!-- <config key="enableDragDropAndResizeGadget" value="false"/> -->
  ```

- Team-specific layouts (**Manage Team Resources > Desktop Layout**)—Select a specific team and then in the **Text Editor**, remove the comment (<!---->) from the `enableDragDropAndResizeGadget` code snippet and enter the value as `true` to add these features to the team desktop layout. For more information, see **Customize Desktop Properties at Team Level**, on page 429.

  The following is the sample code snippet, as displayed in the team **Desktop Layout**.

  ```xml
  <!-- <config key="enableDragDropAndResizeGadget" value="false"/> -->
  ```
Customize Desktop Properties

You can customize the Finesse desktop properties.

Procedure

Step 1  Click Desktop Layout.
Step 2  Select from the following editors:
   • Text Editor
   • XML Editor
Step 3  Enter the desktop property name in the config key tag.
Step 4  Enter the possible value of the desktop property in the value tag.

The following are the sample desktop property entries, as displayed in the default Desktop Layout. To change these desktop property entries in Text Editor, remove the comment (<!-- and -->) and set appropriate values.

```xml
<!-- <config key="enableDragDropAndResizeGadget" value="false"/> -->
<!-- <config key="wrapUpCountDown" value="true"/> -->
<!-- <config key="desktopChatAttachmentEnabled" value="true"/> -->
<!-- <config key="enableShortCutKeys" value="true"/> -->
```

Note  If the property value is defined in the Desktop Layout, then the Desktop Layout value takes precedence over the property value defined using the CLI. For more information on Finesse CLIs, see Desktop Properties.

The following table lists the supported desktop properties:

<table>
<thead>
<tr>
<th>Config Key</th>
<th>Value</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>enableDragDropAndResizeGadget</td>
<td>true/false</td>
<td>false</td>
</tr>
</tbody>
</table>
### Horizontal Header

The Horizontal Header on the Finesse desktop has the following components from left to right. All these components can be removed and replaced with custom gadgets as required.

- **Logo:** Default is Cisco logo. Can be customized.
- **Product Name:** Default is Cisco Finesse. Can be customized.
- **Agent State for Voice:** Displays agent state for voice call.
- **Agent State for Digital Channels:** Displays agent state for digital channels.
- **Dialer Component:** Agent can make a new call.
- **Identity Component:** Displays agent name and signout functionality with reason codes.

### Configurable Properties

<table>
<thead>
<tr>
<th>Config Key</th>
<th>Value</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>enableShortCutKeys</td>
<td>true/false</td>
<td>true</td>
</tr>
<tr>
<td>forceWrapUp</td>
<td>true/false</td>
<td>false</td>
</tr>
<tr>
<td>wrapUpCountDown</td>
<td>true/false</td>
<td>true</td>
</tr>
<tr>
<td>showWrapUpTimer</td>
<td>true/false</td>
<td>true</td>
</tr>
<tr>
<td>desktopChatAttachmentEnabled</td>
<td>true/false</td>
<td>true</td>
</tr>
<tr>
<td>desktopChatMaxAttachmentSize</td>
<td>Range: 1—10 (MB)</td>
<td>5</td>
</tr>
<tr>
<td>desktopChatUnsupportedFileTypes</td>
<td>Unsupported file formats include comma-separated valid file extensions. For example: .exe, .sh, .bat</td>
<td>.exe, .msi, .sh, .bat</td>
</tr>
<tr>
<td>showAgentHistoryGadgets</td>
<td>true/false</td>
<td>true</td>
</tr>
<tr>
<td>showActiveCallDetails</td>
<td>true/false</td>
<td>true</td>
</tr>
<tr>
<td>(for Supervisor Only)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>pendingDTMFThresholdCount</td>
<td>Range: 1—20</td>
<td>20</td>
</tr>
<tr>
<td>dtmfRequestTimeoutInMs</td>
<td>Range: 1000—200000 (1 to 200 seconds)</td>
<td>5000 (5 seconds)</td>
</tr>
</tbody>
</table>

For more information on Finesse desktop properties, see *Desktop Properties*.

**Step 5**

Click **Save**.

The change takes effect when the agent or supervisor refreshes the Finesse desktop or sign out and sign in again.

**Note** If you clear the **Override System Default** check box and click **Save**. The changes are overwritten, and the editing pane reverts to the default desktop layout XML.
Note
The sum of widths set for all gadgets and components in the header (inside right aligned columns and left aligned columns) should not exceed the total header width. If it exceeds the header width, some of the gadgets/components will not be visible.

Customize Title and Logo in the Header

You can customize the title and logo displayed on the Finesse desktop:

Procedure

Step 1
Click Desktop Layout.

Step 2
Select from the following editors:
  • Text Editor
  • XML Editor

Step 3
Enter the product name in the config value tag with title key.

Step 4
Upload the logo file just like any third-party gadget.
For more information, see section Upload Third-Party Gadgets in Cisco Finesse Admin Guide.

Step 5
Enter the URL of the logo file in the config value tag with logo key.

Example:

```
<configs>
  <!-- The Title for the application which can be customised.--> 
  <config value="product.full-name" Key="title"/>
  <!-- The logo file for the application--> 
  <!--<config key="logo" value="/3rdpartygadgets/<some_sample_image>"/>-->
</configs>
```

The customized logo and product name is displayed on the Finesse desktop.

Note
The file size that can be uploaded for the logo must be kept within 40 pixels. The file types supported are .svg, .png, .gif, and .jpeg/jpg.

alternateHosts Configuration

The <gadget> element in the Finesse Layout XML provides an attribute to specify alternate hosts from which the gadget can be loaded. This allows the Cisco Finesse desktop to load the gadget using a different host if the primary server is unavailable.

The alternateHosts attribute contains a comma-separated list of FQDNs that will be used if the primary-host-FQDN is unavailable.

```
<gadget alternateHosts="host1,host2,host3,...">
  https://<primary-host-FQDN>/gadget-URL
</gadget>
```
The `alternateHosts` attribute is only applicable for gadgets with an absolute URL. That is URLs containing the FQDN of a host, an optional port, and the complete URL path to the gadget. For example: 

```xml
<gadget alternateHosts="host1,host2">https://primary host/relative_path</gadget>
```

If loading the gadget from the primary-host fails, the Cisco Finesse container attempts to load the gadget from the alternate hosts in the order specified in the `alternateHosts` attribute.

The Cisco Finesse desktop may fail to load the gadget even if some of the hosts are reachable. In such cases, refresh the Cisco Finesse desktop.

When the gadget is specified with a relative URL, for example: 

```xml
<gadget >/3rdpartygadgets/relative_path</gadget>
```

the `alternateHosts` attribute does not apply and is ignored by the Cisco Finesse desktop.

---

**Note**

If the host serving the gadget fails after the Cisco Finesse desktop was successfully loaded, the desktop must be refreshed in order to load the gadget from an alternate host. The gadget does not implement its own failover mechanism.

---

**Headless Gadget Configuration**

Headless gadgets are gadgets which do not need a display space, but can be loaded and run like a background task in the browser. The `Hidden` attribute (optional) is used to support headless gadgets in the layout XML. When an attribute is set to "hidden=true", then the gadget is loaded by the container, but will not be displayed. The default value set for the attribute is "false".

---

**Customize Icons in Left Navigation Bar**

You can add icons (both custom and inbuilt) to the collapsible left navigation bar of the Finesse desktop:

**Procedure**

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>Click Desktop Layout.</td>
</tr>
</tbody>
</table>
| Step 2 | Select from the following editors:  
  - Text Editor  
  - XML Editor |
| Step 3 | Enter name of the gadget or component in the `id` tag. |
| Step 4 | Enter the value of the icon in the `icon` tag. |
| Step 5 | Upload the icon file just like any third-party gadget. |

For more information, see section *Upload Third-Party Gadgets* in *Cisco Finesse Admin Guide*.

**Note**

When adding a custom icon, provide the path in the `icon` tag and if you are adding an inbuilt icon, provide the icon value in the `icon` tag.

**Example:**
Customize Icons for Gadgets

As part of the Cisco Finesse container, various standard icons are available. Use the following procedure to customize the icons for the gadgets hosted in Finesse desktop.

**Procedure**

**Step 1** Click **Desktop Layout**.

**Step 2** Select from the following editors:

- Text Editor
- XML Editor

**Step 3** Enter the value of the icon in the icon tag. Get the icon name from the List of Icons, on page 380. The icon name is located on the right of the icon image. For example, search.

<table>
<thead>
<tr>
<th>Icon Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>search</td>
<td>Icon Name</td>
</tr>
<tr>
<td>dial</td>
<td>remove-contain</td>
</tr>
<tr>
<td>keyboard</td>
<td>remove-outline</td>
</tr>
<tr>
<td>close</td>
<td>close</td>
</tr>
<tr>
<td>exit-contain</td>
<td>exit-outlin</td>
</tr>
<tr>
<td>delete</td>
<td>exit-outline</td>
</tr>
<tr>
<td>trash</td>
<td>refresh</td>
</tr>
<tr>
<td>add</td>
<td>more</td>
</tr>
<tr>
<td>add-contain</td>
<td>sign-in</td>
</tr>
<tr>
<td>add-outline</td>
<td>forced-sign-in</td>
</tr>
<tr>
<td>Remove / Delete</td>
<td>sign-out</td>
</tr>
</tbody>
</table>

**Note** Icon name is case sensitive. Enter the icon name exactly as displayed in the List of Icons, on page 380.

**Example**

An example of the desktop layout using the **Search** and **Close-Keyboard** icons.
List of Icons

The following are the icons for Actions.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>🔍</td>
<td>search</td>
</tr>
<tr>
<td>☒</td>
<td>remove-contain</td>
</tr>
<tr>
<td>☐</td>
<td>remove-outline</td>
</tr>
<tr>
<td>✖</td>
<td>close</td>
</tr>
<tr>
<td>✖</td>
<td>exit-contain</td>
</tr>
<tr>
<td>☐</td>
<td>exit-outline</td>
</tr>
<tr>
<td>♻</td>
<td>refresh</td>
</tr>
<tr>
<td>+/-</td>
<td>more</td>
</tr>
<tr>
<td>🔍</td>
<td>sign-in</td>
</tr>
<tr>
<td>☐</td>
<td>forced-sign-in</td>
</tr>
<tr>
<td>☐</td>
<td>sign-out</td>
</tr>
</tbody>
</table>

The following are the icons for Audio.
**List of Icons**

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>🎤</td>
<td>microphone</td>
</tr>
<tr>
<td>🎤聋</td>
<td>mute</td>
</tr>
<tr>
<td>🎤</td>
<td>mic-in</td>
</tr>
<tr>
<td>🎤</td>
<td>speaker</td>
</tr>
<tr>
<td>🎤聋</td>
<td>speaker-cross</td>
</tr>
<tr>
<td>🎧聋</td>
<td>volume-cross</td>
</tr>
<tr>
<td>🎧聋</td>
<td>audio-min</td>
</tr>
<tr>
<td>🎧</td>
<td>audio</td>
</tr>
<tr>
<td>🎧聋</td>
<td>speaker-out-left</td>
</tr>
<tr>
<td>🎧聋</td>
<td>line-out-left</td>
</tr>
<tr>
<td>🎧聋</td>
<td>line-out-right</td>
</tr>
<tr>
<td>🎧聋</td>
<td>audio-settings</td>
</tr>
<tr>
<td>🎧聋</td>
<td>headset</td>
</tr>
<tr>
<td>🎧聋</td>
<td>headset-cross</td>
</tr>
<tr>
<td>🎧聋</td>
<td>active-speaker</td>
</tr>
<tr>
<td>🎧聋</td>
<td>locked-speaker</td>
</tr>
<tr>
<td>🎧聋</td>
<td>active-speaker-cross</td>
</tr>
<tr>
<td>🎧聋</td>
<td>bluetooth-contain-cross</td>
</tr>
<tr>
<td>🎧聋</td>
<td>handset-cross</td>
</tr>
</tbody>
</table>

The following are the icons for Camera.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>📹</td>
<td>video</td>
</tr>
<tr>
<td>📹聋</td>
<td>zoom-in</td>
</tr>
<tr>
<td>📹聋</td>
<td>zoom-out</td>
</tr>
<tr>
<td>📹聋</td>
<td>aux-camera</td>
</tr>
<tr>
<td>📹聋</td>
<td>self-view</td>
</tr>
<tr>
<td>📹聋</td>
<td>self-view-crossed</td>
</tr>
<tr>
<td>📹聋</td>
<td>self-view-alt</td>
</tr>
<tr>
<td>📹聋</td>
<td>web-camera</td>
</tr>
<tr>
<td>📹聋</td>
<td>camera</td>
</tr>
<tr>
<td>📹聋</td>
<td>swap-camera</td>
</tr>
<tr>
<td>📹聋</td>
<td>swap-video-camera</td>
</tr>
</tbody>
</table>

The following are the icons for Chat.
The following are the icons for Collaboration.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Icon</th>
<th>Icon</th>
</tr>
</thead>
<tbody>
<tr>
<td>schedule-add</td>
<td>leave-meeting</td>
<td>micro-blog</td>
</tr>
<tr>
<td>day</td>
<td>community</td>
<td>timeline</td>
</tr>
<tr>
<td>week</td>
<td>web-sharing</td>
<td>bookmark</td>
</tr>
<tr>
<td>calendar-icon-date</td>
<td>mobile-presenter</td>
<td>chapters</td>
</tr>
<tr>
<td>external-calendar</td>
<td>presentation</td>
<td>feedback</td>
</tr>
<tr>
<td>instant-meeting</td>
<td>slides</td>
<td>like</td>
</tr>
<tr>
<td>webex</td>
<td>point</td>
<td></td>
</tr>
<tr>
<td>meeting-room</td>
<td>extension-mobility</td>
<td></td>
</tr>
<tr>
<td>conference</td>
<td>participant-list</td>
<td></td>
</tr>
<tr>
<td>meet-me</td>
<td>browser</td>
<td></td>
</tr>
</tbody>
</table>

The following are the icons for Contacts.
The following are the icons for Content.

- attachment
- link
- document
- create-page
- move-page
- notes
- image
- folder
- export
- import
- watchlist
- playlist
- prevent-download
- prevent-download-container
- download
- download-contain
- upload
- upload-contain
- share
- share-contain

The following are the icons for Editor.
The following are the icons for Email.

- 🔄 email
- 🔄 send-email
- 🔄 read-email
- 🔄 spam
- 🔄 inbox
- 🔄 outbox
- 🔄 sent
- 🔄 universal-inbox
- ➡️ arrow-right-tail
- ⬅️ arrow-left-tail
- ⬅️ reply-all

The following are the icons for Hardware.
## List of Icons

<table>
<thead>
<tr>
<th>Display</th>
<th>Power</th>
</tr>
</thead>
<tbody>
<tr>
<td>Multi-display</td>
<td>DC-power</td>
</tr>
<tr>
<td>Soft-phone</td>
<td>AC-power</td>
</tr>
<tr>
<td>Video-input</td>
<td>Power-contain</td>
</tr>
<tr>
<td>Computer</td>
<td>Charging</td>
</tr>
<tr>
<td>Notebook-in</td>
<td>Battery</td>
</tr>
<tr>
<td>Devices</td>
<td></td>
</tr>
<tr>
<td>Idefix</td>
<td></td>
</tr>
<tr>
<td>Mobile-phone</td>
<td></td>
</tr>
<tr>
<td>Tablet</td>
<td></td>
</tr>
</tbody>
</table>

The following are the icons for Media.

<table>
<thead>
<tr>
<th>Image</th>
<th>Sound</th>
</tr>
</thead>
<tbody>
<tr>
<td>Music</td>
<td>Graph</td>
</tr>
<tr>
<td>Text</td>
<td>Tables</td>
</tr>
<tr>
<td>Zip</td>
<td></td>
</tr>
</tbody>
</table>

The following are the icons for Navigation.
The following are the icons for Network.

- wifi
- proximity
- proximity-not-connected
- bluetooth
- bluetooth-contained
- bluetooth-outline
- ethernet
- no-signal
- signal-1
- signal-2

The following are the icons for Notifications and Alerts.
The following are the icons for Phone.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>☑️</td>
<td>quality</td>
</tr>
<tr>
<td>⌚️</td>
<td>location</td>
</tr>
<tr>
<td>☑️</td>
<td>check</td>
</tr>
<tr>
<td>☑️</td>
<td>certified</td>
</tr>
<tr>
<td>⏳️</td>
<td>clock</td>
</tr>
<tr>
<td>🗡️</td>
<td>dms</td>
</tr>
<tr>
<td>☑️</td>
<td>running-application</td>
</tr>
<tr>
<td>🗝️</td>
<td>default-app</td>
</tr>
<tr>
<td>🗝️</td>
<td>pin</td>
</tr>
</tbody>
</table>

The following are the icons for Sources.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>☑️</td>
<td>call-forward-divert</td>
</tr>
<tr>
<td>☑️</td>
<td>merge-call</td>
</tr>
<tr>
<td>☛️</td>
<td>group-call</td>
</tr>
<tr>
<td>✉️</td>
<td>hunt-group</td>
</tr>
<tr>
<td>✉️</td>
<td>edit-call</td>
</tr>
<tr>
<td>☑️</td>
<td>intercom</td>
</tr>
<tr>
<td>☑️</td>
<td>intercom-whisper</td>
</tr>
<tr>
<td>☑️</td>
<td>intercom-duplex-connected</td>
</tr>
<tr>
<td>☑️</td>
<td>forward-to-mobility</td>
</tr>
<tr>
<td>☑️</td>
<td>transfer-to-mobile</td>
</tr>
</tbody>
</table>
The following are the icons for Settings.

- settings
- sliders
- user
- admin
- activities
- profile-settings
- ringer-settings
- language
- wallpaper
- manage-cables
- animation
- accessibility
- setup-assistant
- tools
- hue
- brightness
- volume
- call-rate
- vibrate
- time
- reset
- backup-data
- bug
- lock-contain
- ground
- storage
- data-usage
- numbered-inputs
- numbered-outputs

The following are the icons for Video Controls.
The following are the icons for Miscellaneous Icons.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>circle-bar chart</td>
<td>circle-pie chart</td>
</tr>
<tr>
<td>circle-column chart</td>
<td>unknown-customer</td>
</tr>
<tr>
<td>dashboard</td>
<td>circle-navigate</td>
</tr>
<tr>
<td>circle-gauge</td>
<td>circle-custom-widget</td>
</tr>
<tr>
<td>circle-line chart</td>
<td>grid</td>
</tr>
<tr>
<td>event</td>
<td>bar-chart</td>
</tr>
<tr>
<td>social</td>
<td>bars</td>
</tr>
<tr>
<td>web</td>
<td>text-and-font</td>
</tr>
<tr>
<td>node</td>
<td>report-view</td>
</tr>
<tr>
<td>formula</td>
<td>resize</td>
</tr>
</tbody>
</table>

For more information on customizing the visual experience, see Visual Design Kit at [https://developer.cisco.com/docs/finesse/#visual-design-guide](https://developer.cisco.com/docs/finesse/#visual-design-guide).
XML Schema Definition

You must ensure that the XML uploaded conforms to the XML schema definition for Finesse. The XML schema definition for Finesse is as follows:

```xml
<?xml version="1.0" encoding="UTF-8"?>
<xs:schema xmlns:xs="http://www.w3.org/2001/XMLSchema"
xmlns:xsd="http://www.w3.org/2001/XMLSchema"
xmlns:finesse="http://www.cisco.com/vtg/finesse"
targetNamespace="http://www.cisco.com/vtg/finesse"

elementFormDefault="qualified">
  <!-- definition of version element -->
  <xs:element name="version">
    <xs:simpleType>
      <xs:restriction base="xs:double">
        <xs:pattern value="[0-9.]+" />
      </xs:restriction>
    </xs:simpleType>
  </xs:element>
  <!-- The below elements are for common desktop header and configs -->
  <!-- If the common-desktop XSD changes, this too needs to be updated -->
  <!-- Only difference is that, column has been renamed to headercolumn, since column is already there in finesse desktop layout -->
  <xs:complexType name="configs">
    <xs:sequence>
      <xs:element name="config" type="config" minOccurs="0" maxOccurs="unbounded" />
    </xs:sequence>
  </xs:complexType>
  <xs:complexType name="config">
    <xs:attribute name="key">
      <xs:simpleType>
        <xs:restriction base="xs:string">
          <xs:pattern value="[a-zA-Z]*" />
        </xs:restriction>
      </xs:simpleType>
    </xs:attribute>
    <xs:attribute name="value" type="xs:string" />
  </xs:complexType>
  <xs:complexType name="header">
    <xs:choice>
      <xs:sequence>
        <xs:element name="leftAlignedColumns" type="listOfColumns" minOccurs="1" maxOccurs="1" />
        <xs:element name="rightAlignedColumns" type="listOfColumns" minOccurs="0" maxOccurs="1" />
      </xs:sequence>
    </xs:choice>
  </xs:complexType>
  <xs:complexType name="component">
    <xs:sequence>
      <xs:element name="url" type="xs:string" minOccurs="1" maxOccurs="1" />
      <xs:element name="stylesheet" type="xs:string" minOccurs="0" maxOccurs="1" />
      <xs:attribute name="id" use="required">
        <xs:simpleType>
          <xs:restriction base="xs:string">
            <xs:pattern value=".+"></xs:pattern>
          </xs:simpleType>
        </xs:attribute>
    </xs:sequence>
  </xs:complexType>
</xs:schema>
```
<xs:simpleType name="role">
    <xs:restriction base="xs:string">
        <xs:enumeration value="Agent"/>
        <xs:enumeration value="Supervisor"/>
        <xs:enumeration value="Admin"/>
    </xs:restriction>
</xs:simpleType>

<!-- definition of simple elements -->
<xs:element name="id">
    <xs:simpleType>
        <xs:restriction base="xs:string">
            <xs:pattern value="[a-zA-Z](\[-_:\.a-zA-Z0-9\])*"/>
        </xs:restriction>
    </xs:simpleType>
</xs:element>

<xs:element name="label">
    <xs:simpleType>
        <xs:restriction base="xs:string">
            <xs:minLength value="1"/>
            <xs:pattern value="[^\r\n\s]+"/>
        </xs:restriction>
    </xs:simpleType>
</xs:element>

<xs:element name="icon" type="xs:anyURI"/>
<xs:element name="gadget">
</xs:complexType>
<xs:complexType name="listOfColumns">
    <xs:sequence>
        <xs:element name="headercolumn" type="headercolumn" minOccurs="1" maxOccurs="unbounded"/>
    </xs:sequence>
</xs:complexType>
<xs:complexType name="headercolumn">
    <xs:choice minOccurs="0" maxOccurs="1">
        <xs:element ref="gadget"/>
        <xs:element name="component" type="component"/>
    </xs:choice>
    <xs:attribute name="width">
        <xs:simpleType>
            <xs:restriction base="xs:string">
                <xs:pattern value="[0-9]+(px|%)"/>
            </xs:restriction>
        </xs:simpleType>
    </xs:attribute>
</xs:complexType>
</xs:complexType>

<!-- The above elements are for common desktop header and configs -->
<!-- definition of role type -->
<xs:simpleType name="role">
    <xs:restriction base="xs:string">
        <xs:enumeration value="Agent"/>
        <xs:enumeration value="Supervisor"/>
        <xs:enumeration value="Admin"/>
    </xs:restriction>
</xs:simpleType>

<!-- definition of simple elements -->
<xs:element name="id">
    <xs:simpleType>
        <xs:restriction base="xs:string">
            <xs:pattern value="[a-zA-Z](\[-_:\.a-zA-Z0-9\])*"/>
        </xs:restriction>
    </xs:simpleType>
</xs:element>

<xs:element name="label">
    <xs:simpleType>
        <xs:restriction base="xs:string">
            <xs:minLength value="1"/>
            <xs:pattern value="[^\r\n\s]+"/>
        </xs:restriction>
    </xs:simpleType>
</xs:element>

<xs:element name="icon" type="xs:anyURI"/>
<xs:element name="gadget">
</xs:complexType>
<xs:complexType name="listOfColumns">
    <xs:sequence>
        <xs:element name="headercolumn" type="headercolumn" minOccurs="1" maxOccurs="unbounded"/>
    </xs:sequence>
</xs:complexType>
<xs:complexType name="headercolumn">
    <xs:choice minOccurs="0" maxOccurs="1">
        <xs:element ref="gadget"/>
        <xs:element name="component" type="component"/>
    </xs:choice>
    <xs:attribute name="width">
        <xs:simpleType>
            <xs:restriction base="xs:string">
                <xs:pattern value="[0-9]+(px|%)"/>
            </xs:restriction>
        </xs:simpleType>
    </xs:attribute>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:simpleType>

</xs:attribute>
</xs:complexType>
<xs:complexType name="listOfColumns">
    <xs:sequence>
        <xs:element name="headercolumn" type="headercolumn" minOccurs="1" maxOccurs="unbounded"/>
    </xs:sequence>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
</xs:complexType>
<xs:pattern value="[a-zA-Z]([-_a-zA-Z0-9])*" />
</xs:restriction>
</xs:simpleType>
</xs:element>
<xs:element name="role" type="role" />
<xs:element name="gadgets">
  <!-- Grouping of a set of gadgets -->
  <xs:complexType>
    <xs:sequence minOccurs="0" maxOccurs="unbounded">
      <!-- No limit to number of gadget URIs for now -->
      <xs:element ref="gadget" />
      <!-- URI of the gadget xml -->
    </xs:sequence>
  </xs:complexType>
</xs:element>
<xs:element name="restrictWhiteSpace">
  <xs:complexType>
    <xs:sequence>
      <xs:element ref="column" minOccurs="0" maxOccurs="unbounded" />
    </xs:sequence>
  </xs:complexType>
</xs:element>
<xs:element name="page">
  <!-- Grouping of a set of persistent gadgets -->
  <xs:complexType>
    <xs:sequence minOccurs="0" maxOccurs="unbounded">
      <!-- No limit to number of gadget URIs for now -->
      <xs:element ref="gadget" />
      <!-- URI of the gadget xml -->
    </xs:sequence>
  </xs:complexType>
</xs:element>
<xs:element name="tab">
  <xs:complexType>
    <xs:sequence>
      <xs:element ref="id" />
      <!-- Id of the tab selector in the desktop -->
      <xs:element ref="icon" minOccurs="0" maxOccurs="1" />
      <xs:element ref="label" />
    </xs:sequence>
  </xs:complexType>
</xs:element>
Add Webchat and Email to Finesse

The Cisco Finesse default layout XML contains commented XML code for Web Chat and Email gadgets available for the Finesse desktop. Each gadget or tab is surrounded by comment characters ( <!-- and -->) and comments that describe what the tab or gadget is for and how to add it to the desktop.

The Chat and Email Control gadget is only supported at the page level. You must ensure that the Chat and Email Control gadget (<gadget>https://localhost/uccx-nvcontrol/gadgets/NonVoiceControl.xml</gadget>) is placed within the <page></page> tag. Placing this gadget within a <tab></tab> tag is not supported.

The procedure that you follow depends on your deployment. The following table describes when to use each procedure.
When to use Procedure

<table>
<thead>
<tr>
<th>When to use</th>
<th>Procedure</th>
</tr>
</thead>
<tbody>
<tr>
<td>Follow this procedure if you want to add Web Chat and Email to the Finesses desktop after a fresh installation or after an upgrade if you have not customized the default desktop layout.</td>
<td>Add Web Chat and Email to the default desktop layout.</td>
</tr>
<tr>
<td>Follow this procedure if you want to add Web Chat and Email and have customized the desktop layout.</td>
<td>Add Web Chat and Email to a custom desktop layout.</td>
</tr>
<tr>
<td>Follow this procedure if you want to add Web Chat and Email to the desktop only for specific teams.</td>
<td>Add Web Chat and Email to a team layout.</td>
</tr>
</tbody>
</table>

**Note**

After you add the Web Chat and Email gadgets, sign in to the Finesses desktop and make sure they appear the way you want. Agents who are signed into Finesses when you change the desktop layout must sign out and sign back in to see the change on their desktops.

**Add Web Chat and Email to the Default Desktop Layout**

**Note**

If you upgraded from a previous release but do not have a custom desktop layout, click **Restore Default Layout** on the Manage Desktop Layout gadget and then follow the steps in this procedure.

**Procedure**

**Step 1**
In the Finesses administration console, click the **Desktop Layout** tab.

**Step 2**
Select from the following editors:

- **Text Editor**
- **XML Editor**

**Step 3**
To add the Chat and Email Control gadget to the agent desktop, look for the following under the `<role>Agent</role>` tag and within the `<page>` tag:

```xml
<gadget>https://localhost/uccx-nvcontrol/gadgets/NonVoiceControl.xml</gadget>
```

**Step 4**
Remove the comments and comment characters (`<!--` and `-->`) that surround the gadget, leaving only the gadget (`<gadget>https://localhost/uccx-nvcontrol/gadgets/NonVoiceControl.xml</gadget>`).

**Step 5**
To add the Manage Chat and Email tab and gadget to the agent desktop, look for the following within the `<tabs>` tag:

```xml
<tab>
  <id>manageNonVoiceMedia</id>
  <label>finesses.container.tabs.agent.manageNonVoiceMediaLabel</label>
  <columns>
    <column>
      <gadgets>
        <gadget>https://my-CCP-server/multisession/ui/gadgets/multisession-reply-gadget.xml?gadgetHeight=590</gadget>
      </gadgets>
    </column>
  </columns>
</tab>
```
Step 6  Remove the comments and comment characters (<!-- and -->) that surround the tab.

Step 7  Replace my-CCP-server in the gadget URL with the fully-qualified domain name (FQDN) of your Customer Collaboration Platform server.

Step 8  Optionally, change the height of the Manage Chat and Email gadget.

Example:

The height specified in the gadget URL is 590 pixels. If you want to change the height, change the gadgetHeight parameter in the URL to the desired value. For example, if you want the gadget height to be 600 pixels, change the code as follows:

```xml
<gadget>https://my-CCP-server/multisession/ui/gadgets/multisession-reply-gadget.xml?gadgetHeight=600</gadget>
```

The default and minimum height of the Manage Chat and Email gadget is 590 pixels. If you do not specify a value for the gadgetHeight parameter or if you specify a value that is less than 590, the gadget defaults to 590 pixels.

Note  An agent can be configured to handle up to five chat contacts and five email contacts at a time. If the agent has the maximum number of contacts on the desktop, not all contacts are visible. If your agents are configured to handle the maximum number of contacts, you must increase the height of this gadget to a minimum of 570 pixels to ensure there is enough space for all of the contacts to appear.

Step 9  To add the Chat and Email Control gadget to the supervisor desktop, look for the following under the <role>Supervisor</role> tag and within the <page></page> tag:

```xml
<gadget>https://localhost/uccx-nvcontrol/gadgets/NonVoiceControl.xml</gadget>
```

Step 10 Remove the comments and comment characters (<!-- and -->), leaving only the gadget

```xml
<gadget>https://localhost/uccx-nvcontrol/gadgets/NonVoiceControl.xml</gadget>
```

Step 11 To add the Live Data report for Agent Chat Statistics to the supervisor desktop, look for the following:

```xml
<gadget>https://localhost:8444/cuic/gadget/LiveData/LiveDataGadget.xml?gadgetHeight=310&viewId=F2F1FC17100001440000014E5D48&filterId=ChatAgentStats.agentId=CL</gadget>
```

Step 12 Remove the comments and comment characters (<!-- and -->), leaving only the gadget.

Step 13 To add the Live Data report for Chat Queue Statistics to the supervisor desktop, look for the following:

```xml
<gadget>https://localhost:8444/cuic/gadget/LiveData/LiveDataGadget.xml?gadgetHeight=310&viewId=E42ED78100001440000007B0A4E5CA1&filterId=ChatQueueStatistics.queueName=CL</gadget>
```

Step 14 Remove the comments and comment characters (<!-- and -->), leaving only the gadget.

Step 15 To add the Manage Chat and Email tab and gadget to the supervisor desktop, look for the following within the <tabs></tabs> tag:

```xml
	<tab>
		<id>manageNonVoiceMedia</id>
		<label>finesse.container.tabs.supervisor.manageNonVoiceMediaLabel</label>
		<columns>
```
Add Webchat and Email to a Custom Desktop Layout

**Procedure**

**Step 1** In the Finesse administration console, click the **Desktop Layout** tab.

**Step 2** Select from the following editors:

- Text Editor
- XML Editor

**Step 3** Copy the XML code for the Chat and Email Control gadget for the agent desktop.

```
<gadget>https://localhost/uccx-nvcontrol/gadgets/NonVoiceControl.xml</gadget>
```

**Step 4** To add the gadget to the agent desktop, paste the code within the `<page></page>` tags under the Call Control gadget as follows:

```
<role>Agent</role>
<page>
    <gadget>/desktop/gadgets/CallControl.xml</gadget>
    <gadget>https://localhost/uccx-nvcontrol/gadgets/NonVoiceControl.xml</gadget>
</page>
```

**Step 5** To add the gadget to the supervisor desktop, paste the code within the `<page></page>` tags under the Call Control gadget as follows:

```
<role>Supervisor</role>
<page>
    <gadget>/desktop/gadgets/CallControl.xml</gadget>
    <gadget>https://localhost/uccx-nvcontrol/gadgets/NonVoiceControl.xml</gadget>
</page>
```

**Step 6** Copy the code for the agent Manage Chat and Email tab and gadget from the default layout XML.

```
<tab>
    <id>manageNonVoiceMedia</id>
    <label>finesse.container.tabs.agent.manageNonVoiceMediaLabel</label>
    <columns>
        <column>
            <gadgets>
                <gadget>https://my-CCP-server/multisession/ui/gadgets/multisession-reply-gadget.xml?gadgetHeight=590</gadget>
            </gadgets>
        </column>
    </columns>
</tab>
```

**Step 16** Remove the comments and comment characters (<!-- and -->) that surround the `tab`.

**Step 17** Replace my-CCP-server in the gadget URL with the fully-qualified domain name (FQDN) of your Customer Collaboration Platform server.

**Step 18** Optionally, change the height of the Manage Chat and Email gadget.

**Step 19** Click **Save**.
Step 7
Paste the code within the `<tabs></tabs>` tag for the agent role after the Manage Call tab:

```xml
tab
  id="manageCall"
  label="finesse.container.tabs.agent.manageCallLabel"
tab
  id="manageNonVoiceMedia"
  label="finesse.container.tabs.agent.manageNonVoiceMediaLabel"
column
gadgets
gadget=https://my-CCP-server/multisession/ui/gadgets/multisession-reply-gadget.xml?gadgetHeight=430
  </gadget>
column
</columns>
tag
```

Step 8
Replace `my-social-miner-server` with the FQDN of your Customer Collaboration Platform server.

Step 9
Optionally, change the height of the Manage Chat and Email gadget.

**Example:**
The height specified in the gadget URL is 430 pixels. If you want to change the height, change the `gadgetHeight` parameter in the URL to the desired value. For example if you want the gadget height to be 600 pixels, change the code as follows:

```xml
gadget=https://my-CCP-server/multisession/ui/gadgets/multisession-reply-gadget.xml?gadgetHeight=600
```

The default and minimum height of the Manage Chat and Email gadget is 430 pixels. If you do not specify a value for the `gadgetHeight` parameter or if you specify a value that is less than 430, the gadget defaults to 430 pixels.

**Note**
An agent can be configured to handle up to five chat contacts and five email contacts at a time. If the agent has the maximum number of contacts on the desktop, not all contacts are visible. If your agents are configured to handle the maximum number of contacts, you must increase the height of this gadget to a minimum of 570 pixels to ensure there is enough space for all of the contacts to appear.

Step 10
Copy the code for the Live Data gadgets for Agent Chat Statistics and Chat Queue Statistics from the default layout XML.

```xml
gadget=https://localhost:8444/cuic/gadget/LiveData/LiveDataGadget.xml?gadgetHeight=310&
  viewId=E2F1FC1710000144000001480A4E53D48&
  filterId=ChatAgentStats.agentId=CL
<gadget=https://localhost:8444/cuic/gadget/LiveData/LiveDataGadget.xml?gadgetHeight=310&
  viewId=E42ED788100001440000007B0A4E56A1&
  filterId=ChatQueueStatistics.queueName=CL
```

Step 11
Paste the code for these gadgets within the `<gadgets></gadgets>` tags for the tabs on which you want them to appear.
Step 12  Copy the code for the supervisor Manage Chat and Email tab and gadget from the default layout XML.

```xml
<tab>
  <id>manageNonVoiceMedia</id>
  <label>finesse.container.tabs.supervisor.manageNonVoiceMediaLabel</label>
  <columns>
    <column>
      <gadgets>
      </gadgets>
    </column>
  </columns>
</tab>
```

Step 13  Paste the code within the `<tabs>` tag for the supervisor role after the Manage Call tab:

```xml
<tab>
  <id>manageCall</id>
  <label>finesse.container.tabs.supervisor.manageCallLabel</label>
</tab>
<tab>
  <id>manageNonVoiceMedia</id>
  <label>finesse.container.tabs.supervisor.manageNonVoiceMediaLabel</label>
  <columns>
    <column>
      <gadgets>
      </gadgets>
    </column>
  </columns>
</tab>
```

Step 14  Replace my-social-miner-server with the FQDN of your Customer Collaboration Platform server.

Step 15  Optionally, change the height of the gadget.

Step 16  Click `Save`.

---

**Add Web Chat and Email to a Team Layout**

**Procedure**

**Step 1** In the Finesse administration console, click the **Desktop Layout** tab.

**Step 2** Select from the following editors:

- **Text Editor**
- **XML Editor**

**Step 3** Copy the XML code for the Chat and Email Control gadget for the agent desktop and paste it into a text file.

```xml
<gadget>https://localhost/uccx-nvcontrol/gadgets/NonVoiceControl.xml</gadget>
```

**Step 4** Copy the code for the agent Manage Chat and Email tab and gadget and paste it into your text file.

```xml
<tab>
  <id>manageNonVoiceMedia</id>
  <label>finesse.container.tabs.agent.manageNonVoiceMediaLabel</label>
  <columns>
```

---

Cisco Unified Contact Center Express Administration and Operations Guide, Release 12.5(1)
Step 5  Copy the code for the Live Data gadgets for Agent Chat Statistics and Chat Queue Statistics and paste it into your text file.

```xml
<gadget>https://localhost:8444/cuic/gadget/LiveData/LiveDataGadget.xml?gadgetHeight=310&viewId=F2F1FC171000014400001480A4E5d46&filterId=ChatAgentStats.agentId=CL</gadget>
<gadget>https://localhost:8444/cuic/gadget/LiveData/LiveDataGadget.xml?gadgetHeight=310&viewId=E42ED78810000144000007B0A4E5C1A&filterId=ChatQueueStatistics.queueName=CL</gadget>
```

Step 6  Copy the code for the supervisor Manage Chat and Email tab and gadget and paste it into your text file.

```xml
<tab>
  <id>manageNonVoiceMedia</id>
  <label>finesse.container.tabs.supervisor.manageNonVoiceMediaLabel</label>
  <columns>
    <column>
      <gadgets>
      </gadgets>
    </column>
  </columns>
</tab>
```

Step 7  Click the Team Resources tab.

Step 8  Select the team from the list of teams for which you want to add Web Chat and Email.

Step 9  Check the Override System Default check box.

Step 10  In the Resources for <team name> area, click the Desktop Layout tab.

Step 11  Select from the following editors:
- Text Editor
- XML Editor

Step 12  To add the Chat and Email Control gadget to the agent desktop, copy the code for the gadget from your text file and paste it within the <page></page> tags under the Call Control gadget as follows:

```xml
<role>Agent</role>
<page>
  <gadget>/desktop/gadgets/CallControl.xml</gadget>
  <gadget>https://localhost/uccx-nvcontrol/gadgets/NonVoiceControl.xml</gadget>
</page>
```

Step 13  To add the gadget to the supervisor desktop, paste the code within the <page></page> tags under the Call Control gadget as follows:

Step 14  To add the Manage Chat and Email tab and gadget to the agent desktop, copy the code from your text file and paste it within the <tabs></tabs> tag for the agent role after the Manage Call tab:
Step 15  Replace my-social-miner-server with the FQDN of your Customer Collaboration Platform server.

Step 16  Optionally, change the height of the Manage Chat and Email gadget.

Example:
The height specified in the gadget URL is 430 pixels. If you want to change the height, change the gadgetHeight parameter in the URL to the desired value. For example if you want the gadget height to be 600 pixels, change the code as follows:

```xml
<gadget>https://my-CCP-server/multisession/ui/gadgets/multisession-reply-gadget.xml?gadgetHeight=600</gadget>
```

The default and minimum height of the Manage Chat and Email gadget is 430 pixels. If you do not specify a value for the gadgetHeight parameter or if you specify a value that is less than 430, the gadget defaults to 430 pixels.

Note  An agent can be configured to handle up to five chat contacts and five email contacts at a time. If the agent has the maximum number of contacts on the desktop, not all contacts are visible. If your agents are configured to handle the maximum number of contacts, you must increase the height of this gadget to a minimum of 570 pixels to ensure there is enough space for all of the contacts to appear.

Step 17  To add the Live Data gadgets for Web Chat and Email to the supervisor desktop:
   a)  Copy the code for the Agent Chat Statistics Live Data gadget from your text file and paste it within the <gadgets></gadgets> tags for the tab on which you want it to appear.
   b)  Copy the code for the Chat Queue Statistics Live Data gadget from your text file and paste it within the <gadgets></gadgets> tags for the tab on which you want it to appear.

Step 18  To add the Manage Chat and Email tab gadget to the supervisor desktop, copy the code from your text file and paste it within the <tabs></tabs> tag for the supervisor role after the Manage Call tab:
Step 19 Replace my-social-miner-server with the FQDN of your Customer Collaboration Platform server.

Step 20 Optionally, change the height of the gadget.

Step 21 Click Save.

Enable Advanced Supervisor Capabilities in Finesse

The Cisco Finesse default layout XML contains commented XML code of Advanced Supervisor Capabilities gadget for the Finesse desktop. Each gadget or tab is surrounded by comment characters (<!-- and -->) and comments that describe what the tab or gadget is for and how to add it to the desktop.

Note The Advanced Supervisor Capability is designed for only supervisors.

The procedure that you must follow to enable the gadget depends on your deployment. The following table describes when to use each procedure.

<table>
<thead>
<tr>
<th>Procedure</th>
<th>When to use</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable Advanced Supervisor Capabilities for Default Desktop Layout</td>
<td>Follow this procedure if you want to enable Advanced Supervisor Capabilities in the Finesse desktop after a fresh installation or after an upgrade if you have not customized the default desktop layout.</td>
</tr>
<tr>
<td>Add Advanced Supervisor Capabilities in Custom Desktop Layout</td>
<td>Follow this procedure if you want to add Advanced Supervisor Capabilities and have customized the desktop layout.</td>
</tr>
<tr>
<td>Add Advanced Supervisor Capabilities to a team layout.</td>
<td>Follow this procedure if you want to add Advanced Supervisor Capabilities to the desktop for specific teams.</td>
</tr>
</tbody>
</table>

Note After you enable the Advanced Supervisor Capabilities gadget, sign in to the Finesse desktop as a supervisor and ensure that they appear the way you want. When you change the desktop layout, supervisors who are signed in to Finesse must sign out and sign in again to see the change on their desktops.

Enable Advanced Supervisor Capabilities in Default Desktop Layout

If you upgraded from a previous release but do not have a custom desktop layout, click Restore Default Layout on the Manage Desktop Layout gadget and then follow the steps in this procedure.

Note Perform this task only once at the beginning of Default Desktop Layout modification. If you do it later, the previous changes will be lost.
Add Advanced Supervisor Capabilities in Custom Desktop Layout

Procedure

Step 1  In the Finesse administration console, click the Desktop Layout in the left pane. Manage Desktop Layout page is displayed with Desktop Layout XML.

Step 2  Select from the following editors:
  • Text Editor
  • XML Editor

Step 3  To enable Advanced Supervisor Capabilities gadget in the supervisor desktop, look for the following under the <role>Supervisor</role> tag:

```xml
<id>ASCGadget</id>
```

Step 4  Remove the comments and comment characters (<!-- and -->) that surround the gadget, leaving only the gadget <gadget>https://localhost/ascgadget/gadgets/ascgadget.xml</gadget>.

Step 5  Click Save.

Note  Ensure that the gadget is available only for supervisors.
Add Advanced Supervisor Capabilities in Team Layout

Procedure

Step 1 In the Finesse administration console, click the Desktop Layout in the left pane. Manage Desktop Layout page is displayed with Desktop Layout XML.

Step 2 Select from the following editors:
   • Text Editor
   • XML Editor

Step 3 Copy the XML code of Advanced Supervisor Capabilities gadget.
   <gadget>https://localhost/ascgadget/gadgets/ascgadget.xml</gadget>

Step 4 Click the Team Resources in the left pane.

Step 5 Select the team from the list of teams for which you want to add Advanced Supervisor Capabilities.

Step 6 Check the Override System Default check box.

Step 7 In the Resources for <team name> area, click the Desktop Layout tab.

Step 8 Select from the following editors:
   • Text Editor
   • XML Editor

Step 9 In the XML, look for the <role>Supervisor</role> tag.

Step 10 Paste the copied code within the <tab> </tab> tags in the XML, below the WeChat and Email gadget as follows:

<tab>
  <id>ASCGadget</id>
  <icon>admin</icon>
  <label>finesse.container.tabs.supervisor.advancedcapabilities</label>
  <column>
    <column>
      <gadgets>
        <gadget>https://localhost/ascgadget/gadgets/ascgadget.xml</gadget>
      </gadgets>
    </column>
  </column>
</tab>

Note Ensure that the gadget is available only for supervisors.

Step 11 Click Save.
Add Team Message in Custom Desktop Layout

Procedure

Step 1  In the Finesse administration console, click the Desktop Layout in the left pane. Manage Desktop Layout page is displayed with Desktop Layout XML.

Step 2  Select from the following editors:
  • Text Editor
  • XML Editor

Step 3  Copy the XML code where component id="broadcastmessagepopover".
<component id="broadcastmessagepopover">
  <url>/desktop/scripts/js/teammessage.component.js</url>
</component>

Step 4  Click the Team Resources in the left pane.

Step 5  Check the Override System Default check box.

Step 6  In the Resources for <team name> area, click the Desktop Layout tab.

Step 7  Select from the following editors:
  • Text Editor
  • XML Editor

Step 8  In the XML, look for the </headercolumn> tag in the XML.

Step 9  Paste the copied code below the </headercolumn> tag as follows:

<headercolumn width="50px">
  <component id="broadcastmessagepopover">
    <url>/desktop/scripts/js/teammessage.component.js</url>
  </component>
</headercolumn>

Step 10  Click Save.

Add Desktop Chat in Custom Desktop Layout

Procedure

Step 1  In the Finesse administration console, click the Desktop Layout in the left pane. Manage Desktop Layout page is displayed with Desktop Layout XML.

Step 2  Select from the following editors:
  • Text Editor
  • XML Editor

Step 3  Copy the XML code where component id="chat".
<component id="chat">
    <url>/desktop/scripts/js/chat.component.js</url>
</component>

Step 4 Click the Team Resources in the left pane.

Step 5 Check the Override System Default check box.

Step 6 In the Resources for <teamname> area, click the Desktop Layout tab.

Step 7 Select from the following editors:

   • Text Editor
   • XML Editor

Step 8 In the XML, look for the </headercolumn> tag in the XML.

Step 9 Paste the copied code below the </headercolumn> tag as follows:

   <headercolumn width="50px">
     <component id="chat">
       <url>/desktop/scripts/js/chat.component.js</url>
     </component>
   </headercolumn>

Step 10 Click Save.

---

**Live Data Gadgets**

Cisco Finesse for Unified CCX supports Live Data gadgets. Live Data gadgets display information about the current state of the contact center. The gadgets receive data from the real-time data source at frequent intervals and display reports in grid format only.

Cisco Unified Intelligence Center provides Live Data real-time reports that you can add to the Cisco Finesse agent and supervisor desktop.

This feature provides the following access:

   • Agents can access the Live Data agent reports.

   • Supervisors can access the Live Data supervisor reports.

**Gadgets URLs for Reports**

The following table displays gadgets URLs for reports.
<table>
<thead>
<tr>
<th>Users</th>
<th>Reports</th>
<th>Report View</th>
<th>Is the Report Available in Default Layout ?</th>
<th>Tab</th>
<th>Gadget URLs</th>
</tr>
</thead>
<tbody>
<tr>
<td>Agent</td>
<td>Agent CSQ Statistics Report</td>
<td>Agent CSQ Statistics Report</td>
<td>Yes</td>
<td>Home</td>
<td>&lt;gadget&gt;<a href="https://localhost:8444/cuic/gadget/LiveData/LiveDataGadget.xml?gadgetHeight=310&amp;viewId=76D964A10000140000000830A4E5E6F&amp;filterId=AgentCSQStats.csqName=CL&amp;compositeFilterId=AgentCSQStats.AgentIds.agentId=loginId">https://localhost:8444/cuic/gadget/LiveData/LiveDataGadget.xml?gadgetHeight=310&amp;viewId=76D964A10000140000000830A4E5E6F&amp;filterId=AgentCSQStats.csqName=CL&amp;compositeFilterId=AgentCSQStats.AgentIds.agentId=loginId</a>&lt;/gadget&gt;</td>
</tr>
<tr>
<td>Agent</td>
<td>Agent Team Summary Report</td>
<td>Agent Team Summary Report</td>
<td>Yes</td>
<td>Home</td>
<td>&lt;gadget&gt;<a href="https://localhost:8444/cuic/gadget/LiveData/LiveDataGadget.xml?gadgetHeight=310&amp;viewId=5C626F9C1000014000000600A4E5B33&amp;filterId=ResourceIAQStats.resourceId=CL">https://localhost:8444/cuic/gadget/LiveData/LiveDataGadget.xml?gadgetHeight=310&amp;viewId=5C626F9C1000014000000600A4E5B33&amp;filterId=ResourceIAQStats.resourceId=CL</a>&lt;/gadget&gt;</td>
</tr>
<tr>
<td>Supervisor</td>
<td>Agent Outbound Team Summary Report</td>
<td>Report since midnight</td>
<td>No</td>
<td>Team Data</td>
<td>&lt;gadget&gt;<a href="https://localhost:8444/cuic/gadget/LiveData/LiveDataGadget.xml?gadgetHeight=310&amp;viewId=FD919FB910000140000005D0A4E5B29&amp;filterId=ResourceIAQStats.resourceId=CL">https://localhost:8444/cuic/gadget/LiveData/LiveDataGadget.xml?gadgetHeight=310&amp;viewId=FD919FB910000140000005D0A4E5B29&amp;filterId=ResourceIAQStats.resourceId=CL</a>&lt;/gadget&gt;</td>
</tr>
<tr>
<td>Supervisor</td>
<td>Agent Outbound Team Summary Report</td>
<td>Short and long term average</td>
<td>No</td>
<td>Team Data</td>
<td>&lt;gadget&gt;<a href="https://localhost:8444/cuic/gadget/LiveData/LiveDataGadget.xml?gadgetHeight=310&amp;viewId=FD919FB51000014000000470A4E5B29&amp;filterId=ResourceIAQStats.resourceId=CL">https://localhost:8444/cuic/gadget/LiveData/LiveDataGadget.xml?gadgetHeight=310&amp;viewId=FD919FB51000014000000470A4E5B29&amp;filterId=ResourceIAQStats.resourceId=CL</a>&lt;/gadget&gt;</td>
</tr>
<tr>
<td>Supervisor</td>
<td>Chat Agent Statistics Report</td>
<td>Chat Agent Statistics Report</td>
<td>No</td>
<td>Team Data</td>
<td>&lt;gadget&gt;<a href="https://localhost:8444/cuic/gadget/LiveData/LiveDataGadget.xml?gadgetHeight=120&amp;viewId=F2F1FC17100001400000014E0A4E5D48&amp;filterId=ChatAgentStats.agentId=CL">https://localhost:8444/cuic/gadget/LiveData/LiveDataGadget.xml?gadgetHeight=120&amp;viewId=F2F1FC17100001400000014E0A4E5D48&amp;filterId=ChatAgentStats.agentId=CL</a>&lt;/gadget&gt;</td>
</tr>
<tr>
<td>Users</td>
<td>Reports</td>
<td>Report View</td>
<td>Is the Report Available in Default Layout?</td>
<td>Tab</td>
<td>Gadget URLs</td>
</tr>
<tr>
<td>------------</td>
<td>---------------------------------</td>
<td>----------------------</td>
<td>-------------------------------------------</td>
<td>-----------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Supervisor</td>
<td>Chat CSQ Summary Report</td>
<td>Chat CSQ Summary Report</td>
<td>No</td>
<td>Queue Data</td>
<td>&lt;gadget&gt;<a href="https://localhost:8444/cuic/gadget/LiveData/LiveDataGadget.xml?gadgetHeight=120&amp;viewId=E42ED786100001440000000780A4E5C91&amp;filterId=ChatQueueStatistics.queueName=CL">https://localhost:8444/cuic/gadget/LiveData/LiveDataGadget.xml?gadgetHeight=120&amp;viewId=E42ED786100001440000000780A4E5C91&amp;filterId=ChatQueueStatistics.queueName=CL</a>&lt;/gadget&gt;</td>
</tr>
<tr>
<td>Supervisor</td>
<td>Email Agent Statistics Report</td>
<td>Email Agent Statistics Report</td>
<td>No</td>
<td>Team Data</td>
<td>&lt;gadget&gt;<a href="https://localhost:8444/cuic/gadget/LiveData/LiveDataGadget.xml?gadgetHeight=310&amp;viewId=5CC5767B1000014F000000580A4D3FA7&amp;filterId=EmailAgentStats.agentId=CL">https://localhost:8444/cuic/gadget/LiveData/LiveDataGadget.xml?gadgetHeight=310&amp;viewId=5CC5767B1000014F000000580A4D3FA7&amp;filterId=EmailAgentStats.agentId=CL</a>&lt;/gadget&gt;</td>
</tr>
<tr>
<td>Supervisor</td>
<td>Email CSQ Summary Report</td>
<td>Email CSQ Summary Report</td>
<td>No</td>
<td>Queue Data</td>
<td>&lt;gadget&gt;<a href="https://localhost:8444/cuic/gadget/LiveData/LiveDataGadget.xml?gadgetHeight=310&amp;viewId=13970B4E1000015000000030A4D3FA7&amp;filterId=EmailQueueStatistics.queueName=CL">https://localhost:8444/cuic/gadget/LiveData/LiveDataGadget.xml?gadgetHeight=310&amp;viewId=13970B4E1000015000000030A4D3FA7&amp;filterId=EmailQueueStatistics.queueName=CL</a>&lt;/gadget&gt;</td>
</tr>
<tr>
<td>Supervisor</td>
<td>Team State Report</td>
<td>Team State Report</td>
<td>No</td>
<td>—</td>
<td>&lt;gadget&gt;<a href="https://localhost:8444/cuic/gadget/LiveData/LiveDataGadget.xml?gadgetHeight=310&amp;viewId=5C90012F1000014000000053A4E5B33&amp;filterId=ResourceIAQStats.resourceId=CL">https://localhost:8444/cuic/gadget/LiveData/LiveDataGadget.xml?gadgetHeight=310&amp;viewId=5C90012F1000014000000053A4E5B33&amp;filterId=ResourceIAQStats.resourceId=CL</a>&lt;/gadget&gt;</td>
</tr>
<tr>
<td>Supervisor</td>
<td>Team Summary Report</td>
<td>Report since midnight</td>
<td>Yes</td>
<td>Team Data</td>
<td>&lt;gadget&gt;<a href="https://localhost:8444/cuic/gadget/LiveData/LiveDataGadget.xml?gadgetHeight=310&amp;viewId=728283C21000015000000053A4E5B33&amp;filterId=ResourceIAQStats.resourceId=CL">https://localhost:8444/cuic/gadget/LiveData/LiveDataGadget.xml?gadgetHeight=310&amp;viewId=728283C21000015000000053A4E5B33&amp;filterId=ResourceIAQStats.resourceId=CL</a>&lt;/gadget&gt;</td>
</tr>
<tr>
<td>Supervisor</td>
<td>Team Summary Report</td>
<td>Short and long term average</td>
<td>Yes</td>
<td>Team Data</td>
<td>&lt;gadget&gt;<a href="https://localhost:8444/cuic/gadget/LiveData/LiveDataGadget.xml?gadgetHeight=310&amp;viewId=7291DCB410000140000000890A4E5B33&amp;filterId=ResourceIAQStats.resourceId=CL">https://localhost:8444/cuic/gadget/LiveData/LiveDataGadget.xml?gadgetHeight=310&amp;viewId=7291DCB410000140000000890A4E5B33&amp;filterId=ResourceIAQStats.resourceId=CL</a>&lt;/gadget&gt;</td>
</tr>
</tbody>
</table>
Add Live Data Gadgets to Desktop Layout

The Cisco Finesse default layout XML contains commented XML code for the Live Data gadgets available for Cisco Finesse desktop. Perform the following steps to add Live Data gadgets to desktop layout:

### Procedure

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Step 1</strong></td>
<td>Sign in to Cisco Finesse administration console. Cisco Finesse home page appears.</td>
</tr>
<tr>
<td><strong>Step 2</strong></td>
<td>Click the Desktop Layout tab.</td>
</tr>
<tr>
<td><strong>Step 3</strong></td>
<td>Select from the following editors:</td>
</tr>
<tr>
<td></td>
<td>• Text Editor</td>
</tr>
<tr>
<td></td>
<td>• XML Editor</td>
</tr>
<tr>
<td><strong>Step 4</strong></td>
<td>Copy the gadget URL for the report you want to add from Live Data Gadgets.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Users</th>
<th>Reports</th>
<th>Report View</th>
<th>Is the Report Available in Default Layout?</th>
<th>Tab</th>
<th>Gadget URLs</th>
</tr>
</thead>
<tbody>
<tr>
<td>Supervisor</td>
<td>Voice CSQ Summary</td>
<td>Snapshot</td>
<td>Yes</td>
<td>Queue Data</td>
<td>&lt;gadget&gt;<a href="https://localhost:8444/cuic">https://localhost:8444/cuic</a> /gadget/LiveData/LiveDataGadget.xml? gadgetHeight=310&amp;viewId =C8E2B16100000140000000A60A4E5E6B &amp;filterId=VoiceIAQStats.esdName=CL&lt;/gadget&gt;</td>
</tr>
<tr>
<td>Supervisor</td>
<td>Voice CSQ Summary</td>
<td>Short and long term average</td>
<td>Yes</td>
<td>Queue Data</td>
<td>&lt;gadget&gt;<a href="https://localhost:8444/cuic">https://localhost:8444/cuic</a> /gadget/LiveData/LiveDataGadget.xml? gadgetHeight=310&amp;viewId =C8EE2419100000140000000C30A4E5E6B &amp;filterId=VoiceIAQStats.esdName=CL&lt;/gadget&gt;</td>
</tr>
<tr>
<td>Supervisor</td>
<td>Voice CSQ Summary</td>
<td>Report since midnight</td>
<td>No</td>
<td>Queue Data</td>
<td>&lt;gadget&gt;<a href="https://localhost:8444/cuic">https://localhost:8444/cuic</a> /gadget/LiveData/LiveDataGadget.xml? gadgetHeight=310&amp;viewId =C8EF510810000140000000EB0A4E5E6B &amp;filterId=VoiceIAQStats.esdName=CL&lt;/gadget&gt;</td>
</tr>
</tbody>
</table>

### Gadgets Customization

You can use optional query parameter to adjust height of the gadgets.

### Query Parameter

<gadget>https://localhost:8444/cuic /gadget/LiveData/LiveDataGadget.xml? gadgetHeight=200&viewId=5C626F9C10000140000000600A4E5B33&filterId=ResourceIAQStats.resourceId=CL</gadget>

---

**Add Live Data Gadgets to Desktop Layout**

The Cisco Finesse default layout XML contains commented XML code for the Live Data gadgets available for Cisco Finesse desktop. Perform the following steps to add Live Data gadgets to desktop layout:

### Procedure

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Step 1</strong></td>
<td>Sign in to Cisco Finesse administration console. Cisco Finesse home page appears.</td>
</tr>
<tr>
<td><strong>Step 2</strong></td>
<td>Click the Desktop Layout tab.</td>
</tr>
<tr>
<td><strong>Step 3</strong></td>
<td>Select from the following editors:</td>
</tr>
<tr>
<td></td>
<td>• Text Editor</td>
</tr>
<tr>
<td></td>
<td>• XML Editor</td>
</tr>
<tr>
<td><strong>Step 4</strong></td>
<td>Copy the gadget URL for the report you want to add from Live Data Gadgets.</td>
</tr>
</tbody>
</table>
Example:

To add the Agent Report, copy the following:

```xml
<gadget>https://localhost:8444/cuic/gadget/LiveData/LiveDataGadget.xml?gadgetHeight=150&viewId=67D4371110000140000001080A4E5E6B&filterId=ResourceIAQStats.resourceId=loginId</gadget>
```

Step 5

Paste the gadget URL within the tab tags where you want it to appear.

Example:

To add the report to the home tab of the agent desktop:

```xml
<finesseLayout xmlns="http://www.cisco.com/vtg/finesse">
  <layout>
    <role>Agent</role>
    <page>
      <gadget>desktop/gadgets/CallControl.xml</gadget>
    </page>
    <tabs>
      <tab>
        <id>home</id>
        <label>finesse.container.tabs.agent.homeLabel</label>
        <gadgets>
          <gadget>https://localhost:8444/cuic/gadget/LiveData/LiveDataGadget.xml?gadgetHeight=310&viewId=76D964AD10000140000000830A4E5E6F&filterId=AgentCSQStats.csqName=CL&compositeFilterId=AgentCSQStats.AgentIds.agentId=loginId</gadget>
          <gadget>https://localhost:8444/cuic/gadget/LiveData/LiveDataGadget.xml?gadgetHeight=310&viewId=5C626F9C10000140000000600A4E5B33&filterId=ResourceIAQStats.resourceId=CL</gadget>
          <gadget>https://localhost:8444/cuic/gadget/LiveData/LiveDataGadget.xml?gadgetHeight=150&viewId=67D4371110000140000001080A4E5E6B&filterId=ResourceIAQStats.resourceId=loginId</gadget>
        </gadgets>
      </tab>
      <tab>
        <id>myStatistics</id>
        <label>finesse.container.tabs.agent.myStatisticsLabel</label>
        <gadgets>
          <gadget>https://localhost:8444/cuic/gadget/LiveData/LiveDataGadget.xml?gadgetHeight=600&viewId=5D411E8A1000014000000230A4E5E6B&filterId=AgentStateDetailStats.agentID=loginId</gadget>
        </gadgets>
      </tab>
      <tab>
        <id>manageCall</id>
        <label>finesse.container.tabs.agent.manageCallLabel</label>
      </tab>
    </tabs>
  </layout>
</finesseLayout>
```

Step 6

Click Save. Cisco Finesse validates the XML file to ensure that it is valid XML syntax and conforms to the Cisco Finesse schema.

Step 7

To verify, log in to Cisco Finesse agent desktop as agent/Cisco Finesse supervisor desktop as supervisor and check the reports.

Related Topics

Live Data Gadgets
Add Customized Live Data Gadgets to Desktop Layout

This procedure explains how to create gadget URLs for customized Live Data reports, which are copied from stock reports, and add them to desktop layout.

Important

The new gadget renders the report only when the appropriate permission on that report is given in Cisco Unified Intelligence Center.

Procedure

Step 1
Copy the gadget URL of the stock report that you want to customize from Live Data Gadgets and paste it in a text editor.

Example:
Consider the URL shown here as the gadget URL. Copy and paste it in a text editor. The underlined ID is the value of viewID.

```html
<gadget>https://localhost:8444/cuic/gadget/LiveData/LiveDataGadget.xml?gadgetHeight=310
&viewId=5C626F9C10000140000000600A4E5B33&filterId=ResourceIAQStats.resourceId=CL</gadget>
```

Step 2
In Cisco Unified Intelligence Center, in the Edit view of the customized report, select the view for which you want to create the gadget URL and then click Links.

The HTML Link field displays the permalink of the customized report.

Step 3
Copy the permalink of the customized report from the HTML Link field and paste it in a text editor, then copy the viewID value from this link.

Example:
Copy the underlined viewID value from the permalink of the customized report.

```html
https://<Server Name>:8444/cuic/permalink/PermalinkViewer.htm?viewId=5C90012F10000140000000830A4E5B33&linkType=htmlType&viewType=Grid
```

Step 4
Replace the viewID value in the gadget URL with the viewID value from the permalink of the customized report.

Example:
The customized gadget URL appears as shown here after replacing the viewID value with the viewID value of the customized report.

```html
<gadget>https://localhost:8444/cuic/gadget/LiveData/LiveDataGadget.xml?gadgetHeight=310
&viewId=5C90012F10000140000000830A4E5B33&filterId=ResourceIAQStats.resourceId=CL</gadget>
```

Step 5
Add the customized gadget URL to Desktop Layout in the Finesse administration console and save.

Step 6
Log in to Finessedesktop and check the report.

Related Topics

Live Data Gadgets
Configure Live Data Reports with Multiple Views

Cisco Finesse allows you to display multiple Live Data reports or views on a single gadget. Supervisors can select the desired view to display from a drop-down list on the gadget toolbar, which lists up to five report views in Report Name - View Name format.

This procedure describes how to add multiple Live Data views to the Finesse desktop layout using the viewId_n and filterId_n keys. You can specify up to five report views to appear in your gadget. The first view among the five is the default view. There is no defined order for how the remaining views are displayed.

Finesse still supports the display of a single gadget using a single viewId. However, if you specify the single viewId along with multiple viewId_n keys, the multiple views are used and the single viewId is ignored.

---

**Procedure**

**Step 1**

For each report or view that you want to include in the gadget, obtain the associated viewId from the permalink for the view:

a) In Unified Intelligence Center, in Edit view of the report, select the desired view then click **Links**.

   The HTML Link field displays the permalink of the customized report.

b) Copy the permalink of the customized report from the **HTML Link** field, and paste it in a text editor, and then copy the viewID value from the permalink and save it.

   **Example:**

   Copy the viewId, which is underlined in this example, from the permalink for the report.

   ![Example](https://<Server Name>:8444/cuic/permalink/PermalinkViewer.htm?viewId=5C90012F10000140000000830A4E5B33&linkType=htmlType&viewType=Grid)

**Step 2**

From the Finesse default layout XML, copy the gadget URL for one of the Live Data reports and paste it into a text editor.

**Example:**

Copy the URL for the Agent Skill Group for HTTPS from the default layout XML and paste it into a text editor:

```xml
<gadget>https://my-cuic-server:8444/cuic/gadget/LiveDataGadget.xml?gadgetHeight=310&viewId_1=9AB7848B1000014100000C50A000E6C4&filterId_1=agent.id=CL%20teamName</gadget>
```

**Step 3**

To update the URL to refer to a different report view, populate the viewId_1 value (after the equal sign) with the desired viewId obtained in step 1.

**Example:**

The following shows the URL updated with the example viewId copied from step 1.
Step 4  For each additional view you want to include:

a) At the end of the URL, copy and paste the viewId_1 and agentId_1 strings with a leading ampersand.

Example:

```html
<gadget>https://my-cuic-server:8444/cuic/gadget/LiveData/LiveDataGadget.xml?gadgetHeight=310&viewId_1=5C90012F10000140000000830A4E5B33&filterId_1=agent.id=CL%20teamName&</gadget>
```

b) Update the copied viewId_1 and filterId_1 in the URL to the next available integer (in this example, viewId_2 and filterId_2).

Example:

```html
<gadget>https://my-cuic-server:8444/cuic/gadget/LiveData/LiveDataGadget.xml?gadgetHeight=310&viewId_1=5C90012F10000140000000830A4E5B33&filterId_1=agent.id=CL%20teamName&viewId_2=5C90012F10000140000000830A4E5B33&filterId_2=agent.id=CL%20teamName</gadget>
```

c) Populate the copied viewId value (after the equal sign) with the value defined in the permalink for the desired report (in this example, 99E6C8E210000141000000D80A0006C4).

Example:

```html
<gadget>https://my-cuic-server:8444/cuic/gadget/LiveData/LiveDataGadget.xml?gadgetHeight=310&viewId_1=5C90012F10000140000000830A4E5B33&filterId_1=agent.id=CL%20teamName&viewId_2=99E6C8E210000141000000D80A0006C4&filterId_2=agent.id=CL%20teamName</gadget>
```

d) Make sure that the filterId value matches the type required by the report type, as follows:

- Agent Reports: filterId_N=agent.id=CL%20teamName
- Agent Skill Group Reports: filterId_N=agent.id=CL%20teamName
- Skill Group Reports: filterId_N=skillGroup.id=CL%20teamName
- Precision Queue Reports: filterId_N=precisionQueue.id=CL%20teamName

Step 5  Replace my-cuic-server with the FQDN of your Cisco Unified Intelligence Center Server.

Step 6  Add the customized gadget URL to the desktop layout XML in the Manage Desktop Layout gadget and click Save.

---

**Manage Phone Books**

On the Phone Books tab of the Cisco Finesse administration console, you can create and manage global and team phone books and phone book contacts. Global phone books are available to all agents; team phone books are available to agents in that specific team.

**Phone Books and Contacts**

Finesse supports the following number of phone books:
• 10 global phone books
• 300 team phone books

The system supports a total of 50,000 contacts. The total number of contacts per agent across all phone books is limited to 6000.

Use the Manage Phone Books gadget to view, add, edit, or delete phone books and phone book contacts. Click the Name or Assign To headers to sort the phone books in ascending or descending order. Click the last Name, First Name, Number, or Note headers to sort the contacts in ascending or descending order.

The following table describes the fields on the Manage Phone Books gadget:

<table>
<thead>
<tr>
<th>Field</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the phone book. It must be unique, and can be a maximum of 64 alphanumeric characters.</td>
</tr>
<tr>
<td>Assign To</td>
<td>Indicates if the phone book is global (All Users) or team (Teams).</td>
</tr>
<tr>
<td>Last Name</td>
<td>The last name of a contact. The last name can be a maximum of 128 characters. This field is optional.</td>
</tr>
<tr>
<td>First Name</td>
<td>The first name of a contact. The first name can be a maximum of 128 characters. This field is optional.</td>
</tr>
<tr>
<td>Number</td>
<td>The phone number for the contact. The phone number can be 1-32 characters long and cannot be blank.</td>
</tr>
<tr>
<td>Note</td>
<td>Optional text that describes the contact. The note can be a maximum of 128 characters.</td>
</tr>
</tbody>
</table>

**Actions on the Manage Phone Books gadget:**

- **New:** Add a new phone book or contact
- **Edit:** Edit an existing phone book or contact
- **Delete:** Delete a phone book or contact
- **Refresh:** Reload the list of phone books or contacts from the server
- **Import:** Import a list of contacts to the phone book
- **Export:** Export a list of contacts from the phone book

**Add Phone Book**

**Procedure**

**Step 1** In the Manage Phone Books gadget, click **New**.

**Step 2** In the **Name** field, enter a name for the phone book.

**Note** Phone book names can be a maximum of 64 characters.
Step 3  From the Assign To drop-down, select All Users if the phone book is global or Teams if the phone book is available to specified teams.

Step 4  Click Save.

---

**Edit Phone Book**

**Procedure**

Step 1  In the Manage Phone Books gadget, select the phone book you want to edit.

Step 2  Click Edit.

Step 3  In the Name field, enter the new name for the phone book. If you want to change who can access the phone book, in the Assign To drop-down, choose All Users or Teams.

Step 4  Click Save.

If you change the Assign To field from Teams to All Users, click Yes to confirm the change.

---

**Delete Phone Book**

**Procedure**

Step 1  In the Manage Phone Books gadget, select the phone book that you want to delete.

Step 2  Click Delete.

Step 3  Click Yes to confirm the deletion of the selected phone book.

---

**Import Contacts**

The Import function allows you to replace all the contacts in a phone book with a new list of contacts, or to populate a new phone book with contacts.

The import list must be in the specified comma separated values (CSV) format, and can contain a maximum of 6000 contacts. Import lists that contain more than 6000 contacts are rejected with an error message.

The CSV file contains the fields described in the following table:

<table>
<thead>
<tr>
<th>Field</th>
<th>Max Length</th>
<th>Can Be Blank</th>
<th>Permitted Characters</th>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>First Name</td>
<td>128</td>
<td>Yes</td>
<td>Alphanumeric characters</td>
<td></td>
</tr>
<tr>
<td>Last Name</td>
<td>128</td>
<td>Yes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Phone Number</td>
<td>32</td>
<td>No</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Notes</td>
<td>128</td>
<td>Yes</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

*Note:* The CSV file that contains the contacts to import must use Latin encoding.
The following is an example of a phone book CSV file:

"First Name","Last Name","Phone Number","Notes"
"Amanda","Cohen","651-123-4567",""
"Nicholas","Knight","612-555-1228","Sales"
"Natalie","Lambert","952-555-9876","Benefits"
"Joseph","Stonetree","651-555-7612","Manager"

A phone book CSV file must conform to this format and include the headers in the first line. During import, the file is scanned for illegal characters. If any are found, they are replaced with question marks.

---

**Note**

Exported CSV files always show each field enclosed in double quotes to ensure that any commas or double quotes that are part of the actual filed data are not mistaken for field delimiters. If your data does not include these characters, you can omit the double quotes in files you prepare for importing.

---

**Procedure**

**Step 1**
In the Manage Phone Books gadget, select the phone book into which you want to import a list of contacts.

**Step 2**
Click **Import**.

**Step 3**
Click **Browse** and navigate to the location of the CSV file containing the contacts you want to import.

**Note**
The CSV file must use Latin encoding.

**Step 4**
Click **OK**.

---

**Export Contacts**

The Export function allows you to extract a list of contacts from an existing phone book. The exported list is saved in CSV format.

**Procedure**

**Step 1**
In the Manage Phone Books gadget, select the phone book that contains the contacts you want to export.

**Step 2**
Click **Export**.

**Step 3**
Click **Open** to open the CSV file in Excel, or click the **Save** drop-down list and choose **Save**, **Save as**, or **Save and open**.

**Step 4**
A message appears that gives you the option to view the downloaded file, open the folder into which the download was saved, view the Internet Explorer View Downloads window, or dismiss the message without viewing the file.
Add Contact

Procedure

Step 1 In the Manage Phone Books gadget, select the phone book to which you want to add a contact.

The List of Contacts for <phone book name> area appears.

Step 2 Click New.

Step 3 Complete the fields. The First Name, Last Name, and Note fields are optional and have a maximum length of 128 characters. The Number field is required and has a maximum length of 32 characters.

Step 4 Click Save.

Edit Contact

Procedure

Step 1 In the Manage Phone Books gadget, select the phone book that contains the contact you want to edit.

The List of Contacts for <phone book name> area appears.

Step 2 Select the contact you want to edit.

Step 3 Click Edit.

Step 4 Edit the fields that you want to change. The First Name, Last Name, and Note fields are optional and have a maximum of 128 characters. The Number field is required and has a maximum of 32 characters.

Step 5 Click Save.

Delete Contact

Procedure

Step 1 In the Manage Phone Books gadget, select the phone book that contains the contact you want to delete.

The List of Contacts for <phone book name> area appears.

Step 2 Select the contact that you want to delete.

Step 3 Click Delete.

Step 4 Click Yes to confirm the deletion of the selected contact.
Manage Reasons

The Reasons tab on the Cisco Finesse administration console allows you to view, add, edit, and delete Not Ready reason codes, Sign Out reason codes, and Wrap-Up reasons.

Note

Certain reason codes are reserved and cannot be used.

For Unified CCX systems, these reserved reason codes are as follows: 0, 22, and 33.

Not Ready Reason Codes

Not Ready reason codes represent reasons that agents can select when they change their state to Not Ready.

Use the Manage Reason Codes (Not Ready) gadget to view, add, edit, or delete Not Ready reason codes. Click the Reason Label or Reason Code headers to sort the Not Ready reason codes by label or reason code in ascending or descending order. Click the Type header to sort and display system or custom reason codes. Click the Global header to sort reason codes by whether they are global (Yes) or not (No).

Not Ready reason codes can be global (visible to all agents) or team (visible only to agents on specified teams).

Note

Finesse supports a total of 200 Not Ready reason codes. This includes a maximum of 100 global Not Ready reason codes, and 100 team Not Ready reason codes. The team reason codes can be mapped to any team, and the same reason code can be mapped to multiple teams.

The following table describes the fields on the Manage Reason Codes (Not Ready) gadget:

<table>
<thead>
<tr>
<th>Field</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reason Label</td>
<td>The label for the Not Ready reason code. The label has a maximum length of 40 characters and should be unique for each Not Ready reason code. Alphanumeric and special characters are supported.</td>
</tr>
<tr>
<td>Type</td>
<td>The type of reason code (System or Custom). The column is default and can be sorted to display both System reason codes and Custom reason codes.</td>
</tr>
<tr>
<td>Reason Code</td>
<td>A code for the Not Ready reason. The value of the code must be between 1 and 999 and must be unique.</td>
</tr>
<tr>
<td>Global?</td>
<td>Yes/No. Indicates if the reason code is available globally to all agents (Yes) or to specific teams of agents (No).</td>
</tr>
</tbody>
</table>

Actions on the Manage Reason Codes (Not Ready) gadget:

- **New:** Add a new Not Ready reason code
- **Edit:** Edit an existing Not Ready reason code
- **Delete:** Delete a Not Ready reason code
Add Not Ready Reason Code

**Procedure**

**Step 1**
In the Manage Reason Codes (Not Ready) gadget, click **New**.

**Step 2**
In the Reason Label box, enter a label for the reason code.

**Note**
Not Ready reason code labels are limited to 40 characters.

**Step 3**
In the Reason Code box, an auto populated reason code is displayed. If you choose not to save the prepopulated reason code, you can enter your own reason code.

**Note**
The code must be between 1 and 999 and must be unique.

Ensure there are no leading or trailing spaces.

**Step 4**
If the reason code is global, select the Global? check box. If the reason code is specific to a team, clear the Global? check box.

**Note**
By default, the Global? check box is selected.

**Step 5**
Click **Save**.

**Note**
The Finesse server removes leading or trailing spaces before saving the Reason Label in the database.
Edit Not Ready Reason Code

Procedure

Step 1  In the Manage Reason Codes (Not Ready) gadget, select the reason code that you want to edit.
Step 2  Click Edit.
Step 3  If you want to change the label for the Not Ready reason code, in the Reason Label field, enter a new label for the reason code. If you want to change the code, in the Reason Code field, enter the new code. If you want to change who has access to the code, select or clear the Global? check box.
Step 4  Click Save.

Delete Not Ready Reason Code

Note  An error may occur if an agent selects a Not Ready reason code after it has been deleted. Agents who are signed in when you make changes to Not Ready reason codes must sign out and sign back in to see those changes reflected on their desktops.

Procedure

Step 1  In the Manage Reason Codes (Not Ready) gadget, select the Not Ready reason code that you want to delete.
Step 2  Click Delete.
Step 3  Click Yes to confirm the deletion of the selected reason code.

Sign Out Reason Codes

Sign Out reason codes represent reasons that agents can select when they sign out of the Finesse desktop.

Use the Manage Reason Codes (Sign Out) gadget to view, add, edit, or delete Sign Out reason codes. Click the Reason Label or Reason Code headers to sort the Sign Out reason codes by label or by reason code, in ascending or descending order. Click the Type header to sort and display system or custom reason codes. Click the Global header to sort the reason codes by whether they are global (Yes) or not (No).

Sign Out reason codes can be global (visible to all agents) or team (visible only to agents on specified teams).

Note  Finesse supports 200 Sign Out reason codes. These include 100 global Sign Out reason codes, and 100 Sign Out team reason codes. The team reason codes can be mapped to any team, and the same reason code can be mapped to multiple teams.

The following table describes the fields on the Manage Reason Codes (Sign Out) gadget:

| Field       | Explanation |
The label for the Sign Out reason code.
The label has a maximum length of 40 characters and should be unique for each Sign Out reason code. Alphanumeric and special characters are supported.

Type
The type of reason code (System or Custom).
The column is default and can be sorted to display both System reason codes and Custom reason codes.

Reason Code
A code for the Sign Out reason.
The code must be between 1 and 999 and must be unique.

Global?
Yes/No. Indicates if the reason code is available globally to all agents (Yes) or to specific teams of agents (No).

Actions on the Manage Reason Codes (Sign Out) gadget:
- **New**: Add a new Sign Out reason code
- **Edit**: Edit an existing Sign Out reason code
- **Delete**: Delete a Sign Out reason code
- **Refresh**: Reload the list of Sign Out reason codes from the server

**Note**
When you add, edit, or delete a Sign Out reason code, the changes you make take effect on the Finesse desktop after three seconds. However, agents who are signed in when the changes are made must sign out and sign back in to see those changes reflected on their desktops.

When an agent clicks Sign Out on the desktop, any configured Sign Out codes appear in a drop-down list. The agent can then choose the code that represents why that agent is signing out.

**Add Sign Out Reason Code**

**Procedure**

**Step 1**
In the Manage Reason Codes (Sign Out) gadget, click **New**.

**Step 2**
In the Reason Label box, enter a label for the reason code.

**Note**
Sign Out reason code labels are limited to 40 characters.

**Step 3**
In the Reason Code box, an auto populated reason code is displayed. If you choose not to save the prepopulated reason, you can enter your own reason code.

**Note**
The code must be between 1 and 999 and must be unique.

Ensure there are no leading or trailing spaces.

**Step 4**
If the reason code is global, select the Global? check box. If the reason code is specific to a team, clear the Global? check box.
Note: By default, the Global? check box is selected.

Step 5: Click Save.

Edit Sign Out Reason Code

Procedure

Step 1: In the Manage Reason Codes (Sign Out) gadget, select the reason code that you want to edit.
Step 2: Click Edit.
Step 3: If you want to change the label of the Sign Out reason code, in the Reason Label field, enter a new label for the reason code. If you want to change the code, in the Reason Code field, enter the new code. If you want to change who has access to the code, select or clear the Global? check box.
Step 4: Click Save.

Delete Sign Out Reason Code

Procedure

Step 1: In the Manage Reason Codes (Sign Out) gadget, select the Sign Out reason code that you want to delete.
Step 2: Click Delete.
Step 3: Click Yes to confirm the deletion of the selected Sign Out reason code.

Predefined System Reason Codes

For Not Ready system reason codes and Sign Out system reason codes, only the reason code label can be edited and saved. The Global attribute and system code cannot be modified. In case the system reason code label is modified and you wish to revert to the default label, refer to the following list of predefined system reason codes:

<table>
<thead>
<tr>
<th>System Reason Code</th>
<th>Reason Label</th>
<th>Reason Label Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>32767</td>
<td>Logged Out - Device Conflict</td>
<td>The system issues this reason code when an agent is already logged in to one device (computer or phone) and then tries to re-login to a second device.</td>
</tr>
<tr>
<td>Code</td>
<td>Description</td>
<td>Reason</td>
</tr>
<tr>
<td>---------</td>
<td>--------------------------------------------</td>
<td>------------------------------------------------------------------------</td>
</tr>
<tr>
<td>32765</td>
<td>Logged Out - System Disconnect</td>
<td>The system issues this reason code when a Cisco Finesse IP Phone Agent or Cisco Finesse desktop crashes due to any reason or if the connection is disrupted.</td>
</tr>
<tr>
<td>32764</td>
<td>Logged Out - System Standby</td>
<td>The system issues this reason code when the active server becomes the standby server and the agent loses connection to the Unified CCX Platform.</td>
</tr>
<tr>
<td>32763</td>
<td>Not Ready - Call Not Answered</td>
<td>The system issues this reason code when the agent fails to answer a Unified CCX call within the specified timeout period.</td>
</tr>
<tr>
<td>32762</td>
<td>Not Ready - Offhook</td>
<td>The system issues this reason code when the agent goes off the hook to place a call. If the agent remembers to do this task the corresponding agent-triggered reason code is displayed. If the agent does not remember to do this task, the system issues this reason code.</td>
</tr>
<tr>
<td>32761</td>
<td>Not Ready - Non ACD Busy</td>
<td>The system issues this reason code when the agent is logged on to the Cisco Finesse desktop or Cisco Finesse IP phone and then receives a call that is not queued on the Unified CCX Platform.</td>
</tr>
<tr>
<td>32760</td>
<td>Not Ready - Log On</td>
<td>The system issues this reason code when an agent logs in and is automatically placed in the Not Ready state.</td>
</tr>
<tr>
<td>32759</td>
<td>Not Ready - Phone Failure</td>
<td>The system issues this reason code if the agent’s phone crashes and that agent is placed in the unavailable state.</td>
</tr>
<tr>
<td>32758</td>
<td>Not Ready - Wrap Up Timer Expiry</td>
<td>The system issues this reason code when an agent’s state is changed from WORK to Not Ready. This change occurs if the WORK state for that agent’s CSQ is associated with an expired wrap-up timer.</td>
</tr>
<tr>
<td>32757</td>
<td>Not Ready - CUCM Failover</td>
<td>The system issues this reason code when the Unified CM fails over and the agent is moved to the Not Ready state.</td>
</tr>
<tr>
<td>32756</td>
<td>Not Ready - Phone Working</td>
<td>The system issues this reason code when the agent’s phone comes up after it has been through a Phone Down state.</td>
</tr>
<tr>
<td>32755</td>
<td>Not Ready - Call Ended</td>
<td>The system issues this reason code when an agent is moved to the Not Ready state after handling a Unified CCX call. This situation occurs in one of two cases:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1. If an agent (Agent 1) is in the Not Ready state and gets a consult Unified CCX call from another agent (Agent 2). In this case, after handling the call, Agent 1 moves back to the Not Ready state.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2. If an agent’s Automatic Available option is disabled and this agent gets a Unified CCX call, then this agent goes to the Not Ready state after handling the call.</td>
</tr>
<tr>
<td>32749</td>
<td>Not Ready - Call Cancel</td>
<td>The system issues this reason code when an agent’s state is changed from TALKING to Not Ready because of the Cancel feature. The feature is triggered during an ICD consult call.</td>
</tr>
</tbody>
</table>
between two agents. When the consulting agent presses the Cancel softkey on the phone, the consulted agent is no longer associated with an ICD call and their state changes to Not Ready. This feature is only available on some newer phone models.

<table>
<thead>
<tr>
<th>Code</th>
<th>Reason Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>32754</td>
<td>Not Ready - Restricted Device</td>
<td>The system issues this reason code if the agent device is flagged as a restricted device by the Unified CM Administrator.</td>
</tr>
<tr>
<td>32753</td>
<td>Not Ready - Restricted Line</td>
<td>The system issues this reason code if the agent’s phone line is flagged as a restricted device by the Unified CM Administrator.</td>
</tr>
<tr>
<td>32752</td>
<td>Not Ready - Cancel Reservation Preview Call</td>
<td>The system issues this reason code when an agent receives a preview outbound call and decides to cancel the reservation by pressing &quot;Decline&quot; button on Cisco Finesse desktop.</td>
</tr>
<tr>
<td>32751</td>
<td>Not Ready - Skip Preview Call</td>
<td>The system issues this reason code when an agent receives a preview outbound call and skips the call.</td>
</tr>
<tr>
<td>32748</td>
<td>Log Out - Agent Deleted</td>
<td>Agent is logged out from Unified CCX as the agent is deleted from Unified Communications Manager. This event is triggered when Unified CCX synchronizes the agent information with Unified Communications Manager.</td>
</tr>
<tr>
<td>32750</td>
<td>Not Ready - Extension Modified</td>
<td>The system issues this reason code when an agent is logged out from CCX because the agent’s IPCC extension was changed in Unified Communications Manager.</td>
</tr>
<tr>
<td>32742</td>
<td>Not Ready - Non ACD Offhook</td>
<td>Agent's state is changed from Ready state to Not Ready state when the monitored Non ICD lines are used for Incoming or Outgoing calls.</td>
</tr>
<tr>
<td>32741</td>
<td>Logged Out - Extension Conflict</td>
<td>The system issues this reason code when an agent logs in to Cisco Finesse using an extension number that has already been used by another agent to log in, the first agent is logged out forcibly with this reason code.</td>
</tr>
<tr>
<td>32740</td>
<td>Logout - System Initiated Relogin</td>
<td>The system logs out the agent from one session when the agent tries to log in with the same credentials in another session.</td>
</tr>
<tr>
<td>33</td>
<td>Not Ready - Supervisor Initiated</td>
<td>The system issues this reason code when the Supervisor changes an agent’s state to Not Ready state.</td>
</tr>
<tr>
<td>22</td>
<td>Logged Out - Supervisor Initiated</td>
<td>The system issues this reason code when the Supervisor changes an agent’s state to log out.</td>
</tr>
<tr>
<td>255</td>
<td>Logged Out - Connection Failure</td>
<td>The system issues this reason code when the agent is forcibly logged out when there is a connection failure between the Cisco Finesse Desktop and the Cisco Finesse Server.</td>
</tr>
</tbody>
</table>

Manage Reason Code Conflicts During Upgrade

System Reason Codes are auto-generated reason codes that may conflict with custom reason codes when upgrading from an older version to Cisco Finesse 11.6(1). If there is a reason code conflict then the following message appears when you sign in to the administration console:
**Custom reason codes conflict with system reason codes. Resolve to avoid reporting inconsistency.**

**Note**
Clear your browser cache to ensure that you are allowed to view and resolve system reason code conflicts.

All conflicting reason codes are highlighted. To edit, select each conflicting reason code and click **Edit**. The **Edit Reason Code** area appears. Select the reason code from the available options listed or enter any other code you wish. The code must be unique to the particular category (Not Ready or Sign Out).

Once resolved, the reason code gets sorted based on the reason code number and placed in the table accordingly.

**Wrap-Up Reasons**

Wrap-Up reasons represent the reasons that agents can apply to calls. A Wrap-Up reason indicates why a customer called the contact center. For example, you may have one Wrap-Up reason for sales calls and another for support calls.

You can configure Wrap-Up reasons to be available globally to all agents or only to specific teams.

Use the Manage Wrap-Up Reasons gadget to view, add, edit, or delete Wrap-Up reasons. Click the Reason Label header to sort the Wrap-Up reasons in ascending or descending order.

**Note**
Finesse supports a maximum of 100 global and 1500 team Wrap-Up reasons. No more than 100 Wrap-Up reasons can be assigned to any one team.

Finesse supports wrap-up functionality for incoming calls, outgoing calls, and Outbound Option Dialer Calls (Finesse does not support Outbound Option Direct Preview mode).

**Note**
The **showWrapUpTimer** property can be used to show or hide timer in wrap-up state.

If **showWrapUpTimer** is set to true then timer is displayed.

If **showWrapUpTimer** is set to false then timer is hidden.

**Note**
Wrap-Up timer is configurable. By default **wrapUpCountDown** property is set to true. The timer counts down by default when the agent is in wrap-up state. For more information, see *Desktop Properties*.

For example, if you set the timer to 30 seconds, then by default the timer starts from 30 and ends on zero.

The default behavior can be changed by setting the **wrapUpCountDown** property to false.

If an agent is configured for wrap-up and selects a pending state during a call, when the call finishes that agent goes into the pending state selected during the call.

The following table describes the fields on the Manage Wrap-Up Reasons gadget:

<table>
<thead>
<tr>
<th>Field</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reason Label</td>
<td>The label for the Wrap-Up reason.</td>
</tr>
</tbody>
</table>
This label must be unique for each Wrap-Up reason and has a maximum length of 39 bytes (which equals 39 US English characters). Both alphanumeric and special characters are supported.

| Global? | Yes/No. Indicates if the Wrap-Up reason is available globally to all agents (Yes) or to specific teams of agents (No). |

**Actions on the Manage Wrap-Up Reasons gadget:**
- **New**: Add a new Wrap-Up reason
- **Edit**: Edit an existing Wrap-Up reason
- **Delete**: Delete a Wrap-Up reason
- **Refresh**: Reload the list of Wrap-Up reasons from the server

---

**Note**
When you add, edit, or delete a Wrap-Up reason, the changes you make take effect on the agent or supervisor desktop after three seconds. However, agents who are signed in when the changes are made must sign out and sign in again to see those changes reflected on their desktops.

---

**Add Wrap-Up Reason**

**Procedure**

**Step 1**
In the Manage Wrap-Up Reasons gadget, click **New**.

**Step 2**
In the Reason Label field, add a label for the Wrap-Up reason.

**Note**
Wrap-Up reason labels are limited to 39 bytes.

**Step 3**
If the Wrap-Up reason is global, select the Global? check box. If the Wrap-Up reason is specific to a team, clear the Global? check box.

**Note**
By default, the Global? check box is selected.

**Step 4**
Click **Save**.

**Edit Wrap-Up Reason**

**Procedure**

**Step 1**
In the Manage Wrap-Up Reasons gadget, select the Wrap-Up reason that you want to edit.

**Step 2**
Click **Edit**.

The Edit Wrap-Up Reason area appears.
Step 3  In the Wrap-Up Reason Label field, enter the new label for the Wrap-Up reason. If you want to change who has access to the Wrap-Up reason, select or clear the Global? check box.

Step 4  Click Save.

Delete Wrap-Up Reason

Procedure

Step 1  In the Manage Wrap-Up Reasons gadget, select the Wrap-Up reason that you want to delete.

Step 2  Click Delete.

A question appears asking you to confirm that you want to delete the selected Wrap-Up reason.

Step 3  Click Yes to confirm the deletion of the selected Wrap-Up reason.

Force Wrap-Up Reason

If the Force Wrap-Up reason is configured, the agent must select a Wrap-Up reason before changing the state after the call ends. The agent cannot change the state until the Wrap-up reason is applied. The Wrap-Up reason can be selected during the call or after the call ends.

Note  The Force Wrap-Up reason is disabled by default. Use the CLI commands to enable and disable this feature. For more information, see Desktop Properties in Cisco Finesse Administration Guide.

Manage Team Resources

You can assign phone books, reason codes, wrap-up reasons, custom desktop layouts, and workflows to teams on the Team Resources tab of the administration console.

Team Resources

Use the Manage Team Resources gadget on the Team Resources tab to assign and unassign phone books, reasons, custom desktop layouts, and workflows to teams. Click the Name or ID header to sort the teams in ascending or descending order.

The Manage Team Resources gadget contains six tabs, each enabling you to assign or unassign resources to a team. The tabs are defined in the following table:

<table>
<thead>
<tr>
<th>Tab Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tab Name</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Phone Books</td>
<td>Use this tab to assign and unassign phone books to the team. Only phone books that are defined in the Manage Phone Books gadget as available for assignment.</td>
</tr>
<tr>
<td>Reason Codes (Not Ready)</td>
<td>Use this tab to assign and unassign Not Ready reason codes to the team. Only Not Ready reason codes that are defined in the Manage Reason Codes (Not Ready) gadget as available to teams (not global) are available for assignment.</td>
</tr>
<tr>
<td>Reason Codes (Sign Out)</td>
<td>Use this tab to assign and unassign Sign Out reason codes to the team. Only Sign Out reason codes that are defined in the Manage Reason Codes (Sign Out) gadget as available to teams (not global) are available for assignment.</td>
</tr>
<tr>
<td>Wrap-Up Reasons</td>
<td>Use this tab to assign and unassign Wrap-Up reasons to the team. Only Wrap-Up reasons that are defined in the Manage Wrap-Up Reasons gadget as available to teams (not global) are available for assignment.</td>
</tr>
<tr>
<td>Workflows</td>
<td>Use this tab to assign and unassign workflows to the team. Only workflows that are defined in the Manage Workflows gadget are available for assignment.</td>
</tr>
</tbody>
</table>

**Actions on the Manage Team Resources Gadget**

- **Add**: Assign a phone book, reason, or workflow to the team
- **Save**: Save the phone book, reason, desktop layout assignment, or workflow to the team
- **Revert**: Cancel any changes made before they are saved
- **Refresh**: Refresh the list of teams

**Note**

If you select a team and then click Refresh, the team is deselected and the Resources area for that team disappears. The list of teams is refreshed and you must select a team again.

**Add or Delete a Team When Database is Not Accessible**

If you add or delete a team when Finesse cannot access the Finesse database, those changes do not appear in the Finesse administration console unless you restart Cisco Finesse Tomcat or the Cisco Unified CCX Engine.

**Assign Phone Books and Reasons to Team**

**Procedure**

- **Step 1**: In the Manage Team Resources gadget, select a team.
- **Step 2**: Click the tab for the resource you want to assign for the selected team.
- **Step 3**: Click Add.
- **Step 4**: Select one or more resources from the list to assign them to the team.
Resources you assign are highlighted in blue in the Add <resources> popup and added to the List of <resources> area.

**Step 5** When you finish assigning resources, click Save.

**Note** You can make changes on all resource tabs and then save them at the same time. If there is an error on one resource tab but not others, the changes on the tabs with no errors are saved while the changes on the tab with errors are not saved.

---

**Unassign Phone Books and Reasons from Team**

**Procedure**

**Step 1** In the Manage Team Resources gadget, select a team.

**Step 2** Click the tab for the resource you want to unassign from the selected team.

**Step 3** Click the red X next to the resource you want to unassign.

**Step 4** Click Save.

---

**Assign Custom Desktop Layout to Team**

**Procedure**

**Step 1** In the Manage Team Resources gadget, select a team.

**Step 2** Click Desktop Layout.

The Desktop Layout XML area appears. The area contains the default desktop layout XML.

**Step 3** Select the Override System Default check box.

The XML becomes editable.

**Step 4** Select from the following editors:

- Text Editor
- XML Editor

For more information, see Default Layout XML.

**Step 5** Edit the XML.

**Step 6** Click Save.

The custom desktop layout replaces the default desktop layout for the team after 10 seconds. If a supervisor or agent is signed in when the change is saved, the change does not take effect on their desktop until the supervisor or agent signs out and signs in again.
If you clear the Override System Default checkbox, any changes you made to the XML are lost and the XML in the editing pane reverts to the default desktop layout XML.

**Note**

If the Supervisor is managing single/multiple teams, the custom layout of the team for which the supervisor is a resource/agent is displayed. However, if the supervisor is not the resource/agent of a team, the layout of the default team is displayed.

**Customize Desktop Properties at Team Level**

You can customize the Finesse desktop properties for a specific team.

**Procedure**

**Step 1** In the Manage Team Resources gadget, select a team.

**Step 2** Click Desktop Layout.

**Step 3** Select the Override System Default check box.

**Step 4** Select from the following editors:

- Text Editor
- XML Editor

**Step 5** Enter the desktop property name in the config key tag.

**Step 6** Enter the possible value of the desktop property in the value tag.

The following are the sample desktop property entries, as displayed in the default Desktop Layout. To change these desktop property entries in Text Editor, remove the comment (<!-- and -->) and set appropriate values.

```xml
<!-- <config key="enableDragDropAndResizeGadget" value="false"/> -->
<!-- <config key="wrapUpCountDown" value="true"/> -->
<!-- <config key="desktopChatAttachmentEnabled" value="true"/> -->
<!-- <config key="enableShortCutKeys" value="true"/> -->
```

**Note**

If the property value is defined in the team-specific desktop layout (Manage Team Resources > Desktop Layout), then the team-specific desktop layout takes precedence over the property value defined in the Desktop Layout and CLI.

For more information on customizing desktop properties at Desktop Layout, see Customize Desktop Properties.

For more information on Finesse CLIs, see Desktop Properties.

The following table lists the desktop properties that support team-level updates:

<table>
<thead>
<tr>
<th>Config Key</th>
<th>Value</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>enableDragDropAndResizeGadget</td>
<td>true/false</td>
<td>false</td>
</tr>
<tr>
<td>enableShortCutKeys</td>
<td>true/false</td>
<td>true</td>
</tr>
</tbody>
</table>
### Assign Workflows to Team

#### Procedure

**Step 1** In the Manage Team Resources gadget, select a team.
**Step 2** Click the Workflows tab.
**Step 3** Click **Add**.
**Step 4** Select one or more workflows from the list to assign them to the team.

Workflows you assign are highlighted in blue in the Add Workflows popup and added to the List of Workflows area.

**Step 5** Workflows are executed in the order they are listed. Use the up and down arrows to move a selected workflow to the desired position in the list.

---

<table>
<thead>
<tr>
<th>Config Key</th>
<th>Value</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>forceWrapUp</td>
<td>true</td>
<td>false</td>
</tr>
<tr>
<td>wrapUpCountDown</td>
<td>true</td>
<td>false</td>
</tr>
<tr>
<td>showWrapUpTimer</td>
<td>true</td>
<td>false</td>
</tr>
<tr>
<td>desktopChatAttachmentEnabled</td>
<td>true</td>
<td>false</td>
</tr>
<tr>
<td>desktopChatMaxAttachmentSize</td>
<td>Range: 1—10 (MB)</td>
<td>5</td>
</tr>
<tr>
<td>desktopChatUnsupportedFileTypes</td>
<td>Unsupported file formats include comma-separated valid file extensions. For example: .exe, .sh .exe, .msi, .sh, .bat</td>
<td></td>
</tr>
<tr>
<td>showAgentHistoryGadgets</td>
<td>true</td>
<td>false</td>
</tr>
<tr>
<td>showActiveCallDetails</td>
<td>true</td>
<td>false</td>
</tr>
<tr>
<td>(for Supervisor Only)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>pendingDTMFTresholdCount</td>
<td>Range: 1—20</td>
<td>20</td>
</tr>
<tr>
<td>dtmfRequestTimeoutInMs</td>
<td>Range: 1000—200000 (1 to 200 seconds)</td>
<td>5000 (5 seconds)</td>
</tr>
</tbody>
</table>

For more information on Finess desktop properties, see *Desktop Properties*.

**Step 7** Click **Save**.

The change takes effect when the agent or supervisor refreshes the Finess desktop or sign out and sign in again.

**Note** If you clear the **Override System Default** check box and click **Save**. The changes are overwritten, and the editing pane reverts to the default desktop layout XML.
Step 6 When you have finished assigning workflows, click Save.

Note You can make changes on all resource tabs and then save them at the same time. If there is an error on one resource tab but not on others, the changes on the tabs with no errors are saved while the changes on the tab with errors are not saved.

Unassign Workflows from Team

Procedure

Step 1 In the Manage Team Resources gadget, select a team.
Step 2 Click the Workflows tab.
Step 3 Click the red X next to the workflow to unassign.
Step 4 Click Save.

Manage Workflows

On the Workflows tab of the Cisco Finesse administration console, you can create and manage workflows and workflow actions.

Workflows and Workflow Actions

You can use workflows to automate common repetitive agent tasks. A workflow has a unique name and a helpful description. Use the Manage Workflows and Manage Workflow Actions gadgets to view, add, edit, or delete workflows and workflow actions.

All workflows are team-level workflows. You cannot create a global workflow. If you need a global workflow, create a team workflow and assign it to all teams.

Finesse supports the following number of workflows and workflow actions:

- 100 workflows per Finesse system
- 100 actions per Finesse system
- 20 workflows per team
- 5 conditions per workflow
- 5 actions per workflow
- 5 variables per action

There are additional fields that are used to configure workflow based on the media type selected:

- For Voice - Call variables, Outbound option variables, queue details, wrap-up reasons, agent details or team details.
- For Email - Queue name and email attributes like From, To, Cc, Bcc, or Subject.
• For Chat - Queue name, chat type, or system defined customer details as available from the webchat form.

Click the column headers to sort workflows and workflow actions in ascending or descending order.

The following table describes the fields on the Manage Workflows gadget:

<table>
<thead>
<tr>
<th>Field</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Media</td>
<td>The media of the workflow. You can choose the media as Voice, Email or Chat.</td>
</tr>
<tr>
<td>Name</td>
<td>The name of the workflow must be unique and can be a maximum length of 40 characters.</td>
</tr>
<tr>
<td>Description</td>
<td>The description of the workflow can be a maximum length of 128 characters.</td>
</tr>
</tbody>
</table>

The following table describes the fields on the Manage Workflow Actions gadget:

<table>
<thead>
<tr>
<th>Field</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the workflow action must be unique and can be a maximum length of 64 characters.</td>
</tr>
<tr>
<td>Type</td>
<td>The type of workflow. Possible values are Browser Pop and HTTP Request.</td>
</tr>
</tbody>
</table>

Actions on the Manage Workflows and Manage Workflow Actions gadgets:

• **New**: Add a new workflow or workflow action
• **Edit**: Edit an workflow or workflow action
• **Delete**: Delete a workflow or workflow action
• **Refresh**: Reload the list of workflows or workflow actions from the server

You can configure workflow actions to be handled by the Finesse desktop or in a third-party gadget. A third-party gadget can be designed to handle the action differently than Finesse does.

Each workflow must contain only one trigger. Triggers are based on Finesse dialog events.

---

### Note

You can configure the trigger only after you select the media.

• Voice dialog events include the following:
  • When a Call arrives
  • When a Call is answered

---

### Note

If you set a workflow to trigger when a call is answered, the workflow runs when an agent answers an incoming call or makes an outgoing call, or when a customer answers an Outbound Option call.
• When a Call ends
• When making a Call

Note The call variable workflow responds as expected only when you add both the conditions: **Is not equal** and **Is not empty**.

• While previewing an Outbound call.

• Chat dialog events include the following:
  • When Chat is Presented
  • When Chat is Accepted
  • When Chat is Handled
  • When Group Chat is Declined
  • When Leaving Group Chat

• Email dialog events include the following:
  • When Email is Presented
  • When Email is Read
  • When Email is Discarded
  • When Email is Replied
  • When Email is Forwarded
  • When Email is Requeued

The workflow engine uses the following simple logic to determine whether to execute a workflow:

Note The workflow logic and examples are similar for all media.

• Its trigger set and conditions are evaluated against each dialog event received.

• The workflow engine processes workflow events for the first call that matches any configured workflow's trigger set and conditions. No other workflows run until this call has ended. If the agent accepts a second call while still on the first call, workflows do not run on the second call even after the first call has ended.

Note Outbound Preview calls are an exception to this rule. You can have a workflow run while the agent previews the call and when the agent accepts the call.

• After a workflow for a particular trigger type (for example, Call Arrives) executes, it never triggers again for the same dialog ID.
The workflow engine caches workflows for an agent when the agent signs in. Workflows do not change for the agent until the agent signs out and signs in again or refreshes the browser.

**Note**

Workflows that trigger when a call arrives, when a call is answered, or when making a call, run whenever the browser is refreshed. When an agent refreshes the browser, the workflow engine sees the call as newly arrived or newly made. If an HTTP request action is part of the workflow, the HTTP request is sent when the agent refreshes the browser. Applications that receive the HTTP requests must account for this scenario.

An example of a workflow is a Call Arrival event that triggers an action that collects information from the dialog event (for example, the ANI or customer information) and displays a webpage containing customer information.

You can filter trigger events by the value of the data that comes in the event. You can configure a workflow to execute if any conditions are met or if all conditions are met.

Individual conditions comprise of the following:

- A piece of event data to be examined, for example, DNIS or call variables.
- A comparison between the event data and entered values (for example, contains, is equal to, is not equal to, begins with, ends with, is empty, is not empty, and is in list).

When the trigger and its conditions are satisfied, a list of actions assigned to the workflow are executed. The actions execute in the listed order.

Workflows run only for agents and supervisors who are Finesse users. The Workflow Engine is a JavaScript library that runs client-side on a per-user basis within the Finesse desktop application. The desktop retrieves the workflows to execute for a user from the server when the user signs in or refreshes the browser.

**Note**

Changes made to a workflow or its actions while a user is signed in are not automatically pushed to that user.

It is possible to set workflows, conditions, and actions that are contradictory so that a workflow or action cannot function. Workflows are not validated.

If multiple workflows are configured for a team, the Workflow Engine evaluates them in the configured order. The Workflow Engine ignores workflows with no actions. When the Workflow Engine finds a workflow with a matching trigger for the event and the workflow conditions evaluate to true, then that workflow is the one used and subsequent workflows in the list are not evaluated. Workflows with no conditions evaluate to true if the event matches the workflow trigger. All workflows are enabled by default. Only one workflow for a specific user can run at a time.

The Workflow Engine retrieves dialog-based variables used in workflow conditions from the dialog that triggered the workflow. If a variable is not found in the dialog, its value is assumed to be empty.

The Workflow Engine executes the actions associated with the matched workflow in the order in which they are listed. The Workflow Engine executes actions in a workflow even if the previously executed action fails. Failed actions are logged.

The Finesse server controls which calls are displayed to the Finesse user. If the user has multiple calls, the workflow applies only to the first call that matches a trigger. If the first call displayed does not match any triggers but the second call does match a trigger, the Workflow Engine evaluates and processes the triggers for the second call.
A call is considered to be the first displayed call if it is the only call on the Finesse desktop when it appears. If two calls on a phone are merged (as they are in a conference call), then the first displayed call flag value of the surviving call is used.

If the user has a call when the user refreshes the browser, the Workflow Engine evaluates the call as it is. If the dialog data (call variable values) change, the data may not match the trigger and conditions of the original workflow. The data may match a different workflow or no workflows at all.

If the user has multiple calls when the user refreshes the browser, the Workflow Engine treats the first dialog received from the Finesse server as the first displayed call. This call may not be the same call that was the first displayed call before the browser refresh. Dialogs received for any other call are ignored because they are not considered first displayed calls. If dialogs for more than one call are received before the Workflow Engine is loaded after the browser refresh, no dialogs are evaluated because none are considered first displayed calls.

Workflows run for both Finesse agents and supervisors. The team to which the supervisor belongs (as distinguished from the team that the supervisor manages) determines which workflows run for the supervisor. Put the supervisors in their own team to keep agent workflows from being run for them.

**Workflow Triggers and Outbound Calls**

**Note** When you create a workflow specifically for Outbound Option calls, add a condition of BAStatus is not empty (except for the Workflow Trigger 'When a call arrives' as BAStatus will be empty at that point of time). This condition ensures that the workflow can distinguish Outbound Option calls from agent-initiated outbound calls.

The following table illustrates when workflows trigger in outbound call scenarios:

<table>
<thead>
<tr>
<th>Workflow Trigger</th>
<th>Direct Preview Outbound Call</th>
<th>Progressive/Predictive Outbound Call</th>
</tr>
</thead>
<tbody>
<tr>
<td>When previewing a call</td>
<td>When the agent previews the call (before accepting or rejecting it)</td>
<td>Does not trigger</td>
</tr>
<tr>
<td>When a call arrives</td>
<td>Does not trigger</td>
<td>Does not trigger</td>
</tr>
<tr>
<td>When a call is answered</td>
<td>When the customer answers the call and during failover</td>
<td>When the customer answers the call</td>
</tr>
<tr>
<td>When a call is made</td>
<td>When the customer call is initiated</td>
<td>When the customer call is initiated, and during failover</td>
</tr>
<tr>
<td>When a call ends</td>
<td>When the customer call ends</td>
<td>When the customer call ends</td>
</tr>
</tbody>
</table>

**Add Browser Pop Workflow Action**

The Browser Pop workflow action opens a browser window or tab on the user's desktop when workflow conditions are met.

**Note** Whether the action opens a new window or tab on the desktop depends on the target user's browser settings.
Procedure

**Step 1**
In the Manage Workflow Actions gadget, click **New**.

**Step 2**
In the Name box, enter a name for the action.

*Note*  Workflow action names are limited to 64 characters.

**Step 3**
From the Type drop-down list, choose **Browser Pop**.

**Step 4**
From the Handled By drop-down list, choose what will execute the action, either the Finesse Desktop or Other (a third-party gadget).

**Step 5**
In the Window Name box, enter the ID name of the window that is opened. Any action that uses this window name reuses that specific window.

*Note*  Window names are limited to 40 characters, and can be blank. If you leave the window name blank, a new window opens every time the action runs.

**Step 6**
Enter the URL of the browser window and click the tag icon at the right of the box and select one or more variables from the drop-down list to add tags.

*Example:*

```
http://www.google.com/search?q=callVariable1&callVariable2
```

For every variable you select, you can enter test data in the Sample Data box. A sample URL is automatically built in the Browser URL box below the Sample Data area. To test the URL, click **Open** to open the URL in your browser.

*Note*  Finesse does not validate the URL you enter.

**Step 7**
Click **Save**.

---

## Add HTTP Request Workflow Action

The HTTP Request workflow action makes an HTTP request to an API on behalf of the desktop user.

**Procedure**

**Step 1**
In the Manage Workflow Actions area, click **New**.

**Step 2**
In the Name box, enter a name for the action.

A workflow action name can contain a maximum of 64 characters.

**Step 3**
From the Type drop-down list, select **HTTP Request**.

**Step 4**
From the Handled By drop-down list, select what will execute the action, the Finesse desktop or Other (a third-party gadget).

**Step 5**
From the Method drop-down list, select the method to use.

You can select either PUT or POST.

---
Step 6  From the Location drop-down list, select the location.
If you are making the HTTP request to a Finesse API, select Finesse. If you are making a request to any other API, select Other.

Step 7  In the Content Type box, enter the content type.
The default content type is application/xml, which is the content type for Finesse APIs. If you are using a different API, enter the content types for that API (for example, application/JSON).

Step 8  In the URL box, enter the URL to which to make the request. To add variables to the URL, click the tag icon at the right of the box and select one or more variables from the drop-down list.

Note  The drop-down list contains variables from all the media channels.

Example:
The following is the URL example for a Finesse API:

```
/finesse/api/Dialog/[dialogId]
```

Note  When the location is FINESSE, do not specify the protocol, host, and port information. Finesse automatically fetches these details when the REST request is executed.

If you want to make a request to another API, you must enter the entire URL (for example, http://googleapis.com).

You can click the tag icon at the right of the box and select one or more variables from the drop-down list to add tags to the URL. In the preceding example, to add the dialogId, click the tag icon and select dialogId from the list.

Step 9  In the Body box, enter the text for the request. The body must match the content type (for example, if the content types is application/xml, the body must contain XML). To add variables to the body, click the tag icon at the right of the box and select one or more variables from the drop-down list.

Example:
To make an HTTP request to the Dialog - Start a recording API, enter the following into the Body box:

```
<Dialog>
<targetMediaAddress>extension</targetMediaAddress>
<requestedAction>SEND_DTMF</requestedAction>
<actionParams><ActionParam><name>dtxfString</name><value>8</value></ActionParam></actionParams>
</Dialog>
```

To add the extension, click the tag icon and select extension.
For every variable you add, you can enter test data in the Sample Data box.

Step 10  Click Save.
**Edit Workflow Action**

**Procedure**

**Step 1**  
In the Manage Workflow Actions gadget, select the action that you want to edit.

**Step 2**  
Click **Edit**.

**Step 3**  
Edit the fields that you want to change.

**Step 4**  
Click **Save**.

**Delete Workflow Action**

**Procedure**

**Step 1**  
In the Workflow Actions gadget, select the action that you want to delete.

**Step 2**  
Click **Delete**.

**Step 3**  
Click **Yes** to confirm the deletion of the selected action.

**Add Workflow**

**Procedure**

**Step 1**  
In the Manage Workflows gadget, click **New**.

**Step 2**  
From the **Choose Media** drop-down, select the media.

**Note**  
In case of a voice only configuration, the **Choose Media** drop-down will display only Voice.

**Step 3**  
In the **Name** box, enter the name of the workflow.

**Note**  
The name is limited to 40 characters.

**Step 4**  
In the **Description** box, enter a description of the workflow.

**Note**  
The description is limited to 128 characters.

**Step 5**  
In the **When to perform Actions** drop-down list, select the event that triggers the workflow.

**Note**  
The drop-down actions change depending on the selected media.

**Step 6**  
In the **How to apply Conditions** box, select if all conditions are met, or if any conditions are met, and then click **Add Condition** to add up to five conditions.
Variables in the drop-down for conditions are grouped depending on the selected media. The fields To, Cc, and Bcc support comma separated values, so that, agents can enter multiple email IDs.

**Example:**
For example, you can specify that the action is taken when CallVariable 1 equals 123 and CallVariable 2 begins with 2.

**Step 7**  
In the Ordered List of Actions area, click Add to open the Add Actions area. Click an action in this area to add it to the Ordered List of Actions.

**Step 8**  
Use the up and down arrows next to the Ordered List of Actions to move actions into the performance order.

**Step 9**  
Click Save.

**Step 10**  
Assign the workflow to one or more teams.

**Note**  
A workflow does not run until it is assigned to a team.

---

### Edit Workflow

**Procedure**

**Step 1**  
In the Manage Workflows gadget, select the workflow you want to edit.

**Step 2**  
Click Edit.

**Note**  
The media for an existing workflow can be changed by editing the workflow.

**Step 3**  
Edit the fields that you want to change.

**Step 4**  
Click Save.

---

### Delete Workflow

**Procedure**

**Step 1**  
In the Manage Workflows gadget, select the workflow that you want to delete.

**Step 2**  
Click Delete.

**Step 3**  
Click Yes to confirm the deletion of the selected workflow.

---

### Manage Security

The Cisco Finesse administration console and agent desktop support secure HTTP (HTTPS). To access the administration console, enter the following URL in your browser (where FQDN is the fully qualified domain name of your primary server):
HTTPS Support

The Cisco Finesse administration console and agent desktop supports only HTTPS. To access the administration console using HTTPS, enter the following URL in your browser:

https://FQDN:8445/cfadmin

Where FQDN is the name of your primary Finesse server and 8445 is the port number.

Similarly, agents and supervisors can access their desktops using HTTPS as follows:

https://FQDN:8445/desktop

For HTTPS access, you can eliminate browser security warnings by choosing to trust the self-signed certificate provided with Finesse or uploading a CA certificate.

If you add custom gadgets that perform HTTPS requests to Finesse, you must add a certificate to the Finesse server for that gadget.

Note
Wildcard Certificates are not supported in Unified CCX.

HSTS

Finesse supports HTTP Strict Transport Security (HSTS) for increased security. HSTS is automatically enabled, in which case the Finesse server sends HTTPS responses indicating to browsers that Finesse can only be accessed using HTTPS. If users then try to access Finesse using HTTP instead of HTTPS, the browser changes the connection to HTTPS before generating any network traffic. This functionality prevents browsers from sending requests to Finesse using unencrypted HTTP before the server can redirect them.

Cross-Origin Resource Sharing (CORS)

Finesse supports CORS requests and allows the customization of the domains which are allowed to make CORS requests to the Finesse desktop. Once CORS is enabled via the CLI `utils finesse cors enable`, the CORS origin request from external domains is blocked by the browser. To enable specific domains to access Finesse desktop via CORS, the domains need to be added to the CORS origin allowed list using the CLI `utils finesse cors allowed_origin add`. For more information on the CORS CLIs, see Cisco Finesse CLI.

Gadget Source Allowed List

Shindig proxies requests from the Finesse desktop to external servers and this introduces the possibility of server side request forgery (SSRF). To prevent SSRF, you can choose to restrict outgoing connections requested
by the gadgets to specific URIs by enabling Shindig allowed listing CLIs and adding the required URIs to the allowed list. For more information on Gadget Source Allowed List CLIs, see *Cisco Finesse CLI*.

### Security Enhancements

Cisco Finesse Release 12.5(1) onward, following security changes are implemented:

- By default, Cisco Finesse Notification Service unsecure XMPP port 5222 and BOSH/WebSocket (HTTP) port 7071 are disabled.

  Use the CLI command `utils finesse set_property webservices enableInsecureOpenfirePort true` to enable these ports.

  For more information on CLI commands, see *Service Properties*.

### Manage Finesse IP Phone Agent

#### Finesse IP Phone Agent

With Finesse IP Phone Agent (IPPA), agents and supervisors can access Finesse features on their Cisco IP Phones as an alternative to accessing Finesse through the browser. Finesse IPPA supports fewer features than the Finesse desktop in the browser, but it does allow agents and supervisors to receive and manage Finesse calls if they lose or do not have access to a computer.

#### Supervisor Tasks

Finesse IPPA does not support supervisor tasks such as monitor, barge, and intercept, but supervisors can sign in and perform all agent tasks on their IP Phones.

#### Administration Tasks

After you configure Finesse IPPA, the administration tasks that you perform for the Finesse desktop also apply for the supported Finesse IPPA features. For example, the Call Variables Layouts that you configure for the desktop also apply for Finesse IPPA, although the column layout is modified to fit the IP Phone screen.

#### Reason Code Limitations

- On the IP Phone, Finesse can display a maximum of 100 Not Ready, Wrap Up, or Sign Out reason codes. If more than 100 codes are configured, the phone lists the first 100 applicable codes (global or applicable team codes).

- When Finesse IPPA displays reason codes, some IP Phone models truncate the codes due to character length limitations on the phone. To ensure they meet your requirements, verify the display of the reason codes on all phone models in your environment.

#### Finesse IP Phone Agent Service Access Protocol

Finesse IPPA phone clients communicate with the Finesse server using Secure HTTP (HTTPS) protocol.

#### Failure Behavior

Unlike the Finesse desktop, the Finesse IP Phone Agent does not automatically failover to the alternate Finesse server. To resume normal operations in a failure scenario, the Finesse IPPA agents must exit from the current
Finesse IP Phone service and manually sign in to another configured Finesses service that connects to an alternate Finesseserver.

To ensure continued operations in a failure situation, you must configure at least two Finesse IP Phone services in Unified CM, each pointing to different Finesseservers.

One Button Sign In

With One Button Sign In, you can set up the Finesses IP Phone services with prepopulated agent ID, extension, and password. In this case, agents can sign in to Finesses on the IP Phone without credentials just by selecting Cisco Finesses from the Services menu.

Alternatively, you can set up One Button Sign In and prepopulate only a subset of agent credentials. For example:

- You can prepopulate only the agent ID and extension, forcing the agents to manually enter their password at sign-in for increased security.
- You can prepopulate only the extension, forcing agents to manually enter their ID and password at sign-in (useful for agents who share the same phone).

You can use Unified CM Administration to prepopulate the agent credentials, or you can set up the agents with access to the Unified CM Self Care Portal to prepopulate their own credentials.

The following table shows examples of how you can assign the responsibility of defining agent credentials to the administrator or the agent, or share that responsibility between them:

<table>
<thead>
<tr>
<th>Example Set Up</th>
<th>Prepopulated in Unified CM Administration (by Administrator)</th>
<th>Prepopulated in Self Care Portal (by Agent)</th>
<th>Entered at Sign-In (by Agent)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Administrator populates the extension only</td>
<td>extension</td>
<td>-</td>
<td>id password</td>
</tr>
<tr>
<td>Administrator populates the ID and extension</td>
<td>id extension</td>
<td>-</td>
<td>password</td>
</tr>
<tr>
<td>Agents enter password only using Self Care Portal</td>
<td>id extension</td>
<td>password</td>
<td>-</td>
</tr>
<tr>
<td>Agents enter all credentials using Self Care Portal</td>
<td>-</td>
<td>id extension password</td>
<td>-</td>
</tr>
<tr>
<td>Agents enter ID and extension only using Self Care Portal</td>
<td>-</td>
<td>id extension password</td>
<td>password</td>
</tr>
</tbody>
</table>
Finesse IP Phone Service Subscription Options

To set up access to Finesse on agent IP phones in Cisco Unified Communications Manager, you must create the Finesse IP Phone service to which the phones can subscribe. To set up the Finesse service, you can choose one of the following options:

- Set up an enterprise subscription to automatically subscribe all IP phones in the cluster to the Finesse service. (Not supported with One Button Sign In.)
- Set up a manual subscription, and manually subscribe each IP phone to the Finesse service.
- Set up a manual subscription, and set up the agents with access to the Unified CM Self Care Portal to subscribe to the Finesse service.

The following table lists the Finesse IPPA configuration procedures and indicates which procedures are required depending on the subscription option you choose:

<table>
<thead>
<tr>
<th>Finesse IPPA Configuration Procedures</th>
<th>Enterprise Subscription</th>
<th>Manual Subscription</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Administrator Manually Subscribes the Phones</td>
<td>Agents Manually Subscribe Their Phones Using the Self Care Portal</td>
</tr>
<tr>
<td>Set Up Application User, Web Access, and HTTPS Server Parameters</td>
<td>Required</td>
<td>Required</td>
</tr>
<tr>
<td>Configure Finesse IP Phone Service in Unified CM</td>
<td>Required</td>
<td>Required</td>
</tr>
<tr>
<td>Add Service Parameters for One Button Sign In</td>
<td>Not applicable</td>
<td>Required only with One Button Sign In</td>
</tr>
<tr>
<td>Subscribe Agent Phones to Manual Subscription Service</td>
<td>Not applicable</td>
<td>Required</td>
</tr>
<tr>
<td>Set Up Agent Access to the Self Care Portal</td>
<td>Not applicable</td>
<td>Optional. Allows the administrator to enter agent credentials for One Button Sign In.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Required</td>
</tr>
</tbody>
</table>

Set Up Application User, Web Access, and HTTPS Server Parameters

To support Finesse IPPA functionality, you must configure an application user in Unified Communications Manager that is associated with all Finesse IPPA phones. For proper Finesse IPPA operation, you must also set the Web Access and HTTPS Server parameters in Unified CM.

The following steps are required for both manual and enterprise subscriptions:

**Before you begin**

Set up call capabilities for the agent phones in Cisco Unified Communications Manager.
Procedure

Step 1
Set the following parameters in Unified CM:

- Set the Web Access parameter to Enabled.
- Set the HTTPS Server parameter to HTTPS Only.

To set these parameters in Cisco Unified CM Administration, use either of the following pages:

- Phone Configuration page (Product Specific Configuration portion of page): choose Device > Phone.
- Enterprise Phone Configuration page: choose System > Enterprise Phone Configuration.

Step 2
Configure an application user in Unified Communications Manager.

a) In Cisco Unified Communications Manager Administration, select User Management > Application User.

b) Click Add New.

c) Under User Information, enter a userID and password for the new user.

The password must be 95 characters or less and must contain ASCII characters only.

d) Under Device Information, in the Available Devices pane, select all phones that Finesse IP Phone Agents will use and move them to the Controlled Devices pane using the arrows.

e) Under Permissions Information, click Add to Access Control Group.

f) From the list of search results, select Standard CTI Enabled and Standard CTI Allow Control Of All Devices and then click Add Selected.

The application user is added to the Standard CTI Enabled and Standard CTI Allow Control Of All Devices groups.

g) Click Save at the bottom of the page.

Note In UCCX deployments, usage of an existing RMCM User for Finesse IPPA is known to cause problems in functionality, however, the physical phones must be associated with the RMCM User.

Step 3
Enter the application user's credentials in the Finesse IP Phone Agent Settings gadget.

a) Sign in to the Cisco Finesse Administration Console.

b) Choose Settings > IP Phone Agent Settings.

c) Under Phone URL Authentication Settings, enter the same username and password that you entered in Unified CM for the application user.

The password must be 95 characters or less and must contain ASCII characters only.

d) Click Save.

e) Restart Cisco Finesse Tomcat on the primary Unified CCX node.

f) After replication is complete, restart Cisco Finesse Tomcat on the secondary Unified CCX node.

For information to check the replication status, see Step 3 of Prepare System for IP Address/hostname Change.
For Finesse IP Phone Agent (IPPA) from 11.0 (1) onwards, the User Device Profile (UDP) must be associated with the Finesse IP Phone Agent Application User along with the physical phones for agents using Extension Mobility. The Finesse Service URL must use the complete FQDN of the Unified CCX server.

Configure Finesse IP Phone Service in Unified CM

The following procedure describes the steps required for manual and enterprise subscription.

Procedure

| Step 1 | Log in to the Unified CM Administration using administrator credentials. |
| Step 2 | Select Device > Device Settings > Phone Services. |
| Step 3 | Click Add New to create a new IP phone service. |
| Step 4 | In the Service Name field, enter Cisco Finesse (or another service name that is appropriate for your environment). |
| Step 5 | In the Service URL field, enter: http://Finesse FQDN:8082/fippa/#DEVICENAME# |

Note: The Service URL entry is mandatory for Unified CM.

| Step 6 | In the Secure-Service URL field, enter: https://Finesse FQDN:8445/fippa/#DEVICENAME# to configure Finesse IP Phone Agent. |

Note: Support to HTTP is disabled from Cisco Finesse, Release 12.5(1) onwards. Step 5 and Step 6 are mandatory to save the Finesse IP Phone Agent settings.

• Import certificates for Finesse IP Phone Agent to communicate with the Finesses server using Secure HTTP (HTTPS) mode. For more information, see Finesse IP Phone Agent Certificate Management.

| Step 7 | Ensure that the Service Category is set to XML Service, and the Service Type is set to Standard IP Phone Service. |
| Step 8 | Check the Enable check box. |
| Step 9 | Perform one of the following: |

• To automatically subscribe all phones in the cluster to the Finesse service, check the Enterprise Subscription check box, and click Save. Agents and supervisors can now access Cisco Finesse by selecting it from the Services menu on subscribed IP phones.

Note: One Button Sign In is not supported with enterprise subscriptions.

• To subscribe only the desired phones to the Finesse service manually, leave the Enterprise Subscription check box unchecked and click Save.

| Step 10 | With a two-node Finesses setup (primary and secondary Finesses servers), perform the preceding steps again to create a secondary Finesses service that points to the secondary Finesses server. When you create the secondary service, note the following procedural differences: |
At Step 4, in the Service Name field, enter a name that distinguishes the secondary service from the primary service, such as Cisco Finesse Secondary.

At Step 5 and Step 6, replace Finesse FQDN with the FQDN of the secondary server.

Note: The language used in Finesse IPPA is selected based on the User Locale field in Unified CM. The language selected based on the User Locale must be available in the Unified CCX language pack for Unified CCX deployments. If the language selected based on the User Locale in Unified CM is not available in the Unified CCX deployment, Finesse IPPA displays all content in the default language (U.S. English).

Finesse IP Phone Agent Certificate Management

The administrator must perform the following operations to enable Finesse IP phones to communicate with the Finesseserver using HTTPS.

• For a CA-signed certificate, see CA-Signed Certificate, on page 446.
• For a self-signed certificate, see Self-Signed Certificate, on page 446.

CA-Signed Certificate

Procedure

Step 1 Obtain the CA-signed certificate from the signed authority for both Cisco Unified CCX and CUCM server.
Step 2 Import the CA-signed certificate of CUCM to the Cisco Unified CCX server trust store as tomat-trust. For more information, see Import CUCM Certificate , on page 447.
Step 3 Import the CA-signed certificate of Cisco Unified CCX certificate to the CUCM trust store as Phone-trust. For more information, see Import Certificate into CUCM Trust Store, on page 448.

Self-Signed Certificate

Procedure

Step 1 Export the self-signed CUCM certificate from the Cisco Unified Operating System Administration. For more information, see Export CUCM Certificate, on page 447.
Step 2 Import the downloaded self-signed CUCM certificate to the Cisco Unified CCX trust store as tomat-trust. For more information, see Import CUCM Certificate, on page 447.
Step 3 Export the self-signed Cisco Unified CCX certificate from the Cisco Unified Operating System Administration. For more information, see Export Cisco Unified CCX Certificate, on page 448.
Step 4 Import the downloaded self-signed Cisco Unified CCX certificate to the CUCM trust store as Phone-trust. For more information, see Import Certificate into CUCM Trust Store, on page 448.
**Export CUCM Certificate**

**Procedure**

**Step 1** Sign in to Cisco Unified OS Administration on the CUCM server using the following URL: https://FQDN of CUCM server:8443/cmplatform.

**Step 2** Select Security > Certificate Management.

**Step 3** Enter the search criteria as **tomcat** and then click **Find** to filter the certificate.

The tomcat certificates list is displayed. If you do not find the tomcat certificate for your server in the **Certificate List**, then click **Generate Self-signed**. When the certificate generation is complete, reboot your server. Then restart this procedure. For more information on generating the self-signed certificate, see *Cisco Unified Operating System Administration Online Help*.

**Step 4** Click the tomcat certificate hyperlink in the **Common Name** column.

**Step 5** Click **Download .PEM File**.

**Step 6** Save the .PEM file in your local machine.

**What to do next**

Follow the same steps for both publisher and subscriber nodes. It is also to be followed for all the CUCM node certificates.

**Import CUCM Certificate**

**Procedure**

**Step 1** Sign in to Cisco Unified OS Administration on the Cisco Unified CCX server using the following URL: https://FQDN of Unified CCX server:8443/cmplatform.


**Step 3** From the **Certificate Purpose** drop-down list, select tomcat-trust.

**Step 4** In the **Upload File** field, click **Choose File** and browse to the tomcat.pem or CA-signed certificate file that you saved on your system.

**Step 5** Click **Upload**.

**Step 6** Restart Cisco Finesse tomcat and Cisco Unified CCX Notification Service.

**Note** Follow the same steps for both publisher and subscriber nodes. It is also to be followed for all the CUCM node certificates.
Export Cisco Unified CCX Certificate

**Procedure**

**Step 1** Sign in to Cisco Unified OS Administration on the Cisco Unified CCX server using the following URL: https://FQDN of Unified CCX server:8443/cmplatform.

**Step 2** Select Security > Certificate Management.

**Step 3** Enter the search criteria as tomcat-trust and then click Find to filter the certificate.

The tomcat-trust certificates list is displayed. If you do not find the tomcat certificate for your server in the Certificate List, then click Generate Self-signed. When the certificate generation is complete, reboot your server. Then restart this procedure. For more information on generating the self-signed certificate, see Cisco Unified Operating System Administration Online Help.

**Step 4** Click the tomcat-trust certificate hyperlink in the Common Name column.

The tomcat Certificate Details dialog box is displayed.

**Step 5** Click Download .PEM File.

**Step 6** Save the .PEM file in your local machine.

**What to do next**

Follow the same steps for both publisher and subscriber nodes. It is also to be followed for all the CUCM node certificates.

Import Certificate into CUCM Trust Store

**Procedure**

**Step 1** Sign in to Cisco Unified OS Administration on the CUCM server using the following URL: https://FQDN of CUCM server:8443/cmplatform.


**Step 3** From the Certificate Purpose drop-down list, select Phone-trust.

**Step 4** In the Upload File field, click Browse and browse to the tomcat.pem or CA-signed certificate file that you saved on your system.

**Step 5** Click Upload.

**Step 6** Reboot the Cisco Unified Communications Manager (CUCM) server.

**Note** Follow the same steps for both publisher and subscriber nodes. It is also to be followed for all the CUCM node certificates.

Add Service Parameters for One Button Sign In

With One Button Sign In, for any agent credentials that you want prepopulated, you must set up corresponding service parameters in Unified CM.
Only perform this procedure if you are setting up One Button Sign In. Otherwise, skip this.

Procedure

**Step 1**
From Cisco Unified Communications Manager Administration, select the Finesse phone service (under Device > Device Settings > Phone Services).

**Step 2**
Click **New** to the right of the Parameters box.

**Step 3**
Set up service parameters for the agent id, extension, and password credentials as per the following table. Enter only the parameters that you want prepopulated for the agents. For each parameter, enter the required field values and click **Save**. To add parameters, click **Add New** and enter the required values.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Parameter Name</td>
<td>Enter one of the following parameter names as follows:</td>
</tr>
<tr>
<td></td>
<td>• Id</td>
</tr>
<tr>
<td></td>
<td>• Extension</td>
</tr>
<tr>
<td></td>
<td>• Password</td>
</tr>
<tr>
<td></td>
<td>The values entered are the exact query string parameters used for the subscription URL.</td>
</tr>
<tr>
<td>Parameter Display Name</td>
<td>Enter a descriptive parameter name; for example, id, extension, and password.</td>
</tr>
<tr>
<td>Default Value</td>
<td>Leave the default value blank for all parameters.</td>
</tr>
<tr>
<td>Parameter Description</td>
<td>Enter a description of the parameter. The user can access this text when they subscribe to the service.</td>
</tr>
<tr>
<td>Parameter is Required</td>
<td>If the administrator prepopulates the parameter in Unified CM Administration, check the <strong>Parameter is Required</strong> box.</td>
</tr>
<tr>
<td></td>
<td>However, if the agent prepopulates the parameter in the Self Care Portal, two options are available:</td>
</tr>
<tr>
<td></td>
<td>• If the agents prepopulates all defined parameters, check the <strong>Parameter is Required</strong> box for each parameter.</td>
</tr>
<tr>
<td></td>
<td>• If the agent and administrator share the responsibility of prepopulating the parameters, set only the administrator-defined parameters as required. This configuration ensures that the administrator can save the subscription without prepopulating all parameters. In this case, the administrator first prepopulates the required parameters, and then the agents prepopulate the nonrequired parameters.</td>
</tr>
<tr>
<td>Parameter is a Password (mask contents)</td>
<td>Check this box for the password only.</td>
</tr>
<tr>
<td></td>
<td>This check box masks the password entries in the Self Care Portal, to display asterisks rather than the user entry.</td>
</tr>
</tbody>
</table>
When you save the last parameter, click **Save and Close**.

---

**What to do next**

You can prepopulate the agent credentials when you subscribe the agent phones, or the agents can prepopulate their own credentials using the Unified CM Self Care Portal.

### Subscribe Agent Phones to Manual Subscription Service

If you set up the Finesse service as a manual subscription, you can subscribe the agent phones to the Finesse service in Unified CM and optionally define agent credentials for One Button Sign In.

If you prefer to allow the agents to subscribe to the Finesse service using the Self Care Portal and prefer not to specify One Button Sign In credentials for the agents, you can skip this procedure.

**Procedure**

**Step 1**  From the menu bar, select **Device > Phone**.

**Step 2**  Select the phone that you want to subscribe to the Finesse service.

**Step 3**  From the **Related Links** drop-down list on the upper right side of the window, select **Subscribe/Unsubscribe Services** and click **Go**.

The **Subscribed IP phone services** window displays for this phone.

**Step 4**  From the **Select a Service** drop-down list, select **Cisco Finesse**.

**Step 5**  Click **Next**.

**Step 6**  *(Applicable for One Button Sign In only)* Enter values for any of the defined service parameters (id, password, and extension) that you do not want the agents to enter using the Self Service Portal or at sign-in.

**Step 7**  Click the **Subscribe** button to subscribe this phone to the Cisco Finesse service.

The Cisco Finesse service displays in the **Subscribed Services** list.

**Step 8**  Click **Save**.

The subscribed agents or supervisors can now access Cisco Finesse by selecting it from the **Services** menu on their IP phones.

**Step 9**  With a two-node Finesse setup (primary and secondary Finesse servers), perform this procedure again to also subscribe the phones to the secondary Finesse service that points to the secondary Finesse server.

---

### Set Up Agent Access to the Self Care Portal

You can optionally set up the agents with access to the Unified CM Self Care Portal to prepopulate their own credentials and to subscribe to the Finesse service.

If you are not setting up One Button Sign In, or not enabling the agents with access to the Self Care Portal, skip this procedure.
Procedure

Step 1 From the Unified CM Administration page, select System > Enterprise Parameters.
Step 2 Under the Self Care Portal Parameters, in the Self Care Portal Default Server field, select the IP address of the Unified CM Publisher server from the drop-down list and click Save.
Step 3 Select User Management > End User.
Step 4 Select the user that you want to set up with access to the User Care Portal.
Step 5 Under Permissions Information, click Add to Access Control Group.
Step 6 From the list of Access Control groups displayed, check Standard CCM End Users and click Add Selected.
Step 7 Click Save.

With access enabled to the Self Care Portal, agents can sign in to the portal at http://<UCM address>/ucmuser to subscribe to the Finesse service and enter their own credentials under Phones > Phone Settings > Services.

Note In a two-node Finesse setup with two services configured, the agents must enter their credentials on the primary and secondary Finesse services.

Cisco Finesse Failover Mechanisms

CTI Failover

CTI failover is when the Finesse service disconnects from one CTI server and reconnects to the same or another CTI server.

The prerequisites for successful CTI failover are as follows:

- Unified Contact Center Express (Unified CCX) must be configured in High Availability (two-node, publisher and subscriber) setup.
- Unified CCX REST service on the local CCX node must be up and running.

In the two-node setup, if Finesse loses connection to the Unified CCX server, it attempts to connect to the server which is running. Finesse alternates between the configured servers until it makes a successful connection.

While failover is in progress, Finesse transitions to OUT_OF_SERVICE state. During this period, Finesse does not entertain client requests or send out events. Any request made during this time receives a 503 Service Unavailable error message.

After reconnecting to a Unified CCX server and transitioning to IN_SERVICE state, Finesse responds to client requests and publishes events.

Note For Finesse transition to IN_SERVICE,

- Unified CCX REST services on the publisher must be IN_SERVICE.
- Unified CCX server CTI connectivity to the publisher or the subscriber must be successful.
Connection to the Unified CCX server can be lost due to the following reasons:

• Finesse misses three consecutive heartbeats from the connected Unified CCX server (heartbeat interval is five seconds).

• Finesse socket that is opened to the Unified CCX server.

• Unified CCX REST services on the publisher transitions to OUT_OF_SERVICE.

After the failover is complete, the last state of call control, call data, or agent state are published as events to all clients. This allows Finesse clients to reflect an accurate view of the call control, call data, and agent state.

If an agent either makes or answers a call, and then ends that call during failover (that is, the entire call takes place during failover), the corresponding events are not published.

---

**Note**

An agent or supervisor might experience certain limitations, related to preservation of their states over failover. Examples include, but are not limited to, the following:

• The Finesse desktop does not show the agent state as it was before the failover, instead shows NOT READY state.

• The Finesse desktop does not show the pending state that the agent had set before the failover.

• The Finesse desktop shows NOT READY state even when there is an active call.

Despite these limitations, the agent and supervisor can continue to perform normal operations on the phone.

---

**Finesse Desktop Failover**

Desktop failover can occur for the following reasons:

• When the Finesse desktop loses network connectivity to the Unified CCX Notification Service.

• When the Finesse Tomcat Service becomes *Unavailable*.

• When the Finesse REST API Service becomes *Unavailable*.

• When the Unified CCX Notification Service becomes *Unavailable*.

• When the Finesse loses connection to the publisher.

---

**Note**

• After the failover, the pending state of an agent will not be displayed once the agent fails over to the subscriber. The pending state change is lost during the failover, as the agent will be logged out, and logged in again.

• Finesse is IN_SERVICE, co-ordinates the distribution of desktop reloads, such that failover and consequent desktop reloads are evenly distributed to prevent overwhelming of the Finesse service. Configuration data such as reason codes, workflows and so on are not reloaded during failover to improve the performance.
If the server that an agent is connected transitions to OUT_OF_SERVICE, the agent receives a notification that the connection with the server is lost. The Finesse desktop:

- Checks whether the subscriber is available and IN_SERVICE.
- Continues to check whether the publisher recovers its state.

If the subscriber is available, then the desktop automatically signs the agent into the subscriber. If the publisher recovers its state, the desktop notifies the agent that it has reconnected.

The failover logic has three triggers to detect desktop failure:

- The Finesse desktop receives a SystemInfo event that the publisher is OUT_OF_SERVICE.
- The Unified CCX Notification Service is disconnected.
- The XMPP presence of “finesse” user changes to Unavailable.

No matter which trigger is detected, the desktop reconnection logic is as follows:

1. Poll SystemInfo for publisher every 20 seconds.
2. If SystemInfo API reports Finesse is IN_SERVICE, check the Unified CCX Notification Service.
3. If SystemInfo is IN_SERVICE, check whether the last CTI heartbeat status of the side being connected is a success.

The last CTI heartbeat status is checked to ensure that the subscriber is healthy before failover, and thus does not immediately transition to OUT_OF_SERVICE after the client has failed over. Removal of the publisher from the network can cause the Finesse service to disconnect and connect to its local Unified CCX server. Depending on the network topology the subscriber might be slower to sense a network disconnect.

4. If XMPP is disconnected, make the Unified CCX Notification Service request.
5. If the Unified CCX Notification Service is successful and Finesse service is IN_SERVICE, refresh the data.

The failover logic prefers to stay with the publisher. If the failover logic detects that the subscriber is available, it checks the publisher one more time. If the publisher has recovered, the desktop reconnects to the publisher. If the publisher is still down, the desktop connects the agent to the subscriber. In this case, the agent does not automatically reconnect to the failed server after it recovers, but instead remains connected to the subscriber.

If the Unified CCX Notification Service is the source of failure, the desktop makes three attempts to reconnect before changing the state of the desktop to disconnected. These attempts occur before the failover logic begins.

**Desktop Behavior**

When the agent is forcibly logged out due to the connection failure between the Finesse desktop and the Finesse service, then Finesse sends a reason code 255 to the Unified CCX server. The Unified CCX server places the agent in Logout state.
Finesse takes up to 120 seconds to detect when an agent closes the browser. If the browser crashes, Finesse waits 60 seconds before sending a forced logout request to the Unified CCX server. Under these conditions, Finesse can take up to 180 seconds to sign out the agent.

The following table lists the conditions under which Finesse sends this code to the Unified CCX server.

<table>
<thead>
<tr>
<th>Scenario</th>
<th>Desktop Behavior</th>
<th>Server Action</th>
<th>Results</th>
</tr>
</thead>
<tbody>
<tr>
<td>The agent closes the browser, the browser crashes, or the agent clicks the Back button on the browser.</td>
<td>Finesse desktop makes a best-effort attempt to notify the server.</td>
<td>Finesse receives a presence notification of Unavailable from the client. Finesse waits 60 seconds, and then sends a forced logout request to the Unified CCX server.</td>
<td>Race Conditions 1. The agent closes the browser window. Finesse receives a presence notification of Unavailable for the user. Finesse tries to sign the agent out; however, that agent is already signed out.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>2. If the browser crashes, it can take the Finesse service up to 120 seconds to detect that the client is gone and send a presence notification to Finesse. A situation can occur where the client signs into the subscriber before the publisher receives the presence notification caused by the browser crash. In this case, the agent may be signed out or put into Not Ready state on the subscriber.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>3. If the Finesse desktop is running</td>
</tr>
</tbody>
</table>
over a slower network connection, Finesse may not always receive an *Unavailable* presence notification from the client browser. In this situation, the behavior mimics a browser crash, as described in the preceding condition.

4. The agent is logged out, with reason code Connection Failure, which can be seen in the reports.

| The client refreshes the browser | Finesse receives a presence notification of *Unavailable* from the client. Finesse waits 60 seconds before sending a forced logout request to the Unified CCX server to allow the browser to reconnect after the refresh. | — |

| The Refresh Token has expired. For more information on tokens, see https://developer.cisco.com/docs/finesse/#single-sign-on-apis. | Finesse desktop sends a forced logout request to the Unified CCX server. | The Finesse service forwards the forced logout request to the Unified CCX server. | The session expiry warning appears 10 minutes and 5 minutes before the Refresh Token expires. In the last minute, a countdown timer appears till the Refresh Token expires. The agent is forcefully logged out when the timer reaches zero and must log in again. |
Desktop Chat Failover

The following table lists the desktop chat failover scenarios:

<table>
<thead>
<tr>
<th>Failover Type</th>
<th>Desktop Chat Behavior</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cisco IM&amp;P server failover</td>
<td>The desktop chat status is retained, and all active chat sessions are lost.</td>
</tr>
<tr>
<td>Finesseservice failover</td>
<td>The desktop chat status is retained, and all active chat sessions are lost.</td>
</tr>
<tr>
<td>Unified CCX server failover</td>
<td>The desktop chat status and all chat sessions are retained.</td>
</tr>
</tbody>
</table>

Finesseservice failover can occur for the following reasons:

- The Finesseservice REST API Service transitions to "OUT_OF_SERVICE".
- The Unified CCX Notification Service transitions to "OUT_OF_SERVICE".
- The Finesseservice connection to the Unified CCX server transitions to "OUT_OF_SERVICE".
- If Finesseservice detects a server failure before Finesseservice fails over to the subscriber, then Finesseservice declares the Finesseservice service "OUT_OF_SERVICE".

The server that an agent is connected transitions to "OUT_OF_SERVICE", the Finesseservice IP Phone Agent (IPPA) displays a notification that the server is unavailable. Finesseservice IPPA continues to check whether the current Finesseservice service recovers its state and notifies the agent if it reconnects.

Finesseservice IPPA attempts to reconnect to the server every 5 seconds and declares it "OUT_OF_SERVICE" after three failed attempts. The total time required for the transition to "OUT_OF_SERVICE" is approximately 15 seconds.

Unlike the Finesseservice desktop, Finesseservice IPPA does not check whether the subscriber is available. To connect to subscriber, the agent must exit the publisher, and manually sign into the subscriber.

Finesseservice IPPA failover logic has the following two triggers to detect failure:

- Finesseservice IPPA receives a SystemInfo event that the publisher is "OUT_OF_SERVICE".
  Finesseservice IPPA polls SystemInfo every 5 seconds to check whether the Finesseservice service is "IN_SERVICE". After three attempts, if the Finesseservice service is not "IN_SERVICE", Finesseservice IPPA displays a server unavailable message to the agent.
- Finesseservice IPPA receives notification that the Unified CCX Notification Service is disconnected.
  Finesseservice IPPA tries every 5 seconds to reconnect with the XMPP server. After three attempts, if the Unified CCX Notification Service cannot be reestablished, Finesseservice IPPA displays a server unavailable message to the agent.

While the agent is still signed into the current service, Finesseservice IPPA continues attempting to reestablish the connections with the Finesseservice and XMPP servers. If they both resume service, Finesseservice IPPA displays the Sign In screen and the agent can sign in again and continue as normal.
Alternately, the agent must exit the current Finesse service and try to connect using an alternate Finesse service.

Guidelines for Optimal Desktop Failover

The following are the guidelines to optimize failover scenarios, to avoid server overload and unnecessary delays.

- Browser Configuration, on page 457
- Agent Configuration, on page 458
- Finesse Configuration, on page 458
- Common Configuration Safeguards, on page 458

Note

The guidelines for optimal failover ensure that desktop initialization time and general system performance is optimized.

Browser Configuration

Finesse browser failover performance depends on the number of requests made to the Finesse service. Fewer the requests, lesser the system load on the Finesse service. The following browser-specific configurations ensure that the browser does not fetch static resources unnecessarily from the server, and it is a key requirement for faster failover.

Note

Clear the browser cookies before logging into the Finesse desktop. This avoids unexpected expiry of the Refresh Token in the Single Sign-On mode for Unified CCX.

- Avoid loading the Finesse desktop with `bypassServerCache=true&nocache` as a query parameter in the desktop URL. The `bypassServerCache` is to bypass Webproxy cache, and `nocache` is to bypass Shindig cache.

- Host systems must have at least 200 MB of free disk space more than the free space required by the operating system (OS).

- Adequate network bandwidth must be available between the Finesse desktop and the Finesse service. Lower latency results in faster failover.


- Host systems must have adequate memory and CPU without being overloaded at any point in time. A slow host slows the browser enough to cause it to fail and reload resources randomly during failover.

- External gadget hosting servers must prefer CA-signed certificates for easy integration with the browser. If they are self-signed, then import those certificates into the agent browser.

Firefox Configurations

Disable the Race Cache With Network (RCWN) in all the agent desktops to avoid any unwanted requests to the Finesse service. If RCWN is enabled, the Firefox browser by-passes the cached data and fetches the static requests again from the server. Set the network.http.rcwn.enabled configuration as false.

For more information, see https://support.mozilla.org/en-US/questions/1267945.

Google Chrome, Internet Explorer, and Microsoft Edge Configurations

Import the Finesse self-signed certificates on Google Chrome, Internet Explorer, and Microsoft Edge browsers trust store.


Agent Configuration

Agents configured must be evenly distributed between the publisher and subscriber. This prevents all agents from failing over when there is an outage that affects only one of the deployed Finesse service.

The number of agents failing over impacts system load and has a linear relationship with the maximum time taken for the operation to complete.

Finesse Configuration

The number of signed-in users, the gadget types, and the average number of gadgets configured per user, significantly impacts failover load.

The following are the best practices for ensuring a trouble-free failover.

- Number of Gadgets per Agent—Gadget-initiated requests constitute the bulk of the requests made during Finesse desktop failover or startup. Configuring fewer gadgets in the desktop layout results in faster desktop failover and startup. The administrator must configure the team or desktop layouts such that only the required gadgets for each team are available in the desktop layout.

- Type of Gadget—XML-based gadgets load much faster. The gadget content is also cached at the WebProxy Service, which allows the Finesse service to scale further.

- Gadget Configuration—Gadgets developers must follow certain best practices to ensure that gadgets load faster.


- Secondary Resources—The preloading of server resources reduces latency and improves performance during desktop failover. By default, the preLoadSecondaryResources property is enabled. Disabling this property impacts failover time. For more information, see Desktop Properties.

Common Configuration Safeguards

- Import the self-signed certificates into the browser.
• Do not disable browser caching for Finesse desktop.
• Do not clear the cache every time the browser is launched.
• Distribute the agents between the publisher and subscriber.

Failover Planning

CTI Failover

CTI failover happens when Finesse service disconnects from the Unified CCX server due to network failure or server error. If the desktop is connected, it displays that the server is unavailable, and tries to reconnect to the available Unified CCX server.

The duration required for Finesse CTI failover depends on the following factors.

• Available bandwidth from the remote Unified CCX to the Finesse service.
• Round Trip Time (RTT) between the Unified CCX server and the Finesse service in case of WAN deployments.
• The number of signed-in users.
• The number of gadgets configured.

Note

The time indicated does not include the Unified CCX server recovering from the failure it encountered. It indicates only the time taken for Finesse to reconnect and be IN_SERVICE.

Desktop Failover

The Finesse desktop failover happens in all failure scenarios. The Finesse desktop tries to find an active server and fails over to it, once it has located a reachable server which is IN_SERVICE.

The duration required for Finesse desktop failover depends on the following factors.

• Bandwidth available to the client to reach the Finesse service.
• Time taken for Unified CCX server to become IN-SERVICE.
• RTT between the client and the network gateway.
• The number of signed-in users.
• The number of gadgets configured in the desktop per user.
• Type of gadgets (XML) and the resources it loads. For more information on Finesse gadgets, see https://developer.cisco.com/docs/finesse/#finesse-gadgets.

The average time taken for desktop failover, with 400 logged in users, and system defined gadgets per agent, is 35-75 seconds, after an IN-SERVICE Finesse service is identified. If Unified CCX server failover is involved, then the time taken is longer as it includes the time taken for Finesse service failover.

The numbers indicated varies depending on the customer configuration and the above-stated factors. It must be used as a guideline to determine the approximate range for failover time.
Backup and Restore

The Unified CCX backup and restore component also backs up and restores Finesse configurations and data.


Additional Language Support

For the list of languages that are supported by Finesse, see the Unified CCX Compatibility related information, located at:


If you want to use the Finesse desktop interface in a language other than English, download and install the language COP file. For more information, see the “COP File” section of the Cisco Unified Contact Center Express Install and Upgrade Guide, located at:


Cisco Finesse Agent and Supervisor Desktop

Cisco Finesse Desktop provides easy access to the applications and information sources from a single customizable cockpit. Providing this unique access to information helps the agents deliver fast and accurate service.

CUIC Cluster Configuration

• Cluster Configuration for JVM Using Hazelcast, on page 461
• Troubleshooting Cluster Configuration, on page 463

Cluster Configuration for JVM Using Hazelcast

Cisco Unified Intelligence Center uses Hazelcast for application clustering. Hazelcast provides a second-level cache for the Unified Intelligence Center application layer. When any entity (for example: report, report definition, and so on) cached by Hazelcast is updated in one of the Unified Intelligence Center nodes, it must be invalidated and reloaded in all the other Unified Intelligence Center nodes in the cluster. The Hazelcast cluster automatically takes care of it by publishing clusterwide notifications containing the identifiers of such entities which must be invalidated.

In Unified Intelligence Center, the default mechanism for Hazelcast cluster discovery or formation is UDP multicast. Unified Intelligence Center uses the Multicast group IP address 224.2.2.3 and port 54327. You cannot change these settings in Unified Intelligence Center.

The UDP multicast based discovery mechanism will not work for the customer in the following scenarios:

• When the network has multicasting disabled.

• If the nodes in the Unified Intelligence Center cluster are in different subnets.

In such scenarios, you can change the discovery mechanism to TCP/IP. You can form the CUIC application cluster using TCP/IP instead of the default UDP Multicast based discovery mechanism.

Use the following CLI commands to manage the cluster mode (UDP Multicast vs TCP/IP). That is, use the following CLI commands to switch to TCP/IP only if the customer’s network does not support Multicasting:

• `utils cuic cluster show`—This command shows the current cluster mode that is enabled on this node and the other member details.

  **Note**

  The member details are available only in the TCP/IP mode. The member details displayed are of the configured members and does not represent the cluster in real time.

• `utils cuic cluster mode`—This command is used to switch the Hazelcast cluster join configuration from Multicast to TCP/IP and the opposite way.
After changing the cluster mode in all the nodes, restart “Intelligence Center Reporting Service” in all the nodes starting from the publisher sequentially.

**Note**

- **utils cuic cluster refresh**—This command refreshes the cluster member information only when executed in the TCP/IP mode. Run this command when there is an addition or deletion of nodes to the CUIC cluster, which is already in TCP/IP.

**Usage**

You can use these commands using to switch to TCP/IP only when the customer’s network does not support the Multicasting requirements that are specified in Port Utilization Guide for Cisco Unified Contact Center Solutions > Intracluster Ports Between Cisco Unified Intelligence Center section available at https://www.cisco.com/c/en/us/support/customer-collaboration/unified-contact-center-enterprise/products-installation-and-configuration-guides-list.html.

- Stop the “Cisco Unified Intelligence Center Reporting Service” on all the Unified Intelligence Center nodes before performing cluster configuration changes using these CLI commands.

- When you have completed the cluster configuration changes on all nodes, use the “utils cuic cluster show” command to ensure that all nodes have identical configuration before starting “Cisco Unified Intelligence Center Reporting Service” on any one of them.

- Unified Intelligence Center cluster / application will work only if all the nodes use the same mode—that is, either Multicast or TCP/IP. Mixed mode is not allowed.

- If the network is disconnected and after the cluster nodes retain the network, ensure to perform “synchronize cluster” from all the nodes after logging into the Unified Intelligence Center reporting application.

**Steps**

Run the following CLIs on all nodes in the given sequence starting from the Publisher node:

**Note**

Execute every step on all nodes before performing the subsequent step.

**Procedure**

**Step 1**

utils service stop Cisco Unified Intelligence Center Reporting Service

**Step 2**

utils cuic cluster mode

**Step 3**

utils cuic cluster show

**Note**

Ensure that all nodes have identical configuration.

**Step 4**

utils service start Cisco Unified Intelligence Center Reporting Service
Troubleshooting Cluster Configuration

Verify the Hazelcast Cluster Formation using Hazelcast REST client. To verify, replace <CUIC-IP> with the IP address of any CUIC member in the following URL.

http://<CUIC-IP>:57011/hazelcast/rest/cluster

The Unified Intelligence Center application cluster can be down in the following cases:

• Common Cases:
  • Node is not reachable
  • Unified Intelligence Center Reporting Service is down
  • Extra Node is added in OAMP and the node installation is in progress
  • Hazelcast default Port 57011 is not enabled in Unified Intelligence Center nodes in the customer environment, which is used to communicate between cluster members.

• When multicasting is being used for the member discovery (Default method):
  • Network has UDP multicast disabled
  • UDP port 54327 used for Hazelcast member discovery is disabled
  • Multicast default group IP 224.2.2.3 is not allowed in the network
  • CUIC nodes are distributed across different subnets

Note

If any of the above mentioned cases cause issue because of the restrictions on multicasting in the customer environment, you can use TCP/IP for Hazelcast discovery.

• When TCP/IP is being used for the member discovery:
  • When an extra Node is added in OAMP, but the cluster mode in the newly added node is not switched to TCP/IP from the default method ‘multicasting’.

For more information, contact Cisco support to troubleshoot and reset the cluster.
Overview of Extend and Connect

With the Extend and Connect feature, Unified Contact Center Express agents and supervisors can work from a remote location using any device.

This feature gives the user (agent or supervisor) the flexibility to answer or make calls using devices that are connected to the PSTN or to mobile or other PBX networks. Extend and Connect functions by leveraging CTI remote device and persistent connection features of Cisco Unified Communications Manager (CUCM).

You can enable the Extend and Connect feature through the Cisco Jabber client by selecting only the Extend mode. This feature provide the following connections:

- **CTI remote device**—CTI remote devices are Unified CCX off-cluster devices for users that can be connected to any of the third-party networks, such as PSTN, mobile, or PBX.

- **Persistent connection**—Unified CCX users use this feature to set up a persistent call connection to remote destination. The advantage of this connection is that call establishment to the remote destination is much faster.

For information about Extend and Connect feature, see *Features and Services Guide for Cisco Unified Communications Manager* at https://www.cisco.com/c/en/us/td/docs/voice_ip_comm/cucm/admin/10_0_1/ccmfeat/CUCM_BK_F3AC1C0F_00_cuem-features-services-guide-100/CUCM_BK_F3AC1C0F_00_cuem-features-services-guide-100_chapter_010111.html.


Server Configuration

To use the Extend and Connect, follow these server configuration steps:
Procedure

Step 1  Perform the preinstallation tasks for IM and Presence nodes.

Step 2  Configure the Cisco IM and Presence node details on Call Manager before you install Cisco IM and Presence.
From Cisco Unified CM Administration on the publisher node, choose System > Server > Server Type and then choose **CUCM IM and Presence**.


Step 3  Install Cisco IM and Presence as a Call Manager subscriber.

Step 4  Activate and start all the Cisco IM and Presence services in Cisco Unified Serviceability.
For information about activating services, see the "Configure the IM and Presence Publisher" section in Installation Guide for Cisco Unified Communications Manager and the IM and Presence Service at https://www.cisco.com/c/en/us/support/unified-communications/unified-communications-manager-callmanager/products-installation-guides-list.html

Step 5  Create Presence Redundancy groups in Call Manager.
   a)  Choose System > Presence Redundancy Groups > Add New.
   b)  Select Cisco IM and Presence, which you installed from the Presence Server drop-down list.


Step 6  Create UC services for CTI and IM Presence services in Call Manager.

*Note* You must select CTI and IM Presence services.


Step 7  Set up the service profile in Call Manager.

*Note* You must specify CTI and IM Presence service that you created in step 6.


Step 8  Set up the end user in Call Manager.
Perform the following steps:
Example


**Persistant Connection**

Unified CCX makes a persistent connection call to the agent's remote phone when an agent logs in to the agent desktop.

**Note**

The agent must first answer the persistent connection call and then change the status to Ready in the agent desktop to answer the incoming call.
After establishing the persistent connection, the call remains connected until the Maximum Call Duration timer expires or until the agent logs out, provided that no other problems occur in the remote destination network. You must specify to match the time on the Maximum Call Duration timer with your company shift time or specify more than your company shift time. If the persistent connection gets disconnected, it retries until the connection is established.

**Add Customized Announcement for Persistent Connection Call**

When an agent answers persistent connection call, make an announcement to the agent indicating that the persistent connection must be retained so that further calls from or to customers are established over persistent connection.

If the agent's remote device supports Caller ID display, it displays EC Mode as the caller name, which indicates a persistent connection call.

By default, the Cisco Unified Communications Manager has announcements created. Unified CCX, through JTAPI communication to Cisco Unified Communications Manager, calls the announcement ID UCCX Persistent Connection Prompt. You must create the UCCX Persistent Connection Prompt customized announcement ID.


Enter **UCCX Persistent Connection Prompt** in the Announcement Identifier field.

**Note**

- Add a customized prompt to the created UCCX Persistent Connection Prompt, click **Upload Files** and select the desired prompt (.wav file).
- When the announcement is played, the Caller ID information on agent's remote phone changes to **Voice Connect**.
- If no announcement ID is created, Cisco Unified Communications Manager does not play any announcement to the agent when the persistent call is answered.

**Incoming Call Notification**

An agent can configure a sound alert to notify an incoming call when the customer calls are routed through Persistent Connection Calls of the agents.

To receive the sound alert, in Cisco Unified Communications Manager, configure the Announcement ID as **UCCX Customer Call Prompt**. When the Announcement ID is configured, Unified CCX plays the announcement before the call is routed to a desktop. If you do not configure an Announcement ID, Unified CCX does not play an announcement, and then the agent relies on desktop signal for an incoming call.

**Note**

Configure **UCCX Customer Call Prompt** in the English language in Cisco Unified Communications Manager.
Cisco Unified CCX Serviceability

Access Cisco Unified CCX Serviceability

When you complete the AppAdmin initial setup, the end user with administrator capability as configured in AppAdmin web interface can login to Cisco Unified CCX Serviceability. You can also log in as an Application user with default administrator capability configured during the installation of Unified CCX. See the Cisco Unified Contact Center Express Install and Upgrade Guide and Cisco Unified Contact Center Express Administration and Operations Guide for detailed instructions on initial AppAdmin setup and how to assign administrator capability to end users.

To access Cisco Unified CCX Serviceability:

Procedure

Step 1
By using a supported web browser, open a browser session.

Step 2
Go to https://<server name or IP address>/uccxservice/.

Step 3
Enter an applicable username and password, and click Login.

Note
If you log in as an end user, you can access Cisco Unified CCX Administration from the Navigation drop-down list box without logging in again. If you log in as an Application user, you can access Cisco Unified Serviceability in addition to these web applications.
Alarms

Cisco Unified CCX Serviceability alarms provide information on runtime status and the state of the system so that you can monitor the status and troubleshoot problems that are associated with the system. Alarm information includes the catalog, name, severity, explanation, recommended action, routing list, and parameters.

You can view alarm information by using the SysLog Viewer in Cisco Unified Real-Time Monitoring Tool (RTMT). See Cisco Unified Real-Time Monitoring Tool Administration Guide for Cisco Unified Contact Center Express and Cisco Unified IP IVR for detailed information on how to view alarm information.

Note
Use the Alarm Definitions web page in Cisco Unified Serviceability to find information about an alarm message.


Alarm Configuration

Use the Alarm Configuration web page in Unified CCX Serviceability to view and configure alarm server settings for different Unified CCX components.

Note
Alarm Server Configuration is applicable for the following Unified CCX components: Unified CCX Administration, Unified CCX Engine, and Unified CCX Cluster View Daemon.

The alarm configuration submenu allows you to:

- Enable or disable sending of alarms to local or remote syslog server.
- Configure alarm event level for local or remote syslog server

Select Alarm > Configuration from the Cisco Unified CCX Serviceability menu bar to access the Alarm Configuration web page.

Related Topics

Configure Alarm Settings, on page 470
Alarm Configuration Settings, on page 471

Configure Alarm Settings

The Alarm Configuration page is used to view and update Cisco Unified CCX Alarm Configuration for local and remote syslogs.
Procedure

Step 1

From the Unified CCX Serviceability menu bar, choose Alarm and click Configuration.

The Alarm Configuration web page opens and the following fields are displayed on the Alarm Configuration web page, if configured on your Unified CCX server:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Local Syslogs</td>
<td>Use the check box next to Enable Alarm field to enable or disable the alarms for local syslog.</td>
</tr>
<tr>
<td>Alarm Event Level</td>
<td>Lists the alarm severity level.</td>
</tr>
<tr>
<td>Remote Syslogs</td>
<td>Use the check box next to Enable Alarm field to enable or disable the alarms for remote syslog.</td>
</tr>
<tr>
<td>Server Name</td>
<td>IP address or hostname of the Syslog server to which system should send the alarm messages. If you are using CiscoWorks, enter the IP address or the hostname of the CiscoWorks server.</td>
</tr>
</tbody>
</table>

Step 2

To update the Alarm Event Level for local or remote syslogs, check the check box before Enable Alarm field.

Step 3

Modify Alarm Event Level for the local or remote syslogs by selecting from the Alarm Event Level drop-down list. Modify the syslog server name in case of remote syslog.

Step 4

Click Update icon that displays in the tool bar in the upper, left corner of the window or the Update button that displays at the bottom of the window to save your configuration. Click Clear to reset data to the previous values.

In case of a High Availability deployment, the alarm configuration changes are automatically propagated to the second node. If the second node cannot be contacted, an alert message indicating that the update has failed on the remote node is displayed.

Caution  
You should activate logging only for the purpose of debugging and remember to deactivate logging once the debugging session is complete.

Alarm Configuration Settings

Use the Alarm Configuration page to modify alarm settings.

In the case of a High Availability deployment, the alarm configuration changes are automatically propagated to the second node. If the second node cannot be contacted, an alert message indicating that the update has failed on the remote node is displayed.

Following table defines the options available on this page:
**Setting** | **Description**
---|---
Enable Alarm for Local Syslogs | The SysLog viewer serves as the alarm destination. The program logs errors in the Application Logs within SysLog Viewer and provides a description of the alarm and a recommended action. You can access the SysLog Viewer from the Cisco Unified Real-Time Monitoring Tool. For information on viewing logs with the SysLog Viewer, see *Cisco Unified Real-Time Monitoring Tool Administration Guide for Cisco Unified Contact Center Express and Cisco Unified IP IVR*.

Enable Alarm for Remote Syslogs | The Syslog file serves as the alarm destination. Check this check box to enable the Syslog messages to be stored on a Syslog server and to specify the Syslog server name.

Alarm Event Level | Alarm event level messages range from severity 0 (most severe) to severity 7 (least severe) description of which is mentioned below. When you choose a severity level, all messages of that severity level and higher are sent.

For example, if you choose ERROR_ALARM (Severity 3), all messages of severity 3, severity 2, severity 1, and severity 0 are sent. The default is “INFORMATIONAL_ALARM (Severity 6)”, which will send messages of all severity levels starting from 6 to severity level 0.

You can choose one of the following alarm event level options from the drop-down list box:

- **Emergency**
  - This level designates system as unusable.

- **Alert**
  - This level indicates that immediate action is needed.

- **Critical**
  - The system detects a critical condition.

- **Error**
  - This level signifies an error condition exists.

- **Warning**
  - This level indicates that a warning condition is detected.

- **Notice**
  - This level designates a normal but significant condition.

- **Informational**
  - This level designates information messages only.

- **Debug**
  - This level designates detailed event information that Cisco TAC engineers use for debugging.

---

**Traces**

A trace file is a log file that records activity from the Cisco Unified CCX components. Trace files let you obtain specific, detailed information about the system that can help you troubleshoot problems.

The Cisco Unified CCX system can generate trace information for different services. This information is stored in a trace file. To help you control the size of a trace file, you can specify the services for which you want to collect information and the level of information that you want to collect.
The Cisco Unified CCX system also generates information about all threads that are running on the system. This information is stored in the thread dump file and is useful for troubleshooting.

**Component Trace Files**

The component trace file contains information about each component. You can create a trace file for any of the following Unified CCX components:

- Cisco Unified CCX Administration
- Cisco Unified CCX Cluster View Daemon
- Cisco Unified CCX Editor
- Cisco Unified CCX Engine
- Cisco Unified CM Telephony Client
- Cisco Unified CCX Recording and Monitoring Services
- Cisco Unified CCX Socket.IO Service

---

**Note**

You must use Cisco Unified Intelligence Center CLIs for Log Trace Settings. For more information see *Cisco Unified Intelligence Center Commands.*

The component trace file contains information about each component. To set up the trace file, follow the procedure mentioned in **Configure Trace Parameters** section.

After configuring the information that you want to include in the trace files for the various services, you can collect and view trace files by using the trace and log central option in the Cisco Unified Real-Time Monitoring Tool. See *Cisco Unified Real-Time Monitoring Tool Administration Guide for Cisco Unified Contact Center Express and Cisco Unified IP IVR* for detailed information.

**Configure Trace Parameters**

To update trace file information and to activate and deactivate logging, follow the procedure mentioned below:

**Procedure**

**Step 1**

From the Cisco Unified CCX Serviceability menu bar, choose **Trace > Configuration.**

The Trace Configuration web page opens displaying the default trace configuration for Unified CCX Engine.

**Step 2**

From the **Select Service** drop-down list box, choose a service or component for which you want to configure trace then, click **Go.**

You should be able to view the existing Trace configurations and debug levels for the selected Unified CCX service with check boxes for the various Debugging and XDebugging levels for each sub facility.

The debug levels for different Unified CCX subfacilities or services might vary depending on the selected service and are listed in the following table:
Table 18: Debug Levels for Different Unified CCX Subfacilities

<table>
<thead>
<tr>
<th>Cisco Unified CCX Components</th>
<th>Subfacilities or Services</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cisco Unified CCX Administration</td>
<td>Libraries</td>
</tr>
<tr>
<td></td>
<td>Managers</td>
</tr>
<tr>
<td></td>
<td>Miscellaneous</td>
</tr>
<tr>
<td>Cisco Unified CCX Cluster View Daemon</td>
<td>Libraries</td>
</tr>
<tr>
<td></td>
<td>Managers</td>
</tr>
<tr>
<td></td>
<td>Miscellaneous</td>
</tr>
<tr>
<td>Cisco Unified CCX Editor</td>
<td>Libraries</td>
</tr>
<tr>
<td></td>
<td>Managers</td>
</tr>
<tr>
<td></td>
<td>Miscellaneous</td>
</tr>
<tr>
<td></td>
<td>Steps</td>
</tr>
<tr>
<td>Cisco Identity Service</td>
<td>Error</td>
</tr>
<tr>
<td></td>
<td>Warning</td>
</tr>
<tr>
<td></td>
<td>Information</td>
</tr>
<tr>
<td></td>
<td>Debugging</td>
</tr>
<tr>
<td>Cisco Unified CCX Engine</td>
<td>Libraries</td>
</tr>
<tr>
<td></td>
<td>Managers</td>
</tr>
<tr>
<td></td>
<td>Miscellaneous</td>
</tr>
<tr>
<td></td>
<td>Steps</td>
</tr>
<tr>
<td>Cisco Unified CM Telephony Client or JTAPI Debug Levels</td>
<td>Subsystems</td>
</tr>
</tbody>
</table>
Cisco Unified CCX Components | Subfacilities or Services
--- | ---
Warning |  
Information |  
Debugging |  
Cisco Unified CCX Socket.IO Service | Service |  
DataProcessing |  
Communication |  

**Step 3**

Update the debug level for one or more of the libraries or sub facilities for the selected service by doing the following:

a) To activate traces for a specific component or logging for a server, check the check box for the service that you chose.

b) To deactivate logging for a server, uncheck the specific check box.

**Caution** If you modify the trace level settings for Cisco Unified CM Telephony Client, you have to restart the Unified CCX Engine for the changes to take effect.

**Step 4**

To limit the number and size of the trace files, you can specify the trace output setting using the following two fields. See the following table for description and default values for these two fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum No. of Files</td>
<td>The maximum number of trace files to be retained by the system. This field specifies the total number of trace files for a given service. Cisco Unified CCX Serviceability automatically appends a sequence number to the file name to indicate which file it is; for example, Cisco001MADM14.log. When the last file in the sequence is full, the trace data begins writing over the first file. The default value varies by service.</td>
</tr>
<tr>
<td>Maximum File Size</td>
<td>This field specifies the maximum size of the trace file in kilobytes or megabytes depending on the selected service. The default value varies by service.</td>
</tr>
</tbody>
</table>

**Step 5**

Click **Save** icon that displays in the tool bar in the upper, left corner of the window or the **Save** button that displays at the bottom of the window to save your trace parameter configuration. The settings are updated in the system and the trace files will be generated as per the saved settings. Click **Restore Defaults** icon or button to revert to the default settings for the selected service.

In a High Availability deployment, the changes are propagated to the second node. If the second node cannot be contacted, an alert message indicating that the update has failed on the remote node is displayed.

**Caution** You should activate logging only for the purpose of debugging and remember to deactivate logging once the debugging session is complete.
Note You will not be able to save the trace configuration if the Socket.IO service is down. When the node containing the socket.IO service is down then the log levels will not be saved on that particular node.

Related Topics
Trace file location, on page 480

Trace Level Options

A trace file is a log file that records activity from the Cisco Unified CCX component subsystems and steps. Trace files let you obtain specific, detailed information about the system that can help you troubleshoot problems.

The Cisco Unified CCX system can generate trace information for every component. This information is stored in an trace file. To help you control the size of an trace file, you specify the components for which you want to collect information and the level of information that you want to collect.

A trace file that records all information for a component, such as the Cisco Unified CCX Engine, can become large and difficult to read. To help you manage the trace file, the Cisco Unified CCX system lets you specify the subfacilities for which you want to record information.

For each component, you can select one or more Debugging trace levels. These selections specify the level of details in the debugging messages that the system sends to a trace file. For instance, if you select Debugging, the system sends only the basic error messages while if you select XDebugging5, the system will send errors, warnings, informational, debugging, verbose messages and so on in detail to the trace file.

The table below describes the Trace file subfacilities.

<table>
<thead>
<tr>
<th>Component Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AC_CLUSTER</td>
<td>Archive Cluster Component</td>
</tr>
<tr>
<td>AC_CONFIG</td>
<td>Archive Configuration Component</td>
</tr>
<tr>
<td>AC_DATABASE</td>
<td>Archive Database Component</td>
</tr>
<tr>
<td>AC_JTAPI</td>
<td>JTAPI Archive Component</td>
</tr>
<tr>
<td>AC_OS</td>
<td>Archive Operating System Component</td>
</tr>
<tr>
<td>ADM</td>
<td>Administration Client</td>
</tr>
<tr>
<td>ADM_CFG</td>
<td>Administration Configuration</td>
</tr>
<tr>
<td>APP_MGR</td>
<td>Applications Manager</td>
</tr>
<tr>
<td>ARCHIVE_MGR</td>
<td>Archive Manager</td>
</tr>
<tr>
<td>AW_CFG</td>
<td>Restore Administration Configuration</td>
</tr>
<tr>
<td>BARBI_CLI</td>
<td>Backup and Restore Client Interface</td>
</tr>
<tr>
<td>Component Code</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------</td>
<td>------------------------------------------------------------------</td>
</tr>
<tr>
<td>BOOTSTRAP_MGR</td>
<td>Cisco Unified CCX Bootstrap Manager</td>
</tr>
<tr>
<td>CFG_MGR</td>
<td>Configuration Manager</td>
</tr>
<tr>
<td>CHANNEL_MGR</td>
<td>Channel Manager</td>
</tr>
<tr>
<td>CLUSTER_MGR</td>
<td>Cluster Manager</td>
</tr>
<tr>
<td>CONTACT_MGR</td>
<td>Contact Manager</td>
</tr>
<tr>
<td>CONTACT_STEPS</td>
<td>Contact Steps</td>
</tr>
<tr>
<td>CRA_CMM</td>
<td>Cisco Unified CCX ClusterMsgMgr Component</td>
</tr>
<tr>
<td>CRA_HRDM</td>
<td>Cisco Unified CCX Historical Reporting Data Manager</td>
</tr>
<tr>
<td>CVD</td>
<td>Cluster View Daemon</td>
</tr>
<tr>
<td>DB</td>
<td>Database</td>
</tr>
<tr>
<td>DBPURGE_MGR</td>
<td>Database Purge Manager</td>
</tr>
<tr>
<td>DESKTOP</td>
<td>Cisco Unified CCX Editor Desktop</td>
</tr>
<tr>
<td>DOC_MGR</td>
<td>Document Manager</td>
</tr>
<tr>
<td>EDT</td>
<td>Cisco Unified CCX Editor general</td>
</tr>
<tr>
<td>ENG</td>
<td>Cisco Unified CCX Engine</td>
</tr>
<tr>
<td>EXECUTOR_MGR</td>
<td>Executor Manager</td>
</tr>
<tr>
<td>EXPR_MGR</td>
<td>Expression Manager</td>
</tr>
<tr>
<td>FILE_MGR</td>
<td>File Manager</td>
</tr>
<tr>
<td>GENERIC</td>
<td>Generic catalog for a facility</td>
</tr>
<tr>
<td>GRAMMAR_MGR</td>
<td>Grammar Manager</td>
</tr>
<tr>
<td>GRP_CFG</td>
<td>Group Configuration</td>
</tr>
<tr>
<td>HOLIDAY_MGR</td>
<td>Holiday Manager</td>
</tr>
<tr>
<td>HR_MGR</td>
<td>Historical Reports Manager</td>
</tr>
<tr>
<td>ICD_CTI</td>
<td>Cisco Unified CCX CTI Server</td>
</tr>
<tr>
<td>ICD_HDM</td>
<td>IPCC Express Historical Data Manager</td>
</tr>
<tr>
<td>ICD_RTDM</td>
<td>Cisco Unified CCX ICD Real-Time Data Manager</td>
</tr>
<tr>
<td>IVR_RTDM</td>
<td>Cisco Unified CCX IP IVR Real-Time Data Manager</td>
</tr>
<tr>
<td>Component Code</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>IO_ICM</td>
<td>Cisco Unified ICME Input/Output</td>
</tr>
<tr>
<td>JASMIN</td>
<td>Java Signaling and Monitoring Interface</td>
</tr>
<tr>
<td>LIB_APPADMININTERCEPTOR</td>
<td>Cisco Unified CCX Administration Interceptor Library</td>
</tr>
<tr>
<td>LIB_AXL</td>
<td>AXL Library</td>
</tr>
<tr>
<td>LIB_CFG</td>
<td>Configuration Library</td>
</tr>
<tr>
<td>LIB_CLUSTER_CFG</td>
<td>Configuration Library for the cluster</td>
</tr>
<tr>
<td>LIB_CRTP</td>
<td>CRTP Library</td>
</tr>
<tr>
<td>LIB_DATABASE</td>
<td>Database Library</td>
</tr>
<tr>
<td>LIB_DIRECTORY</td>
<td>Directory Access Library</td>
</tr>
<tr>
<td>LIB_EVENT</td>
<td>Event Message Library</td>
</tr>
<tr>
<td>LIB_ICM</td>
<td>Cisco Unified ICME Library</td>
</tr>
<tr>
<td>LIB_JASPER</td>
<td>Jasper Tomcat Library</td>
</tr>
<tr>
<td>LIB_JCUP</td>
<td>JavaCup Library to parse expressions</td>
</tr>
<tr>
<td>LIB_JDBC</td>
<td>JDBC Library</td>
</tr>
<tr>
<td>LIB_JINI</td>
<td>JINI Services</td>
</tr>
<tr>
<td>LIB_JMAIL</td>
<td>Java Mail Library</td>
</tr>
<tr>
<td>LIB_JLEX</td>
<td>JLEX Library used to parse expressions</td>
</tr>
<tr>
<td>LIB_LICENSE</td>
<td>License Library</td>
</tr>
<tr>
<td>LIB_MEDIA</td>
<td>Media Library</td>
</tr>
<tr>
<td>LIB_RMI</td>
<td>Java Remote Method Invocation Library</td>
</tr>
<tr>
<td>LIB_SERVLET</td>
<td>Servlet Library</td>
</tr>
<tr>
<td>LIB_TC</td>
<td>Tomcat Library</td>
</tr>
<tr>
<td>LOG_MGR</td>
<td>Log Manager</td>
</tr>
<tr>
<td>MRCP_CFG</td>
<td>MRCP Configuration</td>
</tr>
<tr>
<td>MGR_MGR</td>
<td>Manager Manager</td>
</tr>
<tr>
<td>NODE_MGR</td>
<td>Node Manager</td>
</tr>
<tr>
<td>PALETTE</td>
<td>Editor Palette</td>
</tr>
<tr>
<td>Component Code</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td>PROMPT_MGR</td>
<td>Prompt Manager</td>
</tr>
<tr>
<td>PURGING</td>
<td>Purging</td>
</tr>
<tr>
<td>RPT</td>
<td>Reporting</td>
</tr>
<tr>
<td>RTPPORT_MGR</td>
<td>RTP Manager</td>
</tr>
<tr>
<td>SCRIPT_MGR</td>
<td>Script Manager</td>
</tr>
<tr>
<td>SESSION_MGR</td>
<td>Session Manager</td>
</tr>
<tr>
<td>SIP_STACK</td>
<td>SIP Stack logging</td>
</tr>
<tr>
<td>SOCKET_MGR</td>
<td>Socket Manager</td>
</tr>
<tr>
<td>SS_APP</td>
<td>Application Subsystem</td>
</tr>
<tr>
<td>SS_CHAT</td>
<td>Chat Subsystem</td>
</tr>
<tr>
<td>SS_CM</td>
<td>Contact Manager Subsystem</td>
</tr>
<tr>
<td>SS_CMT</td>
<td>Cisco Media Termination Subsystem</td>
</tr>
<tr>
<td>SS_DB</td>
<td>Database Subsystem</td>
</tr>
<tr>
<td>SS_EMAIL</td>
<td>Email Subsystem</td>
</tr>
<tr>
<td>SS_HTTP</td>
<td>HTTP Subsystem</td>
</tr>
<tr>
<td>SS_ICM</td>
<td>Cisco Unified ICME Subsystem</td>
</tr>
<tr>
<td>SS_MRCP_ASR</td>
<td>MRCP ASR Subsystem</td>
</tr>
<tr>
<td>SS_MRCP_TTS</td>
<td>MRCP TTS Subsystem</td>
</tr>
<tr>
<td>SS_OUTBOUND</td>
<td>Outbound Dialer Express Subsystem (uses MIVR log file)</td>
</tr>
<tr>
<td>SS_RTM</td>
<td>Resource Manager Subsystem</td>
</tr>
<tr>
<td>SS_RMCM</td>
<td>Resource Manager Contact Manager Subsystem</td>
</tr>
<tr>
<td>SS_ROUTEANDQUEUE</td>
<td>Route and Queue Subsystem</td>
</tr>
<tr>
<td>SS_RTR</td>
<td>Real-Time Reporting Subsystem</td>
</tr>
<tr>
<td>SS_SIP</td>
<td>SIP Subsystem</td>
</tr>
<tr>
<td>SS_TEL</td>
<td>JTAPI Subsystem (Telephony)</td>
</tr>
<tr>
<td>STEP_CALL_CONTROL</td>
<td>Call Control Steps</td>
</tr>
<tr>
<td>STEP_MEDIA_CONTROL</td>
<td>Media Control Steps</td>
</tr>
</tbody>
</table>
### Component Code

<table>
<thead>
<tr>
<th>Component Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>STEP_SESSION</td>
<td>Sessions Steps</td>
</tr>
<tr>
<td>STEP_SESSION_MGMT</td>
<td>Session Management Steps</td>
</tr>
<tr>
<td>STEP_USER</td>
<td>User Steps</td>
</tr>
<tr>
<td>STEP_CALL_CONTACT</td>
<td>Call Contact Steps</td>
</tr>
<tr>
<td>STEPS_CONTACT</td>
<td>Contact Steps</td>
</tr>
<tr>
<td>STEPS_DB</td>
<td>Database Steps</td>
</tr>
<tr>
<td>STEPS_DOCUMENT</td>
<td>Document Steps</td>
</tr>
<tr>
<td>STEPS_EMAIL</td>
<td>E-mail Steps</td>
</tr>
<tr>
<td>STEPSGENERAL</td>
<td>General Steps</td>
</tr>
<tr>
<td>STEPS_GRAMMAR</td>
<td>Grammar Steps</td>
</tr>
<tr>
<td>STEPS_HTTP</td>
<td>HTTP Steps</td>
</tr>
<tr>
<td>STEPS_ICM</td>
<td>Cisco Unified ICME Steps</td>
</tr>
<tr>
<td>STEPS_IPCC_EXP</td>
<td>Cisco Unified CCX Steps</td>
</tr>
<tr>
<td>STEPS_JAVA</td>
<td>Java Steps</td>
</tr>
<tr>
<td>STEPS_PROMPT</td>
<td>Prompt Steps</td>
</tr>
<tr>
<td>STEPS_SESSION</td>
<td>Session Steps</td>
</tr>
<tr>
<td>UCCX_WEBSERVICES</td>
<td>Chat Subsystem</td>
</tr>
<tr>
<td>USR_MGR</td>
<td>User Manager</td>
</tr>
<tr>
<td>WEB_STEPS</td>
<td>HTTP Contact Steps</td>
</tr>
</tbody>
</table>

When the Cisco Unified CCX product is running on a 7845 machine and tracing is ON (the default), limit the Busy Hour Call Completions (BHCC) to 4500 calls per hour. If you want to run a higher BHCC, turn the debug traces OFF. The trace subfacilities to be turned OFF are ICD_CTI, SS_TEL, SS_RM, SS_CM, and SS_RMCM.

### Trace file location

The Unified CCX server stores the trace files in the Log directory under the directory in which you installed the Unified CCX component. You can collect and view trace information using the Real-Time Monitoring Tool (RTMT).

### Trace File Information

The trace files contain information in standard Syslog format. The file includes some or all of the following information for each event that it records:
• Line number
• Date and time the event occurred
• Facility and subfacility (component) name
• Severity level
• Message name
• Explanation
• Parameters and values

**Log Profiles Management**

Log Profile is an aggregated entity that preserves trace settings of the following Unified CCX services:

- Cisco Unified CCX Engine (Traces termed as MIVR)
- Cisco Unified CCX Administration (Traces termed as MADM)
- Cisco Unified CCX Cluster View Daemon (Traces termed as MCVD)

Choose Trace > Profile from the Unified CCX Serviceability menu bar to access the Log Profiles Management web page. The Log Profiles Management web page opens displaying the available log profiles each with a radio button. You can perform different operations on the listed log profiles, which are explained in detail in the following sub-sections.

---

**Note**

Log Profiles Management does not support Socket.IO service.

Log profiles in Unified CCX can be one of the following two types:

1. System Log Profiles: These log profiles are pre-installed with Unified CCX and you cannot modify these profiles.

The following table provides information on the log profiles that are factory shipped with Unified CCX:

**Table 20: System Log Profiles**

<table>
<thead>
<tr>
<th>Name</th>
<th>Scenario in which this profile must be activated</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default</td>
<td>Activate this profile once an issue is resolved.</td>
</tr>
<tr>
<td>Outbound</td>
<td>For issues with Unified CCX Outbound Dialer AppAdmin.</td>
</tr>
<tr>
<td>AppAdmin</td>
<td>For issues with web administration through AppAdmin, Unified CCX Serviceability, and other web pages.</td>
</tr>
<tr>
<td>Media</td>
<td>For issues with media setup or media transmission.</td>
</tr>
<tr>
<td>HRDM (Historical Reporting Data Manager)</td>
<td>For issues with historical data that is written to the database.</td>
</tr>
<tr>
<td>Name</td>
<td>Scenario in which this profile must be activated</td>
</tr>
<tr>
<td>---------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>StuckSession</td>
<td>For issues with application sessions, sessions that are not being deleted when appropriate and appearing stuck in AppAdmin Real Time Reports.</td>
</tr>
<tr>
<td>Database</td>
<td>For issues with Unified CCX Informix database.</td>
</tr>
<tr>
<td>EDBS (Enterprise Database Subsystem)</td>
<td>For issues with external database connectivity and integration.</td>
</tr>
<tr>
<td>CallsStuckInQueue</td>
<td>For issues with calls in queue that are not being allocated to available agents or appearing stuck in queue in reports.</td>
</tr>
<tr>
<td>Serviceability</td>
<td>For issues with the functionality in Unified CCX Serviceability Administration Interface.</td>
</tr>
<tr>
<td>RealTimeDataProblems</td>
<td>For issues with Real Time Reports in AppAdmin.</td>
</tr>
</tbody>
</table>

2. Custom Log Profiles: If the trace settings generated by system profiles are not sufficient in a particular scenario, you can create custom log profiles for better troubleshooting. You can upload and activate these custom log profiles, on a need basis.

- In a HA deployment of Unified CCX, all the log profile operations will be reflected on both the nodes in the cluster.
- You cannot delete the profile if the selected log profile is the last-enabled profile in the system.

Related Topics
- Create Profile, on page 482
- Save as Another Profile, on page 483
- Enable Profile, on page 483
- Save Current Trace Settings, on page 484
- Upload Profile, on page 485
- Update Profile, on page 485

Create Profile

To create a log profile for a specific trace, perform the following steps:

Procedure

**Step 1**  
From the Unified CCX Serviceability menu bar, choose **Trace > Profile**. The Log Profiles Management web page displays.

**Step 2**  
Click **Add New** icon that displays in the tool bar in the upper, left corner of the window or the **Add New** button that displays at the bottom of the window.
The Log Profile Configuration web page displays. You can view lists of subfacilities such as libraries, managers, steps, subsystems, and so on with check boxes for the various Debugging and XDebugging levels for each subfacility for the MIVR tab by default.

Step 3
Select desired trace setting for different subfacilities in a service by clicking the corresponding check box.

Step 4
Click MCVD and MADM tabs to navigate to view and enable trace setting for these profiles.

Step 5
On successful configuration of these log profiles, click Save to save the profile or Save and Enable to save and enable the profile. The new profile will be displayed in the main profile page.

Related Topics
- Update Profile, on page 485
- Enable Profile, on page 483
- Save Current Trace Settings, on page 484

Save as Another Profile
To save an existing profile as another profile, perform the following steps:

Procedure

Step 1
From the Unified CCX Serviceability menu bar, choose Trace > Profile. The Log Profiles Management web page displays.

Step 2
Click the radio button to select a log profile.

Step 3
Click Save As.

Step 4
The Log Profile Configuration web page for the selected profile is displayed where you can view and update the existing profile settings. Click MIVR, MCVD, and MADM tabs to view and modify the trace settings.

You can save these updated trace settings with a new name. You will see a message confirming successful saving of the new profile.

Related Topics
- Update Profile, on page 485
- Enable Profile, on page 483
- Save Current Trace Settings, on page 484

Enable Profile
To enable or activate a log profile, perform the following steps:

Procedure

Step 1
From the Unified CCX Serviceability menu bar, choose Trace > Profile. The Log Profiles Management web page displays.

You can enable a log profile using any one of the following methods from the Log Profiles Management web page:
a) Select the radio button for the profile and click **Enable** icon or button
b) Click the hyperlink for the desired profile. Log Profile Configuration web page for the selected profile is displayed. Click **Enable** icon or button in the Profile Configuration web page
c) Click **Add New**. Enter the desired trace settings in the Profile Configuration web page and click **Save and Enable** icon or button in the Profile Configuration web page.

**Step 2**
The trace setting for the selected profile is transferred to system's trace settings and on successful activation, a message will be displayed in the status bar.

**Related Topics**
- [Create Profile](#), on page 482
- [Update Profile](#), on page 485

### Delete Profile

To delete an existing log profile, perform the following steps:

**Procedure**

**Step 1**
From the Unified CCX Serviceability menu bar, choose **Trace > Profile**. The Log Profiles Management web page displays.

**Step 2**
Select the radio button for an existing profile and click **Delete** icon or button to delete a log profile. Alternatively, you can click the hyperlink of the profile that you want to delete from the Log Profiles Management web page. Log Profile Configuration web page for the selected profile is displayed where you can view the existing profile settings. Click **Delete** to delete the selected log profile.

**Step 3**
The selected log profile is deleted and you will see a confirmation message in the status bar.

**Note**
You cannot delete the default and system log profiles. If the selected log profile happens to be the last-enabled profile in the system, then you cannot delete the profile. If you try to delete the last-enabled profile, the following alert message—“This is the last enabled profile in system and hence not allowed to be deleted.” will be displayed.

**Related Topics**
- [Update Profile](#), on page 485
- [Enable Profile](#), on page 483

### Save Current Trace Settings

The trace settings that are currently enabled in Unified CCX can be saved by clicking **Save Current Trace Settings** so that it can be enabled at a later date. For example, you might be asked to enable certain trace levels or a log profile during troubleshooting. In such a scenario, before doing the troubleshooting, you can save the current trace settings of your system as a profile so that you can enable the same trace settings after resolving the issue.

Use the procedure mentioned below to save the current trace settings in the system as a profile:
Procedure

Step 1  From the Unified CCX Serviceability menu bar, choose Trace > Profile. The Log Profiles Management web page displays.

Step 2  Click Save Current Trace Settings icon in the tool bar or the Save Current Trace Settings button at the bottom of the window.

Step 3  The Explorer User Prompt dialog box opens. Enter a name for your log profile.

Step 4  Click OK to save this profile. All the existing trace settings in your system is saved as a profile. Click Cancel to cancel this operation.

You should be able to view this new log profile along with the existing profiles in the Log Profiles Management web page. You can select and click Enable to enable the same profile at a later date.

Related Topics
  Update Profile, on page 485
  Enable Profile, on page 483
  Save as Another Profile, on page 483

Upload Profile

To upload a log profile, perform the following steps:

Procedure

Step 1  From the Unified CCX Serviceability menu bar, choose Trace > Profile. The Log Profiles Management web page displays.

Step 2  To locate the log profile, click the Browse button next to Enter a Profile File to Upload field, navigate to the directory in which the profile (.xml file) is located, and click Open. The path for the profile appears in this field.

Step 3  Click Upload to upload the profile.

Step 4  You should be able to view the uploaded profile along with the existing profiles in the Log Profiles Management web page.

Related Topics
  Update Profile, on page 485
  Enable Profile, on page 483
  Save Current Trace Settings, on page 484

Update Profile

You can update only custom log profiles. To view and update an existing log profile, perform the following steps:
Procedure

Step 1  From the Unified CCX Serviceability menu bar, choose Trace > Profile. The Log Profiles Management web page displays.
Step 2  Click the hyperlink of the profile you wish to view or update.
        The Log Profile Configuration web page for the selected profile is displayed where you can view the existing profile settings.
Step 3  Click MIVR, MCVD, and MADM tabs to view and modify the trace settings.
Step 4  Click Save to save the updated profile settings or Save and Enable to enable the updated profile. You will see a message confirming successful saving or enabling of the updated profile. Click Cancel to go back to Log Profiles Management web page.

Related Topics
- Create Profile, on page 482
- Upload Profile, on page 485
- Enable Profile, on page 483
- Save Current Trace Settings, on page 484

Serviceability Tools

Access Control Center — Network Services Menu

Control Center in Cisco Unified CCX Serviceability lets you do the following tasks:

- Start, stop, and restart Unified CCX services
- View the status the status of Unified CCX services
- Refresh the status of Unified CCX services

Unified CCX Serviceability provides Control Center - Network Services menu option, which is essential for your system to function.

Procedure

Choose Tools > Control Center - Network Services from the Unified CCX Serviceability menu bar to perform the above-mentioned actions.

**Network Services**

Installed automatically, network services include services that the system requires to function; for example, database and system services. Because these services are required for basic functionality, you cannot activate them in the Service Activation window.

After the installation of your application, network services start automatically. The list of services displayed in the Control Center—Network Services web page depends on the license package of your Unified CCX. If you have a Unified CCX Premium license, Unified CCX Serviceability categorizes the network services into the following categories, which are explained in the subsequent sections:

- **System Services**, on page 487
- **Admin Services**, on page 488
- **DB Services**, on page 488

The Control Center—Network Services web page displays the following information for the network services:

- Name of the network services, their dependant subsystems, managers, or components
- Status of the service (IN SERVICE, PARTIAL SERVICE, or SHUTDOWN; for individual subsystems, the status could be OUT OF SERVICE or NOT CONFIGURED).
- Start Time of the service
- Up Time of the service

---

**Note**

- Unified CCX Engine Services information will be removed from UCCX Serviceability page, when an invalid license is uploaded.
- Only System and Admin Services Information will be visible in Unified CCX Node Services Information.

---

**System Services**

The Unified CCX Serviceability service supports starting and stopping of the following System Services:

- Cisco Unified CCX Perfmon Counter Service
- Cisco Unified CCX Cluster View Daemon—List of Managers
- Cisco Unified CCX Engine—List of Subsystems and Managers
- Cisco Unified CCX Voice Subagent
- Cisco Unified CCX Notification Service
- Cisco Unified CCX SNMP Java Adapter
- Cisco Unified Intelligence Center Reporting Service
- Cisco Unified Intelligence Center Serviceability Service
- Cisco Unified CCX DB Perfmon Counter Service
- Cisco Unified CCX Socket IO Service
Admin Services

The Unified CCX Serviceability service supports starting and stopping of the following Admin Services:

- Cisco Unified CCX Administration
- Cisco Unified CCX Serviceability - List of Managers

Note: You cannot start or stop this service from the Unified CCX Serviceability web interface and you need to use CLI.

- Cisco Unified CCX WebServices

DB Services

You can start and stop Cisco Unified CCX Database service.

Finesse Services

The Unified CCX Serviceability service supports starting and stopping of the following Cisco Finesse Services:

- Cisco Finesse Tomcat

Manage Network Services

Control Center in Cisco Unified CCX Serviceability allows you to view status, refresh the status, and to start, stop, and restart network services.

Perform the following procedure to start, stop, restart, or view the status of services for a server (or for a server in a cluster in a Unified CCX Cisco VVB cluster configuration). You can start, stop, or refresh only one service at a time. Be aware that when a service is stopping, you cannot start it until the service is stopped. Likewise, when a service is starting, you cannot stop it until the service starts.

Procedure

Step 1 Choose Tools > Control Center—Network Services from the Unified CCX Serviceability menu bar.

Step 2 From the Server drop-down list box, choose the server and then click Go.

The window displays the following items:

a) The service names for the server that you chose.

b) The service status; for example, In Service, Shutdown, Partial Service and so on. (Status column)

c) The exact time that the service started running. (Start Time column)

d) The amount of time that the service has been running. (Up Time column)

Step 3 Perform one of the following tasks:
a) Click the radio button before the service that you want to start and click the **Start** button. The Status changes to reflect the updated status.

b) Click the radio button before the service that you want to stop and click the **Stop** button. The Status changes to reflect the updated status.

c) Click the radio button before the service that you want to restart and click the **Restart** button. A message indicates that restarting may take a while. Click **OK**.

d) To get the latest status of the services, click the **Refresh** button. The status information is updated to reflect the current status.

### Command Line Interface

You can start and stop some services through the Command Line Interface (CLI). For a list of services that you can start and stop through the CLI and for information on how to perform these tasks, refer to the *Cisco Unified Contact Center Express Command Line Interface Reference Guide*.

### Unified CCX Datastore

Datastores are components that allow you to manage and monitor historical, repository, and configuration data across all servers in the Unified CCX cluster.

*Note* Support for High Availability and remote servers is available only in multiple-server deployments.

The Unified CCX Cluster uses the publisher/subscriber database model for data replication across the system. Under normal circumstances, the database master acts as the source of data and the other node acts as the target for the data. In other words, the database master is the *publisher* and the other node is the *subscriber*.

*Note* In the **Tools > Datastore Control Center > Datastores** web page, the first node installed in the cluster is marked as publisher (with an icon marked P). This should not be confused with the publisher/subscriber model being discussed here. The term publisher is used to denote only the first node in the cluster and does not indicate that node to be the source of the data. The publisher/subscriber mentioned in these pages refer to the source and destination of the data respectively. Typically, the database master node acts as the source and the other node acts as the destination.

The publisher/subscriber database model enables Unified CCX to provide high-availability and failover support. To support this on the database level, the data must be available on multiple nodes of the cluster. To have such data availability, replication is used for the Historical, and Repository datastore. The Configuration datastore does not use replication; instead, it uses atomic transactions to commit data changes to all active Configuration datastores in the cluster.

The database master is the main database. All data is written to this database, with the other database synchronizing with it. If the database master fails, then data can be written to the database on the second node.
When the database master is back online, it returns to accepting writes. It also synchronizes with the other database to ensure data consistency is maintained in the cluster.

**Network Outage**

By default, replication between two nodes is removed if they are not able to synchronize with each other due to network outage for a substantial period of time. If the replication is dropped due to network outage, an alert is sent to the administrator so that the administrator can take corrective action.

**Note**

Even though the replication between the nodes is removed, data could still be written to the database, which is accessible to the Unified CCX engine.

If the replication is removed, the administrator can go to Tools > Datastore Control Center > Replication Servers submenu from the Cisco Unified CCX Serviceability menu bar and click Reset Replication. This ensures that the replication is established between the nodes and the data synchronization (repair) process is initiated. Click Check Details icon in this web page to monitor the status of the repair.

If the network outage did not result in the replication setup being removed, once the network is up, the synchronization of data between the databases will happen automatically. For outages that last a few seconds, typically the administrator need not take any action and the system will be able to synchronize automatically.

**Datastore Replication Status**

Unified CCX Cluster configuration is not complete until Historical, and Repository publishers are configured. The Datastore Control Center in Unified CCX displays the status of datastore replication, allows you to synchronize data, and reset replication functions.

**Note**

Support for High Availability is available only in multiple-server deployments.

Use the Datastore Control Center to perform the following functions:

- Obtain an overview of the datastores in the cluster and their relationships.
- Manage the datastore read/write access.
- Monitor and control the replication state (available only for Historical, and Repository datastores.)

**Tip**

The Datastore Control Center page is available even in single-node deployments but you can only monitor the read and write access. You cannot synchronize data, reset replication, or control the replication state.

The Datastore Control Center will have the following two submenus:

- Reset Replication Between Nodes, on page 491
- Datastores, on page 492

The following table describes the datastores available and what they contain.
Reset Replication Between Nodes

The Replication Servers menu option in Datastore Control Center allows you to view replication status and reset the replication between two nodes for the above-mentioned three datastores across all servers in the cluster. This menu will be available only in a High Availability deployment.

Follow the procedure below to access the Replication Servers web page:

**Procedure**

**Step 1**
Choose **Tools > Datastore Control Center > Replication Servers** from the Unified CCX Serviceability menu bar.

The Replication Servers web page opens displaying the list of servers and the following fields in a High Availability deployment.

<table>
<thead>
<tr>
<th>Datastore Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Historical</td>
<td>This datastore contains Historical Report data.</td>
</tr>
<tr>
<td>Repository</td>
<td>This datastore contains user prompts tables, grammar tables, and document tables.</td>
</tr>
<tr>
<td>Configuration</td>
<td>This datastore contains Unified CCX system configuration information.</td>
</tr>
</tbody>
</table>

**Step 2**
Click **Reset Replication** to reset the replication if the replication is not functional between the two nodes.

The **Reset Replication** button will be enabled only when the database on both the nodes are enabled.

When the subscriber goes down and it is required to make configuration updates from the publisher, you can disable Config Datastore (CDS) and Historical Datastore (HDS) on the subscriber using **Disable CDS and HDS** icon or button. The database information for the cluster is displayed at the bottom of the window. Once the subscriber is up, you can enable CDS and HDS on the subscriber using the same toggle button.
**Caution** Any configuration in Application Administration and Historical data on the Subscriber node would get over written, when CDS is enabled again.

**Related Topics**
- Datastores, on page 492
- Datastore Replication Status, on page 490

## Datastores

**Procedure**

**Step 1** Choose **Tools > Datastore Control Center**.

**Step 2** Click **Datastores** from the Unified CCX Serviceability menu bar to view replication status of all the Unified CCX datastores and to synchronize data.

**Step 3** Click **Synchronize Data** to synchronize data for each datastore except for the Configuration datastore between the two nodes in case of mismatch.

**Related Topics**
- Reset Replication Between Nodes, on page 491
- Datastore Replication Status, on page 490
- Datastore Control Center contents, on page 492

### Datastore Control Center contents

The following table describes the Datastore Control Center contents common to all the Unified CCX datastores.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Server</td>
<td>Server machine name.</td>
</tr>
</tbody>
</table>
| Replication Type | One of the following Enterprise Replication (ER) values in a High Availability deployment:  
  • ER—Publication  
  • ER—Subscription |
| Node ID        | Node ID of server/node in Unified CCX cluster.                                                                                               |
| Read Access    | Indicates whether data can be read from the datastore. Options: Yes, No.                                                                     |
| Write Access   | Indicates whether data can be written to the datastore. Options: Yes, No.                                                                    |
Replicate Status | Can be one of the following values:
--- | ---
RUNNING | All the necessary database services are up and the datastore is functioning as expected.
RETRYING | The datastore is in partial service and might be in the state of restart.
SHUTDOWN | The datastore is shutdown.
UNKNOWN | Unable to determine the current status of the datastore. This value is shown in a single-node deployment only.

Last Update Time | Indicates the last action the replication agent was performing.

Info | Use these icons to view further information in a new window:
Check Details | Click this icon to view information about data synchronization or repair jobs that might have been initiated.
History | Click this icon to view information about the replication latency (the time it takes to replicate transactions).

Related Topics
- Reset Replication Between Nodes, on page 491
- Datastore Replication Status, on page 490

Update Parameters

Use the Service Parameters page to view and update different services in Unified CCX servers. Ensure the following prerequisites are met before configuring the parameters:

- The servers are configured.
- The service is available on the servers.

⚠️ Caution

Some changes to service parameters may cause system failure, thus do not make any changes to service parameters unless you fully understand the feature that you are changing or unless the Cisco Technical Assistance Center (TAC) specifies the changes.

Use the following procedure to configure the service parameters for a particular service on a particular Unified CCX server.

Procedure

| Step 1 | From the Unified CCX Serviceability menu bar, choose Tools and click Service Parameters. |
| Step 2 | Choose a server from the Server drop-down list box. If parameters are available for that server, the service drop down list box appears displaying the following services: |
• Cisco AMC Service.
• Cisco Log Partition Monitoring Tool.
• Cisco Trace Collection Service.
• Cisco RIS Data Collector.
• Cisco Serviceability Reporter.
• Cisco DRF local.
• Cisco DRF Master.

Note: Only the common platform services mentioned above are supported currently for Unified CCX.

Step 3
Choose the service that contains the parameter that you want to update from the Service drop-down list box.

Note: The Service Parameter Configuration window displays all services (active or not active).

Step 4
The parameters for the selected service are displayed and the suggested values (if available) are listed against each one of them. Update the appropriate parameter value.

Step 5
Click Save.

The modified values are saved and the new values are reflected on subsequent access to the service's parameters.

Click Set to Default to set all service parameters for this instance of the service to the default value. A warning is displayed that this action cannot be undone and only on confirmation, the parameter values for the selected service is set to the default values.

Note: Currently, you cannot configure any parameters for the following platform services: Cisco Trace Collection Service and Cisco Log Partition Monitoring Tool.

---

Configure Performance Monitoring of Unified CCX Servers

Use the Performance Configuration and Logging page to configure JVM parameters and dump Thread and Memory traces for performance monitoring of Unified CCX servers. You can configure settings only for the following services of Unified CCX:

• Cisco Unified CCX Cluster View Daemon
• Cisco Unified CCX Engine
• Cisco Unified CCX Serviceability

Use the following procedure to configure JVM parameters for a particular service on a particular server.

Procedure

Step 1
From the Cisco Unified CCX Serviceability menu bar, choose Tools > Performance Configuration and Logging.

Step 2
Choose a server from the Server drop-down list box and click Go.

The first node is selected by default and JVM options for the Unified CCX Engine service in the first node is displayed.
Step 3  Choose a service for which you want to see the JVM options from the Service drop-down list box. You should be able to select any one of the following services from this list box:

- Cisco Unified CCX Cluster View Daemon
- Cisco Unified CCX Engine
- Cisco Unified CCX Serviceability

The following JVM options are displayed for each service:

- PrintClassHistogram
- PrintGCDetails
- PrintGC
- PrintGCTimeStamps

Step 4  Click the Dump Thread Trace icon or button to dump the thread traces for the selected service in the selected server. You can collect the corresponding jvm.log from the log folder for that facility using Real-Time Monitoring Tool (RTMT).

Step 5  Click the Dump Memory Trace icon or button to dump the memory traces. This creates the following two logs in the log folder for that facility.

a) Memory-<facility name>-<time stamp>.hprof (for heap dump)
b) histo-<facility name> <time stamp>.log (for histogram)

Step 6  You can change the JVM options by clicking Enable or Disable radio buttons in this page.

Click the Update JVM Options icon or button to update the new settings for selected service on selected node.
CHAPTER 25

Real-Time Monitoring

The Cisco Unified Real-Time Monitoring Tool (RTMT), which runs as a client-side application, uses HTTPS and TCP to monitor system performance. Unified RTMT can connect directly to devices through HTTPS to troubleshoot system problems.

Unified RTMT allows you to perform the following tasks:

- Monitor a set of predefined management objects that monitor the health of the system.
- Generate alerts in the form of email messages, for objects when values go above or below user-configured thresholds.
- Collect and view traces in default viewers that exist in RTMT.
- View syslog messages in SysLog Viewer.
- Work with performance-monitoring counters.

Even when Unified RTMT is not running as an application on your desktop, tasks such as alarm and performance monitoring updates continue to take place on the server in the background.

Installation and Configuration

The Unified RTMT installer can be downloaded using Tools > Plug-ins menu on the Cisco Unified Contact Center Express Administration web interface. See “Cisco Unified Real-Time Monitoring Tool” section in Cisco Unified Real-Time Monitoring Tool Administration Guide for Cisco Unified Contact Center Express and Cisco Unified IP IVR for installation and configuration procedures, available here:

Performance Monitoring

Unified CCX provides performance counters (called perfmon counters) for application performance monitoring. The perfmon counters help expose various performance values and enable to track application performance in real time.

The perfmon counters contain counter-based information, such as the name and index of the counter, the scale, the type, subcounters to set when setting a counter, the current values, and a map containing counter instance data. Each performance counter instance object contains instance-based data, like the instance ID and current values.

You can log perfmon counters locally on the computer and use the performance log viewer in Unified RTMT to display the perfmon CSV log files that you collected or the Real-time Information Server Data Collection (RISDC) perfmon logs. Choose System > Performance on the Unified RTMT tool to view perfmon counters.

Performance Objects

Unified RTMT provides a set of default monitoring objects that assist you in monitoring the health of the system. Default objects include performance counters or critical event status for the system and other supported services.

The system logs information every 10 seconds for predefined system counters.

Performance Counters

To troubleshoot system performance problems, you add a counter (query) that is associated with the perfmon object to the performance monitor, which displays a chart for the counter. Choose System > Performance > Open Performance Monitoring to add a new counter.

For more information about monitoring objects and counters, see “Performance Monitoring” section in the Cisco Unified Real-Time Monitoring Tool Administration Guide for Cisco Unified Contact Center Express and Cisco Unified IP IVR, available here:


Performance Objects and Counters for Unified CCX

Following are the Unified CCX application specific objects:

- Unified CCX database monitors
- Unified CCX engine JVM heap
- Intelligence center database performance Info
- Intelligence center JVM statistics
- Intelligence center system condition table
- Intelligence center thread pool section
- Intelligence center tomcat connector
• Reporting engine info
• Ramfs
• SchedulerInfo

Note Expand the objects in RTMT to display the counters. Right click on each counter and select Counter Description for the description.

Critical Services

The Critical Services monitoring function provides the name of the critical service, the status (whether the service is up, down, activated, stopped by the administrator, starting, stopping, or in an unknown state), and the elapsed time during which the services are functional on the system.

Note Unified RTMT does not display a partial running status of a service in Unified CCX. For example, it does not display a service as “running” under "Critical Services" if some of its subsystems are down. The partial status of the Unified CCX services will only be viewable from the Unified CCX Serviceability Administration web interface.

Note You can view and manage Cloud Connect services using Cloud Connect CLIs. For more information, see Cloud Connect section in the Command Line Interface chapter.

Tools

Unified RTMT provides various tools to monitor and troubleshoot system issues. The following section briefly describes these tools.

Alerts

Unified CCX generates alert messages to notify the administrator when a predefined condition is met, such as when an activated service fails to start. The system sends alerts as email or displays alerts as a popup message on RTMT.

RTMT contains preconfigured and user-defined alerts that support alert modifications. Although you can perform configuration tasks for both types, you cannot delete preconfigured alerts (whereas you can add and delete user-defined alerts). Predefined alerts are configured for perfmon counter value thresholds as well as event (alarms) notifications.

Unified CCX Alerts

The following list contains preconfigured Unified CCX alerts:
<table>
<thead>
<tr>
<th>Alert Name</th>
<th>Syslog Alarm Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DB CRA % Space Used</td>
<td>DB CRA % Space Used</td>
<td>The percentage of used space in the Unified CCX database, db_cra. The database, db_cra, contains the Unified CCX historical and configuration data.</td>
</tr>
<tr>
<td>DBReplicationStopped</td>
<td>DB_REPLICATION_STOPPED</td>
<td>Unified CCX Database Replication has been removed. This typically happens when the replication queues become full due to the inability to contact the other node.</td>
</tr>
<tr>
<td>HistoricalDataWrittenToFile</td>
<td>UCCX_HISTORICAL_DATA_WRITTEN_TO_FILE</td>
<td>Historical data is not written to the Unified CCX database and has been written to the file system. Please verify the state of the Unified CCX database.</td>
</tr>
<tr>
<td>Intelligence Center</td>
<td>CUIC_DATABASE_UNAVAILABLE</td>
<td>This alert occurs when the Intelligence Center CUIC_DATABASE_UNAVAILABLE event gets generated. This indicates the system detected critical error with database.</td>
</tr>
<tr>
<td>Event Type</td>
<td>Error Code</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------------------------</td>
<td>-------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Intelligence Center</td>
<td>CUIC_DB_REPLICATION_FAILED</td>
<td>This alert occurs when the Intelligence Center CUIC_DB_REPLICATION_FAILED event gets generated. This indicates the Database replication failed.</td>
</tr>
<tr>
<td>Intelligence Center</td>
<td>CUIC_REPORT_EXECUTION_FAILED</td>
<td>This alert occurs when the Intelligence Center CUIC_REPORT_EXECUTION_FAILED event gets generated. This indicates that the reporting server could not run a report. This could be because the associated datasource is offline.</td>
</tr>
<tr>
<td>Intelligence Center</td>
<td>CUIC_UNRECOVERABLE_ERROR</td>
<td>This alert occurs when the Intelligence Center CUIC_UNRECOVERABLE_ERROR event gets generated. This indicates that the system has detected an internal error within Reporting Server which may prevent it from functioning correctly. Restart may be required.</td>
</tr>
<tr>
<td>CCXToCUICAdminSyncFailed</td>
<td>UCCX_TO_CUIC_SYNC_FAILED</td>
<td>This alert occurs when the Unified CCX has failed to notify CUIC on any resource change.</td>
</tr>
<tr>
<td>CCXToCUICCCVDSyncFailed</td>
<td>UCCX_TO_CUIC_SYNC_FAILED</td>
<td>This alert occurs when the Unified CCX has failed to notify CUIC on any resource change.</td>
</tr>
<tr>
<td>Alert Description</td>
<td>Alert Code</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>------------</td>
<td>-------------</td>
</tr>
<tr>
<td>CCXToCUICEngineSyncFailed</td>
<td>UCCX_TO_CUIC_SYNC_FAILED</td>
<td>This alert occurs when the Unified CCX has failed to notify CUIC on any resource change.</td>
</tr>
<tr>
<td>PurgeInvoked</td>
<td>AUTO_PURGE_COMPLETE</td>
<td>This alert occurs when the Unified CCX Auto Purging has completed.</td>
</tr>
<tr>
<td>UnifiedCCXEngineMemoryUsageHigh</td>
<td>UnifiedCCXEngineMemoryUsageHigh</td>
<td>This alert occurs when the percentage of JVM heap memory used by Cisco Unified CCX Engine process is greater than the configured threshold value.</td>
</tr>
<tr>
<td>EMAIL_SERVER_DOWN</td>
<td>EMAIL_SERVER_DOWN</td>
<td>This alert occurs when the email server is not reachable.</td>
</tr>
<tr>
<td>CCPTomcatServiceDown</td>
<td>SS_PARTIAL_SERVICE_CCP_TOMCAT_DOWN</td>
<td>This alert occurs when CCP Tomcat is not reachable.</td>
</tr>
<tr>
<td>CCPXMPPServiceDown</td>
<td>CCP_XMPP_SERVICE_DOWN</td>
<td>This alert occurs when the Unified CCX has failed to contact CCP runtime server (XMPP).</td>
</tr>
<tr>
<td>OutboundScheduledContactImportFailed</td>
<td>OB_SCHEDULED_CONTACT_IMPORT_FAILED</td>
<td>Scheduled import of outbound contacts failed.</td>
</tr>
<tr>
<td>OutboundContactImportSchedulingFailed</td>
<td>OB_CONTACT_IMPORT_SCHEDULING_FAILED</td>
<td>Scheduling of outbound import contact failed.</td>
</tr>
<tr>
<td>UserPasswordMismatchAcrossNodes</td>
<td>UserPasswordMismatchAcrossNodes</td>
<td>One or more user passwords are not same across both the nodes.</td>
</tr>
</tbody>
</table>
Reason Codes Sync from Finesse failed and reached to Maximum number of retries. Ensure that Finesse service and Unified CCX database are active.

Unable to cache emails as disk space is low. No new emails will be fetched.

Existing emails have consumed a considerable amount of disk space.

Considerable amount of disk space is now available. New emails would now be fetched.

This alert occurs when SSL Connectivity with Customer Collaboration Platform fails.

---

To view or edit values for any alert, right click on the alert and select Set Alert/Properties.

---

Cisco Identity Service Alerts

You can view the Cisco Identity Service alerts from the Unified CCX pane.

The following list contains preconfigured Cisco Identity Service alerts:

**Table 22:**

<table>
<thead>
<tr>
<th>Alert Name</th>
<th>Syslog Alarm Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>IdSInitializationFailure</td>
<td>IDS_INIT_ERROR</td>
<td>This alert occurs when an error is encountered during IdS initialization.</td>
</tr>
</tbody>
</table>

---

Note: Cisco Identity Service Alerts

You can view the Cisco Identity Service alerts from the Unified CCX pane.

The following list contains preconfigured Cisco Identity Service alerts:

**Table 22:**

<table>
<thead>
<tr>
<th>Alert Name</th>
<th>Syslog Alarm Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>IdSInitializationFailure</td>
<td>IDS_INIT_ERROR</td>
<td>This alert occurs when an error is encountered during IdS initialization.</td>
</tr>
</tbody>
</table>
Syslog and Alert

Below are the set of syslog messages and alert which can be viewed from RTMT.

<table>
<thead>
<tr>
<th>Syslog Alarm Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CONTM_INIT_FAILURE</td>
<td>Container Manager initialisation failed</td>
</tr>
<tr>
<td>CONTM_INIT_HTTP_FAILURE</td>
<td>Container Manager HTTP Server initialisation failed</td>
</tr>
<tr>
<td>CONTM_INIT_PROVISIONING_FAILURE</td>
<td>Container Manager fails to initialise the provisioning</td>
</tr>
</tbody>
</table>
### Traces and Logs

The trace and log central feature in RTMT allows you to configure on-demand trace collection for a specific date range or an absolute time. You can collect trace files that contain search criteria that you specify and save the trace collection criteria for later use, schedule one recurring trace collection and download the trace files to a SFTP or FTP server on your network, or collect a crash dump file.

After you collect the files, you can view them in the appropriate viewer within the RTMT. You can also view traces on the server without downloading the trace files by using the remote browse feature. You can open the trace files by either selecting the internal viewer that is provided with RTMT or choosing an appropriate program as an external viewer.

For more information about traces and logs, see “Tools for traces, logs, and plug-ins” in Cisco Unified Real-Time Monitoring Tool Administration Guide for Cisco Unified Contact Center Express and Cisco Unified IP IVR, available here:


### Cloud Connect Serviceability

Use the Cisco Unified Real-Time Monitoring Tool (RTMT) to collect Cloud Connect logs.

You can use the Cloud Connect CLIs to:

- List all the containers in your deployment.
- View details of the specified container in JSON format.
- Start the specified container.
- Stop the specified container.
- Generate the heap dump for the specified container that is running JVM.
- Generate the thread dump for the specified container that is running JVM.
- Set log level for the specified service.
- Update the Cloud Connect Cherry point connector configuration details.
- Download and install RTMT on a client computer.

For more information on Cloud Connect CLIs, see Cloud Connect.


CUCM Telephony Data Monitoring

Following entities can be monitored using CUCM Telephony Data RTMT:

- Triggers
- Call Control Groups
- CTI ports

To access CUCM Telephony Data, click Cisco Unified CCX tab in RTMT.

**Triggers Page**

The Triggers page displays the following information for the triggers that are configured for Unified CCX:

*Table 23: Triggers Page Options*

<table>
<thead>
<tr>
<th>Counters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>TriggerDN</td>
<td>This field displays the directory number that is associated with the trigger.</td>
</tr>
<tr>
<td>Trigger State</td>
<td>This field displays the state of the trigger, which can be In Service, Out of Service, or Unknown.</td>
</tr>
<tr>
<td>Application Name</td>
<td>This field displays the name of Unified CCX application that is associated with the trigger.</td>
</tr>
<tr>
<td>Ready for Call</td>
<td>This field indicates whether the trigger is ready to accept the call.</td>
</tr>
<tr>
<td>CallControlGroup ID</td>
<td>This field displays the ID of the call control group that is associated with the trigger.</td>
</tr>
<tr>
<td>Media Group ID</td>
<td>This field displays the ID of the media group that is associated with the trigger.</td>
</tr>
<tr>
<td>Last State Change Time</td>
<td>This field displays the time of last state change for the trigger.</td>
</tr>
<tr>
<td>Recommended Action</td>
<td>This field provides the reason the trigger state is Out of Service or Unknown and provides the recommended action to return the trigger state to In Service.</td>
</tr>
</tbody>
</table>

**Note**

This field is populated only if the trigger is in Out of Service state or Unknown state.

**Call Control Groups page**

The Call Control Groups page provides the following information about the current Call Control Group that is configured for Unified CCX:
Table 24: Call Control Groups Page Options

<table>
<thead>
<tr>
<th>Counters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CallControlGroup ID</td>
<td>This field displays the ID that is associated with the call control group.</td>
</tr>
<tr>
<td>Group State</td>
<td>This field displays the state of the call control group, which can be In Service, Partial Service, or Out of Service.</td>
</tr>
<tr>
<td>Total Ports</td>
<td>This field displays the total number of CTI ports that are configured for the call control group.</td>
</tr>
<tr>
<td>InService Ports</td>
<td>This field displays the number of in-service CTI ports.</td>
</tr>
<tr>
<td>OOS Ports</td>
<td>This field displays the number of out-of-service CTI ports.</td>
</tr>
</tbody>
</table>

CTI Ports Page

The CTI Ports page provides the following information about the current CTI ports that are configured for Unified CCX:

Table 25: CTI Ports Page Options

<table>
<thead>
<tr>
<th>Counters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CTI Port DN</td>
<td>This field displays the directory number of the CTI port.</td>
</tr>
<tr>
<td>CallControlGroup ID</td>
<td>This field displays the ID of call control group to which the CTI port belongs.</td>
</tr>
<tr>
<td>Port State</td>
<td>This field displays the state of CTI port, which can be In Service or Out of Service.</td>
</tr>
<tr>
<td>CallID</td>
<td>This field displays the call ID of the last call that is available on the CTI port before the port state changed to Out of Service.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong> This field is populated only if the port state is Out of Service.</td>
</tr>
<tr>
<td>Last State Change Time</td>
<td>This field displays the last time when the CTI port state changed.</td>
</tr>
</tbody>
</table>

Summary Page

The Summary page provides the following information:
Table 26: Summary Page Options

<table>
<thead>
<tr>
<th>Counters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overall Telephony Subsystem State</td>
<td>This field displays the state of the Unified CCX telephony subsystem, which can be In Service, Partial Service, or Out of Service.</td>
</tr>
<tr>
<td>Call Control Groups In Service</td>
<td>This field displays the number of call control groups that are in service.</td>
</tr>
<tr>
<td>Call Control Groups Out Of Service</td>
<td>This field displays the number of call control groups that are out of service.</td>
</tr>
<tr>
<td>Call Control Groups In Partial Service</td>
<td>This field displays the number of call control groups that are in partial service.</td>
</tr>
<tr>
<td>Enabled Triggers</td>
<td>This field displays the number of triggers that are associated with valid call control group IDs.</td>
</tr>
<tr>
<td>Disabled Triggers</td>
<td>This field displays the number of triggers that are associated with invalid call control group IDs.</td>
</tr>
<tr>
<td>Triggers With Config Errors</td>
<td>This field displays the number of triggers with configuration errors.</td>
</tr>
</tbody>
</table>

Note
In UCCX system, if we do not configure any Trigger and CTI Ports then CM Telephony displays Out of Service status. Similarly in IPIVR, if we do not configure ICM Subsystem then ICM Subsystem displays Out of Service status.

Cisco Unified Analysis Manager

Use Cisco Unified Analysis Manager, a tool included with the Unified RTMT to perform troubleshooting operations. Unified Analysis Manager also allows you to monitor various aspects of the devices added to the tool. Unified Analysis Manager is used to collect troubleshooting information from your system and analyze the information. It can identify the supported Unified Communications (UC) products and applications that you have in your system and troubleshoot call failures across these UC applications, collecting trace and log files and other platform and configuration information. You can use this information to troubleshoot on your own or send the information to Cisco Technical Assistance for analysis.

Unified Analysis Manager for Unified CCX

To monitor and troubleshoot a Unified CCX-based solution with the help of Unified Analysis Manager, you must connect to a Unified Communications Manager server and then add the Unified CCX nodes accordingly. You can add following nodes/servers for monitoring:

- Unified CCX node
- Call record server

Consider the following points while adding nodes/servers for monitoring:
• To add nodes/servers, ensure that you select Node Type as Unified CCX.

• To add a call record server, enter uccxsct in the JDBC User Name field.

For detailed procedures to perform these actions, see “Cisco Unified Analysis Manager preferences” section in the Cisco Unified Real-Time Monitoring Tool Administration Guide for Cisco Unified Contact Center Express and Cisco Unified IP IVR, available here:

Unified Analysis Manager for Unified CCX

Real-Time Monitoring
Backup and Restore

Cisco Disaster Recovery System (Cisco DRS), which you can access from Cisco Unified Contact Center Express Administration, provides complete data backup-and-restore capabilities for all servers in a Cisco Unified Contact Center Express (Unified CCX) cluster. Cisco DRS allows you to perform regularly scheduled automatic or user-invoked data backups and to restore data in the case of a system failure.

To access Cisco DRS, choose **Disaster Recovery System** from the navigation drop-down list box in the upper-right corner of the **Cisco Unified CCX Administration** window. Log in to the Disaster Recovery System using platform administrator credentials.

Cisco DRS will back up and restore the following components:

- Cluster configurations and applications profile in the data repository
- Workflow scripts that are already uploaded in the data repository
- Platform
- Databases (such as db_cra, db_cra_repository, and FCRasSvr database)
- Configuration data (such as open LDAP and flat files)
- Recording files
- JTAPI configuration (jtapi.ini)
- Trace Collection Tool (TCT)
- User prompts, grammars, and documents
- CUIC_CONFIG configuration (such as configuration property files, security configuration, and Unified Intelligence Center Tomcat server.xml)
- Finesse components
- Socket.IO Server Configuration Files
- Cloud Connect Configuration

In the case of high availability (HA), Cisco DRS performs a cluster-level backup, which means that it collects backups for all servers in a Unified CCX cluster to a central location and archives the backup data to a remote SFTP server.
DRS will back up and restore its own settings, that is, backup device settings (saved in file `drfDevice.xml`) and schedule settings (saved in file `drfSchedule.xml`) as part of the platform component. Once a server is restored with these files, you do not need to reconfigure DRS backup device and schedule settings.

**Note**
Cisco DRS uses SSL-based communication between the Master Agent and the Local Agent for authentication and encryption of data between the Unified CCX publisher and subscriber nodes. Cisco DRS makes use of the IPSec certificates for its Public/Private Key encryption. Be aware that if you delete the IPSec truststore (hostname.pem) file from the Certificate Management pages, then Cisco DRS will not work as expected. If you delete the IPSec-trust file manually, then you must ensure that you upload the IPSec certificate to the IPSec-trust. For more details, see the certificate management help pages in the *Cisco Unified Communications Manager Security Guide* available here:


---

**Important Considerations**

Following are the important considerations when you perform backup and restore procedures:

- Before you run a backup or a restore, make sure that both nodes in a cluster are running the same version of Unified CCX. If different nodes are running different versions of Unified CCX, you will have a certificate mismatch and your backup or restore will fail.

- Before you restore Unified CCX, make sure that the hostname, IP address, DNS configuration, version, and deployment type matches the hostname, IP address, DNS configuration, version, and deployment type of the backup file that you want to restore.

- Before you restore Unified CCX, ensure that the Unified CCX version that is installed on the server matches the version of the backup file that you want to restore. Cisco DRS supports restore only for matching versions of Unified CCX. For example, Cisco DRS does not allow you to restore from Version 12.0(1) to Version 12.5(1).

- Schedule backups during off-peak hours to avoid call-processing interruptions and impact to service.

- After you use the recovery disk to bring a server with a corrupted file system into a bootable and semi-functional state, rebuild the server.

**Note**
If you do not rebuild the server, you may notice missing directories, lost permissions, or corrupted soft links.
SFTP Requirements

To back up data to a remote device on the network, you must have an SFTP server that is configured and accessible from the Unified CCX node to run the backup. Cisco allows you to use any SFTP server products that have been certified with Cisco through the Interoperability Verification Testing (IVT) process. Cisco Developer Network (CDN) partners, such as GlobalSCAPE, certify their products with a specified version of Unified CCX. For information about which vendors have certified their products with your version of Unified CCX, see the following URL:


For information on using GlobalSCAPE with supported Cisco Unified Communications versions, refer to the following URL:

https://www.globalscape.com/managed-file-transfer/cisco

Cisco uses the following servers for internal testing. You may use one of the servers, but you must contact the vendor for support:

- Open SSH (see http://sshwindows.sourceforge.net/)
- Cygwin (see http://www.cygwin.com/)
- Titan (see http://www.titanftp.com/)

Cisco does not support use of the SFTP product freeFTPD, because it has a 1-GB file-size limit.

Note

- For issues with third-party products that have not been certified through the IVT process, contact the third-party vendor for support.

- While a backup or restore is running, you cannot perform any Operating System (OS) Administration tasks because Cisco DRS blocks all OS Administration requests. However, you can use CLI commands to back up or restore the system.

Cipher Support

From Unified CCX release 12.5 onward, CBC ciphers are not supported. Unified CCX supports the following CTR ciphers for SFTP connections:

- aes128-ctr
- aes192-ctr
- aes256-ctr

Note

To configure an SFTP server as a backup device, it has to support one of these ciphers.
Master and Local Agents

The system automatically starts the Master Agent service on each node of the cluster, but it is functional only on the first node. Both servers in a Unified CCX cluster must have Local Agent running to perform the backup and restore functions.

Note

By default, a Local Agent automatically gets activated on each node of the cluster.

Master Agent Duties

The Master Agent (MA) performs the following duties:

• Stores system-wide component registration information.
• Maintains a complete set of scheduled tasks in an XML file. The MA updates this file when it receives updates of schedules from the user interface. The MA sends executable tasks to the applicable Local Agents, as scheduled. Local Agents execute immediate-backup tasks without delay.
• Lets you perform activities such as configuring backup devices, scheduling backups by adding new backup schedules, viewing or updating an existing schedule, displaying status of executed schedules, and performing system restoration.
• Stores backup data on a remote network location.

Local Agent Duties

In a Unified CCX cluster, the Local Agent runs backup and restore scripts on each node in the cluster.

Note

Cisco DRS uses an SSL-based communication between the Master Agent and the Local Agent for authentication and encryption of data between the Unified CCX publisher and subscriber nodes. Cisco DRS uses IPSec certificates for its Public/Private Key encryption. This certificate exchange is handled internally; you do not need to make any configuration changes to accommodate this exchange.

Backup Tasks

You can perform the following backup tasks using Cisco DRS:

• Manage backup devices
• Create backup schedules
• Manage backup schedules
• Estimate size of backup tar file
• Perform manual backup
• Check backup status
• View history of last 20 backups

Manage Backup Devices

Before using Cisco DRS, you must configure the locations where the backup files will be stored. You can configure up to ten backup devices. Perform the following steps to configure backup devices.

Procedure

<table>
<thead>
<tr>
<th>Step 1</th>
<th>On Disaster Recovery System page, choose Backup &gt; Backup Device.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 2</td>
<td>Click appropriate button to add a new device or to edit settings of an existing backup device.</td>
</tr>
<tr>
<td>Step 3</td>
<td>Enter the backup device name and choose the backup device type.</td>
</tr>
</tbody>
</table>

Note: You cannot delete a backup device that is configured as the backup device in a backup schedule.

Manage Backup Schedules

You can create up to ten backup schedules. Each backup schedule has its own set of properties, including a schedule for automatic backups, and a storage location.

Caution: Schedule backups during off-peak hours to avoid call-processing interruptions and impact to service.

Procedure

<table>
<thead>
<tr>
<th>Step 1</th>
<th>On the Disaster Recovery System page, choose Backup &gt; Scheduler.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 2</td>
<td>Click the appropriate button to add a new schedule or to edit settings of an existing backup schedule.</td>
</tr>
<tr>
<td>Step 3</td>
<td>Fill out the form and enable the backup schedule.</td>
</tr>
</tbody>
</table>

Note:
- If you plan to schedule a backup on a two-node deployment, ensure that both the servers in the cluster are running the same version of Unified CCX and are communicating in the network. Servers that are not communicating at the time of the scheduled backup will not be backed up.
- Do not schedule a backup to run while the Update Database Statistics task is running. By default, this task is set to run every Saturday at 3:00 am and Shrink-repack on Sunday at 3:00 am.
Perform Manual Backup

Procedure

<table>
<thead>
<tr>
<th>Step 1</th>
<th>On the Disaster Recovery System page, choose Backup &gt; Manual Backup.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 2</td>
<td>Select a backup device and start the backup.</td>
</tr>
<tr>
<td>Step 3</td>
<td>Click Estimate Size to get the approximate size of the disk space that the backup file will consume on the SFTP server.</td>
</tr>
</tbody>
</table>

To perform backup tasks on virtual machines, see Unified Communications VMware Requirements, available here:


Check Backup Status

On the Disaster Recovery System page, choose Backup > Current Status to check the backup status.

⚠️ Caution

Be aware that if the backup to the remote server is not completed within 20 hours, the backup session will time out. You will then need to begin a fresh backup.

Restore Scenarios

You can choose to restore any node in the cluster.

📝 Note

- Do not attempt a restore when there is a version mismatch between the Unified CCX nodes.
- If no backup is available, you may not be able to run the restore activity on any of the nodes through Cisco DRS.
- If restore is performed without rebuild, both the nodes have to be restored.
- **One-Step Restore** option is not supported in Unified CCX.
- When SRTP is disabled on your system and you are restoring from an SRTP-enabled backup, you must disable SRTP in the System Parameters page after the restore.
Backup and Restore

Caution

• Be aware that your backup .tar files are encrypted by a randomly generated password. Unified CCX uses the cluster security password to encrypt this password and save it along with the backup .tar files. If you change this security password between the backup and restore, Cisco DRS prompts you for the old security password. Therefore, to use old backups, remember the old security password or perform a fresh backup immediately after you reset or change the password.

• Cisco DRS supports only matching versions of Unified CCX for restore. For example, Cisco DRS does not allow a restore from version 8.5(1).1000-1 to Version 9.0(1).1000-1, or from Version 8.5(1).1000-2 to Version 9.0(1).1000-1. (The last parts of the version number change when you install a service release or an engineering special.) The product versions must match, end-to-end, for Cisco DRS to run a successful Unified CCX database restore.

• After you restore a node, reboot the node, and then perform the Data Resync manually by logging in to the web interface of Cisco Unified CCX Administration.

• The backup process does not back up the passwords that you set for Wallboard and Recording SFTP external database users. After data is restored, passwords revert to the original default value. If you set passwords for external database users, you must manually reset them from the Password Management window.

Restorable SA or HA Setup (Without Rebuild)

Perform this procedure if you are restoring an SA or HA setup of Unified CCX to the last known good configuration, without reinstalling Unified CCX on any of the nodes. Do not perform this procedure after a hard drive failure or other hardware failure.

Note

Before you restore a cluster, make sure that the second node in the cluster is functional and is communicating with the first node. Run the CLI command utils network connectivity to know if second node is communicating with the first node.

You must carry out a fresh installation for the second node if it is not functional or if it is not communicating with the first node at the time of the restore.

Caution

You should not perform the restore activity of a SA backup in a HA setup; otherwise the cluster will break and the second node will be an orphan.

Procedure

Step 1

In the Disaster Recovery System page, choose Restore > Restore Wizard.

Follow the on-screen instructions in the wizard to complete the restore process. You can select a single node or both nodes while performing restore.

Note Restoring the node restores the entire Unified CCX database. This may take up to several hours based on the size of database that is being restored.
Step 2  Restart the SA server or the HA cluster when the restore is successful and the status shows 100 per cent. For more information on restarting, see Cisco Unified Operating System Administration Guide available here: https://www.cisco.com/en/US/products/sw/custcosw/ps1846/prod_maintenance_guides_list.html.

Step 3  After you restart the SA server or HA cluster, perform the data resync by choosing Subsystems > Cisco Unified CM Telephony > Data Resync from Cisco Unified CCX Administration web interface.

Restore SA Setup (with Rebuild)

You can restore a SA setup (with rebuild) in the following cases:

- The hard drive fails, and you have a valid backup that was taken before the hard drive failure.
- The server hardware is to be replaced. Take a backup of Unified CCX when it is running in the old server hardware that is to be replaced. Note the backup device details before you shut down the Unified CCX setup.
- To correct a virtual machine with unaligned partitions, you will need to perform a manual backup first and follow the procedure by performing a fresh installation using the latest OVF Template from Unified Contact Center Express Virtual Machine Templates.

Tip  If you are performing any other type of hardware upgrades, such as replacing a network card or adding memory, you do not need to perform the following procedure.

Procedure

Step 1  Perform a fresh installation of the same version of Unified CCX (using the same administrator credentials, network configuration, and security password that you used earlier) on the node before you restore it.

Step 2  In the Disaster Recovery System page, choose Restore > Restore Wizard. Follow the on-screen instructions in the wizard to complete the restore process.

Note  • There is no need to perform initial configuration in the Unified CCX Administration page for any restore with rebuild scenarios.

• To view the current license package, go to System > Licensing > Display License.

Step 3  Restart the server when the restore is successful and perform data resync manually using Unified CCX Administration page.
Apply the same license type on node the backup was taken to restore.

- If the License MAC has changed during the rebuild, the UCCX license will need to be rehosted. When applying the new license after the restore process has completed, apply a rehosted license with the same package (Enhanced, Premium, IP IVR) as the license contained within the backup that was restored.

For more information on the license rehosting mechanism, see the *Cisco Unified Contact Center Express Install and Upgrade Guide*, available here:

---

**Restore Only First Node in HA Setup (with Rebuild)**

In a High Availability (HA) setup, if there is a hard-drive failure or any other critical hardware or software failure which needs rebuild of the first node, then perform the following procedure to recover the publisher node to the last backed up state of the publisher.

**Procedure**

**Step 1**
Perform a fresh installation of the same version of Unified CCX (using the same administrator credentials, network configuration, and security password that you used earlier) on the node before you restore it.

**Step 2**
Navigate to Cisco Unified Contact Center Express Administration, select **Disaster Recovery System** from the Navigation drop-down list box in the upper-right corner of the Cisco Unified CCX Administration window, and click **Go**.

The Disaster Recovery System Logon window displays.

**Note**
To view the current license package, go to **System > License Management**.

**Step 3**
After the restore process is successful, run the following CLI command from the second node.

```bash
utils uccx setuppubrestore
```

**Step 4**
Run the following CLI command on the target node; that is, if you want to retrieve the publisher node’s data, then run this command on the subscriber node, but if you want to retrieve the subscriber node’s data (which is more up-to-date), then run this command on the publisher node.

```bash
utils uccx database forcedatasync
```

**Step 5**
Restart both the nodes and run the following CLI command on the Publisher node to set up replication:

```bash
utils uccx dbreplication reset
```

**Step 6**
To set up replication for the Cisco Finesse database:
- **a)** Run the following CLI command on the Subscriber node:

  ```bash
  utils dbreplication stop
  ```

- **b)** Run the following CLI command on the Publisher node:

  ```bash
  utils dbreplication reset all
  ```
Caution

- Apply the same license type on node the backup was taken to restore.
- If the License MAC has changed during the rebuild, the UCCX license will need to be rehosted. When applying the new license after the restore process has completed, apply a rehosted license with the same package (Enhanced, Premium, IP IVR) as the license contained within the backup that was restored.


---

## Restore Second Node in HA Setup (with Rebuild)

In a high availability (HA) setup, if there is a hard-drive failure or any other critical hardware or software failure which needs rebuild of the second node, then perform the following procedure to recover the second node to the last backed up state of the second node.

**Caution**

In case the second node crashes during upgrade and there is no backup available, you may not be able to restore anything. To restore the second node, enter `utils system enableAdministration` command in the first node, delete the second node from the first node, add the second node details again and then rebuild the second node.

The recording and monitoring data which was present in the server cannot be recovered since there is no backup.

**Procedure**

**Step 1**
Perform a fresh installation of the same version of Unified CCX (using the same administrator credentials, network configuration, and security password that you used earlier) on the node before you restore it.

**Step 2**
In the Disaster Recovery System web interface, choose Restore > Restore Wizard.
Follow the on-screen instructions in the wizard to complete the restore process.

**Note**
When you are prompted to choose the nodes to restore, choose only the second node.

**Step 3**
Restart the server when the restore status is 100 per cent.

Restore Both Nodes in HA Setup (with Rebuild)

In a High Availability (HA) setup, if a major hard drive failure occurs on both the nodes in the cluster, or in the event of a hard drive migration or replacement, you may need to rebuild both the nodes.

- In case of a hard drive failure if you have taken a valid backup before the failure, follow this procedure to restore both the nodes, starting with the first node.

- In case of server hardware replacement, take a backup of Unified CCX when running in the old server hardware that is to be replaced. Note the backup device details before you bring down the Unified CCX setup. Follow this procedure to bring up a new server.

- To correct a virtual machine with unaligned partitions, you need to perform a manual backup first and follow the procedure by performing a fresh installation using the latest OVF Template from Unified Contact Center Express Virtual Machine Templates to restore both the nodes, starting with the first node.

Caution

Set up a new cluster if you do not have a valid backup for the first node.

Procedure

Step 1
Rebuild the first node by performing a fresh installation of the same version of Cisco Unified Contact Center Express (using the same administrator credentials, network configuration and security password being used before the failure).

For more information on installing Cisco Unified Contact Center Express, see Cisco Unified Contact Center Express Install and Upgrade Guide available here: https://www.cisco.com/en/US/products/sw/custcosw/ps1846/prod_installation_guides_list.html.

Step 2
Restore only the first node by following the procedure in Restore Only First Node in HA Setup (with Rebuild), on page 519.

Note To view the current license package, go to System > Licensing > Display License.

Step 3
Restart the first node.


Caution

- Apply the same license type on node the backup was taken to restore and should be applied for first node only.

- If the License MAC has changed during the rebuild, the UCCX license will need to be rehosted. When applying the new license after the restore process has completed, apply a rehosted license with the same package (Enhanced, Premium, IP IVR) as the license contained within the backup that was restored. For more information on the licensing rehosting mechanism, see the Installing Cisco Unified Contact Center Express available here: https://www.cisco.com/c/en/us/support/customer-collaboration/unified-contact-center-express/products-installation-guides-list.html.
Step 4  Rebuild the second node by performing a fresh installation of the same version of Cisco Unified Contact Center Express (using the same administrator credentials, network configuration and security password being used before the failure).

Step 5  Restore only the second node by following the procedure in Restore Second Node in HA Setup (with Rebuild), on page 520.

Step 6  Restart the second node. Your data is restored on both the nodes of the cluster.

---

Trace Files

The trace files for the Master Agent, the user interface, each Local Agent, and the JSch (Java Secure Channel) library are found in the following locations:

- For the Master Agent, find the trace file at platform/drf/trace/drMA0*
- For each Local Agent, find the trace file at platform/drf/trace/drLA0*
- For the user interface, find the trace file at platform/drf/trace/drfConfLib0*
- For the JSch, find the trace file at platforms/drf/trace/drFSch*

You can view trace files by using the command line interface. For more information, see Command Line Interface, on page 522.

Command Line Interface

Cisco DRS also provides command-line access to few backup and restore tasks, as listed in the following table:

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>utils disaster_recovery backup</td>
<td>Starts a manual backup by using the feature that is configured in the Cisco DRS interface</td>
</tr>
<tr>
<td>utils disaster_recovery restore</td>
<td>Starts a restore and requires parameters for backup location, filename, feature, and nodes to restore</td>
</tr>
<tr>
<td>utils disaster_recovery status</td>
<td>Displays the status of ongoing backup or restore job</td>
</tr>
<tr>
<td>utils disaster_recovery history</td>
<td>Displays the history of previous backup and restore operations</td>
</tr>
<tr>
<td>utils disaster_recovery show_backupfiles</td>
<td>Displays existing backup files</td>
</tr>
<tr>
<td>utils disaster_recovery cancel_backup</td>
<td>Cancels an ongoing backup job</td>
</tr>
<tr>
<td>utils disaster_recovery show_registration</td>
<td>Displays the currently configured registration</td>
</tr>
<tr>
<td>utils disaster_recovery show_tapeid</td>
<td>Displays the tape identification information</td>
</tr>
<tr>
<td>Command</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------------------</td>
<td>---------------------------------</td>
</tr>
<tr>
<td>utils disaster_recovery device add</td>
<td>Adds the network or tape device</td>
</tr>
<tr>
<td>utils disaster_recovery device delete</td>
<td>Deletes the device</td>
</tr>
<tr>
<td>utils disaster_recovery device list</td>
<td>Lists all the devices</td>
</tr>
<tr>
<td>utils disaster_recovery schedule add</td>
<td>Adds a schedule</td>
</tr>
<tr>
<td>utils disaster_recovery schedule delete</td>
<td>Deletes a schedule</td>
</tr>
<tr>
<td>utils disaster_recovery schedule disable</td>
<td>Disables a schedule</td>
</tr>
<tr>
<td>utils disaster_recovery schedule enable</td>
<td>Enables a schedule</td>
</tr>
<tr>
<td>utils disaster_recovery schedule list</td>
<td>Lists all the schedules</td>
</tr>
</tbody>
</table>

Command Line Interface

Unified CCX provides a command line interface as an alternative to the web administration page to configure and troubleshoot the system.

- Command Line Interface Basics, on page 525
- Show commands, on page 528
- Set Commands, on page 548
- Run Commands, on page 557
- Util Commands, on page 560
- File Commands, on page 587
- High Availability Commands, on page 591
- Cisco Finesse Commands, on page 600
- Cisco Unified Intelligence Center Commands, on page 620
- Cloud Connect, on page 632
- Specific License Reservation Commands, on page 639

Command Line Interface Basics

Start CLI Session

Access the Cisco Unified Contact Center Express (Unified CCX) Command Line Interface (CLI) either remotely or locally using one of these two methods:

- From an SSH-enabled client workstation, use SSH to connect securely to the Unified CCX.
- Access the Unified CCX CLI directly or by using a terminal server that is connected to the serial port. Use this method if a problem exists with the IP address.

To start a CLI session:

**Procedure**

**Step 1**

Perform one of the following tasks:

- From a remote system, use SSH to connect securely to the Cisco CCX Platform. In your SSH client, enter
**Get Help with Commands**

You can get two kinds of help for any command:

- Detailed help that includes a definition of the command and an example of its use.
- Short query help that includes only command syntax.

To get detailed help, at the CLI prompt, enter:

```
help command
```

where `command` specifies the command name or the command and parameter.

### Detailed Help Example:

```
admin:help file list activelog help: This will list active logging files options are: page - pause output detail - show detailed listing reverse - reverse sort order date - sort by date size - sort by size file-spec can contain '*' as wildcards

```

---

**Note**

If you enter the `help command` without specifying the name of a particular command as the optional parameter, the system provides information about the CLI system.

To query only command syntax, at the CLI prompt, enter
command ?

where command represents the command name or the command and parameter.

Query Example

admin:file list activelog?Syntax: file list activelog file-spec [options] file-spec
   mandatory file to view options optional page|detail|reverse|[date|size]

Note
If you enter a ? after a menu command, such as set, it acts like the Tab key and lists the commands that are available.

Exit Command with Ctrl-C Key Sequence

You can stop most interactive commands by entering the Ctrl-C key sequence.

admin:utils system upgrade initiate Warning: Do not close this window without first exiting the upgrade command. Source: 1) Remote Filesystem 2) DVD/CD q) quit
   Please select an option (1 - 2 or "q"): Exiting upgrade command. Please wait...
   Control-C pressed admin:

Note
If you execute the command utils system switch-version and enter Yes to start the process, entering Ctrl-C exits the command but does not stop the switch-version process.

End CLI Session

To end the CLI session, enter quit at the CLI prompt.

If you are logged in remotely, you get logged off, and the SSH session is terminated. If you are logged in locally, you get logged off, and the login prompt appears.

Additional CLI Commands

Besides the commands available on Unified CCX, more commands are available that can be executed as a part of Unified Operating System. For detailed information about all the CLI commands available for the Cisco Unified Operating System, see the Command Line Interface Reference Guide for Cisco Unified Communications Solutions available here:


The following Unified Operating System commands are not applicable to Unified CCX:

- delete dscp
- file delete license
- file get license
• file list license
• file view license
• set cert bulk
• set dscp
• set network cluster publisher
• set network dhcp
• set network ipv6 dhcp
• set network ipv6 service
• set network ipv6 static_address
• show ctl
• show dscp
• show itl
• show network ipv6 settings
• show tech ccm_service
• run loadxml
• utils sso unavailable

**Important**

When `file get` CLI command is used with the `abstime` as an option to collect log files, this filters the files based on the last modified timestamp. If the last modified time is updated, this CLI may not give desired results. Use the log collection feature in RTMT instead to collect the log files.

---

**Show commands**

**show uccx version**

This command displays the Unified CCX versions on the active partition and the inactive partition. The inactive version is displayed only if the inactive partition is available.

**Command syntax**

```plaintext
show uccx version
```

**Requirements**

- Level privilege: 0
- Command privilege level: 0
- Allowed during upgrade: Yes
Example

```
admin:show uccx version
Active UCCX Version: 10.5.0.95000-152
Inactive UCCX Version: NA
Command successful.
```

**show uccx jtapi_client version**

This command displays the JTAPI client version that the Unified CCX is using on the active and the inactive partitions. The inactive version is displayed only if the inactive partition is available.

**Command syntax**

```
show uccx jtapi_client version
```

**Requirements**

- Level privilege: 0
- Command privilege level: 0
- Allowed during upgrade: Yes

**Example**

```
admin:show uccx jtapi_client version
Active:Cisco JTAPI version 9.0(0.96000)-4 Release
Inactive: NA
Command successful.
```

**show uccx components**

This command displays the various components in Unified CCX for which tracing can be turned on or off from CLI commands. This command is useful when you need the list of components to modify the trace settings of Unified CCX.

**Command syntax**

```
show uccx components
```

**Requirements**

- Level privilege: 0
- Command privilege level: 0
- Allowed during upgrade: Yes

**Example**

```
admin:show uccx components
Various UCCX components are as follows -
  UCCXEngine
  UCCXCVD
  UCCXEditor
```
show uccx subcomponents

This command displays the various subcomponents in specific Unified CCX component. This command is useful when you need the list of subcomponents to modify the trace settings of Unified CCX.

Command syntax

show uccx subcomponents component [options]

Options

• component—(Mandatory) Component such as UCCXEngine or UCCXEditor. For example, some of the UCCX subcomponents for 'UCCX_ENGINE' component are:
  • APP_MGR
  • ARCHIVE_MGR
  • BOOTSTRAP_MGR
  • CFG_MGR
  • CHANNEL_MGR and so on

• page—Displays the output one page at a time

Requirements

Level privilege: 0
Command privilege level: 0
Allowed during upgrade: Yes

Example

admin:show uccx subcomponents uccxengine

show uccx license

This command displays various licenses that are configured for Unified CCX and the features which have been activated. This command works only if the Unified CCX Cluster View Daemon (CVD) is running.

Note

This command does not display license-expiry information. For more information about viewing licenses, see the Cisco Unified Contact Center Express Administration and Operations Guide.

This command is not applicable when you are using Smart Licensing.

Command syntax

show uccx license
show uccx trace levels

This command displays the names and trace levels of the various Unified CCX components and subcomponents. If the optional component is specified, then the trace settings of all the subcomponents of the specified component are displayed. If both the optional component and subcomponent are specified, then the trace settings of the specified subcomponent of the specified component are displayed.

Command syntax

show uccx trace levels [options]

Options

• Component—Displays the trace levels of all the subcomponents of this component

• Sub-component—Displays the trace levels of this subcomponent for the specified component. The trace levels can be displayed only if the component was specified

• page—Displays the output one page at a time

• file—Stores the output to a file instead of showing it on the console. The name of the file is displayed after the completion of the command

Requirements

Level privilege: 0
Command privilege level: 0
Allowed during upgrade: Yes
Example

admin:show uccx trace levels UCCXEngine
Trace settings for component 'UCCX_ENGINE' and module are
ALARM = true
DEBUGGING = false
XDEBUGGING1 = false
XDEBUGGING2 = false
XDEBUGGING3 = false
XDEBUGGING4 = false
XDEBUGGING5 = false

Command successful.

admin:show uccx trace levels UCCXEngine
Trace settings for component 'UCCX_ENGINE' and module are
ALARM = true
DEBUGGING = false
XDEBUGGING1 = false
XDEBUGGING2 = false
XDEBUGGING3 = false
XDEBUGGING4 = false
XDEBUGGING5 = false

Command successful.

show uccx provider ip axl

This command shows the Unified CCX AXL provider IP address.

Command syntax
show uccx provider ip axl

Requirements
Level privilege: 0
Command privilege level: 0
Allowed during upgrade: Yes

Example

admin: show uccx provider ip axl
Cisco Unified Communications Manager IP is 10.78.14.140

Command Successful.

show uccx provider ip jtapi

This command shows the Unified CCX JTAPI provider IP address.

Command syntax
show uccx provider ip jtapi

Requirements
show uccx provider ip rmcm

This command shows the Unified CCX Resource Manager-Contact Manager provider IP address.

Command syntax
show uccx provider ip rmcm

Requirements
Level privilege: 0
Command privilege level: 0
Allowed during upgrade: Yes

Example

admin: show uccx provider ip rmcm
UCCX RMCM Provider is 10.78.14.140
Command Successful.

show uccx trace file size

This command shows the trace file size for the specified component.

Command syntax
show uccx trace file size [component]

Options
component—(Mandatory) Component such as UCCXEngine or UCCXEditor

Requirements
Level privilege: 1
Command privilege level: 1
Allowed during upgrade: Yes

Example
show uccx trace file count

This command shows the trace file count for the specified component, which is the maximum number of trace files. The new file overwrites the older files.

**Command syntax**

```
show uccx trace file count [component]
```

**Options**

- **component**—(Mandatory) Component such as UCCXEngine or UCCXEditor

**Requirements**

- Level privilege: 1
- Command privilege level: 1
- Allowed during upgrade: Yes

**Example**

```
admin: show uccx trace file count UCCXEngine
Trace file count for UCCXEngine is 300.
Command Successful.
```

show uccx livedata connections

This command displays the status of the Socket.IO service and the following details of the LiveData connection:

- Total Active Client Connections to Socket.IO server.
- Total Long Polling clients connected to Socket.IO server.

**Command syntax**

```
show uccx livedata connections
```

**Requirements**

- Level privilege: 0
- Command privilege level: 0
- Allowed during upgrade: Yes

**Example**

```
admin:show uccx socketio connection
Server Status: Active
Client Count: 2 (polling: 1)
```

---

Cisco Unified Contact Center Express Administration and Operations Guide, Release 12.5(1)
show tls server min-version

This command allows you to show the minimum TLS version in the server that is currently configured.

**Command syntax**
show tls server min-version [tls server minVersion]

**Options**

**tls server minVersion**—Refers to 1.2 (TLS Version 1.2)

**Requirements**
Level privilege: 1
Command privilege level: 1
Allowed during upgrade: No

**Example**

```
admin:show tls server min-version
The server tls min-version is set to 1.2
Command successful
```

show tls client min-version

This command allows you to show the minimum TLS version in the client that is currently configured.

**Command syntax**
show tls client min-version [tls client minVersion]

**Options**

**tls client minVersion**—Refers to 1.2 (TLS Version 1.2)

**Requirements**
Level privilege: 1
Command privilege level: 1
Allowed during upgrade: No

**Example**

```
admin:show tls client min-version
The client tls min-version is set to 1.2
Command successful
```
show uccx tech dbserver all

This command runs the commands show uccx tech dbserver log diagnostic and show uccx tech dbserver status in succession and stores the output of the commands in a file.

Command syntax

show uccx tech dbserver all

Note

The name of the file containing the output from each show uccx tech command run is automatically generated by the command script. The file path and filename are displayed after the completion of the operation.

Requirements

Level privilege: 0
Command privilege level: 0
Allowed during upgrade: Yes

Example

admin:show uccx tech dbserver all
This operation may take a few minutes to complete. Please wait...
Output is in file: uccx/cli/DbServerAll_1250664874580.txt
Command successful.

show uccx tech dbserver log diagnostic

This command checks for the existence of Informix assertion failure and shared memory dump logs. If logs exist, the name and path of the log files are displayed.

Command syntax

show uccx tech dbserver log diagnostic [options]

Options

page—Displays the output one page at a time

Requirements

Level privilege: 0
Command privilege level: 0
Allowed during upgrade: Yes

Example

admin:show uccx tech dbserver log diagnostic
This operation may take a few minutes to complete. Please wait...
The following diagnostic logs are available for the UC database server.
core/log.txt
show uccx tech dbserver status

This command outputs a detailed status report of the Unified CCX database server (IDS engine) instance, that is onstat -a to a txt file.

Command syntax
show uccx tech dbserver status

Note
The name of the file is automatically generated by the command script. The file path and filename are displayed after the completion of the operation.

Requirements
Level privilege—0
Command privilege level—0
Allowed during upgrade—Yes

Example

admin:show uccx tech dbserver status
This operation may take a few minutes to complete. Please wait...

Output is in file: uccx/cli/DbServerStatus_1250666138379.txt

Command successful.

show uccx dbcontents

This command dumps the contents of the specified database. This command can be used to recreate a customer database on a test system for troubleshooting. For each Unified CCX database table, a dump csv file is created. Because there are huge numbers of files, these files are created in a subdirectory which will have the name as DbContents_<TIMESTAMP>. After the completion of the command, the subdirectory name and subdirectory path are displayed.

Command syntax
show uccx dbcontents database_name

Arguments
database_name—(Mandatory) Database whose contents will be output to CSV file

Requirements
Level privilege: 1
Command privilege level: 1
show uccx dbtable schema

This command displays the column names of the specified table.

Command syntax

show uccx dbtable schema database_name table_name [options]

Arguments

database_name—(Mandatory) Name of the database (db_cra, db_cra_repository etc.,) in which the table resides

table_name—(Mandatory) Name of the table

Options

page—Displays the output one page at a time

Requirements

Level privilege: 0

Command privilege level: 0

Allowed during upgrade: Yes

Example

admin:show uccx dbcontents db_cra
This operation may take a few minutes to complete. Please wait...
Database contents dump is in directory: uccx/cli/DbContents_1250666234370
Command successful.

show uccx dbtable schema

admin:show uccx dbtable schema db_cra_repository documentsfiletbl
List of columns in table 'documentsfiletbl' in database 'db_cra_repository' is -
filename (nvarchar)
parentfolderid (nvarchar)
payload (blob)
lastmodifystamp (datetime year to fraction(3))
lastmodifyuser (nvarchar)
length (int)
checksum (int)
Command successful.

show uccx dbschema

This command outputs the schema for all the tables, views, and stored procedures in the specified database to a text file. The output consists of SQL statements that are necessary to replicate a specified database. The IDS “dbschema” utility is used to create the file. This command only displays the DB schema; it does not provide any data in the tables.

Command syntax
show uccx dbschema database_name

Arguments

database_name—(Mandatory) Name of the database whose schema will be output

Note

The name of the file containing the schema is automatically generated by the command script. The file path and filename are displayed after the completion of the operation.

Requirements

Level privilege: 0
Command privilege level: 0
Allowed during upgrade: Yes

Example

admin:show uccx dbschema db_cra
Output is in file: uccx/cli/schema_db_cra_080212-110543.txt

show uccx dbtable list

This command displays the names of all the tables contained in the specified Unified CCX IDS database. The database names can be db_cra, db_cra_repository, FCRasSvr, sysmaster.

Command syntax

show uccx dbtable list database_name [options]

Arguments

database_name—(Mandatory) Database name where tables reside

Options

page—Displays the output one page at a time

Requirements

Level privilege: 0
Command privilege level: 0
Allowed during upgrade: Yes

Example

admin:show uccx dbtable list
db_cralist of tables in database 'db_cra' is -
  agentconnectiondetail
  agentroutingsetting
  agentstatedetail
  application
  areacode
  campaign
  campaignsqmap
show uccx dbserver disk

This command displays information for each storage space (chunks and dbspaces).

Command syntax
show uccx dbserver disk [options]

Options
page—Displays the output one page at a time
file—Outputs the information to a .txt file. The filename is generated dynamically at runtime and the filename and path are displayed to user after the completion of the operation.

Requirements
Level privilege: 0
Command privilege level: 0
Allowed during upgrade: Yes

Example


<table>
<thead>
<tr>
<th>SNO</th>
<th>DATABASE NAME</th>
<th>TOTAL SIZE (MB)</th>
<th>USED SIZE (MB)</th>
<th>FREE SIZE (MB)</th>
<th>PERCENT FREE</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>rootdbs</td>
<td>358.4</td>
<td>66.3</td>
<td>292.1</td>
<td>81%</td>
</tr>
<tr>
<td>2</td>
<td>log_dbs</td>
<td>317.4</td>
<td>307.3</td>
<td>10.1</td>
<td>3%</td>
</tr>
<tr>
<td>3</td>
<td>db_cra</td>
<td>512.0</td>
<td>8.8</td>
<td>503.2</td>
<td>98%</td>
</tr>
<tr>
<td>4</td>
<td>db_hist</td>
<td>13000.0</td>
<td>3651.4</td>
<td>9348.6</td>
<td>71%</td>
</tr>
<tr>
<td>5</td>
<td>db_cra_repository</td>
<td>10.2</td>
<td>2.9</td>
<td>7.3</td>
<td>71%</td>
</tr>
<tr>
<td>6</td>
<td>db_frascal</td>
<td>512.0</td>
<td>2.8</td>
<td>509.2</td>
<td>99%</td>
</tr>
<tr>
<td>7</td>
<td>temp_uccx</td>
<td>1572.9</td>
<td>0.1</td>
<td>1572.7</td>
<td>99%</td>
</tr>
<tr>
<td>8</td>
<td>uccx_sbspace</td>
<td>3145.7</td>
<td>2988.1</td>
<td>157.6</td>
<td>5%</td>
</tr>
<tr>
<td>9</td>
<td>uccx_er</td>
<td>204.8</td>
<td>0.1</td>
<td>204.7</td>
<td>99%</td>
</tr>
<tr>
<td>10</td>
<td>uccx_ersb</td>
<td>1572.9</td>
<td>1494.1</td>
<td>78.8</td>
<td>5%</td>
</tr>
</tbody>
</table>
show uccx dbserver sessions all

This command displays detailed session and SQL-related information for each database user session. The content of the information displayed is equivalent to running the IDS command `onstat -g ses` for each active session.

Command syntax

show uccx dbserver sessions all [options]

Options

- `page`—Displays the output one page at a time
- `file`—Outputs the information to a txt file. The filename is generated dynamically at runtime and the filename and path are displayed to user after the completion of the operation.

Requirements

Level privilege: 0

Command privilege level: 0

Allowed during upgrade: Yes

Example

```
admin:show uccx dbserver sessions all
IBM Informix Dynamic Server Version 10.00.UC5XD -- On-Line -- Up 58 days 02:26:37
-- 444676 Kbytes

session id user   tty  pid  hostname   threads memory  memory  explain
 27  cudbeven -  6750  crslnx  1       151552  75400   off

  tid  name  rstcb  flags  curstk  status
 75   sqlexec 52477164 Y--P---  4208  cond wait(netnorm)
```
show uccx dbserver session

This command displays detailed session and SQL-related information for a specific session, which represents a user connected to the database server. The content of the information displayed is equivalent to running the IDS command `onstat -g ses` for an active session specified by the session-id.

**Command syntax**

`show uccx dbserver session session_id [options]`

**Arguments**

session_id—(Mandatory) The Informix session ID number

**Options**

page—Displays the output one page at a time

file—Outputs the information to a .txt file. The filename is generated dynamically at runtime and the filename and path are displayed to user after the completion of the operation.

**Requirements**

Level privilege: 0

Command privilege level: 0

Allowed during upgrade: Yes

**Example**

```
admin:show uccx dbserver session 58
IBM Informix Dynamic Server Version 11.50.UC4 -- On-Line -- Up 14 days 04:43:40 -- 254160 Kbytes
session  effective #RSAM total used
dynamic id user user tty pid hostname threads memory memory
```
show uccx dbserver sessions list

This command displays a one-line summary of each active Unified CCX database session. The summary includes the database name, username, session ID, and process ID. The session ID information can be used to display more detailed information about a specified session using the show uccx dbserver session command.

Command syntax

show uccx dbserver sessions list [options]

Options

page—Displays the output one page at a time

Requirements
show uccx dbserver user list

This command displays a one-line summary of each active uccx database user. The summary includes the database name, session ID and process ID. The session ID information can be used to display more detailed information about a specified user session using the show Unified CCX dbserver session command.

Command syntax

show uccx dbserver user list [option]

Option

page—Displays the output one page at a time

Requirements

Level privilege: 0

Command privilege level: 0

Allowed during upgrade: Yes

Example

```
admin:show uccx dbserver user list

+------------------+------------+-------+----------+
| DATABASE         | USERNAME   | SESSION| PROCESS ID|
|------------------+------------+-------+----------|
| db_cra           | uccxuser   | 49    | -1       |
| db_cra           | uccxuser   | 44    | -1       |
| db_cra           | uccxuser   | 46    | -1       |
| db_cra           | uccxuser   | 61    | -1       |
| db_cra           | uccxuser   | 24    | -1       |
| db_cra           | uccxuser   | 18    | -1       |
| db_cra           | uccxhruser | 31224 | -1       |
| db_cra           | uccxuser   | 62    | -1       |
| db_cra           | uccxuser   | 60    | -1       |
| db_cra           | uccxuser   | 47    | -1       |
| db_cra           | uccxuser   | 59    | -1       |
| db_cra           | uccxuser   | 58    | -1       |
| db_cra           | uccxuser   | 48    | -1       |
| db_cra           | uccxuser   | 50    | -1       |
| db_cra           | uccxcluser | 31616 | -1       |
```

Command successful.
show uccx dbserver user waiting

This command displays a one-line summary of each Unified CCX database user and also displays whether a user session is waiting for a resource.

Command syntax

show uccx dbserver user waiting [option]

Option

page—Displays the output one page at a time

Requirements

Level privilege: 0

Command privilege level: 0

Allowed during upgrade: Yes

Example

```
admin:show uccx dbserver user waiting
USERNAME SESSION ID LATCH LOCK BUFFER CHECKPOINT TRANSACTION INCRITICAL
------------ ---------- ----- ---- ------ ---------- ----------- ----------
informix 16 N N N N N N
informix 17 N N N N N N
informix 15 N N N N N N
uccxcliuser 33927 N N N N N N
uccxcliuser 32784 N N N N N N
uccxcliuser 32737 N N N N N N
uccxcliuser 32631 N N N N N N
uccxcliuser 34244 N N N N N N
uccxcliuser 32522 N N N N N N
uccxcliuser 34364 N N N N N N
uccxcliuser 32508 N N N N N N
uccxcliuser 32480 N N N N N N
uccxcliuser 31616 N N N N N N
uccxcliuser 31601 N N N N N N
uccxcliuser 34327 N N N N N N
uccxcliuser 34071 N N N N N N
```
show uccx tech dbserver log message

This command displays the most recent messages in the Informix message log. The number of messages displayed is determined by the lines parameter.

Command syntax

```
show uccx tech dbserver log message [lines] [option]
```

Arguments

- **lines**—(Optional) Number of lines from message log that will be displayed. Defaults to 20.

Option

- **page**—Displays the output one page at a time

Requirements

- Level privilege: 0
- Command privilege level: 0
- Allowed during upgrade: Yes

Example

```
admin:show uccx tech dbserver log message 10
Message Log File: online.uccx.log

The last 10 lines of the log file are -
16:05:19 Maximum server connections 33
16:05:19 Checkpoint Statistics - Avg. Txn Block Time 0.000, # Txns blocked 0,
Plog used 21, Llog used 12
16:10:19 Checkpoint Completed: duration was 0 seconds.
16:10:19 Wed Aug 19 - loguniq 8, logpos 0x93c018, timestamp: 0xb0244c Interval: 4106
16:10:19 Maximum server connections 33
16:10:19 Checkpoint Statistics - Avg. Txn Block Time 0.000, # Txns blocked 0,
Plog used 2, Llog used 2
```

Command successful.

---

show uccx dbtable contents

This command displays the contents of the specified table.

Command syntax
show uccx dbtable contents database_name table_name [option]

Arguments

database_name—(Mandatory) Name of the database for example, db_cra, db_cra_repository in which the table resides
table_name—(Mandatory) Name of the table

Option

page—Displays the output one page at a time

Requirements

Level privilege: 0
Command privilege level: 0
Allowed during upgrade: Yes

Example

```
admin:show uccx dbtable contents db_cra resource
Output is in file: uccx/cli/resource_Contents_1250666550481.csv
Command successful.
```

show vmtools version

This command displays the current version of the vmtools that are installed on the system.

Command syntax

```
show vmtools version
```

Requirements

Level privilege: 0
Command privilege level: 1
Allowed during upgrade: No

Example

```
admin:show vmtools version
Current VMware Tools running version: 10.0.9.55972 (build-3917699)
```

show uccx asr sessions

This command shows the number of concurrent active ASR sessions.

Command syntax

```
show uccx asr sessions
```

Requirements

Level privilege: 1
show uccx tts sessions

This command shows the number of concurrent active TTS sessions.

**Command syntax**

`show uccx tts sessions`

**Requirements**

- Level privilege: 1
- Command privilege level: 1
- Allowed during upgrade: No

**Example**

```
admin:show uccx tts sessions
10.11.12.13 : Concurrent = 0 , Aggregate [Success = 0 , Failure = 0 ]
11.12.13.14 : Concurrent = 0 , Aggregate [Success = 0 , Failure = 0 ]
Total : Concurrent = 0 , Aggregate [Success = 0 Failure = 0 ]

Command successful.
```

Set Commands

set uccx trace defaults

This command sets the default trace levels for all components and subcomponents in Unified CCX. If the optional component is specified, it sets the default trace levels only for all the subcomponents of the specified component. If both the optional component and subcomponent are specified, it sets the default trace levels only for the specified subcomponent under the component.

**Command syntax**

`set uccx trace defaults [component] [subcomponent]`

**Options**

- **Component**—(Mandatory) Sets the default trace levels for all the subcomponents of this component. The various components are UCCXEngine, UCCXCvd, UCCXAppAdmin and JTAPI_CLIENT.
• **Sub-component** — (Optional) Sets the default trace levels for this subcomponent for the specified component. This trace level can be specified only if the component was specified preceding it.

**Requirements**
Level privilege: 1
Command privilege level: 1
Allowed during upgrade: No

**Example**

```
admin:set uccx trace defaults uccxengine
SS_HTTP
Default traces restored successfully for the module.
```

### set uccx trace file size component size

This command sets the trace file size for the specified component.

**Command syntax**

```
set uccx trace file size [component] [size]
```

**Parameters**

- **component** — (Mandatory) The component such as UCCXEngine or UCCXEditor
- **size** — (Mandatory) Specifies the file size in bytes

**Requirements**

Level privilege: 1
Command privilege level: 1
Allowed during upgrade: No

**Example**

```
admin:set uccx trace file size uccxengine 3145728
Trace file size for uccxengine is set to 3145728 bytes.
```

### set uccx trace file count component no-of-files

This command sets the trace file count for the specified component, that is the maximum number of trace files after which older files will start getting overwritten.

**Command syntax**

```
set uccx trace file count [component] [no-of-files]
```

**Arguments**

- **component** — (Mandatory) The component such as UCCXEngine or UCCXEditor.
- **no-of-files** — (Mandatory) Specifies the number of files after which older files will get overwritten.
set uccx trace enable

Enables the specified logging level for the sub-component in the component mentioned in the command. The user can enter multiple levels of logging by separating them by commas.

After the completion of the command, a message is displayed showing the current log trace settings enabled. Restart the Unified CCX services for the trace changes to take effect.

Command syntax

set uccx trace enable [component] [sub-component] [level]

Options

**component**—(Mandatory) The component such as UCCXEngine or UCCXEditor or JTAPI_CLIENT

**sub-component**—(Mandatory) The subcomponent within the component such as JTAPI Subsystem within the UCCXEngine component. For the JTAPI_CLIENT component, there are no sub-components.

**sub-component**—(Mandatory) The subcomponent within the component such as SS_SIP within the UCCXEngine component. For the SS_SIP component, there are no sub-components.

**Level**—(Mandatory) The logging level which will be enabled. Tracing levels are Debugging, XDebugging1, XDebugging2, XDebugging3, XDebugging4 and XDebugging5. For the JTAPI_CLIENT, the tracing levels are Warning, Informational, Debug, Jtapi_Debug, JtapiImpl_Debug, Cti_Debug, CtiImpl_Debug, Protocol_Debug and Misc_Debug.

**Level**—(Mandatory) The logging level which will be enabled. Tracing levels are Debugging, XDebugging1, XDebugging2, XDebugging2, XDebugging3, XDebugging4 and XDebugging5.

Requirements

Level privilege: 1

Command privilege level: 1

Allowed during upgrade: No

Example 1

```
admin:set uccx trace enable uccxengine SS_VB debugging
Trace for uccxengine:SS_VB:debugging is enabled.
Command successful.
```

Example 2
set uccx trace disable

Disables the specified logging level for the subcomponent in the component mentioned in the command. The user can enter multiple levels of logging by separating them by commas. You cannot use this command to turn off Alarm tracing.

After the completion of the command, a message is displayed showing the current log trace settings enabled. Restart the Unified CCX services for the trace changes to take effect.

Command syntax

```
set uccx trace disable [component] [sub-component] [level]
```

Options

- **Component** — The component such as UCCXEngine or UCCXEditor or JTAPI_CLIENT.
- **Sub-component** — The subcomponent within the component such as JTAPI Subsystem within the UCCXEngine component. For the JTAPI_CLIENT component, there are no subcomponents.
- **Sub-component** — The subcomponent within the component such as SS_SIP within the UCCXEngine component.
- **Level** — (Mandatory) The logging level which will be disabled. Tracing levels are Debugging, XDebugging1, XDebugging2, XDebugging2, XDebugging3, XDebugging4 and XDebugging5. The tracing levels will also be available as part of the help of the command.

Requirements

- Level privilege: 1
- Command privilege level: 1
- Allowed during upgrade: No

**Example 1**

```
admin:set uccx trace disable uccxengine SS_VB debugging
Trace for uccxengine:SS_VB:debugging is disabled.
Command successful.
```

**Example 2**

```
set uccx trace disable UCCXEngine SS_SIP XDEBUGGING1,XDEBUGGING2
Trace for uccxengine:SS_SIP:XDEBUGGING1 is disabled
Trace for uccxengine:SS_SIP:XDEBUGGING2 is disabled
Command successful.
```
set password user security

This command changes the security/SFTP password on Unified CCX. In addition to changing the security password, it also changes the passwords of the internal Unified CCX users.

Command syntax

set password user security

Requirements

Level privilege: 1
Command privilege level: 1
Allowed during upgrade: No

Example

admin:set password user security
Please enter the old password: ******
Please enter the new password: ******
Reenter new password to confirm: ******
WARNING:
Please make sure that the security password on the publisher is changed first. The security password needs to be the same on all cluster nodes, including the application server, therefore the security password on all nodes need to be changed.
After changing the security password on a cluster node, please restart that node.

Continue (y/n)? y
Please wait...

Command successful.

set tls server min-version

This command allows you to configure the minimum TLS version in the server that can be used for inbound SSL connections. You must restart the system for the changes to take effect.

Note

In a high availability (HA) deployment, run this CLI command on both the nodes of the cluster. Restart both the nodes after executing the CLI command.

Command syntax

set tls server min-version [tls server minVersion]

Options

tls server minVersion—Refers to 1.2 (TLS Version 1.2)

Requirements

Level privilege: 1
Command privilege level: 1
**COMMANDS**

**set tls client min-version**

This command allows you to configure the minimum TLS version in the client that can be used for outbound SSL connections. You must restart the system for the changes to take effect.

---

**Note**

In a high availability (HA) deployment, run this CLI command on both the nodes of the cluster. Restart both the nodes after executing the CLI command.

**Command syntax**

```
set tls client min-version [tls client minVersion]
```

**Options**

- **tls client minVersion**—Refers to 1.2 (TLS Version 1.2)

**Requirements**

- Level privilege: 1
- Command privilege level: 1
- Allowed during upgrade: No

**Example**

```
admin:set tls client min-version 1.2
**WARNING** If you are lowering the TLS version it can lead to security issues
**WARNING**
Do you really want to continue (yes/no) ? yes
Execute this command in the other nodes of the cluster.
Restart the system using the command 'utils system restart' for the changes to take effect
Command successful
```

**set uccx provider ip axl**

This command sets the Unified CCX AXL provider IP address. Use this command only when the IP address of Unified Communications Manager has been changed and Unified CCX is being pointed to the new IP address.
After you run this command, restart the Unified CCX Engine service. After Unified CCX Engine service starts successfully, restart Cisco Tomcat using the CLI command `utils service restart Cisco Tomcat`.

**Note**

Command syntax

```
set uccx provider ip axl [ip-address]
```

**Arguments**

[ip-address]—The IP address of the AXL provider.

**Requirements**

Level privilege: 0
Command privilege level: 0
Allowed during upgrade: No

**Example**

```
admin: set uccx provider ip axl 10.78.14.140
Cisco Unified Communications Manager IP is set to 10.78.14.140
Command Successful.
```

---

**set uccx provider ip jtapi**

This command sets the Unified CCX JTAPI provider IP address. Use this command only when the IP address of Unified Communication Manager has been changed and Unified CCX is being pointed to the new IP address.

After you run this command, restart the Unified CCX Engine service. After Unified CCX Engine service starts successfully, restart Cisco Tomcat using the CLI command `utils service restart Cisco Tomcat`.

**Note**

Command syntax

```
set uccx provider ip jtapi [ip-address]
```

**Arguments**

[ip-address]—The IP address of the JTAPI provider.

**Requirements**

Level privilege: 0
Command privilege level: 0
Allowed during upgrade: No

**Example**

```
admin: set uccx provider ip jtapi [ip-address]
```

set uccx provider ip rmcm

This command sets the Unified CCX Resource Manager-Contact Manager provider IP address. Use this command only when the IP address of Unified Communications Manager has been changed and Unified CCX is being pointed to the new IP address.

**Note**

After you run this command, restart the Unified CCX Engine service. After Unified CCX Engine service starts successfully, restart Cisco Tomcat using the CLI command `utils service restart Cisco Tomcat`.

**Command syntax**

`set uccx provider ip rmcm [ip-address]`

**Arguments**

[ip-address]—The IP address of the RMCM provider.

**Requirements**

Level privilege: 0  
Command privilege level: 0  
Allowed during upgrade: No

**Example**

```
admin: set uccx provider ip rmcm 10.78.14.140  
UCCX RMCM Provider is set to 10.78.14.140  
Command Successful.
```

set uccx appadmin administrator

Administrator capability can be added to a user in Unified Communications Manager using this command.

**Note**

Run this command to set the administrator for a configured Unified CCX system only. For a newly installed system, you must login with the platform login password that you specified during installation.

**Command syntax**

`set uccx appadmin administrator [username]`

**Options**

[username]—Username is set as the Cisco Unified CCX application administration.
**set authmode**

This command is used to set the authentication mode.

**Command syntax**

```plaintext
set authmode <non_sso>
```

**Options**

- `non_sso` - to set authentication to Non-SSO mode.

**Requirements**

- Level privilege: 4
- Command privilege level: 4
- Allowed during upgrade: No

**Example**

```plaintext
admin:set authmode non_sso
```

**set uccx asr count clear**

This command clears all the counts that were recorded from the ASR hosts.

**Command syntax**

```plaintext
set uccx asr count clear
```

**Requirements**

- Level privilege: 1
- Command privilege level: 1
- Allowed during upgrade: No

---

_You cannot assign Administrator capability to a user ID that is the same as the application administrator user ID that you created during the Unified CCX installation. If you assign Administrator capability to such a user ID, a “Command failed” error message is displayed on the console._
set uccx tts count clear

This command clears all the counts that were recorded from the TTS hosts.

Command syntax
set uccx tts count clear

Requirements
Level privilege: 1
Command privilege level: 1
Allowed during upgrade: No

Example
admin: set uccx asr count clear
ASR reset successfully
Command successful.

run Commands

run uccx hrdataexport

This command dumps the historical reporting data and related configuration information to csv files, and a tar file is created that contains all the exported csv files. The tar file is saved in the local file system, under <activelog>/uccx/log/db/hrdataexport.

The command output indicates the filename and specific commands that you must run to transfer the generated tar file to a remote server and to delete the file from the local disk.

If the Start Date and End Date are specified, then the data between those dates, including the start and end dates, is exported. If only one date parameter is passed, it is considered as start date and all the data from that date onwards is exported.

Note
When the command is executed, any previous tar file that was created is deleted. At any point only one Historical Reporting data export file is saved in the local file system. So after the Historical Reporting data is exported, transfer the tar file to remote server before running the command again.

Command Syntax
run uccx hrdataexport all [Start Date] [End Date]
Dumps all the historical reporting data.

run uccx hrdataexport reports report names [Start Date] [End Date]
Dumps all the historical reporting data for given reports.

run uccx hrdataexport tables table names [Start Date] [End Date]
Dumps all the historical reporting data for given table names.

Parameters

report names—(Mandatory) Comma separated names of the specific reports for which the corresponding data has to be exported. Enclose the list of report names in “ ” (double quotes).

table names—(Mandatory) Comma separated names of the specific tables from which the data is exported. Enclose the list of table names in “ ” (double quotes).

[Start Date]—(Optional) Must be in the format “yyyy-MM-dd HH:mm:ss”, including the double quotes.

[End Date]—(Optional) Must be in the format “yyyy-MM-dd HH:mm:ss”, including the double quotes.

Examples

admin:run uccx hrdataexport all "2012-01-01 00:00:00" "2012-02-01 00:00:00"

admin:run uccx hrdataexport reports "abandoned call detail activity report,aborted rejected call detail report" "2012-01-01 00:00:00" "2012-02-01 00:00:00"

admin:run uccx hrdataexport tables "agentconnectiondetail,agentstatedetail,contactcalldetail" "2012-01-01 00:00:00" "2012-02-01 00:00:00"

run uccx sql database_name sql_query

Executes an SQL “select” statement from the CLI. Read-only operations are permitted. Insert, Update, Delete and any DML statements are disallowed. This command allows queries to be run against the Unified CCX databases (data stores) and sysmaster database for the Unified CCX Informix instance (IDS engine).

Command syntax

run uccx sql database_name sql_query [options]

Arguments

database_name—(Mandatory) Database on which the SQL statement is run

sql_query—(Mandatory) The sql statement to run

Options

page—Displays the output one page at a time

file—Stores the output to a file instead of showing it on the console. The name of the file is displayed after the completion of the command.

Requirements
run uccx sp database_name sp_name

Executes a stored procedure that is specified as a parameter on the database, which is also mentioned as a parameter. This command runs only a stored procedure.

Command Syntax

run uccx sp database_name sp_name [options]

Arguments

database_name—(Mandatory) Database on which the stored procedure is run

sp_name—(Mandatory) The stored procedure to be run

Options

page—Displays the output one page at a time

file—Stores the output to a file instead of showing it on the console. The name of the file is displayed after the completion of the command.

Requirements

Level privilege: 0

Command privilege level: 0

Allowed during upgrade: No
(Utils Commands)

**utils uccx notification-service log**

This command allows you to enable, disable, and check the status of debug logging for Cisco Unified CCX Notification Service.

By default, debug logging is disabled for Cisco Unified CCX Notification Service. Enable debug logging for Cisco Unified CCX Notification Service when there is an issue in the system related to this service and when you require detailed logs for troubleshooting. After the troubleshooting is complete, disable logging for Cisco Unified CCX Notification Service.

You can retrieve the logs from the log-collection facility provided by Cisco Unified Real-Time Monitoring Tool.

You can execute **utils uccx notification-service log** only if Cisco Unified CCX Notification Service is running. If the service is not running, start the service first and then execute the command.

---

**Note**

- Logging for Cisco Unified CCX Notification Service affects system performance; therefore, disable logging when it is not required.

- Logging is disabled automatically when you restart Cisco Unified CCX Notification Service.

**Command syntax**

utilities uccx notification-service log enable
utilities uccx notification-service log disable
utilities uccx notification-service log status

**Arguments**

None

**Requirements**

Level privilege: 1
Command privilege level: 1
Allowed during upgrade: No
Examples

Check status of logging

admin:utils uccx notification-service log status
Cisco Unified CCX Notification Service logging is currently DISABLED.

Enable logging

admin:utils uccx notification-service log enable
WARNING! Enabling Cisco Unified CCX Notification Service logging can affect system performance and should be disabled when logging is not required.
Do you want to proceed (yes/no)?
Cisco Unified CCX Notification Service logging enabled successfully.
NOTE: Logging will be disabled automatically if Cisco Unified CCX Notification Service is restarted.

Disable logging

admin:utils uccx notification-service log disable
Cisco Unified CCX Notification Service logging disabled successfully.

utils remote_account

This command allows you to enable, disable, create, and check the status of a remote account.

Command Syntax

- utils remote_account status
- utils remote_account enable
- utils remote_account disable
- utils remote_account create username life

Arguments

- username—Specifies the name of the remote account. The username can contain only lowercase characters and must be more than six characters long.
- life—Specifies the life of the account in days. After the specified number of days, the account expires.

Usage Guidelines

A remote account generates a pass phrase that allows Cisco support personnel to access the system for the specified life of the account. You can have only one remote account that is enabled at a time.

Example

admin:utils remote_account status
Remote Support
Avoid creating remote account usernames starting with "uccx" or "UCCX" because such usernames may conflict with system account names that are used internally within the Cisco Unified Contact Center Express server.

## utils reset_application_ui_administrator_name

This command resets the application user interface administrator name for Serviceability, CUIC Admin property, and CUIC Administrator.

### Command syntax

```
utils reset_application_ui_administrator_name
```

### Command Modes

**Administrator (admin)**

### Requirements

Command privilege level: 0

Allowed during upgrade: Yes

### Note

Restart the service (Cisco Unified Intelligence Center Reporting Service) on all nodes in the cluster to enable the new administrator to log in to Unified Intelligence Center.

```
admin:utils reset_application_ui_administrator_name
----------------------- utils reset_ui_administrator_name -----------------------

Reset user interface administrator user name

New administrator user name:
User_1
Serviceability Administrator user name has been successfully updated to User_1
CUIC Admin property has been successfully updated to User_1
CUIC Administrator user name has been successfully updated to User_1
```

## utils reset_application_ui_administrator_password

This command resets the application user interface administrator password.

### Command syntax

```
utils reset_application_ui_administrator_password
```
Command Modes
Administrator (admin)

Requirements
Command privilege level: 0
Allowed during upgrade: Yes

Example

```
admin:utils reset_application_ui_administrator_password
New password:********
Confirm new password:********
```

utils service

This command allows start, stop, activate, deactivate, list, auto-restart and restart of the following services:

- System SSH
- Service Manager
- Entropy Monitoring Daemon
- Cisco SCSI Watchdog
- A Cisco DB
- A Cisco DB Replicator
- Cisco AMC Service
- Cisco Audit Event Service
- Cisco CDP
- Cisco CDP Agent
- Cisco CallManager Serviceability
- Cisco Certificate Change Notification
- Cisco Certificate Expiry Monitor
- Cisco Cloud Connect Container Manager
- Cisco Database Layer Monitor
- Cisco DRF Local
- Cisco DRF Master
- Cisco Finesse Tomcat
- Cisco Identity Service
- Cisco Log Partition Monitoring Tool
- Cisco RIS Data Collector
• Cisco RTMT Reporter Servlet
• Cisco Syslog Agent
• Cisco Tomcat
• Cisco Tomcat Stats Servlet
• Cisco Trace Collection Service
• Cisco Trace Collection Servlet
• Cisco Unified Serviceability RTMT
• Cisco Finesse Tomcat
• Cisco Unified CCX Administration
• Cisco Unified CCX CVD Dependent Webapp
• Cisco Unified CCX Cluster View Daemon
• Cisco Unified CCX Configuration API
• Cisco Unified CCX DB Perfmon Counter Service
• Cisco Unified CCX Database
• Cisco Unified CCX Engine
• Cisco Unified CCX Notification Service
• Cisco Unified CCX Perfmon Counter Service
• Cisco Unified CCX SNMP Java Adapter
• Cisco Unified CCX Serviceability
• Cisco Unified CCX Socket.IO Service
• Cisco Unified CCX Voice Subagent
• Cisco Unified CCX WebServices
• Cisco Unified Intelligence Center Reporting Service
• Cisco Unified Intelligence Center Serviceability Service
• Cisco Unified Serviceability RTMT
• Cisco Web Proxy Service
• Docker Engine
• Host Resources Agent
• MIB2 Agent
• Platform Administrative Web Service
• Platform Communication Web Service
• SNMP Master Agent
• SOAP -Log Collection APIs
• SOAP -Performance Monitoring APIs
• SOAP -Real-Time Service APIs
• System Application Agent
• Cisco DirSync
• Cisco Serviceability Reporter

Command syntax
utils service [option] [service-name]

Arguments
option—The option to {start | stop | activate | deactivate | list | auto-restart | restart} a service.
service-name—The name of the service.

Requirements
Level privilege: 1
Command privilege level: 1
Allowed during upgrade: No

Example

admin:utils service start Cisco Unified CCX Administration
Service Manager is running
Cisco Unified CCX Administration[STARTING]
Cisco Unified CCX Administration[STARTING]
Cisco Unified CCX Administration[STARTED]
Cisco Unified CCX Administration[STARTED]

utils system upgrade

This command allows you to install upgrades and Cisco Option Package (COP) files from both local and remote directories.

Command syntax
utils system upgrade [Options]

Options
initiate—Starts a new upgrade wizard or assumes control of an existing upgrade wizard. The wizard prompts you for the location of the upgrade file for Unified CCX.
status—Displays status of the upgrade
cancel—Stops the upgrade process

Example

admin:utils system upgrade initiate
Warning: Do not close this window without first canceling the upgrade.

Source:
1) Remote Filesystem via SFTP
2) Remote Filesystem via FTP
3) Local DVD/CD
q) quit

Please select an option (1 - 3 or "q"): 

**utils system switch-version**

This command restarts and switches the system to the Unified CCX product release that is installed on the inactive partition.

**Command syntax**

```
utils system switch-version
```

**Requirements**

Level privilege: 1
Command privilege level: 1
Allowed during upgrade: No

When the user initiates a switch version, system restart, or system shutdown from the CLI, a warning message is displayed and user confirmation is requested before Unified CCX proceeds with the command execution. This command is applicable for the following scenarios:

- The system detects that a switch version is in progress.
- The system detects that a previous switch version was abruptly terminated.

**Note**

A switch version operation is abruptly terminated if a power reset or hard reboot is performed on the Unified CCX system when the operation is in progress.

**Example**

```
admin:utils system switch-version
** There is no inactive side available **
```

**utils uccx database dbserver integrity**

This command checks the integrity of the database server disk structures and displays results. It also checks the DB configuration integrity and performs a fix if integrity is broken. Detailed information is output to a text file. The Informix oncheck utility is used for the command.

**Command Syntax**

```
utils uccx database dbserver integrity
```
**Requirements**

Level privilege: 0
Command privilege level: 0
Allowed during upgrade: Yes

**Example**

```
admin:utils uccx database dbserver integrity
This operation may take a few minutes to complete. Please wait...
Output is in file: uccx/cli/DbServerIntegrity_1372844998930.txt
Command successful.
Starting DB config integrity check
This operation may take a few minutes to complete. Please wait...
Output is in file: uccx/cli/DbConfigIntegrity_1372845048816.txt
Use "file view activelog  uccx/cli/DbConfigIntegrity_1372845048816.txt" command to see output
Command successful.
```

---

**Note**

The name of the file containing the output from all the checks performed is automatically generated by the command script. For the filename to be unique, the naming format is `DbServerIntegrity_<TIMESTAMP>.txt`. This format ensures the uniqueness across processes and over time. The file path and filename are displayed after the completion of the operation.

---

**utils uccx list license**

This command lists the licenses that are uploaded into the uccx system.

---

**Note**

This command is not applicable when you are using Smart Licensing.

**Command syntax**

```
utils uccx list license
```

**Requirements**

Level privilege: 1
Command privilege level: 1
Allowed during upgrade: No

**Example**

```
admin:utils uccx list license
The following licenses are uploaded in the system:
ccx90_pre_demo.lic
UCCXLicense.lic
ccx100_premium_300seat_allfeatures_dummy.lic
```
utils uccx delete license licenseName

This command deletes a license, permanent or temporary, that is already uploaded into the Unified CCX system.

⚠️ Caution

Use this command with extreme care, because it will delete any license that has been uploaded to the Unified CCX system, without checking whether the license is a temporary or a permanent one. Use this command only to delete wrong or invalid permanent licenses. You can delete temporary licenses by using Unified CCX Administration.

📝 Note

For the single-node system, execute the delete command first, and then restart the Unified CCX node. For the HA system, execute the delete command separately on each of the two nodes, and then restart both the Unified CCX nodes in the cluster.

Command syntax

utils uccx delete license licenseName

Arguments

licenseName is deleted from the Unified CCX system

Requirements

Level privilege: 1
Command privilege level: 1
Allowed during upgrade: No

Example

admin:utils uccx delete license ccx10_premium_300seat.lic
Warning:
Deleting the license may have adverse effect on the working of the uccx system. After deleting the license from all UCCX nodes, restart the UCCX nodes in the cluster.
Are you sure you want to run this command?
Continue (y/n)?n
Exiting the command.
Command successful.

utils uccx jtpapi_client update

This command updates the JTAPI Client version on the active partition on the Unified CCX box to match JTAPI version on the Unified Communications Manager. This command downloads the JTAPI Client from the Unified Communications Manager and checks whether the downloaded version needs to be installed.
the downloaded version needs to be installed, it installs the downloaded JTAPI Client and displays a message that the JTAPI Client was updated with the previous and the current versions. If the downloaded version does not need to be installed, it displays a message saying the same and displays the current JTAPI Client version. The JTAPI client update occurs only on the local node and not the second node in case of an HA deployment.

After you run this command, you must reboot the Unified CCX server and restart all the Unified CCX services.

**Command syntax**

`utils uccx jtapi_client update`

**Requirements**

- Level privilege: 1
- Command privilege level: 1
- Allowed during upgrade: No

**Example**

```
admin:utils uccx jtapi_client update
Node ID: 1 -- Cisco JTAPI Client versions are consistent
Command successful.
```

**utils uccx prepend custom_classpath**

This command adds the CustomJarName to the classpath ahead of the system classpath.

**Note**

You must use this command when there are common classes being used in the custom code as well as by Unified CCX and there is a version mismatch between the common classes that are being used.

**Caution**

You must add the custom classpath only if the Custom class files have a newer version than the class files used by Unified CCX. Adding class files that are of older version at the start of the classpath could lead to system instability.

**Command syntax**

`utils uccx prepend custom_classpath [CustomJarName]`

**Arguments**

- `CustomJarName`—Custom jar filename to be prepended to classpath

**Example**

```
admin:utils uccx add custom_classpath jsafe.jar
Command successful.
```
utils uccx switch-version db-check

This command allows you to check whether the database was corrupted after an unsuccessful switch version due to a restart in the middle of a switch version attempt. The command displays the status of last switch version. If there is a database backup available that can be restored, it prints the time stamp of the backup and display the CLI command **utils uccx switch-version db-recover** to recover from this backup.

**Command Syntax**

**utils uccx switch-version db-check**

**Requirements**

Level privilege: 1

Command privilege level: 1

Allowed during upgrade: No

**Example**

```
admin:utils uccx switch-version db-check
ccx DB was found to be corrupted.
Last switch version was aborted at 05/29/2012 16:18:07
05/29/2012 16:18:07|root:Switch Version 9.0.1.10000-41 to 9.0.10000-42 Aborted
There is a CCX backup with timestamp 2012-05-29 16:16:19.000000000 +0530 that was taken during a prior switch version.
!!!WARNING!!! IF YOU CHOOSE TO RECOVER FROM THIS BACKUP, ANY CHANGES DONE TO THE DATABASE AFTER THE TIMESTAMP OF THIS BACKUP WILL BE LOST.
You can run the CLI command "utils uccx switch-version db-recover" to restore the DB from this backup.
```

utils uccx switch-version db-recover

This command first checks whether the database was corrupted after an unsuccessful switch version due to the restart in the middle of a switch version attempt. The command displays the status of the last switch version. If there is a database backup available that can be restored, it prints the time stamp of the backup and offer an option to restore the database from this backup. If the restore option is chosen, the command completes after restoring the database from this backup and bringing up all the services.

**Command Syntax**

**utils uccx switch-version db-recover**

**Requirements**

Level privilege: 1

Command privilege:1

Allowed during upgrade: No

**Example**
admin:utils uccx switch-version db-recover
CCX DB was found to be corrupted.

Last switch version was aborted at 05/29/2012 16:18:07
05/29/2012 16:18:07|root:Switch Version 9.0.1.10000-42 Aborted

There is a CCX DB backup with timestamp 2012-05-29 16:16:19:000000000 +530 that
was taken during a prior switch version.

!!!WARNING!!! IF YOU CHOOSE TO RECOVER FROM THIS BACKUP, ANY CHANGES DONE TO THE
DATABASE AFTER THE TIMESTAMP OF THIS BACKUP WILL BE LOST.

Are you sure you want to continue?
Continue (y/n)?y
This operation may take a few minutes to complete. Please wait

utils uccx syncusers

This command allows you to synchronize the Unified CCX user passwords with the security password.

Command syntax
utils uccx syncusers

Example

admin:utils uccx syncusers
Command successful.

utils uccx synctocuic

Synchronizes the users, teams and grants permissions to the reports and stock folders from Unified CCX to
Unified Intelligence Center. The following are the configurations that are pushed from Unified CCX to Unified
Intelligence Center:

• Users
• Teams
• Stock folders
• Reports
• Value lists

If you make any changes to the above mentioned configurations in Unified Intelligence Center, then such
changes are overwritten during the sync.

Note

If the sync fails, then running this command or the auto sync that is part of the purge schedule will not revoke
the permissions for the previously-synced users or user groups.
Command Syntax

utils uccx synctocuic

Example

admin:utils uccx synctocuic
Warning:
Synchronizing all the data to cuic will take some time.
Are you sure you want to run this command?
Continue (y/n)?y
Synchronization of the data from UCCX to CUIC is in progress...
Command successful.

utils uccx icd clid status

This command allows you to view the current configuration parameter values for the Caller ID (CLID) feature.

Command syntax

utils uccx icd clid status

Example

admin:utils uccx icd clid status
CLID Feature: Disabled
CLID Text Header: Caller Details
CLID Text Prefix: Calling Party Number :

utils uccx icd clid enable

This command allows you to enable the CLID feature.

Restart the Unified CCX Engine service for the changes to take effect.

In HA deployments, run this command separately on both the Unified CCX nodes.

After upgrade, run this command again to enable the CLID feature.

Command syntax

utils uccx icd clid enable

Example

admin:utils uccx icd clid enable
Successfully enabled the CLID feature
Please restart the "Cisco Unified CCX Engine" service for changes
to take effect
In case of Cisco Unified CCX HA cluster, enable the CLID feature in
remote node as well by running the CLI command
"utils uccx icd clid enable" on the remote node
**utils uccx icd clid disable**

This command allows you to disable the CLID feature.

Restart the Unified CCX Engine service for the changes to take effect.

In HA deployments, run this command separately on both the Unified CCX nodes.

After upgrade, run this command again to disable the CLID feature.

**Command syntax**

`utils uccx icd clid disable`

**Example**

```
admin:utils uccx icd clid disable
Successfully disabled the CLID feature
Please restart the "Cisco Unified CCX Engine" service for changes to take effect
In case of Cisco Unified CCX HA cluster, disable the CLID feature in remote node as well by running the CLI command "utils uccx icd clid disable" on the remote node
```

**utils uccx icd clid header**

This command allows you to set the display header on the phone screen.

Restart the Unified CCX Engine service for the changes to take effect.

In HA deployments, run this command separately on both the Unified CCX nodes.

After upgrade, run this command again to set the values for the display header.

If the header string has space, enclose the entire string in double quotes.

You can set the header string to "" if you do not want to provide any values.

**Command syntax**

`utils uccx icd clid header <header string>`

**Example**

```
admin:utils uccx icd clid header "Caller Details"
Successfully set the CLID text header to "Caller Details"
Please restart the "Cisco Unified CCX Engine" service for changes to take effect
In case of Cisco Unified CCX HA cluster, set the CLID text header in remote node as well by running the CLI command "utils uccx icd clid header <header string>" on the remote node
```

**utils uccx icd clid prefix**

This command allows you to set the prefix string for the calling party number displayed on the phone screen.

Restart the Unified CCX Engine service for the changes to take effect.

In HA deployments, run this command separately on both the Unified CCX nodes.
After upgrade, run this command again to set the values for the prefix string.

If the prefix string has space, enclose the entire string in double quotes.

You can set the prefix string to "" if you do not want to provide any values.

**Command syntax**

```sh
utils uccx icd clid prefix <prefix string>
```

**Example**

```
admin:utils uccx icd clid prefix "Calling Party Number : 
Successfully set the CLID text prefix to "Caller Party Number: 
Please restart the "Cisco Unified CCX Engine" service for changes
to take effect
In case of Cisco Unified CCX HA cluster, set the CLID text prefix in
remote node as well by running the CLI command
"utils uccx icd clid prefix <prefix string>" on the remote node
```

---

### `utils uccx security_filter enable`

Run this command to enable Unified CCX administration security filter settings.

In HA deployments, run this command separately on both the Unified CCX nodes.

**Command syntax**

```sh
utils uccx security_filter enable
```

**Requirements**

- Level privilege: 1
- Command privilege level: 1
- Allowed during upgrade: No

**Example**

```
admin:utils uccx security_filter enable
The status of security filter is: enabled
Please restart Unified CCX service using
'utils service restart Cisco Tomcat' for changes to take effect.
In case of Cisco Unified CCX HA cluster, set the security filter in
remote node as well.
```

---

### `utils uccx security_filter disable`

Run this command to disable Unified CCX administration security filter settings.

In HA deployments, run this command separately on both the Unified CCX nodes.

**Command syntax**

```sh
utils uccx security_filter disable
```

**Requirements**

- Level privilege: 1
Command privilege level: 1
Allowed during upgrade: No

Example

```
admin:utils uccx security_filter disable
The status of security filter is: disabled
Please restart Unified CCX service using
'utils service restart Cisco Tomcat' for changes to take effect.
In case of Cisco Unified CCX HA cluster, set the security filter in
remote node as well.
```

**utils uccx security_filter status**

Run this command to check the status of Unified CCX administration security filter flag.

**Command syntax**

```
utils uccx security_filter status
```

**Requirements**

Level privilege: 1
Command privilege level: 1
Allowed during upgrade: No

**Example**

```
admin:utils uccx security_filter status
uccx security filter is :enabled
```

**utils uccx dbreplication dump configfiles**

Run this command to append the data of dbreplication configuration files to a text file. This command is only available in the High Availability deployment of Unified CCX.

**Command syntax**

```
utils uccx dbreplication dump configfiles
```

**Requirements**

Level privilege: 1
Command privilege level: 0
Allowed during upgrade: No

**Example**

```
admin:utils uccx dbreplication dump configfiles
Command Started
Output is in file: DbConfigFiles_120813161827.txt
Use "file view activelog uccx/cli/DbConfigFiles_120813161827.txt" command to view
the file
Use "file get activelog uccx/cli/DbConfigFiles_120813161827.txt" command to get
```
**utils uccx database healthcheck**

This command runs the database health check script, which checks the health of the Unified CCX database.

After the execution of this command, a health check report is generated. If any issues are found by this script then they are recorded in the health check report. A solution file is also generated that consists of suggested solutions for the problems reported in the health check report file.

**Command syntax**

`utils uccx database healthcheck`

**Requirements**

- Level privilege: 1
- Command privilege level: 0
- Allowed during upgrade: No

**Example**

```
admin:utils uccx database healthcheck
Command Started
This command may take few minutes to complete
UCCX database health report is available at: /var/log/active/uccx/cli/healthcheck.rpt
UCCX database health report suggested solutions is available at: /var/log/active/uccx/cli/healthcheck.soln
Use "file view activelog uccx/cli/healthcheck.rpt" command to view the file
Use "file get activelog uccx/cli/healthcheck.rpt" command to get the file
Use "file view activelog uccx/cli/healthcheck.soln" command to view the file
Use "file get activelog uccx/cli/healthcheck.soln" command to get the file
Command Successful
```

**utils uccx database dbperf start**

Run this command to monitor the CPU and database utilization on the Unified CCX server.

After this command is executed, a successful execution message appears on the screen. This command runs in the background for the total duration specified in the command at periodic intervals and generates a file, which consists of the details related to CPU and database utilization.

**Command syntax**

`utils uccx database dbperf start totalHours interval`

**Arguments**

- **Interval**— Period of time between the execution / operation.
- **TotalHours**— Total duration of the execution.

**Requirements**

- Level privilege: 1
Command privilege level: 0
Allowed during upgrade: No

Example

```
admin: utils uccx database dbperf start 10 20
The script runs every 20 minutes over a total duration of 10 hours.
Please collect files after 10 hours
Use "file get activelog uccx/cli/dbperf_250913131546.log" to get the file
Use "file view activelog uccx/cli/dbperf_250913131546.log" to view the file
Command Successful
```

**utils uccx database dbperf stop**

Run this command to stop the current active instance of **utils uccx database dbperf start** before it runs to completion.

**Command syntax**

```
utils uccx database dbperf stop
```

**Requirements**

Level privilege: 1
Command privilege level: 0
Allowed during upgrade: No

**Example**

```
admin:utils uccx database dbperf stop
Execution of dbperf has been stopped
Command Successful
```

**utils ids sync-security-config**

This command is used to synchronize the security configuration files from the primary node to secondary node.

**Note**

This CLI is available only on the secondary node(s) in a cluster.

**Command Syntax**

```
utils ids sync-security-config
```

**Requirements**

Level privilege: 0
Command privilege level: 0
Allowed during upgrade: True
Example

```
admin:utils ids sync-security-config
```

**utils uccx healthcheck**

Run this command to perform checks on the Unified CCX system to ensure that the potential issues are detected at an early stage. When you execute this command, you are prompted to enter the category on which health check must be performed. For example, you can select to check the Unified CCX system hardware usage to detect if it is within the threshold limit and return the health check status. A report can be generated with all the plug-in details.

If you execute `utils uccx healthcheck all`, you are not prompted to select the category. This command will execute health check on all the categories.

**Command Syntax**

`utils uccx healthcheck`

**Requirements**

- Level privilege: 1
- Command privilege level: 1
- Allowed during upgrade: Yes

**Available Categories:**

- Hardware Usage
- System Parameters
- Database
- Unified CM Configurations

**Hardware Usage**

This section provides information on the Unified CCX system hardware usage. Plug-ins of this category checks and provides the Unified CCX system CPU usage, memory usage, disk space usage, and disk I/O latency status. If the hardware usage exceeds the threshold limit, then the system will display the appropriate status message.

For example, if the CPU usage in the last ten minutes is within the threshold limit, an OK state is displayed. If the CPU usage in the last ten minutes exceeded the threshold limit, a Not OK state is displayed with the appropriate message.

The following table lists the available plug-ins, their threshold limits and the message displayed when the threshold limit is exceeded.
The CPU usage has exceeded the threshold limit.

System CPU usage exceeds 70 percent.

The memory usage has exceeded the threshold limit.

System memory usage exceeds 70 percent.

The disk usage has exceeded the threshold limit.

System disk space usage exceeds 70 percent.

Disk I/O exceeded the permissible limit.

Time taken to read 1 MB and write 1 MB of data exceeds 500 milliseconds.

Disk I/O exceeded the permissible limit.

Example

admin:utils uccx healthcheck
Healthcheck is available for the following categories:
1) Hardware Usage
2) System Parameters
3) Database
4) Unified CM Configurations
q) Quit
Select an option (1 - 4 or "q"):

Checking CPU Usage.................................................OK
Checking Memory Usage.........................................OK
Checking Disk Usage.............................................OK
Checking Disk I/O Latency.................................Not OK

Disk I/O exceeded the permissible limit.

Use 'file get activelog healthcheck/report_2019-11-11-09-40-04.json' command to download the health report.
Command Successful.

CCX Configuration

This section provides information on the Unified CCX system parameters usage. If the configured values for the following system parameters exceed the threshold limit, then the Unified CCX system will display the appropriate status message. For example, if the configured number of agents is within the capacity limits, an OK state is displayed. If the configured number of agents exceeds the capacity limits, a Not OK state is displayed with the appropriate message.

The following plug-ins check the various configuration limits in the Unified CCX system:

• Configured Agents
• Configured Agents per Team
• Configured CSQs
• Configured Skills per Agent
• Configured Outbound Campaigns
• Configured Supervisors per Team
• Configured Teams per Supervisor
• Configured Contacts per Outbound Campaign
• Configured Contact Service Queues
• Configured Skills
• Configured Skills per CSQ

For more information on team configuration limits, see Server Capacities and Limits section in the Solution Design Guide for Cisco Unified Contact Center Express.

Database

This section provides a list of plug-ins that executes to check the health of database components. The available plug-ins include the following:

• CCX DB Status: This plug-in checks if the Unified CCX database service is running. If the Unified CCX database service is down, an appropriate status message is displayed.

• CCX DB Replication Status: This plug-in checks if all the Unified CCX database replications are running. If the Unified CCX database replications are not in synchronization, an appropriate status message is displayed.

• CCX DB Space Usage: This plug-in checks if all the three Unified CCX database (db_cra, db_cra_repository, and db_hist) usage is within the threshold limit. If any of the database usage exceeds the threshold limit, the system displays the name of that particular database along with the percentage used.

• CCX Config DB tables consistency in HA: This plug-in checks if the Unified CCX configuration tables are in synchronization across the Unified CCX cluster. If any of the configuration tables are not in synchronization, an appropriate status message is displayed.

• Number of Wallboard/External clients: This plug-in checks the number of wallboards and external clients that are connected to the database. If the configured number of wallboards and external clients is within the threshold limit, an OK state is displayed. If the configured number of wallboards and external clients exceeds the threshold limit, a Not OK state is displayed with the appropriate message.

Example

```
admin:utils uccx healthcheck
Healthcheck is available for the following categories:
1) Hardware Usage
2) System Parameters
3) Database
4) Unified CM Configurations
q) Quit
Select an option (1 - 4 or "q"):
3
Checking CCX DB Status.................................OK
Checking CCX DB Replication Status......................OK
Checking CCX DB Space Usage............................Not OK
Reason:DB space usage has exceeded the threshold limit of 75% for the following:db_hist and db_cra_repository
Checking CCX Config DB tables consistency in HA........Not OK
Reason:DB table(s) out of sync:Skill
```
Unified CM Configurations

This section provides a list of plug-ins that can be executed to check the configurations of Unified CM configured in Unified CCX.

The available plug-ins include the following:

• AXL Configuration:

This plug-in validates the following:

  • If the AXL configurations are available in Unified CCX.

  • If the configured Unified CM is reachable.

  • If the configured Unified CM certificates stored in Unified CCX are correct.

  • If the AXL service is running in the configured Unified CM.

  • If the configured user in Unified CM has AXL API Access role.

  • If the configured AXL user is available in Unified CM, if the credentials are valid, or if the user is locked in Unified CM.

• Telephony Provider (JTAPI) Configuration:

This plug-in validates the following:

  • If the Telephony Provider configuration is available in Unified CCX.

  • If the configured Unified CM is reachable or if the CTIManager service is running in the configured Unified CM.

  • If the configured Telephony Provider in Unified CCX has Standard CTI Enabled role in Unified CM.

  • If the configured Telephony Provider is available in Unified CM or if the configured Telephony Provider credentials are valid.

  • If the configured Telephony Provider is locked in Unified CM.

• RmCm Provider Configuration:

This plug-in validates the following:

  • If the RmCm Provider configuration is available in Unified CCX.

  • If the configured Unified CM is reachable or the CTIManager service is running in the configured Unified CM.

  • If the configured RmCm Provider has the following different Access Control roles in the Unified CM:
• Standard CTI Allow Call Monitoring.
• Standard CTI Allow Call Recording.
• Standard CTI Allow Control of Phones supporting Connected Xfer and conf.
• Standard CTI Enabled.

• If the configured RmCm Provider is available in Unified CM or if the credentials are valid.
• If the configured RmCm Provider is locked in Unified CM.

Example

```
admin:utils uccx healthcheck
Healthcheck is available for the following categories:
1) Hardware Usage
2) System Parameters
3) Database
4) Unified CM Configurations
q) Quit
Select an option (1 - 4 or "q"):
4 Checking AXL Configuration .........................OK
Checking Telephony Provider (JTAPI) Configuration............OK
Checking RmCm Provider Configuration......................Not OK
Reason:The configured RmCm Provider is not assigned with the following
roles in Unified CM: Standard CTI Allow Call Recording
Checking CCX Config DB tables consistency in HA...........Not OK
Use 'file get activelog healthcheck/report_2019-11-11-09-40-04.json' command
to download the health report.
Command Successful.
```

**utils cloudconnect start**

Run this command to start the specified container.

**Command Syntax**

```
utils cloudconnect start container_name
```

**Arguments**

`container_name` - Name of the container that has to be started.

**Requirements**

Level privilege: 1
Command privilege level: 1
Allowed during upgrade: Yes

**Example**

```
admin:utils cloudconnect start dataconn
Starting the container dataconn ...
Container dataconn is started successfully.
```
**utils cloudconnect stop**

Run this command to stop the specified container.

**Command Syntax**

```
utils cloudconnect stop container_name
```

**Arguments**

*container_name* - Name of the container that has to be stopped.

**Requirements**

Level privilege: 1

Command privilege level: 1

Allowed during upgrade: Yes

**Example**

```
admin:utils cloudconnect stop dataconn
Stopping the container dataconn ...
Container dataconn is stopped successfully.
```

**utils fips**

This command enables, disables, or displays the status of FIPS 140-2 mode. By default, FIPS 140-2 mode is disabled.

```
utils fips {enable | disable | status}
```

For using FIPS 140-2 mode, consider the following points:

---

**Note**

FIPS 140-2 mode is supported only on releases that have been through FIPS compliance.

- In a HA setup, FIPS 140-2 mode must be first enabled or disabled on the publisher and then on the subscriber. Before enabling or disabling FIPS 140-2 mode on the subscriber, ensure that all the services are running on the publisher.
- Ensure that SRTP is disabled before enabling or disabling FIPS 140-2 mode in Unified CCX. You can enable SRTP after enabling or disabling FIPS 140-2 mode in Unified CCX.
- When FIPS 140-2 mode is enabled or disabled, the keys and certificates are regenerated, and the Unified CCX server reboots. While rebooting, the system performs the cryptographic modules integrity check, and runs certification self-tests.

---

**Caution**

Back up the system before and after enabling FIPS 140-2 mode.

If any of the startup self-tests fail, the Unified CCX server halts. Restart the Unified CCX server. If the startup self-test error persists, it indicates that there is a critical problem in the FIPS module and the only option is to use a recovery CD.
**utils fips enable**

Use this command to enable FIPS 140-2 mode on the system.

---

**Note**

Before enabling security modes such as FIPS, Common Criteria, and Enhanced Security, the cluster security password must be at least 14 characters. Update the cluster security password by using the `set password user security` command on all nodes and then run this command.

---

**Caution**

After you enable FIPS 140-2 mode on a server, please wait until the server reboots and the phones re-register successfully before enabling FIPS 140-2 mode on the next server.

**Command syntax**

`utils fips enable`

**Requirements**

- Level privilege: 1
- Command privilege level: 1
- Allowed during upgrade: No

**Example**

```bash
admin:utils fips enable

Security Warning: The operation will regenerate certificates for
1)Tomcat
2)IPsec

Any third party CA signed certificates that have been uploaded for the above
components will need to be re-uploaded. If there are other servers in the cluster, please wait and do not change the
FIPS settings on any other node until the FIPS operation on this node is complete
and the system is back up and running.

**********************************************************************************************
This will change the system to FIPS mode and will reboot.
**********************************************************************************************

WARNING: Once you continue, do not press Ctrl+C. Canceling this operation after it
starts will leave the system in an inconsistent state; rebooting the system and
running "utils fips status" will be required to recover.
**********************************************************************************************

Do you want to continue (yes/no) ? yes

Generating certificates...

Setting FIPS mode in operating system.
FIPS mode enabled.
FIPS mode enabled successfully.
**********************************************************************************************

```
It is highly recommended that after your system restarts, a system backup is performed.
********************************************************
The system will reboot in a few minutes.

**utils fips status**

Use this command to know if FIPS 140-2 mode has been enabled on the system. When you run the `utils fips status` command, the system runs the certification self-tests and displays the result.

**Command syntax**

`utils fips status`

**Requirements**

Level privilege: 1
Command privilege level: 1
Allowed during upgrade: No

**Example**

The system is operating in FIPS mode. Self test status:

- S T A R T ---------------------
  Executing FIPS selftests
  runlevel is N3
  Start time: Thu Apr 9 08:50:59 IST 2020
  NSS self tests passed.
  Kernel Crypto tests passed.
  Operating System OpenSSL self tests passed.
  Libreswan self tests passed.
  OpenSSL self tests passed.
  CryptoJ self tests passed.

**utils fips disable**

Use this command to disable FIPS 140-2 mode on the system.

**Command syntax**

`utils fips disable`

**Requirements**

Level privilege: 1
Command privilege level: 1
Allowed during upgrade: No

**Example**

Security Warning : The operation will regenerate certificates for
1)Tomcat
2)IPsec

Any third party CA signed certificates that have been uploaded for the above components will need to be re-uploaded.
Enhanced Security Mode

Enhanced Security Mode runs on a FIPS-enabled system. Unified CCX can be enabled to operate in Enhanced Security Mode, which enables the system with the following security and risk management controls:

- Stricter credential policy is implemented for user passwords and password changes.
- If the protocol for remote audit logging is set to TCP or UDP, the default protocol is changed to TCP. If the protocol for remote audit logging is set to TLS, the default protocol remains TLS. In Common Criteria Mode, strict hostname verification is implemented. So, it is required to configure the server with a fully qualified domain name (FQDN) which matches the certificate.

Credential Policy Updates

When the Enhanced Security Mode is enabled, a stricter credential policy takes effect for new user passwords and password changes. After Enhanced Security Mode is enabled, administrators can use the set password *** series of CLI commands to modify any of the following requirements:

- The length of the password must be between 14 and 127 characters.
- A password must have at least one lowercase, one uppercase, one numeral, and one special character.
- Any of the previous 24 passwords cannot be reused.
- Minimum age of the password is one day and maximum age of the password is 60 days.
- Character sequence in the newly-generated password must differ by at least four characters from the character sequence in the old password.
**File Commands**

File commands help in creating custom files that are stored in a specific directory in UCCX Filesystem.

**file uccx view**

Use this command to view custom files created by Unified CCX scripts.

**Command syntax**

`file uccx view custom_file file-spec`

**Arguments**

`file-spec`—(Mandatory) The file to view. The file-spec must resolve to a single file. File-spec can contain asterisks (*) as wildcards, providing it resolves to a single file.

**Options**

None

**Requirements**

Level privilege: 0
Command privilege level: 1
Allowed during upgrade: No

**Example**

```
admin:file uccx view custom_file test.txt
```
Level privilege: 0
Command privilege level: 1
Allowed during upgrade: No

Example

```
admin:file uccx list custom_file * detail
08 Dec,2009 16:56:11 0 text.txt
dir count = 0, file count = 1
```

**file uccx list prompt_file**

This command lists prompt files created for various locales.

**Command syntax**

```
file uccx list prompt_file file_spec [options]
```

**Arguments**

file-spec—(Mandatory) The file to view. File-spec can contain asterisks (*) as wildcard.

**Options**

page—Pauses output
detail—Shows detailed listing
reverse—Reverses sort order
date—Sorts by date
size—Sorts by size

**Requirements**

Level privilege: 0
Command privilege level: 1
Allowed during upgrade: No

Example

```
admin:file uccx list prompt_file system/G711_ULAW/en_US detail
16 May,2012 17:50:19 <dir> AA
16 May,2012 17:50:19 <dir> ICD
16 May,2012 17:50:19 <dir> ICM
16 May,2012 17:50:19 <dir> SNU
16 May,2012 17:50:19 <dir> SSA
16 May,2012 17:50:19 <dir> UserDialog
16 May,2012 17:50:19 <dir> gen
05 Dec,2002 06:19:03 13,822 continue_enter_number.wav
05 Dec,2002 06:19:03 7,280 credit_of.wav
05 Dec,2002 06:19:04 18,310 did_not_hear_name.wav
05 Dec,2002 06:19:04 11,430 enter_phone_number.wav
05 Dec,2002 06:19:05 12,926 finished.wav
05 Dec,2002 06:19:05 4,448 goodbye.wav
05 Dec,2002 06:19:06 8,546 name_cancelled.wav
```
### file uccx get

This command transfers the custom files created by Unified CCX scripts outside the box.

**Command syntax**

```
file uccx get custom_file file-spec [options]
```

**Arguments**

- `file-spec`—(Mandatory) File to transfer. File-spec can contain asterisks (*) as wildcards.

**Options**

- `retime`—(Mandatory) File to transfer. File-spec can contain asterisks (*) as wildcards.
- `abstime`—(Mandatory) Absolute time to filter.
- `match`—Search pattern to filter.
- `recurs`—Obtains all the files located in file-spec and subdirectories
- `compress`—Transfers files as compressed file

**Requirements**

- Level privilege: 0
- Command privilege level: 1
- Allowed during upgrade: No

**Example**

```
admin:file uccx get custom_file text.txt abstime 00:00:12/01/08 01:00:12/30/08
```
**file uccx tail**

This command will tail a custom file that was created by a Unified CCX script.

**Command syntax**

```
file uccx tail custom_file file-spec [options]
```

**Arguments**

- **file-spec** — (Mandatory) File to tail.

**Options**

- **hex, [num lines], regexp "expression"**
- **recent** — To tail the most recently changed file in the directory.

**Requirements**

- Level privilege: 0
- Command privilege level: 1
- Allowed during upgrade: No

**Example**

Tail file starting with the last ten lines with pagination enabled:

```
admin:file uccx tail custom_file text.txt page 102005-08-03 15:01:41,248 DEBUG [main] - cmdMVL size = 0
2005-08-03 15:01:41,248 INFO [main] - adding command in level3 (password/security)
2005-08-03 15:01:41,249 DEBUG [main] - begin for level4, topVL size = 0
2005-08-03 15:01:41,250 DEBUG [main] - begin for level4, topVL size = 0
2005-08-03 15:01:41,256 DEBUG [main] - begin for level3, topVL size = 0
2005-08-03 15:01:41,257 DEBUG [main] - begin for level2, topVL size = 0
2005-08-03 15:01:41,884 INFO [main] - merging complete
2005-08-03 15:06:27,619 INFO [main] - got to save history
2005-08-03 15:06:27,620 INFO [main] - Exiting CLI
```

**file uccx dump**

This command dumps the contents of a file on the Unified CCX custom files area.

**Command syntax**

```
file uccx dump custom_file file-spec [options]
```

**Arguments**

- **file-spec** — (Mandatory) File to dump.

**Options**

- **hex, regexp "expression"**
- **recent** — To dump the most recently changed file in the directory

**Requirements**

- Level privilege: 0
Command privilege level: 1
Allowed during upgrade: No

Example

```
admin:file uccx dump custom_file text.txt
23640935: Dec 06 22:59:43.407 IST Unable to process call, Exception=java.lang.NullPointerException
```

`file uccx delete`

This command deletes a custom file that was created by a Unified CCX script. The command deletes one or more files on the Unified CCX custom files area.

**Note**

Files that are in use cannot be deleted.

**Command Syntax**

```
file uccx delete custom_file file-spec [options]
```

**Arguments**

- `file-spec`—(Mandatory) File to delete. File-spec can contain asterisk (*) as a wildcard.

**Options**

- `detail, noconfirm`

**Requirements**

- Level privilege: 0
- Command privilege level: 1
- Allowed during upgrade: No

**Example**

```
admin:file uccx delete custom_file log/*.log det noconfirm
deleing file : log/cli00001.log
deleing file : log/cli00002.log
deleing file : log/cli00003.log
deleing file : log/cli00004.log
files:        found = 4, deleted = 4
```

**High Availability Commands**

**Note**

If the Unified CCX database in either of the node is down or is Out of Service, High Availability commands do not work.
show uccx dbreplication tables

This command is only available in the High Availability deployment of Unified CCX. This command lists all the database tables which are involved in replication in the high availability deployment.

Command syntax

show uccx dbreplication tables [options]

Options

Page—Displays the output one page at a time
File—Stores the output to a file and displays the filename

Requirements

Level privilege: 0
Command privilege level: 0
Allowed during upgrade: Yes

Example

admin:show uccx dbreplication tables
This operation may take a few minutes to complete. Please wait...

CURRENTLY DEFINED REPLICATES
-----------------------------------
REPLICATE: template_db_cra_pshree_dactyl_sub_uccx_1_2_agentstatedetail
STATE: Active ON:g_pshree_dactyl_pub_uccx
CONFLICT: Timestamp
FREQUENCY: immediate
QUEUE SIZE: 0
PARTICIPANT: db_cra:informix.agentstatedetail
OPTIONS: transaction,ris,ats,fullrow
REPLID: 131075 / 0x20003
REPLMODE: PRIMARY ON:g_pshree_dactyl_pub_uccx
APPLY-AS: INFORMIX ON:g_pshree_dactyl_pub_uccx
REPLTYPE: Master

.............
.............
.............

REPLICATE: template_fcrassvr_pshree_dactyl_sub_uccx_3_3_fcrascallogweek
STATE: Active ON:g_pshree_dactyl_pub_uccx
CONFLICT: Timestamp
FREQUENCY: immediate
QUEUE SIZE: 0
PARTICIPANT: fcrassvr:informix.fcrascallogweek
OPTIONS: transaction,ris,ats,fullrow
REPLID: 131104 / 0x20020
REPLMODE: PRIMARY ON:g_pshree_dactyl_pub_uccx
APPLY-AS: INFORMIX ON:g_pshree_dactyl_pub_uccx
REPLTYPE: Master

Command successful.
admin:
show uccx dbreplication servers

This command is only available in the High Availability deployment of Unified CCX. This command lists all the database servers which are involved in replication in the high availability deployment and whether replication is still connected or if replication is broken.

**Command syntax**

show uccx dbreplication servers [options]

**Options**

- **Page**—Displays the output one page at a time
- **File**—Stores the output to a file and displays the filename

**Requirements**

Level privilege: 0
Command privilege level: 0
Allowed during upgrade: Yes

**Example**

```
admin:show uccx dbreplication servers
SERVER   ID STATE   STATUS       QUEUE CONNECTION CHANGED
--------- ------ ------- ------------ --------- ------------------
10.76.253.106 110 Active Connected 0 Apr 7 22:01:19
10.76.253.107 100 Active Local 0
```

**utils uccx modify remote_IPAddress**

This command is available only in the High Availability deployment of Unified CCX. This command updates IP address of remote node in the server. Use this command during IP address change of remote node.

**Note**

Use this command only when the IP address of the other node is going to be changed.

After you run this command, reboot the Unified CCX server and restart all the Unified CCX services.

**Command syntax**

utils uccx modify remote_IPAddress <remote_server_old_ip_address> <remote_server_new_ip_address>

**Arguments**

- **remote_server_old_ip_address**—Old IP address of the remote server
- **remote_server_new_ip_address**—New IP address of the remote server

**Requirements**

- Level privilege: 1
- Command privilege level: 1
- Allowed during upgrade: No
**Example**

```
admin:utils uccx modify remote_IPAddress 10.76.253.82 10.76.253.83
Old Remote IP Address: 10.76.253.82
New Remote IP Address: 10.76.253.83
```

This command should be executed only in case you are changing IP Address of remote server.

Are you sure you want to run this command?
Continue (y/n)?
Command successful.

**utils uccx modify remote_hostname**

This command is available only in the High Availability deployment of Unified CCX. This command updates hostname of remote node in the server. Use this command during hostname change of remote node.

**Note**

Use this command only when the hostname of the other node is changed.

After you run this command, reboot the Unified CCX server and restart all the Unified CCX services.

**Command syntax**

`utils uccx modify remote_hostname <remote_server_old_hostname> <remote_server_new_hostname>`

**Arguments**

remote_server_new_hostname—New hostname of the remote server
remote_server_old_hostname—Old hostname of the remote server

**Requirements**

Level privilege: 1
Command privilege level: 1
Allowed during upgrade: No

**Example**

```
admin:utils uccx modify remote_hostname uccx-node-1 uccx-node-2
Old Remote Hostname: uccx-node-1
New Remote Hostname: uccx-node-2
```

This command should be executed only in case you are changing Host name of remote server.

Are you sure you want to run this command?
Continue (y/n)?
Command Successful.

**utils uccx database forcedatasync**

This command gets the data from the other node in the cluster, effectively overwriting the data on this node.

**Command syntax**
**utils uccx database forcedatasync**

**Arguments**
None

**Options**
None

**Requirements**
Level privilege: 1
Command privilege level: 0
Allowed during upgrade: No

**Example**

```
admin: utils uccx database forcedatasync
Are you sure you want to overwrite the local database? (y/n).
Command successful.
```

**utils uccx setuppubrestore**

This command sets up a passwordless communication between Unified CCX cluster nodes. Passwordless communication is required to perform the restore operation. Execute this command only on the subscriber node. Use this command while running restore using the "Publisher Only" option.

**Note**
This command is available only in high availability mode.

**Command syntax**
```
utils uccx setuppubrestore
```

**Example**
```
admin:utils uccx setuppubrestore
```

**utils uccx dbreplication setup**

This command is available only in the High Availability deployment of Unified CCX. This command is used to set up database replication. The command can be executed on any node and it sets up database replication in the cluster.

**Command syntax**
```
utils uccx dbreplication setup
```

**Options**
Page—Displays the output one page at a time

**Requirements**
Level privilege: 1
Command privilege level: 1
Allowed during upgrade: No

Example

```
admin:utils uccx dbreplication setup
The DB replication for the UCCX cluster has been setup.
```

**utils uccx dbreplication status**

This command is available only in the High Availability deployment of Unified CCX. This command is used to check the Unified CCX database replication status.

**Command syntax**

```
utils uccx dbreplication status
```

**Options**

None

**Requirements**

- Level privilege: 1
- Command privilege level: 1
- Allowed during upgrade: No

**Example**

```
utils uccx dbreplication status
```

<table>
<thead>
<tr>
<th>SERVER</th>
<th>ID</th>
<th>STATE</th>
<th>STATUS</th>
<th>QUEUE</th>
<th>CONNECTION</th>
<th>CHANGED</th>
</tr>
</thead>
<tbody>
<tr>
<td>g_alpha_ha_n1_uccx</td>
<td>1</td>
<td>Active</td>
<td>Connected</td>
<td>0</td>
<td>Aug 8 18:45:26</td>
<td></td>
</tr>
<tr>
<td>g_alpha_ha_n2_uccx</td>
<td>2</td>
<td>Active</td>
<td>Local</td>
<td>0</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

```

<table>
<thead>
<tr>
<th>REPLICATE</th>
<th>STATE</th>
</tr>
</thead>
<tbody>
<tr>
<td>db_cra:informix.agentconnectiondetail</td>
<td>Active</td>
</tr>
<tr>
<td>db_cra:informix.contactcalldetail</td>
<td>Active</td>
</tr>
<tr>
<td>db_cra:informix.contactroutingdetail</td>
<td>Active</td>
</tr>
<tr>
<td>db_cra:informix.eememailstatusdescription</td>
<td>Active</td>
</tr>
<tr>
<td>db_cra:informix.eemreasoncodedescription</td>
<td>Active</td>
</tr>
<tr>
<td>db_cra:informix.eemcontactemaildetail</td>
<td>Active</td>
</tr>
<tr>
<td>db_cra:informix.eemcontactemailagentstatedetail</td>
<td>Active</td>
</tr>
<tr>
<td>db_cra_repository:informix.promptsfolder</td>
<td>Active</td>
</tr>
<tr>
<td>db_cra_repository:informix.promptsfile</td>
<td>Active</td>
</tr>
<tr>
<td>db_cra_repository:informix.grammarsfile</td>
<td>Active</td>
</tr>
<tr>
<td>db_cra_repository:informix.documentsfile</td>
<td>Active</td>
</tr>
<tr>
<td>db_cra_repository:informix.sysgrammarsfile</td>
<td>Active</td>
</tr>
<tr>
<td>db_cra_repository:informix.latesynchedtime</td>
<td>Active</td>
</tr>
<tr>
<td>fcrassvri:informix.fcrascallslogweek</td>
<td>Inactive</td>
</tr>
<tr>
<td>fcrassvri:informix.fcrasrecordlog</td>
<td>Inactive</td>
</tr>
<tr>
<td>fcrassvri:informix.latesynchedtime</td>
<td>Inactive</td>
</tr>
<tr>
<td>db_cra:informix.agentstatedetail</td>
<td>Active</td>
</tr>
</tbody>
</table>
utils uccx dbreplication templatestatus

This command is available only in the High Availability deployment of Unified CCX. This command is used to see the template status of the database replication.

Command syntax

utils uccx dbreplication templatestatus

Options

Page—Displays the output one page at a time

Requirements

Level privilege: 1
Command privilege level: 1
Allowed during upgrade: No
Example

admin:utils uccx dbreplication templatestatus
The DB replication templatestatus is as follows.

utils uccx dbreplication repair

This command is available only in the High Availability deployment of Unified CCX. You can run this command on any node. This command repairs mismatched data between cluster nodes; it does not repair replication setup. The command initiates the repair, which executes in the background. To monitor the status of the repair process, the user must go to the data store control center in Serviceability Administration. For more information, see the Cisco Unified Serviceability Administration Guide available at:

Command syntax:

utils uccx dbreplication repair [database_name]|all

Arguments
[database_name]|all—(Mandatory) Database_name, which database to repair replication on. (Argument)
all—Fix replication on all nodes.

Options
Page—Displays the output one page at a time

Requirements
Level privilege: 1
Command privilege level: 1
Allowed during upgrade: No

Example

```
admin:utils uccx dbreplication repair all
Repair has been initiated in the background...
Please go to Data Control Center in Serviceability Admin to monitor the status of the repair.
```

**utils uccx dbreplication start**

This command is available only in the High Availability deployment of Unified CCX. This command is used to start the database replication. Run this command on any node to start database replication in the entire cluster.

Command syntax
```
utils uccx dbreplication start
```

Options
Page—Displays the output one page at a time

Requirements
Level privilege: 1
Command privilege level: 1
Allowed during upgrade: No

Example

```
admin:utils uccx dbreplication start
The DB replication for the UCCX cluster has been started.
```

**utils uccx dbreplication stop**

This command is available only in the High Availability deployment of Unified CCX. This command is used to stop database replication. Run this command on any node to stop database replication in the entire cluster.

Command syntax
```
utils uccx dbreplication stop
```

Options
**Page**—Displays the output one page at a time

**Requirements**
Level privilege: 1  
Command privilege level: 1  
Allowed during upgrade: No

**Example**
```
admin:utils uccx dbreplication stop  
The DB replication for the UCCX cluster has been stopped.
```

---

**utils uccx dbreplication reset**

This command is available only in the High Availability deployment of Unified CCX. This command is used to reset the database replication. Resetting replication involves the following activities, in the same order, and is equivalent to the commands presented in parentheses.

- Remove database replication (utils uccx dbreplication teardown)
- Setup database replication (utils uccx dbreplication setup)
- Initiate a data repair process for all the databases (utils uccx dbreplication repair all)

**Command syntax**
```
utils uccx dbreplication reset
```

**Options**

**Page**—Displays the output one page at a time

**Requirements**
Level privilege: 1  
Command privilege level: 1  
Allowed during upgrade: No

**Example**
```
admin:utils uccx dbreplication reset  
The DB replication for the UCCX cluster has been reset.
```

---

**utils uccx dbreplication teardown**

This command is available only in the High Availability deployment of Unified CCX. This command is used to remove the database replication. Running this command on any node with the cluster removes database replication between all nodes.

**Command syntax**
```
utils uccx dbreplication teardown
```

**Options**
**Cisco Finesse Commands**

**utils reset_3rdpartygadget_password**

Run this command to set or reset the password of the 3rdpartygadget account (where password is the new password for the account).

Use the 3rdpartygadget account to upload third-party gadgets to the Cisco Unified CCX Server so that you can use the gadgets from Cisco Finesse. Before you use this account, you must set the password.

**Note**

The password length must be between 5 and 32 characters long and must not contain spaces or double quotes.

**Command syntax**

```
utils reset_3rdpartygadget_password
```

**Requirements**

Level privilege: 1
Command privilege level: 1
Allowed during upgrade: No

```
admin: utils reset_3rdpartygadget_password
New Password:
Confirm New Password:

Updating password for 3rdpartygadget...
Password updated successfully.
admin
```

**Note**

Password values entered by the user is not echoed on the console.
Cisco Finesse Trace Logging

Use the following commands to toggle trace logs for Cisco Finesse, enable trace logs for Finesse IPPA, and enable debug logs for realm.

---

**Note**

Enabling trace logging may cause an overload in the system and must be used for debugging purposes only.

- **utils finesse trace enable:**
  
  This command allows you to:
  
  - Enable trace logs for Cisco Finesse.
  - Turn on command dispatcher logs.
  - Enable trace logs for Finesse IPPA.
  - Enable debug logs for Realm.

- **utils finesse trace disable**
  
  This command allows you to:
  
  - Disable trace logs for Cisco Finesse.
  - Turn off command dispatcher logs.
  - Disable trace logs for Finesse IPPA.
  - Disable debug logs for Realm.

---

**Note**

After execution of each command, wait for 60 seconds for the changes to take effect.

- **utils finesse trace status**
  
  This command allows you to display status as:
  
  - Enabled - When all four actions are enabled.
  - Disabled - When all four actions are disabled.

---

Toaster Notifications

Toaster notifications are enabled by default after a fresh installation of Cisco Finesse. Use the following CLI commands to disable, enable, and check the status of the toaster notifications:

- **utils finesse toaster enable [closeTimeout]**: This command enables the Cisco Finesse toaster notification.
While enabling toaster notification, use the `closeTimeout` parameter (timeout in seconds) to set the time interval after which toaster automatically closes. If no parameter is specified, timeout is set to 8 seconds by default. The valid range for timeout activity is between 5-15 seconds. The browser must be refreshed for timeout changes to take effect.

The `closeTimeout` parameter is applicable only for Chrome and Firefox browsers in Windows OS. In macOS, Chrome and Firefox browsers automatically close the toaster notification.

- `utils finesse toaster disable`: This command disables the Cisco Finesse toaster notification.
- `utils finesse toaster status`: This command displays the status (enable or disable) of the Cisco Finesse toaster notification.

Note: Cisco Finesse Toaster Notification does not work with Internet Explorer browser.

**Finesse IPPA Inactivity Timeout**

Use the following CLI commands to enable or disable the Inactivity Timeout feature in Finesse IPPA. You must either disable the Finesse Inactivity Timeout feature or increase the timeout in the range of 120 seconds to one day (in seconds), so that the Finesse IPPA agent is not logged out if on any other screen:

- `utils finesse ippa_inactivity_timeout enable`: This command enables Finesse IPPA Inactivity Timeout.

  Note: The default time set for inactivity timeout is 120 seconds.

- `utils finesse ippa_inactivity_timeout disable`: This command disables Finesse IPPA Inactivity Timeout.

  Note: When inactivity timeout is disabled, you will not be logged out of Finesse IPPA, if the agent is on any other screen.

- `utils finesse ippa_inactivity_timeout enable inactivity_timeout`: This command enables the Finesse IPPA Inactivity Timeout with timeout set to n seconds.

  Note: Minimum value of n must be 120 seconds and maximum value can be up to one day (86400 seconds).

- `utils finesse ippa_inactivity_timeout status`: This command checks the status of Finesse IPPA Inactivity Timeout.
The Finesse IPPA Inactivity Timeout CLIs should be run on primary and secondary Finesse servers. Enabling or disabling this feature requires a restart of Cisco Finesse Tomcat, and restart must be done in the maintenance window. During upgrade, the inactivity timeout configuration is not retained and should be re-configured post upgrade.

To know how this feature works on specific IP phone models, see https://www.cisco.com/c/en/us/support/customer-collaboration/unified-contact-center-express/products-device-support-tables-list.html

**Supported Content Security Policy Directives**

Content Security Policy (CSP) is a standardized set of security directives that can inform the browser of the policies to be used to help mitigate various forms of attacks. CSP frame-ancestor policy defines the allowable locations from where the Finesse desktop can be accessed as an embedded HTML content, which can help prevent click-jacking attacks.

Use the following CLI commands to view, add, or delete the frame-access sources in the response header of Cisco Finesse. This ensures that only the configured sources can embed the Cisco Finesse in an iFrame within their HTML pages.

**Note** Internet Explorer does not support frame-ancestors, and therefore will not block any websites from loading Cisco Finesse within it.

```
• util finesse frame_access_allowed_list add [source1,source2] — This command adds one or more frame sources, thereby allowing the configured sources to embed the Cisco Finesse in their iFrames. Multiple sources can be provided as a comma-separated list. The source should be of the following format:
  • https://<fqdn>:[port]
  • https://IP:[port]
  • https://<fqdn1>:port, https://<fqdn2>:port

  Note: Wildcard character * is also supported for the FQDN and port entries, which indicates that all the legal FQDN or ports are valid.
```

```
admin:util finesse frame_access_allowed_list add
Source(s) successfully added.
Ensure Source(s) is added to the frame access list in all Finesse nodes in the cluster.
Restart Cisco Finesse Tomcat and Cisco Unified CCX Notification Service for the changes to take effect:
util service restart Cisco Finesse Tomcat
util service restart Cisco Unified CCX Notification Service
```
**utils finesse frame_access_allowed_list delete**—This command displays an indexed list of all the configured frame sources that have been allowed to access Cisco Finesse. Enter the corresponding index number to delete a single source or all the configured sources.

```
admin:utils finesse frame_access_allowed_list delete
1: https://www.abc.com:8445
2: https://*.abc.com
3: https://*.abc.com:
4: https://10.21.255.25
a: all
q: quit
```

Select the index of source to be deleted [1-4 or a,q]: 1

Sources deleted successfully.

```
Restart Cisco Finesse Tomcat and Cisco Unified CCX Notification Service for the changes to take effect:
utils service restart Cisco Finesse Tomcat
utils service restart Cisco Unified CCX Notification Service
```

**utils finesse frame_access_allowed_list list**—This command lists all the frame sources that are allowed to access Cisco Finesse.

```
admin:utils finesse frame_access_allowed_list list
The following source(s) are configured in the frame access list:
1: https://www.abc.com:8445
2: https://*.abc.com
3: https://*.abc.com:
4: https://10.21.255.25
```

---

**Finesse System Commands**

Configure the following Cisco Finesse system CLIs:

**Node Statistics**

Use the following CLI command to view the run-time statistics for the current node.

- To view: **utils finesse node_statistics list**

```
admin:utils finesse node_statistics list
Warning: Running this command frequently will affect system performance.
Press ENTER to continue. Press any other key to exit:
Wait while the statistics (updated every 5 secs) are being fetched...
The following are the runtime statistics for the current node.
Active Dialogs Count: 0
Active Tasks Count: 0
Average Configured Media per Agent Count: 0
Average Logged in Media per Agent Count: 0
Average Skill Groups per Agent Count: 0
```
Max Skill Groups per Agent Count: 0
Total Time for Finesse to Start (in seconds): 32
Logged in Agents on current node: 0
Unique Configured Skill Groups per Agent Count: 0

For more information, see RuntimeConfigInfo API Parameters section in the Cisco Finesse Web Services Developer Guide at https://developer.cisco.com/docs/finesse/.

Desktop Properties

Configure the desktop properties using the following CLIs for the features.

Note
Refresh the browser for the changes to take effect.

Active Call Details in the Team Performance Gadget
Use the following CLI commands to enable or disable the active call details.

• To enable: `utils finesse set_property desktop showActiveCallDetails true`
• To disable: `utils finesse set_property desktop showActiveCallDetails false`

View History in the Team Performance Gadget
Use the following CLI commands to enable or disable the agent history.

• To enable: `utils finesse set_property desktop showAgentHistoryGadgets true`
• To disable: `utils finesse set_property desktop showAgentHistoryGadgets false`

Force Wrap-Up Reason
Use the following CLI commands to enable or disable the force wrap-up reason.

• To enable: `utils finesse set_property desktop forceWrapUp true`
• To disable: `utils finesse set_property desktop forceWrapUp false`

Show Wrap-Up Timer
Use the following CLI commands to show or hide the timer in wrap-up state. By default, the value of this property is set to true.

• To hide the timer in wrap-up state: `utils finesse set_property desktop showWrapUpTimer false`
• To display the timer in wrap-up state: `utils finesse set_property desktop showWrapUpTimer true`

Wrap-Up Timer Count Down
Use the following CLI commands to set the wrap-up timer to count down or count up the time. By default, the value of this property is set to true.

• To count up the time: `utils finesse set_property desktop wrapUpCountDown false`
• To count down the time: `utils finesse set_property desktop wrapUpCountDown true`
Notification Connection Type

Use the following CLI commands to update the desktop notification connection type as WebSockets or BOSH. By default the connection type is WebSockets.

- For WebSockets: `utils finesse set_property desktop notificationConnectionType websocket`
- For BOSH: `utils finesse set_property desktop notificationConnectionType bosh`

Desktop Chat Attachment

Use the following CLI commands to enable or disable the attachment support in Desktop Chat. Attachments are enabled by default in Desktop Chat.

- To enable: `utils finesse set_property desktop desktopChatAttachmentEnabled true`
- To disable: `utils finesse set_property desktop desktopChatAttachmentEnabled false`

Desktop Chat Maximum Attachment Size

Use the following CLI commands to configure the attachment size in Desktop Chat. If you do not configure the maximum attachment size, then it is set to 5 MB by default.

- `utils finesse set_property desktop desktopChatMaxAttachmentSize Attachment Size`
  
  For example, to set the maximum attachment size to 2 MB, use:
  
  `utils finesse set_property desktop desktopChatMaxAttachmentSize 2097152`

  
  **Note**

  The maximum attachment size configurable is up to 10 MB.

Desktop Chat Unsupported File Types

The .exe, .msi, .sh, and .bat file types are not supported by default. Use the following CLI commands to override the default list and customize the file types that will not be supported in the Desktop Chat. Multiple file types can be added using a comma separated string.

- `utils finesse set_property desktop desktopChatUnsupportedFileTypes File Types`
  
  For example, to set the .jar and .bin as unsupported file types, use:
  
  `utils finesse set_property desktop desktopChatUnsupportedFileTypes jar,bin`

Automatic Desktop Login Retries

Cisco Finesse supports automatic desktop login retries when the desktop login fails due to device-related errors. The following properties allow the administrator to control how this feature behaves. By default, the value of this property is set to true.

- To enable: `utils finesse set_property desktop enableRetryLoginFeature true`
  
  If this feature is enabled, then you can define the retry attempts and intervals.
  
  - To set attempts: `utils finesse set_property desktop loginFailureRetryAttempts <value>`
    
    The maximum retry attempts is 10. Default value is 3.
  
  - To set intervals: `utils finesse set_property desktop loginFailureRetryInterval <value>`
The login retry has a configurable amount of delay between each retry to allow the device to recover. The minimum and maximum interval between retries is 15-180 seconds. Default value is 60 seconds.

**Note** Reducing the retry interval increases the load on the system when there is a system-wide outage of devices.

- To disable: `utils finesse set_property desktop enableRetryLoginFeature false`

Enable or Disable Keyboard Shortcuts

Use the following CLI commands to enable or disable the keyboard shortcuts for the Finesse agent and supervisor desktop. By default, the value of this property is set to true.

- To enable: `utils finesse set_property desktop enableShortCutKeys true`
- To disable: `utils finesse set_property desktop enableShortCutKeys false`

Enable or Disable Drag-and-Drop and Resize for a Gadget or Component

Use the following CLI commands to enable or disable the drag-and-drop and resize features for a gadget or component in the Finesses desktop. By default, the value of this property is set to false.

- To enable: `utils finesse set_property desktop enableDragDropAndResizeGadget true`
- To disable: `utils finesse set_property desktop enableDragDropAndResizeGadget false`


Enable or Disable Preloading of the Secondary Resources

Use the following CLI commands to enable or disable the preloading of the secondary server resources from the alternate side during desktop sign in. The resources that are preloaded are: images, CSS, JS, and HTML. The preloading reduces latency and improves performance during desktop failover. By default, the value of this property is set to true.

- To enable: `utils finesse set_property desktop preLoadSecondaryResources true`
- To disable: `utils finesse set_property desktop preLoadSecondaryResources false`

Security Banner Message for Desktop Users

Cisco Finesses supports custom banner messages in the desktop Sign In page. The administrator defines the banner message for Finesses desktop users so that they are aware of the security policy while using Cisco Finesses. The banner message can have a maximum of 220 characters. It supports both alphanumeric and special characters. By default, the banner message is not displayed.

- To add the security banner message to the desktop Sign In page: `utils finesse set_property desktop desktopSecurityBannerMessage <value>`

The following example displays the sample security banner that is defined for desktop Sign In page.

```bash
admin:utils finesse set_property desktop desktopSecurityBannerMessage "IMPORTANT: Finesses may only be accessed by authorized users!"
```
Property successfully updated.
Ensure property is updated in all Finesse nodes in the cluster.

No service restart required. Ensure browser is refreshed for the changes to take effect.

- To remove the security banner message in the desktop Sign In page: `utils finesse set_property desktop desktopSecurityBannerMessage ""

**Dual-Tone Multi Frequency (DTMF) Desktop Behaviour**

The **Wrap-Up** button and the call control buttons **Hold**, **Transfer**, **Consult**, and **End** are disabled across all calls when DTMF **Keypad** is opened, and until the responses to all DTMF requests are completed or have timed out.

**DTMF Pending Requests Threshold Count**

When the network or the server is slow to respond, then the response to DTMF requests are delayed. DTMF keypad prevents new operations when more than a configured number of outstanding responses are pending. The default value is 20.

- To configure the DTMF threshold count for pending requests: `utils finesse set_property desktop pendingDTMFThresholdCount <value>`

  The following example displays the sample DTMF threshold count.
  ```
  admin:utils finesse set_property desktop pendingDTMFThresholdCount 15
  ```

  Property successfully updated.
  Ensure property is updated in all Finesse nodes in the cluster.

  No service restart required. Ensure the desktop browser is refreshed for the changes to take effect.

**DTMF Request Timeout**

Cisco Finesse waits for a configured time for each DTMF request. The default timeout is 5 seconds.

- To configure the DTMF timeout for pending requests: `utils finesse set_property desktop dtmfRequestTimeoutInMs <value>`

  The timeout value must be entered in milliseconds.

  The following example displays the sample DTMF timeout count.
  ```
  admin:utils finesse set_property desktop dtmfRequestTimeoutInMs 4000
  ```

  Property successfully updated.
  Ensure property is updated in all Finesse nodes in the cluster.

  No service restart required. Ensure the desktop browser is refreshed for the changes to take effect.

**WebProxy Service**

WebProxy Service acts as a transparent reverse proxy between external clients and the Finesse service. It provides SSL termination and caching services to the Finesse server to reduce latency and improve performance.
Configuration changes done on the Finesse server may not be immediately available to the clients due to the intermediary webproxy cache. The administrator can clear the intermediary webproxy cache using `utils webproxy cache clear`.

WebProxy cache is automatically cleared when you restart the Finesse Tomcat service. Static resources (images and scripts), Shindig gadget XML, and resources are cached until the Finesse Tomcat service is restarted or explicitly cleared by the administrator.

For more information on REST API Response Caching, see *REST API Developer Guide* at https://developer.cisco.com/docs/finesse/.

The logging level of the WebProxy Service is managed using the web proxy log-levels CLI.

---

**Note**

WebProxy Service CLIs are node-specific and must be executed on all nodes in the cluster.

Proxy cache bypassing reduces performance and must be used for debugging purposes during the gadget development or troubleshooting.

Server cache for the Finesse API can be bypassed by including `bypassServerCache=true` as a query parameter in the request or clear server cache using `utils webproxy cache clear`.

Server cache for the Finesse desktop can be bypassed by including `bypassServerCache=true&nocache` as a query parameter in the desktop URL.

---

### utils webproxy cache clear

This command clears the cache from the WebProxy Service.

**Command Syntax**

```
utils webproxy cache clear {all | webproxy | desktop | rest | shindig | notification_service}
```

**Options**

- `all`—Clears all the configured caches.
- `webproxy`—Clears the default webproxy cache.
- `desktop`—Clears the desktop cache. The desktop cache contains static HTML, CSS, scripts, and icons used in the Finesse desktop.
- `rest`—Clears the REST APIs cache. The REST API responses cached are:
  - `MediaDomain`
  - `TeamResource APIs` include `ReasonCodes`, `WrapUpReasons`, `MediaPropertiesLayouts`, `PhoneBooks`, and `WorkFlows`. The responses of the TeamResource API are cached at the team-level.
- `shindig`—Clears the Shindig cache. The Shindig cache contains XML gadget definition (ifr request-response) and gadget resources (concat request-response).
- `notification_service`—Clears the Notification Service cache. The Notification Service cache contains scripts and HTML used by the Finesse desktop to connect to notification service.

**Command Modes**
set webproxy access-log-level

This command sets the log-level for the access logs generated by the WebProxy Service. The access logs record information about all external requests that reach the proxy. The requests are logged in the access log after the request is processed.

**Command Syntax**

```
set webproxy access-log-level {off | info | debug}
```

**Options**

- **off**—Turns off the logging into the access logs of the WebProxy Service.
- **info**—Sets the log-level for access logs of the WebProxy Service to information. This captures the data of each request such as time, client, host, user, and so on.
- **debug**—Sets the log-level for access logs of the WebProxy Service to debug. This captures the detailed data of each request for debugging.

**Note**

Setting the access logs to debug impacts performance. Hence, avoid using in the production deployment.

**Command Default**

The default value is `off`.

**Command Modes**

Administrator (admin)

**Requirements**

Command privilege level: 1
Allowed during upgrade: Yes
Applies to: Unified CCE, Unified CCX, Packaged CCE and HCS for Contact Center

**Example**

```
admin:utils webproxy cache clear desktop
Successfully cleared desktop cache

admin:set webproxy access-log-level off
Webproxy access log-level is turned off
```
set webproxy log-severity

This command sets the severity of the error logs that are generated by the WebProxy Service. The error logs record information about encountered issues of different severity levels.

Command Syntax

`set webproxy log-severity {debug | warn | error | crit | alert | emerg}`

Options

- `debug`—Sets the severity level to debug.

  ![Note](image)

  **Note** Setting the error logs to debug impacts performance. Hence, avoid using in the production deployment.

- `warn`—Sets the severity level to warning.
- `error`—Sets the severity level to error.
- `crit`—Sets the severity level to critical.
- `alert`—Sets the severity level to alert.
- `emerg`—Sets the severity level to emergency.

Command Default

The default value is `warn`.

Command Modes

Administrator (admin)

Requirements

Command privilege level: 1

Allowed during upgrade: Yes

Applies to: Unified CCE, Unified CCX, Packaged CCE and HCS for Contact Center

Example

```
admin:set webproxy log-severity warn
Successfully set webproxy log severity to warn
Service restarted
```

show webproxy access-log-level

This command displays the configured log-level for the access logs of the WebProxy Service.

Command Syntax

```
show webproxy access-log-level
```
Command Modes
Administrator (admin)

Requirements
Command privilege level: 1
Allowed during upgrade: Yes
Applies to: Unified CCE, Unified CCX, Packaged CCE and HCS for Contact Center

Example
admin:show webproxy access-log-level
Current webproxy access log-level is: info

show webproxy log-severity
This command displays the configured severity level for the error logs of the WebProxy Service.

show webproxy log-severity

Command Modes
Administrator (admin)

Requirements:
Command privilege level: 1
Allowed during upgrade: Yes
Applies to: Unified CCE, Unified CCX, Packaged CCE and HCS for Contact Center

Example
admin:show webproxy log-severity
Current webproxy log-severity is: warn

Service Properties
Configure the service properties using the following CLIs for the features.

Note
The CLIs require Cisco Finesse Tomcat restart except for desktop related properties.

Security Banner Message for Administrators
Cisco Finesse supports custom banner messages in the administration Sign In page. The administrator defines the banner message for the users so that they are aware of the security policy while using Cisco Finesse. The banner message can have a maximum of 220 characters. It supports both alphanumeric and special characters. By default, the banner message is not displayed.

- To add the security banner message to the administrator Sign In page: utils finesse set_property admin adminSecurityBannerMessage <value>

The following example displays the sample security banner that is defined for the administrator Sign In page.
admin:utils finesse set_property admin adminSecurityBannerMessage "IMPORTANT: Finesse may only be accessed by authorized users!"

Property successfully updated.
Ensure property is updated in all Finesse nodes in the cluster.

Restart Cisco Finesse Tomcat Service for the changes to take effect:
utils service restart Cisco Finesse Tomcat

- To remove the security banner message in the administrator Sign In page: utils finesse set_property admin adminSecurityBannerMessage ""

Enable or Disable Plain XMPP Socket—Port 5222

Use the following CLI commands to enable or disable the Cisco Unified CCX Notification Service plain XMPP port (5222). This port can be enabled only if you have third-party solutions that connect directly to the Cisco Unified CCX Notification Service over plain Transmission Control Protocol (TCP) connection. This port is not required for the Finesse desktop or BOSH/WebSocket based integrations. By default, the port is disabled.

- To enable: utils finesse set_property webservices enableInsecureOpenfirePort true
- To disable: utils finesse set_property webservices enableInsecureOpenfirePort false

Enable or Disable Secure XMPP Socket—Port 5223

Use the following CLI commands to enable or disable the external access to the Cisco Unified CCX Notification Service TCP-based XMPP port (5223). The port must be enabled for external client connectivity only if you have third-party solutions that connect directly to the Cisco Unified CCX Notification Service over this port. By default, the port is enabled (value is set to true).

- To enable: utils finesse set_property webservices enableExternalNotificationPortAccess true
- To disable: utils finesse set_property webservices enableExternalNotificationPortAccess false

Restart Cisco Finesse Tomcat and Cisco Finesse Notification Services for the changes to take effect.

Enable or Disable Enforcement of X.509 Certificate Trust Validation

Use the following CLI commands to enable or disable the validation of the X.509 CA or the self-signed certificate. From Release 12.5(1) onwards, Cisco Finesse validates SSL certificates of all the servers (CUCM and Customer Collaboration Platform) it communicates. This requires the custom CA providers or the self-signed certificates of the server it communicates to be present in the Cisco Finesse Tomcat trust store. If the certificates are not added into the Cisco Finesse trust store, then certain interactions can fail. It is advised to add the certificates into the Cisco Finesse trust store. If any user chooses to ignore the validation, enforcement can be turned off. This CLI allows users to disable or enable validation. By default, the validation is turned on.

- To enable: utils finesse set_property webservices trustAllCertificates true
- To disable: utils finesse set_property webservices trustAllCertificates false
Enable or Disable Call Variables Logging

Use the following CLI commands to enable or disable the call variables logging. The callVariables contain sensitive user information and this property allows the administrator to decide whether the information must be captured in the logs. By default the property is disabled.

- To enable:
  ```
  utils finesse set_property webservices logCallVariables true
  utils finesse set_property fippa logCallVariables true
  ```
- To disable:
  ```
  utils finesse set_property webservices logCallVariables false
  utils finesse set_property fippa logCallVariables false
  ```

Cross-Origin Resource Sharing (CORS)

CORS support to third-party web server is disabled by default for Cisco Finesse and OpenFire. Use the following CLIs to enable CORS for Cisco Finesse and OpenFire and configure the allowed origin list:

**Note**
CORS support to third-party clients is enabled for all origins by default in Cisco Finesse and OpenFire. This corresponds to the **enable_all** mode below.

**Important**
After you make changes to the CORS status or to the allowed origin list, restart Cisco Finesse Tomcat and Notification Services for changes to take effect.

- **utils finesse cors enable_all**: This command allows all origins to make cross domain requests. It responds and allows CORS preflight requests from any domain to make Finesse API/OpenFire requests.
  
  **Note**
  This is not a secure configuration and is included only to support backward compatibility.

- **utils finesse cors enable**: This command allows CORS for Cisco Finesse APIs and OpenFire requests for allowed origin list. It responds to browser CORS preflight requests and allows valid domains to make Finesse API/OpenFire requests.
  
  **Note**
  Use the **utils finesse cors allowed_origin** CLI to customize the allowed origin list. Any custom headers used in the CORS requests have to be added using **utils finesse cors allowed_headers** CLI.
• **utils finesse cors disable**: This command restricts CORS for Cisco Finesse APIs and OpenFire requests. It disallows or prevents CORS preflight requests from any external domain to make Finesse API and OpenFire requests.

  __Note__  
  If allowed origin list is already present, then the list is preserved and used when CORS is enabled. Note that the CLI changes are reflected only after you clear your cache and close and re-open the browser.

• **utils finesse cors status**: This command displays the CORS status (enable_all, enabled, or disabled) on the console.

  For allowing any other header, the following set of CLI commands are added to enable CORS for both Cisco Finesse and OpenFire and configure the allowed origin list:

  • **utils finesse cors allowed_origin list**: This command lists all the origins in the allowed origin list.

  • **utils finesse cors allowed_origin add**: This command adds origins to the allowed origin list. Origins can be added by using a comma separated string. For example:

    ```
    utils finesse cors allowed_origin add https://origin1.com:[port]
    utils finesse cors allowed_origin add https://origin1.com:[port],https://origin2.com:[port]
    ```

      __Note__  
      Wildcard character * is not a valid origin in the allowed origin list.

  • **utils finesse cors allowed_origin delete**: This command deletes origins from the allowed origin list.

  ```
  Delete will list all the origins in the allowed origin list, of which origins can be deleted by selecting the correct choice. For example:
  ```

  ```
  utils finesse cors allowed_origin delete
  1: http://google.com
  2: https://www.cisco.com
  3: https://def.com
  4: https://abc.com:7777
  a: all
  q: quit
  Select the index of origin(s) to be deleted [1-4 or a,q]
  ```

  By default the following headers are allowed and exposed:

  • **allowed_headers**: Content-Type,X-Requested-With,accept,Origin,Authorization,Access-Control-Request-Method,Access-Control-Request-Headers,requestId,Range.

---

**Note**  These headers cannot be modified. Custom headers can be added or removed using the following CLIs:

- **utils finesse cors allowed_headers list**: This command lists all the allowed headers for CORS. The list is used to validate incoming requests to Finesse.

- **utils finesse cors allowed_headers add**: This command adds one or more allowed headers for CORS. Multiple headers can be added as a comma separated string. For example:

  ```
  utils finesse cors allowed_headers add header1
  utils finesse cors allowed_headers add header1,header2,header3
  ```

  **Note**  Wildcard character * is not supported.

- **utils finesse cors allowed_headers delete**: This command lists the choices for deleting the allowed headers. The choice should be an index as displayed in the list of allowed headers. The list provides the option to delete a single header or all configured custom headers. For example:

  ```
  utils finesse cors allowed_headers delete
  1: header1
  2: header2
  a: all
  q: quit
  ```

  Select the index of allowed header to be deleted [1-2 or a,q]: 1

- **utils finesse cors exposed_headers list**: This command lists all the exposed headers for CORS. The list will be used by the browser to validate the accessible headers in the response.

- **utils finesse cors exposed_headers add**: This command adds one or more exposed headers for CORS. Multiple headers can be added by a comma separated string. For example:

  ```
  utils finesse cors exposed_headers add header1
  utils finesse cors exposed_headers add header1,header2,header3
  ```

  **Note**  Wildcard character * is not supported

- **utils finesse cors exposed_headers delete**: This command lists the choices for deleting the exposed headers. The choice should be an index as displayed in the list of allowed headers. The list provides option to delete a single header or all configured custom headers. For example:

  ```
  utils finesse cors exposed_headers delete
  1: header1
  ```
2: header2
a: all
q: quit
Select the index of exposed header to be deleted [1-2 or a,q]: 1

All CLIs are node specific and must be executed on all nodes in the cluster.

Gadget Source Allowed List

Shindig proxies requests from the Finesses desktop to external servers and this introduces the possibility of server side request forgery (SSRF). To prevent SSRF, you can choose to allow outgoing connections for specified sources to be used in the gadgets by adding URLs to the allowed list. Note that this functionality is disabled by default for Cisco Finesse.

Use the following CLIs to enable or disable Gadget Source allowed list functionality and to configure source(s) in the allowed list:

- `utils finesse gadget_source_check enable`: This command enables allowed list for Cisco Finesse.
- `utils finesse gadget_source_check disable`: This command disables allowed list for Cisco Finesse.
- `utils finesse gadget_source_check status`: This command prints the allowed list status (enabled or disabled) on Cisco Finesse console.
- `utils finesse gadget_source_check allowed_list list`: This command lists all the source(s) in the allowed list.
- `utils finesse gadget_source_check allowed_list add`: This command adds source(s) to the allowed list. For Example,
  - `utils finesse gadget_source_check allowed_list add https://www.abc.com:8445`

Note

Wildcard character * is not supported.

The allowed list feature will not perform hostname resolutions. The format of the allowed list entry should match the format in which the gadget requests for a resource.

- `utils finesse gadget_source_check allowed_list delete`: This command deletes source(s) from the allowed list. For Example:
  - `utils finesse gadget_source_check allowed_list delete`
    1: http://origin1:8080
    2: https://origin2:7777
    a: all
q: quit

Select the index of origin to be deleted [1-2 or a,q]: 1

---

Note

All CLIs are node-specific and must be executed on all nodes in the cluster.
After any changes are done to gadget source status or to the allowed list, restart Cisco Finesse Tomcat for changes to take effect.

---

Log Collection Schedule

Use the following CLIs to create, list, and delete automatic desktop log collection schedules for agents and supervisors. This can also be used for debugging purposes.

**utils finesse desktop_auto_log_collection create:** This command creates a schedule that collects the agent's browser logs. You can create up to five log collection schedules for up to 15 agents.

While creating the log schedule, specify the agent IDs, log collection interval, and duration up to when the logs are to be collected.

The log collection interval and the duration have to be between 30 to 900 seconds. The logs that are collected during the schedule are received in a .zip file format. The logs are collected at: /opt/cisco/desktop/logs/clientlogs.

**Example:**

```
admin:utils finesse desktop_auto_log_collection create

Initializing command line interface...
Checking Cisco Finesse Tomcat status...

Enter agent IDs to continue. (Maximum 15 agents) [Example : 1001001,1001002] : 1001002
Agent IDs entered: 1001002
Enter duration in seconds.(value between 30 and 900) : 240
Duration entered: 240
Enter interval in seconds.(value between 30 and 240) : 60
Interval entered: 60

Successfully scheduled client log collection for the specified agent(s).

Ensure the same is enabled in all the Finesse nodes in the cluster..
```

**utils finesse desktop_auto_log_collection list:** This command lists all active log collection schedules.

**Example:**

```
admin:utils finesse desktop_auto_log_collection list

Initializing command line interface...
Checking Cisco Finesse Tomcat status...
These are the live log collection schedules:

Schedule ID:1 Created At: Thu Jun 6 23:23:53 PDT 2019
Duration: 240 seconds
Frequency: 60 seconds
Agent Ids: 1001002
```
**utils finesse desktop_auto_log_collection delete**: This command deletes the active log collection schedules. When this command is executed, all the active log collection schedules are displayed and you are prompted to enter the Schedule ID that you want to delete.

Example:

```
admin:utils finesse desktop_auto_log_collection delete

Initializing command line interface...
Checking Cisco Finesse Tomcat status...
These are the live log collection schedules:

Schedule ID:1 Created At: Thu Jun 6 23:23:53 PDT 2019
Duration: 240 seconds
Frequency: 60 seconds
Agent Ids: 1001002
Enter schedule ID to delete (enter 'all' to delete all): 1
Schedule ID entered: 1

Successfully deleted the log collection with schedule id : 1
```

**View Property**

Use the following CLIs to view the property values across all property files.

- `utils finesse show_property fippa property_name`: To view the specified Finesse IPPA property's value.

- `utils finesse show_property desktop property_name`: To view the specified desktop property's value.

- `utils finesse show_property webservices property_name`: To view the specified web service property's value.

- `utils finesse show_property admin securityBannerMessage`: To view the specified banner message for the administrator Sign In page.

**Note**

The View property CLIs do not support multiple values.

**Update Property**

Use the following CLIs to update the property values across all property files.

- `utils finesse set_property desktop property_name property_value`: To update an existing property value used by the Finesse desktop service.

- `utils finesse set_property fippa property_name property_value`: To update an existing property value used by the Finesse IPPA service.

- `utils finesse set_property webservices property_name property_value`: To update an existing property value used by the Finesse web service.

- `utils finesse set_property admin adminSecurityBannerMessage`: To update an existing property value used by the Finesse administrator for the security banner message.
Cisco Unified Intelligence Center Commands

show cuic component-status

This command shows the status of the Unified Intelligence Center components. The Component name parameter is mandatory.

Command syntax
show cuic component-status Component name

Component name
• CuicStatus—Shows status of Unified Intelligence Center web engine and the DB replication
• DBRepStatus—Shows status of database replication on this node
• DBStatus—Shows the database status
• SchedulerStatus—Shows status of the report scheduler

Requirements
Level privilege: 0
Command privilege level: 0
Allowed during upgrade: No

Example
admin:show cuic component-status EmailStatus

show cuic properties

This command shows information about Cisco Unified Intelligence Center properties.

Command syntax
show cuic properties [options]

Options
• host-to-ip—Current host-to-IP translation for the Cisco Unified Intelligence Center databases in the cluster
• purge-retention—Number of days data is retained in the Cisco Unified Intelligence Center database before it is purged
• purge-time—Time of day and the regular interval in minutes when the Cisco Unified Intelligence Center database is purged
• session-timeout—Session timeout for the Cisco Unified Intelligence Center web applications
show cuic properties dashboard-customwidget-enabled—Displays the value on or off depending on the current value set for the dashboard-customwidget-enabled property. This value can be set using the CLI set cuic properties dashboard-customwidget-enabled.

Requirements
Level privilege: 0
Command privilege level: 0
Allowed during upgrade: Yes

Example

```
admin:show cuic properties purge-retention
purge_retention
==============
1
```

show cuic tech

Command syntax
This command provides technical details on the Cisco Unified Intelligence Center setup, such as database tables, triggers, procedures and so on.

show cuic tech procedures
This command displays the stored procedures in use for the database.

show cuic tech systables
This command displays the names of all the tables in the Unified Intelligence Center database.

show cuic tech dbschema
This command displays the database schema in a CSV file. This displays output to a .csv file.

show cuic tech table table_name
The command shows the contents of a table on the Unified Intelligence Center database. This displays output to a .out file.

show cuic tech triggers
This command displays Unified Intelligence Center table names and the triggers associated with those tables.

show cuic tech table cuicreport
This command redirects the contents of the specified database table into a file.

Requirements
Level privilege: 1
Command privilege level: 1
Allowed during upgrade: No

Example
admin:show cuic tech dbschema
------------show cuic tech dbschema--------------
Database schema
Output is in /cm/trace/dbi/dbSchema1331705967878.csv
Use "file view activelog/cm/trace/dbi/dbSchema1331705867878.csv" command to see output

admin:show cuic tech systables
--------Show cuic tech system tables---------
SYSTEM TABLES

<table>
<thead>
<tr>
<th>tabname</th>
</tr>
</thead>
<tbody>
<tr>
<td>GL_COLLATE</td>
</tr>
<tr>
<td>GL_CTYPE</td>
</tr>
<tr>
<td>VERSION</td>
</tr>
<tr>
<td>cdr_deltab_000657</td>
</tr>
<tr>
<td>cdr_deltab_000658</td>
</tr>
<tr>
<td>cdr_deltab_000659</td>
</tr>
<tr>
<td>cdr_deltab_000660</td>
</tr>
<tr>
<td>cdr_deltab_000661</td>
</tr>
<tr>
<td>cdr_deltab_000662</td>
</tr>
<tr>
<td>cdr_deltab_000663</td>
</tr>
<tr>
<td>cdr_deltab_000664</td>
</tr>
<tr>
<td>cdr_deltab_000665</td>
</tr>
<tr>
<td>cdr_deltab_000666</td>
</tr>
<tr>
<td>cdr_deltab_000667</td>
</tr>
<tr>
<td>cdr_deltab_000668</td>
</tr>
<tr>
<td>cdr_deltab_000669</td>
</tr>
<tr>
<td>cdr_deltab_000670</td>
</tr>
<tr>
<td>cdr_deltab_000671</td>
</tr>
<tr>
<td>cdr_deltab_000672</td>
</tr>
<tr>
<td>cdr_deltab_000673</td>
</tr>
<tr>
<td>cdr_deltab_000674</td>
</tr>
</tbody>
</table>

admin:show cuic tech table ?
Syntax:
  show cuic tech table table_name
  table_name mandatory table name

admin:show cuic tech triggers
-----------show cuic tech triggers----------
Triggers

<table>
<thead>
<tr>
<th>tablename</th>
<th>trigger</th>
</tr>
</thead>
<tbody>
<tr>
<td>cuiccategory</td>
<td>tr_del_category</td>
</tr>
<tr>
<td>cuiccategory</td>
<td>tr_ins_category</td>
</tr>
<tr>
<td>cuiccategory</td>
<td>tr_upd_category</td>
</tr>
<tr>
<td>cuiccollection</td>
<td>tr_del_collection</td>
</tr>
<tr>
<td>cuiccollection</td>
<td>tr_ins_collection</td>
</tr>
<tr>
<td>cuiccollection</td>
<td>tr_upd_collection</td>
</tr>
<tr>
<td>cuicdashboard</td>
<td>tr_del_dashboard</td>
</tr>
<tr>
<td>cuicdashboard</td>
<td>tr_ins_dashboard</td>
</tr>
<tr>
<td>cuicdashboard</td>
<td>tr_upd_dashboard</td>
</tr>
<tr>
<td>cuicdatasource</td>
<td>tr_del_datasource</td>
</tr>
<tr>
<td>cuicdatasource</td>
<td>tr_ins_datasource</td>
</tr>
<tr>
<td>cuicdatasource</td>
<td>tr_upd_datasource</td>
</tr>
<tr>
<td>cuicreport</td>
<td>tr_del_report</td>
</tr>
<tr>
<td>cuicreport</td>
<td>tr_ins_report</td>
</tr>
</tbody>
</table>
show cuic trace

This command shows the log level and trace masks of the given subsystem. If the logging level is set to DEBUG, the trace mask is displayed. If the logging level is set to INFO, the trace masks are not displayed.

The command is case sensitive and can only be run on the Controller node.

To set traces on the member nodes, use the Operations Console command Device Management > Log And Trace Settings.

Command syntax

show cuic trace cuicserver [options]

Options

This consists of the subsystems of Unified Intelligence Center. The various subsystems available are:

• CUIC
• Infrastructure
• CUIC_MODEL_OBJECTS
• CUIC_DATA_PROCESSING
• CUIC_SECURITY
• CUIC_DISPLAY
• CUIC_MIGRATION
• CUIC_USER_HISTORY
• CUIC_JSP
• CUIC_STATISTICS

Requirements

Level privilege: 0
Command privilege level: 0
Allowed during upgrade: No

Example

admin:show cuic trace cuicserver Infrastructure
Log levels are not set - assumed to be Basic
Since log level is basic trace masks are not in effect for Infrastructure
**set cuic properties**

Use these commands to set values for the Unified Intelligence Center database and session timeout.

**Command syntax**

`set cuic properties host-to-ip`

**Parameter**

- **host**—Enter the value for the host DNS name for the server, as displayed on the Data Sources interface.
- **ip_address**—Enter the IP address of the server for the historical or real-time database.

`set cuic properties session-timeout`

**Parameter**

- **#number of Seconds**—This command sets the session timeout for the Unified Intelligence Center Reporting web application. The default is 14,400 seconds (4 hours).

**Requirements**

- Level privilege: 0
- Command privilege Level: 0
- Allowed during upgrade: Yes

**Example**

```
admin:set cuic properties session-timeout 1900
Value has been successfully set
```

`set cuic properties dashboard-customwidget-enabled`

**Parameter**

- **on/off**—This command sets the dashboard-customwidget-enabled property to *on* or *off*. By setting the value to *on* or *off*, you can enable or disable the Custom Widget feature in Dashboards respectively. By default, the value is set to *off*.

---

**Note**

Enabling the custom widget configuration can lead to injection vulnerabilities.

**unset cuic properties**

Use this command to unset the translation of host-to-IP hostname.

**Command syntax**

`unset cuic properties host-to-ip [hostname]`

**Requirements**

- Level privilege: 0
- Command privilege level: 0
- Allowed during upgrade: Yes
Example

```bash
admin:unset cuic properties host-to-ip ccxbox1
```

set cuic syslog

**Command syntax**

*set cuic syslog [disable|enable]*

**Options**

- **disable**—To disable Cisco Unified Intelligence Center application remote syslogs
- **enable**—To enable Cisco Unified Intelligence Center application remote syslogs

**Requirements**

- Level privilege: 0
- Command privilege level: 0
- Allowed during upgrade: Yes

Example

```bash
admin:set cuic syslog enable
```

set cuic trace

Use these commands to set or change the log levels and trace setting for the subsystems of two server processes (cuicserver and oampserver) to basic or detailed.

**Command Syntax**

- **set cuic trace basic cuicserver [subsystem] none**
- **set cuic trace infrastructure cuicserver [subsystem] [TRACE_FLAGS | none]**
- **set cuic trace subsystem cuicserver [subsystem] [trace_mask1 trace_mask2]**

For cuicserver, the valid subsystems are:

- Infrastructure
- CUIC
- CUIC_MODEL_OBJECTS
- CUIC_DATA_PROCESSING
- CUIC_SECURITY
- CUIC DISPLAY
- CUIC_MIGRATION
- CUIC_USER_HISTORY
- CUIC_JSP
Detailed log levels are set by enabling trace flags, which allows debug statements to appear in the logs. You can control debug tracing for specific functionalities (specified in the TRACE flag name), within specific subsystem components.

*basic* indicates to set a basic level of tracing. With this setting, messages and warnings are displayed.

*detailed* indicates to set a debug level and allows you to turn on tracing for specific components.

*subsystem* indicates the subsystem you are setting and displays the list of all valid subsystems.

*none* indicates that you do not want to set a flag for tracing.

**Requirements**

- Level privilege: 1
- Command privilege level: 1
- Allowed during upgrade: Yes

**Example**

```
admin:set cuic trace basic cuicserver CUIC_SECURITY
Log level updated successfully. Trace masks are cleared
```

## utils cuic purge

### Command Syntax

**utils cuic purge**

This command runs a manual purge of the cuic database tables. You might do this if you receive an alert that the database is nearing capacity and you do not want to wait for the daily automatic purge.

The tables purged are:

- CuicDataSetInfo
- CuicDataSet
- CuicReportDefinitionFilter
- CuicReportDefinitionFilterField
- CuicReportDefinitionFilterParameter
- CuicCollection
- CuicCollectionValue

This command prompts for the password of the administration user. When the password is confirmed, the purge runs immediately.

**Options**

- None

**Requirements**
Level privilege—1
Command privilege level—1
Allowed during upgrade—Yes

Example

```
admin:utils cuic purge
Executed Purge Successfully
```

**utils cuic user make-admin [user-name]**

In Single Sign-On (SSO) mode the **Application User** created during installation will not be able to access the Cisco Unified Intelligence Center application with administrator privileges. To enable the Cisco Unified CCX Administrator to have administrator privileges in Cisco Unified Intelligence Center as well, assign reporting capability first and then run this command to make this user the administrator.

After the Unified Intelligence Center user is made an Administrator using this CLI, this user looses Unified Intelligence Center Administrator capabilities after the upgrade.

Thus, this user would not be able to view all the reports that were available to view before the upgrade. The user would have access to reports based on the assigned role (Agent or Supervisor) and not as an Administrator. You must execute this CLI after the upgrade such that the user is made the Unified Intelligence Center Administrator.

---

**Note**

The domain must always be, **UCCX**.

In an HA deployment, the Cisco Unified Intelligence Center Reporting Service must be restarted on both the nodes.

**Command Syntax**

```
utils cuic user make-admin [user-name]
```

Tip: User name should be the complete user name, including the prefix, as listed in Cisco Unified Intelligence Center User List page.

**Options**

None

**Example**

```
admin:utils cuic user make-admin UCCX\ABCD
Command executed successfully.
```
utils cuic cluster show

This command shows the current cluster mode enabled on this node and the other member details.

Note
The member details are available only in the TCP/IP mode. The member details displayed are of the configured members and does not represent the cluster in real-time.

Command Syntax
utils cuic cluster show

utils cuic cluster mode

This command is used to switch the CUIC cluster join configuration from Multicast to TCP/IP and vice versa.

Note
After changing the cluster mode in all the nodes, restart “Cisco Unified Intelligence Center Reporting Service” in all the nodes starting from the publisher sequentially.

Command Syntax
utils cuic cluster mode

utils cuic cluster refresh

This command refreshes the cluster node information only when executed in the TCP/IP mode and must be executed when there is an addition or deletion of nodes to the CUIC cluster.

Command Syntax
utils cuic cluster refresh

utils cuic cors

Important
After you make changes to the CORS status, allowed origins list, exposed header, or allowed header, restart Cisco Intelligence Center Reporting Service for changes to take effect. All CLIs are node-specific and must be executed on all nodes in the cluster.

Command Syntax
utils cuic cors enable

This command enables Cross Origin Resource Sharing (CORS) support in Unified Intelligence Center.

Command Syntax
utils cuic cors disable

This command disables CORS support in Unified Intelligence Center.
Command Syntax
utils cuic cors status
This command displays the current CORS status in Unified Intelligence Center.

Command Syntax
utils cuic cors allowed_origin list
This command displays the list of allowed URLs that can make CORS requests to Unified Intelligence Center.

Command Syntax
utils cuic cors allowed_origin add <URL1,URL2,URL3>
Parameter: Comma-separated list of URLs (without spaces) that has to be added to the allowed origins list.
The URL format: http[s]://<hostname>[:port]
This command adds the given set of comma-separated URLs to the allowed origins list.

Command Syntax
utils cuic cors allowed_origin delete
This command prompts for a choice to delete a particular allowed origin URL or all the allowed origin URLs.
utils cuic cors allowed_origin delete
1. http://google.com
a: all
q: quit
Select the index of origin to be deleted [1-2 or a,q]

Command Syntax
utils cuic cors allowed_headers list
This command lists all the configured allowed headers for CORS. This list is used to validate incoming requests to CUIC.

Command Syntax
utils cuic cors allowed_headers add <header1,header2,header3>
Parameter: Comma-separated list of headers (without spaces) that have to be added to the allowed headers list.
This command adds one or multiple allowed headers for CORS. You can add multiple headers using a comma-separated string.

Command Syntax
utils cuic cors allowed_headers delete
This command prompts for a choice to delete a particular custom allowed header or all the custom allowed headers.
utils cuic cors allowed_headers delete
Command Syntax
utils cuic cors exposed_headers list
This command lists the response headers available for a client.

Command Syntax
utils cuic cors exposed_headers add <header1,header2,header3>
Parameter: Comma-separated list of headers (without spaces) that have to be added to the exposed headers list.
This command adds one or multiple exposed headers for CORS. You can add multiple headers using a comma-separated string.

Command Syntax
utils cuic cors exposed_headers delete
This command prompts for a choice to delete a particular custom exposed header or all the custom exposed headers.
utils cuic cors exposed_headers delete
1: header1
2: header2
a: all
q: quit
Select the index of exposed header to be deleted [1-2 or a, q]: 1

utils cuic logging list
This command lists the module and the logging level for the specified module. If a module name is specified, the logging level is displayed only for that module.

Command Syntax
utils cuic logging list [module-name]
Options
[module-name] - optional
Possible module names for which, the log levels can be printed are as follows:
REPORT, REPORTENGINE, REPORTDEFINITION, SCHEDULER, DASHBOARD, AUTHORIZATION, AUTHENTICATION, VALUELISTCOLLECTION, SECURITY, CUICUI, DATASOURCE, CUICCONFIG
utils cuic logging config set

This command sets the value for log file configuration.

**Command Syntax**
utils cuic logging config set [config-name] [config-value]

**Options**
- [config-name] - mandatory log file configuration name
  Valid configuration names are max-file-size and max-file-count. The maximum limit of max-file-size and max-file-count is 50 MB and 50 respectively.
- [config-value] - mandatory log file configuration value

utils cuic logging update

This command updates the log level for the given module name.

**Command Syntax**
utils cuic logging update [module-name] [log-level]

**Options**
- [module-name] - mandatory
  Possible module names are as follows:
  REPORT, REPORTENGINE, REPORTDEFINITION, SCHEDULER, DASHBOARD, AUTHORIZATION, AUTHENTICATION, VALUELISTCOLLECTION, SECURITY, CUICUI, DATASOURCE, CUICCONFIG
- [log-level] - mandatory
  New log level for the module. Valid log-level values are as follows:
  ERROR, WARN, INFO, DEBUG

utils cuic logging config show

This command prints the log file configuration.

**Command Syntax**
utils cuic logging config show [config-name]

**Options**
- [config-name] - mandatory log file configuration name
  Valid configuration names are max-file-size and max-file-count

utils cuic logging reset

This command resets any modifications done to the logging configuration to the default value. For all the modules, the default value is Info.
Command Syntax
utils cuic logging reset

Options
No parameters

Cloud Connect

utils cloudconnect list

Run this command to list all the services in your deployment.

Command Syntax
utils cloudconnect list

Requirements
Level privilege: 1
Command privilege level: 1
Allowed during upgrade: Yes

Example

<table>
<thead>
<tr>
<th>CONTAINER_ID</th>
<th>IMAGE REPO</th>
<th>TAGS</th>
<th>STATUS</th>
</tr>
</thead>
<tbody>
<tr>
<td>container_id1</td>
<td>image_name1:image_version1 1.0, Build582,latest</td>
<td>Running Up x 2 days ago</td>
<td>container_name1</td>
</tr>
<tr>
<td>container_id2</td>
<td>image_name2:image_version2 1.0, Build580,latest</td>
<td>Exited x ago 2 days ago</td>
<td>container_name2</td>
</tr>
</tbody>
</table>

utils cloudconnect details

Run this command to view details of the specified container in JSON format.

Command Syntax
utils cloudconnect details container_name

Arguments
container_name - Name of the container.

Requirements
Level privilege: 1
Command privilege level: 1
Allowed during upgrade: Yes
**utils cloudconnect start**

Run this command to start the specified container.

**Command Syntax**

`utils cloudconnect start container_name`

**Arguments**

`container_name` - Name of the container that has to be started.

**Requirements**

Level privilege: 1  
Command privilege level: 1  
Allowed during upgrade: Yes

**Example**

```
admin:utils cloudconnect start dataconn  
Starting the container dataconn ...  
Container dataconn is started successfully.
```

**utils cloudconnect stop**

Run this command to stop the specified container.

**Command Syntax**

`utils cloudconnect stop container_name`

**Arguments**

`container_name` - Name of the container that has to be stopped.

**Requirements**

Level privilege: 1  
Command privilege level: 1  
Allowed during upgrade: Yes

**Example**

```
admin:utils cloudconnect stop dataconn  
Stopping the container dataconn ...  
Container dataconn is stopped successfully.
```

**utils cloudconnect heap dump**

Run this command to generate the heap dump for the specified JVM-based container.

**Command Syntax**

`utils cloudconnect heap_dump container_name`
utils cloudconnect thread dump

Run this command to generate the thread dump for the specified JVM-based container.

Command Syntax

```plaintext
utils cloudconnect thread_dump container_name
```

Arguments

category_name - Name of the JVM-based container.

Requirements

Level privilege: 1

Command privilege level: 1

Allowed during upgrade: Yes

Example

```plaintext
admin:utils cloudconnect thread_dump dataconn
thread_dump file successfully created

The final output will be in
file:hybrid/log/dataconn/dataconr_threadDump_23_Nov_2019_11_33_08.txt

please use "file get activelog
hybrid/log/dataconn/dataconr_threadDump_23_Nov_2019_11_33_08.txt" command to download it
```
show cloudconnect dataconn config

Run this command to view configuration details of the Cloud Connect data connector in JSON format.

Command Syntax

show cloudconnect dataconn config

Requirements

Level privilege: 1
Command privilege level: 1
Allowed during upgrade: Yes

Example

admin:show cloudconnect dataconn config

Getting Configuration from CloudConnect Data Connector ...
Configuration accessed successfully.

{
    "DataConnConfig": {
        "connCfg": {
            "proxyEnabled": true,
            "proxyHost": "proxy.mycompany.com",
            "proxyPort": 8080
        },
        "connData": {
            "apiKey": "z9y8x7w6v5u4",
            "connUri": "https://analyzer.cisco.com/mytenant",
            "tenantId": "1234"
        },
        "lastUpdatedTimestamp": 1560514531713
    }
}

show cloudconnect dataconn status

Run this command to view the status of Cloud Connect Data Connector in JSON format.

Command Syntax

show cloudconnect dataconn status

Requirements

Level privilege: 1
Command privilege level: 1
Allowed during upgrade: Yes

Example

admin:utils cloudconnect dataconn show-status

Getting status of CloudConnect Data Connector ...
Status accessed successfully.
{
    "cluster": {
        "nodes": [
            {
                "address": "f2-uccx1.cisco.com",
                "status": "IN_SERVICE",
                "statusSince": 1560503785232
            }
        ]
    },
    "description": "status of this data connector node",
    "details": {
        "components": [
            {
                "details": {
                    "metric": {
                        "failureCount": 0,
                        "lastFailureTime": -1,
                        "lastSuccessTime": -1,
                        "successCount": 0,
                        "totalOperations": 0
                    }
                },
                "name": "ApiGateway",
                "status": "IN_SERVICE",
                "statusSince": 1560514531944
            },
            {
                "details": {
                    "isConfigWriter": true
                },
                "name": "ConfigurationService",
                "status": "IN_SERVICE",
                "statusSince": 156050379296
            }
        ]
    }
},

utils cloudconnect reinit services

Run this command on all nodes in the cluster to reconfigure the Cloud Connect services when Unified CCX IP Address/Hostname is changed.

Command Syntax

utils cloudconnect reinit services

Requirements

Level privilege: 1

Command privilege level: 1

Allowed during upgrade: Yes

Example
Running this CLI command will restart all the cloud connect services.

---

**set cloudconnect log_level**

Run this command to set log level for the specified container.

**Command Syntax**

```bash
set cloudconnect log_level container_name log_level
```

**Arguments**

- **container_name** - Name of the container.
- **log_level** - The log level for the specified container. Log level can be set to trace, debug, info, error, or warn.

**Requirements**

- Level privilege: 1
- Command privilege level: 1
- Allowed during upgrade: Yes

**Example**

```bash
admin:set cloudconnect log_level dataconn error
```

The log level will be changed to ERROR for the container dataconn within 30 seconds.

---

**set cloudconnect cherrypoint config**

Run this command to update the Cloud Connect Cherry point connector configuration details.

**Note:** When you execute this command, you are prompted to enter new configuration details. The current configuration details are displayed within [ ]. You can enter the new configuration details or retain the existing configuration.

**Note:** User input for Web URL Prefix must be a valid http or https url. The default value is https://nps.bz. For users upgrading Unified CCX, if the Web URL Prefix does not have a valid http or https url prefix, they must reconfigure Cloud Connect Cherry point to provide a valid url for Web URL Prefix.

**Note:**

**Command Syntax**

```bash
set cloudconnect cherrypoint config
```

**Requirements**
Level privilege: 1
Command privilege level: 1
Allowed during upgrade: Yes

Example

```
admin:set cloudconnect cherrypoint config
Fetching existing configuration...
Enter the Config details to be saved:
Desktop User (with Read Only Privileges): readonlyusername
Desktop User API Key []: apikey-ABCD1234EFGH5789!dummy
System User (with Read and Write Privileges): rewriteusername
System User API Key []: apikey-JKMLN12345OPQRST6789!dummy
Voice PIN Prefix: 1234
SIP URI Domain: cloudcherry.sip.twilio.com
Web URL Prefix: https://nps.bz
Deployment ID: CCX
Proxy Enabled(true/false) [false]: true
Proxy Host: proxyhost.domain.com
Proxy Port [0]: 5678
The config details updated successfully.
```

**show cloudconnect cherrypoint config**

Run this command to display the Cloud Connect Cherry point connector configuration details.

**Command Syntax**

`show cloudconnect cherrypoint config`

**Requirements**

- Level privilege: 1
- Command privilege level: 1
- Allowed during upgrade: Yes

**Example**

```
admin:show cloudconnect cherrypoint config
Fetching existing configuration...
Desktop User (with Read Only Privileges): readonlyusername
Desktop User API Key: ******
System User (with Read and Write Privileges): rewriteusername
System User API Key: ******
Voice PIN Prefix: 1234
SIP URI Domain: cloudcherry.sip.twilio.com
Web URL Prefix: cloudsurveyweb
Deployment ID: CCX
Proxy Enabled(true/false): true
Proxy Host: proxyhost.domain.com
Proxy Port: 5678
Last Updated Timestamp: 1577480741820
```

**utils cloudconnect cherrypoint test-connectivity**

Run this command to check connectivity to Cloud Cherry server.
Command Syntax

utils cloudconnect cherrypoint test-connectivity

Requirements

Level privilege: 1
Command privilege level: 1
Allowed during upgrade: Yes

Example

admin:utils cloudconnect cherrypoint test-connectivity
Cloudcherry Connectivity Test URL [https://api.getcloudcherry.com/api/]:
https://api.getcloudcherry.com/api/
Proxy Host: proxy.esl.cisco.com
Proxy Port: 8080
Connectivity check to https://api.getcloudcherry.com/api/ was successful.

Specific License Reservation Commands

license smart reservation enable

Use this command to enable the license reservation feature in Smart Licensing. Before running this command, ensure the following:

- Smart Licensing must be enabled.
- Smart Account must be enabled for reservation.
- Smart Licensing must be in unregistered state.

Command syntax

license smart reservation enable

Requirements

Level privilege: 1
Command privilege level: 1
Allowed during upgrade: No

Example

admin:license smart reservation enable
License reservation is enabled successfully.
Command successful.

Result: Smart Licensing is enabled and you can continue with the license reservation process.
With license reservation enabled, **Smart License Management** page, option to **Register**, update **Transport Settings** and other allied operations in Unified CCX Administration are not available for this product instance.

---

**license smart reservation request**

Use this command to initiate the license reservation request process. Before running this command, ensure the following:

- Enable command has been executed.

**Command syntax**

```
license smart reservation request
```

**Requirements**

- Level privilege: 1
- Command privilege level: 1
- Allowed during upgrade: No

**Example**

```
admin:license smart reservation request
License reservation requested successfully.
Reservation Request Code is: CB-ZUCCX:059d8a992467-AAwxxawE5-73
Use this code in Cisco SSM to obtain the Authorization Code.

Reserve the following License Names in Cisco SSM to use the associated features.

<table>
<thead>
<tr>
<th>SL NO.</th>
<th>LICENSE NAME</th>
<th>MANDATORY</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>CCX Flex Standard Seat 12.5</td>
<td>Yes, if standard agent seats are required.</td>
</tr>
<tr>
<td>2</td>
<td>CCX Flex Premium Seat 12.5</td>
<td>Yes, if premium agent seats are required.</td>
</tr>
<tr>
<td>3</td>
<td>CCX Inbound Port 12.5-Flex 12.5</td>
<td>Yes, if Advanced IVR ports are required.</td>
</tr>
<tr>
<td>4</td>
<td>CCX Outbound Port 12.5-Flex</td>
<td>Yes, if Outbound IVR ports are required.</td>
</tr>
</tbody>
</table>
```

**Result:** Reservation Request Code is generated. Use the code in Cisco SSM to generate the Authorization Code.

---

**license smart reservation install**

Use this command to install or update the license reservation. Before running this command, ensure the following:

- Request command has been executed.
- Authorization Code is obtained from Cisco SSM.
If you have already installed an Authorization Code and want to modify the reserved licenses, you must generate a new Authorization Code and run this command again.

**Note**

Command syntax

```
license smart reservation install "<authorization code >"
```

The `<authorization code>` has to be obtained from Cisco SSM. Ensure to put the Authorization Code in double quotes.

**Note**

Authorization Code is also available in a file. You cannot provide file name as the parameter. You must copy the entire content of the file and use it as Authorization Code.

After successfully installing the license reservation, restart the system.

**Requirements**

- Level privilege: 1
- Command privilege level: 1
- Allowed during upgrade: No

**Example 1: Install License Reservation for the First Time**

```
admin:license smart reservation install
"<specificPLR><authorizationCode><flag>A</flag><version>C</version>
<piid>4e0f17d0-4d83-4a74-8009-6e1a909f505a</piid><timestamp>1583227289333</timestamp>
<entitlements><entitlement><tag>regid.2019-06.com.cisco.CCX_FLEX_PREMIUM,12.5_0ecc396f-9a80-4b7b-a4c1-35011a2bc68f</tag><count>1</count><startDate>2020-Feb-26 UTC</startDate><endDate>2021-Feb-20 UTC</endDate><licenseType>TERM</licenseType><displayName>CCX Flex Premium Seat 12.5</displayName><tagDescription>CCX Flex Premium License</tagDescription><subscriptionID></subscriptionID></entitlement></entitlements><signature>MEYCIQDNodtb0VfzvyJfLenhGMCeprSELdAMXaCpsqW8e/mBBAihAIYXW+80inS9e+9JlOM5FzWbuJ93YnQM/yoSTcDwzst</signature><udi>P:UCCX,S:1f2b5461b8ed</udi><specificPLR>"
```

This operation has to be performed in maintenance window.

Continue (y/n)?y

License reservation is being installed. Please wait ...
License reservation is installed successfully. Reboot the system for the changes to take effect.

Command successful.

**Example 2: Update License Reservation**

```
admin:license smart reservation install
"<specificPLR><authorizationCode><flag>A</flag><version>C</version>
<piid>4e0f17d0-4d83-4a74-8009-6e1a909f505a</piid><timestamp>1583227289333</timestamp>
<entitlements><entitlement><tag>regid.2019-06.com.cisco.CCX_FLEX_PREMIUM,12.5_0ecc396f-9a80-4b7b-a4c1-35011a2bc68f</tag><count>1</count><startDate>2020-Feb-26 UTC</startDate>
```

Cisco Unified Contact Center Express Administration and Operations Guide, Release 12.5(1)
This operation has to be performed in maintenance window.
Continue (y/n)? y

License reservation is being installed. Please wait ...
License reservation is installed successfully. Reboot the system for the changes to take effect.
Confirmation Code is: 125ffe1b
Use this code in Cisco SSM to complete the license reservation update process.
Command successful.

Result: Unified CCX gets automatically refreshed with the reserved licenses.

Caution:
If the installed licenses are incorrect, all the critical services of the contact center will go down. Be cautious while reserving licenses and ensure that the appropriate licenses are reserved.

license smart reservation return

Use this command to return the license reservation if you have already installed the Authorization Code.

Command syntax
license smart reservation return

Requirements
Level privilege: 1
Command privilege level: 1
Allowed during upgrade: No

Example

admin:license smart reservation return

This command will return the license reservation and this product instance will transition back to the unregistered state.
Continue (y/n)? y

License reservation is being returned. Please wait ...
License reservation is returned successfully.
Reservation Return Code is:
Cb3AEN-61XgQW-YGBXWm-FqS16L-LFRQ7n-aHU9Y1-cJDQGL-DtZGhJ-2D3
Use this code in Cisco SSM to complete the reservation return process.
Command successful.

Result: Reservation Return Code is generated and the product instance will transition back to the unregistered state. Enter the code in Cisco SSM to return the reserved licenses to the virtual pool. The product instance will enter evaluation or evaluation expired mode.
The best practice is to restart the system after returning the reservation.

If the evaluation period has expired, this product instance will enter into enforcement mode. For more information on enforcement mode, see Cisco Unified Contact Center Express Features Guide at https://www.cisco.com/c/en/us/support/customer-collaboration/unified-contact-center-express/products-feature-guides-list.html.

**Note**

Use this command to return the license reservation if you have not yet installed the Authorization Code.

This command is primarily for executing before installing the Authorization Code. However, you can also execute this command after installing the Authorization Code.

**Command syntax**

```bash
license smart reservation return-authorization ""<authorization code>"
```

The `<authorization code>` that has to be obtained from Cisco SSM. Ensure to put the Authorization Code in double quotes.

**Requirements**

- Level privilege: 1
- Command privilege level: 1
- Allowed during upgrade: No

**Example**

```bash
admin:license smart reservation return-authorization
""<specificPLR><authorizationCode><flag>A</flag><version>C</version>
<piid>4e0f17d0-4d83-4a74-8009-6e1a909f505a</piid><timestamp>1583227289333</timestamp>
<entitlements><entitlement><tag>regid.2019-06.com.cisco.CCX_FLEX_PREMIUM,12.5_0ecc396f-9a80-4b7b-a4c1-35011a2bc68f</tag><count>1</count><startDate>2020-Feb-26 UTC</startDate>
<endDate>2021-Feb-20 UTC</endDate><licenseType>TERM</licenseType><displayName>CCX Flex Premium Seat 12.5</displayName><tagDescription>CCX Flex Premium License</tagDescription>
<subscriptionID></subscriptionID></entitlement></entitlements><signature>MEYCIQDNodtb0VfzvyJfLenhGMCprSELdAMXaCpsqW8e/mBBAlhAIYXX+8OinS9e+9JlloMGF2WbuJ93yNQM/ySTcDxzst</signature><udi>P:UCCX,S:1f2b5461b8ed</udi><specificPLR>"
```

License reservation is being returned. Please wait ...
License reservation is returned successfully.
Reservation Return Code is: gfgh677hn
Use this code in Cisco SSM to complete the reservation return process.
Command successful.

**Result:** Reservation Return Code is generated and the product instance will transition back to the unregistered state. Enter the code in Cisco SSM to return the reserved licenses to the virtual pool. The product instance will enter evaluation or evaluation expired mode.
The best practice is to restart the system after returning the reservation. If the evaluation period has expired, this product instance will enter into enforcement mode. For more information on enforcement mode, see Cisco Unified Contact Center Express Features Guide at https://www.cisco.com/c/en/us/support/customer-collaboration/unified-contact-center-express/products-feature-guides-list.html.

**license smart reservation cancel**

Use this command to cancel the license reservation process for Smart Licensing.

**Prerequisites:**
- Request command has been executed.
- Authorization Code has not been installed.

**Command syntax**

```
license smart reservation cancel
```

**Requirements**
- Level privilege: 1
- Command privilege level: 1
- Allowed during upgrade: No

**Example**

```
admin:license smart reservation cancel
License reservation request is canceled successfully.
Command successful.
```

**Result:** Reservation Request Code that was generated will be made invalid on the product instance.

**Caution**

After you run the cancel command, do not use the earlier generated Reservation Request Code to generate Authorization Code.

**license smart reservation disable**

Use this command to disable the license reservation feature in Smart Licensing. Before disabling the license reservation, you must return the reserved licenses to the virtual pool, so that you can use the licenses without reservation.

**Note**

Before running this command, if you have requested or installed license reservation, cancel or return the license reservation respectively.
**Command syntax**

`license smart reservation disable`

**Requirements**

Level privilege: 1

Command privilege level: 1

Allowed during upgrade: No

**Example**

```
admin:license smart reservation disable
License reservation is disabled successfully.
Command successful.
```

**Result:** License Reservation is disabled.

---

**Note**

After disabling the license reservation, you have the option to register the product instance by using **Smart Licensing** in Unified CCX Administration.
Cisco Unified Contact Center Express License Packages

This appendix describes the features that are available with each Unified CCX license package.

- Application Availability by License Package, on page 647
- Trigger Availability by License Package, on page 647
- Subsystem Availability by License Package, on page 648
- Unified CCX Services Availability by License Package, on page 648
- Unified CCX Component Availability by License Package, on page 649

Application Availability by License Package

The following table lists the applications available with each license package:

<table>
<thead>
<tr>
<th>Application</th>
<th>Unified IP IVR</th>
<th>Unified CCX Enhanced</th>
<th>Unified CCX Premium</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cisco Script Application</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Busy</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Ring No Answer</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
</tbody>
</table>

Trigger Availability by License Package

The following table lists the triggers available with each license package:

<table>
<thead>
<tr>
<th>Trigger</th>
<th>Unified IP IVR</th>
<th>Unified CCX Enhanced</th>
<th>Unified CCX Premium</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unified CM Telephony</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>HTTP</td>
<td>X</td>
<td></td>
<td>X</td>
</tr>
</tbody>
</table>
### Subsystem Availability by License Package

The following table lists the subsystems available with each license package:

<table>
<thead>
<tr>
<th>Subsystem</th>
<th>Unified IP IVR</th>
<th>Unified CCX Enhanced</th>
<th>Unified CCX Premium</th>
</tr>
</thead>
<tbody>
<tr>
<td>CMT Subsystem</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Core RTR Subsystem</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Database Subsystem</td>
<td>X</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>eMail Subsystem</td>
<td>X</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>HTTP Subsystem</td>
<td>X</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Unified CM Telephony Subsystem</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>MRCP ASR Subsystem</td>
<td>X</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>MRCP TTS Subsystem</td>
<td>X</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Outbound Subsystem</td>
<td></td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>RmCm Subsystem</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Voice Browser Subsystem</td>
<td>X</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>RouteAndQueue Subsystem</td>
<td></td>
<td></td>
<td>X</td>
</tr>
</tbody>
</table>

4 The Unified CCX Outbound Preview Dialer feature does not require an additional license and it comes as part of the Premium license package.

### Unified CCX Services Availability by License Package

The following table lists the Unified CCX Services available with each license package:

<table>
<thead>
<tr>
<th>Unified CCX Services</th>
<th>None</th>
<th>Unified IP IVR</th>
<th>Unified CCX Enhanced</th>
<th>Unified CCX Premium</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unified CCX Cluster View Daemon</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Unified CCX Administration</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Unified CCX Engine</td>
<td></td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
</tbody>
</table>
### Unified CCX Component Availability by License Package

The following table lists the Unified CCX Component available with each license package:

<table>
<thead>
<tr>
<th>Unified CCX Component</th>
<th>None&lt;sup&gt;5&lt;/sup&gt;</th>
<th>Unified IP IVR</th>
<th>Unified CCX Enhanced</th>
<th>Unified CCX Premium</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cisco Unified CCX Database</td>
<td></td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Unified CCX Cluster View Daemon (CVD)</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Unified CCX Engine</td>
<td></td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Unified CCX Repository Datastore</td>
<td></td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Unified CCX Historical Datastore</td>
<td></td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Unified CCX Configuration Datastore</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Unified CCX Recording</td>
<td></td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Unified CCX Monitoring</td>
<td></td>
<td></td>
<td>X</td>
<td>X</td>
</tr>
</tbody>
</table>

<sup>5</sup> Available upon installation, before license package is activated.

### Unified CCX Component Availability by License Package

The following table lists the Unified CCX Component available with each license package:

<table>
<thead>
<tr>
<th>Unified CCX Component</th>
<th>None&lt;sup&gt;6&lt;/sup&gt;</th>
<th>Unified IP IVR</th>
<th>Unified CCX Enhanced</th>
<th>Unified CCX Premium</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cisco Unified CCX Database</td>
<td></td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Unified CCX Cluster View Daemon (CVD)</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Unified CCX Engine</td>
<td></td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Unified CCX Repository Datastore</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Unified CCX Historical Datastore</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Unified CCX Configuration Datastore</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Unified CCX Recording</td>
<td></td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Unified CCX Monitoring</td>
<td></td>
<td></td>
<td>X</td>
<td>X</td>
</tr>
</tbody>
</table>

<sup>6</sup> Available upon installation, before license package is activated.
Bubble Chat Experience

Bubble chat can be launched on any device and the display adapts to the screen size of the device used. For example, if you launch the bubble chat using a desktop, a small chat pop-over appears on the right-side bottom of the web page. If you use a mobile device, the bubble chat launches in the full-screen mode.

To use Bubble chat, ensure that:

- The browser cookies and third-party cookies are enabled.
- The Tracking Protection option in the browser is disabled.
- The Customer Collaboration Platform server and customer website are in the same domain so that the bubble chat works on various browsers.

Note For more information about cookies and Tracking Protection option, see your browser-specific documentation.

The chat process is as follows:

1. The customer initiates the chat by clicking a text link, button, or icon.
   The chat form attempts to collect the details of the customer, such as name, email, phone number etc. The form also presents a list of problem statements - from which the customer has to mandatorily select one.

2. The customer provides details in the chat form and submits it.

3. The chat pop-over opens with a welcome message, such as 'Thanks for contacting. We will be with you shortly'. If all the agents are busy, an appropriate message appears.
   When the agent joins the chat, the customer is notified by a message, and the pop-over divides into a conversation area (where messages appear) and a typing area (where the customer can type messages for the agent).

4. The customer and agent chat - more than one agent can join the chat to create a group chat. While chatting, the agent's messages are displayed on the left of the conversation area and the customer's messages are displayed on the right. All messages are displayed with the timestamp below the message (in the 24-hour format); the agent's message will additionally have the agent's name before the timestamp.
   The chat pop-over can be minimized or maximized.
The following indicators appear on the chat pop-over at appropriate times:

- Agent typing indicator: This indicator, represented by three squiggly dots, appears above the typing area whenever the agent types.

- New messages indicator: The pop-over blinks in a minimized stated whenever a new event occurs during the chat, such as the receipt of a new message, joining of another agent, connection problems etc.

- Agent left/joined indicator: The customer is informed when an agent leaves or joins the chat.

5. When the customer completes the chat and attempts to exit the chat, the following pop-ups are displayed in a sequence:
   a. A chat closure confirmation box.
   b. A chat transcript download box. The customer can choose to download the chat transcript.
   c. A chat rating box, if rating is enabled for the chat. The customer can choose to rate or skip rating by closing this box.

---

**Note** Any connectivity or technical problems that are encountered during the chat session are notified as banner messages at the top of the conversation area.